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New User Guide 5.6

Welcome to the new Margill Loan Manager User Guide. Our last official release was for version 5.1 of the software.

The User Guide for version 5.6 (with some new features that remain to be documented in the August 2023 version since
Margill Loan Manager 5.6 remains in Beta at this time), now over 1200 pages, is drafted in both English and French and
so take, literally, years to update. We have a difficult time keeping up with our great programmers who constantly add
new features that you the users have asked for!

We have tried to update most (maybe 80%) of the thousands of images that have been updated as of version 5.0 but you
will  notice  many  are  still  from  our  version  4.x.  Not  a  huge  thing  -  we  prefer  to  focus  on  more  important  things.  We
continue to update these over time....

So welcome to the new 5.6 User Guide and thanks to Sophie and Kim for their hard work!

Marc Gelinas, CEO

   

Introduction
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What is Margill Loan Manager (MLM)

Margill  Loan  Manager  (MLM)  is  designed  for  small  and  medium-sized  lenders  (personal,  commercial,  and  car  loans,
mortgages), medium and large corporations (inter-company loans, client finance) lessors, investors, law firms, collection
agencies and accountants who manage anywhere from 10 to 25,000 Records. 

MLM offers its users a simple, precise and powerful tool to manage their:

 Loans
 Mortgages
 Lines of credit 
 Accounts receivable
 Leases
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 Due judgments

MLM can perform simple and complex calculations using a fixed interest rate or variable rates (bank rates, preferential
rates, legal interest rates, variable rates + or - x%, etc.) whether the payment schedule is uniform or not. 

Any  type  of  payment  or  "event"  such  as  interest-only,  fixed  principal,  irregular  lump  sum  payments,  step  payments,
missed, partial or late payments, additional principal, fees, insurance, penalties, taxes or any combination of these may
make up a payment schedule. The payments or additional principal can even be named as desired to reflect their nature.

The calculation results appear rapidly and detailed results for each loan, or consolidated reports, may be printed or easily
exported to formats such as Excel, Word, HTML, PDF, CSV or TXT. 

Furthermore, MLM produces custom portfolio reports using any of  900+ data fields  (see the  very  important  Reporting
Fields section) as well  as  contracts,  letters,  invoices and  statements and  accounting  data  (debits  and  credits)  exported
directly to the General Ledger of various accounting packages.

MLM allows:

 creditors

 lenders

 collection agencies

 financial planners

 financial analysts

 investors

 accountants

 law firms

 government agencies

to 
manage

 loans

 mortgages

 leases

 lines of credit

 receivables

 investments

 legal fees

 unpaid judgments

 other financial
instruments

and to track these
when

 payments are made

 payments are late

 payments are unpaid

 payments are only partial

 payments are paid in various  modes
(cash, check, credit card, EFT, etc.)

 checks bounced (NSF)

 invoices are made and paid

 withdrawals are made from an
account

 additional principal is added 

 late fees are charged

 insurance, taxes

 etc.

In addition, MLM allows pre-authorized payments by debit or credit card, and to produce Credit reports to be submitted
to  credit  reporting  agencies  (Equifax,  Experian  or  other).  In  case  of  payments  that  bounce,  fees  can  be  added
automatically based on rules set by the user.

Its  Alerts  module  is  a  powerful  feature that  reminds users  when  certain  tasks  must  be  accomplished or  to  be  warned
when certain conditions are met.

   

System Requirements

Recommended Configuration:

 A Windows-based personal computer or server with a minimum Intel i3 (or equivalent) type microprocessor with a
minimum of 4 GB RAM, available 250 MB of drive space for installation and between 100 MB and 2GB is required for
data;

 Microsoft Windows: 7, 8.x, 10, Server 20XX;

 MLM Uses its  own internal  database,  Hyperfile,  a  high performance, highly  stable  database,  so  no  other  database
system is required;
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 Monitor with a minimal resolution of 1280 x 1024;

o It is strongly recommended to keep the "Size of all items" at Smaller (or 100%), otherwise Margill icons and
buttons will not be displayed properly (Windows Control Panel > Appearance and Personalization > Display).
 

 Internet access and a browser (optional but highly recommended in order to have access to updates and to activate
the software); 

Environments:

Margill Loan Manager (MLM) was developed for Windows environments.

On  Mac,  MLM  has  been  tested  with  the  Windows  emulator  Parallels  (www.parallels.com)  that  provides  flawless
compatibility.

The software can also be used with Remote Desktop  technologies,  Remote Apps  and Microsoft Terminal services,  for
example.

Citrix, that enables virtualization of the Desktop, can also be used as a platform.

CAUTION:

Depending on the number of loans in a portfolio, the speed of the computer used and the network access speed (in a
networked environment) will greatly affect MLM's operational speed. If the user's computer is too slow, processing time
between operations (data access, table generation, report generation) may become quite long. For portfolios over 5000
loans, latest generation computers and high speed networks should be used and a dedicated server may be wise.

Considering the quantity of data that flows in a network installation:

 It is strongly recommended to be on a fast Ethernet connection (wired) as opposed to wireless;

 MLM is not recommended on Virtual Private Networks (VPN) unless connected with a high bandwidth connection.

See: Installation, Networking capabilities and Database.

   

Installation, Networking capabilities and Database
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The  installation  process  is  very  simple  and  can  be  performed  on  a  single  workstation  (on  one  computer)  or  more
commonly, on a network.

Download the "MLM_Install_5.6.23xxx.x_DEMO.EXE" file at www.margill.com/get (MLM meaning Margill Loan Manager
and .23 xxxx indicating the year, month and day and .x the version of minor update). Save the installation file, preferably
on the Desktop to easily find the file afterwards.

Double click to install and select the language.

Single User Installation:

Margill Loan Manager (MLM) is most often used in a network environment, but can be used on a desktop computer or on
a laptop. Backups are ESSENTIAL in case of destruction, loss, theft, etc.

MLM is installed by default in the following folders:

Software: C:\Program Files (x86)\MLM
Data: C:\ProgramData\MLM_Data

Users must have the rights to read and write on the "MLM_Data". The data can also be saved in a location other than the
default (suggested) folder.

Once  the  installation  is  completed,  run  MLM  and  press  "Activate  by  Internet"  (once  a  license  is  purchased),  or  use  in
Demo mode.

Network Installation: 

Install on a server (shared drive) at the desired location while making sure to give the read and write rights on the data
older: either the MLM_Data" folder or the "DB" subfolder (located in the MLM installation folder).

If  the  data  is  located  elsewhere  than  in  the  MLM  installation  folder,  make  sure  that  the  Network  path  is  entered  as
opposed  to  the  local  server  path.  For  example,  MLM  could  be  installed  on  the  C:\  drive  on  the  server,  but  for  the
Network, this is the Z:\ drive (or directly the server’s name). Always use the Network path, otherwise the client stations
will not be able to find the data.

Create on each workstation, a shortcut to MLM.exe (that points to the server installation) giving read and write rights to
each user on the "MLM_Data" folder.

Next, launch MLM from one of the client workstations and press on "Activate by Internet" (once a license is purchased),
or use in Demo mode.

www.margill.com/get


Page 15

© Jurismedia Inc., 2007- 2023

Version 3.1 and less

In  version 3.1 and less,  the data (database and other  data)  are  located in  the  "DB" sub-folder  of  the  MLM installation
folder. Users must have read and write rights on the "DB" sub-folder.

See also:

 Environments  sub-section in the System Requirements chapter;
 Administrator and Users to add or modify users;
 Location (Path) of System Data.

Registration:

Once  the  installation  done,  launch  the  Margill  Loan  Manager.  Press  on  "Activate  by  Internet"  for  software  activation.
Follow the instructions.

Database:

MLM uses its internal database, "Hyperfile" and therefore, no external database is required. The database is known to be
highly efficient and very stable. Furthermore, as of version 5.3, the database files are now encrypted for greater security. 
 
See also Setting the Records' Unique Identifiers.

   

Fundamental Principles of Operation

With  Margill  Loan  Manager  (MLM),  a  user  can  be  up  and  running  within  only  a  few  minutes.  This  page  contains  the
fundamental  operating  principles.  Once  these  are  understood,  MLM  offers  extraordinary  flexibility  all  the  while  being
very user friendly.

A Record includes many components which can be associated together to form a complete Record.
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A  Borrower  or  a  Creditor  can  be  created  in  the  database  without  having  to  create  (calculate)  the  Payment  schedule
(sometimes referred to as Payment schedule).

To create a Borrower, Creditor or Employer, press the appropriate tab in the Main MLM window (under File) and click the

"New" button . You can enter the data for each.

To create a new Record, which, as shown in the diagram above, includes the Payment schedule (loan, mortgage, line of
credit, etc.), its Borrower, Co-Borrower(s) and Creditor(s), press on "File" and the "New Record" button.
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Record Data and Preliminary payment schedule creation

The window that opens up should contain all the data that pertains to that Record: 

 Data:  preliminary mathematical  data ("Data" tab),  identification data for the  loan (General  tab),  unlimited custom
fields ("Other Data" tab), option to attach documents to a Record ("General" tab). A field can be left blank and will
be calculated automatically. Column Fees can also be included as a percentage of the balance or as an amount.

This is only the preliminary mathematical data since the schedule may be completely edited  to  include irregular
payment  scenarios  (interest-only  for  a  while,  no  payment,  lump  sum  payments,  no  interest,  irregular  payments,
principal, fees, insurance or taxes, and multiple other possibilities).

 Borrower: all data relating to the Borrower as well as unlimited custom fields ("Other Data" tab), as well as all data
regarding a possible Co-Borrower and data pertaining to the Employer.

 Creditor: all data relating to the Record's Creditor (lender) or the fund, unlimited custom fields ("Other Data" tab), as
well as data relating to its Loan Officer.

 Credit Report: all relevant data in order to submit the credit history to the credit bureaus.

 APR: all Compulsory fees charged to the Borrower by the Creditor (if APR must be provided).

 Alerts: allows you to create an alert specifically for this Record.

 Advanced: various other settings (day count, simple or compound interest, etc.).
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Preliminary schedule

 The  preliminary  schedule  will  be  created  and  will  include  all  future  payments  (or  historical  payments  if  entering
historical data). These lines will be tagged by default as "Due Pmt".

Theoretical schedule
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 The payment schedule should then be adapted to reflect the proposed payment plan over time. If regular payments
are  to  be  paid  on  different  dates  or  if  the  payments  are  to  be  different  than  those  entered  in  the  preliminary
schedule, change these while Line status is "Due Pmt".

 For reporting purposes, the "Due Pmt" status allows MLM to keep in mind the payment amount that SHOULD have
been made as well as the date at which it SHOULD have been made.

 In  this  example,  the  first  three  (3)  lines  are  interest-only,  fees  (50.00)  are  charged  on  the  4th  line  (which  was
inserted), followed by three (3) 1000.00 payments and the last six (6) payments are recomputed to yield a balance =
0.00.

 For an APR calculation, the APR should be provided before any payments (or other events) are actually made, thus
based on the theoretical payment schedule at the time when the loan contract is signed.

 It is suggested to keep this theoretical Payment schedule, by either printing (using the "Print"  

button),  or  joining  a  PDF  file  the  to  the  Record  (using  the   button).  It  will  appear  in  the

 link of the "General" tab in the "Data" window. The "Attach" also offers the option to
attach this PDF to an email.

True payment history



Page 20

© Jurismedia Inc., 2007- 2023

 The payment schedule works somewhat on a what you see is what you have  (WYSIWYG) principle. Only change a
Line  status  from  the  "Due  Pmt"  to  the  new  Line  status  when  a  payment  or  other  event  is  actually  made.  Dates,
amounts and of course Line statuses may/must be changed to reflect reality.

 Thus, the data that appears in a payment schedule along with the Line status should reflect what has, what is, and in
the future, what should truly happen over time. Choose the most appropriate Line status among 70 Line statuses.

 MLM  attempts  to  minimize  illogical  payment  scenarios.  For  example,  a  "Due  Payment"  cannot  precede  a  "Paid
Payment". See Data Integrity.

 In this example (see image above), the first two (2) payments are Paid, the 3rd Unpaid. The 06/01 payment is actually
paid  on  06/10  and  only  250.00  instead  of  1000.00,  thus  becomes  a  Partial  Late  payment.  The  50.00  in  fees  are
eventually paid (07/12). A second loan of 15,000 is made on 07/15. Finally, the last six (6) payments are recomputed
to give a balance of 0.00. These are not yet due though. The Line status will change as the payments become due.

Main MLM window - Record Summary
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 All Records (loans, mortgages, lines of credit or other financial instrument) are contained in the Main MLM window -
called Record Summary window.

 
 The Records may be sorted as desired (by name, number, type of loan, phone number, balances, any custom fields,

etc). Each user can display the desired columns from over 900 fields, custom fields and mathematical equations. See
Displayed column selection and order. Sorting is also possible with 2 to 3 columns (Ctrl + column headers).

 Thanks to the Borrower, Creditor and Type Display  Filters  in  the  Main  window,  as  well  as  the  three Custom fields
filters, it is possible to display only the Records relating to certain Borrowers, Creditors, Record types, custom fields,
or a combination of any of these.

o Please note that the '"Type" filter will only appear if a Scroll menu is defined for this field. The Administrator
can create this scroll menu in Tools > Settings.

 You can view the complete list of Borrowers, Employers or Creditors, as well as data associated with them, by clicking
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on the Borrower, Employer or Creditor in the left menu under File.

o All data relating to the Borrowers, Employers or Creditors, including custom fields are displayed in columns
and can be sorted by clicking the header of a column.

 For  reporting,  sort  the  Records,  select  the  desired  Records  (the  lines  will  become  blue)  and  the  report  will  only
contain data relating to the selected Records.

Interest, Payments and Balance and Record termination date

Another fundamental element to understand is when interest is computed, when a payment is made in a day and when a
balance is computed.

In the example below, a partial payment schedule is shown including the usually hidden "Start Date" column. Let's take
line 2 as our example:

 

The interest amount of 411.81 is accrued interest from 12-01-2009 at 0:00 in the morning until 01-01-2010 at 0:00 in the
morning. Thus, interest up to 01-01-2010 but excluding the interest for that day.

The payment of 1000.00 is considered made on "Pmt Date" on 01-01-2010 at 0:00:01 (so at 0:00 in the morning plus a
fraction of a second).

The balance on "Pmt Date" 01-01-2010 of 48,828.48 is at 0:00:02 (so at 0:00 in the morning plus a fraction of a second
after the payment is made). The day's interest is not included but the day's payment is included to yield the balance.

Finally, a Record is considered to be completely terminated on the "Pmt Date" at 0:00:02 (so at 0:00 in the morning plus a
fraction of a second to allow the last payment to be made). No interest is included for that last day. For reports, if  the
report end date entered is after the Record's termination date, data will be provided only up to that termination date,
thus at 0:00:02.
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See also the distinction between accrued interest and paid interest (Accounting data section).

Important suggestion for loans with unknown payments dates (Irregular payments, lines of credit)

If a loan or line of credit was to contain only one payment (or only a few payments), MLM would consider it terminated
on the last line of the Payment schedule and thus, data after this last date would not be obtained.

For such loans or lines of credit (the Borrower pays when he/she is able to or when events such as sales occur), in order
to obtain the loan balance and other financial data over time, even if  no payments are made, it  is suggested to create
dummy monthly payments of 0.00 for the next x years or one dummy payment (Line status "Information") of 0.00 a few
years later (as in example below). 

This will allow you to obtain the true balance due, the accrued interest, etc., at any point in time until the last line of the
schedule. The number of years is based on your evaluation of the typical duration of the loan in ordinary circumstances.

   

WARNING

Before using Margill  Loan Manager (MLM), you should be sure to fully  understand the context of  the calculations.  For
this,  we  advise  you  to  consult  the  appropriate  lending  legislations,  the  lending  or  leasing  contractual  clauses  and  a
finance manual in order to apply the appropriate advanced calculation method.

It  is  extremely  important  to  differentiate  between  the  nominal  interest  rate,  the  effective  (real)  interest  rate,  the
compounding period, the Day count,  as well as whether a loan is normal compound,  simple interest or  simple interest
(capitalized) and to specify clearly if a date is to be included or excluded at the beginning or the end of the calculation.

Furthermore, it is also important to consult the User License, the Limited Warranty, and the Acceptance that comes with
MLM.

Data Backup

It is up to the user to create data backups regularly. See the Backup section.

   

Technical and Application support

Technical or application related questions? Please call or email us:

Jurismedia inc.
Toll free: 1-877-683-1815
Direct: 001-450-621-8283
Direct: 001-514-683-1815
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Fax: 001-450-621-4452
E-mail: support@margill.com

More Contact information

Specific interest questions

A service (with fees) is also available to clients in order to:

 solve very specific interest calculation questions or problems;
 create special custom reports.

Please contact Jurismedia by email at support@margill.com.

See also:  Support, maintenance and update contract.

   

Contact information

Jurismedia Inc.:
Canada office - Head office

75 des Chateaux Blvd, Suite 102
Blainville (greater Montreal region), Quebec, J7B 2A4

Canada

US office

2915 Ogletown Road 
Newark, Delaware, 19713

USA

Phone, Fax, E-mail, Web:

Toll free: 1-877-683-1815 (North America)
Telephone: (001) 450-621-8283
Telephone: (001) 514-683-1815

Fax: (001) 450-621-4452

Sales
sales@margill.com

Support
support@margill.com

Web
www.margill.com

www.jurismedia.com

   

License

mailto:support@margill.com
mailto:support@margill.com
mailto:sales@margill.com
mailto:support@margill.com
http://www.margill.com
http://www.jurismedia.com
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Margill Loan Manager (MLM) license is available in single-user or network versions as well as on the Cloud as a service
(SAAS).

The MLM license takes into account two (2) factors:

 Number of Seats (computers) that can access MLM
 Number of Records for that license

The number of Records and seats allowed is indicated in Other > About:

When  a  license  is  acquired  for  a  certain  number  of  Records  (loans),  the  number  of  Borrowers  (and  less  importantly,
Creditors and Employers) can be triple that number. So a 1000 loan license can include up to 3000 Borrowers.

The  key  returned  by  Jurismedia  will  limit  the  software's  use  to  the  appropriate  number  of  loans  and  users  (seats)
indicated in the license. 

If  more  stations  are  required  or  if  the  number  of  Records  allowed by  the  current  license  becomes  insufficient,  please
contact Jurismedia to upgrade. See Contact information

Margill Loan Manager (MLM)©  End User License Agreement
Montreal, Quebec, Canada 

March 1, 2022 
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USER LICENSE AND LIMITED WARRANTY FOR MARGILL LOAN MANAGER (MLM)
This  document  constitutes  a  contract  between  you,  and  Jurismedia  Inc.  By  installing  Margill  Loan  MANAGER  (MLM),  you  agree  to
respect the terms and conditions of this contract, which include the USER LICENSE, the LIMITED WARRANTY, and an ACCEPTANCE. 

IF YOU DO NOT AGREE WITH THE TERMS OF THIS AGREEMENT, DO NOT INSTALL MLM. Return or destroy the file or disc immediately. 

In order to preserve and to protect its rights within the framework of national and international copyright laws, Jurismedia does not
sell rights to MLM, but grants a License to use MLM within the framework of a License agreement and expressly reserves the right of
ownership of MLM. 

USER LICENSE
1.  LICENSING IN DEMO MODE.  Subject  to  your  commitment to  comply  to  the terms and conditions of  this  License  and  the  Limited
Warranty,  Jurismedia,  the  LICENSOR,  grants  you,  the  LICENSEE,  the  nonexclusive  right  to  use  this  copy  of  MLM  in  DEMO  mode
provided that the terms of the License are respected. The DEMO mode gives you the right to use MLM for a certain number of days.
The License in DEMO mode ceases and is replaced by the License AFTER PURCHASE of article 2 of  the present Agreement when the
LICENSE fees have been paid and when MLM is activated by a special code available exclusively through Jurismedia. 

2.  LICENSING  AFTER  PURCHASE.  Upon  payment  of  the  LICENSE  fees  included  in  the  purchase  price  of  the  product  and  your
commitment to conform to the terms of this License and the Limited Warranty, the LICENSOR grants the LICENSEE, the nonexclusive
right to use MLM on a single computer in only one physical location, provided that the terms of the License are respected. If the single
computer on which MLM is used is a system with several users, the License will apply to all its users at no cost. If a network License is
granted,  the  number  of  stations  purchased  represents  the  number  of  stations  which  have  ACCESS  to  MLM  in  one  unique  physical
location (also known as “per seat” license). An installation of MLM or a shortcut to the host computer containing the MLM files can
only  be  made on  the  maximum number  of  stations  acquired by  License.  Jurismedia  reserves  all  rights  not  expressly  granted to  the
LICENSEE.

3. RIGHT OF OWNERSHIP OF MLM. Upon payment of the License fees, the LICENSEE becomes the owner of the disk or other support
on which MLM is  initially  or  thereafter recorded.  However,  the present License is  granted on the express condition  that  Jurismedia
preserve its right of ownership of MLM, as saved on the original disc as well as on all copies that may have been made, in whatever
form or support containing the original and copies. This License does not constitute a sale of MLM software or any copy thereof.

4.  REPRODUCTION  RESTRICTIONS.  MLM  and  the  documentation  which  accompanies  it  are  protected  by  national  and  international
copyright laws. Subject to the right of distribution in DEMO mode, any unauthorized reproduction of MLM, including its modification,
its fusion or its inclusion in another, or of the documentation which accompanies it, is strictly prohibited. The LICENSEE could be liable
to  legal  sanctions  for  any  violation  of  this  copyright  and  his  or  her  default  in  respecting  the  terms  of  this  License.  The  LICENSEE  is
however authorized to copy or distribute MLM in DEMO mode. 

5. RESTRICTIONS OF USE. The LICENSEE is authorized to physically transfer MLM from a computer to another on condition however
that MLM is used or installed on only one computer or on the number of computers allowed by the license through Jurismedia or one
of  its  authorized dealers.  Subject  to  the transfer and distribution authorized in  DEMO mode,  electronic  transfers of  MLM from  one
computer  to  another  on  a  network  and  the  distribution  of  MLM  or  its  documentation  to  a  third  party  are  strictly  prohibited.  Any
modification, adaptation, translation, reverse engineering, decompilation, dismantling or creation of works drawn from MLM, as well
as any modification, adaptation, translation or drafting of works inspired from its documentation without the prior written approval of
Jurismedia, are strictly prohibited. 

6.  RESTRICTIONS  OF  TRANSFER.  The  user  License  of  MLM  is  conferred  only  to  the  LICENSEE  and  cannot  be  transferred  to  anyone
without prior written approval from Jurismedia. Any recipient of a duly authorized transfer will be held under the terms and conditions
of this License and Limited Warranty. The LICENSEE may not transfer, yield, rent, nor sell MLM, nor dispose of it in one way or another
temporarily or permanently except as is expressly authorized in this agreement. 

7. TERMINATION. The present License remains in force until it is ended. It will automatically end, without notice from Jurismedia if the
LICENSEE does not conform to the terms of the License. In the event of termination, the LICENSEE will have to immediately return or
destroy any documentation and all copies of MLM, including the modified copies, if the case arises. 

8. REFUND. As with any electronic license, NO REFUND is offered on the purchase of a LICENSE IN DEMO MODE and / or following the
purchase of a LICENSE. Once an activation key is sent by Jurismedia by any means whatsoever (email, telephone or other), no refund
will be given. Even if payment has not yet been paid by you, you agree to pay the invoice within 30 days from date the invoice has been
sent. If payment was made by credit card, you agree not to undertake any operation aimed at cancellation of the transaction even if
the payment was made by telephone or via Internet.

9.  UPDATES.  Jurismedia  may  publish  from  time  to  time  revised  versions  of  MLM  which  it  may,  at  its  full  discretion,  offer  to  the
LICENSEE and to recipients of a transfer who will have paid the update fees. 

10. OTHER CLAUSES. The present License is governed by the legislation in force in the province of Quebec, Canada for the benefit of
Jurismedia Inc, its representatives, its heirs and successors. The LICENSEE agrees to subject itself to the jurisdiction of the appropriate
Quebec and Canadian courts. 

LIMITED WARRANTY
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MLM AND THE DOCUMENTATION WHICH ACCOMPANIES IT (INCLUDING USERS’ INSTRUCTIONS) ARE PROVIDED AS IS AND WITHOUT
ANY WARRANTY. MOREOVER, JURISMEDIA PROVIDES NO WARRANTY AND DOES NOT MAKE ANY STATEMENT CONCERNING THE USE
OR THE RESULTS OBTAINED FROM MLM OR  ITS  DOCUMENTATION IN  TERMS  OF  THEIR  ACCURACY,  RELIABILITY,  CURRENTNESS OR
OTHER. ALL RISKS RELATED WITH THE RESULTS AND PERFORMANCE OF MLM ARE SUPPORTED BY THE LICENSEE. IN THE EVENT OF A
DEFECT  IN  MLM  OR  ITS  DOCUMENTATION,  THE  LICENSEE  AND  NOT  JURISMEDIA,  ITS  DISTRIBUTORS,  AGENTS,  ADMINISTRATORS,
EMPLOYEES, SUB-CONTRACTORS OR ANY PERSON HAVING PARTICIPATED IN THE CREATION OF MLM, WILL BE RESPONSIBLE FOR ALL
COSTS NECESSARY FOR CORRECTIVE MAINTENANCE, REPAIR OR CORRECTION.

WHEN  USING  ANY  AND  ALL  DATA  EXPORT  OR  IMPORT  FEATURES  IN  MLM,  INCUDING  BUT  NOT  LIMITED  TO  THIRD-PARTY
ACCOUNTING  PACKAGES,  CREDIT  REPORTING,  ELECTRONIC  FUNDS  TRANSFERS,  DATA  IMPORT  OR  UPDATE  FROM  FILES  OR
APPLICATION PROGRAMMING INTERFACES (API), THE LICENSEE IS SOLELY RESPONSIBLE FOR ANY RESULTING INCOMPLETE, MISSING
OR  DUPLICATE  DATA,  ANY  DATA  CORRUPTION,  ANY  AMOUNT  COLLECTED  INCORRECTLY  OR  NOT  COLLECTED,  THAT  MAY  RESULT
FROM THIS EXPORT OF MLM DATA TO THE OTHER SYSTEM, DATABASE OR SOFTWARE OR DATA IMPORT TO MLM. THE LICENSEE AND
NOT  JURISMEDIA,  ITS  DISTRIBUTORS,  AGENTS,  ADMINISTRATORS,  EMPLOYEES,  SUB-CONTRACTORS  OR  ANY  PERSON  HAVING
PARTICIPATED IN THE CREATION OF MLM, WILL BE RESPONSIBLE FOR ALL COSTS NECESSARY FOR CORRECTIVE MAINTENANCE, REPAIR
OR CORRECTION.

WHAT  PRECEDES  CONSTITUTES  THE  ONLY  WARRANTY  GIVEN  BY  JURISMEDIA  FOR  ITS  PRODUCT  AND  EXCLUDES  ANY  OTHER
WARRANTY, OF WHATEVER FORM, SPECIFIC OR IMPLICIT, STATUTORY OR OTHER, INCLUDING, WITHOUT RESTRICTION, ANY IMPLICIT
WARRANTY OF THE PRODUCT’S ADEQUATE COMMERCIAL CHARACTERISTICS OR APPROPRIATENESS FOR A PARTICULAR USE. 

NO  INFORMATION  OR  OPINION  GIVEN  VERBALLY  OR  BY  WRITING  BY  JURISMEDIA,  ITS  ADMINISTRATORS,  DISTRIBUTORS,  AGENTS,
EMPLOYEES OR ANY PERSON HAVING PARTICIPATED IN THE CREATION OF MLM WILL CONSTITUTE A WARRANTY NOR WILL EXTEND IN
WHATEVER WAY THE CONTENT OF THIS  WARRANTY,  AND THE  LICENSEE  CANNOT RELY  ON SUCH INFORMATION OR  OPINION FOR
THIS PURPOSE. 

NEITHER THE VENDOR, NOR ANYONE HAVING PARTICIPATED IN THE CREATION, PRODUCTION OU DELIVERY OF MLM CAN BE HELD
RESPONSIBLE  FOR  ANY  DAMAGE  DIRECT,  INDIRECT,  SECONDARY  OR  ADDITIONAL  (INCLUDING  DAMAGES  RESULTING  FROM  THE
MATHEMATICAL  RESULTS  CALCULATED,  THE  LOSS  OF  BENEFIT,  THE  INTERRUPTION  OF  ACTIVITIES  OR  THE  LOSS  OF  INFORMATION
AND OTHERS) ARISING FROM THE USE OR THE IMPOSSIBILITY OF USE OF THE PRODUCT,  AND THIS  EVEN IF  JURISMEDIA HAS BEEN
INFORMED OF THE POSSIBILITY OF SUCH DAMAGE. 

IN THE EVENT OF CONFLICT BETWEEN A PROVISION OF THIS WARRANTY AND ANY PROVINCIAL, STATE OR FEDERAL LAW APPLICABLE,
THIS LAW WILL HAVE PRECEDENCE OVER AN INCOMPATIBLE PROVISION. The present limited WARRANTY is governed by the laws of
Quebec, Canada for the benefit of Jurismedia Inc, its representatives, its heirs and successors.

Client Data:

The  LICENSEE  is  entirely  responsible  for  the  client  data  produced  with  MLM.  NEITHER  JURISMEDIA,  NOR  ANY  PERSON  HAVING
PARTICIPATED IN THE CREATION, THE PRODUCTION OR THE DELIVERY OF THE PRODUCT CAN BE HELD RESPONSIBLE in case of data
corruption, destruction or loss. It is entirely up to the LICENSEE to regularly create backup copies of his or her client data.

Confidentiality of Data:

The  LICENSEE  is  entirely  responsible  for  any  and  all  data  confidentiality  and  protection  issues  resulting  from  MLM  use.  NEITHER
JURISMEDIA, NOR ANY PERSON HAVING PARTICIPATED IN THE CREATION, THE PRODUCTION OR THE DELIVERY OF THE PRODUCT CAN
BE HELD RESPONSIBLE in case of confidential information loss, unauthorized access or distribution, database tampering or any other
illicit use of information. 

MLM login protection should not be considered as a foolproof data protection method.

ACCEPTANCE 

YOU  HEREBY  CERTIFY  THAT  YOU  HAVE  READ  THIS  LICENSE  AGREEMENT  AND  THE  LIMITED  WARRANTY,  HAVE  UNDERSTOOD  ITS
TERMS  AND  CONDITIONS  AND  YOU  AGREE  TO  RESPECT  THEM.  YOU  ALSO  RECOGNIZE  THAT  THE  AFOREMENTIONED  LICENSE  AND
LIMITED WARRANTY CONSTITUTE THE INTEGRAL AND EXCLUSIVE AGREEMENT WHICH BINDS THE PARTIES AND THAT THESE REPLACE
ANY  PREVIOUS  OFFER  OR  AGREEMENT,  ORAL  OR  WRITTEN,  AND  ANY  OTHER  COMMUNICATION  BETWEEN  THE  PARTIES  AND
RELATING TO THE CONTENT OF THIS LICENSE OR LIMITED WARRANTY. 

For further information about the License or Limited Warranty, or to reach Jurismedia for any reason, please write to Jurismedia Inc.,
75 Des Chateaux Boulevard, Suite 102, Blainville, Quebec, Canada, J7B 2A4 (Greater Montreal Region). By e-mail: sales@margill.com.
Web  -  www.jurismedia.com,  www.margill.com.  Tel.:  (450)  621-8283  Toll  free  (North  America  only):  1-877-683-1815.  Fax:  (450)
621-4452.

   

Purchase additional licenses / Upgrade loan level
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If  additional  Margill  Loan  Manager  (MLM)  stations  are  required  or  if  the  number  of  Records  allowed  by  the  current
license becomes insufficient, please contact Jurismedia to upgrade. 

Very often, the price of an upgrade will be determined by subtracting the smaller license retail  price from the upgrade
retail price plus an administrative fee.

Once the purchase is complete, go in the "Other" tab and press "License Update" . The following window
will  appear,  allowing you  to  update  via  the  Internet  (you must  then enter  the  email  address  on  file  or  the  email  with
which  the  MLM  licence  was  purchased).  A  manual  registration  is  also  possible  by  e-mail  (Send  E-mail  button)  or  by
phone.

   

Personal Logo Display

As  of  version  4.0  of  Margill  Loan  Manager  (MLM),  it  is  now  possible  to  personalize  your  main  page  by  adding  your
corporate logo and by removing MLM's logo.

In  order  to  have  access  to  this  option  and  for  additional  information,  please  contact  us  by  e-mail  at
assistance@margill.com. Additional fees will apply.

Once you get the activation code from Margill's customer service team, click on "Tools", then on "System Settings".
 
In the Modules section, click on "Personal Logo Display".

Finally, insert the activation code in the window that will open.
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Versions

Version 5.6

Version 5.6.2312XX.1

To be released December x, 2023

What's new:

 Main window:
o Significantly optimized data loading time in the Main window  ("Instant mode" not documented November

7, 2023)
 Borrower selection window:

o Significantly optimized data loading time
 Attached documents: option allowing to name the document type that  is  attached to the Record or  the Borrower

(not documented November 7, 2023)
 An interest payment can pay capitalized interest before the current interest accrued (for that line or lines)

o Corresponding fields
 Capitalized Interest (for period)
 Capitalized Interest (entire Loan)
 Capitalized Interest Paid (for period)
 Balance Capitalized Interest due at Report Start date at 0:00
 Balance Capitalized Interest due at Report End Date

 User Management:
o Option allowing access to the designated user only to the Records of certain Creditors
o Special option for participation loans with multiple Creditors (access, or not, to the Record if not authorized

Creditor)
o Apply a Template for users for the Main window and/or Payment schedule setup based on ADMIN settings

(compulsory or not)(only the ADMIN user can do this)
 Accounting entry Report: 

o Option to include closed Records
o When an Advanced Query is used, elimination of the constraint of including only Active Records

 Document Merge: (not documented - November 7, 2023)
o Option to select report dates from the Record's Origination date up to date X
o Column added in the merge fields showing the short merge code

 Automatic reports (Overnight) - option to save produced files to a FTP or SFTP folder
 Automated import via Windows service (Borrower data and/of Records / loan data):

o Alert  in  the  Main  window  when  a  file  is  in  the  import  folder  (folders  should  always  be  empty  except
temporarily (less than 2 minutes) when the file is sent there)

 Automated existing "Due Pmt" update to "Paid Pmt", "Unpaid Pmt", "Partial Pmt", "Late Pmt", etc. (payment update
via Excel sheet - API)(documented in separate document available on-line)

 New variables added for the Employer linked to Co-Borrower 1
 New reporting fields:

o Next Due Pmt even if Pmt = 0 (amount and date) (not documented - November 7, 2023)
 In version 5.5 and below, if the payment amount was 0.00, then this Due Pmt was ignored

o Borrower Business and if empty, then First Name Last Name of the Borrower
 Payment schedule - Global changes to change the data for multiple lines at once. Columns included:

o Comment
o Expected Payment
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o Expected Principal (if option is activated in Settings)
o True Pmt Date (Grace/EFT)
o Minimum Payment
o 3 custom columns - Money
o 3 custom columns - Numerical
o 3 custom columns - Text

 Column fees can be added when adding new payments directly in the Payment schedule
 Post payment tool - change "True Pmt (Grace-EFT)" date for many lines at once
 City can now be a scroll menu (for Borrower, Creditor and Employer)
 Electronic Funds Transfers (EFT) - If number of consecutive Unpaid Payments is greater than x, then advise user or do

not allow to submit this next payment as EFT
 For Custom fields, elimination of numbering the field order presentation. You can now move them up or down with

the arrows without the need to number them
 If your default PDF reader cannot open PDFs directly in MLM, there is an option to use MLM's internal PDF reader

(Tools > User Settings)
 The "Modify / New Record" option in the Data tab will  be grayed out if  the Origination Date precedes the current

date by more than X days if the option blocking the edit of historical transactions is activated
 Data  confidentiality:  bank  account  number  can  now  be  "redacted"  (hidden)  for  all  users  except  those  specifically

authorized to see the data (Sensitive data module)
 If interest is negative and capitalized, the amount of interest that will be capitalized will be zero (0.00) instead of a

negative  amount.  The  Balance  Due  Interest  will  thus  remain  unchanged  instead  of  increasing  negatively  (so
decreasing). In previous versions, negative interest amounts continued to capitalize negatively (rare cases)

 History of changes by line in a Payment schedule
 Bank account number included in the Sensitive data module
 Borrower Social security number (SSN) can now be forced to follow a specific format 
 The "Country" for Borrower and Creditor in Advanced Queries (also in October 2023 version 5.5)
 Force various Record and Borrower identifiers to be unique or not
 Automatic import of new transactions (API) - option for same date transactions and column K (for Fixed Principal Due

payments, added)
 Total Borrower credit, amount can be up to 999 billion
 Behind the scenes Borrower window redesign  (not documented November 7, 2023)

o EFT  banking  data  can  be  entered  in  the  Borrower  window  directly  accessible  from  the  Record  window
without needing to go through File > Borrower (not documented November 7, 2023)

 64 bit version (previous versions were 32 bit)

--------
Version 5.5

 Version 5.5.230810.1

Released August 10, 2023

 Shortcut (Ctrl Alt Shift C) in the Main window to bulk add or change Creditors (only for Creditor in first position)
 Shortcut (Ctrl Alt Shift Z) in the Main window to bulk check the "Balance = 0 (or other amount)" box in the selected

Payment schedules to adjust the latest "Due Pmt" amount. Only for Records whose last line is of "Due Pmt" type.
 Borrower Email now accepts 300 characters to allow the entry of multiple emails for a Borrower
 Fixed  a  recent  error  introduced  (in  5.5)  of  payment  dates  in  Payment  schedule  when  the  unknown  variable  was

Amortization (Payment dates were set to last day of month) 

--------
Version 5.5.230627.1
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Released June 27, 2023

 Borrower Merge (Special options in Settings) issue fixed when Borrowers had EFT payments linked to them. Software
froze. Now a message appears requesting a confirmation of the special operation.

 Creditor Invoices and Statements (Document Merge). Issue fixed with Mathematical Equations in the data presented
to the Creditor in table format. Only the total appeared, not amounts by loan.

 Documents Merge: new Table 25
 Revised  calculation  for  "Interest  Paid"  line  -  especially  when  interest  is  prepaid  as  simple  interest  or  simple

compound interest
 Accounting entry Report (General Ledger) - if the "Actual Pmt Date - Grace/EFT" date was greater than the Payment

Date on the last line of the Payment schedule, this transaction was excluded.  It is not included.
 Various minor adjustments to previous versions 5.5

--------

Version 5.5.230510.1

Released May 10, 2023

 New reporting field:
o First Payment Date (Original)

 Main window:
o Fix to all the "Tally" type fields (for example, number of Unpaid Pmts)

--------

Version 5.5.230406.1

Released April 6, 2023

What's new:

 Main window:
o New search, filter and other options including the "Contains" search
o Three extra Custom fields Display filters (total of six now)

--------

Version 5.5.230322.1

Released March 22, 2023

What's new:

 Add Column Fees on the first line of the Payment schedule only (on the Origination Date), when creating a Record. A
new line will be inserted automatically with the desired Line status "Other x". The often seen fees at Origination can
thus be added without the need to do it manually in the Payment schedule.

 New  "Expected  Principal"  concept  (similar  to  "Expected  Payment"  but  for  the  principal  portion  upon  loan
amortization schedule creation)

 New refund order (Order 2)(in Advanced)(limited accessibility):
o Interest  >  Expected principal  (no  interest)  >  Expected principal  (with  interest)  >  Column Fees  1  >  Column

Fees 2 > Column Fees 3 > Column Fees 4 > Column Fees 5 > Column Fees 6 > Principal  (no  interest)  >  All
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other  Line  status  amounts  (no  interest)  >  All  other  Line  status  amounts  (with  interest)  >  Principal  (with
interest)

 Number of events (Line statuses) now in Mathematical equations and Advanced equations
 Added Borrower and Creditor IDs in Document Merge
 Added of unique IDs 1 and 2 when selecting the Borrower (Co-Borrower and Guarantor) in the Record
 Drop-down menus available for the nine custom in the Payment schedule
 Added Borrower's bank accounts fields in the automatic import
 Bulk import of file attachments for Borrowers and Records (based on a unique identifier)
 Payment schedule templates 23, 24 and 24 in Document Merge
 Import of new payments in the Payment schedule in bulk via an Excel sheet

o In order to quickly find import errors, sorting by "Message" column is now possible
o When there are more than 15 lines in an import, button "Find next red issue"

 Choose Record color directly in the Record with the right mouse click (as opposed to only through the Main window)
 Social Insurance Number, Record and Record number can be unique
 Possibility to add a mandatory SIN format during import via Excel
 Added the "Bad Debt" field in Global changes
 Credit Report:

o Allows adding the Date of first delinquency when the Consumer indicator is other than empty
o Added in Global changes: "Report on the same Borrower (Consumer) as that of the current Record"

 New Report field: Original final balance entered in the Data window when creating the Record
 Pre-authorized payments:

o VoPay (Canada): Windows Scheduled tasks (Margill Overnight tasks) "argument" to enable only preliminary
validation of payments

o For NACHA files (electronic debits in the United States), added "filler" lines for files with less than 10 lines
 Variable interest rates: Option to include a negative spread for import via Excel
 Record List (personalized): Subtotals by Borrower ID and Unique ID 1 and 2 in order to be able to sort by first name,

last name, company.
 Correction in the sending of emails in bulk via Main window by SMTP (corrected in the January version)
 Complex participation loan module:

o Delete multiple transactions in bulk
o Enter multiple uniform payments in bulk
o Enter Line Comment

 Various fixes to the previous 5.5 version

--------

Version 5.5.221104.1

Released November 4, 2022

What's new:

 Variable interest rate module:
o Payment  schedule  can  now  be  linked  to  an  Interest  rate  table  and  updated  as  new  rates  are  entered  in

Margill
 Rates can follow all Rate table changes, or
 Rates can follow set dates at set frequencies (every x months)

o Option to enter new interest rates in bulk via Excel sheet
o Mass change from old variable interest rate method to new high-performance method via Global changes 

 E-signature in the Document Merge - in partnership with Xodo Sign (subscription with XoDo Sign / formerly Eversign)
 Electronic Funds Transfer (EFT) integrated into Margill, new provider in Canada: VoPay
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o Includes  e-Transfers  in  order  to  credit  the  loan  amount  to  the  Borrower  instantly  (service  contract  with
VoPay)

o Preliminary banking data error analysis
 New Line statuses:

o Interest paid (3 new) with names that can be personalized
o Principal paid (3 new) with names that can be personalized

 For "Due Pmt" Line statuses the "Expected Pmt" may be forced to must = 0
 Email and SMS

o Main window - option to send an email to the Guarantors (bcc) and by SMS
o Document Merge - option to send email to Co-borrowers (cc) and to Guarantors (bcc)

 Accounting  (GL)  Report  -  participation  loan  data  extraction  based  on  Creditor  participation  as  an  amount  (as
opposed to participation percentage only)

 User rights:
o Option that allows user access only to some Record Types

 Main window:
o "Unmanaged  Records"  tab  appears  in  red  (more  like  pink  actually)  if  there  are  unmanaged  Records  (so

Payment schedule lines still in "Due Pmt" as opposed to Paid / Unpaid / etc. when past current date)
o Critical (red) system Warning now flashes slowly to better warn users of critical fixes required 

 IMPORTANT  for  the  Mathematical  Equations:  for  Monetary  results,  change  of  method  from  up  to  six  (6)  decimal
places to the monetary method of only two (2) decimals. Instead of rounding the amount up or down to two decimal
places, the 3rd decimal is truncated since fractions of pennies cannot exist. This may affect the results if you compare
an Equation result in 5.4 (or earlier) with the same calculation in version 5.5. The difference could be a penny.

 Send invoices or statements (Documents Merge module) via the Alerts window. For example, alert created 30 days
before next Due Pmt. User can select these Records and send invoices in seconds

 New automatic import field - Line Behavior (payment amount automatically recalculated)
o Interest-only and Fixed Principal - Option 1 only

 Advanced queries (for report production) - Compounding frequency added as a query field
 In a Record window header, option to add the Record Type
 In the Master and Affiliate loans module (in EFT), option to only see Records for the active Borrower 
 "Do not show again" checkbox added in the error message when "Due Pmt" or "Additional principal" Line statuses

are at 0.00
 Payment schedule button name changed to Payment Schedule
 Various corrections for version 5.4

--------
Version 5.4

Version 5.4.2209XX.1

Released September X, 2022

 Document Merge:
o New Payment schedule templates 19, 20, 21

 Various fixes

--------

Version 5.4.220830.1

Released August 30, 2022

 Document Merge:
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o New Payment schedule template 18
o Email and SMS templates - Custom fields added to the merge fields available

 Automatic reports production - in Excel format, ISO type date format option (YYYYMMDD) or other without the / or -
between year, month and day. This allows the import of data when the importing system only accepts an ISO date
(such as Margill with third-party software imports or from Margill itself to update data in other loans)

 Change Payments dates for multiple loans at once (in bulk) via the Post Payment tool
 New field in the reports (and elsewhere): Date of change to "Closed" Record Status
 New variables to extract the last Paid payment which is more than five (5) days before the current date in order to

obtain, with near certainty, that this payment has really been paid and will not be refused by the bank (especially for
collection by electronic payments):

o Last Paid Payment (>5 days of current date) - Date
o Last Paid Payment (>5 days of current date) - Amount
o Last Paid Payment (>5 days of current date) - Balance
o Last Paid Payment (>5 days of current date) - Line status

 In the Master and Affiliate loans module (in EFT), Record Type added and now possible to sort be other fields in the
table

--------

Version 5.4.220622.1

Released June 22, 2022

 Alerts : 
o Option allowing User type users to view, modify and delete all Alerts (Note: Administrator and Power type

users had access to these alerts automatically. Now this right must be specifically granted).
--------

Version 5.4.220601.1

Released June 1, 2022

 Added fields for reports and other:
o Borrower: First name and Last name in a single field (concatenated)
o Methods used for Interest-only payment (1 or 2) or Fixed principal payment (1, 2 or 3) when "Due Pmt" lines

include  the  automatic  payment  recalculation  with  the  "Line  Behavior"  option  (2  fields).  Mainly  used  to
ensure that loans all follow the same method

 Fixed: Interest-only or Fixed principal payment amount calculated automatically with the "Line Behavior" when the
Column Fee method was based on the pure Principal balance and the number of days

 Document Merge: CA bank account data added in merge fields (fix)

--------
Version 5.4.220519.1

Released May 19, 2022

 Fixed in the EFT module: Line status "Due Pmt" was not changed to "Paid Pmt" (only the Paid Pmt, not the other Paid
Pmt (X))

--------
Version 5.4.220407.1

Released May 12, 2022
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What's new:

 Added Payment schedule template 17 in Document Merge (exactly template 10 but based on the user's date format)
 Correction of the date format in Statements to Creditors
 Various minor adjustments 

--------
Version 5.4.220407.1

Released April 7, 2022

What's new:

 Import new loans via Excel: for Simple interest capitalized loans, the date of first capitalization can be inserted and
used to create the Record

 New payment import:
o Added "Interest Charged" 1 and 2 Line status
o If  the same date already exists  in  the  payment  schedule,  option  to  insert  a  new transaction on  the  same

date after the existing line instead of before (default method)
o Sort the import analysis by the rejection reason column

--------

Version 5.4.220314.1

Released March 14, 2022

What's new:

 Transactional report - new report date options:
o Report based on “Pmt date”, ignoring “True Payment Date (Grace/ EFT)” if a date is included in the column
o Report based on “True Payment Date (Grace/ EFT)”

 Ctrl  Alt  Shift  F12 shortcut in  the Payment schedule now allows to change the selected "Due Pmt"  Line  statuses to
“Unpaid”

 Semi-monthly payments  can  now be added in  the  Payment  schedule  at  other  dates  than  the  1st  and  15th  of  the
month

 Elimination  of  the  constraint  to  force  the  payment  to  zero  (0.00)  on  the  Other  1  to  9  Line  statuses  in  the  new
payment import module. This adds flexibility.

 Fixed  automatic  recalculation  of  Interest-only  or  Fixed  Principal  payment  amounts  when  other  Line  statuses  are
added upstream. Only affected Simple interest calculations.

--------
Version 5.4.220226.1

Released February 26, 2022

What's new:

 Multi-factor authentication (MFA) for connection to the software
 New Right click in the Payment schedule will now export to Excel only the columns that are displayed and will reflect

the column order
 Various fixes to previous version 5.4 (including FolioMedian's SMS service configuration)

--------
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Version 5.4.220214.1

Released February 14, 2022

What's new:

 New  sub-version  update  message:  When  a  minor  update  is  available  a  message  will  be  given  stating  the  current
version  and  date  as  well  as  the  new  version  available  and  date.  Message  will  also  state  whether  this  is  a  critical
update or not.

--------
Version 5.4.220210.1

Released February 10, 2022

What's new:

 Important fix: "Expected Pmt" column when payment recomputation to give balance = 0 or X was made (Expected
payments were reset in all lines above)

--------
Version 5.4.220204.1

Released February 4, 2022

What's new:

 Filters in the Main Window
o New Color filters
o Option to rename Color to a more descriptive name (color label) such as Urgent for red, etc.

 Color names (label) available in reports
o New "Select all" option to easily exclude choices (deselection instead of selection which can be long when a

menu has several choices) 
 New  transactions  import  via  an  Excel  sheet:  possible  import  of  up  to  9.9  billion  instead  of  999.9  million  in  the  3

information columns (numerical) of the Payment schedule
 Fixed the erroneous 5.3 New version update notice

--------
Version 5.4

Version 5.4.220127.1

Released January 27, 2022

What’s new:

 Automatic Import and Update of Borrowers and Loans via an Excel or JSON file
 Automated Import of new Transactions to the Payment schedule (via Excel file)
 Payments  (principal,  interest,  fees,  etc.)  automatically  recomputed  to  give  a  final  balance  =  0.00  or  X  (after  an

interest rate change or other upstream transactions). This is a new "Line Behavior"
 Accounting entry report - option to extract the Participation of each of the creditors (%)
 Master and Affiliated Records - EFT - automatic update of "Affiliate" loans from "Due Pmt" to "Paid Pmt" (or other)

when "Master" loan is updated via EFT (Perceptech)
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 Automated "overnight" (produced any time in fact) Reports: new option to send the documents produced by Email. 
 Salesforce (API) (Beta in 5.4)

o Option to update only data for existing Borrowers in Margill (as opposed to all Salesforce data)
o Option to include up to five (5) Salesforce Conditions (in order to obtain only a subset of Salesforce data) 

 Sub-creditor module (Participation loan)(advanced feature)
 Sensitive data module
 In Advanced queries, new option to include Records with upcoming payments for next week, next month, etc. This

allows, among other things, to easily select the Records to send invoices to (Document merge)
 Two  (2)  additional  Column  fees  (Column  fee  5  and  6)  including  the  47  new  corresponding  variables  (totals,  paid

amounts, etc.)
 Alerts:

o Send  alerts  to  Borrowers  via  SMS  without  the  need  to  use  Email-to-SMS  method.  In  collaboration  with
FolioMedian (subscription basis)

o Send SMS via the Main MLM window
o Record  Alerts  -  new  option  that  allows  sending  Emails  from  a  template  to  the  Borrower(s),  the

Co-Borrower(s) and/or to another Email address (such as a Margill user, for example, for internal alerts)
 New custom Record Statuses (as opposed to only Active, Closed, etc.)   
 Advanced Mathematical Equations using "IF" and other special conditions
 Full database search engine (Beta in 5.4)
 Multi currency module: can now be updated with an Excel sheet
 Notes: default font size increased to 9 pts (from 7 pts that was too small) and preferred font size memorized
 Security: Maximum of five (5) password attempts to access the software (present in some recent versions of 5.3 as

well)
 Improved Undo function and activity Logs improved in the Payment schedule
 Option never to display the "What's New" window (was an irritant in certain situations)
 Various corrections from version 5.3

--------

Version 5.3

Version 5.3.220113.1

Released January 13, 2022

Corrections :

 When creating a  Payment schedule with irregular payments up  to  a  specific  date  and  using  an  interest  table  with
unchanged rates between dates in the table, rate changes could be shifted. This has been fixed (exceptional situation
rarely used)

 Other adjustments with variable interest rates (rate insertions and additions at the end of the Calendar)

--------

Version 5.3.21206.1

Released December 6, 2021

What's new and corrections :

 Option to delete many Borrowers in bulk (as opposed to one by one) if the Borrower does not have any Loans
 For EFT payments (ACH) for the US (via NACHA file):
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o Option to exclude some "Due Pmt" Line statuses when submitting the payments to your bank
o Option to automatically update "Due Pmt" to "Paid Pmt" (as renamed) taking into account the precise Line

status
 Fixed this issue in the Main window: "Dashboard" was no longer displaying when MLM was moved to another screen

(multi screen)

--------
Version 5.3.21119.1

Released November 19, 2021

Corrections:

 Document Merge - short merge code for Equations had been deactivated (fixed on Nov. 2, 2021) 
 Correction in the EFT module for the "Include the description of the rejection..." option which could not be checked

(error had been introduced earlier in 2021) 

--------
Version 5.3.211028.1

Released October 28, 2021

Corrections:

 When sending emails via Gmail (OAut) in version 5.2, emails to Co-Borrowers were changed from Blind carbon copy
(bcc) to Carbon copy (cc). In this version we have restored the bcc.

--------
Version 5.3.210922.1

Released September 22, 2021

What’s new:

 Bulk data import of banking data (bank accounts for EFT)
 Various corrections from previous version

--------
Version 5.3.210602.1

Released June 2, 2021

What’s new:

 For Creditor participation as a percentage, addition of 2 decimals (total of 8) for increased precision in Equations
 In Mathematical Equations, calculations using 8 decimals instead of 4 for increased precision

o NOTE:  In  some  situations,  some  results  for  existing  Equations  could  be  slightly  affected  because  of  this
additional precision

 Personalized Standard Fields: Administrator can customize the names of certain standard fields and gray out fields
for them not to be used (Record identifiers in Data > General and four Borrower fields)

 Custom fields with scroll menus: option that allows the change the presentation order of the scroll data content
 In Document merge, new payment table 14 template (for DOCX)
 Correction of the Outstanding amount (fraction of a cent in some situations)
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--------
Version 5.3.210520.1

Released May 20, 2021

What’s new:

 Automatic import and update of the Borrower’s data via Excel or JSON – with a Windows service.
 Automatic import/export of Salesforce data via a Windows service and Overnight tasks, so no more manual process

when the tool was in Beta mode in version 5.2
 USA – Create a NACHA file for preauthorized payments (EFT / ACH)
 ACH payments (Canada)

o Cannot submit an ACH payment if the balance is negative at the time or submitting the payment or if  the
payment leads to a negative balance

 Last  payment  calculated  even  if  the  Payment  amount  is  entered  (to  yield  a  0.00  or  X  final  balance)(before  all
payments were the same amount, no matter the final balance)

 Automatic fees based on Record Type or a Custom field scroll menu
 Column fees can now be imported with the Bulk payment import tool via Excel file
 Record List report:

o Subtotals and sorting based on report fields
 Administrator can rename certain fields and grey them out in order to prevent them from being filled in:

o Data window > General tab
 File, File number (Numerical), Date, Accounting ID, Unique ID 1, Unique ID 2

o Borrower window
 Social Sec., Birth Date, Unique ID 1, Unique ID 2

 Mandatory fields not required for Records in Draft mode
 The ADMIN user exclusively can activate additional security and privacy measures:

o Activity logs saved in text format
o Increased data protection (ban on bulk copying and exporting, ban on capturing images of the data)
o ADMIN password can be modified by ADMIN user only
o Can give or withdraw the rights for other administrators to change passwords
o Can give or withdraw the rights for other users to import Records/Borrowers/Employers/Creditor via Excel
o Can give or withdraw the rights for other users to import and update bulk data:

 “Post Payment” tool
 “Bulk Payment Import” in Tools > Post Payments
 “Import / update data in bulk in the Record Summary (Tools > Various)
 Change interest rate in bulk

o Option prohibiting users to access Internet from Margill
 New logs of changes and extraction to a JSON file to be retrieved by a third-party activity management system:

o Loan activities
o User management (new log)
o "Overnight" tasks and reports
o Activity reports (new log)
o User activity sessions (new log)

 In  the  "Data"  window,  when  creating  a  loan,  advanced  option  to  specify,  for  interest-only  or  fixed-principal
payments,  that  the payment amount  must  be  recalculated automatically  based on  the  previous transactions (Line
behavior)

 Advanced queries (for reports):
o Currency added to query options (if multi-currency module is activated)

 2 new variables:
o Last Unpaid payment – Amount
o Last Unpaid payment – Date
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 Elimination of the “Special events” report but it remains available under Custom reports (password required)

--------

Version 5.2

Version 5.2.210408.1

Released on April 8, 2021

What’s new:

 Additional fields for reports
o Next Due Pmt (Line status = Next Due Pmt)(Entire loan)

 Correction of the Term and Amortization variables in certain situations (corrected in March version)

--------

Version 5.2.2101xx.1

Released February 17, 2021

What’s new:

 Notes  extraction  in  PDF  format  (as  opposed  to  RTF  which  made  a  partial  extraction  only  –  excluded  images  for
example)

 Correction  of  various  irritants  in  the  Statements  to  Creditors/Investors  (adjustable  column  width,  name  of  merge
codes, etc.)

 Document Merge with Euro currency – correction in the formatting
 Interest rate tables now with 6 decimals

--------

Version 5.2.201214.1

Released December 14, 2020

What’s new:

 Improvement of the visual “Dashboard” in the Main window: much faster data loading and window can remain open
while working normally with the software

 Correction of the MLM software update tool in previous versions: some files had to be removed manually

----------------

Version 5.2.201201.1

Released December 1, 2020

What's new:

 Main window visual "Dashboard" using widgets
 Automatically  produce  the  "Record  List"  (Customized)  report  or  "Transaction"  report  (every  day,  every  week,  as

required) with Overnight tasks.
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 Salesforce (CRM) integration (Beta mode):
o Export various data from Margill (balances, outstanding amounts, next due payment date and amount, etc.)

to Salesforce
o Import data from Salesforce to Margill via API

 Column fees based on the pure Principal balance as well as number of days (calculated using a very similar method
as Simple interest)

 Batch email sending via Main window: Send payment schedule (PDF) to Borrowers
 Record (loan) and Borrower Notes are now time stamped and by user. Cannot be changed after 24 hours.
 Record Notes can now be extracted in one operation
 "Payment" amount for "Other" 1 to 10 Line statuses can be set on a compulsory basis to 0.00 (Admin's decision)(to

allow  the  entry  of  data  in  other  columns  of  the  payment  schedule  without  the  risk  that  a  Payment  amount  be
entered by accident)

 "Expected Pmt" column can be set on a compulsory basis  to 0.00 (Admin's decision) for  Due Pmts,  Paid  Pmts  and
Unpaid Pmts. Simplifies the calculation of the Outstanding payment amount. 

 Email sent via "OAut" more secure method (particularly for Gmail)(as opposed to SMTP)
 Global changes for Borrower - import data via Excel sheet
 Important improvement in the Column fees default settings and in their insertion via the right mouse click
 User Management:

o Administrator can decide that a "Strong" password is required for all users
o Administrator can decide that a user does not have the right to create a new Record

 In Alerts, right click of the mouse to open the Record
 Mathematical Equations: a variable can now be multiplied by a negative number
 Advanced Queries: option to sort data based on various fields
 Custom fields setup: import scroll menu data via Excel spreadsheet
 All database files are now encrypted
 Elimination of 001, 002 files when software updates are done (so database takes up less space)

--------

Version 5.1

Version 5.1.201030.1

Released October 30, 2020

What's new:

 Social security number now in the reports for the 9 Co-borrowers

--------

Version 5.1.201015.1

Released October 15, 2020

What's new:

 EFT (Canada)  - considerable improvement in the time required to submit EFT payments (no longer
recomputes the APR thus saving time)

--------
Version 5.1.200715.1
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Released July 15, 2020

What's new:

 Bulk  data  import  /  update  in  the  Payment  schedule  of  Payment  amount,  Column  fees,  Custom  Columns  (9)  and
Comment for Due Payments

 Post payment tool (Import new payments via Excel):
o Data in the 3 Monetary Custom columns can now be imported
o “Other” Line statuses can now be imported (with compulsory Payment of 0.00)

 Email mass sending test tool
 Fixed loan import via Excel sheet to include variable interest rate table
 Added version 13 of the Payment schedule for Merged documents

--------

Version 5.1.200528.1

Released May 28, 2020

What's new:

 "Anniversary" capitalization date in Simple interest capitalized at a date other that the Origination date
 User  cannot  change  Record  Status  (for  example,  only  one  designated  user  could  change  a  Record  from  Draft  to

Active or some other Status - part of Workflow)
 Line  statuses:  Hide  obsolete  Line  statuses  from  the  Payment  schedule  menu  even  if  they  are  still  used  in  older

Records for example
 Transaction (payment) import in bulk via Excel 

o "Expected Pmt" data (spreadsheet column L)
o Allowed to import new payments via Excel (Bulk Payment import) with "True Payment Date Grace / EFT"

after the last date of the payment schedule

--------

Version 5.1.200404.1

Released April 4, 2020

What's new:

 Creditor Email field - now 200 spaces (was 75 before) so that multiple emails may be entered in the field (separated
by semicolon ";", no spaces)

 In Mathematical equations, it is now allowed to multiply by a negative number 
 Social Security Number (SSN) field for Guarantors now available in Reports 
 When  sending  emails  (document  merge,  automatic  emails),  multiple  email  addresses  can  be  added  to  receive  a

carbon copy (cc). CC emails must be separated by a semicolon “;” and no space between each email (260 spaces)

--------

Version 5.1.200325.1

Released March 23, 2020

What's new:
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 Read-only users with the right to produce reports can now also create report templates
 Grace date (entered in column) may be after the date of the last line of the payment schedule
 Tool to change the interest rate between two dates (set them to 0% for example) for multiple loans at once in order

to allow an interest holiday (relief) to be given to borrowers (and deferral of payments during the COVID 19 crisis)
 Payment update tool:

o Nine  (9)  complementary  information  columns  of  the  payment  schedule  now  added  so  that  data  can  be
posted in these directly with the Post payment tool

o New column displaying the last date of the payment schedule (amount > 0.00)
 Option to hide or display the "Term" and the default "Due Pmt" Record's Data window

--------
Version 5.1.200210.1

Released February 10, 2020

What's new:

 Refund order by type of money (Fees, Interest, Principal):
o Column Fees 2, 3, 4 can be paid according to a priority other than the normal refund order: Fees 1, followed

by Fees 2 and so forth...
o Pure accounting principal can be paid without being paid along with the APR Fees Financed on a pro-rated

basis
o APR Fees Financed can be paid before pure accounting principal

 Column Fees added automatically when a payment is made by borrower after an allowed number of days late
 Document Merge:

o Option to include only Records that have at least one transaction during the reporting period. You can also
view Records and transactions included before producing the report

 Option to specify the default “Due Pmt” type (Due Pmt 1 to 5) when creating the payment schedule
 Payment schedule: 

o Option to change “Due Pmt” Line status to any of the 1 to 20 “Paid Pmt” via the shortcut “Ctrl Alt Shift F12”
o Option to change lines from one of the “Due Pmt” Line statuses to another “Due Pmt” type (“Due Pmt 2-5”)

via the shortcut “Ctrl Alt Shift F11”
o Select (highlight) “Due Pmt” Line statuses of your choice via the shortcut “Alt X”

 New reporting fields and for the Main window:
o Four fields used to obtain at current date or at Date X, the amount that is really past due (including fees,

interest, principal and others) and required for the Borrower to be up to date in his payments:
 Amount due at Current Date (final balance = 0.00)
 Amount due at Current Date (final balance = original balance or new balance entered)
 Amount due report End Date (final balance = 0.00)
 Amount due report End Date (final balance = original balance or new balance entered)

o Creditor – Total participation (Amount) of all Creditors in the Record
o Tally (count) of number of various Line statuses (for example, number of “Unpaid Pmt”).

 New system to show warnings (potential errors) depending on the severity level: red, orange and yellow in the Main

window ( )
 Improvement of the interest-only payment amount calculation tool in complex and specific situations
 15 new Record colors in the Main window (+ button)
 Column Fees now allowed on the “Principal Paid” Line status
 Sum in Main Window of whole number type Custom fields
 For larger databases, option in the Main Window that does not refresh the data when closing a Record (a time saver)
 Optimization of the payment recomputation tool to yield a balance = 0.00 or X in the Payment schedule
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Optional additional modules:

 Irregular participation loans / investments: Investor / Fund module allowing multiple investors or funds to invest in a
loan and divest in whole or in part at various times (or reallocation to another fund). Module calculates interest due
and principal balances at any time taking into account the investment dates and partial or full divestments.

 For  large  databases  (minimum 5000  loans)  option  to  Archive  Records.  These  Records  are  then  removed  from  the
usual database and can no longer be modified or be included in reports.

--------

Version 5.0

Version 5.0.1.191213.1

Released December 13, 2019

What's new:

 Two new fields for Document Merge:
o Interest rate in text (in capital letters, text rounded to two decimal points)
o Total loan interest (in capital letters)

 Margill User name is now stored by computer
 Option not to refresh the data in the Main window (for larger databases or networks that are a little slow)
 Merged documents - preferred suffix for file names remembered
 With the launch of Credit Manager 5 (report to credit agencies - Metro 2) update of the Vendor Template
 Correction  of  the  payment  amount  calculated  automatically  with  the  Interest-only  and  Fixed  principal  labels  in

special situations (when interest paid in advance in previous lines for example)

--------

Version 5.0.1.191111.1

Released November 11, 2019

What's new:

 15 new Record colors in the Main window
 Quick  links  in  the  Main  window  to  launch  a  website,  a  document  (PDF,  Word,  Excel,  etc.)  and  even  third-party

software. Not available in SAAS version (Cloud service)
 Correction of some exceptions in the Merged documents (Payment schedules added to a Merged document)
 Correction of date problem (depending on format) when sending automatic emails

--------

Version 5.0.1.191022.1

Released October 22, 2019

What's new:

 Global database changes - bulk data import via spreadsheet (Excel) for Record data
 Option to hide totals displayed in the Main window (bottom of each column and summary)
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 Electronic Funds Transfers:
o Two new "Due Pmt" Line statuses
o Option not to submit some "Due pmt" to EFT provider
o Option  to  automatically  change  to  an  Unpaid-type  Line  status  based  on  the  Paid-type  Line  status  -  thus

allowing, for example, not to charge automatic fees on certain Unpaid-type Line statuses
o Perceptech (Canada) - Reason for payment rejection added to Comment column in Payment schedule
o Perceptech (Canada) - Payment rejection date added to Payment schedule (existing column called "Date of

returned Check" - and renamed to "Date of returned Check/EFT") allowing you to create payment rejection
date reports with the Transaction report

 Document merge tool:
o Improved wording for the "Principal (Original) - Text" merge field
o This same field can now be added in all CAPITAL letters

 Option to send emails with templates in bulk from the Alerts window
 Correction of the automatic email test based on Line status
 Fixed possible issue when saving merged documents indicating that the specified path cannot be found

-------- 

Version 5.0190916.1

Released September 16, 2019

What's new:

 Default column display and order configuration for the Payment schedule
 Emails  sent  in  bulk  will  now  have  the  Co-borrower  in  "Carbon  copy"  (cc)  versus  "Blind  carbon  copy"  (bcc)(in  first

release of version 5.0) in order for the Margill user to see all emails sent.

-------- 

Version 5.0190905.1

Released September 5, 2019

What's new:

 Modernized look and feel, keeping the same navigation you are used to
 Graphics optimization for very high definition monitors (4K)
 Powerful Advanced queries module that can be used in most reports
 Main (Record Summary) window:

o Multiple Records can now be opened at once
o Fast Display mode for the Main window optimized and Custom fields can now be displayed
o Total at the bottom of each money/numerical column
o Improved sorting of names entered in CAPITAL letters versus small letters

 Payment schedule:
o Easier and quicker to hide/show/order columns in the Payment schedule (bottom right icon)
o When the "Returned checks" module is activated, now allowed to hide the corresponding columns
o Day of week shown when scrolling over the Pmt Date in Payment schedule

 Lead/Prospect approval and Record (loan) import via Excel or JSON (mostly used for Web loan applications)
 User customized Creditor reports (statements and others)
 First  Payment  Date  initially  entered  can  now  be  changed  and  line  deleted  (only  for  new  loans  created  as  of  this

version, 5.0)
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 First Payment Date can now automatically be entered as one period after the Origination Date (Data window - press
on  to the right of the Origination Date)

 Column Fees:
o New "Column Fees" added (total 4 Column Fees)
o Automatic Column fees based on the percentage of paid payment amount (for example, for payments that

are simply 3 or more days late, charge 8% of the payment amount)
 For some irregular calculations: Effective Rate Method calculation improvements - for new loans only. Old loans are

not updated to the new method
 Improved refund order for new calculations only (existing calculations maintain the pre-version 5.0 order)
 Short  period  special  calculation  method  (Advanced  calculation  settings):  In  version  5.0  we  have  limited  the  short

method impact  to  the  short  period at  start  of  loan.  When new short  periods  are  inserted  in  the  regular  payment
schedule,  the  normal  method  will  apply.  Users  can  always  manually  designate  a  special  short  period  calculation
method for any line(s) with the right mouse click.

o If a line is inserted between Simple capitalized lines (blue interest rate), inserted line will be Simple interest
(green interest rate) so as not to capitalize if not desired. This can be changed manually to capitalized line
that was inserted.

 New  powerful  behind-the-scenes  report  generation  "black  box"  for  improved  report  production  speeds  and
harmonized results throughout the reports

 Sending batch or individual emails with templates:
1. when loans are imported in batch via spreadsheet
2. in the Main window (right mouse click)
3. individually in the Record as such

o Added: "Last Paid/Unpaid Payment (only Paid and Unpaid Line statuses)(in period) - Expected Pmt Amount" 
(code 814.1) for automatic emails

 New Line statuses
o Paid Principal (pays only accounting principal)
o Compensatory payment (name may be changed, Expected pmt = 0.00)
o "Information - No impact" Line status that, even in special calculations, has no impact on any number when

inserted (exception being 30/360 Day count in very special situations)
 New reporting fields:

o Date of the first negative payment in a Payment schedule
o Amount of the first negative payment
o Balance at the first negative payment date
o Line status for the first negative payment
o Employer data (added to the Borrower theme - very end of section)
o Internal Rate of Return (IRR)

 For "Record List with period breaks" (Customized), new fields added that can be split by sub period:
o 14 fields including Ageing fields, balances at 0:00, year-to-date fields

 Spreadsheet application now available directly in these reports: "Record List" (Personalized), "Record List with Period
Breaks", "Transaction Report and Accounting Entries "

 Creditor  (or  Investor)  participation  in  loans  -  total  participation  amount  and  total  participation  percentage  now
added in table

 Interest rates in variable Interest tables now can include up to six (6) decimal places
 Document Merge:

o User  can  now  partially  adjust  Detailed  Line  templates  (Payment  Schedules  -  templates  1  to  11):  header
names, column width and portrait/landscape layout can be edited

o New template 11 for the Payment schedule in the Document Merge module 
o Merge fields by theme now on the right
o Elimination of the old RTF document merge interface in order to incite users to use the new interface. The

old interface remains accessible with Ctrl+Alt+Shift+R
o Template owners or creators added to prevent another user from modifying another user's templates

 Borrower Email field: now allowed to enter up to 175 characters (to enter numerous emails)
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 When saving a Record, optional elimination of the pop-up asking whether to update or create a new Record
 Basic Tutorial from the Main Window - it can even be partially adapted by you to train your new users
 Harmonization of reporting fields:

o "Interest accrued from the last Paid/Unpaid Payment" type fields:
 Modification of merge fields 721 and 727 so they are harmonized with other similar fields:

 If the payment is after the report end date, the result is 0.00 (did not give 0.00 before) 
 Modification of the descriptions of many of these fields in order to better describe their behavior

o Balance at 0:00 type fields (thus before the day's transaction):
 Modification of the fields Principal Balance, True Balance, Computational Balance (412, 705, 833 et

4900, 7900, 8900) to include the logical exception in which a user does not differentiate between
an Original Principal and "Additional Principal" type Line statuses when this "Add. Princ." is entered
on the Origination date.  Both are thus deemed inserted at  0:00,  not  at  0:00+. This exception did
not exist before version 5.0

 For the three variables Outstanding at the Report start date (thus at 0:00)(variables 415, 420, 424),
the balance reported is that before payments that would have reduced the outstanding amount.
Before version 4.5, the balance was that after the day's transactions (thus 0:00+, not 0:00)

o Principal,  whether  included  as  Original  Principal  or  as  any  of  the  "Additional  principal"  Line  statuses
specifically added at  the Origination Date,  will  now generate the same amounts for  these reporting fields
(RTF codes 412, 705, 822, 823, 833, 4900, 7900)(management of exceptions)

o Variables 707 and 708 "Balance updated for Interest Due" eliminated from version 5.0
 Minor correction of the interest on outstanding amount when interest is capitalized
 Correction in the Accounting entries report of the variables APR - Fees 4 and 5 which did not take into account the

transaction date
o Variable must be deleted from report and reselected

 Database Reindexation now in Overnight tasks

-------- 

Version 4.4

Version 4.4.190501.1

Released May 1, 2019 

What's new:

 New option that allows the user, before updating the software, to compare the difference between the current live
version with the update for these three essential components: total accrued interest, final balance and last payment
amount  (sometimes  referred  to  as  a  Sandbox).  Other  components  can  also  be  tested  before  updating  the  live
version.

 Graphics optimization for small, very high definition monitors (>1080p)
 Import of loans via spreadsheet:

o Twice monthly payments default payment date now used instead of  1st and 15th of month
o Improved mapping memory (will remember mapping even if spreadsheet columns are ignored)

-------- 
Version 4.4.190225.1

Released February 25, 2019 

What's new:

 New reporting field: "Next Due Pmt - Amount (all  same day)". This reports the total  due payment amount if  more
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than one "Due Pmt" type Line status is included at the same payment date
 "Add. Pmt" Line statuses can now be imported in bulk via Excel
 For many personalized reports, option that includes all Records selected even if the Record dates (Origination date

and loan end date) are not within the report start date and end date range 
 EFT payments activated with the Global changes (US and Canada)
 In  the EFT window (payments to be submitted),  number of  days specified in  the "True Pmt Date  (Grace/EFT)" can

now be greater than 9 days
 Borrower bank account data can be bulk imported with Global changes (feature available since March 2018 - but was

not included in "What's new")
 Minor language issue fixed

-------- 
Version 4.4.190118.1

Released January 18, 2019 

What's new:

 General Ledger report: correction of double reporting in very specific "Additional principal" Line status situations

-------- 

Version 4.4.190110.1

Released January 10, 2019

What's new:

 Record List customized:
o New option to include all selected Records even if Record is outside the chosen reporting dates (Record end

date is before Report start date or Record start date is after the Report end date)
 Document Merge module:

o Fix where in certain situations Equations with Line fees did not work properly (inversed negatives)
o New Detailed Lines template 10
o In the DOCX module new option to create PDF via Word

-------- 

Version 4.4.181214.1

Released December 14, 2018

What's new:

 Interest  Adjustment Date  option  now available  for  all  Payment  Methods (Data  tab)(was  only  available  for  Normal
(Principal and Interest) method in earlier 4.4 versions) 

 Automatic deletion of older backups (automatic overnight tasks)
 Borrower import via Excel - banking information can now be included for selected borrowers only

-------- 

Version 4.4.181031.1

Released October 31, 2018
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What's new:

 In printed Payment schedule, new Line statuses "Interest charged" taken out of the "Other increases" section (totals
at end of page) and Column fees added.

-------- 

Version 4.4.181025.1

Released October 25, 2018

What's new:

 Blocking of historical transaction changes by the Administrator of all Payment schedules for Active, Closed and
Archived Records as of a chosen date

 Document merge module: 
o For the DOCX report, a single file may now be created for the batch of Records as opposed to a separate file

for each
o When individual DOCX, RTF or PDF files are saved, choice of different identifiers in the file name (as opposed

to the single option using the MLM ID)
 Interest Adjustment Date can now be added at the start of a loan (usually for short periods between the Origination

date and the First payment date in a mortgage)
 Main (Record Summary) window:

o User may change the column heading names
 New Line status:

o  Due Pmt - Unpaid (for Due payments that the user knows will not be paid before their due date)
 New reporting fields:

o Balance Due Interest (at Current Date)
o New document merge Payment schedules (numbers 8 and 9)

 Twice monthly payments can not be set to desired, less usual, frequencies (2nd and 22nd day of the month, 5th and
24 day of the month, etc.)

 For EFT transmissions (Intrix and Perceptech), number of days to add to the "True Pmt Date (EFT/Grace)" (as well as
Saturday  and  Sunday  payments)  now  remembered.  Nevertheless,  the  user  must  Submit  the  request  at  each  EFT
transmission.

 Step  payments  percentage  increase  or  decrease  automatically  calculated  to  yield  a  balance  =  0  or  other  amount
(when lines are added at the end of a Payment schedule).

 Lines in a Payment schedule can now be assigned a special color (right mouse click)
 Loan import via Excel sheet:

o A Co-borrower and a Guarantor can now be added
o Column fees can now be 0.00 for some loans
o Other adjustments offering more import flexibility

 Copy of the payment amount to one of the extra information columns (with shortcut)
 Reset Expected Pmt to 0.00 for all "Add. Pmt" Line statuses (with shortcut)

-------- 

Version 4.4.180613.1

Released June 13, 2018

What's new:
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 Day count:
o The 30/360 Day count method used so far was temporarily taken out of version 4.4 (replaced by 30U/360)

and added back in this version 4.4
o 30U/360  Day  count  method  added.  This  method  adds  a  condition  for  February  28/29  end  of  month

payments. See Calculation methods > Day count
 EFT (US and Canada) payment selection window sorting now allowed with Borrower name and other columns
 EFT (Canada) module improved to reduce possibility of human error and operations tracking mechanism added

-------- 

Version 4.4.180320.1

Released March 20, 2018 (Beta released February 21, 2018)

What's new:

 Electronic Funds transfer (EFT):
o ACH payments for the United States with our partner Intrix
o With  Perceptech  (Canada),  import  and  update  rejected  payments  (changes  Paid  payments  to  Unpaid

payments along with the automatic fees if required)
o Automatically change the "Paid pmt" type based on the "Due Pmt" type (3 choices)
o New field which indicates if EFT is enabled or not (Yes / No) (“EFT enabled” under “General”). Useful in the

Main window allowing you to see which Records have not been submitted as EFT
o New field to identify the Perceptech account number
o To reduce the risk that upcoming EFT payments will be forgotten, Margill no longer allows users to submit

EFT transactions if the option “Access to your own Files” is checked
 Major evolution in the Document Merge tool:

o New sophisticated text editor to create Word documents (DOCX)(Beta mode for now)
o New Invoices and statements module to include data for multiple periods in one statement/invoice:

 Current (or upcoming payments) reporting period
 Previous reporting period
 Year-to-date to start of current reporting period
 Start of loan to start of current reporting period

 New Line statuses: 
o "Paid interest". Allows interest to be paid in advance without the need for there to be an interest balance

 "Balance Due Interest" can now become negative (minimum 0.00 in previous versions)
o “Interest  Charged”  and  “Interest  Charged  (2)",  which  can  be  renamed.  Allows  the  user  to  add  interest

without needing to increase the interest rate
o 10  new  Payment-type  lines  (Paid  Pmt  11x  to  20x).  These  payments  do  not  include  their  "Unpaid"

counterparts  and  only  include,  for  the  reports,  the  amounts  per  se.  The  reporting  fields  that  subdivide
Interest, Principal, Column fees and APR Fees financed portions are not included.

 The  MLM  Administrator  may  now  define  Mandatory  fields  so  they  must  be  filled  by  the  user  before  saving  the
Record, the Borrower, the Creditor and/or the Employer. Custom fields are also included

 Alerts module: 
o Automatic  emails  to  notify  Borrowers,  Co-Borrowers  and  /  or  other  e-mail  addresses  (blind  carbon  copy,

BCC) that a payment is due, late, unpaid, etc. (Line status-type Alerts)
o Data merge templates (subject and body message) for these automatic emails

 Post payment tool via Excel:
o New  option  that  allows  updating  Due  pmts  via  an  Excel  sheet  simply  with  one  of  the  Record's  unique

identifiers and the precise payment Date and Amount
 Creditor participation:

o Return  (in  percentage)  given  to  each  creditor  in  a  loan.  Can  then  be  used  in  Mathematical  Equations  to
report Creditor's monthly interest revenue share.
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 New reporting fields:
o Principal amount converted to words ("115" becomes "one hundred fifteen"). To be used in the templates

for the Document merge (Letters, Invoices and Statements).
o Last Paid payment (all Paid Line statuses)(in period) - Expected Pmt Amount
o Last Paid payment (all Paid Line statuses)(in period) - True Pmt Date (Grace)
o Last Paid/Unpaid payment (only Paid and Unpaid Line statuses)(in period) -  Expected Pmt Amount
o Last Paid/Unpaid payment (only Paid and Unpaid Line statuses)(in period) - True Pmt Date (Grace)

 Changes in the accounting Principal
o "Paid Principal" can now be greater than the Principal balance
o "Balance Due Principal" can now become negative (minimum 0.00 in previous versions)

 Accounting (GL report). New optional notes that accompany the transactions:
o Record, Borrower and Creditor Unique ID 1 and 2
o Record Type

 Find Unmanaged Records (those that remain as "Due Pmt" on the current date or x days before) directly in the Main
window

 Automatic / Overnight Tasks using Windows "Task scheduler" to compute the new balances in the Main window and
to generate Alerts - this saves considerable time when MLM is first run in the morning.

 Log  of  EFT  transactions  and  extra  confirmation  when  EFT  file  may  or  may  not  have  been  properly  received  by
Perceptech.

 Creditor First and Last names in Record window header (optional)
 New print interface offering more options
 Direct scan from the Attached documents module (Record and Borrower) - scan your documents at the touch of the

button
 Handy Calculator now added in the Payment schedule window

--------

Version 4.3

Versions 4.3.170201.4

Released October 6, 2017

What's new:

 New  and  highly  specialized  field  allowing  you  to  obtain  the  amount  of  capitalized  interest:  Line  status  Other  3
(Mathematical Principal column (for period) + 1 day) (see more in Reporting Fields – Principal section)

 Fixed the report fields “Interest accrued since last payment (paid or unpaid)”
 Fixed the report fields “Balance Column Fees (1 to 3) at end date”. Problem when there were no transactions in the

reporting period
 Changed  the  term  “Balance”  to  “For  period”  for  the  fields  that  report  the  “unpaid  portions”  of  the  expected

payment amount. These various fields (merge codes 704, 791 to 799, 800, 818, 828) do not show the balances at the
end of report period date but rather a periodic total, not a cumulative total. 

--------

Versions 4.3.170201.3

Released May 18, 2017

What's new:

 Posting payments through an Excel sheet (with unique line identifier) now allows for Grace date
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 Issue with Payment schedule column user preferences fixed
 Right mouse click menu in Payment schedule modified

--------
Version 4.3.170201.2

Released February 21, 2017

What's new:

 Read-only user can now be allowed (by Administrator) to post payments with any of these tools:
o Post payment module - Post payment tool
o Post payment module - Existing (Due) payment update through a spreadsheet
o Post payment module - New payment import through a spreadsheet

--------
Version 4.3.170201.1

Released February 1, 2017

What's new:

 New calculation method that can be used automatically: Simple interest capitalized
 In the Main window, display filters now allow to choose multiple data elements and multiple fields to display desired

Records (example : display Active and Draft Records)  
 Interest rate now computed with six (6) decimal places and displayed with 0 to 6 decimals.
 Nine (9) new columns (Custom Columns) that may be named as desired in the Payment schedule, allowing the entry

of  Monetary,  Numerical  or  Text  data.  This  is  useful  for  Escrow  (insurance  and  property  taxes)  by  allowing  the
Creditor to specify when he pays the insurance company and/or the city (Escrow Report).

o 18 new fields for various reports:
 Total amount entered in the Columns (by period) - Money and Numerical (6 fields)
 Total amount entered in the Columns from the Origination Date to the Report end date - Monetary

and Numerical (6 fields)
 Total amount entered in the Column Fees (1, 2 or 3) (Accrued)  from the Origination Date to the

Report end date (3 fields)
 Total  of  amounts entered in  the  Column Fees (1,2  or  3)  (Paid)   from the Origination Date  to  the

Report end date (3 fields)
o In the Transaction Report, transactions resulting from these new Columns

 Irregular Payments may be entered in a window before producing the Payment schedule
 Record List (Customized) report can now be divided by Year, Quarter and Month
 Record Alerts may now be created in the Alerts display module (under Tools)
 Alerts module: if multiple email addresses are included under the Borrower, email now sent to all of these in (carbon

copy)
 Automatic Column Fees are now available for the Line statuses "Paid Pmt 2" to "Paid Pmt 10"
 Automatic  Column  Fees  may  now  be  configured  to  generate  an  amount  of  0,00  (for  example,  tax  or  insurance

invoiced that becomes 0,00 if payment is unpaid)
 For pre-authorized payments (EFT) with Perceptech (Canada),  older unpaid payments (less than 173 days)  may be

submitted
 Unique Line ID for each line in a Payment schedule (available in the Transactions report and in the Accounting entries

report)
 In the new payments import via an Excel sheet, new options:

o Import  one  or  multiple  transaction  types  (Due  payment,  Paid  payment,  Additional  Principal,  Information
(Payment = 0.00), etc.) in one operation
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o Additional data imported in the Payment schedule columns:
 Line Comment, Check number, Grace date, Custom columns (3 text type columns)
 Import  of  fixed  principal  payments  without  first  needing  to  refund  all  accrued  and  outstanding

interest
 Payment update tool via an Excel sheet and Unique Line ID
 New reporting fields:

o "Payment Method" (entered in the Record's "Data" tab)
o Balance at 0:00 at report Start Date (excluding any transaction on that day and Principal (Original))
o Balance  computational  at  0:00  at  report  Start  Date  (excluding  any  transaction  on  that  day  and  Principal

(Original))
o Balance  Due  Principal  at  0:00  at  report  Start  Date  (excluding  any  transaction  on  that  day  and  Principal

(Original))
o APR - Balance Due Fees Financed at 0:00 at report Start Date (excluding these fees and any transaction on

that day)
o Active EFT Account Number for the Record

 78 new fields for  the PAID Principal,  Interest,  APR Fees Financed and Column Fees (3  types)  according to  "Payment"  type  Line
statuses now included in the Mathematical Equations

 Global changes to the database (batch changes) - new added fields for the Borrower
 In  the  pre-authorized  payments  (EFT)  submission  window,  new Column containing  the  Line  status  (Due  Pmt,  Due

Payment 1 or 2 - renamed)
 Printing the Payment schedule:

o When  the  Origination  date  is  before  the  current  date,  the  interest  rate  displayed  will  be  that  at  the
Origination date, not 0.00%

o New  option  allows  to  print  the  lines  contained  in  the  Payment  schedule  without  including  the  accrued
interest when annual or quarterly totals are requested

 In the Record window header:
o Choice  of  data  to  be  displayed  in  the  window  header  among:  Borrower  First  and  Last  names,  Borrower

Company, File number, etc.
o Display by Record Unique ID (1 and 2)

 Sort by Record Color in the Main window (with the Record Color field)
 Record import via an Excel sheet:

o "Fixed principal" method now allowed
o "Payments set to 0.00" now allowed

 Post payment tool:

o Font size can now be increased with 
 In the Data window, the "New Record" link renamed to "Modify/New Record".

--------
Version 4.2

Version 4.2.160627.1

Released June 27, 2016

Changes and improvements:

 Great increase in system speed
 Column Fees can now be added automatically taking into account special criteria (Unpaid payment, Late payment,

etc.). The Margill Administrator can create his/her own rules (fee amount or percentage).
 Major improvements in the Post-payment tool:

o Change "Due Pmt" not only to Paid or Unpaid but also to Late or Partial or both with the option to add Column Fees and
make other changes
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o Easily update Records by displaying not only "Due Pmts" but all payment types (Paid, Unpaid, etc.). Most useful when
multiple payments were posted as paid but had bounced afterwards.

o Display only those payments that the user wishes to update as opposed to system default. This can be done manually or
though an Excel sheet.

o Record Unique Identifier 1 and 2 as well as the Electronic Funds Transfer (EFT) Account Number now displayed in the
payments table.

o Special color assigned to a Record via this window

 Bulk Import of Payments (Due Pmt, Paid Pmt, Additional principal, etc.) via an Excel sheet in an existing Record.
 New tool to perform global changes in the database (batches changes) .  The following fields can now be modified

without having to open each Record or Borrower individually:
o Record:

 Record Status and Sub-status
 For example, it is now possible to change 136 Record statuses from Draft to Active

 Record Type
 Record Owner (was already available)
 Activation of Automatic Column Fees
 Add or remove Borrowers from credit reporting
 Currency
 File Number, File Number (Numerical), Record Date, Accounting ID, Unique Record IDs 1 and 2
 Credit Limit for a Record
 9 Custom fields
 Unlimited Custom fields

o Borrowers:
 Borrower Owner (was already available)
 Unique ID 1 and 2
 9 Custom fields
 Unlimited Custom fields
 Many more coming in future versions

 New Lines statuses: "Due Pmt (2)" and "Due Pmt (3)" (that can be renamed). For example, "Due Pmt - Cash"
 New reporting fields:

o 78 new fields for the PAID Principal, Interest, APR Fees Financed and Column Fees (3 types) according to "Payment" type
Line statuses:
 Paid Pmt
 Paid Pmt 2 to 10 (as renamed)(54 fields!)
 Paid Pmt Returned Check
 Add. Pmt
 Partial Pmt, Partial Late Pmt, Late Pmt

o 205 new fields to identify up to 9 Co-Borrowers and 9 Guarantors
o Balance Due Principal (at Current Date)
o APR - Balance Fees Financed (at Current Date)
o Record Creation Date
o Other 3 (Principal)(Line status)(for period)
o Template 6 for the Payment schedule (detailed lines) (Document merge) 

 Maximum credit by Borrower (for Active Records only) based on one of these four criteria:
o Total original Principal
o Total original Principal and all Additional Principal Line statuses
o True Balance (Principal, Interest, Fees, etc.) at the current date
o Balance of the Principal and the Fees Financed (APR) at the current date

 New option to add a Guarantor to a Loan
 Record Notes are now accessible and can be changed from the Alerts display module 
 Conditional Alerts can now be applied to future Active Records (in order to create particular data entry rules)
 Executive Summary report - option to exclude empty fields from the report
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 New special payment method, "Simple Interest" (and no longer only Simple Interest Capitalized), for specific
payment lines (usually for Short periods)

 Correction of some totals and balances in reports when special short methods are used in a payment schedule (mix
of simple interest capitalized and other lines compound interest payments) 

 Management of the zip/postal code and telephone number format import for the Borrowers (via Excel)
 Option allowing special Records to be highlighted by Color in the Main MLM window 
 Improved email connection settings for sending batch emails
 Records become "Read-only" when the Payment Update tool is used
 Display issues fixed when Windows display (size of text, apps, and other items) is at 125%, 150%, etc.

--------
Version 4.1

Version 4.1.150525.7

Released March 3, 2016

What's new:

 Four new fields that factor in the "True Pmt Date" (Grace/EFT)" as the date of transaction for the Record List
(Customized) and Document merge reports:

o Interest Paid (for period)(using Grace/EFT Date)
o Principal Paid (for period)(using Grace/EFT Date)
o Interest Paid - Year-to-date (from January 1 to report End Date)(using Grace/EFT Date)
o Principal Paid - Year-to-date (from January 1 to report End Date)(using Grace/EFT Date)

 The "Expected Pmt" column amount can now be changed for Line statuses "Other 1 to 10"
 

--------

Version 4.1.150525.6

Released October 29, 2015

Corrections:

 In the Accounting report (export to General Ledger) correction of the following variables to factor in the "True Pmt
Date  (Grace/EFT)"  when  a  payment  is  made.  Previously,  even  if  a  date  was  entered  in  the  "True  Pmt  Date
(Grace/EFT)" column, the Payment Date was used:

o Interest Paid (for period)
o Principal Paid (for period)
o APR - Fees Financed Paid (for period)(for all APR Fees Financed)
o The five (5) individually segmented "Paid Fees Financed (APR)"

 In the Accounting report (export to General Ledger):
o Correction of the three (3) "Paid Column Fees" variables. Now  report the "Payment Date" or the "True Pmt

Date (Grace/EFT)" as opposed to report end date.
o Various adjustments to the report.
o Warning no longer shows when the Grace date precedes the payment date.
o Warnings not related to the report's time period no longer show. 

--------

Version 4.1.150525.5
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Released September 21, 2015

Changes and improvements:

 Participation percentage of each of the Borrowers and Co-Borrowers
 New option to tag a Borrower as a "bad payer" (or other) in order for a warning to be given to the user if this person

or entity is  selected as a  Borrower or  as  a  Co-Borrower in  a  loan.  The warning message may be  adapted for  each
Borrower. For example: "Do not lend to this person."

 All loans are now saved as a text file that can be imported back into MLM in case of accidental deletion - voir avec
Mario quelle date car en 4.1, pas 4.2

--------

Version 4.1.150525.3

Released July 31, 2015

Changes and improvements:

 Import of multiple Records at once (regular payment schedule portion) from an Excel sheet (support is required from
the Margill team - fees are involved)

 Detailed report (Payment schedule) now with the option to include interest and transactions of the report end date
 New templates of the Payment schedule in the document merge report
 New fields:

o Computational Balance of the last Transaction (in period)
o Computational Balance of the last Paid/Unpaid payment (only Paid and Unpaid Line statuses)(in period)
o True Balance of the last Transaction (in period)

 Various fixes to version 4.1

--------
Version 4.1.150525.1

Released May 25, 2015

Changes and improvements:

 New report: Custom Executive Dashboard including amounts and number of Records by categories, averages and pie
chart

 New report:  Custom Transactions  report  by  Line  status,  data  from  Payment  schedule  columns  (payment  amount,
accrued interest, paid interest, fees, comment, check number, etc.) and option to include hundreds of other fields

 New module to manage returned Checks (NSF)
o New data columns in the Payment schedule:

 Check number
 Date of returned check
 Date at which the NSF check was compensated

 Search  now possible for most of the columns of the Post payment tool
 New fields:

o Interest rate at the report end date
o Interest rate at the current date
o Proportion,  as a  percentage, of  each the  Fees Financed (APR)  in  relation to  the  total  of  all  Fees Financed

(APR) 
o Paid Financed Fees (1 to 5)  (APR)(based on the proportion of  each to the total  of  the paid Financed Fees

(APR)
o Number of days of delinquency
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 Options  via  Tools  >  Users  allowing  the  Margill  Administrator  to  prohibit  certain  users  from  deleting  Records,
Borrowers, Creditors or Employers

 Multi-Creditor module:
o For  loans  with  multiple  Creditors,  possibility  of  extracting  Creditor  data  according  to  the  name  of  these

Creditors (as opposed to their position in the Creditor loan table – Creditor 1, 2, 3)
o Extraction of the following data:

 Company name
 Name and First Name (if Creditor is an individual)
 Participation in percentage
 Participation in currency
 Possibility of using Mathematical Equations to extract hundreds of other data elements. 

 Search tool for loans from the Main window now allows a search using multiple criteria. For example, First Name
AND Family Name (or multiple other criteria)  can be used as opposed to a  search with only  one field  at  a  time in
version 4.0.

 Significant increase in the refresh time of Records in the Main window (Record Summary) with the new "Fast Search
Mode" (Tools > Settings > User Settings > Record Summary window). Particularly useful for the larger databases (over
1000 loans)

 In the printed Detailed Schedule will be displayed in the heading, the nominal and effective interest rates in effect,
either at the date at which the report is produced or at the end date of the report (if the loan is terminated at the
current  date  or  if  the  report  is  produced  up  to  this  date).  In  the  previous  versions,  the  rate  was  that  originally
entered in the Data window. 

 Tool that extracts all the files Attached to the loans (Tools > Various)

 In the Main window and in the Results table, new icons  in order to enlarge or reduce the size of the text
(previously done by the "Ctrl Arrow up or down" shortcut)

 Correction of the refund sequence of Fees Financed (APR) for a particular scenario
 Adjustments to the credit reporting module
 Change in the APR calculation method when the balance is positive
 Files can now be attached directly in to a Record using the "Attach" button
 Unique identifiers for the Employer

--------
Version 4.0

Version 4.0.141212.1

Released December 12, 2014

Four most important developments:

1. Fees by column (offering a host of new powerful possibilities)
2. Documents merge now creating PDF documents that can be sent in bulk by email
3. APR module completely redone with new powerful fee options (for easy add-on interest calculations)
4. Search tool that displays, in the Main window, the desired Records based on various search criteria 

Changes and improvements (in detail):

 Fees  module  which  allows  the  user  to  add  fees,  insurance  or  taxes  in  column  format  as  opposed  to  lines  in  the
Payment  schedule.  These  fees  (or  other)  can  then  be  isolated  more  easily  from  an  accounting  perspective.  Up  to
three (3) types of fees can be added as column fees. Corresponding fields for the reports.

 Significant improvement of APR calculations (Annual Percentage Rate)
o Possibility of including financed, prepaid or  subsequently paid fees in the loan.
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o New columns in the Payment Schedule:
 Paid fees (when financed fees added in the APR tab)
 APR financed fees balance

o Corresponding fields for the reports.
 For the Document Merge tool (Letters, Contracts, Invoices and Statements):

o Export  and  print  in  PDF format  (direct  PDF  or  though  Word  2007  and  up  to  obtain  a  more  sophisticated
visual). 

o In one operation, it is now possible to:
 save as PDF or RTF
 print
 send the document(s) in batch by e-mail
 attach the document(s) to the Record

o For the Dates fields, new date format options (short, medium or long format) are now available
o New Payment schedules that can be integrated to the merged document:

 Summary format (2 columns with payment amount and date)

 Schedule  from  the  loan's  Origination  date  to  report  end  date  (even  if  the  report  start
start date is after the Origination date)

 Schedule  that  includes  PAID  (as  opposed  to  accrued)  interest,  principal,  fees  financed
(APR) and the 3 Column Fees, as well as the Principal balance

 In  the Main  window,  search tool  that  displays  the  desired Records based on  various  search criteria  related to  the
Borrower, Creditor or Record.

 In  the  the  accounting  report  (export  to  General  Ledger),  a  new  tab  displays  the  total  of  Debits  and  Credits  by
account.

 For Draft users, option that allows these users to enter Notes and to Attach files to all Records as opposed to only
Draft Records.

 Change  of  certain  terms  in  the  software  for  better  differentiation  between  interest  and  principal
Accrued/Mathematical vs Paid.

o "Interest" becomes "Accrued Interest"
o "Principal" becomes "Mathematical Principal"

 In the Payment schedule, the columns whose data may be changed are now indicated with an asterisk: *.
 Option in the Settings allowing the "Expected Pmt" to be changed to another amount when the Line status is 'Due

Pmt".
 In  the  Electronic  Funds  Transfer  (EFT)  module,  new  option  allowing  the  user  to  change  the  "Expected  Payment"

amount for easy Outstanding amount calculation.
 New option which allows the user to enter a payment of 0,00 instead of the automatic calculation
 For Mathematical Equations, many current date fields now included
 In the Record list (Customized) report, fields calculated on current date were added
 New features for Interest-only and Fixed principal calculations using Compound interest (these options were already

available for Simple interest):
o Automatic calculation of  the required payment amount to pay any accrued interest and column fees first

(new default method)
o Other options for:

 Payment of line's current interest and column fees (previous default method)
 Payment  of  a  defined  amount  of  the  principal  before  paying  the  interest  and  column  fees  (not

conventional method)
 New fields in the Record List (Customized) report, Document Merge tool and in the Accounting Entries report, that

can be displayed in the Main window:

 Payments  frequency  that  includes  the  frequency  when  payments  are  made  every  X  days.  Exemple:
Weekly,  Twice weekly, etc.

 Data relating to Co-Borrowers 1, 2 and 3

 Multiple fields relating to APR and US Truth in Lending Act
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 Original principal reported only if origination date is within the reporting dates

 Original principal plus APR Fees Financed reported only if origination date is within the reporting dates

 Attached files (Number) for the Record and the Borrower

 Attached files (Size) for the Record and the Borrower

 For the United States, Electronic funds transfers (ACH) with Wells Fargo Bank (NACHA file)
 Displays column totals in the Payment schedule
 Numerical sorting (as oppose to text) in the Main MLM window of the text fields that only contain only numerals
 Option to add a corporate logo on the Main MLM window
 Improvement of the interest adjustment for the last line of a Payment schedule (Balance = x)
 As of version 4.0 of Margill Loan Manager, the "Computational Balance" of the last line of the Payment schedule will

always  display  the  balance  used  to  compute  the  interest,  and  not,  as  in  earlier  versions  for  simple  interest
calculations,  the true balance.  Non-interest bearing principal,  fees or  others  had  been excluded in  earlier  versions
and continue to be in versions 4.0 and beyond.

 Interruption of the majority of calculations and reports by pressing Ctrl + C keys
 Multiple other adjustments and fixes to earlier versions

--------

Version 3.2

Version 3.2.140212.2

Released February 20, 2014

Changes and improvements:

 For reporting, ability for users to create their own Mathematical Equations with all  of MLM's numerical (as well as
monetary and percentage) fields. For example, adding or subtracting several fields to give a total.

 Conditional Alerts.  Alerts based on mathematical  conditions that  are fulfilled over time. For example, a  user could
create an alert that would advise him when the total of the principal + interest becomes greater than the amount
entered in the Maximum Credit field.

 Ability to view upcoming Alerts as opposed to only present and historical alerts.
 RTF  Merge  Fields  can  be  inserted  in  abbreviated  format  making  it  easier  to  create  documents  (e.g.

&&CAPinit&AddPrinc&& becomes |23|)
 Location (Path)  of  system data (database and others)  may now be located in  a  folder  other  than  the  Margill  Loan

Manager installation folder.
 Location of the backup copy defined by the Administrator.
 In the Post payment tool, new column to enter the "Expected payment" amount
 New fields:

o Maximum Credit (Amount)
o Interest to be paid at the next Due Pmt (as if Paid)(entire loan)
o Principal to be paid at the next Due Pmt (as if Paid) (entire loan)
o Outstanding – Interest portion at Report End Date
o Outstanding – Principal portion at Report End Date
o Computational Balance at report End Date
o Computational Balance at 0:00 at report Start Date (excluding any transaction on that day)

 For each reporting field (more than 900), descriptive text now included in the software (previously available in the
User Guide only). 

 The Borrower, Creditor and Employer import tool by batch (from an Excel sheet) allows the user to save an Import
Format in order to reimport data at any time without the need to reconfigure the import tool.
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 Tool to find specific Line statuses (for example, find all Records with the "Not set" Line status and fix this). 
 Major User Guide update to version 3.2.
 Calculator added in the Payment schedule.
 Various adjustments to version 3.1.
 Updated License Agreement.

--------

Version 3.1

Version 3.1.131119.1

Released November 19, 2013

Changes and improvements:

 Electronic  Funds  Transfer:  Module  to  automatically  perform  regular  and  direct  bank  account  debits  (ACH,
Pre-authorized  payments)  or  credit  card  debits  (in  collaboration  with  partners  in  the  United  States  and  Canada).
Please note: The US EFT module has been delayed after our EFT partner was acquired and the new entity could not
honor the contract.

 The Post Payment tool now allows to post Unpaid payments (thus payment = 0.00) and to post payments to any of
the ten (10) custom payment types.

 The Post Payment tool now allows you to find all "Due Pmt" between two specific dates.
 All  Borrower,  Employer  and  Creditor  fields  are  now  displayed  in  the  table  listing  each  (Main  MLM  window  under

File). Sorting is thus possible (by clicking on header) based on criteria other than name, first name and company. 
 Basic data may be extracted (in reports) for the Co-Borrowers (Borrowers 2 and 3).  
 Borrower, Creditor and Employer data may be imported in batch from a spreadsheet (Excel format) to Margill Loan

Manager.
 Quick Print for Invoices/Statements/Contracts (RTF document merge) and for some Custom reports (directly with the

"Print" button in the Record window).
 Five (5) new "Additional Principal" Line statuses that may be named as desired.
 Three (3) new "Paid Pmt" Line statuses that may be named as desired (so a total of 10 Paid-type Line statuses).
 Option to attach a PDF Payment schedule in  a  Record with  one click  and  to  send this  payment  schedule by  email

.
 For document merges (RTF format) it is now possible to specify the margins, paper orientation and page numbering.
 Add  up  to  three  (3)  additional  Record  Display  filters  in  the  Main  window  (Record  Summary).  Choose  among  the

Record's Unlimited custom fields (Table format). 
 Unlimited  (Table  format)  custom  fields  default  values  are  now  automatically  entered  in  the  loan,  Borrower  or

Creditor (no need to specifically check to enter the default values).
 Field name harmonization.
 New fields in Record List (Customized) report, RTF reports (merges) that can be displayed in the Main window:

 Loan - Number of Days

 Loan Origination Date + 12 months

 Additional Principal (multiple new Line statuses)

 Record Unique ID 1 and 2

 Creditor Unique ID 1 and 2

 Borrower Unique ID 1 and 2

 Co-Borrower 1 and 2 data (identification data)
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 Creditor 2 and 3 data (identification data and participation)

 Interest paid since last Paid or Unpaid payment (multiple new fields and options)

 Last payment (various options: date, balance, amount, etc.)

 Balance of line for the last Paid or Unpaid payment (whole loan or period chosen)

 Improved unlimited Custom fields  (Table  format).  Text  and  text  scroll  menus  can  now  take  up  to  1000  characters
(before maximum 100). Carriage returns (paragraphs) are now also possible.

 Log (History) of changes can now be seen for multiple Records at a time and for the selected dates. New fields added
in the log.

 Two optional  rights for  a  Read-only user:  write and delete Notes  and add and delete Attached Documents

.
 Notes and Attachments for Borrowers.
 List of Record associated to Borrowers and Creditors.
 Special calculation method for short periods (or other), "Simple interest capitalized" over 366 days.
 Only a user with Administrator rights may delete or copy more than one Record at a time in the Main MLM window.
 When producing  reports,  in  order  to  avoid  missing Records,  the  number  of  Records selected and displayed in  the

Main window is provided and compared to the total number of Records that can be accessed by this user and the
total Records in the system. 

 The default Windows currency's 3 to 5 letter Abbreviation can now be set.
 Two new "Unique ID" fields under the loan itself, for bridging with a third-party software.
 Transfer of multiple Borrowers, Employers or Creditors from one user to another in one operation (right mouse click,

Administrator only).
 Abnormal software shutdown by a user no longer needs to be reset by the Administrator for login.

--------

Version 3.0

Version 3.0.150513.1

Released May 15, 2013

Changes and improvements:

 Option in a payment schedule to insert Fees, Insurance or Tax lines automatically based on the balance of the
previous line (as a percentage) or as a fixed amount. The Fees (or other) based on a percentage of the balance, are
automatically recomputed as the balance changes.

 Shortcut allowing to change the majority of Line statuses to Due Pmt.

--------

Version 3.0.130213.2

Released February 13, 2013

Changes and improvements:

 Database  restructured  allowing  to  create  a  list  of  Borrowers  (and  Co-Borrowers),  Creditors  and  Employers
(Borrower's Employer):

o Tabs on the Main window to quickly view the Borrowers, Creditors and Employers registered in the system;
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o Add Borrowers, Creditors and Employers without the need to create and calculate a loan;
o A loan may include one or many Co-Borrowers;
o A Borrower's Employer may be added;
o Ability to create syndicated (participating) loans (multiple Creditors for a loan based on a proportion);
o A Creditor may now have several agents;
o See Merge Borrowers and Creditors (version 2.x to 3.x).

 Module for sending reports to credit agencies (additional software required for the Metro 2 format)
o Many standardized new fields for production of this report.

 Aging report by industry-standard periods such as Current for < 30 days, 30-59 days, etc.
 Change the interest rates for multiple Records at once.
 Size of the attachments can be adjusted up to 99 MB by the Administrator.
 Reporting fields now classified and based on themes.
 New fields:

o Next Due Payment - Balance (as if paid)
o Next Due Payment - receivable Principal Balance (as if paid)

 For the Invoices and statements, new option to select only Active AND Records displayed (or specifically selected) in
the Main window (as opposed to all Active Records in previous versions).

 Option to allow monthly payments at the end of month or on the 28, 29, 30 or 31 of the month.
 Two new "Unique ID" fields under Borrower and Creditor, for bridging with a third-party software.
 Remembers the previous dates entered when producing reports.
 Optimization of the Undo function and the transaction history.

--------
History:

Version 2.4

Version 2.4.121127.1

Released November 27, 2012

Changes and improvements:

 For the * "Power User" may now create Alerts for all users.
 In the "Record List (Customized)" report, the fields "Balance Due Interest at Start Date entered" and "Balance Due

Principal at Start Date entered" now EXCLUDE any transactions on that Start date entered. Fields renamed to: 
o Balance Due Interest at 0.00 at Start Date entered (report excluding any transaction on the Start Date

entered) 
o Balance Due Principal at 0.00 at Start Date entered (report excluding any transaction on the Start Date

entered) 
 In the "Record List (Customized)" report, "Report up to (Date)", the following fields were fixed to include the

amounts when the loan's last payment precedes the report End date entered: 
o Interest Accrued - Year to date 
o Interest Paid - Year to date 
o Principal Paid Year to date 

 Various other minor adjustments to previous version. 

--------

Version 2.4.120517.1

Released May 17, 2012
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Changes and improvements:

 For the Export accounting transactions to the General ledger module, new option to first select the desired Active
Records in the Main window (Record Summary) and export only the transactions among these. 

 For accounting, new field added:
o "Due  Interest  between  Expected  Payments  (Period)"  that  computes  the  due  interest  (thus  interest  that

should  have  been  paid)  between the  previous  period's  payment  and  the  current  payment  if  the  latter  is
insufficient to pay off the interest due.

 For accounting, change in reporting for the "Interest Accrued from last Payment "Paid" (for the period)" field. The field takes
into account only the accrued interest during the report period all the while reporting the accrued interest even if no payment is
made in this period.

 For the six (6) custom Line statuses "Paid Pmt (X)", new option to enter the amount expected and date at which the
payment should have been paid, thus allowing partial, late or partial late payments with these Line statuses.

 Various other fixes of the previous version 2.4 release.

--------

Version 2.4.120214.1

Released February 14, 2012

Changes and improvements:

 New  module  to  Export  accounting  transactions  (credits  and  debits)  to  the  General  ledger  of  various  accounting
packages:

o Intuit QuickBooks Pro (.IIF)
o Sage Simply Accounting Pro
o Acomba
o Excel (.XLS)
o Text format (.TXT)
o CSV format (.CSV)

 In the Main window (Record Summary) optional new field:
o Total of the Outstanding amount (including interest) at the current date

 Major developments with the Line statuses (in the Payment schedule):
o New  Line  status  that  may  be  named  as  desired  (for  example,  Payment  by  Visa,  Payment  by  check,  Fees

Annual, etc.):
 Paid payment (2 to 6)
 Unpaid payments (2 to 6)
 Fees (4 to 6)
 Fees Paid (4 to 6)
 Other (6 to 10)

o Existing Line statuses may be renamed:
 "Fees" (all)
 "Fees Paid" (all)
 "Other" (all)

o The display order of all Line statuses can be modified
o The Line statuses that are not used in your particular circumstances may be eliminated

 Three columns added in the Payment schedule:
o Interest on Outstanding Balance
o Balance of Interest on Outstanding Balance
o Total Outstanding Balance

 New fields in Record List (Customized) report, RTF reports (merge), Accounting Export module, and Main window:



Page 65

© Jurismedia Inc., 2007- 2023

 Interest Accrued from last Payment "Paid" but for the period only

 Interest on Outstanding Balance (for the period)

 Outstanding - Total (Variation for the period)

 Interest Balance on Outstanding Balance (Balance) at Start Date entered

 Interest Balance on Outstanding Balance (Balance) at End Date entered

 Outstanding - Total (Balance) at Start Date entered

 Outstanding - Total (Balance) at End Date entered

 Sort data with up to three columns in the Main window (Ctrl key).
 Transfer  the  "ownership"  of  Records  to  a  different  user  directly  through  the  Main  window  (Record  Summary

window) with the right mouse clic. 
 Corrections to version 2.3:

o Standard reports adjusted for  additional  principal,  negative payments,  end date  transactions and  interest
included or not in computation 

o Calculated fields for reports:
 Balance Due Principal at Start Date entered
 Balance of line of last Paid payment (all "Paid" Line statuses)
 Negative payments
 Outstanding variation for the period has been inversed (more logical this way)

 Multiple behind the scenes adjustments.

--------
Version 2.3

Version 2.3.111111.1

Released November 11, 2011

Changes and improvements:

 New user privilege level: create and edit Records that are in "Draft" state only.
 New "Notes" section allowing the user to add and view general notes in a Record.
 In the Main window, new field can be configured to provide the "Interest Accrued from the last paid payment to the

current date".
 In the Payment schedule, new option to instantly recompute (adjust) the interest rate for a line in order to obtain a

known interest amount for that line (or period) only.
 In the Detailed payment schedule report, the following elements can now be excluded from the printed report:

o "Start Date" column
o "Interest Rate" column
o Header: Data window "Description"
o Header: Borrower window "Other info" 

 In the Detailed payment schedule report the Record numbers now appear in the printed report's footer.
 New fields in Record List (Customized) report, RTF reports (merge)(and Main window):

 Balance Due Interest at Start Date entered

 Balance Due Principal at Start Date entered 

 Display of the date and time at which the Record was last updated.
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 Main window refresh speed optimized.

--------

Version 2.3.110914.1

Released September 14, 2011

Changes and improvements:

 New option allowing to add Principal,  Fees (Fees, Fees 1,  Fees 2),  Insurance,  Taxes,  Penalties and Invoices without
charging interest on these.

 Scroll menus may be created for the following fields:
o Borrower window: Type, State/Prov., Country and the nine (9) custom fields
o Custom fields (unlimited): All fields
o Advanced window: Grace period (in days)

 Most fields available in MLM can now appear in the Main window (Record Summary) thus allowing to view and sort
with the data contained in these.

 In the Main window, new field can be configured to provide balance on current date.
 New fields in Record List (Customized) report, RTF reports (merge)(and Main window):

 File Number (as a number, not text)
----------

 Today's date - long format
----------

 Computation method (Simple, Compound, etc.)

 Day count

 Short period computation method

 Year base (anniversary or civil year) for simple interest
computations

----------

 Balance of line of last Paid payment (all "Paid" Line statuses)

 Amount of last Paid pmt (all "Paid" Line statuses) 

 Total of Fees 1 + Fees 2 + Fees 3 

 Total of Fees 1 Paid + Fees 2 Paid + Fees 3 Paid

 Principal Total

 Principal Total (interest bearing portion)

 Principal Total (no interest portion)

 Additional Principal (Line status = Add. Princ.) (interest bearing portion)

 Additional Principal (Line status = Add. Princ.) (no interest portion)

 Principal Total (for the period)

 Principal Total (interest bearing portion) (for the period)

 Principal Total (no interest portion) (for the period)

 Portfolio analysis (our first analysis element)
o Repayment ratio (total of Paid payments divided by total expected Payments for the period) 

 The 9 Custom fields contained in the "Borrower" window now appear in the Payment Update tool (Post payments).
 The Custom fields (unlimited) can now be used in the RTF Report Editor as document merge fields. 
 New data merge module allowing the creation of very precise (PDF) custom reports. 
 Line numbering in the Payment schedule.
 "File" field entered by the user ("Borrower" window) now appears in active Record's header.
 In the "Payment schedule", 100 spaces (characters) now allowed in the "Comment" column.
 In the "Data" window, unlimited number of spaces in the "Description" box (though the Detailed schedule report can

become messy if this field is used as a header).
 "Mobile" phone field added for Borrower and Creditor.
 New Record status: "On hold".
 "File Number" (as a number not text) added for Borrower (in order to sort by numerical order).
 The file number or numbers entered by the user will now appear in the Record window header. 
 For  new  installations,  option  to  start  each  Record's  unique  identifier  at  a  specific  number  other  than  1  or  100
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("Record no." field).
 In the Record List (Customized) report, the 9 Custom fields contained in the "Borrower" window have been moved

from the "Special" column to the "Borrower" column.
 Various "behind the scenes" improvements and corrections.
 registration via Internet.
 Knowledge base added on the Margill website: www.margill.com/knowledge.
 Updated User Guide.

--------

Version 2.2

Version 2.2.101203.5

Released December 3, 2010

Changes and improvements:

 Major new Alert module that includes four (4) types of alerts:
o System Alerts: General alerts for one or all users.
o Line status Alerts: Alerts based on the Line status conditions. Most useful for due payments.
o Record Alerts: General alerts but specific to each Record.
o Record Line-specific Alerts: In the Payment schedule of each Record, on each payment line.

 New sub-statuses for Active Records as well as the corresponding Metro 2 code (for credit reporting agencies).
Option to show only certain sub categories in the Main window. These fields have also been added in the Custom
Record List report and in RTF (merge) reports: 

o Current (0)
o Deferred payment -
o Late payment -
o Late payment 30-59 days (1)
o Late payment 60-89 days (2)
o Late payment 90-119 days (3)
o Late payment 120-149 days (4)
o Late payment 150-179 days (5)
o Late payment 180 days or more (6)
o Collection (G)
o Foreclosure completed (H)
o Voluntary surrender (J)
o Repossession (K)

 Option allowing for a grace period for late payments. Thus, even if a payment is late by x days, no extra interest is
charged to  the  Borrower.  However,  the  feature  is  not  automated  but  a  new column  was  created  in  the  Payment
schedule in which to insert the true payment date if a grace period is given. See Advanced settings to set the Grace
period for each Record.

 Bi-monthly payment frequencies no longer limited to the 1st and 15th of the month.
 Annual interest rate up  to 999%.
 New Line status - "Paid Returned Check".
 Option to add the actual Payment schedule (with various data elements) in the RTF (merge) reports.
 Multiple new fields in Record List (Customized) report and RTF reports (merge):

 Grace period (days)
----------

 Sub-status (for Active Records)

 Balance Total Unpaid portions (Unpaid, Partial, Returned checks)
----------

 Outstanding (balance) Start Date entered 

http://www.margill.com/knowledge
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 Sub-status (for Active Records) - Metro 2 code
----------

 Paid Pmt (Line status = Paid Pmt)

 Paid Late Pmt (Line status = Paid Late Pmt)

 Partial Pmt (Line status = Partial Pmt)

 Partial Late Pmt (Line status = Partial Late Pmt)

 Add. Pmt (Line status = Add. Pmt)

 Returned Checks Paid (Line status = Paid Pmt Returned Check )

 Outstanding (balance) End Date entered 

 Outstanding Paid (for the period)
----------

 Principal paid Year to date
----------

 Detailed lines (for the period)(RTF report only)

 New  columns  in  the  Payment  schedule  allowing  you  to  determine  the  outstanding  payments  balance.  The
"Outstanding (Balance)" column factors in the payment that should have been paid less the true payment amount as
well as the extra payment that compensates the unpaid or partial payments.

 New columns in the Payment schedule:
o True Pmt Date (Grace)
o Outstanding (Balance)
o Alert to accomplish
o Alert Days Before - / After +

 New columns in the Invoices and Statements module:
o Phone
o Creditor
o Expected payment
o True payment date (Grace)
o Outstanding (Balance)

 Maximum file size attached to a Record now up to 2 Meg (was 1 Meg in version 2.1) 
 Backup of the software and the database now in Tools.
 Shortcut summaries with F2.
 Link to check Internet connection (Tools, Settings) 
 Menu button changes and optimization.
 Various other fixes and process optimization.

--------

Version 2.1

Version 2.1.100412.1

Released April 12, 2010

Changes and improvements:

 Improved Line status navigation (simplified constraints)

 Various adjustments of version 2.0 which was a major update  

--------

Version 2.0

Version 2.0.100126.5
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Released February 9, 2010

Changes and improvements:

 New custom data fields (unlimited number) that may be included in Record List (Customized) report.
 Multiple currencies within the same portfolio.
 In Record List Customized, conversion of various currencies based on exchange rate to selected base currency or to

any other.
 Record access blocked to one user. Other users in read-only.
 Unique log on by the same user name.
 Multiple new Line statuses:

 Fees paid

 Fees 2

 Fees 2 paid

 Fees 3

 Fees 3 paid

 Penalty

 Penalty paid

 Insurance

 Insurance paid

 Taxes

 Taxes Paid

 Investment

 Investment withdrawal

 Invoice paid

 Deposit

 Other 4

 Other 5

 Adjustment

 Information

 Not set

 New data integrity constraints (takes into account Line status and the amounts indicated for these payments as well
as logical parameters).

 Actual paid interest, due interest, refunded principal, due principal (if Line status = Paid Pmt, Partial Pmt, Partial Late
Pmt, Late Pmt, Add. Pmt) can now be obtained easily.

 Over  10  new  columns  in  the  Payment  schedule  offering  additional  information  (for  example:  balance  prior  to
payment, interest paid, principal paid, scheduled payment date, different balances, etc.) 

 Column identifying the minimum payment to be paid.
 Adjustment  on  Payment  as  opposed  to  preset  Fixed  principal  amount  or  interest  portion  for  an  Interest-only

payment. Various new refunding options particularly for Simple interest.
 Multiple (over 40) new data elements in Record List (Customized) report and RTF reports (merge):

 Current date
----------

 Amortization period less 1 payment

 Amortization period less 2 payments

 Interest rate (nominal end effective) quoted on a monthly basis
----------

 First Payment Amount (> 0.00) 

 First Payment Date (Pmt > 0.00)

 Last Payment Amount (> 0.00)

 Last Payment Date (Pmt > 0.00)
----------

 Currency - Symbol

 Currency - Abbreviation
----------

 Fees Paid (Line status = Fees Paid)

 Fees 2 (Line status = Fees 2)

 Fees 2 Paid (Line status = Fees 2 Paid)

 Fees 3 (Line status = Fees 3)

 Princ. (original) + Add. Princ. (Line status) up to End Date entered

 Accrued interest from last Payment

 Date of last Pmt tagged as "Paid" (Line status =  Paid Pmt, Paid Late
Pmt, Partial Pmt, Partial Paid Pmt or Add. Pmt)

 Accrued interest - Year to date

 Paid interest - Year to date

 Minimum Payments (Total for the period)

 Next Due Minimum Payment
----------

 Paid Interest (for the period)

 Paid Principal (for the period)

 Balance Due Principal

 Balance Due Interest

 Balance all other
----------

 Doubtful Accounts (%)

 Doubtful Accounts (Date from Record))
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 Fees 3 Paid (Line status = Fees 3 Paid)

 Adjustment (Line status = Adjustment)

 Invoices Paid (Line status = Invoice Paid)

 Insurance (Line status = Insurance)

 Insurance Paid (Line status = Insurance Paid)

 Tax (Line status = Tax)

 Tax Paid (Line status = Tax Paid)

 Penalty (Line status = Penalty)

 Penalty Paid (Line status = Penalty Paid)

 Investment (Line status = Investment)

 Investment Withdrawal (Line status = Investment Withdrawal)

 Other 4 (Line status Other 4)

 Other 5 (Line status Other 5)

 Doubtful Accounts (Balance from Record date)

 Doubtful Accounts (Balance from Report date)

 Bad Debt (Date)

 Bad Debt (Balance)
----------

 APR - Total Principal + Total Cost (Interest + Fees)

 Comment may be added for each payment line directly in the Payment update tool.
 Record Attachment notification (paper clip image).
 Doubtful accounts report improved.
 In Record List (Customized) report, multiple CSV "pure" date formats and export of amounts to Excel with or without

currency.
 Telephone number now in the Loan Summary window (Main window) in order to sort by phone number.
 Major database optimization for larger loan portfolios (1000-5000 Records).
 Borrower first and last names and company name in Record window header (for easier identification)
 One less step when saving and replacing a Record.
 Multiple other "behind the scenes" improvements and adjustments.

--------

Version 1.4

Version 1.4.090316.2

Released March 16, 2009

Changes and improvements:

 Read-only user
 Record access limited to own Records if desired
 Nine (9) new customizable fields in Borrower (fields may be text, monetary, percentage, numerical or date)
 Document management – attach documents to a specific Record
 Data integrity tool that checks to see if Line status is appropriate for a positive, negative or 0.00 payment
 Forced "Additional Principal" Line status to be negative
 Custom invoices and statements (including tax reports – IRS 1098 for example)
 Reports:

o Reports for a user-defined period (monthly, quarterly, yearly, etc.) using start and end dates
o User-created custom Record lists that may be saved to Excel, CSV or TXT formats and then exported to third

party software (accounting, pre authorized payment system, etc.)
o For detailed reports, system number now on each page for quick identification
o For invoices and statements and other data merges (RTF Editor), option to save as one RTF file, one RTF file

with x number of Records per page or multiple files (including system numbering) 
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 Balance = 0.00 not checked unless specifically checked by user 
 In  the  payments  schedule,  Alt-2  shortcut  to  select  one  line  out  of  every  two  lines  (to  have  payments  only  every

second month for example)
 In the Main MLM window (Record Summary window) and in the payments schedule, Alt-  shortcut to increase font

size and Alt  to reduce the size
 Selection of User Guide format according to your system's compatibility
 Change of name from Actuarial Method to Effective Rate Method
 Multiple changes and adjustments from version 1.3

--------

Version 1.3

Version 1.3.071219.2

Released December 19, 2007

Changes and improvements:

 Update payment tool that allows the update of payment status (lines in a Payment schedule)  from "Unpaid Pmt" to
"Paid Pmt" in a snap for multiple Records at once on or before a set date. 

 Portfolio unpaid payments printed report.
 In the Record Summary Window, selected User Records displayed only. 
 Doubtful accounts report only for selected Records in which a percentage for doubtful accounts has been set.
 Check for MLM software updates activated.
 Origination date and first payment date short period reference set permanently.

--------
Version 1.2.071004

Released October 4, 2007

Changes and improvements:

 Simple interest "Short period" method limited to "Same as calculation".
 Reports correction when two or more entries (lines) on same day as report date indicated.

--------

Version 1.2.070914.4

Released September 14, 2007

Changes and improvements:

 Change of the calculation reference period (date) from the loan start date to the first payment date. This allows for
equal interest for each uniform payment period.

 For the reports, consolidation of report choices allowing for the printing up to a chosen date from a unique interface.
 For the reports, correction of some totals (principal and others) for certain global reports. 
 For the reports, new option to include or exclude the interest for the chosen final date.
 Installation correction in Vista.
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--------
Version 1.1

Version 1.1.070604

Released June 4, 2007

Changes and improvements:

 Minor corrections to version 1.1.070525
 New Record Type column added to the Record Summary window. It is thus possible to sort the Records according to

the Record Type indicated in the Borrower (client) information window.

--------

Version 1.1.070525

First version of the Margill Loan Manager (MLM).

Released May 25, 2007.

--------
Beta version

Beta version released March 2007.
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Help & Support

Help & Support Contents

Help file in Margill

Live support

Knowledge Base (Web)

Support, maintenance and update contract

   

User Guide

A very detailed User Guide with many examples is accessible through the "Tools" button. Press on "F1 - Help".

On order to have a lighter Margill Loan Manager installation file, the User Guide is not included automatically. You must
download the User Guide in one of three formats (CHM, HLP or PDF) on this page: www.margill.com/mlm/user. 

This  page  also  contains  tools  and  the  required  Windows  settings  if  the  User  Guide  in  CHM  or  HLP  formats  are  not
displayed properly on your computer. Windows often blocks these formats.

The default Help file may be changed in "Tools", "Settings":

   

Live support

Technical or application related questions? Please call or email us:

Jurismedia inc.
Toll free: 1-877-683-1815
Direct: 001-450-621-8283

Fax: 001-450-621-4452
E-mail: support@margill.com

More Contact information

Specific interest questions

A service (with fees) is also available to help clients with very specific interest calculation questions or problems. Please

http://www.margill.com/mlm/user
mailto:support@margill.com
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contact Jurismedia by email at support@margill.com.

See also:  Support, maintenance and update contract.

   

Knowledge Base (Web)

The Margill Knowledge Base, our Blog, is a constantly evolving ressource allowing us to respond to clients' questions and
potential clients who wish to discover the possibilities offered by Margill Loan Manager and other products.

It includes questions and answers as to what Margill can do and how certain needs may be answered.

Accessible at:  www.margill.com/knowledge

See also: How to do...

   

Support, maintenance and update contract

Updates and support are available at no cost for a period of one (1) year following the purchase date. Afterwards, the
user may subscribe to the update and maintenance and support services for a certain fee. 

The  service  includes  access  to  the  latest  Margill  Loan  Manager  (MLM)  versions  as  well  as  support  for  MLM  -  both
application-related questions (how to do...) and technical (installation, problems...) questions.

An invoice is sent by email to the purchaser before the renewal date. To receive an invoice by regular mail, please contact
Jurismedia.

   
 

mailto:support@margill.com
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Getting started

Getting Stared Content

Start and Exit the software

Demo mode

ADMIN password lost

Registration code and Key

Number of computers with access to MLM

Administrator and Users

Regional settings (Windows)

Tutorial

Import Borrower, Creditor and Employer Data

Creating and modifying a Borrower, Creditor, Employer and Agent

Creating the first Record

Deleting a Record, a Borrower, a Creditor, an Employer or an Agent

Duplicating Records

Locked Records and Alerts

   

Start and Exit the software

Once Margill Loan Manager (MLM) is installed, to start the software, click on the "MLM.exe" file .

See Installation, Networking capabilities and Database and Location (Path) of System Data.

First use

Upon  the  first  use  of  MLM,  the  software  will  prompt  you  to  enter  the  password  for  the  Administrator  (ADMIN  User
Name). 

The password is sent by email by Jurismedia. This password may be changed subsequently. MLM contains a few Records,
Borrowers, Creditors, and Custom fields as examples. These may be deleted.

You will now enter Margill Loan Manager.
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To exit MLM, press on "Exit" . A confirmation will be required.

WARNING: It is highly recommended to exit MLM when the software is not in use for a certain lapse of time or before
putting your computer in sleep, hibernate or stand by mode. This is particularly important for network users because the
network connection could interrupt, closing the software suddenly.

See also: Administrator and Users

   

Demo mode

Upon purchase of the full license or the Demo version, a start-up window invites you to use Margill Loan Manager (MLM)
in Demo mode or to enter an activation key.

 
Demo mode is a full version of MLM but valid for a 30-day period.

If  a  full  license  has  been  acquired,  you  may  nevertheless  use  MLM  in  Demo  mode  until  the  activation  key  has  been
received and entered in MLM. 

The  "Buy  now!"  button  will  bring  you  to  the  MLM  purchase  page  on  line  at  the  margill.com  web  site.  You  may  also
contact Jurismedia by email or phone.

See Registration code and Key

If MLM is used as a new installation the User name is "ADMIN" and the password is provided by email.  It also includes a
few Records as example. 

A trial  period may be extended by first  contacting Jurismedia by email  or  phone.  Jurismedia staff  can  then extend the
demo via Internet or by providing you a new key. Either press on "Extend Trial via Internet" or enter the key provided.

   

ADMIN Password Lost

The ADMIN user is the only software user who cannot be deleted and whose name cannot be changed. This is also the
only user, unless these rights are granted to other administrators, who can create and modify users and grant them rights
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or restrict them.

If  the  ADMIN password is  lost,  the  only  way to  restore it  is  to  contact  Margill  Customer  Service.  Margill  staff  have  no
access to your software but may, with the permission of your primary contact, create a temporary password and provide
it to you.

Once the password has been received, launch Margill Loan Manager (MLM). In this window, press Password:

This window explains the simple process. Click on Continue:

  

The  next  window  will  allow  MLM,  after  clicking  on  "Update  via  Internet"  button,  to  communicate  with  your  file  on
margill.com in order to retrieve the temporary ADMIN password.
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You will  need to enter the email of the authorized person at your location and the next window (not shown here) will
confirm your license settings.

You can then, in the very first window upon opening MLM, enter the temporary password provided by the Margill team
for the ADMIN user.

You will then be asked to change the password and the process will be complete. You will have access to MLM with the
ADMIN user.

See also Administrator and Users.

   

Registration code and Key
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After the purchase of one or multiple licenses of Margill  Loan Manager (MLM), press on the "Registration via Internet"

button .

You  must  accept  the  Software  License  Agreement.  Then  enter  the  email  in  your  MLM  account  or  the  email  used  to
purchase the software. Press on "Next". The software will then be activated and the number of Records and stations will
be shown. Please make sure this corresponds to your purchase.

If  the  connection  cannot  be  established,  your  network  administrator  should  run  MLM  in  Demo  mode,  go  to  "Tools",
"Settings" and "Internet connection" to change the Port 80 default Internet setting.

If MLM cannot connect properly to the Internet, press on the "Send Email" button  on the bottom
right of the window.

This will open up a new window in which to enter the registration information:

The "Description" field is optional and should be used when you wish to provide extra information to Jurismedia.

By pressing once again on "Send Email", the email program will open with the appropriate subject and information to be
sent to Jurismedia. The user must then send the email with his email program. Upon reception of the email, Jurismedia
will return, the appropriate activation key. This operation is done manually by Jurismedia and thus you may not receive
the key immediately.

If the station with MLM does not have email or Internet access, the code may be copied and sent by email to Jurismedia
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or contact Jurismedia by phone. 

Contact information

   

Number of computers with access to MLM

The number of computers with access to Margill Loan Manager (MLM) is determined according to the license acquired.

When a user logs on from a specific computer, MLM registers that computer in the system.

If  the  number  of  computers  that  try  to  access  MLM  exceeds  the  number  allowed  by  the  license,  a  message  appears
indicating that the maximum number of users allowed has been reached.

Two options are possible:

1) Add one or additional workstations. See Purchase additional licenses / Upgrade loan level.

2) In some cases, there may have been computer replacements or MLM users changed. The system memorizes these old
computers as active even if they are no longer.

MLM  allows  the  Administrator  to  purge  these  old  computers  by  going  to  Tools  >  Settings  followed  by  the  keyboard
shortcut "Ctrl Alt Shift W". The following window will appear allowing to remove computers that no longer use MLM.

In case of doubt as to which workstations are active or not, delete ALL computers in the list.  This can be done without
fear even if users are currently logged in the software. They will be simply be registered the next time they run MLM.
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Location (Path) of System Data

Before version 3.2, the database and folders used for exporting to a third-party systems such as the Credit  Report and
Electronic Funds Transfer were and had to be included in the Margill Loan Manager (MLM) installation folder. Now, the
MLM Administrator can define the location for all system data. 

The Administrator can set this location through Tools > Settings > System Settings (Administrators) > Backups and Data >
"Data Folder" section. Simply specify the folder. 

Problems encountered by Windows users since Windows Vista 

As of Windows Vista, the "UAC" or User Account Control has been changed and strengthened. This change has important
yet annoying repercussions as per where the Margill Loan Manager (MLM) data is stored.

Software should normally be installed in "C:/Program Files" or in "C:/Program Files (x86)". However, if  MLM is run as a
simple  Windows  user  (without  full  administrator  rights),  Windows  (Vista,  7,  8,  etc.)  could  automatically  and  without
warning  “virtualized” the data. This happens when access to these folders is forbidden for the user. The MLM data files
would  then  be  saved  in  "C:\Users\LoginNAME\AppData\Local\VirtualStore\MLM"  although  they  would  appear  to  be
located in the normal MLM folder (DB subfolder). 

In  order  to  avoid  this  situation that  confuses  users  in  regards  to  the  data  path,  if  you  do  not  have  full  rights  on  your
machine,  it  is  strongly  suggested  not  to  install  MLM  in  "C:/Program  Files"  or  "C:/Program  Files  (x86)",  nor  in  the
"Windows" folder, but rather, for local (non networked) installations, in a MLM folder that would be created directly on
the C drive.

If MLM is not installed in one of the “Program files” folders, then the data folder may remain in the MLM install folder
(\MLM as default). You must then choose the option "Do not use a Data folder outside the MLM installation folder" so
that MLM detects that the data is in the same location as the software.

It is nevertheless recommended and safer to save the MLM data in a proper data folder on the computer which is backed
up regularly. 
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Location of the new Data folder

For new installations directly on the user's computer, the installer suggests (names may vary depending on the Windows
language):

Software location:       C:\Program Files (x86)\MLM
Data location:         C:\ProgramData\MLM_DATA

For a Network installation, the Administrator can define its usual location, separating the data and the software.

If  the  data  is  located  elsewhere  than  in  the  MLM  installation  folder,  make  sure  that  the  Network  path  is  entered  as
opposed  to  the  local  server  path.  For  example,  MLM  could  be  installed  on  the  C:\  drive  on  the  server,  but  for  the
Network, this is the Z:\ drive (or directly the server’s name). Always use the Network path, otherwise the client stations
will not be able to find the data.

Always make sure, especially for the data, that backups are performed regularly. See also Backup (Data).

In some cases, the "ProgramData" folder may not be visible in Windows. To display the default data folder (MLM_Data)
in the Windows folder, go to View and then select or check to show "Hidden files and folders".

Folders to include in the new data folders 

The most critical MLM data is contained in the DB subfolder. 

The DB (for Database) subfolder is  the largest folder since it  contains the database.  The database and folders used for
export to a third-party systems such as Credit reporting and Electronic Funds Transfer should also be included in the data
folder. Do NOT move the "Update" subfolder. This subfolder should remain in the installation folder (the same location
as MLM.exe).

Ensure that all users are granted the rights to read and write on the MLM_DATA folder (suggested name) which contains
all the data. Also ensure that all sub-folders in the MLM_DATA folder also have these rights. 

Also make sure that if  the Credit reporting and / or Electronic Funds Transfer modules are used, that these folders are
accessible to users.

Changing the Data location (advanced users only)

Here are the steps to follow to change the Data location:

1) MLM should be closed by all users.

2) Create a new Data folder in the desired location. Suggested name: MLM_DATA. The folder will be empty for now.

3) Manually move the following folders to the new Data location. Some folders must be moved while for others, this is
only strongly suggested in order to have all the data in one place:

o DB - folder containing the database (MANDATORY)
o Tables - folder containing interest and sales tax tables (Suggested))
o Metro2 - folder for the credit reports (Required if module is used)
o Folder for the Electronic Funds Transfer (containing the names of Margill partners):

 Perceptech - partners for Canada (Mandatory if module is used)
 Others (coming soon)

o RTF-Examples - folder containing sample documents (RTF Merge documents) (Suggested)
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Do  NOT  move  the  "Update"  subfolder.  This  subfolder  should  remain  in  the  installation  folder  (the  same  location  as
MLM.exe).

4) Start MLM. The following message will appear asking you to specify the new data path:

By pressing "Enter a new Path" a window for specifying the path (location) will appear. 

Specify the path by pressing the folder icon , then press Save .

Once saved, a file named MLM.ini will  be created. This important file identifies users and the data location.  When
returning to  the  window (Tools  >  Settings  >  System Settings  (Administrators)  >  Backups  and  Data  >  "Data  Folder"
section ), we find that the two paths are (should be) identical.

Non-compliant paths

The location (Path) of the data files is contained in two places and each time a user launches MLM it verifies that the path
is the same at these two locations:

1) in the database itself
2) in the MLM.INI file 

Typically,  the Path is  the same for all  users but  it  is  possible  that  during  a  data  Path  change,  it  is  not  passed on  to  all
users. In this situation, when the Path contained in the database and the Path contained in the INI file do not match, a
warning will be displayed to the user.
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The MLM Administrator must change the Path.

Recommendations

The  Administrator  must  ensure  that  data  is  backed  up  securely  from  all  normal  information  technology  security
perspectives.

It is also suggested to NOT leave the data in Program Files or Program Files (x86) but keep it in a data folder for which a
backup is performed regularly.

   

Regional settings (Windows)

Margill Loan Manager (MLM) uses the settings specified in Windows for all the calculations. These include:

 the monetary unit symbol
 the decimal separator
 the thousands separator
 the date format

Before using Margill, you should ensure that these are correctly specified in the Windows settings.

Monetary Unit By Default

MLM  will  use  the  monetary  unit  specified  in  the  Windows  preferences  (Start  >  Settings  >  Control  Panel  >  Regional
Settings > Currency and currency symbol). All monetary units can be used ($, €, £, F, R, DA, Rs, ¥, etc.).

If  the  Windows  settings  do  not  contain  any  units,  the  dollar  sign  ($)  will  be  used.  Therefore,  you  should  make  the
necessary changes in Windows.

Multiple currencies may also be used in the same portfolio. See Multi Currency.

Use of the Period (.) or the Comma (,) for Decimals
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Based on  the Windows preferences (Start > Settings > Control Panel > Regional Settings > Number), MLM will use either
the period or the comma as the decimal symbol. 

It is important that the symbols be specified in the Windows settings.

Thousands Separator

Based  on   the  Windows  preferences  (Start  >  Settings  >  Control  Panel  >  Regional  Settings  >  Number  >  Digit  Grouping
Symbol), MLM will use the specified separator.

It is important that the separator symbol be correctly specified in the Windows settings. The thousands separator should
NOT be the same symbol as the specified decimal separator.

The  metric  system  uses  the  space  “  ”  as  a  separator.  In  the  Windows  “Digit  Grouping  Symbol”  function,  if  the  space
character is used, no symbol appears, but by positioning the cursor in the box, it can be seen that a space is included.

Date Format

Based on  the  Windows preferences (Start  >  Settings  >  Control  Panel  >  Regional  Settings  >  Date  >  Short  Date Format),
Margill will use either the DD/MM/YYYY, YYYY/MM/DD, MM/DD/YYYY, or another format. The "/" or "-" may be used as
the separator.

It is important that the date format be correctly specified in the Windows settings.

We strongly recommend the use of four (4) digits (YYYY) for the year. Otherwise, only calculations after the year 2000 will
be carried out.

   

Administrator and Users

Margill Loan Manager (MLM) includes six (6) privilege levels from Administrator to Read-only. Based on your License, you
may  create  one  of  more  user  accounts.  The  Administrator  named  "ADMIN"  is  a  "Super"  Administrator  (or  main
Administrator) and only that Administrator can do certain configurations.

Adding and Changing User names and Passwords

A  User  name  or  Password  may  be  changed  or  users  added  through  the  Tools   menu  and  Users

:
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Only  the  MLM  Administrator(s)  will  have  access  to  this  menu.  The  main  Administrator  (ADMIN)  can  decide  if  other
Administrators can change other users' settings (including passwords) by checking the option "Allow user management (if
administrator)".

Adding new users

Users with various security levels may be added in MLM. The levels will be determined based on what a user can access
and do in MLM.

If only one person uses MLM, then this person should remain Administrator.

PLEASE NOTE: The password is case sensitive.  

Complex password

As  of  MLM  version,  a  new  option  is  available:  The  Administrator  can  impose  a  complex  password  to  all  users.  If  this
option is  chosen, all  users will  need a strong password.  The strength of  the  password is  evaluated by  the  system with
points.  A  long  enough  password  (at  least  10  characters)  and  a  mix  of  capital  letters,  symbols  and  numbers  give  more
points, while a short password with recurrent characters diminishes the given points.
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If the option "Ask a strong password to all users" is selected, the strength of the password will  be evaluated each time
MLM opens for all users if the password is not considered to be "Strong", then the user will have to modify the password
until  it  is "Strong" before opening a new MLM session. A gauge appears under the password to inform the user of  the
strength of the password. It can only be saved if the gauge indicates at least "Strong".

Forcing password changes

If you wish, you can have a new user change his password the first time he uses the software. If so, the user will see the
following window when using MLM for the first time:

User Privilege Levels:

 Administrator ADMIN exclusively:
o This is the most powerful Administrator and only one Administrator can be at this level
o This  Administrator  can  not  be  destroyed  and  his  rights  can  not  be  reduced.  Only  the  password  can  be

changed by this Administrator only
o This Administrator can require that all users need a Strong password
o Can create templates for the Main window and the Payment schedule so that one or many users can use

these. An option can prohibit, or not, the user who must use this template, to modify it. See Main window
and Payment schedule Templates for users

o Protection options for Confidential information (see Security section)
o Can activate the create Daily activity log files option (see Security section)

It is very important not to loose the ADMIN password. In case it is lost, only Margill personnel will be able to provide a
temporary password via a license update. See ADMIN Password Lost section.

 Administrator (Other than ADMIN):
o All rights:

 Complete Record management (create, modify, export and print Record)
 Complete Report and Merge templates management (create, modify, rename and delete)
 Complete Advanced Queries management (create, modify, rename)
 User management (create, change and delete other users)
 Change Record ownership in bulk (Record Summary window)
 Create,  change,  delete  and  resolve  Alerts  for  himself  and  for  all  other  users  including  other

Administrators
 Access and change the data pertaining to the Creditor for Electronic Funds Transfer (EFT) (EFT tab

under Creditor)
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 Location (Path) of System Data
 Location (Path) of the Backup that users can do on the fly
 Change the names, delete and change order for the Line statuses
 Change own personal settings ("User Settings" tab under Tools > Settings)
 Update Interest Rate tables 
 Change all Custom field names, types and default value
 Create and change the scroll menu data
 Create and change the Display filters that take into account custom fields linked to the Record
 Activate or deactivate Multi currency module as well as make any changes to the currencies
 Add, change or delete currencies and the exchange rates
 Unlock Records that are locked
 Change the interest rate of multiple Records at once
 Change the Owner of multiple Records at once
 Change the Owner of multiple Borrowers, Employers or Creditors at once
 Delete multiple Records in one operation
 Database Reindexation

 Perform a Backup from the various backup scenarios including with the  button
(Tools > Backup). The user must have the proper rights in the backup folder.

 Management of stations / computers that have access to MLM
 Create, change and delete Mathematical Equations

 In the Main MLM window, display the System Warnings for all users 
 Deny access to certain users to delete Records, Borrowers, Guarantors, Creditors and Employers
 Rename the Column Fees
 Create and modify Automatic Fees (Column Fees)
 Apply Color to Records in the Record Summary Window (Main window) and in the Post payment

tool.
 Allow certain users to bypass the blocking of Historical Transaction Changes
 Make Global changes in the Main MLM window
 Has all the rights to add Notes, attach documents, print and export the Payment schedule
 Can update and import payments
 Can import new Records, Borrowers, Creditors and Employers via Excel
 Can import and update data in a payment schedule in bulk via Excel
 Allow, or not, to display totals and other elements in the Main window
 Consult system messages from the red button of the "Settings" window
 Can, if ADMIN allows it, manage the rights and modify the password of other users, except that of

ADMIN

Red Button  of the "Settings" window
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The  "Error  List"  can  be  accessed  by  clicking  on  the  red  button  in  the  right  top  corner  of  the  "Settings"
window:
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The  errors  displayed  are  configuration  errors  (Email  connection  settings)  or  errors  that  have  been
generated by a system failure.

One or many errors can be deleted by highlighting these (in blue) and then by clicking on "Delete Error".
When  the  errors  have  all  been  deleted,  the  red  button  in  the  Administrator  Settings  window  will
disappear. 

 Power user 

Unlike the Administrator,  the Power user has almost no system configuration rights.  For example, he cannot create or
modify users, he cannot create custom fields, etc. The Power user cannot update the Margill software license either.

In fact, the Power user is a Normal user (called User in MLM) with the following additional rights:

 Right to consult the historical changes of all Records selected according to the desired dates (Tools
> Various)

 Right to find the Line status in the Records (Tools > Various)
 Right to make back-up copies (Tools > Save)
 Right to change Interest rate tables and Sales tax tables (Tools > Tables)
 Right to reindex the database (Tools > Reindex)
 Right to modify the Person in charge of the Record, a Borrower, an Employer and a Creditor
 Check for software updates
 Right to delete, modify and rename reports created by other users
 Right to change currency exchange rates
 Right to view the Alerts of all users
 Receives System Messages from all users
 Right to remove system errors from the Settings
 Right  to  access  the  "Various"  Tools  (Log  of  changes,  Find  specific  Line  status,  Extract  attached

documents, Extract Notes and Bulk import and update data in a payment schedule via Excel)
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In  addition,  the  Administrator  can  give  or  remove several  additional  rights  to  the  Power  user  just  like  he  can  do  with
Normal users (see below).

Note: Some options in the system Settings are displayed to consult, but these cannot be modified for this type of user.

 Normal User (called "User" in MLM)

A  Normal  User  can  create,  modify  and  update  Records  and  Payment  schedule,  Borrowers,  Creditors,  etc.  The  Normal
User can create and produce reports but has no administrative rights on the configuration of the system.

The Administrator can also decide to remove or give certain rights to other users, such as:

 Create new Records
 To give access: 

 only to his own Records, Borrowers, Employers and Creditors
 only to certain Record Types
 only to Records for certain Creditors

 Make Global changes to the database
 Add colors to the Records in the Main window (Record summary) and in the Payment update tool
 Bypass the blocking Historical Transaction changes
 Right to create, modify, view and display Alerts for all users
 Delete Records / Borrowers / Employers / Creditors
 Produce certain types of reports
 Create and use Advanced Queries
 Can submit pre-authorized payments
 Can use the Post payment update tool (manual or Excel bulk payment updates)
 Can change interest rates in bulk and update Interest Rate tables

Note: Some options in Settings can be seen by the user with this privilege level but cannot be changed.

 Draft User

The  Draft  User  can  have  the  same  rights  or  limitations  as  the  Normal  User  (according  to  the  rights  granted  by  the
Administrator), except that, unlike the Normal User, the Draft User:

 Can only create and modify Records in "Draft" mode
 Can only be "Owner" of Records in "Draft" mode
 Can only display the Records in "Draft" mode

Other optional permissions can be given to the Draft User. See box below for details.

 Read-only

The Read-only User is much more limited and can usually only view the Records.

The Administrator can also decide if the Read-only User is authorized, or not, to do these:

 Access to his own Records
 Access to his own Borrowers / Employers / Creditors only
 View and create Alerts

Other optional permissions can be given to the Read-only User. See box below for details.
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Optional permissions for Draft and Read-only users

Optional rights for Draft and Read-only users may be granted by the MLM Administrator: 

1) Write and delete Notes  (applicable to Records and/or Borrowers)

2) Add and delete Attached Documents  (applicable to Records and/or
Borrowers)

3) Create reports

4) Create reports and report templates

5) Post payments with Post payment module
o Post payment tool
o Existing (Due) payment update through a spreadsheet
o New payment import through a spreadsheet

First two rights apply on Records and/or Borrowers. 

In  the  United  States,  this  may  be  required  for  the  segregation  of  duties  under  the  Sarbanes-Oxley
compliance regulations.   

Go to Tools > Users and for the Read-only users the "Options" link becomes active.

By  clicking on  the  link,  the  Special  Authorizations  window appears  and  allows  you  to  give  one  or  more
additional rights.

Warning:  by granting these rights to a user means he/she has full  authority  on the options.  He can add
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AND delete notes and / or attached files.

Each of these privilege levels may be specified in the "Users" management window.

To add  a  user,  press  on  "New"  ,  include  User  name and  Password.  Select  the  security  level  and  the
various other rights and constraints (see below).

The  Administrator  can  always  change  user  names  and  delete  a  user  from  the  system  by  pressing  on  "Delete"

.

See Changing Record, Borrower, Employer and Creditor Ownership below.

Specification on  Rights and Constraints

MLM  allows  the  Administrator  to  specify  other  options  and  to  add  or  revoke  various  rights  and  the  total  or  partial
obligation to follow defined Templates for displaying columns in the Main window and in the Payment Schedule:

Force Password change

if desired, force the new user to change his/her password upon the first use. With this last option, the user will see this
window upon his/her first use of MLM.
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Can only see own Records / Can only see own Borrowers/Employers/Creditors

MLM allows a certain data impermeability (segregation) when MLM is used by several Creditors and/or users who should
not  have  access  to  other  Borrowers'  data.  When  "Can  only  see  own  Records"  and/or  "Can  only  see  own
Borrowers/Employers/Creditors"  is/are  selected,  only  the  Records  and/or  the  related  Borrowers,  Employers  and
Creditors data of that user (the user being the Record's "Owner/Creator") will appear for that user.

Thus, a user with these constraints can only see and/or edit his own Records and the Creditors/Borrowers/Employers he
has created or for which he is the Owner.

Read-only and Draft users

Read-only user: No Alerts

Select this option when you do not want a Read-only user to receive alerts when "Alerts sent to all Users" is created.

"User Manager" window "Alerts" window

This can be useful for users less involved and who have limited access to the system.

Display only "Draft" Records

If  this  option  is  checked,  "Draft"  level  users  can  only  view Draft  Records.  If  it  is  not  checked,  they  will  see  all  Records
(depending on the choices above) but can only prepare or edit Records in Draft mode.

Records rights

Cannot create new Records

By default, Read-only users cannot create new Records. It is also possible to prevent any other type of security level user
from creating new Records. 

Authorized to perform Global changes

If this option is checked by the Administrator, users will be authorized to perform "Global Changes" in the database. This
tool allows users to make changes to data in batches for multiple Records or Borrowers without having to open them one
by one. For example, you can add new data in a Custom field or change many Records from Active to Closed in a matter
of seconds. See the Global changes to the database section.
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Authorized to change the Record color

A  user  with  the  required  rights  (Tools  >  Users)  can  place  emphasis  on  certain  special  loans  and  assign  them  different
colors.  Select  the  Record(s)  in  the  Main  Window,  right-click  with  the  mouse  and  choose  the  "Record  Color"  option.  A
color can also be added by the Payment Update tool.

Bypass the blocking of historical transactions

If this option is checked by the Administrator, all types of users (except for the read-only user) can be granted the right to
bypass the blocking of historical transactions. They will be able to modify, add or delete transactions. They will never get
the gray lines in the Payment schedule, regardless of the number of days (greater than 0) entered in the Settings (System)
in the option "Users cannot edit transactions that are older than (from current date)" . 

An Administrator can always restore his own right even if it is removed by another Administrator.

It is STRONGLY recommended to give this permission to only one or a few users so that your previous financial results are
not altered.

User cannot delete Records/Borrowers/Employers/Creditors

If  this  option  is  checked  by  the  Administrator,  users  from  all  security  levels  can  be  prohibited  from  deleting  Records,
Borrowers, Employers and Creditors.

The Administrator can re-give this right at any time even if it has been removed by another Administrator.

It is STRONGLY recommended to choose this option for all Users. This will greatly reduce data loss since Users will have to
go through the Administrator to remove Records and Borrowers.

Cannot Change Record Status

An Administrator can restrict certain users from changing the Record Status.

We see this especially so that only one user or specific users only (except Administrators that have all rights or can
provide themselves these rights), can change for example, a Draft Record to Active mode.

To  do  so,  check  "Cannot  change  Record  Status"  and  assign  a  Default  Record  Status  to  each  user  who  does  not  have
permission to change a Record Status.

This is different from a user in "Draft" mode which is more restrictive since this type of user can only create Drafts but has
no permission to modify Records other than the ones in Draft mode, while the restriction "Cannot change Record Status"
is purely that the user cannot change the Record Status. Therefore, this user can update all types of Records, no matter
the Status (according to his rights, of course). 

CAUTION: This  restriction  is  not  foolproof.  A  user  who  cannot  change  the  Record  Status  could  still  copy  or  modify  an
"Active"  Record  and  the  newly  created  Record  would  maintain  its  "Active"  Status  since  the  user  cannot  change  any
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Record  Status.  This  option  does  not  change  the  copied  Record’s  Status  back  to  this  user’s  Default  Record  Status.
Furthermore, if the user has the rights to make Global changes, he can modify the Record Status without restrictions.

General rights

Can only see own Records / Can only see own Borrowers/Employers/Creditors

In order to preserve a certain segregation of data when MLM is used by several Creditors and/or users who should not
have  access  to  all  the  data  in  the  system,  when  the  "Can  only  see  own  Records  only"  and/or  the  "Can  only  see  own
Borrowers/Employers/Creditors"  fields  are  checked,  only  the  Records  and/or  information  relating  to  Borrowers,
Employers and Creditors of this user (the user being the "Owner/Creator of the Record") will  appear in their respective
windows.

This way, the user will see and be able to modify only their Records and the Creditors/Borrowers/Employers they have
created and for which they are responsible. 

Access to certain Record Types only

Segregation can also be established by only  allowing users to access  certain  Record Types.  Check the  "Access to  these
Record Types only" from the drop-down menu on the right:

This restriction can be combined with other access restrictions (see above and below).

Access to Records linked to certain Creditors only

The same method applies to allow users to only access the Records of one of more Creditors. Check the option "Access to
these Creditors only" box and then select the allowed Creditor(s) from the drop-down menu on the right:  

For Participation Loans (loans that  have more than one Creditor),  the  option  "Allow access in  Participation Loans"  will
allow the user who would not ordinarily have access to one of the participating Creditors to  access the loan nonetheless
(and modify according to the rights) this loan. This of course, if the user has access to one of the participating Creditors.

IMPORTANT NOTE: This segregation of data is not full-proof since there are many ways to access data, including the
Main window and reports. For true data segregation, a separate instance of the software must be used with limited
access.  Considering  this  restriction,  it  is  NOT  suggested  to  check  the  "Authorized  to  produce  reports  for  all  Records"
option, nor to allow the use of Advanced Queries (for reports) since this user will have access to data which should not be
allowed because of the restriction.

Authorized to produce all reports for all Records

This option is included in order not to allow all users to generate reports for all Records.

If a user with the "Can only see own Records" and/or "Can only see own Creditors/Borrowers/Employers" constraints can
generate reports,  the  user  will  automatically  have access  to  all  the  data  produced  in  these  reports,  which  is  not  ideal
when some data confidentiality is required.
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By selecting this  option,  this  user  will  be  able  to  produce all  reports.  The Administrator  could  decide  not  to  allow  the
production of certain specific reports by unchecking the non-allowed reports:

o Accounting entries
o Credit Agency report
o Creditor / Investor Report

By selecting this option, a user who only has access to his own Records, will be able to produce reports for ALL Records
and not only those they have the rights to consult, thus greatly eliminating the other Records' confidentiality.

Can make Global changes

If  this  option is  selected by the Administrator,  the users will  be authorized to make "Global  changes" to the  database.
This tool allows data changes in bulk in multiple fields for Records and Borrowers without the need to open them one by
one. For example, you could add new data in a Custom field or change several Records from Active to Closed in a  few
seconds. Consult Global changes to the database.

User cannot Delete Records/Borrowers/Employers/Creditors

If  this  option  is  selected  by  the  Administrator,  users  of  all  security  levels  may  be  denied  the  right  to  delete  Records,
Borrowers, Employers and Creditors. 

It  is STRONGLY recommended to check this  box for all  Users.  This way,  the loss of  data is  much less likely since only  a
dedicated person (ADMIN or other) will have the right to delete Records or Borrowers.

Reports and Modules

Authorized to use the EFT module

In order to have the right to transmit EFT (Electronic Funds Transfer), the user MUST have access to ALL Records as well
as ALL Borrowers / Employers / Creditors. User will not be able to submit pre-authorized payments otherwise. 

This  authorization  is  intended,  among  other  things,  to  comply  with  the  Sarbanes-Oxley  (separation  of  duties)  of  the
United States.

Can consult the Main window Dashboard

By selecting this option, the user will  be able to view the Main window Dashboard that includes widgets  set up by the
Administrator.

Authorized to produce and use the Advanced Queries

Please note  that  the  Advanced Queries  do  not  take  into  account  user  access  restrictions.  A  user  who  is  authorized  to
produce or use the Advanced Queries will automatically have access to all the data produced in these reports.

Authorized to produce an "Accounting entries" report
Authorized to produce the credit agency report (Metro 2)
Authorized to produce a Creditor/investor' report

Please note that permission to produce these reports does not take into account user access restrictions. A user who is
authorized to produce one of more of these types of reports will automatically have access to all  the data produced in
these reports. 

Changing Record, Borrower, Employer and Creditor Ownership
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A Record,  a  Borrower, an Employer or  a  Creditor created by a  user may also  be  assigned to  another  user  through the
Record's "Data" window by changing the "Record Owner" (bottom right of  the window). This  can  be  useful  to  provide
Read-only users (or other users) with access only to their Records, Borrowers, Employers or Creditors.  The higher level
user can nevertheless change, update and modify the Record while allowing the lower level user to see the Record and
print reports without being able to change it (for read-only).

The change in Record Owner can be done in two ways:

1) Change one by one

In  the  "Data"  window,  "General"  tab,  by  changing  the  "Record  Owner"  (bottom  right  of  the  window)  or  in  the
"Borrower",  "Employer"  and  "Creditor"  windows  respectively,  accessible  through  the  menu  on  the  left  of  the  Main
window, under File, by changing the "Borrower", "Employer" or "Creditor" Owner/Creator.

Accessible through the "Data" window

Accessible from the "Borrower" window accessible through the Main MLM window (under "File")

2) Changing multiple Records, Borrowers, Employers and/or Creditors at once (in batches)

To change the Record Owner or the Borrower with the Global changes" tool, a user must have the rights to make these
global changes. These rights are granted in the "Users" window.

Only an "Administrator" can  change the Creditor or Employer Record ownership.

Changing the Record Owner

This change can be made in a single operation for multiple Records. From the Main window, select the desired Records
(highlighted in blue), right click and then select "Global Changes". In the Global Changes module choose "Owner" under
"Record Various Fields / Options".

Please note that you can only assign "Draft" Records to a "Draft" user.

Changing the Borrower Owner

This change can be made in a single operation for multiple Borrowers through the Borrower window (available from the
Main Window, under "File"). Select the desired Borrowers (highlighted in blue), right click with the mouse and then select
"Global Changes".
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Choose the field to be changed named "Owner". All  users and their  privilege levels will  be displayed. Choose to  which
User to transfer.

Changing the Employer and/or Creditor Owner

This change can be made in a single operation for multiple Creditors through the Creditor window (accessible from the
Main  window,  under  "File").  Select  the  desired  Creditors  (highlighted  in  blue),  right  click  with  the  mouse  and  then
"Transfer Creditors (or Employers) to".
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Multiple accesses by a user

If for some reason (user not logged out, power failure, computer crash or software error) a user remains locked, this user
can log back in without the MLM Administrator needing to intervene. The message below will appear:

Loss of Administrator password or user name

If the Administrator loses his/her user name or password, please contact Jurismedia inc.

Considering the complexity of this operation, fees will be charged in order to obtain a new user name or password.

Reset the Multi-factor authentication code

If Multi-factor authentification (MFA) has been enabled (Tools > Settings > Security)(Only ADMIN can access to this tab),
this  option  will  allow  the  reset  of  the  unique  user's  MFA  in  case  of  a  change  of  smart  phone,  required  to  obtain  the
authentication code.

This option will only be displayed for Margill Administrators with the rights to manage users and only for users who have
already activated MFA. 



Page 101

© Jurismedia Inc., 2007- 2023

 

   

Main window and Payment schedule Template for users

The ADMIN user (and only ADMIN) can define, for each user, a display template for columns of the Main window (Record
summary window) and/or the Payment schedule. You can create one Template which applies to all users or force one of
many users to use the Template and a different Template for other users. The suggested Template can be recommended
(so can be changed by the user) or compulsory (cannot change).

First, under Tools > Users, the ADMIN user must click on of the of "Template" buttons in order to define one or many of
the Templates.

View of the ADMIN user - only the ADMIN can see the "Template" buttons

For the Main window Template, use the central arrows to add or remove fields and the side arrows to position them. The
field names can also be modified by clicking in the desired field in the "Fields Displayed" column:
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Window for defining the Main window Template

The same applies for the Payment schedule Template but the column names cannot be modified:

Window for defining the Payment schedule Template

Once the Template is created, ADMIN must go to the desired user by using the white arrows on top left and can apply, or
not,  the  Template  by  checking  "Apply  the  Main  window  Template  to  this  user"  and/or  "Apply  the  Payment  schedule
Template to this user":
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"Cannot add or remove display fields and/or columns" option

By checking this option, the user will not be able to add or delete display fields and/or columns in the Main window and
in the Payment schedule. However, the user can modify the display order of the columns, using the blue side arrows for
managing the display of the Main window and in columns in the Payment schedule.

Changing Template or Template by user

It will be possible to apply a new Template by proceeding as follows:

1) Check the "Apply the Main window Template..." option and click on the Update button on the right 

2) Apply changes to the Template

3) Recheck the "Apply the Main window Template..." option and click on Update

You can thus, by modifying the Template, apply different Templates to different users. To do this, create a first Template
then apply  it  to  each user  individually  (and prohibit  changes by  the  user  if  desired).  For  other  users  who  would  use  a
different Template, press the "Template" button, update it and check the "Apply... the Template" for this user. Apply this
Template to all desired users, one by one.

Important  Note:  The  chosen  Template  applied  to  the  user  is  the  one  available  when  the  option  is  checked.  If  the
Template is updated, you must uncheck then recheck the option for each user for whom you want to apply the update. 

It is therefore possible to consult the Template available and that the user's display is completely different (since was a
previous template).
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Tutorial

It  may  be  convenient  to  get  interactive  support  during  the  first  few  sessions  with  Margill  Loan  Manager  (MLM).  The
tutorial can even be partially adapted by you in order to train your new users, according to your needs.

You can deactivate the tutorial  by clicking "No thanks...".  You can re-enable it  via  Tools  >  Settings  >  User  Settings  and
then select the "Show Tutorial" option.

It is possible to customize the tutorial text according to your needs. To access the tutorial customization module, simply
press the Ctrl + Shift T keys on your keyboard in the Main MLM window (Record Summary).
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In the "List of steps" drop-down menu, select the subject to be modified.

Title and text for the selected step will appear.
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You can add, replace, delete and format the topic text.

By saving the changes, the tutorial will be updated automatically for all MLM users who will display the tutorial.

Warning! All users, regardless of their access level, can adapt and change the tutorial via the shortcut keys.

Once the original tutorial has been modified, it cannot be recovered. In order to do this, please contact Margill support.
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Import Borrower, Creditor, and Employer Data

You can import Borrower, Creditor, and Employer  data into Margill Loan Manager (MLM), easily and in minutes.

The data should be saved in an Excel spreadsheet that includes headers for each field and the corresponding data in each
column. You can import just a few Borrowers or thousands if your license allows.

The actual loan data (loan amount, interest rate, number of payments, loan fees, etc.) cannot be imported using this tool
since  many  mathematical  aspects  are  involved.  The  Margill  team  offers  an  import  service  (fee  for  service).  See  Bulk
import of Loans and Database configuration.

Spreadsheet rules for importing Borrowers, Creditors,  and Employers:

 File format  xlsx (Excel spreadsheet format).

o If you have a CSV or text (. txt) file, you will need to convert it to an Excel format.
o It  is possible to import other file formats in  MLM but their  importing will  need to be done by the Margill

team.

Spreadsheet Features:

 File formats: .xlsx.
 Only the first tab of the workbook will be included.
 Column headings must be on the first line.
 The data must start on the second line.
 Data will be included up to the first totally empty line.  
 Data will be included up to the first untitled column.

If  your  old  system included  fields  not  present  in  the  basic  MLM  fields  (full  name address,  email,  etc.),  first  create  the
custom fields in MLM. To do this, go to Tools > Settings > System Settings (Administrators) > Custom fields > Borrower (or
Creditor) tab, and then use the 1 to 9 or the unlimited fields (Table format).

These fields can even include scroll menus that you create. Be careful with the field types (text, currency, integer, etc.)
because they must correspond to the fields from your Excel spreadsheet. The text format field is a catchall format. See
Custom fields and Scroll menus.

Procedure

To import data into MLM, go to Tools > Settings > System settings (Administrators) > Special > Import Data (Borrower,
etc.). 
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The following window will appear:

The first step is to select the file to be imported.

Once selected, the fields on the first line of the spreadsheet will appear in the center "Column Header Name"column.
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Click on the spreadsheet field that you wish to associate with the MLM field. In the example below, "LAST NAME" was
selected.

Select the MLM field in the left table that corresponds with the field in the right table and click on the arrow to insert the
field in the "MLM Field Name" column. In the example below, "Borrower - Last Name" was selected for "LAST NAME".
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Please note that the MLM fields in red are Mandatory fields  (set by the Administrator)that must absolutely be included
in the field list that you wish to import, otherwise an error message will prevent you from continuing.

Once all the field associations are done, click "Import". There is no need to import each field separately. If the field is not
connected to the Borrower (or other), leave an empty space.

If an error is detected in the source file, the corrections should be made to the file before any importing is done. Be sure
to follow the "Spreadsheet rules..." above.

Data Validation:

 At least one of the following must be entered: Business, First name or Last name.

 The field format (Date, Numerical, Integer, etc.) must be followed:
o The Date format must be a "Date" type cell in the spreadsheet.
o The Percentage format must have no more than four decimal places.
o The Currency format must NOT include the currency and must have no more than two decimal places.
o Note: The Text format may include any type of alphanumerical character. The Text format is universal.

 A value under "Unique Identifier" must not be repeated.

 When a scroll menu is defined in Margill Loan Manager, the imported data must correspond EXACTLY to what is
included in  that  menu,  including  upper  and  lower  case  (small  and  capital  letters),  special  characters,  accents,
spaces, etc.

Errors will be identified at the first attempt in the "Import Report Preview" window. In the example below, the data in
red,  "12/31/2999"  was  not  a  real  date.  Margill  reports  the  errors  because  it  will  only  import  data  after  all  errors  are
corrected.
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The "Table to Excel"  button allows you to export the table to Excel. However, problematic data
will not be highlighted. It is suggested that the red cells remain visible by keeping the MLM window open before making
corrections to the spreadsheet. Make the corrections and then import again according to the procedure above.

Once all the corrections are made, the "Update" button will appear.  It  will  perform the import and
will be followed by a confirmation including the number of Borrowers (or other) imported into MLM.

You can close the System Settings window by clicking on Cancel.

Note: Once Borrower (or other) data is imported, additional data for the existing Borrowers cannot be imported with this
tool.  This  additional  data  will  have  to  be  entered  manually  (or  with  the  automated  import/update  via  API  -  see  link
below). The Tool can nevertheless be used to enter other batches of Borrowers at any time.

Automated imports via JSON and Excel files or Salesforce API allow for automated loan and borrower data import and
updates. 

NOTE: With the Automated imports, there is an option to manually create Loans and Borrowers using a unique Excel or
JSON file for both Loan and Borrower data as opposed to using a file for Loan data and another for Borrower data. Errors
however, appear in a log, not in real-time like the import process described in this chapter.

Saving the Import Format

Once defined, you may save the Import Format by pressing on the “Save Import Format” button. You can then reimport
data at any time without the need to reconfigure the import tool. However, the spreadsheet must have the exact same
format (heading names, number of columns, data format).

   

Bulk import of Loans and Database configuration
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If  you currently have a database of  a  few dozen loans  or  more,  the  Margill  team offers  a  data  import  service from an
Excel file (Access database or other) and will help you through the Database configuration process (custom fields, drop
down menus, etc). Please contact the Margill team for more information. Additional fees will apply for this service. See
also, the Import Borrower, Creditor, and Employer Data section.

Structured  data  is  best.  The  word  “structured”  is  used,  since  often,  payment  schedules  include  partial,  late,  unpaid
payments  and  a  host  of  other  irregular  payment  scenarios.  These  usually  cannot  easily  be  imported  into  MLM  except
manually. These irregular scenarios can sometimes be imported into MLM if they are well structured (every payment line
corresponds to a standard type of payment, etc.). Extra fees are required for this. See Strongly suggested below.

What can be imported are:

 Borrower data
 Employer data
 Creditor (Lender) data
 Loan data (origination date, first payment date, principal, interest rate, compound or simple interest, payment

frequency, amortization, term, balance, day count, etc.)
 Custom  fields  (for  Borrower,  Creditor  and  the  Loan  itself).  See  also  Useful  Features  >  Bulk  Import  of  Loans

(Manually)
 Custom scroll menus (pull-down)

The steps are as follows:

1. If  required,  a  Non-disclosure  Agreement  signed  by  us  since  you  will  be  sending  us  proprietary  and  confidential
information.

2. Determination by you as to the data you wish to import. One important decision is whether to import the history of
the loan or, easier to implement, the balance on a specific date and the schedule in the future. If you decide on the
latter, the historical payment table can simply be attached to the Record as a file. See Strongly suggested below.

3. You provide us with all the fields to export to MLM. We analyse your fields to match with MLM fields. If we do not
have your field, we create a custom field. 

4. We submit our custom fields for discussion and approval. Scroll menus can also easily be created for standard data
choices.

5. You submit your database.

6. We convert and import the data to MLM and submit the entire database for approval. If there are no problems, then
we are all set.

7.  You adjust for custom scenarios if needed.

Strongly suggested:

Import only  data  going  forward as  opposed to  all  historical  transactions since importing  all  transactions becomes very
time consuming. Often data is  imported starting on the current fiscal  year.  So a  few months  of  historical  data  may be
entered and then managed manually for paid, unpaid, partial payments. Use as the Principal amount, the balance on the
last payment date (before the first day of the fiscal year) and use that date as the Origination date. First payment date
will usually be one period after the Origination date entered. For the number of payments, enter the remaining number
of payments. Use custom fields to enter the true Principal amount, true Origination date and true amortization period.

It is also possible to import, with an Excel sheet, regular and irregular due, paid and partial payments as well as additional
principal.

Automated imports via JSON and Excel files or Salesforce API allow for automated Loan and Borrower data import and
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updates. 

Emails sent to Borrowers when new Records (loans) are created

MLM offers the possibility to send emails according to a personalized template when importing the Records into MLM.

By choosing this option, an email will be sent automatically to Borrowers linked to the Record for all imported Records.
Of course,  the Borrower email  must have been entered previously.  If  you wish to exclude some Records,  import  them
separately.  In  order  to  learn  more  and  for  the  procedure,  consult  the  Useful  features  section  >  Emails  -  Sending
automatically or in batch  with Templates.

   

Integrating Existing Loans

If you have a database of at least a hundred or so loans, the Margill team offers a data import service from an Excel file
and will help you through the Database configuration process (custom fields, drop down menus, etc). Please contact the
Margill team for more information. Additional fees will apply for this service. Also, see section Bulk import of Loans and
Database configuration.

In order to integrate some existing loans to your database, use the following tricks:

 If the loan's history is a complex one such as unpaid amounts, partial payments, etc., we suggest not to include this
history but rather to simply add the file to the Folder. See Useful Features > Attached Documents.

 If, on the other hand, the loan's history is simple such as payments made on time and the Record does not contain
major irregularities, it will be better to integrate the loan's entire data and manage previous payments by changing
the Status from "Due Payments" to "Paid Payments" by using Payment update ("Post Payment"), a tool that allows
Line statuses to be changed in bulk.

Example of loan integration with a complex history:  

First determine the date at which the import will take place. Ideally, it would be at the start of a financial year but any
other date can be used. In this example, the import date will be January 1st. 

The loan was originally 60,000.00, amortized over 5 years (60 monthly payments) due on the 5th of each month with an
annual  interest  rate  of  8.25%.  This  loan  includes  skipped/missed  payments,  partial  payments,  late  payments  and  late
fees. Therefore, the history will not be imported.   

Since we need the  data  starting  January  1st,  we need to  obtain  the  principal  and  interest  balances  from the  previous
servicing system:

 principal balance of 23,764.27 on December 5th
 interest balance of 322.45 on January 1st

Since the payments take place on the 5th of each month, the last payment before the new financial year (December 5th)
will be the loan's Origination date and the First Payment Date will be January 5th. 23 payments are left (in the future) and
the payment amount was 995.00.
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A  payment  schedule  will  be  generated  from  the  information  entered.  The  balance  will  not  be  0,00  because  of  the
irregular payment history.

To  add  the  interest  portion  of  322,45  that  was  accumulated  because  of  the  past  irregular  payments,  we  will  have  to
increase the interest rate enough at the very beginning of the loan (between December 5th and January 1st) in order to
generate this interest amount. 

Right-click on the mouse to insert a line above the first payment line.



Page 115

© Jurismedia Inc., 2007- 2023

Enter the period's start date that was determined (January 1st). Select Interest Rates > Adjust Rate for Line Interest = X by
right-clicking on the mouse.

Enter the interest amount in this window.

The payments schedule will appear with all the relevant information. Other fees or insurance could have been added at
the beginning of the loan with the Line statuses (negative amounts) or Column Fees (amount added in one or more of the
6 Column Fees) to better reflect the Loan Record. 
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Other example of a loan including fees and interest balance with interest adjustment through a Line status

An existing loan must be added to MLM without the historical transaction because this history is too complex to enter.

The original loan was 50 000 two years ago. When entering the loan in MLM (2020-01-01) the balance was 35 656,25,
divided as follows:

o Principal balance: 34 865,30
o Interest balance:     740,95
o Late fees balance:              50,00

Origination date of the loan: 2018-03-22
Date the loan is entered in MLM: 2020-01-01
Number of payments initially: 48
Number of remaining payments : 28
Original payment amount expected: 1211,08

In the Data window, enter the known data. We decided to enter the true origination date of the loan as opposed to the
date at which we have the balance (2020-01-01). We entered the first payment date of 2020-01-01:
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Payment schedule as modified to include the respective balances dated 2020-01-01:

Notice the addition to line 1 of 740,95 as Line status "Interest charged" (renamed "Interest - adjustment") and on line 2,
the adjustment of the Late/NSF Fees (an "Other" Line status type - renamed, with payment of 0,00 but with an amount of
50,00 in the column "Late/NSF Fees -  Accrued").  The interest rate between the Origination date and the first  payment
date has been changed to 0% since the interest balance was entered by Line status.

The Payment schedule reflects the reality on 2020-01-01 with the theoretical  final  balance of  5249,53 (if  the Borrower
pays all his future payments). New payments will have to be added or the remaining payment amounts adjusted in order
to give a balance of 0,00.

See also: "Interest" type Line statuses

It is strongly recommended to use Custom fields to enter the original principal amount, the true origination date and the
original amortization period for future reference.

   

Creating and modifying a Borrower, Creditor, Employer and Loan Officer

To create a new Borrower, when opening Margill Loan Manager (MLM.exe), select "Borrower" under "File" to the left of
the window.
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The "Borrower Update" window will appear, where you can enter the data on the new Borrower, including data related
to the Credit report and any preauthorized payments (EFT). If the data of an existing Borrower appears, just click on the

 button to the left to access an empty window.

This window can be used for both Borrowers and Co-Borrowers since all will appear in the same database.

A Borrower identification number ("Borrower ID")  is  automatically assigned by MLM to each registered Borrower.  This
number is different from the Record's Unique Identifier ("Record No").

The "State/Prov." and "Country" fields can be defined as scroll fields. Go to Tools > Settings > "Field Scroll Menus." See
the Scroll menus section (under Tools and Settings) for more information on creating menus and defining standardized
data.

Unique  Identifier  1  and  2:  can  be  used to  bridge the  gap  with  third-party  software.  An  identifier  can  not  be
reused for another Borrower.
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The Borrower's "Email" file  offers the possibility to enter 300 characters in order to be able to enter multiple
email addresses. Use the semicolon ";" between each address (and no space), so they are recognized by the
various automatic MLM email sending tools. This field can also contain the mobile number of the Borrower
and the destination address according to the mobile service provider. So with "Email to text" technology, you
could, for example, send a text message to your Borrower with an address such as: 2125551212@txt.att.net.

To identify the Record or Records (Loans) that this Borrower "owns" in MLM, press the "Records" link at the
bottom of the window. A list of Records with their various IDs will be displayed with the Borrower's  "Role" -
if it is a Borrower or Co-Borrower for example.

Data entry for a new Creditor or a new Employer is done the same way by selecting the appropriate section.

The "Ctrl  Alt  Shift  C"  shortcut  in  the  Main  window allows  to  bulk  add or  change Creditors  for  the  Records
selected but only for Creditor in first position. See Mass adding/changing Creditors.

To create a Loan Officer (for a Creditor), press on Creditor (under File) and then the "Loan Officer" tab. Choose from the
list of Creditors, the Creditor that will be linked to this Loan Officer, then press "New". An Loan Officer must be linked to a
Creditor and a Creditor can have multiple Loan Officers.

In the example below, Lisa Boswell is one of the loan officers for Heavy Industries.
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To  identify  the  Record(s)  (Loans)  with  a  Creditor  in  MLM,  press  the  "Records"  link  at  the  bottom  of  the
window. A list of Records with their various IDs will be displayed and this Creditor's "Role" - if it's a primary
Creditor, secondary, etc.

See also Creating the first Record, Deleting a Record, a Borrower, Creditor, Employer and Loan Officer, Electronic Funds
Transfer, Credit Report, Borrower (Client) information and the Creditor (Lender) windows.
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Creating the first Record

To create the first Record, upon starting up Margill Loan Manager (MLM.exe), go to the "File" button on the left and in
the sub menu select "New Record".

 
Basic Loan Data

The "Data" window will open allowing you to enter the preliminary data. 

Please note  that  if  a  loan  or  other  financial  instrument  is  irregular  or  somewhat  irregular,  the  precise  loan  payments,
dates, amounts, additional principal, type of refund (interest-only for x periods), etc., may be changed in the "Payment
schedule"  (payment  schedule).  A  loan  may  thus  be  totally  irregular  and  customized  in  the  "Payment  schedule".  See  (
Fundamental principles of operation).

Data window

Borrower, Co-Borrower and Employer



Page 122

© Jurismedia Inc., 2007- 2023

Borrower, Co-Borrower and Employer (if  desired) information may be entered in the "Borrower" (or  its  "Co-Borrower"
sub-tab)  window  or  through  "File",  "Borrower"  in  the  Main  MLM  window.  An  existing  Borrower  and/or  an  existing

Employer  may be tied to a loan with the "Select" button . 

It is possible to add the participation percentage of each of the Borrowers and Co-Borrowers for a Record. Please note
that this option does not permit the extraction of this information. It is solely for informational purposes. Reports with
these participation percentages can be custom built by the Margill team. Additional fees will apply.

Creditor or Co-Creditor

Creditor information may be entered in the "Creditor" window or through "File", "Creditor" in the Main MLM window. An

existing Creditor may be tied to a loan with the "Select/Add" button . Multiple Agents (Loan Officers)
may be assigned to a Creditor. Multiple Creditors may have participations in loans based on ownership percentages (or
amounts)  in  the  loan.  They  can  also  be  assigned  different  Returns  (%).  See  the  Participating  Loan  subsection  in  the
Creditor section.

Credit Reporting

See the Credit Reporting Module Section.

Fees and APR
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Fees and Points for APR (Annual Percentage Rate) calculation may be entered in the "APR" window.

Alerts

See the Alerts section.

Advanced

The "Advanced" window allows you to change the method (Compound interest (Effective rate method), Simple interest
or Simple interest (capitalized)),  the Year base for simple interest,  the Day count, the Short period calculation method,
the number of weeks in a year and the Record Log.

Attach

The "Attach" window allows you to attach various documents to Records or to attach the Payment schedule to an email.

Payment schedule

Once the preliminary data is entered, press on "Compute"  to produce the Payment schedule. This
schedule may then be edited and customized to reflect the reality of each loan.

Once the  Payment  schedule is  created and modified if  needed,  press  on  "Save" to  save the  Record.  A  unique number
"Record  No."  is  assigned  to  the  Record.  This  number  is  unique  and  serves  as  the  Record's  unique  identifier  in  the
database.

Unique Record Identifier / Borrower / Creditor / Employer

If  you wish to use the identifier as the unique identifier in  your operations,  you may start  the numbering at  a  number
other  than  100  (for  example  an  existing  number  in  you  old  system  or  1000,  10001,  etc.).  Assign  a  starting  number
through  the  "Tools"  "Settings"  window  by  pressing  on  "Ctrl  Alt  Shift  I"  (letter  i).  The  following  window  will  appear  in
which to enter the desired starting number for the Records, the Borrowers, the Creditors and the Employers. 
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If  Records  are  already  entered  in  MLM,  these  will  not  be  renumbered,  thus  the  importance  of  starting  the  desired
numbering at the very start of the real (as opposed to simply tests) Record data entry. 

See also Setting the Records' Unique Identifiers.

See also, Identical loans to duplicate an existing loan or a slightly modified one. This function will save you valuable time
in data entry.

See also:

Data entry screen Basics and the calculation Variables.

Amortization (payment) table.

How to do various types  of  calculations:  loans,  mortgages,  ARMs,  lines  of  credit,  leases,  bonds,  collection,  late/unpaid
salaries, rent or annuities and fees. 

   

Setting the Records' Unique Identifiers

A unique number "Record No." is assigned to each saved Record. If you wish to use this identifier as the unique identifier
in your operations, you may start the numbering at a number other than 100 (for example an existing number in you old
system or 1000, 10001, etc.). 

Assign a  starting  number  through the  Tools  >  Settings  window by  pressing  on  "Ctrl  Alt  Shift  I"  (letter  i).  The  following
window will appear in which to enter the desired starting number.
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If  Records  are  already  entered  in  MLM,  these  will  not  be  renumbered,  thus  the  importance  of  starting  the  desired
numbering at the very start of the real (as opposed to simply tests) Record data entry. 

See also, Creating the first Record and Custom Unique Identifiers.

   

Deleting a Record, a Borrower, a Creditor, an Employer or an Agent

Deleting a Record

To delete an existing Record, in the Main Margill Loan Manager window (Record Summary window), highlight the Record
or Records and with the "File" menu on the left, press on "Delete".

A  Record  or  Records  can  also  be  deleted  from  the  Record  Summary  window  with  the  "Delete"  or   "Delete  Selected
Records" choices  available  through the  right  mouse  click  menu.  For  security  reasons,  only  a  Margill  Administrator  can
delete more than one Record at a time.

An Administrator can prevent any user (including another Administrator but  who can restore this  right though...)  from
deleting Records. This is strongly suggested to prevent Record deletion by error or for illegitimate reasons. Go to Tools >
Users and click on "User cannot Delete Records/Borrowers/Employers/Creditors".

 

Deleting a Record will not delete the data for the Borrower (and Co-Borrower), (s) Creditor (s) or the Employer associated
with it.

Deleting a Borrower, Creditor or Employer

To delete a  Borrower, a  Creditor or  Employer,  simply click on  the  corresponding menu button  on  the  left  of  the  Main
MLM window ("Record Summary").
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Then  highlight  the  Borrower,  the  Creditor  or  the  Employer  to  delete  by  clicking  on  it  with  the  mouse.  Then  click  the
"Delete" button at the bottom of the window.

It will be impossible to delete a Borrower, a Creditor or Employer if it is assigned to one or multiple Records. 

Borrower (or other) that can be deleted Borrower (or other) that cannot be deleted because it is
associated with a Record

Deleting a Loan Officer

An  loan  officer  may  be  removed from the  system by  choosing,  under  Creditor  (File  >  Creditor),  the  name  of  the  loan
officer and then pressing Delete. It will be impossible to remove a Loan Officer if it is assigned to one or multiple Records.

See also sections Creating the first Record, Creating and modifying a Borrower, Creditor, Employer and Loan Officer.

   

Duplicating Records

Duplicating loans or other financial instruments with similar or identical characteristics (data)

If  multiple  loans  use the  same data  (Start  date,  Compounding,  Interest  Rate,  Payments,  etc.),  to  save  time,  instead  of
using the "New Record" tab to create this loan, select an existing loan or loans in the Record Summary window and with
the right mouse click, choose "Copy Record" (or "Copy Records"). 

All Record data will be duplicated but you will have the choice to include or not the data contained in the "Custom fields"
(unlimited)  and  the  "Alerts"  pertaining  to  the  Record  (including  Conditional  Alerts).  However,  data  pertaining  to
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Electronic Funds Transfer will not be included. 

The duplication can also be done in the Record itself. Open the desired Record. The Payment schedule will appear. Press
on the "Data" tab, and on the "Modify/New Record" link:

This window will appear allowing you to either:

1)  creates a new Record using the new data displayed in the "Data" window (but will not include
the changes made in the Payment schedule - these will be lost),

This  option  will  not  change  the  information  in  the  "Borrower",  "Creditor"  "Custom  fields",  "APR"  and  "Advanced"
windows. This should be done separately if need be.

See also Change of compounding or calculation methods without affecting the existing Payment schedule.
 
OR

2)  creates a new Record while clearing all data in the "Data" window. If default settings were
set for the Data window, these will appear as opposed to a blank window. The "Borrower", "Creditor", "Custom fields",
"APR" and "Advanced" data will also be cleared or set to the default settings.

Change only the required data if need be and press on "Compute". 
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If  the  default  Data  settings  are  not  wanted,  press  on  the  "Clear  Data"  link  and MLM  will  prompt  you  to
clear the window or to load the default settings. 

 

Once the Payment schedule appears, press on "Save" and MLM will prompt you to "Save changes" then to "Overwrite"
the existing Record or to "Create a new Record".

By pressing on "Create a new Record" a new Record will be created and a new Record number will be assigned.

If you click on "Update", another window will  open in order to confirm your choice and the changes will  be made and
saved (or not) to the existing Record:

If you click on "Always update" button, you will no longer be asked if you wish to update the Record or create a new one.
This is one less click to press when saving since the window below will no longer appear.
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Should  this  window  be  needed  again,  or  if  you  had  mistakenly  chosen  the  option  "Alway  Update",  it  is  possible  to
reactivate the option via Tools > Settings > User settings tab and select "Display the tips and messages".

See also Saving and Change of compounding or calculation methods.

   

Profiles

Margill Loan Manager (MLM) offers very powerful default setting options in order to reduce data entry to a minimum.
MLM allows the creation of default settings called "Profiles".

Profiles may be set for each of the following information windows that apply to a Record.

Loan  information  ("Data"  window)  -  for  example,  a  type  of  loan  with  particular
characteristics  (compounding,  principal,  dates,  payment  amount,  rate,  etc.)  may  be  saved
under a specific name and this loan template called up when needed.

APR  data  -  for  example  if  most  loans  from  Creditor  ABC  include  a  1%  fee  (points)  called
"Service fee", this particular APR profile may be saved. 

Advanced  functions  -  for  example,  if  calculations  made  by  your  organization  are  always
simple interest and based on 30/360, this profile may be created.

To  create  a  profile,  first  enter  the  desired  information  for  that  Record  (see  Creating  the  first  Record).  In  the  example
below, a profile is created for a category of loans (principal of 10,000, rate of 8%, 12 months, compounded monthly). We
named in a cryptic method as "10k,8%,12"

Once all data is entered, click on "Save profile". The following window will appear in which to name the profile (profile
description):
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To retrieve a profile click on "Load profile". The following window will open if one or more profiles are defined. 

Double click on the desired profile and the information will appear in the window.

To delete a profile, select the profile and right click with the mouse. "Delete" will  appear.  Click on and the
selected profile will be deleted. 

The same profile method applies for each of the three information windows.

   

Custom fields

Margill Loan Manager (MLM) includes an unlimited number of custom fields in three sections: 1) Record Data window 2)
Borrower window 3) Creditor window. They are displayed in the "Other Data" tab of each of these sections. This can be
useful for adding additional information to that provided by the standard MLM fields.

The custom fields may be applied to the Loan as such (fields in the "Data" window), the Borrower or the Creditor.

 A field related to the Loan would include data from the loan itself. For example, it may be interesting to create a field
that  indicates  the  number  of  jobs  created  (expected)  as  a  result  of  this  funding  or  a  risk  factor  for  the  loan.  It  is
important  to  understand  that  these  fields  are  related  to  the  Loan  as  such  and  not  directly  to  the  Borrower.  We
would not put the Borrower's license number in one of these custom fields. Such a field would be a custom field in
the Borrower. See Record Data.

 A field  related to  the  Borrower would  be,  for  example,  the  end  date  of  the  financial  year  of  the  company,  or  for
individuals, the annual income, credit score, etc. See Borrower (Client) information.

 A field related to the Creditor would be, for example, the name of a additional contact, such as the person actually
signing the contract. See Creditor (Lender).

Fields come in two formats in different sections:
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1) Fields 1 to 9
(field-type
format)  

2) Unlimited fields
(Table format)

Distinction between the 1 to 9 fields and the Unlimited fields in table format

The advantage of  the nine custom fields that  are linked to the "Data" window, as compared to all  other custom fields
(unlimited fields in table format in "Data" and all fields for Borrower and Creditor), lies in the fact that they appear in the
"Post payments" window. This can  be  useful  when one identifies  the  payments  due at  a  certain  date,  in  order  to  sort
these payments based on other criteria, such as, for example, the payment method (check or pre-authorized payments).
It is thus recommended to choose the "Data" window custom fields based on the needs of the "Post payments" tool. 

Unlimited fields (Table format) have the advantage, for the text and text scroll menus format, that they can include up to
1000 characters as well as paragraphs. The maximum size is 100 characters for the 1-9 text fields and 50 characters for
the text scroll menus. See Appendix 1 - Field Characteristics and Lengths.

The unlimited fields can also include a GL number (see explanation below in the Unlimited custom fields sub-section).

Up to three (3) custom fields (table format), assigned to the loan as such, can be used as display filters in the Main MLM
window (Record Summary). These fields must be of scroll menu types  (see Display Filters section).

The nine custom fields provide a minor advantage over unlimited fields in table format because they look slightly better
in the window and the data displayed is more sophisticated. This does not affect their display in the Main MLM window
or their formatting when reporting.

Field Creation / Configuration

Only the MLM Administrator can set or change these fields.
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The field names, field types and default values (if desired) are configured in , , with the

button  under the "System settings (Administrators)" tab. 

To configure the fields, press "Edit". In the "Description" column, name the fields to reflect the required information to
be  entered.  If  fields  have  already  been  configured,  they  will  appear  in  black  and  may  be  modified  or  corrected  if
necessary. For each custom field created, the corresponding "Field Type" column must be set by using the scroll menu.

A default value can also be entered in the corresponding "Default value" column. This can be useful in situations where
the field value is the same for most of the loans in the portfolio.

See Appendix 1 - Field Characteristics and Lengths for further information on the number of characters allowed for each
field type.

Scroll menus can also be defined here with the desired default values. The values allowed in the drop-down menu can be
entered manually or imported via a simple Excel sheet (data in column A, no header). To do so, click on the Excel button
and import the sheet. It is strongly recommended reading the ? in order to learn about the format and some subtleties.

See the Scroll menus section.

The Administrator must specify the field type:
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 Text:  allows  you  to  enter  alphanumeric  data  and  special  characters.
The text format offers greater flexibility as other formats must follow
stricter criteria. The disadvantage is the fact that the text format data
can not be treated mathematically in MLM or as easily when exported
to a third party systems.

 Numerical
 Monetary
 Percentage (%)
 Date
 Integer
 A  series  of  Menus  (Text,  Numerical,  Monetary,  Percentage,  Date,

Integer) allows configuration of scroll menus offering multiple choices
depending on the selected value. See Scroll menus.

IMPORTANT: Once the field "Type" is chosen and data has been entered for this field, be very careful when changing the
Field type since data may be lost or illogical information may be generated in the Record List report. For example, a Text
field containing text data, if changed to a numerical value could lead to 0.00 being the new value in all Records, leading of
course, to loss of data.

Unlimited custom fields

The "#GL" column defines the field as a custom field that will be used in the Export accounting transactions (Debits and
Credits) to the General Ledger module. For example, in your accounting system, each Borrower has a unique GL number
for  the  Principal  which  is  refunded  when  payments  are  made.  You  should  therefore  enter  a  unique  number  for  each
Record. This unique number will then be used in the Export accounting transactions (Debits and Credits) to the General
Ledger module.

The  display  order  for  users  can  be  changed  using  the  blue  side  arrows.  In  the  Record  itself,  the  user  can  also  sort
alphabetically or in the order defined above with the "Order" column that appears.
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The "Import" button (accessible for unlimited fields related to Data) allows the user to quickly import
specific fields that have already been defined by the Margill team. For example, fields required by investment funds, etc.
Contact the Margill team at support@margill.com if you have special needs.

Up to three unlimited fields related to the Record can be used as Display Filters. See Display Filters.

See also: Scroll menus, Line status, Display Filters and Appendix 1  - Field Characteristics and Lengths.

   

Defining Line (Payment) Statuses

Margill  Loan  Manager  (MLM)  allows  you  to  include,  in  the  payment  schedule,  a  variety  of  payment  types,  additional
principal, fees, insurance, penalties, etc., known as "Line status". In all, there are over 70 possible Line statuses.

In  Tools  >  Settings  >  Line  Payment  Statuses  >  System  settings  (Administrators),  you  can  change  the  names,  eliminate
some  choices  not  required  and  change  the  order  of  the  Line  statuses  in  the  Payment  schedule  scroll  menu  (second
column). You thus obtain a system better adapted to your needs.

Consult the various sections that detail Line statuses:

Line status

"Payment" Type Line statuses
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"Principal" Type Line statuses

Accounting Data and Line status

Data Integrity

   

Email connection (Batch emails)

With  Margill  Loan  Manager  (MLM),  you  may  attach  documents  to  emails  to  be  sent  in  batches  to  Borrowers.  These
emails  can  be  sent  with  the  Document  Merge  tool.  You  may  also  send  automatic  emails  via  Line  status  Alerts  and  in
batches via the Main window and throught he Alerts tool.

You will have to configure MLM's email settings:  Tools > Settings > System Settings (Administrators) > General Settings >
Email Connection.

The Connection Settings window will open.

MLM is  not  an email  management software but  simply  allows you  to  send messages.  It  does  not  allow you to  receive
messages. It uses your outgoing mail server, whether this is hosted on your server, by your Internet Service Provider or
on-line (Gmail for example).

Each  User's  connection  must  be  configured.  In  the  drop-down  menu,  choose  the  User's  name  for  which  you  want  to
configure  the  email  connection.  If  more  than  one  user  can  send  emails,  click  on  "Copy  Data  from  ADMIN"  (once  the
"ADMIN" data is entered and saved). Doing so will avoid you needing to recopy data for each MLM User.

Complete the following information:

 SMTP Server Name
 SMTP User Name
 User's Password
 Port Number
 Secure connection via TLS protocol (optional)
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 Sender's Email
 You can also choose to send a copy to a specific email. Doing so is not recommended for mass emails because this

email Inbox may get full.

If you are using Gmail messaging, instead of using SMTP, you can choose the Gmail API which uses the simplified OAut 2.0
connection technology. See Email connection for more information.

Be careful, your Internet Service Provider might impose a limit on the number of emails sent in a short time period,
especially when sending mass emails with the Document Merge tool. Check with your Internet provider.

If  a limit is indeed imposed, write down a delay in seconds or in fractions of seconds in  the "Delay in  sec." field at  the
bottom of  the  Connection Settings  window.  The emails  will  then be  sent  at  intervals.  You will  have  to  try  many  delay
times to find the shortest one (to reduce the overall time it takes to send the emails). 

This configuration is generally performed by your network administrator.

Your Internet Service Provider could have a limit on the number of emails that can be sent at the same time or during a
day. The "Delay in sec." function allows to send each email seconds apart. Check with your Internet provider about the
best  way  to  deal  with  mass  emails  and  ask  about  the  maximum  number  of  emails  that  can  be  sent  without  being
blacklisted.

It is very important to be sure that everything works well by clicking on .

When the pop-up window appears, you will have to enter a recipient's email address to test the connection. Verify that
the email was received in this Inbox (usually yours).

Finally, before sending emails to clients, be sure to perform some tests by sending emails with the Document Merge tool. 

Sending many emails related to one Borrower

Users can add many email addresses to the same Borrower file. This feature is very convenient when a user must send
merged documents such as statements or invoices and the Borrowers or  Creditors want these documents delivered to
many email addresses. 

In the email field of the Borrower file, enter all the emails each separated by a semicolon (;).
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Email mass sending test tool

In the Email connection settings Batch Testing tab, you will find an email mass sending tool. This tool allows you to send
real emails, in test mode, before sending with the normal Margill batch sending tools. Its goal is really to see if the email
provider accepts the required email volume.

You can enter the same email or multiple emails to see, for example if your email provider sets a limit. If you enter 5 test
emails and enter 500 in the Number of emails, each address will be used randomly.

It is recommended to test with emails outside your corporate email domain (test wit Gmails, Hotmails, personal emails,
family...). Entering a unique email with 500 emails sent, for example, may not be very representative of real-life... 

The goal of the tool being to see if the emails are accepted or not by the email provider, the Message column will simply
show  if  the  email  was  accepted  or  not  by  the  email  provider,  it  will  not  determine  if  the  email  was  delivered.  For
example, the first 500 emails may be accepted but depending on the sending limit, the next 500 may be refused and the
message will indicate so. 

It is recommended to check the daily (or hourly limit maybe) with your email provider.
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Backup (data)

Over a  period of  time, users will  produce a large quantity  of  important  client  data  (loan information,  payments,  client
information,  etc.)  with  Margill  Loan  Manager  (MLM).  This  data  is  often  mission  critical  for  a  company  and  a  loss  may
imply a serious threat to the organization's livelihood. It is thus imperative to put in place the proper infrastructure for
data backup.

The user is entirely responsible for the client data produced with MLM. NEITHER JURISMEDIA, NOR ANY PERSON HAVING
PARTICIPATED IN THE CREATION, THE PRODUCTION OR THE DELIVERY OF THE PRODUCT CAN BE HELD RESPONSIBLE in
case of data corruption, destruction or loss of this data.

It  is entirely up to the user to regularly (once a day or more if  required) create backup copies of his client data and to
store these backup copies in a safe place.

See also License.

Files to backup

MLM  data  files  are  either  located  in  the  MLM  executable  folder  or  in  a  data  folder  determined  by  the  MLM
Administrator. The most critical data is located in the "DB" subfolder. The "DB" subfolder contains over 140 files with the
following  extensions:  *MMO,  *.FIC,  *.NDX.  Other  less  critical  data,  may  be  present  for  Credit  Reports  and  Electronic
Funds Transfer and are located in the Metro2 subdirectory, and other folders. See Location (Path) of System Data.

If the data is contained in the installation folder, then it is suggested to backup the entire folder, usually called MLM.

If the data is contained in a data folder, a backup of the entire folder is sufficient.

Backup copy location (Path)

The MLM Administrator can define the backup location (the path) to be used when a backup is performed by one of the
Quick backup methods, or when the system suggests a backup copy when important changes are made to the database.

The Administrator can set this location through Tools > Settings > System Settings (Administrators) > Data and Backups >
"Quick  Backup  Folder"  section.  Simply  specify  the  folder.  The  Quick  Backup  (see  next  section)  and  the  recommended
MLM backups can only be done in the defined folder. 

The  Administrator  must  ensure  that  data  is  backed  up  securely  from  all  normal  information  technology  security
perspectives.
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Specify the path by pressing the folder  icon.  If  the folder does not  exist,  click  on  the  "Make New Folder"  button,
select it and press OK. 

Then press Save .

It is strongly discouraged to create a subfolder in the data directory (MLM_DATA above) since the backup will be made of
old backups and there will be a continuous duplication of data, greatly increasing disk space.

Secondary backup of the Payment schedule

If you decide to check the "Activate the Secondary backup of the Payment schedule (Payments schedule)" feature, each
time a Record is modified, the Payment schedule and other essential data will be saved in a compressed format (ZIP) and
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will be protected by a password.

In  case  of  corruption  or  any  other  problem,  this  feature  will  allow  you  to  recover  individually  one  or  many  Payment
schedule.

The Payment schedule will be saved in the "RecordsTextFormat" subfolder. The space used is approximately 10 Mo for
1000 Payment schedules.

WARNING:

This feature does not replace backing up your data. This tool can only recover Payment schedules. All the other related
data (Borrowers, Creditors, custom fields, etc.) cannot be recovered.

We strongly recommend saving all data every day.

If  a problem occurs and you would like to recover some Records,  click on the button.  This
window will open:

Records that  seem corrupted or  empty  (that  do  not  include  any  payments)  will  appear  in  the  top  left  window (in  the
example above there are no issues). It will be possible to select Records that will need to restored by selecting them and

clicking on the blue arrows in order to transfer them to the right-side window. 

It is also be possible to enter the Record manually in the window "Enter other Records to be restored. Separate Records
IDs with commas". Enter the identification number of the Record to be restored and separate them by a comma. When

this step is completed, click on .
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When  all  Records  to  be  restored  are  transferred  to  the  top  right  window,  click  on

.  Margill  Loan  Manager  will  restore  Records  in  two
ways:

 If  the  Record's  identification  number  included  in  the  file  name  (text  format)  is  found  in  the  database,  the
corresponding Record will be updated and the Payment schedule will be replaced by the one in the text file (ZIP).

 If the Record's identification number is not found in the database, a new Record will  be created with the Record's
initially saved settings.

These windows will appear:

>>>

Quick Backup

Data  backup  is  possible  through  "Tools"  and  "Backup"  .  MLM  will  create  in  the  backup  folder
designated  by  the  MLM  Administrator,  a  subfolder  indicating  the  date  of  the  backup  and  the  MLM  version  (in  the
example below, the date is 2016-05-09 and the version 4.3.160428.1). A user must have the permissions to create this
folder. The permission must often be granted specifically by your network administrator.
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If the data remains in the MLM install folder, the whole folder will be backed up, including the software itself. If on the
other hand, the Data folder is outside the MLM installation folder, only, but all, the folders and files that are contained in
the Data folder will be saved.

Automatic Backup (Overnight Tasks)

Automatic tasks, also known as "Overnight Tasks", allow you to accomplish certain tasks that can be programmed to be
done outside of  normal business hours,  therefore eliminating waiting time. For example,  it  is  possible  to  program the
automatic MLM backup at 1:00 AM, even if MLM is not opened. The server or computer on which MLM is installed must
be opened or be in sleep mode so that the folder is available.

In order to learn how to program an automatic backup, see Settings > System settings (Administrator) > Automatic and
Overnight Tasks.
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Updates

Margill Loan Manager (MLM) includes two types of updates:

1) Software update

2) Interest and sales tax tables updates

Consult each section for further information.

Support, maintenance and update contract 

Updates and support are available at no cost for a period of one (1) year following the purchase date. Afterwards, the
user  may subscribe to  the  update  and  support  services for  a  certain  fee.  An  invoice  is  sent  by  email  to  the  purchaser
before the renewal date.

See also:  Support, maintenance and update contract

   

Software updates

To  check  for  Margill  Loan  Manager  (MLM)  software  updates,  go  to  the  "Other"  tab  and  press  on  "Check  for  Update"

. MLM will check on the Margill web site to see if a newer version is available.

One can also access the updates on line at:
www.margill.com/get

Margill Loan Manager includes many "software":

 MLM.exe (the main software)
 MLM_Overnight_tasks.exe (software that performs the Overnight Tasks)
 MLM_Repair.exe (software that "fixes" the database)
 MLM  Imports.exe  (located  in  the  MLMImports  folder)(Windows  service  that  updates  data  automatically  by  API

(JSON, Excel and Salesforce)
 HTTP_Margill.exe (located in the HTTP_Margill folder)(Windows Service that picks up MLM data and brings it to the

Web)

Minor  updates  are  done  through  "patches",  files  that  are  downloaded  and  copied  to  the  MLM  folder  (MLM.exe  and
Margill  Loan  Manager.wdd).  For  major  updates,  a  full  installation  is  required.  This  installation  includes  MLM.exe,
MLM_Overnight_tasks.exe and MLM_Repair.exe. The Margill Windows Services are separate installers.

After downloading the update, the installer will automatically search for the proper MLM folder. If the folder is not found
automatically (especially in  more complex network installations),  the  user  will  then have to  find  the  appropriate  MLM
folder and indicate this upon installation.

The "Check for software updates" frequency may be changed in Tools > Settings.  The software may check for  updates
monthly, weekly, daily, or never ("None"). If "None" is chosen, you should check for updates regularly with the "Check for
Update" button under the "Other" tab.

http://www.margill.com/get
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Before updating, always backup the entire MLM folder and the database if it is located elsewhere!

When a full installation is required, install OVER the existing version (always completely backup first). The database will
be updated automatically.

Support, maintenance and update contract 

Updates and support are available at no cost for a period of one (1) year following the purchase date. Afterwards, the
user  may subscribe to  the  update  and  support  services for  a  certain  fee.  An  invoice  is  sent  by  email  to  the  purchaser
before the renewal date.

See also:  Support, maintenance and update contract, Borrower (Client) information, Creditor (Lender) and Update from
previous versions to 3.x and above.

   

Comparative "Sandbox" version before live version update

When  important  updates  are  made  in  Margill  Loan  Manager,  the  development  team  sometimes  makes  mathematical
adjustments.

These adjustments should have, for the vast majority of calculations, no effect on the old calculations. In some situations,
these adjustments may have a very minor effect.

Thus,  the  Margill  team  created  a  Comparative  version  that  can  be  installed  before  updating  the  live  version.  It  then
compares current version data with updated data.

In addition to the tests you can do yourself, the red button ("Compare the data in the live version to that of the update")
starts a comparison of these three key data:

 Total interest
 Ending balance
 Last payment amount

If  these  three  data  of  the  updated  version  match  those  of  the  comparative  version,  you  can  install  the  update  with
confidence.

If differences are found, you will be able to study these before finalizing the update. Very minor differences should not
prevent you from updating to the latest version of Margill.

If you notice more significant differences, please contact the Margill team.

You can use the same installation file to install the update (no need to re-download).

Technical aspects

When installing the Manager update, by pressing the Comparative version option, a folder named "MLMSandbox" will be
created in a folder at the same level as the live installation. Your live version’s database will be copied to this folder and
updated. Your live version will NOT be updated with this option.

BE CAREFUL NOT to use this version as a real version. Its purpose is purely to compare the live version with the update
and perform tests (testing other special customized reports for example).
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This version does not  allow, among other things,  to destroy Records,  only  allows to  create "Drafts",  does  not  allow to
choose a Borrower, etc.

Once the comparison is done, you can delete the "MLMSandbox" folder or keep it. This version does not interfere with
the current version.

Procedure for the Sandbox installation before updating

1. Click on the program provided by Team Margill MLM_Install_.exe;

2. Choose the language;

3. This window will open. Choose the “Sandbox installation before updating”, and click on "OK":

4. Click on "I agree with the terms of the agreement":

5. Indicate the location (path) of the current active installation of Margill (the location of the “MLM.exe” file) and click
on “Next”:
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6. At this stage, a few warning messages may appear to warn you of potential problems. It will be possible to continue
or to cancel in order to make the corrections. 

7. Select the location in which to install the Sandbox and click on “Next”:

8. Click on “Install”. This might take some time before installation begins depending on the size of your database;
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9. Once the installation is done, the Administrator will have two choices: “Launch the program” and/or “Display an icon
on Desktop of workstation”. Click on “End”;

The icon will be distinctive from the regular MLM version by its name which will contain “MLM_Sandbox”.

 

10. When the Administrator launches the program or clicks on the icon on the Desktop, he will  be asked to enter the
user name and password, as is the case with the regular MLM:
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11. The delay for recalculating your Records will be in accordance to the size of your database.

12. Then,  the  Main  window  (Record  Summary)  will  appear  and  a  red  button  will  appear  so  the  Administrator  can
compare the live version’s data with and the data from the updated version. In order to prevent errors, we’ve made
this button hard to miss, because you do not want to use the Sandbox option other than to compare data:

13. By clicking on  the  “Comparison of  the  data  in  your  current  version  to  those  of  the  update”  button,  the  following
window will open. It will display the Records in which calculations are different from one version to the other. The
different Records will be isolated so that the Administrator can analyze them before updating the current version. In
theory, there should be no difference in the numbers.

14. Once the irregularities are dealt with, if necessary, the update can be done. Do not use the Sandbox version as a real
version. Its purpose is purely to allow comparison of the current live version with the update and to perform some
tests (for example, testing special custom reports).

While  testing  the  live  version  with  the  Sandbox,  no  changes  should  be  performed  in  the  live  version,  otherwise,
comparison will become impossible. Access to the live version should be blocked for the entire testing period.

   

Update from previous versions to 3.x and above

Versions of Margill  Loan Manager (MLM), which preceded version 3.0 were based on a flat file database technology in
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which all  the data in  a  Record was contained in a  single Record file.  As of  version 3.0,  the structure became relational
whereby a link is created between the loan and databases (tables) for the Borrower, Employer and Creditor.

When updating from an older version to version 3.x, the updating tool automatically creates these multiple databases (or
tables) and creates the links (or associations) required between loans, Borrowers, Employers and Creditors.

If  a Borrower has multiple loans (or if  one or  more Creditors own a portfolio),  the update tool  will  attempt to identify
identical Borrowers or identical Creditors and create a single entry for each instead of multiple entries with the same data
(thus eliminating unnecessary duplicates).

If, during the update, two Borrowers have identical names (name and/or business), but another field is not identical, the
automatic updating tool will add the file number to the business name (example (Record: 123)), even if no name appears.
This  allows  us  to  understand  that  these  two  entries  are  actually  duplicates  for  the  Borrower  or  for  the  Creditor.  It  is
suggested to review all Borrowers and Creditors and eliminate duplicates.

Hence, the tool offers the ability to merge data on two or more Borrowers or two or more Creditors. This tool is available
in  the  "Special"  section  of  the  "Settings"  window  under  the  "Tools"  menu,  followed  by  the  "Borrower  Merge"  and
"Creditors Merge" links.

It is possible, by clicking on any of these links, to change the account data (selected on the left side of the window labeled
"Old data") with those of another account to be selected on the right side of the window ("New data"). Confirmation of

this merge is done by clicking on the window's central arrow .

Thus,  the  data  from  left  disappear  BUT,  above  all,  the  tool  will  automatically  create  the  link  (association)  required
between the loan and the Borrower (or the Creditor if any).

In the example below, the Borrower Lucy Bernard appears twice. The Borrower card on the left is incomplete and also

includes an error in the address (the correct civic number being 223 not 222). Thus, by clicking on the , the left data
will  be  eliminated while  creating a  link  (association)  between Lucy  Bernard  and  File  123.  If,  for  example,  Lucie  was  to
move,  the  user  would  simply  need to  update  the  information in  one Borrower card  instead of  opening  each  of  Lucy's
loans and needing to make the changes multiple times.

IMPORTANT WARNING: Before making many of these changes, it is strongly recommended to make a backup copy of
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your data.

   

Interest tables (& Sales tax table) updates

Margill Loan Manager (MLM) interest tables can be updated by the user (see Updating / changing interest tables) or on
the Margill web site. Go to www.margill.com/get.

To access to the latest tables on the Margill  website, the user must be registered and have purchased MLM within the
year or opted for the Support, maintenance and update contract. 

Updating Interest rate tables

See Updating / changing interest tables.

Updating the Sales tax tables

Existing  sales  tax  rates  can  be  modified  and  new  rates  incorporated  with  MLM  to  allow  for  a  multitude  of  sales  tax
calculations. This can be done by the "Administrator" or a "Power user".

The  sales  tax  rate  table  contains  several  tax  rates  for  different  countries,  states  and  provinces,  as  well  as  a  rate  of
0.0000%. A new rate can be added to the table for calculating taxes in another jurisdiction. A rate can also be updated.

Since MLM is a bilingual program (English and French),  the table can contain terms in either language. If  a  term is  not
translatable or if you do not need both languages, then a single term can be used in both columns.

To add a new rate, to modify a rate, or to change the rates used by default: 

 Choose “Rate Tables” / “Sales Tax Table”.

 To add a rate, select the icon. Enter the name of the sales tax in the second column (the first column is the French
description) and the desired rate in the third column.

 The rates can also be modified, if necessary, by clicking on the desired line and modifying the appropriate data.

http://www.margill.com/get
http://www.margill.com/get
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 In the sales tax calculation (go to the "Other" button and then "Sales Tax Calculation"), the two rates that appear at
the beginning of the table in red are the default rates. These default names and values can be modified in the “Sales

Tax Table” window. It is also possible to substitute the two rates appearing by default by using the  button (to the
right  of  the  table)  to  slide  the  two  desired  rates  to  the  top  of  the  table.  The  two  new first  lines  of  the  table  will
automatically appear in red.

 Certain sales tax calculations require that the second tax (provincial, in the case of Quebec before 2013, for example)
be applied to the total: amount + federal tax. This setting is set in the sales tax calculation itself.

where, automatically, the first rate of the table is named Tax 1 and the second, Tax 2.

Once set in the Sales Tax Calculation, the default choice will be kept.

 Based on  the jurisdiction, if a single tax is applicable, a zero (0.0000) tax should be specified for the second tax.

 To  save  the  changes,  click  on  the  Save  icon  .  Only  one  tax  rate  table  can  be  used  in  MLM,  and
therefore, no file name is required.

 Only the "Administrator" or a "Power user" can make the necessary updates.
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Tools Menu

Payment update ("Post Payments")

 Bulk Import of Payments
 Payment update via Line Unique Identifier
 Payment update via precise payment Amount and Date

Electronic Funds Transfers

Alerts

Settings

Users (see Getting started > Administrator and Users)

Various

Backup

Tables

Database Reindexation

F1 - Help (User's manual)

   

Payment update ("Post Payments")

Margill  Loan Manager (MLM) offers an extremely useful and powerful  tool  to update all  "Active" Records as payments
are paid in full, unpaid, paid late, paid partially, etc.

IMPORTANT: Only Active Records DISPLAYED in MLM'S Main window (Record Summary window) will be displayed in
the Payment Update tool.

Introduction

Search Tool for Payments

Bulk Import of Payments

Selecting "Active" Records to be displayed

Selecting the dates for the payments to update

Changing Due Payments to Payments Paid in Full, Paid Partially, Paid Late or Unpaid

Changing Paid Payments to Unpaid Payments

Changing Miscellaneous Data:
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 Payment Date
 Adding Column Fees
 "'Expected Pmt"' column and outstanding amounts

o Additional payment or Compensatory Pmt (unexpected) paid
 "True Pmt Date (Grace / EFT)"
 Line Comment
 Minimum Payment 

 Check Number

 9 Custom columns (text, currency, number)

 9 Custom fields (Record)

Automatic Recomputation of Payments and Column Fees (Advanced Options)

Displaying Monetary Totals

Change payment dates in bulk for many Records at once

Apply specific colors to Special Records

Table Printing

Record History (Log)

Introduction

The  Payment  Update  tool  is  certainly  MLM's  most  important  tool.  The  tool  replaces  the  need  to  manually  open  each
Record and change the Line status line by line.

In addition, for each displayed Record, several relevant data are available in the table columns, such as the true Balance,
the Origination Date, the Last payment date > 0.00, the Creditor, etc.

By default,  the tool  finds all  the "Due Pmt" Line statuses and updates them when the payment is  paid,  late,  partial  or
unpaid.

When  you  choose  a  date  interval:  "Include  all  "Payment"  Line  statuses"  can  be  checked  therefore  displaying  all  "Due
Pmt" Line status plus all the other "Paid" type Line statuses (Due Pmt, Paid Pmt, Partial Pmt, Paid Pmt 2..., Unpaid Pmt,
etc.). 

Furthermore, this tool allows to quickly change or add data in the columns when the column headers contain an asterisk
(*). The asterisk means that these columns' data can be changed by the user:

 Line status
 Modified line (checked/unchecked)
 Payment Date
 Payment (amount)
 Expect. Pmt
 Pmt Due Date
 True Pmt Date (Grace / EFT)
 Comment
 Minimum Pmt
 Check Number
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 Column Fees 1 (accrued)(as renamed)
 Column Fees 2 (accrued)(as renamed)
 Column Fees 3 (accrued)(as renamed)
 Column Fees 4 (accrued)(as renamed)
 Column Fees 5 (accrued)(as renamed)
 Column Fees 6 (accrued)(as renamed)
 9 custom Column (text, currency, number)
 9 custom Fields - Record

The Search tool  is available for most of the Payment Update tool columns in order to help you quickly find Records
you want to update.

For  loans  whose  payments  are  not  pre-established  (Payments  are  irregular),  the  Bulk  Import  of  Payments  tool  allows
importing payments in MLM from an Excel spreadsheet (or entered manually). See the Bulk Import of Payments section.

Please note that you can change the columns' location and place the more important ones to the left of the window.
Columns can also be hidden. To show or hide data, click on a header using the right mouse button. You can then show or
hide the various fields.

Usually, a read-only user cannot use this tool. Special rights may still be assigned by the Administrator in order to use this
tool, as well as updating existing payments or adding new payments via an Excel sheet.

Selecting "Active" Records to be Displayed

By  default,  the  "Post  Payments"  tool  includes  displays  all  the  "Active"  Records  in  the  Main  window  that  have  a
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transaction expected on or before the "Pmt Date" or in between the dates entered (when an interval is used).

The user can display only the desired Active Records in the "Post Payments" tool.

By checking "Manual Selection / Spreadsheet", the user can choose which Active Records he wants to display in the "Post
Payments" tool from an Excel spreadsheet or by manual entry. It allows to save time when only a few Records need to be
updated (for  example changing certain  payments  that  were  considered  as  Paid  by  Electronic  Funds  Transfer  (EFT)  but
resulted in insufficient funds).

Here are the steps to follow in order to display only certain Active Records from an Excel spreadsheet:

1. Select the identifier ("Record ID (MLM)", "Unique Identifier 1" or "Unique Identifier 2");
2. Enter the column number that contains the data (usually the first column) in the spreadsheet;
3. Select the file to import;
4. Click on "Display this(ese) Records"

Please  note  that  the  data  on  the  first  line  of  the  Excel  spreadsheet  will  not  be  imported  because  it  contains  the
column titles.

If a Record is not Active or if a Record has been deleted from MLM, an error message will be displayed.

For  manual  entry,  simply  enter  the  "Record  ID  (MLM)"  (or  "Unique  Identifier  1"  or  "Unique  Identifier  2")  in  the
appropriate column and click on "Display this(ese) Records"
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To delete a line, simply delete what is  entered manually in the column.

When the Records are displayed after the manual entry (or by Excel spreadsheet), a scroll down list under Refresh will
appear to indicate which Records are taken into account.

If no Records show, verify the Payment Date, check "Select all Due Payments at, or before this date" and/or select a date
interval. If the Record is Active but there is no transaction on the chosen date or between the chosen dates, the Record
will not be displayed.

Selecting the dates for the payments to update

Click on "Tools"  and go to "Post Payments" . The following window will appear with the current date,
which may be changed to the desired date or date interval:
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Three  options  are  available  for  displaying  the  "Due  Pmt",  "Due  Pmt  2"  to  "Due  Pmt  5"  (and  other  Paid  and  Unpaid
payments if so desired) for "Active" Records only (see "Record Data" section):

1) Show only payments that are due on a specific date entered (please note that this filter will include the five following
Line statuses: Due Pmt, Due Pmt 2 to 5);

o For  example,  to  display  ONLY  Records  for  which  a  payment  is  due  on  a  specific  date  (February  1  in  this
example).

o Only Records with payment due on February 1 will be shown.
o If a Record contains a due payment on that date and one or multiple due payments before that date, these

due payments will also be shown (for this Record only).
o Enter only the date without checking the option:

2) Show ALL Records with due payments on the specific date entered and before this date (please note that this filter will
include the five following Line statuses: Due Pmt, Due Pmt 2 to 5);

o For example, to display all Records with a due payment on or before a specific date (February 1 in this
example).

o Check  "Select all Due payments at, or before this date":

3) Show only due payments that are upcoming between (and including) two chosen dates (please note that this filter will
include the five following Line statuses: Due Pmt, Due Pmt 2 to 5);

o For example, to display ONLY Records with a payment that is due between two dates (inclusively between
February 1 and February 28 in this example).



Page 159

© Jurismedia Inc., 2007- 2023

o If  a  Record  contains  a  due  payment  between  the  dates  entered  and  a  due  payment  or  multiple  due
payments before the start date, these due payments will also be shown (for this Record only).

o Check "Use date interval"

o If the "Select all Due payments in the interval or before" option is checked, all the lines with a due payment,
even before this interval, will be displayed.

It  is  STRONGLY  recommended  to  check  the  option  "Select  all  Due  payments  in  the  interval  or  before"  in  order  to
manage all due payments.

TRICK: In order to get the option to include all "Payment" Line statuses, even if you just need them for a
specific date and not for an interval, check "Use date interval" and enter the same date for both.

In the example above, all February 1st payments (Due Pmt, Paid Pmt, Unpaid Pmt, etc.) will be displayed.

Changing Due Payments to Payments Paid in Full, Paid Partially, Paid Late or Unpaid

By  default,  the  tool  will  find  all  Line  statuses  "Due  Pmt"  on  or  before  this  date  and  will  display  the  payments  in  the
window.
To produce the list of desired payments (Due pmt and other payment types if so desired), press the Refresh button or F5

. A table will be created taking into account the chosen options. 

The example below displays all due payments between February 1st and February 29. Highlighted in yellow are Records
opened  by  another  user.  It  is  strongly  suggested  that  this  user  be  asked  to  close  the  Record  before  updating  it.  By
positioning your cursor on a yellow line, you can see who blocks the Record. See Locked Records and Alerts.
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It is possible to change Line statuses to multiple other choices:

 Due Pmt
 Due Pmt (2) to (5)
 Paid Pmt
 Paid Late Pmt
 Partial Pmt
 Partial Late Pmt
 Paid Pmt Returned Check
 Add. Pmt
 Compensatory Pmt
 Unpaid Pmt
 Paid Pmt (2 to 10)
 Paid Pmt (11 to 20)*
 Interest Paid (2 to 4)
 Paid Principal (2 to 4)
 Unpaid Pmt (2 to 10)
 Due Pmt - Unpaid
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Future due payments payable before the chosen date or  payable before the interval  selected are highlighted in red to
indicate a  state of  urgency (relative) -  these due payments will  need to be managed by  assigning the  appropriate  Line
statuses.  Due payments  on  the  date  (or  between dates)  selected (here between 01/05/2016 and 11/05/2016) are  not
highlighted. A well maintained database should include very few red lines.

In  order  to  update  Records,  changing  "Payment"  Line  status  to  another  Line  status:  enter  a  date  or  an  interval  as
described above. Check payments to update. By default, the Line status will change to "Paid Pmt". You can also change
the Line status to other Line statuses such as "Paid".

 Paid Pmt (2) to (20)
 Partial Pmt
 Late Pmt
 Partial Late Pmt
 Add. Pmt
 Compensatory Pmt

Or "Unpaid":

 Unpaid Pmt
 Unpaid Pmt (2) to (10)

"Paid Pmt (2) to (20)" and "Unpaid Pmt (2) to (10)" are Line statuses whose names can be changed to specifically identify
the type of payment made (Paid Visa, Paid by check, etc.). See very important sections Line status and "Payment" Type
Line statuses.

"Select All"  will select all the Records in the table while allowing to choose the Line status to apply
to ALL Records. This option does not allow changing to partial payments or late payments because these special changes
must be processed line by line.  With the right mouse click  (see table  below),  you  will  have access  to  more Line  status
options than with "Select All".

When  the  lines  are  changed  (whether  changing  a  Line  status,  adding  a  comment,  adding  Column  Fees  or  any  other
change done to a column with an asterisk*), check marks will appear in the "Modified line" column. 
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If  a  date  is  modified  by  the  user  and  thus  this  date  finds  itself  after  dates  entered,  the  line  will  become  pale  green
indicating a possible irregularity. You can save your changes nevertheless, since this is meant simply as a system warning.

When the user clicks "Apply" , the changes will be updated and the check marks will disappear from
the "Modified line" column. 

Here is the fastest way to select many lines without checking each line one by one:

 Highlight the desired lines (use "Shift") to select a block of lines, or press "Ctrl" to select random lines or simply keep
pressing on the left button of the mouse and scroll down (continuous lines) and right mouse click whcih offers the
options described in the box below.
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Right mouse click options

"Change" / "Change Line status of the selected line(s) to" - changes the Line status or Line statuses of the payments that have been
highlighted (now in blue) by one of the Line statuses appearing in the list to the right.

"Change" / "Change Line status of the entire table to" - by selecting any line in the table, changes the Line status of the entire table
by one of the Line statuses appearing in the list to the right.

"Change" / "Change the "Due Pmt" of the entire table to" - by selecting any line in the table, changes the Line status of  a "Due
Pmt" type by one of the Line statuses appearing in the list to the right.

"Change" / "Change Payment Date" (only available if multiple lines are selected) - will change the Payment date to the desired date
.

"Change" / "Revert selected lines to original data" - reverts the table's Line status back to the initial one.

"Display Record changes" - A window will display the changes about to be made for this Record for this update session.

"Open Record" - will open the selected Record's Payment schedule. The table can then be updated manually. The option is available
only when one (1) line is selected. This is particularly useful in less normal situations such as adding an additional payment. 

"Refresh Table" - will update the table if for example, the "Payment Date" was changed or if "Select all late payments" was changed
(checked or unchecked).

"Record Color" - will add or change the selected Record(s) color.

"Export to Excel" - exports the selected line or lines to Excel.

Please note that  it  is  not  possible  to  change multiple  pre-authorized payment,  partial  payment  and  late  payment  Line
statuses in bulk. You will have to change Line statuses one by one since these are special situations that require individual
processing in order to enter the data for each Record (amounts, dates, etc.).

Once the payments are selected from the desired Line status,  click  on  "Apply"  .  Changes will  only  be
updated in the Records when you click "Apply".
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The number of updated payments will appear.

The  payments  updated  with  the  "Payment  Update"  tool  will  be  eliminated  from  the  table  since  they  have  now  been
updated or otherwise managed. You can either choose to update other payments or close the window.

Changing Paid Payments to Unpaid Payments

If "Use date interval" is checked, an additional option will be available. The option "Include all "Payment" Line statuses"
could then be checked and will display not only "Due pmt" but all payment-type Line statuses:

 Displayed by default Displayed when the option "Include all "Payment" Line statuses" is checked

 Due Pmt
 Due Pmt 2
 Due Pmt 3
 Due Pmt 4
 Due Pmt 5

 Paid Pmt
 Paid Pmt (2 to 20)
 Paid Pmt Returned Check
 Partial Pmt
 Partial Late Pmt
 Late Pmt
 Add. Pmt
 Compensatory Pmt

 Interest Paid 
 Interest Paid (2 to 4)
 Principal Paid
 Principal Paid (2 to 4)

 Unpaid Pmt
 Unpaid Pmt (2 to 10)

Notably, when the Electronic Funds Transfer (EFT) module is used, this option allows you to find all payments that have
been automatically changed from Due Pmt to Paid Pmt and allows you to change Line statuses from Paid Pmt (or  PAP
Paid) to Unpaid Pmt for returned payments (insufficient funds). It avoids the user having to open each Record to make
these changes.

In  order  to  get  the  desired  payments  list  (Due  Pmt  and  other  types  of  payments  if  desired),  click  on  Refresh  or  F5

. A table with the chosen options will be created. 

1)  Find  Records  in  the  list  whose  Line  statuses  must  be  modified.  For  example,  you  will  have  to  make  each  change
individually for Records 134 and 138 because they are preauthorized payments.

2) First change the Line status change from "Paid Pmt" to "Unpaid Pmt" in Record 134. Confirm the amount that should
have been paid in the pop up window. A check mark will automatically appear in the "Modified line'' column. 
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3) Click on . A confirmation window will appear and the Record will be updated. Repeat these steps to
modify Record 138's Line status.

Special Cases of Payments Submitted as Electronic Funds Transfer (EFT)

Records highlighted in red/brown (darker)  are "Payment" type Line statuses submitted as preauthorized payments
(PAP). They can only be updated by Line statuses that are not greyed out. Partial payments or late payments are not
allowed because a PAP can be either paid or unpaid:

 Paid Pmt
 Unpaid Pmt
 Paid Pmt (2) to (20)
 Unpaid Pmt (2) to (10)

For example, a hundred (100) Records are submitted as preauthorized payments in January 2016. MLM assumes that
the  payment  was  paid  on  the  day  it  was  debited  from  the  Borrower's  account  and  so  the  Line  status  will
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automatically change from Due Pmt to Paid Pmt in the Payment schedule.

On  the  other  hand,  five  (5)  Records  are  returned  because  of  Borrowers'  insufficient  funds.  Instead  of  manually
changing Line statuses in each Borrower's Payment schedule, use the Payments Update tool to save significant time.

By choosing the date interval January 1 to January 31, 2016 and by checking "Include all  "Payment" Line statuses",
darker red/brown Records representing PAP's with the "Paid Pmt" Line status will show up on the list. It will then be
possible with the Search tool to easily find the five Records to change in the list and to apply the new Line status for
each payment, one by one since PAP Records must be processed separately. It is still much faster than opening each
Record separately. In this case, "Paid Pmt" Line status will have to be changed to "Unpaid Pmt".

If you try to change multiple PAP Line statuses at the same time, the following message will appear:

Changing Miscellaneous Data:

Payment Date

The date in the "Payment Date" column can be modified as long as it is equal to or after the previous line and equal to or
before the payment date of the next line in the Payment schedule.

You  can  also  modify  the  Payment  dates  in  bulk.  Select  the  rows  for  which  the  payment  date  must  be  changed,  right
mouse click: Change > Change Date > Change Payment Date. The only constraints are that date changes in bulk cannot be
made on more than one line for the same Record and the date order described above be respected.

Adding Column fees

For example, if you have to add a 25.00 fee for an unpaid payment, it is possible to do so manually with the "Payment
Update"  tool  at  the  same  time  the  Line  status  is  being  changed  from  "Due  Pmt"  to  "Unpaid  Pmt".  The  amount  must
simply be entered in the appropriate column. In  this  example, "Column Fees 1" is  renamed "Administration Fees". See
section > How to do... > Fees, Insurance and Taxes > Fees, Insurance and Taxes by Column, for more information on this.
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Those Fees can be programmed to generate automatically when a Line status is changed to another. Thus, each time a
"Due Pmt" Line status becomes "Unpaid Pmt",  Fees are added to the Record without intervention.  See How to  do...  >
Fees,  Insurance  and  Taxes  >  Fees,  Insurance  and  Taxes  by  Column  >  Fees,  Insurance  and  Taxes  by  Column,  for  more
information on automatic Column Fees.

In order to be automatically generated after being programmed in the Settings, Column Fees must be activated for each
Record to which they are to apply. Open the Record and in the Advanced option, check "Use Automatic Column Fees for
this Record" or use the "Global Changes" tool to apply the fees to multiple Records at once.

See also: Automatic Recomputing of Payments and Column Fees (Advanced Options)

Expected payment ("Expec. Pmt") column and Outstanding amounts

The "Expect. Pmt" column allows the user to enter the amount which should have been paid when there is a difference
between  the  expected  payment  and  the  payment  actually  made.  Thus,  when  a  payment  is  unpaid  or  an  additional
payment is made, the outstanding amount increases or decreases.
 
Scenarios: 
 
 The amounts in the "Payment" and "Expect. Pmt" columns should be equal when the payment is paid in full.
 If the payment is unpaid, the "Payment" column indicates 0.00 and the "Expect. Pmt" column indicates the amount
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which should have been paid.
 A  partial  payment  could  be  managed  when  the  "Payment"  amount  is  less  than  the  amount  in  the  "Expect.  Pmt"

column. Note, however, that the amount in  the "Payment" column cannot be changed in the Post payments tool.
This amount can only be changed directly in the Payment schedule when the Line status is "Due Pmt".

 If  the  Line  status  is  "Add.  Pmt"  or  Compensatory Pmt,  based on  best  practices,  this  payment  would  not  originally
have  been  expected  and  therefore  should  have  an  "Expect.  Pmt"  of  0.00  (see  the  box  below  that  illustrates  the
methodology suggested for payments that were not expected).
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Additional payment (not expected) that is paid
Compensatory Pmt (not expected) that is paid

 
An additional payment or a compensatory payment is a payment which was not planned originally. A payment may be
an additional payment even if it replaces a normal payment that was unpaid.
 
When  the  normal  payment  is  unpaid,  the  "Payment"  column  amount  becomes  0.00  and  the  "Expect.  Pmt"  column
contains the amount of the payment that should have been paid. An Outstanding amount is then calculated.
 
When the payment is  compensated (paid),  not  by the next normal scheduled payment,  but  by  a  new payment  that
was not scheduled (the Borrower agreed to compensate the missed payment), since this payment was not originally
planned,  the  amount  in  the  "Expect.  Pmt"  column  should  be  0.00.  This  payment  would  therefore  reduce  the
outstanding amount.
 
That being said, if the Borrower agrees with the Creditor to an additional compensatory payment that WILL soon be
paid, it may be inserted as "Due Pmt". With the Line status "Due Pmt", it  will  show up with the Post payments tool.
However,  the  user  who  updates  the  payments  cannot  easily  know  that  this  payment  is  irregular,  not  originally
scheduled. If this was known, the Line status would be changed to "Add. Pmt" (with the corresponding "Expect. Pmt"
of 0.00) as opposed to a normal "Paid Pmt". The first scenario would reduce the outstanding amount, while the second
scenario would not affect the outstanding amount.
 
To remedy this, two options are available: 

Option 1

A Comment should  be  inserted  on  the  new "Due  Pmt"  line  stating  that  the  payment  is  an  additional  payment  that
should be changed to "Add Pmt" (or other Line status but ensuring that the "Expect. Pmt" is 0.00). The behavior of the
"Compensatory Pmt" Line status is exactly the same as that of an "Add. Pmt" but its name may be changed as desired.

In  the  following  example,  the  regular  payment  is  1500  on  the  first  of  each  month.  On  01-06-2016,  the  payment  is
unpaid.  The  Borrower  calls  the  Creditor  asking  him  to  double  the  next  payment.  A  line  is  inserted  on  07-01  (so  2
payments of 1500 on the same date). 
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If no comment is added, the second payment of the 07-01 (line 3 below) will be treated as any other payment (may
become a simple "Paid" payment with the "Expect. Pmt" of 1500).

On the other hand, if a Comment had been added immediately during the conversation with the Borrower to double
up next payment, the comment would appear in the Post payments tool.

The user will then know that he should change the Line status from "Due Pmt" to "Add Pmt" and the "Expect. Pmt" will
automatically be 0.00. The outstanding amount will decrease accordingly.

NOTE: For columns that can be modified (displayed with a *), it is suggested to change the column order in order for
these to be adjacent to one another, to the left of the table.
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Option 2 

A  second  simpler  option  would  be  to  change  the  Expected  Pmt  amount  when  discussing  with  the  Borrower.  This
option is only allowed when "Allow to change the "Expected Payment" amount when Line status is "Due Payment"" is
checked in Tools > Settings > System Settings (Administrators):
 

Thus, "Expected Pmt" column will already be at 0.00, therefore avoiding the need to change Line status to "Add. Pmt".

See: Allow to Change the "Expected Payment" Amount when Line status is "Due Payment"

See: Allow to Change the "Expected Payment" Amount when Line status is "Due Payment"

"True Pmt Date (Grace / EFT)" column

A  date  should  be  entered  in  this  column  only  when  a  payment  is  received  that  is  slightly  late,  is  not  considered
outstanding, and given this late payment should not affect accrued interest. 
 
By entering a date in the "True Pmt Date (Grace / EFT)" column, the payment continues to be considered mathematically,
paid on the date shown in the "Payment Date" column, but for the Export accounting transactions to the General Ledger
report, the transaction date is reported as the date entered in the "True Pmt Date (Grace / EFT)" column. Some Special
Reporting Fields  are  available  for  reports  using  the  Grace/EFT date  as  a  reference (interest  paid  and  principal  paid)  as
opposed to the payment date.

This date can also be changed in bulk for multiple Records/Lines with the right mouse click. Highlight (select) the desired
lines, choose Change > Change Date > Change True Pmt Date (Grace/EFT). The Grace date must absolutely be after the
Record's Origination date.

 Line Comment

It is also possible to add a comment for each line even if the Line status is unchanged. This comment will appear in the
"Comment" column of the Payment schedule.

Minimum Payment

The  "Minimum Pmt"  column is  useful  because it  displays  the  minimum reimbursement so  the  user  can  quickly  see  it.  He  can  then
confirm that the payment, even a partial payment, made by the Borrower matches this minimum. Can be useful to see if fees must be
charged or if minimum payments were not made by the Borrower.
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Data in "Minimum Pmt" can quickly be changed with the "Payment Update" tool for one or multiple Records simultaneously.

Column Fees can also be automatically added if the minimum payment is not made. If the fees differ from normal fees associated with
unpaid  payments  or  partial  payments,  create  a  special  rule  for  a  "Paid  Pmt  x"  Line  status  (renamed  "Partial  Pmt  <  Minimum"  for
example). Thus, when you change a "Dut Pmt" line to "Partial Pmt < Minimum", special fees will apply.

Check Number

It is possible to enter the check number about to be cashed or that has been returned NSF. This is useful to easily retrace supporting
documentation and document payments. This data can be extracted in the Transaction Report. 

9 custom Columns (text, currency, number)

Custom  data  columns  in  the  Payment  schedule  can  also  be  updated  via  the  Payment  Update  tool.  Thus,  you  gain  in
efficiency, since you can modify or add the data in these columns for several Records simultaneously.

9 custom Fields (Record)

Personalized  custom  fields  in  the  Record's  "Other  Data"  tab  can  be  useful  to  identify  the  different  types  of  payment
types.  For  example,  a  field  named  "Payment  by"  could  be  a  custom  field  with  a  scroll  (drop-down)  menu  that  would
contain various payment methods (Cash, Check, Pre-authorized payment (EFT), etc.). You could then sort the payments
using  this  or  any  other  criteria  to  manage  payments  easily.  Only  Custom fields  1  to  9  are  included,  not  the  Unlimited
fields. It is thus necessary to carefully choose the location of the custom fields depending on the need. 

Displaying Monetary Totals

Many relevant data are computed at the bottom of the table:

Calculations are  separated in  two (2)  columns;  First  column:  "On Date"  or  "Interval"  depending on  the  option  chosen.
Second column: "Global".
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 The "On Date" column will be useful for computing data for the date chosen by the user.
 The  "Interval"  column  will  be  useful  for  computing  data  in  the  interval  chosen  by  the  user  (in  this  case  from

2016/01/14 until 2016/01/31). 
 The  "Global"  column  computes  the  total  payment  of  all  lines  displayed  in  the  payment  update  table.  In  a  well

maintained database, there should not be a large difference between total payments for the chosen date (or in the
interval) and the total in the "Global" column. Pink/Red lines are the unmanaged lines and represent this difference.

The total of due payments is indicated at the bottom of the "MLM Record ID" column.

Various other data is provided including: 

 The total of the "Payment" column
 The total of Due Payments (without the EFT payments)
 The total of "Paid Payments" (all "paid" statuses combined) as the lines are checked off
 The  "Outstanding  Portion"  is  computed  by  subtracting  the  "Payment"  column  from  "Expected  Payment"  column.

This portion will be considered "outstanding" if the payment amount is less than the due payment.
 "Extra Payment Amount" is computed by subtracting the "Payment" column from "Expected Payment" column. This

portion will be considered "extra" if the payment amount is greater than the expected payment.
 Total due payments already processed by EFT.

Example of  the  Outstanding Portion  and Extra  Payment
Amount:

 Line 1: No effect since Payment = Expec. Pmt
 Line 2: Extra Payment Amount of 1000.00
 Line 3: Outstanding Portion of 250.00
 Line 4: No effect since not yet "managed" (still a Due Pmt).

Will  only  have  an  effect  once  managed,  thus  changed to
Paid, Unpaid, etc.

Notice the line 4 Expec. Pmt is in blue since the Payment is not
equal to the Expec. Pmt. This special feature can be activated in
Tools  >  Settings >  System Settings (Administrators) >  Allow to
change  the  "Expected  Payment"  amount  when  Line  status  is
"Due Payment". 

Transactions:

Resulting Totals:

If a single date is chosen for due payments, the "On Date" column will indicate the total on the date entered and exclude
other payments on other dates in that table. PAP (EFT) amounts will not be included in this column. If a range is selected,
the text "Interval" is displayed with the total between the two dates entered at the top of the window.
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If the multi-currency module is used, the totals will be shown without currency signs for all currencies.

Automatic Recomputation of Payments and Column Fees (Advanced Options)

Payment schedules can become quite complex when automatic payment recomputation or Column Fees recomputation
functions are activated. 

Automatic recomputation functions are available in order to:

 recompute the payment amount of lines labeled as 1) interest-only and column fees, 2) fixed principal, 3) principal
and interest (and other) to yield a final balance = 0.00 or X.

 automatically recompute Column Fees when a change is made to the balance or interest of the line.

Thus, when one of the above functions is activated, when changing a previous payment (a previous payment is reduced
or unpaid), subsequent special payments (labeled) will automatically be changed to keep their special status.

In  the  following  example,  Record  138  contains  special  payments  that  are  interest-only  (and  column  fees,  if  required)
payments (see "Pmt Type" column whose lines are labeled "Int. Only".

A partial payment of 150.00 will be made on 2015-11-01. When data is entered, the following message appears:

The  "Payment  Update"  tool  simultaneously  deletes  the  special  line  label  (Interest-only)  and  adjusts  the  next  payment
amount  according to  the  above transaction made by  the  user.  The  changes  will  be  only  apply  once  the  user  clicks  on
"Submit".

In  this  example, the three interest-only payments are of  265.00.  When the  payment  due on  2016-02-01 is  changed to
150.00,  the  interest  on  subsequent  lines  is  recomputed.  Thus,  the  payment  due  on  2016-03-01 is  increased  to  381.15
since this payment reimburses all the accrued interest.
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The  example  below  shows  that  automatically  RECOMPUTED  Column  Fees  (Insurance  Fees)  representing  3%  of  the
preceding line's balance, are automatically updated when changes are made with the tool:

Here are the effects on the "Insurance Fees (%) - Accrued" (a customized "Column Fee") on future lines when a line above
is changed to "Unpaid Pmt". The Insurance increases from 264.46 (image above) to 279.39 (image below).

In the last  example below, Column Fees are ADDED  automatically when a payment is  unpaid.  A  25.00 fixed amount  is
charged to the Borrower. In this case Column Fees was renamed "Administration Fees":

When  the  Line  status  is  changed  to  "Unpaid  Pmt",  the  "Payment  Update"  tool  automatically  updates  the  Payment
schedule based on the automatic Column Fees rules.

25.00 Fees are then added and the loan balance will be adjusted consequently.

WARNING: Once a Line status is changed to "Paid Pmt", the special fees label is deleted. If subsequent changes are made
above in the Payment schedule, the Fees will not be automatically recomputed.

Change payment dates in bulk for many Records at once

As of version 5.5, Payment Dates in a Payment schedule may be changed in bulk with the Post Payment tool. In the Post
Payments window, enter the Payment Date or date range (as well as other options if needed) > Refresh button.

Highlight the lines for which dates need to be changed. You can sort by the Payment Date header if desired. Then right
click  with  the  mouse  >  Change  >  Change  Payment  Date.  The  option  will  only  be  available  if  more  than  one  line  is
highlighted:
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In the example below, the May 1 (or other non-uniform dates) payment is to be changed to May 18:

Changes after OK:

The "Modified line" column will be checked and the Payment Date changed. Other changes can also be done if required
(Line  status  change,  payment  amount  changed,  comment  added,  etc.).  The  changes  will  become  effective  once  the
"Apply" button is pressed.

IMPORTANT: 

 Only one payment date per Record can be changed in one operation (to change multiple dates in a Record, you will
need to select the Records, right click, change the date and repeat for each date/Record).

 The chronological line order must be foloed so the new date to which the payment is changed must not be greater
than the next line's date, nor less than the previous line's date.

 The new date cannot precede the Origination Date.
 Only "Due Pmt" type and "Paid" type Line statuses can be updated with this tool. Fees, Other, etc. cannot.

o It is usually not recommended to change "Paid" type Line statuses since, in theory, the dates entered here
are the correct Payment dates and usually have no reason to be changed. 
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Apply specific Colors to Special Records

The Administrator can allow users to assign different colors to Records in order to place emphasis on certain special or
doubtful  loans.  For  example,  when  a  Borrower  does  not  pay  (so  its  Line  status  is  changed  to  Unpaid),  the  user  may
change the color to red.

Choose the Record or Records, right click with the mouse > Record Color > Select Color.

             

In  the "Payment Update" tool,  the Record's color will  appear  only  on  the  first  column in  order  to  avoid  confusing this
color with the tool's other color codes.

The color code that has been applied in the "Loan Payments" tool will be visible in the Record Summary window and vice
versa.

Table Printing

The table as presented in the window can be printed with the button. The presentation order can
be modified as desired. For example, the most recent payments to be paid can be at the end or at the beginning of the
table. Click on the headers to sort. Printing will take this sort into account. The printed report also includes a total.

Record History (Log)

The Line status change will be included in the Record log.
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Bulk Payment (Transaction) Import

One can insert regular and irregular payment lines in the Payment schedule through a simple Excel spreadsheet. Thus, an
Excel spreadsheet received from your bank, could be used to insert multiple payments in the Payment schedule.

This can be useful when Borrowers pay their loan sporadically, as opposed to periodically. This tool should therefore be
used when no payment is  expected whenever the  payment  frequency is  irregular.  Bulk  import  of  payments  is  used to
insert  payments  that  are  generally  irregular  in  a  Payment  schedule  that  includes  "Information"  Line  statuses  with
payment amounts of 0.00 or in an empty Payment schedule. For expected regular payments (including "Due Pmt" lines),
the Payment update tool or the Payment update via Line Unique Identifier should be used as opposed to this special tool
because the "Bulk Import of Payments" does not change "Due Pmt" Line statuses to "Paid Pmt" but simply inserts or adds
lines. This module allows the import of payment dates, payment amounts and multiple other data for:

 Upcoming (Due) payments
 Paid payments
 Additional principal
 "Information" type (Payment = 0.00)
 "Other" type

It is possible to import data from an Excel spreadsheet or to enter these manually. It is also possible for the import to be
done automatically,  without human intervention, with the "Automatic Import" tool  (see Automated Imports  -  JSON or
Excel section). This import is always done via the same Excel sheet, but thanks to a Windows "Service", which checks for
the presence of a new file in the designated folder for this purpose. The update is done in near real-time.

To  access  this  function,  open  the  payment  update  tool  "Post  Payments" ,  and  click  on  the

 button. 

Choose "Import new payments".

The following window, "Import Payments" will open:
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The payment import tool allows the insertion of the following Line statuses:

 Due Pmt / Due Pmt (2 to 5) 
 Paid Pmt / Paid Pmt (2 to 20)
 Add. Principal (Loan) / Add. Principal (2 to 10)
 Information
 Interest Paid / Interest Paid (2 to 4)
 Principal Paid / Principal Paid (2 to 4)
 Add. Pmt
 Compensatory Pmt
 Interest charged / Interest charged (2)
 Other 1 to 10

o Importing a "Due Pmt" (or Due Pmt 2 to 5 - renamed as desired) line means that the payment has not been
paid yet but is expected to be paid and must eventually be "managed" by the change to Paid Pmt, Partial
Pmt, Unpaid Pmt, Add. Pmt, etc.

o "Paid Pmt (2 to 20)" Line statuses can be renamed. For example, "Paid Pmt 2" could be renamed to "Paid -
Visa", "Paid - Cash", "Paid - EFT" (electronic preauthorized payment).

o If a new advance (loan) is made in the future, insert Additional principal type lines. Even if these lines will be
inserted  in  the  Payment  schedule  as  negative  payments,  the  amounts  must  be  inserted  in  the  Excel
spreadsheet without the negative sign.

o "Information"  Line  statuses  can  be  imported  anywhere  in  order  to  obtain,  for  example,  a  balance  at  a
particular date or to  insert  a  line Comment or  other  pertinent information in  the custom columns.  Payment must  be
0.00.

o Interest charged / Interest charged (2) allow to insert interest "artificially", often to include adjustments in a
Payment schedule.

o

o The "Payment" amount for Line status "Other 1 to 10" can only be 0.00. Only a "Payment" of 0.00 is allowed in order to
insert data into the other  columns of  the Payment schedule without the risk  of  a  Payment amount being entered by
mistake. "Other" Line statuses are exceptions and are neither principal, nor interest.

Note: No matter what Line status is chosen, the term "Payment" is used to describe the line insertion in MLM
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and in this section.

This tool should never be used when "Due Pmt" Line statuses are pre-entered since the module does not change
Line statuses but INSERTS lines in the Payment schedule. For example, a payment with a "Due Pmt" Line status
will never be changed to "Paid Pmt" with this tool.

Warning!  It  is  strongly recommended to  backup the  database before inserting payment  lines.  See
Backup (Data) for the steps to follow.

Since this tool allows to insert an almost infinite number of lines, if, by mistake, the same Excel file is
submitted again to MLM through the payment import tool,  the data will  be imported again in  the
Payment schedule. No error message will appear.

The payment import tool adds lines even if the lines already exist for the same dates.

An exception to this rule was provided in the Automatic payment import tool (API via Excel via). The
automatic  tool  will  exclude  lines  on  the  same  date,  for  the  same  amount  and  for  the  same  Line
status for lines that already exist. This is to reduce the risk of error.

There are two (2) ways to insert lines in a Payment schedule:

 Excel File Import

 Manual Entry

Excel File Import

To import data from an Excel spreadsheet:

1) Prepare the Excel spreadsheet with the first three compulsory columns since these contain the basic import data. It is
possible to import many other data and payment types:

 The first column (Excel A) is compulsory and serves to identify the Record. Three Record identification methods are
possible. Check the desired identification from the list. You can choose the MLM Record ID or from Unique ID 1 or 2,
the latter two assigned by the user.

 The second column (Excel  B)  is  compulsory  and  must  be  the  transaction date.  Date  format  must  be  the  Windows
date format (for example mm-dd-yyyy); 
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 The  third  column  (Excel  C)  is  compulsory  and  must  be  the  amount  to  be  inserted  in  the  Payment  schedule.  This
amount must be positive or equal to 0.00. If there are more than two decimal points in the amounts entered in the
Excel spreadsheet, MLM will round them up in order to keep only two decimal points. 

 The 4th column (Excel D) is optional since you could otherwise choose from the drop-down list, the Line status to be
imported for all transactions. If you choose the method with this drop-down, this column will not be needed and can
be left blank.

o To  define  the  Line  status  for  each  transaction  to  be  imported,  enter  the  number  corresponding  to  the
required Line status in the fourth column. For example, to import a "Paid Pmt", enter 4 in the Excel column.
If column 4 is used, the Line status for each and every payment must be specified.

 The 5th column (Excel E), optional, enters the Line Comment and can include up to 100 characters.

 The 6th column (Excel F), optional, enters the "Check Number".

 The 7th, 8th and 9th columns (Excel G, H, I) are also optional. They allow text to be added in the Custom columns 1, 2
and 3 (text format). Each of these columns can contain up to 100 characters.

 The 10th column (Excel J),  optional,  adds a Grace date for the payment. This is used in special situations since the
transaction date would not  be the date entered in the "Pmt Date" column but  the date entered in the "True Pmt
Date (Grace / EFT)" column. 

For  example,  based  on  contract,  the  Borrower  should  be  paying  on  the  date  specified  on  the  "Pmt  Date".  The
Borrower  pays  a  few  days  late  but  the  Creditor  does  not  wish  that  additional  interest  be  added.  The  grace  date
entered will be reported as the transaction date in the General Ledger report. This transaction date is also available
in the Transaction Report.

The Grace date cannot be before the Origination Date, but it  can be after the date of the last line in  the Payment
schedule.

 The  11th  column  (Excel  K),  optional,  allows  a  user  to  add  Fixed  Principal  payments  that  will  refund  the  principal
exclusively without first refunding accrued and outstanding interest (nor Column Fees). 
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This option is only available if this Fixed Principal refund method (method 3: “Refund Principal WITHOUT refunding
outstanding  interest  (NOT SUGGESTED)”)  is  accessible  (activated)  or  is  the  default  option.  To  activate  these  Fixed
Principal  refund  options  or  to  select  this  method  as  the  default,  go  to  Tools  >  Settings  >  “User  Settings”  tab  >
“Options: Interest only and Fixed Principal” link.

 The twelfth column (Excel L) (optional) allows to add the “Expected payment” amount when the amount is not equal
to  the  imported  paid  payment.  This  could  be  useful  when  past  payment  are  imported  in  order  to  compute  the
Outstanding amount. There are some conditions:

First,  make  sure  that  the  "Allow  to  change  the  "Expected  Payment"  amount  on  any  "Due  Payment"  Line  status"
option is activated (Tools > Settings > System settings).

Then  confirm  that  an  Administrator  does  not  force  the  Expected  Payment  to  0.00  via  the  System  settings
(Administrator) > Line status settings.

o If Line Status type is a Due pmt type, Expected Pmt must be > or = 0.00
o If Line Status type is a Paid Pmt type, Expected Pmt must be > or = 0.00
o If Line Status type is Add. Pmt or Compensatory Pmt (as renamed), Expected Pmt must be = 0.00
o If  Line  Status  type  is  an  Additional  Principal  type,  Expected  Pmt  must  =  the  amount  entered  for

additional principal (would usually simply be left blank)
o If Line Status type is Information, Expected Pmt = 0.00
o An  empty  cell  is  considered  empty,  not  at  0.00,  therefore  the  Expected  Pmt  will  be  automatically

inserted according to the Line Status.

 The 13th, 14th and 15th columns (Excel M, N, O) are also optional. They allow amounts to be added in the Custom
columns 1, 2 and 3 (monetary format).

 The 16th, 17th and 18th columns (Excel P, Q, R) are also optional. They allow amounts to be added in the numerical
custom columns.
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 The 19th to 24th columns (Excel S, T, U, V, W, X ) are also optional. They allow amounts to be added in the Column
fees.

o If Column fees are already calculated in the Record, it will be forbidden to add a fee amount via this tool for
this column.  For example, if a NSF Fee is added based on the 1.25% "Line Interest Accrued" calculation, the
"Fee with Calculation" error message will be displayed and the payment won't be imported.

When importing payments, it will be necessary to specify, whether you have chosen to import the Column Fees or
not, if you wish the automatic Fees to be applied or not.

NOTE! If the "Apply Automatic Column Fees" option is checked, the Automatic Column fee rules will take precedence
over the amounts in the Excel sheet for Column fees. Column fees entered in the Excel sheet will be ignored. This is
generally not desired.

The "Insert after if same dates" option ensures that the line inserted is positioned after an existing line on the same
date in the Payment schedule.

IMPORTANT  NOTE:  The  column  order  (from  1  to  24  (A  to  X  in  Excel))  are  mandatory.  If  only  certain  data  is  to  be
imported,  you  must  leave  the  optional  columns  blank,  in  the  prescribed  order,  so  that  the  data  to  be  imported  is
transferred to the correct place during the import. A header is not required for blank columns.
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The first line in the spreadsheet is used to identify your columns, it will not be imported. The names given to the columns
do not matter but their order does.

Only the first sheet of the Excel Book will be imported.

Excel spreadsheet example

2) Choose the identifier to be used to identify the loan:

3) Check the "File import" option.

4) Choose the Line status to insert or ignore this step if a Line status is entered in column 4 of the Excel file (column D).

5) Click on the orange folder icon in order to select the Excel file to import to MLM. 
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A preliminary analysis of the spreadsheet is performed:

Error examples:

Record ID not found in the database Indicates that the Record does not exist.

Active Records only Indicates that Record Status is not "Active".

Amount error, to be verified Indicates an error in the amount or that the amount has not been
entered.

Invalid date Indicates an error in the date format - Year, month, day (YYYY MM
DD) can be separated by a dash or slash (/) even if MLM indicates a
dash. Make sure that Excel considers the cell to be in date format.

If an error is found, it is recommended to cancel the entire import, to correct the Excel sheet and to proceed to a full
new import.

The "Find next red issue" button (bottom center of window) appears when the import consists of over 15 lines in order to
help fin the import errors.
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6)  When the data is accepted in the preliminary analysis, a second analysis will  be done by MLM by clicking on "Insert

Lines" .  This  operation  attempts  to  open  each  Payment  schedule  and  inserts  the  various  Line
statuses (Paid Pmt, Due Pmt, Add. Principal, Information, etc.). Other errors can be detected but valid transactions will be
imported.

WARNING: If a payment is refused in a Record, all payments in this Record will be refused. MLM was programmed this
way to avoid Records the have some valid transactions and some invalid ones. It would have been tedious to find which
transactions were approved as opposed to which ones were refused. Thus, it will never be necessary to analyze an entire
Record to find which transactions were imported and which ones were not.

Error Examples:

 If the Payment schedule is used by another user;
 If a "Paid Pmt" Line status is to be inserted after a "Due Pmt" Line status;
 If a "Due Pmt" Line status is to be inserted after a "Paid Pmt" Line status;
 If the payment date in Excel is prior to the original loan date of the Payment schedule;
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Additional notes: 

End of import: The import system will process each line of the Excel spreadsheet until it detects an empty line. When it
detects an empty line, MLM will assume that the line before is the last transaction. However, as a safety measure, MLM
will  verify  that  the  next  nine  (9)  lines  are  also  empty.  If  they  are  indeed  empty,  MLM  will  assume  that  the  sheet  is
complete and that the import is finished. When MLM detects empty lines in a spreadsheet, this message will appear:

Manual Entry

In order to manually insert lines in the Payment schedule with this tool:

1) Compulsory: Choose the identifier to be used to identify the loan:

It  is  possible  to  validate  that  the  Record  ID  is  correct  thanks  to  the  information  automatically  retrieved  in  the
"Borrower" column (last column to the right of the import table).

It is only possible to insert lines in Payment schedule for ACTIVE Records. 

The user must delete all incorrect entries before continuing the insertion.

     To delete a line, simply enter "0" in the Record ID (or Unique Identifier) column.

2) Compulsory: Click on "Manual entry" 
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3) Compulsory: In the table, enter the Record identifier;

4) Compulsory: Choose, from the "Line status" scroll menu, the desired Line status for the transaction.

5)  Compulsory: Enter the transaction date in  the "Pmt Date" column. If  the format is  incorrect,  an information bubble
"Invalid Date" will appear;

6) Compulsory: Enter the amount to be inserted in the Payment schedule;

7) Optional:  Enter the desired information in each of the columns:

o "Line Comment"
o "Check number"
o "Custom Columns (Text)" 1 to 3
o "Custom Columns (Monetary)" 1 to 3
o "Custom Columns (Number)" 1 to 3
o "True Pmt Date (Grace/EFT)"
o Fixed principal payment
o Column Fees 1 to 6
o Expected Principal

See the complementary instructions in the Import via Excel section above.

As soon as MLM detects an error, a dialog box will appear indicating the problem, or, the line will become red and the
error message will appear on the second to last column. 

In the example above, the second line was not inserted since a "Due Pmt" was found before a "Paid Pmt". This operation
is not allowed because the Record includes expected payments (Due Pmts) and should therefore be managed with the
Payment update ("Post Payments") tool that changes (updates) the Line status instead.
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8) Click on "Insert Lines".

The  button is useful to delete Data in the payment import table. It cannot be used to cancel lines
that have already been inserted. 

See  also  the  very  powerful  tool:  Automated  imports  to  automatically  import  new  transactions  via  en  Excel  sheet  and
Window Service.

Import Examples

Here are (2) suggestions for effective Payment schedule management when it comes to irregular or sporadic payments.

The following Payment schedule initially includes two lines: the first is for the Origination date and the second is a later
date (year 2030) in order for the loan to keep on generating interest (otherwise loan will be ended on 2016-01-06 in the
following example).

The following example is very similar to the previous one. However, the user decided to include monthly "Information"
Line statuses. This is useful for the same reasons mentioned above. Furthermore, in this type of Payment schedule, the
Creditor  can  see  the  accrued  interest  and  other  financial  data  over  time  (although  this  data  is  available  at  any  date
through reports even if no Information lines are present).
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"Other" Line statuses can be useful to enter data in columns in bulk. For example, "Other 1" Line status could be renamed
to  "Taxes  paid  by  Creditor",  along  with  a  Payment  of  0.00  and  the  information  column  also  named  "Taxes  paid  by
Creditor". This way, for Escrow, multiple loans can be updated at once when the Creditor pays the insurance company or
the city or county taxes on behalf of the Borrower.

   

Payment update via Line Unique Identifier

This tool updates existing payments ("Due Pmt" type Line statuses) with an Excel spreadsheet using the Unique ID of each
line in each of the Payment schedule for the desired Records. 

Thus,  the  file  (Excel  format),  from  a  third  party  software  (Accounting  or  Enterprise  Resource  Planning  (ERP)  system)
containing  the  desired  transactions,  will  be  imported  in  Margill  Loan  Manager  (MLM)  and  all  "Due  Pmt"  type  Line
statuses will automatically be modified to Paid Pmt (or to any of the custom Paid Pmt 2 to 20), Partial, Late, Partial Late
or Unpaid Pmt.

Steps:

1) Payments to be updated in MLM, are usually submitted to the third-party software through the Transaction Report



Page 191

© Jurismedia Inc., 2007- 2023

2) The third-party software will process the payments submitted through MLM (bank payment)

3) The third-party software will generate an Excel file containing the completed transactions

4) the Excel file will be imported in MLM

1) Submit Due payments from Margill to the third-party software

Through the Transaction Report,  prepare the  data  that  must  be  transferred to  the  third-party  software.  The file  to  be
sent from MLM to the third-party software must have a minimum of three data:

 Payment date
 Payment amount
 Unique Line ID

And optional:

 True Pmt date (Grace/EFT)

The file must also contain Due Pmt type Line statuses (up to five types)

The  file  may  also  include  any  other  data  (Borrower's  name,  third-party  software's  file  number,  etc.)  or  the  desired
transaction (Column fees, Special Comments, transferred data from the Custom Columns, or any other relevant data for
the third-party software).

Then produce the transactions report for the desired period (in the example below, the November transactions will  be
submitted). Export to Excel (or CSV or Text) and import into the third-party software.
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2) The third-party software will  process the payments submitted through MLM and 3)  The third-party  software will
generate an Excel file containing the completed transactions

The Excel spreadsheet returned to MLM must contain a header and three to five columns. Any other data will be ignored.

 Column  1:  Unique  Line  ID  which  contains  the  MLM's  Unique  ID,  followed  by  hyphen  and  the  Line  number.  For
example: 10333-01.  If you do not have the Unique Line ID, select the MLM option: "Use PRECISE date and amount". 

 Column  2:  Transaction  date  according  to  the  MLM  workstation  format  (be  careful  with  the  formats  from  other
systems - for example 12-03 could be March 12th on one workstation and December 3rd on another)

 Column 3: Payment Amount greater or equal to 0.00

 Column 4, Optional: Actual payment date (Grace / EFT). Date format must be that of the workstation where MLM is
installed  (WARNING:  Pay  attention  to  the  different  formats  of  different  systems  -  for  example  12-03  could  mean
March 12th on a workstation but December 3rd on another one!) These dates can be entered manually by the user
or managed via the automated option of MLM:  "Use "Grace Date".

 Column 5,  Optional:  if  a  header  appears  in  column E  of  the  Excel  sheet,  regardless  of  the  amount  entered  as  the
actual payment and the date, the Line status will be updated from “Due Pmt” to Line status entered in column E. The
code list as well as their definition is available by clicking on the "?":

Example of Excel spreadsheet:
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4) The Excel spreadsheet will be imported to MLM

In MLM, open the "Import existing payments" through Tools > Payment Update > Bulk Payment Import > Import existing
payments

The following window will appear allowing the import of the Excel file:

Once the file is selected with , an analysis will be made to identify the corresponding transactions and the errors
which  will  appear  in  red  in  the  "Message"  column.  The  corresponding  transactions  can  be  updated  even  if  there  are
problem transactions which will not be processed. It is strongly recommended to fix these errors at the source and never
to ignore them. Manual processing in MLM may be required in some instances.
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Before the import, the resulting Line statuses will be displayed as well as the amounts that will be accounted according to
these Line statuses (bottom left of the window). Press on "Submit" and the Payment schedule will be updated:

The process seems simple at first sight but multiple conditions are analyzed by MLM. See the Payment Import Conditions
below.

Payment Import Conditions

The following conditions will be followed for payment updates via the XLSX (or XLS) file.

Definitions for the table below:

 Exact*: the data (Unique Line ID, Pmt Date or Payment (Amount)) from the XLSX file matches the information on the
payment line in the Payment schedule

 Higher: Higher payment than original payment amount
 Lower: Lower payment than original payment amount
 Early: Payment before the date at which it was expected
 Late: Payment after the date at which it was expected
 Any: Any Line ID, Pmt Date or Payment amount
 Unchanged:  Amount  indicated  in  the  “Expect.  Pmt”  column  remains  the  initial  amount  (thus  before  the  payment

update) 
 Error message: An error message will appear and this data will not be updated
 Resulting…: Consequence of the import or tentative import (unsuccessful line import) 

*   If  all  transactions  to  import  meet  the  "Exact"  condition,  as  described  earlier,  refer  to  the  "Payment  update  via
precise payment Amount and Date" section in order to simplify the steps for importing your existing payments.

The Pmt Date and Payment (Amount) will always match those from the import file when the line is updated.
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Line ID Pmt Date Payment
(Amount)

Resulting
Line status

Resulting
“Expect. Pmt”

Resulting
“Pmt Due Date”

Exact Exact Exact Paid Pmt * Unchanged Blank
Exact Exact 0.00 or

Blank
Unpaid Pmt Unchanged Blank

Exact Early or Late 0.00 or
Blank

Error message

Exact Exact Higher Paid Pmt Unchanged Blank
Exact Exact Lower Partial Pmt Unchanged Blank
Exact Late but before

next line
Exact Late Pmt Unchanged Expected Pmt

Date
Exact Late but after next

line
Any Error message

Exact Late but before
next line

Lower Partial LatePmt Unchanged Expected Pmt
Date

Exact Early Exact Paid Pmt * Unchanged Expected Pmt
Date

Exact Early Lower Partial Pmt Unchanged Expected Pmt
Date

Exact Early Higher Paid Pmt * Unchanged Expected Pmt
Date

Exact Early and before
previous line

Any Error message

Record
number-0

(***-0)

Any that meets
above conditions

Positive
amount

Add. Pmt 0.00

Record
number only-

(***-)

Any that meets
above conditions

Positive
amount

Add. Pmt 0.00

Record
number only 

(***)

Any that meets
above conditions

Positive
amount

Add. Pmt 0.00

Same ID twice
or more in file

Any Any First valid
transaction

(chronological
order) will be
accepted and
line updated.

Other identical
IDs will give

Error message
Same ID
(already

updated) sent
in new file

Any Any Error message

Any Invalid date format Any Error message
Any Any Negative

amount
Error message

Empty Any Any Error message
Any Empty Any Error message
Any Any Empty Error message

Empty Empty Empty Ignored

* “Paid Pmt” is the default result for normal payments. A Paid Pmt can be substituted for Paid Pmt 2 to 20 for regular
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payments.

Other conditions:

 Formatting of cells (Line ID, date or monetary) must be met otherwise an error message will be given.

 Only Due Pmts (any of the five types) are updated. No other Line statuses. Error message for any other Line status
with an update attempt.

 Due payments that have been submitted as EFT payments are automatically excluded.

 If Automatic column fees are included, then the normal rules will be followed by the change of Line status (Unpaid or
Late would have $25 fees for example).

 Advanced  settings:  If  lines  are  “tagged”  to  recompute  the  payment  amounts  so  they  pay  interest-only  or  fixed
principal amounts and if  two or more payments are included for the same Record, in the same XLSX file,  then the
first  payment if  less  (or  more)  than  the  normal  payment,  will  affect  the  next  payment  amount  (since recomputed
automatically) and consequently the “Expect. Pmt” column. So the second payment may become a Partial payment
even if  originally a full  payment since the due payment amount was influenced by the preceding  payment (which
would not have been paid for example). 

 Advanced  settings:  If  “Expect.  Pmt”  column  amount  is  changed  by  user  -  no  automatic  recomputation  -  then  this
amount entered manually will always be used, no matter what is returned in XLSX file.

Other notes:

 Line order does not matter. Do not leave more than 10 consecutive empty lines in the XLSX file otherwise MLM will
have considered all data submitted (lines below are ignored).

 If  the  XLSX  file  is  produced  on  a  station  with  a  different  date  format  (DD/MM  versus  MM/DD)  than  the  Margill
station, make sure the format is properly interpreted in the import.

 If  unpaid  payments  cannot  be  returned  in  the  XLSX  file,  the  user  should  then  update  these  payments  to  unpaid
directly in the Payment schedule of though the Post payment tool.

 The date of the original first line of a payment schedule can not be changed for loans created before version 5.0 even
if  you  are  using  version  5.0  and  higher.  In  this  exceptional  situation,  the  change  will  have  to  be  made  manually
(change  first  line  to  Unpaid  and  add  new  line).  For  new  loans  only,  created  with  version  5.0  or  greater,  the  first
payment date can be changed.

Use Grace Date

This option is useful to automatically manage payments to the correct Payment Line status, when users do not want to
penalize their Borrowers who pay later than the payment date, but within a grace period that is available to them.
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When the "Use Grace Date" option is checked, the date entered in the “Pmt Date” column of the Payment schedule will
not be changed if the Excel payment date (or date entered manually below) is within the Grace period entered in the “
Advanced” tab of the Record. 

For  example,  if  a  payment  is  made  two  days  after  the  date  entered  in  the  "Payment  Date"  column  of  the  Payment
schedule, but the Borrower has four days of grace, the Line status will automatically be changed to "Paid Pmt" (or other
Line status by default) as opposed to "Paid Late Pmt". The payment date from Excel will be displayed in the "Actual Pmt
Date (Grace / EFT)" column.

No extra interest is thus accrued if the payment is late but within the Grace period. The date that will be added in the “
True Pmt Date (Grace/EFT)” column becomes the transaction date in the Accounting entries report and is accessible in
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various ways in other reports.

If there is a partial late payment within the Grace period, the Line status will be changed to Partial Pmt, not to Partial Late
Pmt.  The  expected  payment  amount  (“Expect.  Pmt”  column)  will  be  entered  automatically  in  order  to  calculate  the
Outstanding amount.

If  a  “True Pmt Date (Grace/EFT)”  is  already present in  the Payment schedule or  if  a  Grace date is  entered in  the  Excel
sheet (column D), an error message will appear. Date confusion could result. The date already entered in the “True Pmt
Date (Grace/EFT)”must be taken out before the payment can be updated.

The other “Payment Import Conditions” (see information above) remain unchanged.

Example #1 (Payment within the grace period):

A Borrower is entitled to four (4) grace days (entered in "Advanced") from the normal, set payment date.

He owes 250.00 on 2017-07-05

His payment is cashed on 2017-07-07.

Since  it  is  required  that  the  grace  dates  be  managed  automatically  by  MLM,  the  "Use  Grace  Date"  option  is  checked.

Once the file is selected with , an analysis will be made to identify the corresponding transactions and the errors
which  will  appear  in  red  in  the  "Message"  column.  The  corresponding  transactions  can  be  updated  even  if  there  are
problem transactions which will not be processed. It is strongly recommended to fix these errors at the source and never
to ignore them. Manual processing in MLM may be required in some instances. When the transactions are all good, press
"Apply".
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Here is the result of this transaction in the Borrower's Payment schedule: 

o The "Pmt Date" column is intact; 
o The amount in the "Accrued Interest" column as well; and 
o The "True Pmt Date (Grace / EFT)" reflects the real date at which the payment was received. 

Example #2  (Payment after the grace period):

A Borrower is entitled to four (4) grace days from the usual, set payment date.

He owes 250.00 on 2017-07-05
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His payment is cashed on 2017-07-11, so two days over the number of grace days allowed. If the import module's "Use
Grace Date" is selected, processing will be done as follows:

o Since the delay exceeds the number of grace days allowed, the payment will be considered "Late Pmt Paid";
o The "Pmt Date" will be changed on 2017-07-11;
o Accrued interest will be calculated on the amount overdue for the period between 2017-07-05 and 2017-07-

10.

Note:  If  the  user  prefers  to  enter  dates  manually  in  the  "True  Pmt  Date  (Grace  /EFT)"  column,  which  is  allowed  with
import, uncheck the "Use Grace Date" option and add a forth column to the Excel sheet (column D) in order to import
your data. If a "True Pmt Date (Grace / EFT)" is already in the Payment schedule, an error message will appear.  Allowing
otherwise could have caused confusion in the dates.

It is allowed to enter a Grace date that is after the last payment date in the Payment schedule.

If the "Use Grace Date" option is selected, no date must be entered in column D of the import sheet, nor in the "True Pmt
Date  (Grace  /  EFT)"  column  of  the  Payment  schedule.  When  this  option  is  chosen,  MLM  takes  the  responsibility  of
managing the grace dates.

Use PRECISE Date and amount 

This option comes in handy when scheduled payments are either paid or unpaid and cannot be partial or late - usually
when the payments are submitted to a bank for batch processing. It is less practical when there is the possibility of late
and partial payments.

See this section: Payment update via precise payment Amount and Date.

   

Payment update via precise payment Amount and Date

This  tool  updates  existing  payments  ("Due  Pmt"  type  Line  statuses)  with  an  Excel  spreadsheet  using  a  Record  Unique
identifier and the precise payment Date and Amount. 



Page 201

© Jurismedia Inc., 2007- 2023

This option comes in handy when scheduled payments are either paid or unpaid and cannot be partial or late - usually
when the payments are submitted to a bank for a batch processing. It is less practical when there is the possibility of late
or partial payments.

Thus, the file (Excel format) containing the desired transactions, will be imported in Margill Loan Manager (MLM) and all
"Due Pmt" type Line statuses will automatically be modified to Paid Pmt (or to any of the custom Paid Pmt 2 to 20 or Paid
Interest (1 to 4) or Principal Paid (1 to 4)) on the condition that the payment Dates and Amounts correspond EXACTLY
between the Excel file and the Due pmt in MLM. All other transactions will appear in red and must be managed manually.

Steps  are  the  same as  described  in  the  Payment  update  via  Line  Unique  Identifier  section,  except  the  user  needs  not
provide the information related to the line identifier to import payments. 

In  MLM,  open  the  "Import  existing  payments"  window  via  Tools  >  Post  Payments  >  "Bulk  Payment  Import"  button  >
Import existing payments.

The following window will  open allowing for the import of the Excel sheet. Select the "Use PRECISE Date and Amount"
option.

Prepare  the  file  from  a  third-party  software  by  following  the  same  technical  specifications  as  those  described  in  the
previous  section:  Payment  update  via  Line  Unique  Identifier.  Omit  the  dash  and  the  line  identifier  in  the  "Record  ID
(MLM)" column.
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Once the file from the third-party software is ready, follow the steps in this section: Payment update via Line
Unique Identifier.

If the date AND the payment amount correspond EXACTLY to the next "Due Pmt" Line status of the payment schedule,
the payment will be modified from "Due Pmt" to "Paid Pmt", or other Line status chosen by default from the drop-down
list, or to the Line status corresponding to the code entered in column E of the Excel sheet.
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If the date OR the payment amount in the Excel sheet do not correspond EXACTLY to the next "Due Pmt" Line status of
the payment schedule, then the payment line will appear in red and will not be imported. These payments will have to be
managed manually or via the "Payment update ("Post Payments")" tool in order to save time.

Any other transaction that appears in red will be accompanied by an explanation in the "Message" column and must be
managed manually.

Note: If two transactions are included in MLM, at the same date and for the same amount, for the same Record, only the
first transaction will be updated, even if the two payments for the same amount at the same date are scheduled in the
Payment schedule. The second transaction will appear in red as an error. 

Exception:  If  the  payment  Dates  are  the  same,  but  the  amount  in  the  payment  schedule  is  at  0.00  and  the  amount
returned by Excel is 0.00, the Line status will be changed to "Unpaid Pmt".

For example, if there were two transactions in MLM at the same date, one with a payment of 250.00 and the second one
of 300.00 and that the Excel sheet reported a payment of 550.00 at that same date, then none of the two transactions
would be updated because the amounts do not match. These lines would appear in red and will  have to be processed
manually.

Payment schedule Spreadsheet

Import tool for existing payments
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Electronic Funds Transfer

Margill  Loan Manager MLM) allows for  Electronic  Funds  Transfer  (EFT)(ACH) processing in  the  US and Canada (Europe
coming soon).  In  the  United  States,  this  is  done  via  a  "NACHA"  file  accepted  by  most  banks.  In  Canada  the  partner  is
Perceptech Inc.  (subsidiary of  ACCEO Solutions Inc.)(Montreal,  Quebec).  To  apply  with  a  Processor,  please contact  the
Margill team to obtain the proper reference.

Processors charge an initial set-up fee, a monthly fee and a transaction fee. Special prices are offered to Margill clients.
Please contact the Margill team to obtain the fee schedule.

Various other names used in the industry and in this User Guide are ACH (Automatic Clearing House (USA)),  Electronic
checks, Pre-authorized payments...

Once a payment schedule is set up with upcoming Due payments, some of these or all of these future payments may be
submitted for EFT by bank account debit. After the payments to submit are selected, an encrypted file is produced and
sent (or must be sent) to your Bank in the US or one of the Electronic Funds Processors in Canada.

The diagram below (looks complicated but is really simple...) provides an overview of the interactions between MLM, the
EFT Processor (or Bank with NACHA files) and you the Creditor.

Important note:

 ONLY "Due Pmt" Line statuses will be submitted as pre-authorized payments. Fees, Insurance, Taxes, etc. will NOT be
submitted.
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See the next section Setting up the EFT module.

Using EFT without a Margill recommended Processor

The module can also be used partially without going through a Margill EFT Processor. However, you will then be using a
partial  solution by  going  through your  own bank  or  EFT  provider.  Essentially,  by  going  through  your  own  bank  or  EFT
provider, the main component, which adds greatest value, is missing: 

 Direct data transmission of the payments to be collected from MLM to the EFT Processor.

Without this component, depending on the data required by your provider and the transmission format, you may be able
to create a file using the various tools in MLM that can be submitted to your provider. You will then be able to use the
other components of EFT accordingly.

Considering the number of approaches and file formats that are required by various banks and EFT providers, the Margill
team does NOT support such implementation except through a NACHA file in the US.

See:

United States - NACHA file

Canada - Perceptech (Acceo)

Europe - SEPA File

   

EFT Definitions

To simplify explanations,  the following definitions are used in the  User  Guide and in  the  Margill  Loan Manager  (MLM)
software:

EFT: Electronic Funds Transfer

PAP: Pre-authorized payment

EFT Processor: company that partners with Margill Loan Manager that processes the EFT payments.

EFT Provider: same as EFT Processor

EFT  Portal:  EFT  Processor’s  on-line  EFT  management  tool.  This  is  accessible  on  the  Internet  with  a  user  name  and
password provided by the Processor

 Known as GPS for Perceptech (www.perceptech.ca – go to English)

EFT file: Encrypted file that is sent (manually or automatically) regularly to the EFT Processor

NACHA file:  NACHA (National  Automated Clearinghouse Association).  A set  of  instructions that  triggers a  batch of  ACH
payments as soon as it is uploaded into a bank portal. NACHA file format is the protocol for structuring those instructions
in a way that successfully initiates the payments.

ACH (US mostly): Automatic Clearing House (for draws from a bank account as opposed to credit card draws)

http://www.perceptech.ca
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United States - NACHA file

As of version 5.3, Margill Loan Manager (MLM) creates NACHA files for EFT payments in the United States.

A NACHA file is a set of instructions that triggers a batch of ACH payments as soon as it is uploaded into a bank portal.
NACHA file format is the protocol for structuring those instructions in a way that successfully initiates the payments.

Contents:

Setting up the EFT module

Selecting and Submitting Payments 

EFT Payment Update (Rejected payments)

Changing or Deleting Submitted EFT Payments

Replacing Bank accounts

Adding Bank Account and Activating EFT in Bulk

   

Setting up the EFT module

Electronic  payments  (ACH  -  Automated  Clearing  House)  for  the  United  States  are  integrated  in  Margill  Loan  Manager
(MLM) through NACHA files. By using ACH, you will no longer need to deal with physical checks. ACH payments will save
you time, money and headaches.

How it works

Based on the payment schedule produced for your borrowers, once a month, once a week or every weekday, select the
payments to be collected. 

With the click of a button, a NACHA file is produced. Upload this file to your bank's portal  (we recommend to Prenote
first - that is to test account information). If the file is accepted by your bank, the amounts from each of your borrowers'
bank accounts will be collected on the effective date and deposited to your bank account based on your bank's payment
policy.

Automatically, "Due Payments" in Margill will be changed to "Paid" on the day the debit is made. Margill ASSUMES the
payment was successful. For rejected payments, you must consult your bank's rejected payment report and batch change
the "Paid" payments to "Unpaid" (Post payment tool) and, based on your rules, automatic fees can be added as well as
Emails or SMS sent to the Borrowers. You can then contact your borrower to reschedule any payment.

System Setup Steps

1. Setup with your Bank

2. Basic System Setup
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3. Set up Creditor 

4. Set up Borrower

5. Set up Record for EFT

Summary of steps

System Setup Steps

(1) Setup with your Bank

Contact your bank to make sure it accepts NACHA files and has a portal for file uploads. 

(2) Basic System Setup

As MLM Administrator, go to Tools > Settings > Electronic Funds Transfer in the "Modules" section. The following window
will appear:
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 Check “Activate the Banking Data module”.

 Select the US for the bank account.

 Check “Activate the Electronic Funds Transfer module”.

 Choose the EFT method NACHA or Wells Fargo (if your bank is Wells Fargo, you will simply have a few less data to
enter in the Creditor setup but the whole process is the same - a NACHA file is produced).

 The only “Transmission Method” allowed "Manual": This means you must upload the NACHA file produced to your
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Bank.

 It is possible to choose, for the "Due Pmt", "Due Pmt (2) to (5)" (to be renamed as desired) Line statuses which will be
paid by electronic funds transfer. By default, on the day the payment is due, the Line status will be changed to "Paid
Pmt", "Paid Pmt (2)", "Paid Pmt (3)", etc. (as renamed), but you can change these by choosing from the nine other
Line statuses related to a paid payment.

Moreover, you can decide, for example, that only the Line statuses "Due Pmt (4)" and "Due Pmt (5)" be submitted as
pre-authorized payments, and that the three first types be managed manually. You simply need to select the "Do not
include  this  Due  Pmt  when  submitting  EFT"  so  that  these  lines  do  not  appear  in  the  EFT  submission  table.  These
types of Due payments could be, for example, payments by bank transfer made directly by the Borrower (or cash or
check payments).

Note: Line status "Paid Pmt (11) to (20)" are not recommended to manage pre-authorized payments since they do
not have equivalents in the "Unpaid Pmt" Line statuses and their accounting components (interest, principal,  fees)
cannot be isolated in reports. 

Checked Line statuses will not be sent to the EFT module

Example 1:

A user might decide to rename the "Due Pmt (2)" Line status to "Due Pmt - Extra" and use this Line status when the
Borrower makes a payment that was not scheduled. By choosing the corresponding special "Add. Pmt" Line status,
the "Expected Pmt" column will automatically become 0.00, automatically reducing the outstanding balance.

Example 2:

A user might decide to rename the "Due Pmt (3)" Line status to "Due Pmt - LATE" and use this Line status when a
Borrower requests a reprieve before making a pre-authorized payment. Fees are to be charged to the borrower on
this  late  payment.  By  choosing  the  corresponding  "PMT  delayed  >  10  days"  for  "Due  Pmt  -  LATE"  on  the  actual
payment date, the Line status will automatically change and automatically generate Column fees if the rule was set
up with Automatic Column Fees.
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 The rejected payment  automatic  Line  status  change (from Paid  to  Unpaid)  is  not  available  in  the  NACHA module.
Users  must  check  the  Bank's  portal,  consult  the  rejected  transactions  report  and  bulk  change  the  now  (assumed)
"Paid" payments to "Unpaid". This can be done manually for each Record but usually is done in bulk with the very
powerful and quick "Post Payments" tool. See the Changing Paid Payments to Unpaid Payments subsection.

Option not available with NACHA

 The MLM Administrator may decide that only some specific users be allowed to submit Pre-authorized Payments. It
is  strongly recommended to limit  the number of  users that  can create NACHA files.  This  permission may be  set  in
Tools > Users. The "Can use EFT module" should be checked to authorize this. To access the module, the user must
have access to all the Records as well as to all  Borrowers/Employees/Creditors. The user will  not be able to access
the module otherwise.  

(3) Creditor EFT Setup

Now that the system is set up to accept EFT, the Creditor or Creditors must be set up to accept EFT payments.

Single Creditor

Go to File > Creditor > EFT tab. Click on “Edit” and enter the following information, much of it provided by the Bank (or
other financial institution):

 Bank name
 EFT Creditor ID Number
 Originating DFI ID
 File ID
 Company name (long and short)
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Multiple Creditors

EFT is possible for a portfolio with multiple Creditors bearing in mind these conditions:

1. A  loan  can  only  be  credited  to  one  Creditor's  account  even  if  two  or  more  Creditors  own  the  loan  (participating
loans). Including multiple Creditors in a loan and assigning a participation (percentage or monetary) for each, will not
influence  this.  Only  the  chosen  Creditor's  account  will  be  credited.  To  deposit  to  separate  Creditor  accounts,
separate loans would have to be set up.

2. A separate account must be setup with your bank.

Go to File > Creditor > EFT tab. Click on “Edit” for each Creditor as explained in the “Single Creditor” section above.

(4) Borrower EFT Setup

Go to File > Borrower. Choose the Borrower to set up. 

The bank accounts must first be set up for each Borrower. Click on the “Accounts” tab.

A Borrower may have more than one bank account for a loan, but draws can only come from one account at a time. Over
time, the account to draw from may be changed.

To add  a new bank account, click on “New”.



Page 212

© Jurismedia Inc., 2007- 2023

Bank Accounts

For US Bank Accounts, enter the following data:

 Description: describe this account as you wish
 Account Type: select "Checking" or "Savings"
 Routing Number: enter a 9 digits Routing Number for the bank account. 
 Account Number: enter the bank account number only (length may vary)

NOTE: The Routing and Account numbers are NOT verified at this stage, so always double check these.

Borrower banking data can also be entered in bulk through the Global changes tool. Go to File > Borrower. Highlight the
Borrowers (lines will become blue), right click with the mouse and go to the Banking Data tab. The required banking data
can then be entered Borrower by Borrower. Then click on Save.

Banking data can also be imported to Margill via an Excel sheet in Global changes. Click on the question mark to the right
of the Excel logo to obtain the file/data format.
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Once the import file is ready, click on the Excel file to select the banking data file.

(5) Record Setup for EFT

Finally, each Record that will include EFT must be set up to allow EFT.

To set up the EFT payments, open up the desired Record, go to "Data" followed by the "EFT" tab.

NACHA (or Wells Fargo) will be indicated.

Check “Activate Electronic Funds Transfer for this Record”. 

 If one of the steps above has not been completed, you will not be allowed to activate EFT for this loan. See the
error message and complete the missing step(s).

Choose the Creditor whose account will be credited. A Creditor must be chosen in the Creditor tab and the Creditor must
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be EFT enabled (step (3) above).

Choose the  Borrower’s  account  from which to  debit  the  payments.  There  may  be  one  or  many  choices  depending  on
what data was entered in the Borrower’s "Account" tab (step (4)). 

Save the Record.

IMPORTANT  to  save  considerable  time!  The  setup  can  also  be  done  in  minutes  for  all  required  Records  through  the
Global changes (select Records in Main window > right click and choose the "EFT active" option):

Once  this  is  done,  you  will  then  select  the  Payments  you  wish  to  submit  as  EFT  as  described  in  the  "Selecting  and
Submitting Payments" section.

Choice of Creditor

If no Creditor appears in the “The payments will be credited to the Creditor account:” or if the portfolio includes
multiple Creditors but they don’t all appear, two reasons are possible:

1. Creditor setup incomplete

 Make sure the Creditor EFT data is complete.

2. Creditor “Ownership”

 A Creditor is entered in the system by a user. This user will become the Owner/Creator of this Creditor.
Since Margill was developed to allow multiple Creditors with a certain non-transparent wall (or barrier if
you prefer) between the entities, a Creditor owned by one user will not show up when another user sets
up the Borrower's account. 

As an example, there are two users in the system: ADMIN and JOHN.

 ADMIN created Better Lenders
 JOHN created ABC Lenders Inc.

If  user  JOHN  is  setting  up  the  Borrower’s  EFT  account,  only  ABC  Lenders  will  appear  as  a  choice  in  the  “The
payments will be credited to the Creditor account:” menu.
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In  order  for  user  JOHN  to  be  able  to  credit  the  Better  Lenders’  account,  JOHN  should  go  to  File  >  Creditor  >
Creditor File and change the ownership to JOHN. A much faster way is to uncheck these options, allowing JOHN to
see all Records and Borrowers/Employers/Creditors (Tools > Users).

Summary of steps

Here is a summary of the steps required for submitting the EFT payments No need to panic... the steps are easy to follow!

1) EFT Service provider

You must open an ACH account with your bank and make sure it accepts NACHA files.

2) Settings

Activate the module Electronic Fund Transfer (EFT):

Tools > Settings > Electronic Funds Transfer

3) Creditor

Enter the information provided by your bank

File > Creditor > EFT tab

4) Borrower

Enter the account information used for each Borrower

File > Borrower > Accounts tab.
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Use Global Changes (for Borrower) to enter or import bank account data quickly.
 
5) Record

Activate preauthorized payments for the Record.

File > Data > EFT tab

Note: Only “Active” Records can be submitted via ETF.

Use Global Changes (for Records) to activate EFT for each Record more quickly.
 
6) Submitting transactions

Selecting the payments to submit and submitting these:

Tools > EFT

See the next section "Selecting and Submitting Payments" for Step 6.

   

Selecting and Submitting Payments

Once the system and the specific Records are set up for electronic funds transfer, the payments must then be submitted
to your Bank. 

In order to choose the upcoming payments for EFT, go to Tools > EFT .

The following window will appear allowing you to choose the payments that are to be submitted fro ACH: 
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IMPORTANT: Only ACTIVE Records that have been “EFT-enabled” will be included in this tool (see the previous section,
(5) Setup Record for EFT). In order to submit EFT, a user must have the right to see ALL Records and ALL Borrowers/
Employers/Creditors. He will not be able to submit EFT otherwise. See Administrator and Users.

Enter the first date (“Report from”) at which an EFT payment is to be debited and the final date (“to (inclusively)”) for this
EFT batch period.

Payments submitted must be within the following range: Between current day, up to 45 days in the future. Check with
your bank to see if  you can submit payments that should have been collected in the past (old or  "stale" effective date
payments). If this is not allowed, you may need to change the payment date directly in the NACHA file. This should be
done very carefully. 

The amounts from each of your borrowers' bank accounts will be collected on the effective date and usually be deposited
to your bank account the next working day. For next-day debits, consult your bank's policy.

Once the period dates are selected, press on Refresh or F5. A list of all Active and EFT-enabled Records will be displayed
and can then be submitted for EFT. Check, in the first column, the payment lines that are to be submitted for EFT.

Any payment with Line status “Due Pmt” prior to the “from” date (that is EFT enabled), will appear as a pink line, a check
mark  will  appear  in  the  "Do  not  process"  column  and  the  message  "Will  not  process"  will  appear  in  the  "Processing"
column (see the second line in the example below). This means that an Due payment was not properly processed by the
MLM users (its Line status should have been changed to Paid, Unpaid or other, as opposed to remaining “Due Pmt”). It is
strongly recommended to resolve any of these issues before submitting payments for EFT.

If  such  issues  are  not  resolved  before  the  actual  payments  are  debited  at  the  set  date,  MLM  will  NOT  automatically
change the Line status to Paid, since a Due Pmt cannot precede a Paid Pmt.

In such circumstances the Main MLM window will display a warning icon that signifies that there is an error. Click
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on the warning icon and a message will identify the problem Record and describe the problem. The issue really must be
fixed by the user.

On the other hand, MLM will not prevent the user from processing the data in a Record containing irregularities, because
there are exceptions, as in the following scenario:

 It is possible to submit an EFT when previous lines are pink. For example, if a Borrower changes his payment method:
he always had paid by check but now wants to pay with EFT but only in two months. A MLM user can decide, for a
reliable client, to send the payments to be collected to the EFT provider in advance. Therefore, when the checks are
cashed, the user will  update the payments in the Payment schedule (from "Due Pmt" to "Paid Pmt"). Thus, on the
date of the pre-authorized debit, payments will be automatically updated in the Record since this transaction will no
longer be preceded by a "Due Pmt" Line status.

Submitting EFT payments

The  first  step  in  submitting  payments  is  to  select  the  dates  of  the  debit  period.  Payments  should  be  submitted  on  a
regular basis.

As can be seen in the example below, flagrant errors will be highlighted in yellow. Pass he mouse ove the red button to
see the error.

For selecting multiple lines, instead of checking each individually, select the lines with the mouse (or use Shift or Ctrl and
the mouse for non-contiguous lines) and check one of the “Submit” boxes or right click with the mouse > Selection and
select the desired choices.
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The  “Select  All”  button  can  also  be  used  to  select  all  lines  from  this  table.  Always  check  each
payment carefully before using this.

A Comment may also be added for any payment line. Comments will be added in the Payment schedule even if the line
itself is not checked. 

Two options are available:

1) Prepare Prenotes NACHA file
2) Prepare live NACHA file to sent to the bank

Debit date (money from Borrower account) versus Credit date (money to Creditor account)

The EFT Processor will usually debit the Borrower's bank account on the date the payment is due. If the payment is
set for a weekend or on a statutory holiday, the debit will be taken on the next working day.

However, the credit to the Creditor's account will only be made a few days after the debit date. The number of days
may be worked out with your bank.

When  payments  are  due  at  the  end  of  the  month,  the  Creditor's  account  may  be  credited  only  in  the  following
month.  This  can  cause  bank  reconciliation  issues.  For  example,  you  were  expecting  a  total  amount  of  55,500  in
September but only 55,000 (500 missing) is deposited in September. There may have been amounts due in August
but  deposited  to  the  bank  account  only  in  early  September  as  well  as  amounts  due  in  September  but  actually
deposited in early October.
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In order to reduce bank reconciliation issues with EFT, you could use the "True Pmt Date (Grace / EFT)" column. In
the Accounting Entries report ONLY, the date indicated in this column is reported as opposed to the "Pmt Date".
For end-of-month transactions, payments that are to be debited on the 29th, 30th and 31st (and possibly
the 26th, 27th and 28th for February and 30 day months) could have True Pmt Dates on the 1st, 2nd, 3rd
or 4th of the next month, the dates at which the payments are truly credited to the Creditor's account.

A utility allows to automatically indicate a date in the "True Pmt Date (Grace / EFT)" column that is x days after
the  date  indicated  in  the  "Pmt  Date"  column.  So  in  the  example  above,  the  bank  shows  55,000  as  the  amount
credited to  the  Creditor's  account  in  September yet  55,500 was paid  by  the  Borrowers.  By  adding  3  days  to  each
"Pmt Date", the equation will yield the proper September deposits:

55,500   +   2,000   -   2,500   =   55,000
Expected       Extra       Missing       Actual  

To add a date in the "True Pmt Date (Grace / EFT)" column that is x days after the date indicated in the "Pmt Date"

column, click on . The following window will appear allowing you to indicate the number
of days to add.

For payments that are scheduled on a Saturday or on a Sunday, the debit from the Borrower's account will only be
done on the next work day, thus adding an additional day or two to the credit date.

To handle this situation, you may check "Add to the final date 2 days for a Saturday payment, 1 day for...". This will
add two (2) days to the number of days entered above if the payment was to fall on a Saturday or one (1) day if the
payment was to fall on a Sunday.

This feature can be checked even if the number of days to add is 0.
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Submitting "Prenotes"

Prenotes are zero dollar entries that precede the first live entry. The purpose of a prenote is to verify account information
(Routing and Account numbers).

Prenotes  are  optional  but  may  eventually  become  compulsory  in  the  US.  If  sent,  prenote  rules  must  be  followed.  A
prenote must precede the first live entry by at least six banking days.

The Receiving Bank is not required to validate the name of the payee on the prenote, although many do; they are only
required to check the account numbers. You must understand there is still a risk if the subsequent entry debits the wrong
account (this is true for all originations, not just prenotes).

Margill does not check if a prenote has been uploaded to the bank's portal previous to a live ACH entry but a box
reminds you to send a prenote if the "Validate Accounts - Prenotes" box was not checked.

By pressing on Continue, no prenote will be created. The "Cancel (Create Prenotes)" button will get back to the window
without sending the live data, thus allowing you to check  "Validate Accounts - Prenotes".

If  a  Prenote  is  created,  this  message  will  appear  indicating  the  prenote  name  and  where  the  prenote  file  is  located,
allowing you to upload it through the bank's portal.

Then check back in the bank's portal for the prenote analysis. The banking information corrections must be done in MLM
before submitting the live NACHA file.
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Prepare NACHA file to be sent to the Bank

Once  the  proper  payments  have  been  selected,  press  on  “Submit”  .  You  will  then  obtain  the
following message indicating the NACHA file name and where the file is located:

You must then manually upload the file through the bank's portal. MLM does NOT do this for you.

Next, this window will appear again providing the file's path and name. Four (4) options will be available and the choice
to be taken will depend on whether the file has been sent to the bank of not, and if the file production was live or simply
a test:

 
First EFT processing window

"Finish  later":  If  the  file  has  not  yet  been  uploaded,  press  on  this  button.  The  window  will  close  giving  you  the
opportunity to upload the file to the bank. The Records submitted will all lock up and not allow any changes until they
are "freed" from their "temporary, unmanaged" EFT state. They become yellow and indicate the reason for which they
are locked and who created the NACHA file.
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Usually all Active Records would become yellow and in read-only mode

The Records remain locked until an authorized user manages the EFT and tells the software that the file was uploaded to
the bank or that the process should be aborted.

When  an  authorized  user  goes  to  Tools  >  EFT,  the  "Preauthorized  Payments  (EFT)  Transmission"  window  below  will
automatically appear allowing the user to complete or cancel the EFT processing in MLM.

Second EFT processing window

"Continue  and  finish  processing":  Once  the  file  has  been  submitted,  press  on  this  button.  The  first  EFT  processing
window will reappear giving you the same options as before to complete the EFT process or to abort this process:

By pressing on "Continue processing", this tells MLM that the payments will be processed by the bank and to change the
"Due payments"  to  "Paid  Pmt"  on  the  day  they  are  to  be  collected.  The  following  window will  confirm that  MLM  has
managed the payments:
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In the Payment schedule, the payments submitted will keep the "Due Pmt" Line status but will be highlighted in pink until
the effective date at which they are to be collected. 

In the example below, lines 1-3 were submitted as EFT and cannot easily be modified and should not be changed since
these amounts will be drawn on the due dates. The lines below (4 and following) were not submitted as EFT but can be
submitted later and readily changed if required.

On 06/12/2021, Due Pmt for line 1 will automatically be changed to Paid Pmt (or Paid EFT depending on your rules). On
11/12/2021, same will happen for line 2 and so forth. This is an automatic process as long as MLM software is closed and
reopened on that day, or the process done via Automatic/Overnight Tasks (recommended for larger databases to save
time in the morning).

NOTE: An automatic upload of the NACHA file could be programmed by your IT team if your bank allows such automated
uploads. This would allow you to press on "Continue processing" immediately after the file is created (and automatically
uploaded to the bank portal).

"Abort":  If  the  file  is  not  to  be  submitted  for  live  processing,  press  on  Abort  (First  EFT  window).  The  process  can  be
aborted immediately or any time after if only test files were produced for example.

"Open file location": Does not offer much value but allows you to see and possibly copy the file in order to upload to the
bank's portal.
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See next sections: 

EFT Payment Update (Rejected payments)

Changing or Deleting Submitted EFT Payments

Replacing Bank accounts

Adding Bank Account and Activating EFT in Bulk

   

EFT Payment Update (Rejected payments)

After submitting the file to your bank, all transactions submitted will be debited on the set (effective) date (taking into
account weekends and holidays where the debits are done on the following work day).

Payments are a success

On the day the payment is due, Margill Loan Manager (MLM) will automatically change the Line status from “Due Pmt” to
“Paid  Pmt”  (or  other  Line  status  chosen  in  the  EFT  Setup).  In  order  to  easily  recognize  payments  made  by  EFT,  it  is
recommended to name one of the "Paid Pmt" Line statuses "Paid EFT". You may need to enter this name through Tools >

Settings > System Settings (Administrator) > .
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EFT Setup

The change of Line status from "Due Pmt" to "Paid Pmt" (or preferably "Paid EFT") is performed automatically at the set
date when MLM is  launched.  If  MLM had not  been opened for  a  few days  (or  after  a  weekend for  example),  the  Line
status  changes  will  nevertheless  take  place  for  older  payment  dates  and  not  only  for  the  payments  that  should  be
debited on the current date.

It is recommended to use the Automatic / Overnight Tasks so that the operation is performed even when MLM is closed.
This will save time and avoid potential errors if, although highly not recommended, MLM is not closed or shut down on a
daily basis.

Payments are rejected

If the EFT payment is accepted, the user needs not intervene in MLM. The software assumes the payment is accepted.

Only if a payment is rejected, and your bank will advise you of this in the bank Portal, will you have to change the Line
status of the missed payment from "Paid Pmt" (changed by the system automatically) to "Unpaid Pmt" (or "Unpaid EFT").
This can be done one by one or with the Post payment tool in batches. See Changing Paid Payments to Unpaid Payments.

Mixing EFT payments and non EFT payments

If for some reason (most commonly, progressive EFT implementation), non-EFT Due payments were to precede EFT Due
payments,  if  the previous non-EFT Due payment Line status was not  changed on the day the  EFT payment  was due,  a

System Warning would  advise the  Record Owner (and Administrators  and  Power  users)  that  the  Due  Pmt  Line
status will NOT be changed automatically to Paid as it should normally be.

In the example below, the red line had already been submitted for EFT debit.  The Due Pmt on lines 1 and 2 MUST be
changed manually (to Paid, Unpaid or other) in order for the line 3 Due Pmt to be changed automatically on the payment
date (28-12-2021 in the example).
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This  exception to  an  automatic  change  of  Line  status  stems from the  fact  that  Due  payments  cannot  precede  Paid  or
Unpaid payments.

The warning would only be given on the actual day the EFT payment was due and would remain active until deleted. The
warning will appear even if MLM is not launched on that specific day, but launched later on.

   

Changing or Deleting Submitted EFT Payments

Payments that have already been sent to the EFT Processor for debit, whether paid or not, have special restrictions that
other payments do not. This section covers these.

Changing payment amount and/or payment date

The payment amount and payment date for EFT payment lines cannot be changed in the Payment schedule.

If the transaction is no longer required, it should be deleted (see below). If the payment is not made (insufficient funds
for example), then its Line status should be changed to Unpaid or preferably Unpaid EFT.

Deleting a payment

If upcoming EFT payments had already been submitted for debit in a loan, and for example, this loan is suddenly paid in
full  or  in  default  or  in  bankruptcy,  the  upcoming  EFT  payments  should  be  deleted  in  MLM  AND  also  with  the  EFT
Processor  or  bank.  Deleting  the  payments  in  MLM  will  have  no  effect  on  the  payments  already  submitted  to  the  EFT
Processor, thus the need to cancel the payment or payments with the EFT Processor (by going through the bank's Portal).
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Before deleting you should print the details and then make the changes with the EFT Processor. A list of the payments
submitted will be created.

If the payment had already been paid or is unpaid (Line status "Unpaid Pmt"), although there is no real reason to delete
it, a confirmation will be required to delete the payment or payments.

Eliminating the EFT (preauthorized payment (PAP) status) for upcoming payments

Another possible scenario, is one in which the Borrower changes banks or payment method. In  these situations we do
not wish to delete the upcoming payments but simply wish to delete the EFT status for these payments. Select the red
lines, right click with the mouse, and choose "Delete PAP status for these payments".

See  the  Importing  Bank  Account  Data  and  Activating  EFT  in  Bulk  section  for  complete  details  and  procedures,  including  mass
import/update via Excel sheet.

Changing Line status

If you try changing the Line status of any EFT payment (whether paid or upcoming), the following message will  appear
limiting the Line statuses that may be chosen since EFT payments only have two options: Paid or Unpaid (multiple types
of paid and unpaid Line statuses are available in MLM). These payments cannot be partial, nor late. A late EFT payment is
in fact Unpaid.
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Deleting EFT Records

The same principle applies to deleting Records from MLM as that for lines deleted or payments that should no longer be
debited  from  the  Borrower's  account.  A  change  in  MLM  MUST  ABSOLUTELY  be  accompanied  with  the  appropriate
cancellation of the upcoming payments with the EFT Processor.

The following window will appear for all Records to be deleted that contain PAPs. The question will be repeated for each
Record although one report will sum up all the transactions that are influenced by this deletion (upcoming PAPs).

Cancellation of the upcoming payments with the EFT Processor

Please check with your bank on how this can be accomplished.

   

Replacing Bank accounts

In  a  Record,  it  frequently  happens  that  a  Borrower  changes  bank  account  or  the  payer  (the  Borrower)  is  replaced  by
another. In addition, the Creditor or its deposit account may change. In these situations, an update is required in order to
receive future payments from the right source and, when the changes involve the Creditor, to deposit the funds in the
correct account. For payments already submitted as a PAP or payments that are submitted with incorrect information, if
the changes are not made, the payments will be rejected.
 
The role of Margill Loan Manager (MLM) is to submit current and future transactions with bank accounts valid at the
time of  submission  only.  If  they  change,  MLM  cannot  be  used  to  address  this.  It  is  your  responsibility  to  make  the
changes with your EFT service Provider. 

Situation 1 - Payments already submitted as EFT

When payments  are  already  submitted  in  the  EFT  Service  provider's  system,  you  must  make  the  changes  to  the  bank
account, Borrower and even the Creditor, in the Provider's portal. You will also need to make the changes as described in
the section below, "Situation 2 - Payments to submit as EFT".

All  historical data already submitted must be changed with the Provider; otherwise the payments will  be debited from
their  accounts  with  the  probability  that  the  transactions  will  be  rejected.  The  Creditor  must  be  very  vigilant  in  this
regard.

Always consider the accounts (bank data accounts) at the EFT Provider as the master accounts. Changing an account in
MLM is not sufficient. Changes MUST be made in both places.
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Situation 2 - Payments to submit as EFT

A less critical situation arises when a change takes place and no transactions using the old data are yet submitted to the
Provider.

1) Change of bank account

A change in MLM will ensure that the new account data will be submitted to the Provider's Portal at the next submission
without requiring change in the Provider portal. In MLM, the change must simply be made in the Borrower ("Accounts"
tab). To change or add banking information, simply enter them one by one in the appropriate fields in the table and save them.

See the Adding Bank Account and Activating EFT in Bulk  section for complete details and procedures. 

2) Change Borrower

Sometimes a loan will ultimately be paid by someone other than the Borrower (Co-signer or Guarantor, for example). In
these  situations,  the  change  must  be  made  in  the  Loan  ("Data"  window  >  "EFT"  tab  >  "Borrower  (Account)")  and  of
course the new EFT banking data must be entered as well in Borrower > "Accounts" tab.

3) Change of Creditor (or Creditor account)

If the Creditor or its account changes, the change must be made with the EFT provider first. These changes must be made
in one or two places in MLM, depending on the situation:

 Creditor ("EFT" tab)
 Loan ("Data" window > "EFT" tab > "Creditor (the payment will be applied to the Creditor's account)")

   

Canada - Perceptech (Acceo) / VoPay

Margill  Loan  Manager  is  integrated  with  Perceptech/Acceo  and  VoPay  for  EFT  in  Canada.  The  EFT  file  is  seamlessly
submitted directly from Margill and the bounced payments integrated directly in Margill.

Contents:

Setting up the EFT module

Selecting and Submitting Payments 

EFT Payment Update (Rejected payments)

EFT Payment Rejection Date and Reason
 
Master and Affiliate Loans - EFT

Changing or Deleting Submitted EFT Payments

Replacing Bank accounts

e-Transfers (credit to Borrower)
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Adding Bank Account and Activating EFT in Bulk

   

Setting up the EFT module

Your company must have a service contract for EFT with Perceptech inc. (ACCEO Solutions) (Montreal, Quebec) or with
Vopay (Vancouver, British Columbia). Both companies offer preauthorized payment services everywhere in Canada and
with all banks.

To subscribe with Perceptech or with VoPay, please contact the Margill Team in order to get the appropriate reference.

Providers charge installation fees, monthly fees as well as transaction fees. A special fee is offered to Margill customers.
Contact our team to find out about prices.

Electronic Funds Transfer with Perceptech (Acceo Solutions Inc.) and VoPay

 Payment deposits to your account:
o Perceptech: Deposits are usually made up to six (6) business  days after the scheduled debit date,  but  the

delay  may be  less  depending on  the  precise service used and the  bank  you  deal  with.  Delays  are  shorter
with National Bank and Desjardins Credit Union with Perceptech.

o Vopay:  Deposits  are  usually  made  up  to  three  (3)  business  days  after  the  scheduled  debit  date,  but  the
delay may be less depending on the precise service used and the bank you deal with. 

 Payment lead times:
o Perceptech:  A  two  (2)  business  day  lead  time  is  required  between  the  date  the  file  is  submitted  by  the

Margill  user  and  the  expected  payment  debit  date  (Payment  date  column  in  the  Payment  schedule).  In
order for the debit date to match the MLM "Pmt Date", the user must submit the file before noon (12:00
PM) precisely (Eastern time), at least two business days before the Payment date in MLM.

o VoPay: When you submit a batch for EFT (Electronic Funds Transfer), the transactions of the day, so set to
be debited for that day, can be processed on that day if  they are received before one of  the three cutoff
times of 6AM, 1PM, 6PM, Eastern Time.

 A few examples, we are May 24 and the file is sent today:

 Q: In the file sent, the date on which the money is to be collected is today (May 24) Will
the money be collected today?

 A: Transactions will be processed on the same day if they are all sent to VoPay before the
cutoff times. Processed means that the bank will receive the order and will respond as of
that  time.  The timing of  the  debit  is  influenced  by  several  factors,  including  the  type  of
transaction, the processing time of the bank, and the specific policies of the involved bank.

 Q: In the file sent, the date on which the money is to be collected is May 25 and I send my
file at 6 AM. Will the money be collected on May 25? What if 1 PM, and 6 PM? Will your
debit be on the 25th?

 A:Transaction will be created on May 25th at 2.30 AM UTC and will be processed on May
25th.

 Q: In the file sent, the date on which the money is to be collected is May 26 and I send my
file at 6 AM. Will the money be collected on May 26? What if 1 PM, and 6 PM? Will your
debit be on the 26th?

 A: Transaction will be created on May 26th at 2.30 AM UTC and will be processed on May
26th.
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o Files sent by the user on weekends and holidays will be processed on the next business day. Debits are not
done on weekends and holidays.

o It  is possible to submit old payments that were not collected up to 172 days in  the past  with Perceptech.
There  is  no  limit  with  VoPay.  Old  payments,  today  payments  or  payments  due  the  next  day,  when
submitted  to  the  EFT  provider,  will  be  processed  and  sent  to  the  Borrower's  bank  which  will  be
compensated according to its standard policies. This could be the same day, the next day or 48 hours later.

 The full EFT amount is deposited for each client. Fees are charged separately on a monthly basis.

 The Creditor will be informed that a payment was rejected by the bank two to three business days after the debit
date.  In  some  cases  the  deadlines  could  be  longer  depending  on  the  specific  situation  (disputed  payment  for
example). See EFT Payment Update (Rejected payments).

 VoPay  also  offers  e-Transfers  (credit)  to  your  Borrowers.  The  user  ADMIN  (only  ADMIN)  can  thus  send  the  loan
amount (or other amount), up to CAD 25,000 per transaction to the Borrower in near real-time.

System Setup Steps

1. Setup in the EFT Processor's Portal

2. Basic System Setup

3. Set up Creditor 

4. Set up Borrower

5. Set up Record for EFT

Summary of steps

System Setup Steps

(1) Setup in the EFT Processor's Portal

Perceptech or VoPay

When the account is opened with Perceptech or Vopay, all required Creditor banking information will already be entered
in  the  the  EFT  provider's  Portal.  If  this  information  was  to  change  (change  of  bank  for  example)  you  would  have  to
contact the EFT provider directly and they would make the change.

If  multiple  accounts  are  to  be  credited  (multi-company  or  multi-fund  scenarios),  the  EFT  provider  would  set  up  this
environment on their end and provide the proper identification numbers and passwords that are then entered in MLM
(Creditor ID Number in MLM).

Perceptech EFT Portal
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wwws.perceptech.ca/collybus/login.php?lang=en
or

www.perceptech.ca

VoPay Portal

https://dashboard.vopay.com/#/login

The Portal will mostly be used for producing reports and making changes to preset payments (cancelling future payments
for example).
 
A  change  in  Borrower  bank  account  data  on  the  other  hand,  can  be  done  in  MLM  and  when  the  next  payments  are
submitted (with the updated account information), this new information will be automatically be updated in the Portal.
However, if multiple payments for the future had already been set up and the bank account changes, you would have to

https://wwws.perceptech.ca/collybus/login.php?lang=en
http://www.perceptech.ca
https://dashboard.vopay.com/#/login
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make the changes directly in the Portal. Changes made in MLM would only be transmitted to the Portal (and updated)
when a new debit is submitted.

For detailed information on VoPay EFT: https://docs.vopay.com/docs/eft

For detailed information on Perceptech EFT:  https://wwws.perceptech.ca/collybus/support/ProcedureRecurrentEN.pdf.

(2) Basic System Setup

As MLM Administrator, go to Tools > Settings > Electronic Funds Transfer in the "Modules" section. The following window
will appear:

 Check “Activate the Banking Data module”.

 Select the country for the bank account. Only one country may be chosen, either the US or Canada.

 Check “Activate the Electronic Funds Transfer module”.

 Choose the EFT Processor (also referred to as the EFT Provider). Only one Processor may be chosen.

 With VoPay you may decide to activate the e-Transfer (credit) module.

 The “Transmission Method” box allows two options:

o Automatic

 By choosing “Automatic”, Margill will automatically upload the EFT file (once you have chosen the

https://docs.vopay.com/docs/eft
https://wwws.perceptech.ca/collybus/support/ProcedureRecurrentEN.pdf
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Records and payments to submit for EFT) to the Processor’s server.

 This is the recommended method.

o With the “Manual” method, the user will have to produce the EFT file in Margill and upload to the Processor
’s server via the Processor’s web interface (the Portal).

 It is possible to choose, for the "Due Pmt", "Due Pmt (2) to (5)" Line statuses which will be paid by electronic funds
transfer. By default, on the day the payment is due, the Line status will  be changed to "Paid Pmt", "Paid Pmt (2)",
"Paid  Pmt  (3)",  etc.,  but  you  can  change  these  by  choosing  from  the  nine  other  Line  statuses  related  to  a  paid
payment.

Moreover, you can decide, for example, that only the Line statuses "Due Pmt (4)" and "Due Pmt (5)" be submitted as
pre-authorized payments, and that the three first types be managed manually. You simply need to select the "Do not
include  this  Due  Pmt  when  submitting  EFT"  so  that  these  lines  do  not  appear  in  the  EFT  submission  table.  These
types of due payments could be, for example, payments by bank transfer made directly by the Borrower (or cash or
check payments).

Note: Line status "Paid Pmt (11) to (20)" are not recommended to manage pre-authorized payments since they do
not have equivalents in the "Unpaid Pmt" Line statuses and their accounting components (interest, principal,  fees)
cannot be isolated in reports. 

Checked Line statuses will not be sent to the EFT module

 The option that allows to choose the "Unpaid Pmt" Line status for each of the "Paid Pmt" Line statuses allows the
Margill Administrator to specify the final Line status of a payment submitted as an EFT which is rejected (NSF) by the
Borrower's bank. This option allows you to add automatic fees or not depending of the situation. 

o For example, the "Due Pmt", on the set payment date, automatically becomes "Paid Pmt - EFT". When this
payment is rejected, it will become "Unpaid Pmt - EFT" and automatic Column fees would be added.

o If  you do not wish to add fees to certain rejected payments, the payment schedule would include certain
special "Due Pmt" Line statuses which would become special "Paid" Lien statuses and finally, if rejected, it
would become special "Unpaid" Line statues for which no fees would be charged. 

 Example: "Due Pmt - EFT extra" becomes "Paid Pmt - EFT extra" at the date of payment (the system
does this automatically and assumes the payment is not rejected). This extra payment, if rejected,
would become "Unpaid Pmt - EFT extra". By contract between the Creditor and the Borrower, such
an additional payment would not be subject to extra fees in case of rejection and so not fees rule
would be created unlike the "Unpaid Pmt - EFT" which would include NSF fees.
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These Line statuses may be renamed as desired or simply hidden in Tools > Settings > Line Payment Statuses. Naming
a "Paid EFT"  or "Unpaid EFT" may be useful for identifying the payments made or unpaid by EFT versus those paid by
check, cash, etc. These may also be isolated from other types of payments for accounting purposes.

 By  selecting  "Include  the  Rejection  Description  and  the  Rejection  Date  in  the  Payment  schedule",  the  rejection
Description (reason from Perceptech or VoPay) will be added in the "Comment" column of the Payment schedule (if
a comment is already in this column, it will not be erased and the description will be added at the end as long as the
field space is sufficient). Also, the rejection date will  be added to the "Date of Return check/EFT" column even if  a
date  is  already  entered  (will  be  overwritten).  You  can  also  produce  a  report  with  rejection  date  and  reasons  (
Transaction report). See also EFT Payment Update (Rejected payments).

Example :

A user could decide to rename the "Due Pmt (2)" Line status to "Due Pmt - Extra" and use this Line status when the
Borrower  makes  an  unexpected  payment.  Choosing  the  "Add.  Pmt"  (or  "Compensatory  Pmt"  -  name  that  can  be
modify)  Line status for automatic payment, the Borrower's extra payment will be managed correctly in the Payment
schedule.  By choosing the "Add. Pmt" Line status, the "Due Pmt" column automatically set to 0.00. This, therefore,
automatically reduces the Outstanding payment amount if there was one.

Often, when a certain number of debits, in a row, are rejected by the bank, it is suggested to stop attempting to debit the
Borrower’s account needlessly since costs are incurred for rejected debits. This may be 2 or 3, maybe more.

By checking the option "When this number of Unpaid payments in a row is reached", it is possible to prohibit the sending
of or to highlight the pre-authorized payments for loans where several payments have been refused in the past.

This option will, in the EFT submission window, either highlight the next Due Payments that were to be collected and the
Margill user will have to decide whether to submit these or not. 

The second option will altogether prohibit the Margill user from sending the EFT debit order for this loan. The Due Pmt
that was to be collected will still show up in the EFT submission window and will be highlighted. A decision will have to be
taken as to how to deal with this Borrower.

The  number  of  rejected  payments  “in  a  row”  will  be  the  number  of  Unpaid  Pmts  right  before  the  next  Due  Pmt.  For
example,  the  number  indicated  was  3,  the  next  Due  Pmt  will  be  highlighted  if  the  three  preceding  payments  were
Unpaid. If a payment is then successful, this loan will no longer be flagged as a problem account.  
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 When selecting "Exclude the EFT payment if  balance is less than 0.00 before payment or if  payment has a balance
less  of  X.XX",  the  system  will  not  allow  the  user  to  submit  EFT  payments  because  of  an  insufficient  balance.  For
example, if the last payment is 100 and balance is only 25, taking a payment of 100 will give a balance of -75 instead
of the desired 0.00. The lines will be highlighted in red and these payments will be blocked. The user could therefore
decrease the payment before submitting to avoid a negative balance. See also Selecting and Submitting Payments. 

 The MLM Administrator may decide that only some specific users be allowed to submit Pre-authorized Payments to
the EFT Processor. It  is  strongly recommended to limit  the  number  of  users  that  can  submit  these payments.  This
permission may be set in Tools > Users The "Can use EFT module" should be checked to authorize this. To be able to
transmit EFT, the user must have access to all the Records as well as to all Borrowers/Employees/Creditors. The user
will not be able to submit EFTs otherwise.  

(3) Creditor EFT Setup

Now that the system is set up to accept EFT, the Creditor or Creditors must be set up to accept EFT payments.

Single Creditor

Go to File > Creditor > EFT tab. Click on “Edit”.

 The “EFT Processor” box will already be filled out since chosen in the step above.

 A “Creditor ID number” or "Account Number" will be provided by the EFT Processor.

 Perceptech:  In  order  to  transmit  the  encrypted  EFT  file  (the  EFT  file  contains  the  data  required  to  process  the
payments on a regular basis), a User Code and Password must have been set up with the EFT Processor. Enter the
data  here.  Only  the  MLM  Administrator  can  enter  this  data.  The  password  will  be  hidden  and  shown  with

.
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 VoPay: The Account ID, API key, VoPay URL (always https://earthnode.vopay.com/api/v2/) and the API Shared Secret
will all be provided by VoPay. Only the MLM Administrator can enter this data. 
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 Banking data,  thus where the amounts collected will  be  deposited,  is  set  up  in  the  Processor’s  portal.  This  is  NOT
entered in Margill and can only be set up or changed in the Portal or with the Processor’s assistance (see (1) Setup in
the  EFT  Processor's  Portal).  Another  User  name  and  Password  is  used  to  log  into  the  Portal.  It  is  NOT  the  same
password as that entered in MLM for sending the encrypted file.

Multiple Creditors

EFT is possible for a portfolio with multiple Creditors bearing in mind these conditions:

1. A  loan  can  only  be  credited  to  one  Creditor's  account  even  if  two  or  more  Creditors  own  the  loan  (participating
loans). Including multiple Creditors in a loan and assigning a participation (percentage or monetary) for each, will not
influence  this.  Only  the  chosen  Creditor's  account  will  be  credited.  To  deposit  to  separate  Creditor  accounts,
separate loans would have to be set up.

2. A separate account must be setup with the EFT Processor for each Creditor.

Go to File > Creditor > EFT tab. Click on “Edit” for each Creditor as explained in the “Single Creditor” section above.

Banking  information (where the  amounts  are  to  be  deposited)  are  not  entered in  MLM but  directly  in  the  Processor's
Portal.

(4) Borrower EFT Setup

Go to File > Borrower. Choose the Borrower to set up. 
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The bank accounts must first be set up for each Borrower. Click on the “Accounts” tab.

A Borrower may have more than one bank account for a loan, but draws can only come from one account at a time. Over
time, the account to draw from may be changed.

To add  a new bank account, click on the "Bank accounts" tab and on “New”.

Bank Accounts

Bank account data required:

Canada:

 Description: describe this account as you wish
 Active account: check if this account is to be active in the system
 Institution: enter the bank’s three (3) digit institution number (for example, BMO: 001, RBC: 003, etc.)
 Branch No: enter the branch’s five (5) digit number
 Account Number: enter the bank account number only (length may vary)

Since bank account information is  stored in MLM, this  data is  sent to the EFT Processor every time an  EFT file  is  sent.
Thus, there is no need to set up the accounts in the EFT Portal since the data will automatically be added or updated in
the Portal upon transmitting the EFT file.

For  Perceptech  only  (not  required  for  VoPay):  Once  the  banking  data  entered,  go  to  the  EFT  tab  to  create  an  “EFT
Account Number”. This account number is a unique identifier for the payment method and is used by the EFT Processor.
This EFT Account Number is sent in the encrypted file for each transaction.

The  EFT  Processor’s  name  should  appear  (if  not,  go  to  the  "Basic  system  setup"  section  above).  Press  on  "Edit"
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.  When  pressing  on  "Edit",  the  system  will  automatically  generate  an  "EFT  Account  Number".  To  finish,

press on 'Save"  so that the system keeps the identifier.

The EFT Account Number may be changed, but should only be changed in very particular situations, such as, for example,
if an identifier already existed for this payment method with the EFT Processor (the Creditor being an existing client).

It  is  possible  to  enter  the  Borrower's  Banking  Data  by  batch  with  the  Global  changes  module  (including  via  an  Excel
sheet).  This tool  avoids the need to enter the Borrower's banking information one by one.  By entering all  the  banking
data for each Borrower, the "EFT Account Number" will  be entered automatically unless you enter your own identifier
(when such an identifier already exists with Perceptech).

 Then  select,  if  multiple  Creditors  are  included  in  the  portfolio,  to  which  Creditor  the  amounts  should  be  credited
(deposited in the account entered in the Processor’s portal). 

Choice of Creditor

If no Creditor appears in the “The payments will be credited to the Creditor account:” or if the portfolio includes
multiple Creditors but they don’t all appear, two reasons are possible:

1. Creditor setup incomplete

 Make sure the Creditor EFT data is complete, including the Creditor ID provided by the EFT Processor.

2. Creditor “Ownership”

 A Creditor is entered in the system by a user. This user will become the Owner/Creator of this Creditor.
Since Margill was developed to allow multiple Creditors with a certain non-transparent wall between the
entities,  a  Creditor  owned  by  one  user  will  not  show  up  when  another  user  sets  up  the  Borrower’s
account. 

As an example, there are two users in the system: ADMIN and JOHN.

 ADMIN created Better Lenders
 JOHN created ABC Lenders Inc.

If  user  JOHN  is  setting  up  the  Borrower’s  EFT  account,  only  ABC  Lenders  will  appear  as  a  choice  in  the  “The
payments will be credited to the Creditor account:” menu.
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In  order  for  user  JOHN  to  be  able  to  credit  the  Better  Lenders’  account,  JOHN  should  go  to  File  >  Creditor  >
Creditor File and change the ownership to JOHN. A much faster way is to uncheck these options, allowing JOHN to
see all Records and Borrowers/Employers/Creditors (Tools > Users).

Vopay Extra information required:

Before submitting the EFT to VoPay, it is critical to that the Borrower contain an address, a city, a province, a postal code
and a country that respects the following formats, otherwise the transaction will be refused. Make sure to change the
country to CA (or other exceptionally) and the province to the two-letter standard abbreviation:

 Province Must be a valid two-letter Provincial or Territorial code:
o AB, BC, MB, NB, NL, NT, NS, NU, ON, PE, QC, SK, YT

 Country Must be a valid two-letter Country code - CA for Canada (ISO 3166-1 alpha-2 standard)
 Postal Code Must be in the standard A9A 9A9 format (including the space)

Please note the following characters that are allowed or not:

Character Description Address      City

a-z, A-Z Lowercase and uppercase letters                        Yes Yes
0-9 Integers                        Yes Yes
! Exclamation        No No
$ Dollar Sign        No No
, Comma        Yes No

# Number sign (hash)        No No
: Colon        Yes Yes
_ Underscore        Yes No
' Single quote        Yes Yes
( Left parenthesis                        Yes No

) Right parenthesis        Yes No
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/ Slash        Yes No
| Vertical bar        No No
- Minus        Yes Yes
+ Plus        No No
. Period        Yes Yes

? Question        No No
        Space               Yes       Yes

IMPORTANT : Accents are not allowed.

When  the  EFT  payments  are  submitted  via  MLM  (Tools  >  EFT)  if  information  is  missing  or  in  an  incorrect  format,  the
problem field(s) will be highlighted in red and when the user hovers over the cell highlighted in red with the mouse, he
will obtain, in bubble help, useful information to correct the problem. A validation is carried out in MLM, before sending,
in order to eliminate most of the characters not accepted by VoPay, but it  is the user's duty to validate the exceptions
since these validations are not infallible.

See also: Importing Bank Account Data and Activating EFT in Bulk

Automatic Debit Autorisation from the Borrower

The Creditor must obtain the autorisation from the Borrower for automatic debits from a bank account. The autorisation
procedure is worked out with the EFT Processor. Please contact the EFT Processor to obtain the proper forms to be filled
out by the Borrower.

If a signed paper form is required, it is recommended to scan the signed form and attach it in the Record: Data > General

> .

(5) Record Setup for EFT

Finally,  each Record that  will  include EFT must  be  set  up  to  allow EFT.  This  step can  also  be  done  in  bulk  with  Global
changes and is infinitely faster than the method below.

Two options are available for submitting the EFT payments:

1. Default option: Submit payments on a regular basis. 

For instance, submit payments once a month (or once a week, daily or as needed, based on the scheduled payments)
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for a number of loans or for your entire portfolio.

This  option  should  be  used  if  the  future  payments  are  not  known  or  change  regularly,  or  if  the  Borrower’s  bank
account balance is often insufficient to honor the future scheduled payments.

2. Submit, for one or many loans, ALL (or most of) the scheduled payments for the duration of the loan.

For  example,  you  have  a  36  month  loan  with  regular  payments.  Upon  obtaining  the  authorization  from  the
Borrower,  you  could  submit  all  36  payments  for  EFT.  Once  this  is  done,  you  would  no  longer  have  to  submit  this
Borrower’s scheduled payments for this loan.

This option should be used when you know the Borrower can easily meet his/her scheduled payments and these will
not change over time.

This  option  can  be  used  whether  the  scheduled  payments  are  regular  or  irregular  (irregular  amounts,  irregular
payment dates, etc.).

To set up the EFT payments, open up the desired Record, go to "Data" followed by the "EFT" tab.

The EFT Processor will be indicated.

Check “Activate Electronic Funds Transfer for this Record”. 

 If one of the steps above has not been completed, you will not be allowed to activate the module. See the error
message and complete the missing step(s).

The “Show ALL DUE payment lines (entire loan) for EFT” (NOT RECOMMENDED) should only  be checked if  you wish to
submit all or most of the upcoming scheduled payments. Even when you check this option, you will have the choice to
include only some of the upcoming scheduled payments. With this option, in the EFT processing tool, all Due Payments
will be displayed even if they are outside of the dates entered. This allows you to submit, if  desired, Due Payments for
certain Records. This generally is only chosen for borrowers who usually do not miss their payments (good payers).
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Choose the Creditor whose account will be credited. A Creditor must be chosen in the Creditor tab and the Creditor must
be EFT enabled (step (3) above).

Choose the  Borrower’s  account  from which to  debit  the  payments.  There  may  be  one  or  many  choices  depending  on
what data was entered in the Borrower’s "Account" tab (step (4)). 

Save the Record.

This setup should be done for every Record that is to be included in EFT.

Two fields can be displayed in the Main window in order to quickly view if the data for pre-authorized payments have
been entered for the Records, without having to open them one by one.

o EFT Active: If "Yes" in entered, then the "Activate pre-authorized payments for this Record" option has been
checked.

o EFT Account Number (Perceptech): When data is included in this field, it means that for the Record, a bank
account  was  selected  under  the  EFT  tab.  Therefore,  the  Record  contains  all  the  required  data  for
pre-authorized payments. This field can also be useful for reporting.

Once  this  is  done,  you  will  then  select  the  Payments  you  wish  to  submit  as  EFT  as  indicated  in  the  "Selecting  and
Submitting Payments" section.

See also: Importing Bank Account Data and Activating EFT in Bulk

Summary of steps 

Here is a summary of the steps required for submitting the EFT payments No need to panic... the steps are easy to follow!

1) EFT Service provider

You must open an account with Perceptech or VoPay in order to submit your transactions.
 
2) Settings

Activate the module Electronic Fund Transfer (EFT):

Tools > Settings > Electronic Funds Transfer
 
3) Creditor

Enter the information provided by the EFT service provider:

File > Creditor > EFT tab
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4) Borrower

Enter the account information used for each Borrower

File > Borrower > Accounts tab.

EFT tab: The Perceptech EFT reference number for each Record must be created or entered

Use Global Changes (for Borrowers) to enter bank account data more quickly.

5) Record

Activate preauthorized payments for the Record.

File > Data > EFT tab

Note: Only “Active” Records can be submitted via ETF.

Use Global Changes (for Records) to activate EFT for each Record more quickly.

 6) Submitting transactions

Selecting the payments to submit and submitting these:

Tools > EFT

See the next section "Selecting and Submitting Payments" for Step 6.

   

Selecting and Submitting Payments 

Once the system and the specific Records are set up for electronic funds transfer, the payments must then be submitted
to the EFT Processor. Two models exist:

1. Default option: Submit payments on a regular basis. 

2. Submit, for one or many loans, ALL (or most of) the scheduled payments for the duration of the loan.

For  more  information  on  these  choices,  consult  the  previous  section,  Setting  up  the  EFT  module,  and  the  (5)  Set  up
Record for EFT sub-section.

In order to choose the upcoming payments for EFT, go to Tools > EFT .

The following window will appear allowing you to choose the payments that are to be submitted to the EFT Processor.
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IMPORTANT: Only ACTIVE Records that have been “EFT-enabled” will be included in this tool (see the previous section,
(5) Setup Record for EFT). In order to submit EFT, a user must have the right to see ALL Records and ALL Borrowers/
Employers/Creditors. He will not be able to submit EFT otherwise. See Administrator and Users.

Enter the first date (“Report from”) at which an EFT payment is to be debited and the final date (“to (inclusively)”) for this
EFT batch period. 

Payment  lead times will  depend  on  the  EFT  Provider.  Please  click,  on  the  MLM  link  names  "Important:  Payment  Lead
time" for  more information cut-off  time or  times.  It  is  also  critical  to  make  sure  all  Borrower  data  is  present  (VoPay  -
"Important: Required Information").

Once the period dates are selected, press on Refresh or F5. A list of all Active and EFT-enabled Records will be displayed
and can then be submitted for EFT. Check, in the first column, the payment lines that are to be submitted for EFT.
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Any payment with Line status “Due Pmt” prior to the “from” date (that is EFT enabled), will appear as a pink line (see the
first line in the example below). This means that an expected payment was not properly processed by the MLM users (its
Line  status  should  have  been  changed  to  Paid,  Unpaid  or  other,  as  opposed  to  remaining  “Due  Pmt”).  It  is  strongly
recommended to resolve any of these issues before submitting payments for EFT.

If  such  issues  are  not  resolved  before  the  actual  payments  are  debited  at  the  set  date,  MLM  will  NOT  automatically
change the Line status to Paid, since a Due Pmt cannot precede a Paid Pmt.

In such circumstances the Main MLM window will display a warning icon that signifies that there is an error. Click
on the warning icon and a message will identify the problem Record and describe the problem. The issue really must be
fixed by the user.

On the other hand, MLM will not prevent the user from processing the data in a Record containing irregularities, because
there are exceptions, as in the following scenario:

 It is possible to submit an EFT when previous lines are pink. For example, if a Borrower changes his payment method:
he always had paid by check but now wants to pay with EFT but only in two months. A MLM user can decide, for a
reliable client, to send the payments to be collected to the EFT provider in advance. Therefore, when the checks are
cashed, the user will  update the payments in the Payment schedule (from "Due Pmt" to "Paid Pmt"). Thus, on the
date of the pre-authorized debit, payments will be automatically updated in the Record since this transaction will no
longer be preceded by a "Due Pmt" Line status.

 If the option "Exclude the EFT payment if balance is less than 0.00 before payment or if payment has a balance less
of  X.XX"  is  selected,  the  system  will  not  allow  the  user  to  submit  EFT  payments  because  of  an  insufficient  final
balance. The lines will be highlighted in orange and will be blocked.

 For example, if the loan final balance (last line of the Payment schedule) is projected to be equal to or less than 0.00
(negative) and EFT payment is planned on this date, the system will block the payment from being submitted. If the
final balance is close to 0.00 (1057.00 for example) and the next EFT payment is 1139.00, the system would block the
payment because this would give a negative final balance of -82.00. 
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 However, if the balance was 1138.00 and the payment 1139.00, for a balance of minus 1.00, this could be authorized
if the maximum negative amount of 1.00 was added in the option field.

Submitting EFT payments for the entire loan, for some payments or only for the selected period

When selecting which payments  to  submit,  three options  are  available  1)  selecting  all  scheduled  payments  for  one  or
multiple  loans,  2)  selecting  a  number  of  scheduled  payments  anywhere  in  the  loan  or  loans,  and  3)  selecting  only
payments included in the desired period.

Which scheduled payments are to be displayed in the EFT transmission window will depend on the Record setup as are
explained in the (5) Setup Record for EFT) sub-section. 

If  “Show  ALL  DUE  payment  lines  (entire  loan)  for  EFT”  in  the  Record’s  Data  window  (EFT  tab)  is  checked,  ALL  of  this
Record’s future Due Pmt lines will be included even if not within the date range. 

In the example below with the dates from 10-07-2013 to 10-07-2013 (so only  one day),  ALL upcoming transactions for
Record No. 10002 are shown even if not within the range. You will then be able to submit all or some transactions. If you
know  the  client  to  be  trustable  and  the  future  payments  are  set,  then  use  this  option  for  all  or  many  scheduled
payments. In this situation it was decided to submit all 2013 payments. The 2014 payments can be submitted at the end
of  December.  One could  have decided to  submit  all  future  payments.  The  EFT  Processor  may  have  a  limit  in  terms  of
years for future payments. Please check with the EFT processor.
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If on the other hand, this client often has insufficient funds or if future payments are not always known or predictable,
then do  not  check the  “Submit  ALL  Due payment  lines  (entire  loan)  for  EFT”  option.  Rather,  submit  payments  for  this
Record on a regular basis.

For selecting multiple lines, instead of checking each individually, select the lines with the mouse (or use Shift or Ctrl and
the mouse for non-contiguous lines) and check one of the “Submit” boxes. All the highlighted lines will be checked.

The  “Select  All”  button  can  also  be  used  to  select  all  lines  from  this  table.  Always  check  each
payment carefully before using this.

A Comment may also be added for any payment line. Comments will be added in the Payment schedule even if the line

itself is not checked. The following message will appear after clicking on "Submit" .
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Debit date (money from Borrower account) versus Credit date (money to Creditor account)

The EFT Processor will usually debit the Borrower's bank account on the date the payment is due. If the payment is
set for a weekend or on a statutory holiday, the debit will be taken on the next working day.

However, the credit to the Creditor's account will only be made a few days after the debit date. The number of days
may be worked out  with  the  EFT Processor but  the  delay  is  usually  two to  six  days  plus  factoring in  non-working
days.

When  payments  are  due  at  the  end  of  the  month,  the  Creditor's  account  may  be  credited  only  in  the  following
month.  This  can  cause  bank  reconciliation  issues.  For  example,  you  were  expecting  a  total  amount  of  55,500  in
September but only 55,000 (500 missing) is deposited in September. There may have been amounts due in August
but  deposited  to  the  bank  account  only  in  early  September  as  well  as  amounts  due  in  September  but  actually
deposited in early October.

In order to reduce bank reconciliation issues with EFT, you could use the "True Pmt Date (Grace / EFT)" column. In
the Accounting Entries report ONLY, the date indicated in this column is reported as opposed to the "Pmt Date".
For end-of-month transactions, payments that are to be debited on the 29th, 30th and 31st (and possibly
the 26th, 27th and 28th for February and 30 day months) could have True Pmt Dates on the 1st, 2nd, 3rd
or 4th of the next month, the dates at which the payments are truly credited to the Creditor's account.

A utility allows to automatically indicate a date in the "True Pmt Date (Grace / EFT)" column that is x days after
the  date  indicated  in  the  "Pmt  Date"  column.  So  in  the  example  above,  the  bank  shows  55,000  as  the  amount
credited to  the  Creditor's  account  in  September yet  55,500 was paid  by  the  Borrowers.  By  adding  3  days  to  each
"Pmt Date", the equation will yield the proper September deposits:

55,500   +   2,000   -   2,500   =   55,000
Expected       Extra       Missing       Actual  

To add a date in the "True Pmt Date (Grace / EFT)" column that is x days after the date indicated in the "Pmt Date"
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column, click on . The following window will appear allowing you to indicate the number
of days to add.

For payments that are scheduled on a Saturday or on a Sunday, the debit from the Borrower's account will only be
done on the next work day, thus adding an additional day or two to the credit date.

To handle this situation, you may check "Add to the final date 2 days for a Saturday payment, 1 day for...". This will
add two (2) days to the number of days entered above if the payment was to fall on a Saturday or one (1) day if the
payment was to fall on a Sunday.

This feature can be checked even if the number of days to add is 0.
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Submit EFT file to EFT Processor

Once the proper payments have been selected, press on “Submit” . If all is set up properly (user,
password,  Internet  connection,  with  an  Automatic,  not  Manual  file  transmission  etc.)  you  will  obtain  the  following
messages:

MLM will log into the Processor's Web Portal using SSL technology (Secure Socket Layer) (with user name, password and
other)  and  upload  an  encrypted  file  containing  the  transactions  that  are  to  be  submitted.  The  file  format  will  vary
according to each Processor. Below is an example of a file that includes three EFT transactions.

All  files  submitted  will  be  saved  in  the  EFT  Processor  sub-folder  located  in  the  MLM  install  folder.  These  could  be
consulted any time since they are text files. The files are only encrypted when sent with SSL.

If the file is accepted by the EFT Provider, submitted payments will keep the Line status "Due Pmt" but will be highlighted
in pink/red. In the following example, line 101 was submitted as EFT and cannot be easily modified because the amount
will be drawn on the due date. Lines 101 and 102 have not been submitted as EFT but can be submitted later. 

If a component is missing, the file will not be sent and an error message will appear with an error code and description
which will guide you as to the configuration issue which should be fixed.
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Then press on Continue. The following message will appear:
 

If you had submitted Line Comments, these will NOT be updated.

The  file  (TXT  format)  will  be  nevertheless  be  created  and  saved  in  the  "Canceled"  subfolder  (found  in  the  "Provider
Name" subfolder in the MLM data folder).

VoPay EFT Debit Pre-validation

Once  payments  have  been  submitted  to  VoPay,  a  data  pre-validation  is  performed  by  VoPay  in  order  to  validate  the
following information:

1. The currency passed is CAD;
2. The transaction amount does not exceed the allowed limits per transaction, daily, weekly, or monthly;
3. Name, address, banking information, and the amount are provided;
4. Country and province are provided with the proper ISO alpha 2 characters;
5. The provided financial institution number details are valid;
6. The branch transit number is a valid one;
7. If the account is blacklisted, meaning it has been identified as invalid, closed, or problematic in previous transactions;
8. In the case of EFT Withdraw, VoPay also checks if the amount is greater than the available balance.

This process, while being fast, may take longer when thousands of debits are submitted.

Two pre-validation methods are provided:

1) Manual validation
2) Background validation

In order to start the pre-validation process, once the file has been sent to VoPay (as explained above), in the EFT
Transmission window (Tools > EFT), click on "Check Submission progress".



Page 255

© Jurismedia Inc., 2007- 2023

This window will appear offering you the validation methods and more information in the ?:

Manual validation should be used during the initial  EFT module testing phase. This allows you to launch the validation
and view the results obtained from VoPay every two minutes.

Caution: this method blocks the Records during the results analysis phase. You cannot work on anything else while this is
taking place.

Background validation  should  be  used  following  the  initial  tests  and  with  the  ongoing  process.  Background  validation
works as a parallel task and thus, once the validation has started,  the window will  be minimized and you can work on
something else at the same time.

Once all transactions are validated, the window will reappear and you will be able to consult the canceled transactions if
there are any.

To  see  the  transaction  submission  evolution  the  "Initial  transaction  validation"  window  (above)  shows  the  number  of
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transactions in "Waiting". Once past this stage, two statuses are returned by VoPay: Either the transaction is "Failed" or
the  transaction  is  "Created".  If  the  transaction  is  Created,  then  all  is  fine  and  the  normal  process  continues  by  which
amounts should be debited from the Borrower's account. You will only know if the transaction is rejected with the EFT
rejection report. See the next sections: EFT Payment Update (Rejected payments) and EFT Payment Rejection Date and
Reason.

On the other hand, if the transaction status in pre-approval is "Failed" then it will be necessary to consult the "Canceled"
tab of the "Initial transaction validation" window. Details of canceled transactions will appear in the table, including the
error  message  provided  by  VoPay  indicating  why  the  transaction  could  not  be  pre-approved.  To  find  a  canceled
transaction, simply retrieve the Record ID as well as the "Unique line ID".

It is suggested to delete the transactions from the "Canceled" tab once they are corrected. Canceled transactions will be
available again, thus not processed and once the problem is corrected, they must/can be resubmitted.

If the pre-approval process/window is not performed during the EFT submission process or as a background task, MLM
will query VoPay for the pre-approval transaction status the next time MLM is launched. Failed transactions will be listed
in the flashing red exclamation mark in the Main window. This MUST be managed by the user.

To avoid the processing being done when MLM is launched (usually in the morning) and thus save time, it is possible to
perform this processing via an Overnight task. When creating the Windows task, the "VOPAY" argument must be added
in order to trigger this processing. See the Automatic / Overnight Tasks.

Particular cases

This section will look at particular scenarios that can be handled in MLM and with the EFT Processor.

In some odd situations you may wish to submit payments for EFT and others by a different payment method.

In  the  example  below,  only  the  lines  in  red  (42,  43  and  48  to  51)  have  been  submitted  as  EFT.  Lines  44  to  47  were
excluded since the client wanted to pay differently on this date…
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The option to exclude certain Line statuses from EFT debit could have been chosen in the EFT configuration. You could
have had a Line status named "Due Pmt - Check" and excludes this from EFT debits (see Setting up the EFT module > (2)
Basic system setup).

Important note:

If  by error (or not) two distinct payments are submitted for debit on the same day, whether these are sent to the EFT
Processor on the same day or not, the second transaction submitted will NOT erase the transaction that was sent first.
Two debits will be done on the same day. To cancel a transaction that was already submitted, you MUST go through the
EFT Portal.

   

EFT Payment Update (Rejected payments)

After  submitting  the  file  to  the  EFT  Processor,  all  transactions  submitted  will  be  debited  on  the  set  days  (taking  into
account weekends and holidays where the debits are done on the following work day).

Payments are a success

On the day the payment is due, Margill Loan Manager (MLM) will automatically change the Line status from “Due Pmt” to
“Paid  Pmt”  (or  other  Line  status  chosen  in  the  EFT  Setup).  In  order  to  easily  recognize  payments  made  by  EFT,  it  is
recommended to name one of the "Paid Pmt" Line statuses "Paid EFT". You may need to enter this name through Tools >

Settings > System Settings (Administrator) > .
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EFT Setup

The change of Line status from "Due Pmt" to "Paid Pmt" (or preferably "Paid EFT") is performed automatically at the set
date when MLM is  launched.  If  MLM had not  been opened for  a  few days  (or  after  a  weekend for  example),  the  Line
status  changes  will  nevertheless  take  place  for  older  payment  dates  and  not  only  for  the  payments  that  should  be
debited on the current date.

It is recommended to use the Automatic / Overnight Tasks so that the operation is performed even when MLM is closed.
This will save time and avoid potential errors if, although highly not recommended, MLM is not closed or shut down on a
daily basis.

Payments are rejected

The  user  doesn't  have  anything  to  do  in  MLM  for  the  accepted  payments  since  on  the  day  the  payment  is  due,  the
software will automatically change the "Due Pmt" to "Paid Pmt". The software assumes the payment is accepted.

Partial  automation  of  rejected  payments  is  available  for  payments  processed  by  Perceptech.  Accessible  with  the
"Rejected  Transactions  Report"  button  (from  the  menu  EFT),  this  module  downloads  the  rejected  payments  file  from
Perceptech. This way,  with one click of  the mouse,  all  payments  are  updated in  each Record.  The Line  status  of  these
payments  change  from  "Paid  Pmt"  to  "Unpaid  Pmt"  (or  other  defined  unpaid  payment  type)  and  Column  fees  added
automatically if set as a rule.  If you wish, emails can be sent to the Borrowers automatically.

In the "Download report" module, select the Creditor from the list as well as the period for which you wish to obtain the
rejected transactions.
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After  the  information  have  been  entered,  in  order  to  generate  the  list  of  rejections,  click  on  "Download  report".  All
rejected transactions from the selected range will be displayed.

Upon clicking on the "Submit" button, all the transactions from the list will be updated in each of the Records. The Line
statuses will be modified from "Paid Pmt" to "Unpaid Pmt" (or as set in the EFT module Setup). If there are programmed
Column Fees in case of non-payment, they will be added automatically to the Payment table.
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MLM will confirm the number of updated transactions.

By selecting "Include the Rejection Description and the Rejection Date in  the  Payment  schedule",  in  Tools  >  Settings  >
under  Modules  >  Electronic  Funds  Transfer,  the  rejection  Description  (reason  from  Perceptech)  will  be  added  in  the
"Comment"  column  of  the  Payment  schedule  (if  a  comment  is  already  in  this  column,  it  will  not  be  erased  and  the
description will be added at the end as long as the field space is sufficient). Also, the rejection date will be added to the
"Date of Return check/EFT" column even if a date is already entered (will be overwritten). You can also produce a report
with rejection date and reasons (Transaction report). See also EFT Payment Update (Rejected payments).

By default, when opening the module again, MLM will save the number of days in the range of dates and will modify the
dates. For example, the next range listed, according to the image below, would be 2017-07-10 to 2017-07-11 inclusively
since the preceding report was for 2 days.

In case of uncertainty, the "Recent Files" window allows you to see the files that were generated previously. Date ranges
are written in the file name. If there are no rejections between the dates, no file will be created.

There is no need to worry about posting twice: if dates are requested more than once, transactions already processed,
from the list, will be highlighted in red and the user will be able to see, via the "Line status", that the changes had been
made in the Records. 
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Mixing EFT payments and non EFT payments

If for some reason (most commonly, progressive EFT implementation), non-EFT Due payments were to precede EFT Due
payments,  if  the previous non-EFT Due payment Line status was not  changed on the day the  EFT payment  was due,  a

System Warning would  advise the  Record Owner (and Administrators  and  Power  users)  that  the  Due  Pmt  Line
status will NOT be changed automatically to Paid as it should normally be.

In the example below, the red lines had already been submitted for EFT debit. The Due Pmt on lines 43 to 46 MUST be
changed progressively (to Paid,  Unpaid or  other)  in  order for  the line 47 Due Pmt to be  changed automatically  on  the
payment date (11-16-2013 in the example).

This  exception to  an  automatic  change  of  Line  status  stems from the  fact  that  Due  payments  cannot  precede  Paid  or
Unpaid payments.

The warning would only be given on the actual day the EFT payment was due and would remain active until deleted. The
warning will appear even if MLM is not launched on that specific day, but launched later on.

   

EFT Payment Rejection Date and Reason

For managing payments returned (NSF) via Perceptech or VoPay, it is possible to include the description and the date of
rejection in  the "Comment" and the "Date of  returned Check/EFT" columns respectively, in  the  Payment  schedule and
then get a report with all the rejected transactions at a specified date or for a period of time.

To  activate  this  option,  go  to  >  Settings  >  System  settings  (Administrator)  >  Electronic  Funds  Transfer  and  check  the
"Include the Rejection Description and Rejection Date in the Payment schedule" option.

Then, via Tools > EFT, when you click on "Rejected Transactions report", choose the dates and "Download report (F5)".
The following window will open including the rejection dates and reasons for which the transactions were rejected.
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After  clicking  on  the  "Apply"  button,  lines  will  become  pink,  transactions  updates  will  be  confirmed  and  these  four
operations could happen:

1. payments will be updated to "Unpaid Pmt" (or other unpaid type based on your choice in Settings) in the Payment
schedule 

2. automatic fees will be added (if this option is activated)  
3. emails will be sent to the Borrowers in default of payment (if option is activated) 
4. the data in the "Rejection Date" and "Rejection Description" columns will be added in the "Comment" and "Date of

returned Check/EFT" columns of the Payment schedule (if option is activated).  

NOTES:

 The  rejected  transaction  reason  or  description  will  be  added  to  the  "Comment"  column  without  replacing
existing date, case being.

 PLEASE NOTE: The "Rejection Date", however, will replace, case being, a date that would have been entered in
the "Date of returned Check/EFT" column (usually, this column should be empty as it is reserved for a date of a
returned check, a situation that is not relevant for EFT).

You can then run the rejection report for this date in the Transaction Report. You will be able to see all the rejection
dates by choosing the "Date of Returned Check/EFT" option.
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Please note that  if  the "Date of  Returned Check/EFT" column does not  appear in  the Payment schedule,  go to Tools >
Settings > System settings (Administrators) tab > Modules section >  Returned Checks > and check "Activate module".

   

Changing or Deleting Submitted EFT Payments

Payments that have already been sent to the EFT Processor for debit, whether paid or not, have special restrictions that
other payments do not. This section covers these.

Changing payment amount and/or payment date

The payment amount and payment date for EFT payment lines cannot be changed in the Payment schedule.
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If the transaction is no longer required, it should be deleted (see below). If the payment is not made (insufficient funds
for example), then its Line status should be changed to Unpaid or preferably Unpaid EFT.

Deleting a payment

If upcoming EFT payments had already been submitted for debit in a loan, and for example, this loan is suddenly paid in
full  or  in  default  or  in  bankruptcy,  the  upcoming  EFT  payments  should  be  deleted  in  MLM  AND  also  with  the  EFT
Processor. Deleting the payments in MLM will have no effect on the payments already submitted to the EFT Processor,
thus the need to cancel the payment or payments with the EFT Processor (by going through the Processor's Portal).

Before deleting you should print the details and then make the changes with the EFT Processor. A list of the submitted
payments will be created.

If the payment had already been paid or is unpaid (Line status "Unpaid Pmt"), although there is no real reason to delete
it, a confirmation will be required to delete the payment or payments.

Eliminating the EFT (preauthorized payment (PAP) status) for upcoming payments

Another possible scenario, is one in which the Borrower changes bank or payment method. In these situations we do not
wish to delete the upcoming payments yet simply wish to delete the EFT status of these payments. Select the red lines,
right click with the mouse, and choose "Delete PAP status for these payments"
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The following window will allow you to print the payments and dates. The canceled EFT payments in MLM MUST then be
canceled with the EFT Processor.

See the next section, Replacing Bank accounts, in order to change the bank account that is to be used for EFT.

Changing Line status

If you try changing the Line status of any EFT payment (whether paid or upcoming), the following message will  appear
limiting the Line statuses that may be chosen since EFT payments only have two options: Paid or Unpaid (multiple types
of paid and unpaid Line statuses are available in MLM). These payments cannot be partial, nor late. A late EFT payment is
in fact Unpaid.

Deleting EFT Records

The same principle applies to deleting Records from MLM as that for lines deleted or payments that should no longer be
debited  from  the  Borrower's  account.  A  change  in  MLM  MUST  ABSOLUTELY  be  accompanied  with  the  appropriate
cancellation of the upcoming payments with the EFT Processor.

The following window will appear for all Records to be deleted that contain PAPs. The question will be repeated for each
Record although one report will sum up all the transactions that are influenced by this deletion (upcoming PAPs).
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Replacing Bank accounts

In  a  Record,  it  frequently  happens  that  a  Borrower  changes  bank  account  or  the  payer  (the  Borrower)  is  replaced  by
another. In addition, the Creditor or its deposit account may change. In these situations, an update is required in order to
receive future payments from the right source and, when the changes involve the Creditor, to deposit the funds in the
correct account. For payments already submitted as a PAP or payments that are submitted with incorrect information, if
the changes are not made, the payments will be rejected.

The role of Margill Loan Manager (MLM) is to submit current and future transactions with bank accounts valid at the
time of  submission  only.  If  they  change,  MLM  cannot  be  used  to  address  this.  It  is  your  responsibility  to  make  the
changes with your EFT service Provider. 

Situation 1 - Payments already submitted as EFT

When payments are already submitted in the Service provider's system, you must make the changes to the bank account,
Borrower  and  even  the  Creditor  in  the  provider's  portal.  You  will  also  need  to  make  the  changes  as  described  in  the
section below, "Situation 2 - Payments to submit as EFT".

All  historical data already submitted must be changed with the Provider; otherwise the payments will  be debited from
their accounts with the probability that the transactions (and the associated costs) will be rejected. The Creditor must be
very vigilant in this regard.

Always consider the accounts (bank data accounts) at the EFT Provider as the master accounts. Changing an account in
MLM is not sufficient. Changes MUST be made in both places.

Situation 2 - Payments to submit as EFT

A less critical situation arises when a change takes place and no transactions using the old data are yet submitted to the
Provider.

1) Change of bank account

A change in MLM will ensure that the new account data will be submitted to the Provider's Portal at the next submission
without requiring change with the Provider. In MLM, the change must be made in the following sections:

 Borrower
o "Accounts" tab
o "EFT" tab if  a new account is added. If  an account is  replaced, the same identifier may be maintained for

Perceptech (not required for VoPay)
 and possibly in the Loan ("Data" window > "EFT" tab > "Borrower (Account)") if  a new account is added instead of

replacing the old one 
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Multiple account changes may be made in the Global Changes module (for Borrower). To change or add banking information,
simply enter them one by one in the appropriate fields in the table and save them.

To modify or add banking information, simply enter them one by one in the table fields and save.

The changes made will be effective simultaneously in the Borrower "Account" and "EFT" tabs, as well as in the "EFT" tab of the Record
(Loan).

See  the  Importing  Bank  Account  Data  and  Activating  EFT  in  Bulk  section  for  complete  details  and  procedures,  including  mass
import/update via Excel sheet.

2) Change Borrower

Sometimes a loan will ultimately be paid by someone other than the Borrower (co-signer or guarantor, for example). In
these  situations,  the  change  must  be  made  in  the  Loan  ("Data"  window  >  "EFT"  tab  >  "Borrower  (Account)")  and  of
course the new EFT banking data must be entered in Borrower > "Accounts" tab and "EFT" tab. 

3) Change of Creditor (or Creditor account)

If the Creditor or its account changes, the change must be made with the EFT provider first. These changes must be made
in one or two places in MLM, depending on the situation:

 Creditor ("EFT" tab)
 Loan ("Data" window > "EFT" tab > "Creditor (the payment will be applied to the Creditor's account)") 

CRITICAL: The Provider's accounts must be used as master accounts and MLM must be adjusted to reflect any changes
made with the Provider. A deleted account with the Provider will always remain in MLM and vice versa unless the change
is done manually in the other system.

If in doubt, always go to the Provider's Portal to see what bank account is used for the payment.

   

Master and Affiliate Loans - EFT

This advanced module would only be used in very special situations. For example, there are two loans for one Borrower
because financing comes from two different funding sources. Since the interest rates are different in these two loans, the
 Participation Loan option cannot be used. 

In addition to having the two loans in Margill (which allows the loans to be accounted for separately), the user wishes to
include in the system, another loan with a weighted interest rate which, for the Borrower, appears as a single loan, the
total loan amount and payments being combined.

Example:

Loan Fund A: 25 000.00  / rate 10.00%              / payment of  806.68 per month  / 36 months
Loan Fund B: 75 000.00  / rate   6.00%              / payment of  2281.65 per month / 36 months
Total loan:  100 000.00 / weighted rate 7.014%  / payment of  3088.33 per month  / 36 months

The module "associates" (links) these loans and then updates the payments for the loans that are NOT submitted as EFT
(Pre-authorized payments (PAP))("Affiliate" loans) based on the transaction activity of the loan that was submitted as a
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PAP ("Master" loan). So when the Master loan PAP payment is automatically updated from one of  the "Due Pmt" Line
status  to  a  "Paid  Pmt"  status,  the  "Due  Pmt"  for  the  Affiliate  Records  will  also  be  updated  to  one  of  the  "Paid  Pmt"
statuses. This eliminates the need to manually update or use the Post payment tool to update the Affiliate loans.

Also, when the payments are rejected by the financial institution and the "Rejected Transaction Report" module is used
in  order  to  update  the  payments  to  one  of  the  "Unpaid  Pmt"  Line  statuses,  when  the  Master  Record  is  changed  to
Unpaid, the Affiliate Records will follow.

Only an Administrator can activate this module in order to use the different Affiliate functions. A Master Record can have
up to five (5) Affiliate Records. 

You can activate the module in Tools > Settings > System Settings (Administrators) tab > "Module" section > "Master and
Affiliate Records".

Essential conditions:

The Electronic Funds Transfer module must be activated (Tools > Settings).

The  total  Affiliate  Records  payment  amounts  must  be  exactly  the  same  as  the  Master  Record  payment  amounts,
otherwise the Affiliate Records will not be updated for that date. Even a 0.01 difference will not be accepted.

For example:

Payment  date  must  be  exactly  the  same  between  Master  and  Affiliates  for  the  transaction  in  question.  No  further
verification  is  performed  (so  even  if  the  original  Principal,  Borrowers,  total  future  payments,  etc.  are  not  the  same
between Master and total Affiliates, the changes will take place). This offers great flexibility but there is a higher risk of
error.

Once the module is activated, here is the procedure to designate a Master Record and its Affiliate Records.

Create the Affiliate Records based on the same first payment date, the same payment frequency and the same number of
payments:
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Then, create the Master Record based on the first payment date, the same payment frequency and the same number of
payments.  Do not  enter  the  annual  nominal  rate.  Enter  the  original  Principal  by  adding  those of  the  Affiliate  Records.
Enter the payment amount by adding the payments of the Affiliate Records:

Example: 

Original Principal amount: 56 230.25 + 125 000.00 = 181 230.25
Payments amount: 1490.87 + 2365.39 = 3856.26

After  pressing  on  "Compute"  the  Principal  and  the  "weighted"  annual  nominal  interest  rate  will  be  automatically
calculated:
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Activate the EFT Pre-authorized payments module as usual in the Master Record. See Electronic Funds Transfer section
for more detail. In the Master Record EFT tab, check "Update th following Records simultaneously":

Click  on  the  "Choose"  button.This  window  will  appear  showing  only  Records  for  the  same  Borrower  as  the  Master
Record. To have access to all system Records, check the "Show all Records" option:

Select up to 5 Affiliate Records for the Master Record. You cannot choose a Record designated as Master or a Record that
is already Affiliate to another Master Record.
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Then click on Save:

If all  the transactions in the Payment schedules correspond (amounts and dates),  the EFT tab will  show which Affiliate
Records are now associated to this Master Record.
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However,  if  some  payment  lines  do  not  correspond  between  the  Master  Record  and  the  Affiliate  Records,  a  small
validation table will appear in order to notify the user of the problems to be solved so that the Records can be correctly
updated. Often, the last lines in the Record Summary are adjusted and the last payments differ by a few pennies.

If some lines do not match, these transactions will not be updated during the automatic EFT update. The Master Record,
however, can be updated automatically, but the Affiliate Records will not.

Upon  consulting  the  Payment  schedule  in  the  Affiliate  Records,  line  60,  we  can  see  that  the  last  payments  do  not
correspond to the previous payments,  the  addition  of  the  2  payments  in  the  2  Affiliate Records do  not  equal  3856.26
(Master payment amount)(one cent difference). However, the date "2026-12-15" is the same.

In order for these transactions to be automatically updated with the automatic EFT update tool, they must be corrected
manually.
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Once  these  steps  are  completed,  when  opening  MLM  (or  with  the  Automatic  /  Overnight  Tasks),  Due  Payments
submitted to the EFT provider (or via NACHA file) and payable on the current day, will automatically be updated in the
Master Record and at the same time in the Affiliate Records if the sum of payments of the Affiliate Records correspond to
the amount submitted and if the dates are identical.

Master Record

Affiliate Record A Affiliate Record B

The Affiliate Records will also automatically be updated in the case of a rejected payment if updated with the appropriate
tool  (not  available  for  NACHA  files,  only  with  certain  EFT  providers).  To  learn  more  about  this,  see  the  EFT  Payment
Update (Rejected payments) section.

When the rejected transaction procedure is completed, a message will appear to advise the user if the Affiliate Records
were updated or not.
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When  manual  changes  are  made  in  the  Master  or  Affiliate  Records,  a  warning  message  will  appear  when  saving  the
modified Record in order to remind the user that the changes made manually in the Master or Affiliate Records will have
no impact on the other Affiliate Records. Only an automatic update of the Master Record via the EFT module will update
the Affiliate Records Line statuses. 

Note in regards to the Automatic Fees combined with the Master and Affiliate Records.

If an Automatic fee is set when pre-authorized payments are rejected for the Master Record, it  would be important to
apply the same to the Affiliate Recrods as well, but in a different proportion.

Here is an example:

Fees of 25.00 are applicable in the Master Record for rejected payments and half (12.50) are applicable on each of the
two Affiliate Records.



Page 275

© Jurismedia Inc., 2007- 2023

In some situations, although the effect may be minimal, the 50/50 expense ratio (for two loans) could affect amortization
especially if interest is charged on the fees.

For Automatic column Fee rules to apply to the right Records (Master versus Affiliate), two options are available:

1) When creating the Affiliate Loans,  use a  special  "Due Pmt" Line status (Due Pmt 2,  3,  4  or  5 renamed, for  example,
"Due Pmt - Affiliate") which will become "Paid Pmt - Affiliate" when updated, or "Unpaid Pmt - Affiliate" if not paid. The
Master Loans would use "Due Pmt" which would become "Paid Pmt EFT" and if non paid, "Unpaid Pmt EFT". Therefore,
different fees could apply to these Line statuses.
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Tools > Settings > Electronic Funds Transfer

This method offers flexibility but is more complex during creation. See Setting up the EFT module section of the Electronic
Funds Transfer. 

2) Another approach would be to use the "Fees based on" option in the Automatic fee setup. It is thus possible to apply
different Automatic fee amounts depending on the Record Type or a Custom field.

   

e-Transfers (credit to Borrower)

You can send sums to Borrowers by "e-Transfer" directly in Margill Loan Manager (MLM) via VoPay. The e-Transfers allow
money to be sent almost in real-time and for amounts of up to CAD 25,000 per transaction.

To  activate  the  option,  go  to  Tools  >  Settings  >  Electronic  Funds  Transfer  (Modules  section)  and  check  "Activate  the
e-Transfer payout transaction" under the VoPay International Inc. 
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Once the module is activated, the Margill administrator (with proper user management rights) must activate the right to
produce e-Transfers for the users of his choice via the "Users" window. This right should be used with extreme caution
since amounts of up to CAD 25,000 can be sent.
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Users with the right to produce e-Transfers will find the icon in all Records to which they have access. The e-Transfer icon
only appears in the Payment schedule window.

By clicking on the e-Transfer icon, the authorized user will be able to send sums if one of the Creditors registered in the
Record contains the login information for the VoPay account:
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In the window below, choose the recipient. The Borrower and the Co-Borrowers will appear in the drop-down menu so
funds can be sent to one or the other.

Transfers can be sent to an email address or to a mobile (cell) number.
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The language of correspondence can be English or French but the question and answer below can be in any language, but
special characters are not recommended.

It is absolutely necessary to provide a question and an answer. The response is case sensitive and should not include a
comma or ampersand. An optional message can be sent to the recipient. These three options can be "Set by default" to
avoid having to re-enter them each time and to ensure a standard.

The transfer amount entered by default is the amount of the original Principal of the loan. This can be changed.

In order to submit a transfer, the user's password must be entered, so the "Submit" button will be grayed out until the
password is entered.

Transfers  are  done  in  near  real-time 24/7.  An  email  or  SMS  (text  message to  mobile)  will  be  sent  to  the  Borrower  to
accept the transfer.

Upon submission, this confirmation message will appear:

If the user presses "Yes", then this confirmation will appear, if the submission was successful, otherwise an error message
provided by VoPay will be displayed.

To see the e-Transfer status, click the "Transfer statuses" tab.  Each time the user presses the "Refresh"  button,
MLM queries VoPay on the progress of the transfer request.

When the user is in a Record, the "Transfer Statuses" tab will only show transactions made in that Record.

To obtain the status for all e-Transfers sent, click on the "e-Transfer" icon in the Main window. Be careful, once hidden
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(Hide column), the transactions will no longer be visible and cannot be "unhidden". 

The "e-Transfer" icon will be visible only to users with the right to send e-Transfers.

In case of issues with e-Transfers go to the VoPay portal for more detail on these and their status.

   

Europe - SEPA File

Coming soon (eventually)...

   

Importing Bank Account Data and Activating EFT in Bulk

It is possible to add the Borrower's bank data in bulk, manually, or to import via an Excel sheet. This avoids the need to
open each Borrower's file, one by one. This can be done for both US and Canadian banking data.

It is also possible to activate the EFT for various Records simultaneously, thanks to the powerful Global changes tool.

Only users that have been authorized by the Administrator can access the Global changes tool. 

Add bank accounts in bulk

To make global changes for the Borrowers, select "Borrower" under "File".
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From the drop-down menu, select the Borrowers for which a global change is required. Then right-click on the mouse and
choose "Global changes".

The window below will open. Click the "Banking Data" tab.

Banking Data tab

The second tab, "Banking Data", allows you to add or change banking data for the Borrowers for the EFT payments.

A Borrower can  only  have a  bank  account  in  one country  (United States  or  Canada).  This  is  set  up  in  system Settings.
Once a country has been selected, it cannot be changed here. If the Banking data of a Borrower matches that of another
country, the data will become grayed out and a warning will appear in the "Messages" column.

For the US, five (5) data can be changed: Bank Account Description, Type of Account, Borrower Type,  Routing Number
and Bank Account Number.
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For Canada, five (5) data can be also be changed: Bank account Description, Branch number, Institution, Account Number
and EFT Account ID (Perceptech EFT provider number).

For the "EFT Account Number" column (required for Perceptech -  Canada),  a  reference can be generated randomly by
MLM. To do so, simply click in the box corresponding to the field for which it is required. Otherwise, the user can enter in
this  box the desired references when they  are  already known (existing Perceptech account).  This  field  can  also  be  left
blank and be filled later if the pre-existing identifier wasn't known when the data was first entered. 

It is not possible to change the currency of the bank account with this module, since displayed for information purposes
only. 

A green check appears in the "EFT Record" column when at least one Record is linked to this account for electronic fund
transfers.
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To change or add banking information, simply enter the data one by one in the corresponding table fields and save. A
confirmation message will appear indicating which Record(s) this account is linked to.

The following warning message will appear, advising that the new data entered will only apply to payments that will be
submitted in the future. As a result of such changes, it is important to check which account applies to which payments
through the EFT service provider portal.

Changes  related  to  the  Banking  Data  tab  via  the  Global  Changes  module  will  be  carried  out  simultaneously  in  the
"Account"  and  "EFT" tabs  of  the  Borrower and  in  the  "EFT"  tab  of  the  Loan  Record  Data  (the  EFT  tab  is  pertinent  for
Perceptech, not VoPay or NACHA).

Banking data import via Excel

All banking data can be imported via a simple Excel sheet containing 6 columns (USA) or 5 columns (Canada). Column A
must  contain  one  of  the  Borrower's  three  Unique  identifiers  (MLM  Borrower  ID  or  Borrower  Unique  ID  1  or  2  (as
renamed)) in order to assign the banking to the proper Borrower.

Press on the ? next to the Excel icon for a description of columns B to F. The data will change based on country.
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United States Banking data

Canada Banking data

Then click on the  icon to select the file containing the bank data. 
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Sample Excel sheet (errors purposely added and shown in red)

The data will then appear with erroneous data highlighted in red with the reason for the error in the Messages column.

Margill checks if the Routing Numbers follow standard rules but does not check if Account numbers and other data are
accurate. In the US, a Prenote file should be transferred to your bank before submitting the actual bank debit data.

If one data element is erroneous or missing, the whole import will not be allowed. The Save button will  appear in grey

. You will first need to fix all issues before the import or update can be done.

Once no more errors appear, press on Save and a message will appear indicating the number of bank accounts that were
imported or updated. 

Data can also be updated, but all five fields must be included, including data that does not change. In the example below
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we changed the account numbers (false data). The Save button will then update the data.

Notes:

 If a sheet contains multiple tabs, only the first tab will be imported or updated.

 If a number (Routing for example) starts with 0, if the Excel cell is a number cell, the initial 0 will be taken out, thus
give an erroneous number. You should add a ' in front of the number in the Excel cell or make sure the cell is a Text
mode and not numerical. This is especially important if Bank Accounts or Bank IDs start with 0 (in Canada some Bank
IDs start with 00).

 Only one bank account can be entered via Excel for a Borrower. If  an account already exists, it  will  be replaced or
updated (not added).

 If more than one bank account is present for the Borrower, an error will show up (since it is not known if the data
must be updated or a new account added). You will need to manage this manually.

 Please read the ? next to the Excel icon for more subtleties on banking data import.

Activating EFT in Bulk

In order to activate the EFT for many loans simultaneously, you must have entered the Borrowers' banking data and have
one  or  more  Creditor  linked  to  the  Record.  Then,  select,  in  the  Main  window,  the  desired  Records,  right-click  on  the
mouse and select "Global changes".
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The following window will open. Select from the "Record various fields / Options" drop-down menu "EFT active" and click
on the "Refresh" button to the right.

Records will no longer be grayed out following this operation*.

*If  the  Records  remain  grayed  out,  therefore  impossible  to  modify,  check  the  "Message"  column  to  find  out  why  (for
example, a Creditor with the appropriate EFT activation codes (user name and password) must be linked to the Record
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and a bank account must have been previously added to the Record).

Select the Records to modify. Right-click on the mouse and choose "Change selected line(s) to" and click on "Active".

In order to make the changes effective in the database, click on "Save".

At this point, messages may still appear to inform the user of different situations or problems. For example, in the case
below, the user will be able to activate the EFT for the Record 776, but a warning in red indicates that "This account does
not have the needed identifier. It will NOT be included in the Electronic Payments report sent to payment processor". It
will  be  EXCLUDED  when  submitting  the  payments  to  the  payment  processor".  The  user  will  then  have  to  access  the
Borrower's account in order to assign the compulsory identifier required for a proper configuration that allows EFTs with
Perceptech. 
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A final window will appear confirming the number of Records that were modified:

To find out more on this subject, see the "Useful Features" >  Global changes to the database (Batch changes) section.

   

Alerts

Manager Loan Margill (MLM) allows you to create Alerts/reminders in order to be notified when an event occurs or some
kind of an action must be performed. 

For  example,  the  Alerts  module  could  notify  you  when documents  are  required  (financial  statements,  annual  contract
renewal,  etc.),  when  a  loan  reaches  a  certain  threshold,  when  due  payments  are  nearing  their  due  date  (normal
payment, insurance, taxes, etc..), when a loan is about to end (or renewal date) or simply to advise you of your client's
birthday. 

General principles

Alert types

 System alerts: general Alerts for one or all users.
 Line  status  Alerts:  Alerts  that  reflect  Line  status  conditions.  Especially  useful  for  notifying  you  when  payments

become due or when a new principal amount must be paid out.
 Record Alerts: general Alerts relating to a specific Record.
 Record Alerts, specific lines: In the Payment schedule for each Record, an alert included on any payment line.
 Conditional Alerts: Alerts based on mathematical conditions that are fulfilled over time.
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View Daily Alerts ("Today's Alerts")

 History
 Displaying data and preferences
 Add or display Notes
 Add new Record Alerts
 Send Email
 Send SMS (Text message)
 Test sending ou Emails and SMS 
 Export Alerts to Excel 
 Generate new Alerts of the day
 Other Tips

Alerts History

Upcoming Alerts

Other recommendations

Alerts General principles 

Unless otherwise indicated, only the MLM Administrator can create alerts for a user other than himself. Thus, a normal
user (or Power user or Read-only user) can only create alerts for himself.

The same principle applies for viewing alerts. A user other than a MLM Administrator can only view his own alerts.

The workings (creation, who can receive, etc.) for each type of alert are slightly different. These subtleties are explained
below. 

A Read-only user may be excluded from receiving alerts even if  he is the Owner of the Record. To exclude a Read-only
user, check "Read-only user: No alerts" (Tools > Users).

User management - No alerts
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Alert types

Five (5) types of alerts are included in the module:

1. System Alerts (created in the "Tools" tab)

2. Line status Alerts (created in the "Tools" tab)

3. Record Alerts (created in the "Alerts" tab of a Record)

4. Records alerts, specific lines (created in the Record's Payment schedule, "Alerts" column)

5. Conditional Alerts (created in the "Tools" tab and linked to a Record in the "Alerts" tab of the Record)

The window below shows the  various  Alerts  and  the  highlighted blue  Alert  identifies  the  type  of  alert  to  be  managed
(created, modified, destroyed). Check "Do not show again" to hide this window.

1. System alerts

These  are  general  alerts  allowing  you  to  be  notified  at  a  specific  date  when  an  event  occurs  or  a  task  is  to  be
accomplished. This is not linked to any specific Record. 

For example, you may receive an alert once a week notifying you that a backup copy of MLM should be done, or that a
particular type of report must be produced and sent to your accountant.
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Alerts can be created for a single person or for all users who are authorized to receive alerts. A MLM Administrator can
create an alert for himself, for another user or for all users.

The choice "Display  and  Create Alerts  for:"  allows you  to
view alerts for different users and also to create an alert. Only an Administrator has the option to view and create alerts
for another user than  himself.  A  lower level  user  (Power or  Read-only  user)  will  only  see and can only  create his  own
alerts.

"Alerts sent to all  Users" are created for all  users of the system, taking into account the two exceptions below. Even a
new user, created by the MLM Administrator will receive previously created "Alerts sent to a all" .

Exceptions

1) Some read-only users may be excluded automatically from any and all  alerts when creating their  accounts (this
can be helpful for users that are less involved in loan management but nevertheless have some restricted access). To
exclude a read-only user check "Read-only user: No alerts" (Tools > Users).
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User management - No alerts

2) Read-only users who are not  automatically excluded from the Alerts (see above) may or  may not  be allowed to
receive specific alerts. In the System alert management tool, by unchecking the "Include" column for "Alerts sent to
all  users",  the  alerts  that  are  unchecked  will  not  be  sent  to  Read-only  users.  With  "Alerts  sent  to  all  users"  only
Read-only users can be excluded. Normal users, Power users and Administrators are always included in these alerts.
To exclude one of these, do not use "Alerts sent to all users" but instead create the same alert for each user that is to
be included. 

Alerts  can  be  generated  only  once  or  can  be  configured  to  recur  annually,  semiannually,  quarterly,  monthly,  twice
monthly on various dates or even every day or every x days (between 1 and 366 days apart).

Alerts  may  be  paused,  for  example  on  weekends  or  during  holidays.  They  can  also  be  deleted  when  they  become
obsolete. An alert that becomes obsolete since non recurring (thus the alert date has passed), is displayed in red. These
alerts should be deleted but this generally is not required if you wish to keep these for information purposes.

2. Line status Alerts

Line status Alerts allow you to  be  notified of  the  various  events  related to  the  Line  statuses for  ALL  and  ONLY ACTIVE
Records (for example, a "Due payment" Line status has not been updated to "Paid" or "Unpaid" on a specific date, or a
line with insurance or tax becomes due soon). 

For  Automatic  Alerts  based  on  Line  status,  the  main  purpose  of  this  tool  is,  without  human  intervention,  to  notify
Borrowers that a payment is coming soon (in the case of EFT) or that a payment has been rejected (non sufficient funds).
Your borrower could be alerted of this and asked to contact your manager promptly to remedy the situation. Basic fields
such as the date of the next due payment and its amount are included. It also includes the date of the last payment paid
or unpaid as well as the outstanding amount taking into account what was supposed to be paid, subtracted from what
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was actually paid.

You may be notified the same day or several days before or after the Line status date. You may even be notified every
day until the Line status changes (should only be used for "Due Pmt" Line statuses since only these Line statuses should
be modified to reflect the actual payments made over time). 

Quick example

On  November  11,  2018,  you  set  an  alert  for  Line  status  "Due  Pmt".  In  your  portfolio,  payments  are
usually paid on the 1st, 10th and 22th day of each month (no matter). If you set the alert to notify you
two days before the date of the next Due Pmt, you will be alerted on November 20 and November 29 (for
the payment due on the first of December), etc.

It  is  possible  to  configure  the  system  so  that  emails  are  sent  automatically  when  the  Alert  conditions  are  met.  These
emails  can  be  sent  to  the  Borrower,  the  co-Borrower  or  even  a  third  party  (for  example  the  Record's  manager).
Automatic emails will only be sent for Active Records.

The  Administrator  must  configure  a  default  email  address  in  the  System  Settings  >  Email  Connection.  It  is  from  this
default email address that the Alerts will be sent. These automatic emails do not go through any other user account.

For  example,  when  a  pre-authorized  payment  is  scheduled,  an  email  can  be  sent  two/three/four  days  before  the
payment due date, to the Borrower (and/or the Co-Borrower) in order to notify them of an upcoming payment. Select

from the existing email templates in the drop-down list. To create an email template, press on .
The Mail Merge / Templates module will appear. Refer to this section for instructions.

You have the option to choose the email  recipients.  Emails  can be sent  to  the  Borrower and/or  to  the  Co-Borrower(s)
and/or to a third party of your choice. All choices are possible and can be combined.
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When you select both "Borrower Email" and "Co-Borrower Email" check boxes, information in the Borrower's Record will
be used. Custom fields containing emails will not be used as the system will not be able to recognize these.

It is possible to enter several addresses in the "Other Email" field by separating them with a ";" and even use a method
called "Text to SMS" to send emails by SMS (works for most telecommunication companies).

So, when the Alert conditions are met, an email will be sent automatically to the recipients. When emails are sent to the
Borrower, Co-Borrower(s) and others, if needed, they are sent in Blind Carbon Copy (BCC), meaning that a recipient will
not see that the same email has been sent to other recipients.

The MLM Administrator can create these alerts for a specific user or for the "Owners" of each Record. By creating an alert
for the Owner of the Record, each Owner will receive the alert for his Records when the Line status event takes place. An
"Alert Owners" is not sent to the Administrator(s) unless he is also the Owner. 

The Record Owner is determined in the "Data" window under "General" tab (bottom left):
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If the Record Owner is changed, the alert created will be transferred to the new Owner. 

WARNING! If an Alert is created only for a specific Record Owner, only his Records will receive the email. In order for
all  Records  to  receive  the  email,  without  the  need to  create  the  same Line status  Alert  for  each Owner,  create  the
Alert specifying "Alert Owners" as opposed for a specific Owner.

Sending by SMS

In order to access the features relating to Alerts by SMS, the FolioMedian (SMS) Connection module must be activated in
System  settings  and  the  required  information  must  be  entered.  FolioMedian  is  a  Margill  partner  for  sending  SMS  in
multiple countries:

 North America: Canada, United States
 Europe: France, Belgium, Switzerland, Luxembourg, Germany, Great Britain, Spain, Italy, etc.
 Africa 
 Asia
 Australia
 Please contact the Margill Team to find out if the service is available in your country.

Once the connection module configuration is done, additional columns will be available in the Alerts table, based on the
same principle as those when sending email Alerts.

For example, when a pre-authorized payment is  scheduled, a  SMS can be sent two /  three /  four days before the Due
payment, to the Borrower and / or to the Co-Borrower to advise the person of the upcoming payment that will become
due.  Simply  select  an  existing  SMS  template  from  the  drop-down  menu.  To  create  a  SMS  template,  click  on  the

button.  The  Merge  /  Email  /  SMS  Template  module  will  appear.  Consult  the  section
instructions. 

You  have  the  option  to  choose  the  SMS  recipients.  These  can  be  sent  to  the  Borrower  and/or  to  the  Co-Borrower(s)
and/or to a third party of your choice. All choices are available and can be combined.

An Alert can be sent by Email and by SMS or one of the two options.

Test sending via Email and/or SMS

With the help of the  button in the Alerts Management - Line status window, you can make sure that the
Alert and its template corresponds to your needs before sending it to the Borrowers, Co-Borrowers and other recipients.

The selected Record in the Main window will be used to test the Template merge, but the test will  only be sent to the
email address and/or to the mobile number for SMS entered in the following windows:
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Warning:  SMS  templates  can  only  contain  text  or  numbers  (web  links  allowed),  must  be  short  and  comply  with  the
editorial standards for sending SMS in your country. In case of violation of these content standards, the service could be
canceled by FolioMedian.

Activation or not of automatic emails based on the Record 

For  each Record,  the  automatic  email  option  is  active by  default.  If  you  wish  to  disable  it,  in  order  that  no  automatic
emails are sent to anyone for a particular Record, you can do so directly in the Record via the "Alerts" menu on the left
and by clicking "Line status: Disable Automatic Emails (now Active)".

The option will then become inactive. You can reverse this choice by clicking again in order to reactivate it. 

To enable or disable the automatic Emails  /  SMS for several Records simultaneously,  use the Global  Changes,  with the
"Alerts: Email SMS sending Enabled" field.
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3. Record Alerts

Very similar to "System" alerts, the distinction lies in the fact that these alerts are related to specific Records. Each Record
being  different  (payment  and  renewal  dates,  required  documents,  payment  of  insurance,  etc.),  this  type  of  alert  can
include, for a specific Record only, that which should be done or accomplished.

Open the desired Record and click Alerts > Record. The Record must be saved before you can use these alerts.

The MLM Administrator can create these alerts for a specific user or for the "Owners" of each Record (see explanation in
the above section "Line status alerts"). Warning: if the Record Owner is a Read-only user and is not authorized to receive
alerts Tools > Users, he will not receive any alerts even if the alert is created specifically for him.

The  alerts  can  be  generated  only  once  or  can  repeat  annually,  semiannually,  quarterly,  monthly,  twice  monthly  (on
various dates) or on every day or every x days (between 1 and 366 days). 

Sending by Email and SMS
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These alerts  can  be  configured to  automatically  send  an  email  or  a  SMS  when  Alert  conditions  are  met.  For  example,
when a renewal of any kind is coming up, an email or SMS can be sent on a specific date to the Borrower (and/or the
Co-Borrower) to notify them of an upcoming deadline. Also, they can be useful internally in order to notify a Margill user
of a specific action to be taken in the Record in question. This facilitates Record management and reduces oversights!

It is possible to configure the system in order to automatically send emails (and/or SMS), at a specific date and/or at the
desired frequency and according to the established recurrence. These emails and SMS can be sent to the Borrower, to
the Co-Borrower or even to a third party (for example, the user in charge of the Record).

The Administrator must configure a Default email address, in System settings > Email connection. It is from this default
email address that the Alerts will be sent. These automatic emails are not sent from any other user's account. For SMS
that are not of "Email to SMS" type, the configuration must be done in System settings > FolioMedia (SMS) Connection.

Simply  select  the  existing  email  (or  SMS)  template  from  the  drop-down  menu.  To  create  a  template,  click  on  the

 button.  The  Merge  /  Email  /  SMS  Template  module  will  appear.  Consult  the  section
instructions. 

When selecting the "Email Borrower" and "Email Co-Borrower" ("Mobile" for SMS) boxes, the information included in the
"Borrower" Record will be used. Custom fields that include email addresses and mobile numbers will  not  be used - the
system won't be able to recognize these.

It is possible to enter multiple addresses in the "Other Email" field, separating each with a semicolon ";" and also use the
technique  called  "Email  to  SMS"  in  order  to  send  emails  via  SMS  (for  most  telecommunication  companies)  if  the
FolioMedian module is not used. 

Thus,  when the  conditions  relating  to  the  Alert  are  met,  an  email  or  SMS  will  automatically  be  sent  to  the  recipients.
When emails are routed to the Borrower, Co-Borrower(s) and others as needed, they are in blind carbon copy (BCC), so a
recipient does not see that someone else has received the same email. 

The MLM Administrator can create these alerts for a specific user or for the "Owners" of each Record. By creating an alert
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for the "Owners" of the Record, each Owner will receive the alert in relation to their Record when the Line status event
takes place. An "Owner Alert" is not sent to the Administrator(s) unless they are also the Owner of the Record. 

The Owner of a Record is configured in the "Data" window under the tab "General" (left bottom):

If the Owner of the Record is modified, the alert for the Owner will be transferred to the new Owner.

4. Record alerts, specific lines

"Record  alerts,  specific  lines"  are  set  in  each  Record  individually.  These  alerts  are  inserted  on  a  specific  line  in  the
Payment schedule and are generated for the Record Owner only. 

To create these alerts in the Payment schedule, scroll to the right to display the "Alerts to accomplish" and "Alert Days
Before - / After +" columns. Enter what needs to be done on this line and if you wish to be notified 1) before the effective
date (a negative sign indicates the number of days before), 2) after that date (a number of days without a sign) or 3) on
the day (nothing in column).

Excerpt of the Payment Schedule

In  the  example  above,  the  Record  Owner  will  be  notified  14  days  in  advance  for  the  first  alert,  7  days  following
09-23-2009 for the second alert (Insurance required) and the same day for the third alert. 

Please note: only the Record Owner will be alerted as to what must be accomplished. An administrator will be able to see
these alerts by showing all alerts in the view Alerts window as opposed to viewing only his alerts.
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5. Conditional Alerts

Conditional  Alerts are based on mathematical  conditions that  occur over  time.  For  example,  an  alert  could  be  created
that  would  allow notification when the  balance  principal  +  interest  sum becomes  greater  than  the  "Maximum Credit"
amount.

Other examples :

 alert when the outstanding amount exceeds a specific amount
 alert when a ratio created with Mathematical Equations exceeds certain limits
 alert when the refund ratio is below a certain percentage

Combined with Mathematical Equations and custom fields, the possibilities are endless.

Alerts  compare two amounts  (each of  which may be  composed of  several  amounts  through  Mathematical  Equations).
The alert is generated when:

first amount is either

equal to
less than or equal to
equal to or greater

less than
greater than

greater or less than

second amount

 
These alerts will appear 1) at the opening of MLM:

2)  when  a  condition  is  met  when  the  Record  is  opened.  The  alert  will  be  displayed  when  the  Record  is  saved.  For
example, in a line of credit loan type, a disbursement (adding principal (with the Line status "Add. Princ.")) is made and
then  the  Maximum  credit  is  exceeded.  When  saving  the  Record,  a  message  will  warn  you  that  the  condition  was
encountered.  You  can  then  decide  to  either  reduce  the  disbursement  to  meet  the  Maximum  credit  allowed  or  do
nothing. If nothing is done, you will be alerted of this condition with "Today's Alerts" the next time MLM is opened. You
will be alerted as long as the condition exists. 



Page 303

© Jurismedia Inc., 2007- 2023

This  verification  is  not  performed  when  payments  are  recorded  (paid  or  unpaid)  with  the  Payment  update  tool.
Nevertheless, a "Today's Alerts" will appear the next time MLM is open.

Conditional alerts can be created by the Administrator and by a Power user and can be applied to all desired Records or
just certain Records. The alert is displayed when opening MLM in the normal alerts module but only for the owner of the
Record.

An alert will be generated even if a field is blank or contains a 0.00. To avoid generating a warning for this Record, you
can remove the alert or enter a very high amount such as 999999999999 in the blank field.

A  conditional  alert  is  generated  when  MLM  is  launched  by  a  user.  If  MLM  is  not  launched  for  a  day  (weekends  for
example), conditional alerts will  not be created for that day even if  the condition occurs that  day (for a  condition that
would include the accrued interest each day, for example).

1) Creating a conditional alert

To create the alert, go to Tools > Alerts > Set Alerts > Conditional.

The  following  window will  appear.  When  conditional  alerts  are  created,  they  will  appear  in  this  list.  It  is  through  this
window that alerts can be edited or deleted. Press "New".

The following window will appear, allowing you to name and configure the alert.
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 First assign a name to the alert in the "Alert Title" box;

 Choose the field in the left column (fields are sorted by topics) and use the arrow  to insert in the "Field 1" box
on the right of the window;

 Choose the Condition (greater than or equal to, less than, etc.);

 Choose "Field 2".

o Field 1 or Field 2 can either be a MLM field (from over 900), a Custom field, a Mathematical Equation or a

number that can be accessed with the button.

The box to the right of "IF" will be completed as the three components (fields and conditions) are entered. 

 Enter the message to be displayed when the condition is met. The message can be up to 100 characters, so you have
room, if necessary, to explain the condition. Here are some examples of messages:

o Credit limit exceeded 
o Refund ratio below 75% - Call client
o Loan balance exceeds limit allowed
o Risk greater than limit allowed - Produce report for the accountant

Condition as a percentage

When a condition uses a ratio based on a percentage, please use the following notation:

A percentage is expressed as is, not as a fraction of 100. For example, 75% = 75, not 0.75 and 133% = 133, not 1.33.

If  you  wish  to  compare  a  percentage  to  a  number,  express  this  number  by  simply  entering  the  percentage  but
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without the % sign.

For example, to create an alert when the Refund ratio drops below 75%, enter the condition as follows:

Example of a more sophisticated condition

A condition could include mathematical formulas,  custom fields and amounts that  operate in  accordance with the
loan accrued interest and amounts paid. 

For example, your accountant has established a formula or equation that takes into account the FICO score of the
Borrower  (ie  part  of  a  custom  field)  and  the  loan  balance  (calculated  automatically)  and  the  refund  ratio.  A
sophisticated mathematical equation was developed (called "Risk Level") to arrive at a risk level for the loan that may
not exceed such percentage or level (a number). 

The formula takes into account the level of risk of these elements (fictitious formula):

1) FICO Score Custom field      600
2) Loan Balance Calculated automatically 25550
3) Maximum risk balance Custom field           30000
4) Reimbursement ratio Calculated automatically 85.25%
 
The elements are divided and multiplied using MLM's mathematical  equations  to  reach a  level  of  risk  that  is  then
inserted into the condition. Each Record contains its own maximum risk factor according to the FICO score and the
loan type (entered as a custom field).

The condition would be entered as follows:

Equation

Custom field
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Once these steps  are  completed,  press  Save.  The conditional  alert  will  appear  in  the  list  of  Conditional  Alerts  (Tools  >
Alerts > Set Alerts > Conditional):

and in the Record "Alerts"  window. The alert appears but is not yet activated for the Record (see the following section:
2) Assign the alert to the desired Records).

2) Assign the alert to the desired Records.

a) Conditional alerts can be assigned to one or many Records. 

i) Assign an alert to all "Active" Records: 

In  the  Conditional  Alerts  window,  click  on  "Apply  to  existing  Active  Records"  .  The
alert will only be assigned to "Active" Records that exist at the time the button was clicked. A confirmation window will
open in order to apply the Alert to all Active Records. 
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ii) Records that are not Active yet but eventually will:

In  the  Conditional  Alerts  window,  click  on  "Apply  to  Records  as  they  become  Active"

. This tool allows the Alert to be added to Records as they become Active.
The "Activated Auto." column will be checked to indicate that this Alert will apply when the Records become Active. This
tool is useful for creating particular data entry rules.
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TIP! We recommend clicking both buttons in order to include all the Active Records, present and future.

The alert will appear in the Record window in Alerts > Conditional and will be checked as active for this Record.

If an alert has been assigned to all Active Records by mistake, to eliminate the unwanted alert, delete the alert, create a
new one and assign it to the Records by following the procedure below. 

b) To assign a conditional alert to one or many Records individually:

Open Record > Alerts > Conditional.

The list  of  available conditional  alerts appears.  Simply  check the  one or  several  conditional  alerts  to  include and press
"Save".

Renaming and deleting Conditional Alerts 

Go to Tools > Alerts > Set Alerts > Conditional.
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The  following  window  will  appear  with  the  list  of  conditional  alerts  created.  Select  the  alert  whose  name  should  be
changed or deleted and then press the right mouse button. Make your choice.

Conditional Alert limits

Conditional  alert  can  include  a  numerical  custom  field  included  in  the  Borrower's  (or  Creditor)  information  card.
However, a conditional alert can only make the comparison one Record at a time. 

For  example,  you  create for  the  Borrower a  field  called "Credit  Limit".  The condition  will  be  activated  in  one  or  many
loans (Records) of that Borrower and will compare the principal, interest, etc. of one Record at a time with the "Credit
Limit" amount of the Borrower. One might think that the credit limit listed for this Borrower would apply to the total of
all these loans. This is not the case. MLM does not calculate the sum of principal of all the loans of the Borrower but the
principal of each loan would be individually compared with the limit entered.

Example: 

Credit limit entered for the Borrower: 100,000

Loan 1 Total principal 45,000
Loan 2 Total principal 35,000
Loan 3 Total principal 15,000
------------------------------------
Total  95,000

The alert will  not be given when 5,000 in principal is added. The alert will  only sound when one loan is  more than the
limit of 100,000. It is therefore wise to enter a credit limit by Record, not by Borrower.

However, as of MLM version 4.2, a new module named "Maximum Credit Borrower", takes into account all  Records in
the  credit  limit  management  and  may  turn  out  to  be  a  more  effective  tool  for  managing  the  credit  limit.  Consult  the
"Record Window' chapter > Borrower (Client) Informationsection for more detail.

View Daily Alerts ("Today's Alerts")

Upon opening MLM, if alerts are available for the current day or if old alerts have not yet been resolved, the following
window will appear notifying you of these alerts: 
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By pressing on "View Alerts", the following window will be displayed:

When a MLM session is already open, you can view the alerts at any time by clicking on "Alerts" under "Tools".

 

The Alerts window displays alerts of the day (in black) and the alerts that have not yet been resolved (in red). When an
alert is resolved, check the "Done" column and the alarm will turn green. The unresolved alerts will appear the next day.

The  "Generate Alerts" button  updates the alerts by generating the day's new alerts while
eliminating those that are resolved or "Done". 

If an Alert concerns a Record, it is possible to open the Record via this window by selecting the proper line, right mouse
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click > Open Record.

History

The alerts history (accomplished or not and not yet removed by the MLM Administrator [see next section, Alerts History])
can also be displayed with the  "Show alerts from..." option. Normal users (as opposed to the MLM Administrator(s)) can
only view their own alerts.

In the example below we wish to view the historical alerts from November 1 to November 7. Typically, alerts will appear
in green as these should ordinarily have been resolved. It is always possible to uncheck one or many alerts so these are
considered not done.

Displaying data and preferences

In  the  Alerts  window,  scroll  right  to  see  data  pertaining  to  the  client  (Record  number,  company,  name  and  surname,
phone, fax, email) and data pertaining to the alert itself (alert accomplished or not, date generated, task to accomplish,
type of  alert,  and,  depending on the type of  alert,  the payment date,  Line status,  payment  amount,  and  if  the  alert  is
recurring, how often). 

Columns can be hidden by clicking on the header of the column with the right mouse click. You can also change column
order and sort alerts by the desired criteria by clicking on the column's header.

Only a MLM Administrator can view all other users' alerts. An Administrator can also resolve all alerts, including those of
another Administrator. Even a power user does not have these rights.

Add or display Notes

Notes can be added or viewed for a client whose alert is highlighted. Click on . In the list, select if
the note is related to the Record or to the Borrower. The notes included in the Record or the Borrower can be accessed

via the Alerts module.  If  you click on ,  you will  be able to add or  modify  a  note.  To  find  out  more about
these Notes features, consult Useful Features > Notes - Record and Borrower.
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Add new Record Alerts

The  "Record  Alert"  button  allows  you  to  create,  modify,  or  delete  a  Record  Alert,  directly  from  the  Today's  Alerts
window. There is no need to open the Records one by one to manage these alerts. Simply click on a Alert and press the

 button to access the Record Alert's management window. Most useful for collections.

Send Email

Emails may be sent to the clients (Borrowers) whose alerts are highlighted. 

If only one alert is highlighted, by pressing on  you can send a message from your regular email
program.  Your  default  email  program  (Outlook,  Eudora,  Thunderbird,  Windows  Mail,  etc.)  will  open  containing  the
client's  email.  Your  system  must  be  properly  configured.  If  the  right  program  does  not  open,  contact  your  computer
technician.

The option allows you  to  send one or  more emails  from an  "Email  Template" created directly  in
MLM. Choose one or more recipients and the Email Template to be sent.
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Refer to Reports > Mail Merge/Templates, to find out more about customizing these templates.

Emails may only be sent for Record-specific alerts since a Borrower is associated to the alert. "System" alerts do not allow
this since no email is associated with this alert type.

If multiple email addresses are included under the Borrower (each separated by a semi colon ";"), emails are sent to all of
these in (carbon copy).

For managing the different addresses in this window, consult the Email Connection section.

Export Alerts to Excel

The "Save as Excel File"  button allows you to export either the entire table to Excel (if one line is
selected) or all selected lines.

Generate new Alerts of the day

If  an alert  is  created for the current day,  in  order to view this  alert  on  the  day  itself,  make sure that  the  current  date
appears  in  the  box  "Show  Alerts  from"

.  Then  press  on  "Generate

Alerts" . The system will generate new alerts for the current day.

Other Tips

To quickly check or uncheck alerts (to mark as "Done" or if  you decide that  an alert  was not  accomplished), select the
desired alerts (Ctrl or Shift key and click the mouse) and then check or uncheck.

The  "All  done"   button  allows  you  to  quickly  select  all  tasks.  You  can  then  uncheck  those
tasks that were actually not completed.
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Alerts History

All alerts, even if accomplished, are stored in the History log. These can be found by entering the desired dates.

In the longer term, in order to avoid thousands of historical alerts from clogging up the system, the MLM Administrator
can delete the old alerts as of a desired date.

Depending on how you use the Alerts module, it is suggested to eliminate only the older alerts dating back from over a
year. It is suggested to first do a complete backup of the database before deleting the alerts. In the confirmation window,
the default date entered will be one year before the current date.  

Upcoming Alerts

It has become possible to view the upcoming alerts for the future, allowing you to see, for example, what is to be done in
the next month. Go to Tools > Alerts > View Alerts > Upcoming Alerts.
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In the example below, alerts until Oct 31, 2019 were generated (considering that this text was written in may 2019).

Some types of alerts can be displayed or all types with the choice "Alert Types". For the "Line status" alert types, "Due
Pmt" alerts  are  excluded  since  a  significant  number  of  these  alerts  can  be  generated  and  the  value  of  knowing  these
normal, unexceptional alerts is low.

Conditional alerts are not included in the Upcoming alerts.

Alerts can be selected for all users or for one of these with "See the Alerts for:".

Other Recommendations

If  a  user  is  removed from the  system,  it  is  suggested  to  destroy  his  alerts  as  well.  This  is  not  done  automatically.  His
historical alerts will remain, but his active alerts will be transferred to the Administrator "ADMIN".

When  duplicating  a  Record  (from the  Main  window),  the  alerts  are  not  automatically  included.  To  include  these,  you
must specify to include these:
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General Defaults

Upon installing Margill Loan Manager (MLM), some default settings are set for many of the functions. These include:

 Language (English or French version);
 Fields (columns) displayed in the Main window;
 Interest rate table (default) and the default folder containing interest rate tables;
 Sales tax rate(s) and the folder containing them;
 APR tags, amounts or points and if fees are financed, paid up front or paid subsequently; 
 Simple or Compound (Effective rate method) interest;
 Year base for simple interest calculations;
 Day count;
 Short period interest calculation method;
 The Grace period (in days) afforded to the Borrowers;
 No interest on various types of fees (insurance, taxes, invoices and penalties);
 Date format for the Document Merge reports;
 Interest-only and fixed principal refund options and the special optional line "Behavior";
 And many more...

Each of these settings may be changed from various windows and very often, to set new default data settings, change the
settings and press on "Save as default" link. 

Data, Borrower and Creditor windows

For  the  "Data",  "Borrower"  and  "Creditor"  windows,  if  some  information  is  used  regularly  (for  example,  the  same
Creditor for all loans), enter the required information and press on "Save as default". This information will appear for all
subsequent Records.

If a default becomes unnecessary, to delete the data from the "Data" window, click "New Record", then "Create a new
Record." If default settings have been defined for the "Data" window, click "Clear data". A window will appear, asking if
you wish to delete the data in the window, if you wish to load the default settings, cancel all or clear the default data.
With the latter choice, your next Record will be blank with the basic system data.

 
If  "Clear  Default"  is  chosen,  the  next  Record  created  will  contain  no  default  data  in  the  "Data"  window  but  will
nevertheless contain the default data set in the other windows (Borrower, Creditor, APR and Advanced) the case being.  

To  delete  the  default  for  the  "Borrower"  and  "Creditor"  windows,  click  on  "Clear  Default".  When  the  next  Record  is
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created, the data for the Borrower or the Creditor will be empty.

To further simplify data entry, MLM allows you to create Profiles that may be set for the Data window to allow for the
easy creation of loan categories (amount, compounding, interest rate, etc.) frequently created.

Important for default calculation settings:

MLM  may  be  configured  to  meet  practically  any  recognized  interest  calculation  method.  Considering  there  are  many
variants depending on the location, industry, type of client, etc., in more complex situations, it is important to compare
MLM results with an existing calculation known to be right. Various MLM settings may be changed (Simple or Effective
rate  method,  Day  count,  compounding,  number  of  weeks  in  year,  short  period  between  Origination  date  and  First
payment date...) to obtain the required results. 

Once these settings are established, they may be set as the default settings.

   

User settings

Every user can configure his software using different criteria. To do so, go to Tools > Settings > User Settings:

Content:

 Record Summary window
 Default Language
 Check for software updates
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 Printing Preview
 Options: Interest-only and Fixed Principal
 Record window Identifiers (Headers)
 Quick Links
 Show Balloon Text
 Display the tips and messages
 Reset text size (Main window and Payment schedule)
 Hide the Database Path in the Record Summary window
 Tutorial in Main window
 Ask Date of first Capitalization
 Record "Data" window: Display / Hide Loan "Term" and "Due Pmt" Type
 Date format in the Document Merge reports

   

Record Summary window

By  clicking  on  ,  each  user  can  set  which  columns  he  wishes  to  display,  name  the  column
headers as desired and set the order in the Main Window (Record Summary window).

See the "Record Summary window" chapter > Displayed column selection, name and order for more information on this
setting.

Each user can set up a "Filter" or "Search" mode to be displayed in the Main window. The Filter mode includes a list of
filters that will display only the Records that comply to these filters.

The "Search" mode is designed for larger databases (thousands of loans) where various fields can be used to display only
Records that meet the search criteria.

Please consult the "Useful Features" > Search Mode chapter for more information about these modes.

   

Language

Margill Loan Manager is available in both English and French. 

The default language may be changed in the Default Settings by going to Tools > Settings > User Settings and by choosing
the Default Language in the scroll menu.

In a network version, some users may use the English version while others use the French version.

   

Check for software updates

In the User Settings, it is possible to specify how often to verify software updates. In the drop down menu you can choose
the frequency:
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 Monthly
 Weekly
 Daily
 None 

When the user starts the software, a window will open, that will indicate if your version is up to date or if an update is
available.

When an update is required, the main changes will be listed:

   

Printing Preview

In Settings, the user can determine the print preview default display size for the "Detailed Schedules" reports.

Please  note  that  no  matter  what  option  is  selected  it  will  still  be  possible  to  change  it  when  a  printing  preview  is
generated.
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Options: Interest-only and Fixed Principal

Advanced options for Interest-only, Fixed Principal and the automatic recalculation of payments to give a final balance  =
0.00 or X are usually not activated because these are more complex options usually not required for users who perform
normal calculations. These options offer additional choices when it comes to paying back Interest-only (and Column Fees)
and Fixed Principal.

In User Settings, the following window will open when you click on "Options: Interest-only and Fixed Principal":
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When "Offer the two options when creating a new Record" and "Offer the three options when creating a new Record"
are checked, the user will have to make a choice, in the Payment schedule, when making payments of:

 Interest-only Payment (and Column fees)
 Fixed Principal Payment

When  this  choice  is  made,  he  will  have  to  enter  the  interest  amount  to  be  repaid,  if  applicable.  This  will  affect  the
payment amount and how it is mathematically applied and accounted for.

For the Interest-only, the user will have to determine each time if he wants to:

 Refund all outstanding interest (and Column fees)
 Refund only the accrued interest for the current period
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For Fixed principal, the user will have to determine each time if he wants to:

 Refund principal and ALL outstanding interest first
 Refund principal and interest FOR THE PERIOD only
 Refund principal WITHOUT refunding outstanding interest (NOT SUGGESTED)

How to avoid determining these criteria for each transaction:

If  the  user  does  not  wish  to  chose  each  time an  Interest-only  (and  Column Fees)  or  Fixed  principal  payment  is  made,
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because the method is a standard one that does not change, he can adjust the settings and line behaviors in advance in
the  User  Settings  window.  Simply  uncheck  "Offer  the  two  options  when  creating  a  new Record"  and  "Offer  the  three
options when creating a  new Record" and choose the appropriate options  in  the  drop down menu.  These choices  will
apply  by  default  when  "Interest-only  Payment  (and  Column  Fees)"  and  "Fixed  Principal  Payment"  are  made  in  the
Payment schedule.

For  more  information  on  these  features,  refer  to:  Payment  schedule  (Amortization  payment  schedule)  >  Payments  >
Interest-only payments (and Column fees) and Fixed principal payments.

A second advanced option, "Behavior", is usually hidden but can also be activated if needed.

The "Behavior" option tells the software to recalculate the automatic payment in order to:

1) pay interest-only (and Column fees)
2) pay a fixed principal
3) pay principal and interest (and Column fees and any other amount) to give a final balance = 0 or X

The payments are thus recalculated automatically based on the transactions above (transactions before the payment).

This "Behavior" can be directly activated in the Data window with the first option above, thus allowing this "Behavior" to
be added when calculating the Payment schedule, eliminating the need to add subsequently (a step is saved if this option
is required).

"Add Behavior" option available

Upon checking the second option, "Display "Behavior" option in the Payment schedule, the software will ask the user if
this special behavior should be activated in the Payment schedule for the selected payment lines.
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For  more  information  on  this  advanced  option,  see  Interest-only  payments  (and  Column  fees)  and  Fixed  principal
payments.

   

Record window Identifiers (Headers)

This  option  is  used  to  display  some  of  the  identifiers  in  the  header  of  the  Record  Window.  Thus,  each  user  has  the
possibility of displaying or not, one or multiple of the following identifiers

 MLM Record ID
 Accounting ID
 Record- Unique Identifier 1
 Record- Unique Identifier 2
 Record Number
 Record Number (Numerical)
 Borrower's Last name
 Borrower's First name
 Borrower's Business (company)
 Creditor's Business (company)

In this example, the user decided to include 4 identifiers: MLMs ID, Borrower's First and Last Name and his own "Record
Number":

To do so, go to Tools > Settings, in the "User Settings" tab click on "Record window Identifiers".
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To select the fields that must appear in the header of the Record Window, click in the left box of the "Fields Displayed"

menu. A green check mark  will confirm your selection.

To cancel your selection, click on the green check mark.

After selecting the desired fields, you can establish the order in which they appear in the header by using the
arrows located in the right, highlighting the field that to be moved.

After specifying and arranging your fields in the desired order, press on "Save" and then " Exit".
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The user obtains the desired information in the header of each Record that is accessed. 

It is possible to display up to a maximum of five (5) identifiers in the Record header.

If no identifier is selected, the header will only display "Margill Loan Manager".

Feature that's really appreciated!

It is possible to rename the following fields and to gray out fields which should not be populated:
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See Personalized Standard Fields 

   

Quick Links

This option allows you to add links to web pages, documents or programs for quick access from the Main Margill  Loan
Manager (MLM) Window. Each user can enter their own links.

To do so, go to Settings, under the "User Settings" tab and click on "Quick Links".
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To add a new link, click on .  Enter the path and a description which will appear in the Main Window. Click on "Test
link" in order to validate the path.

If  links  need  to  be  shared  with  all  MLM  users,  click  on  .  This  will  add  this  user's  links  to  all  other  users'  Main
window.  This  can  be  useful,  for  example,  to  share  training  or  procedure  documents  (internal  Standard  Operating
procedures  -  SOP)  (link  must  be  accessible  to  all,  not  contained  on  an  unshared  drive)  or  important  websites  such  as
external suppliers.

Click on "Save" and "Close" and this link will be personal to this user.

To delete an existing link, click on the line to be deleted and click on .

New links added will appear at the bottom of the Main Window under the "Quick Links" tab:
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Show Balloon Text

This option displays or hides help text in yellow balloons with a mouse scroll over.

   

Do Not Refresh Main window

A  user  could  decide  to  activate  this  option  when  the  Main  window  refresh  time  is  too  long  (ex.  slow  network  and
thousands of Records displayed).

If you disable the "Do Not Refresh Main window", when in "Filter" mode, the latest changes made by other users will no
longer be automatically displayed.

You can nevertheless manually refresh the data displayed by pressing on th "Refresh icon"  at the top of the filters
or by pressing on the F5 key.

   

Display the tips and messages

If checked, this option displays tips and messages that were checked "Do not show again".

   

Reset text size (main window and Results table)
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If checked, this option resets the Main Window (Record Summary) and the Payment schedule's text size to the default
font size.

   

Hide the Database Path in the Record Summary window

It is often convenient to know the Database Path, especially for new setups or when the database is transferred for one
computer to another. This path can be displayed in the Margill Loan Managers Main Window (Record Summary). 

In order to hide the Database Path at the bottom of the Record Summary window, simply check this option.

   

Tutorial in Main window

A short and basic tutorial is available in the Main Margill Window, top right. The tutorial can also be partially adapted by
you in order to train your new users, according to your needs. See Getting started > Tutorial for more information.



Page 332

© Jurismedia Inc., 2007- 2023

You can activate or  disable the tutorial,  as  needed. To do so,  go to Tools > Settings >  User  settings  and  then select  or
unselect "Show Tutorial".

   

Ask Date of first Capitalization

When a loan uses the "Capitalized simple interest" method, this option allows the user, in the "Data" window, to choose
a capitalization date other than the Origination date of the Record, which is the default in Margill Loan Manager.

The  capitalization  frequency  (annual,  monthly  or  other)  will  be  computed  the  same  way,  but  the  capitalization
"anniversary" Date will be based on the date entered in the dialog box when the user clicks on "Compute".
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For more detail about this option, see: Calculation methods > Simple Interest (Capitalized).

   

Record "Data" window: Display / Hide Loan "Term" and "Due Pmt" Type

Each user has the possibility to hide/display two types of data in the tab "Data" of a loan:

 Number of Payments (Term)
 Due Pmt Default

If  the  Term is  not  used  in  the  types  of  loans  you  usually  do,  it  could  be  hidden  because  in  many  cases,  it  equals  the
"Number  of  payments  (Amortization)".  Generally,  the  Term  is  used  for  mortgages.  For  example,  a  20-year  amortized
mortgage could have a 5-year term. Therefore, payments are calculated based on 240 payments to reach a balance of
0.00 after 20 years but the mortgage is renewable on new conditions after 60 months.

For the "Due Pmt Default" option, this would be used in exceptional situations only. A payment schedule created with a
Line  status  other  than  "Due  Pmt"  (system's  default)  could  be  useful  to  identify  special  Due  payment  lines  that  would
depend on loan types. 

Each  user  can  decide to  display,  or  not,  one or  both  of  these items.  Check or  uncheck  one or  both  options  in  Tools  >
Settings > User settings:
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If the default settings were defined on the Term or on the "Due Pmt" type and the user decides to hide these data, the
set default settings will be ignored and the Due Pmt type default will be "Due Pmt" (system's default). Existing loans will
keep their original values before being hidden even if they remain invisible in the "Data" tab. 

   

Date format in the Document Merge reports

For the "Documents Merge" reports, including automatic emails sent to the Borrowers, each user can specify the date
format in the "Date" fields. The user can choose from five date formats:

 Windows format (based on the Short Date Format entered in the Windows Control Panel)
 January 31, 2022
 Jan. 31, 2022
 31 January 2022
 31 Jan. 2022

Thus,  some users  can  choose the  English  format  while  other  users  who  work  with  an  French  clientele  can  choose  the
French format.

   

PDF Reader

If  your default  PDF reader cannot open PDF files directly from Margill  Loan Manager (MLM), there is  an option to  use
MLM's internal PDF reader (Tools > User Settings).

This should be used if your system's default PDF reader has problems opening the file.
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The PDF reader included with MLM has several features, such as:

 Print
 Save
 Zoom
 Search
 Rotate
 Delete pages
 Import pages
 Add watermark
 Handwritten signature

   

System settings (Administrators)

Multiple  settings  can  be  configured  by  the  Margill  Loan  Manager  Administrator  in  the  System  Settings
(Administrators) tab.
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General Settings

 Unlock Records / Alerts 
 Borrower Maximum Credit ( See Record Window > Borrower (client) Information )
 Mandatory Fields
 Automatic and Overnight Tasks
 Personalized Standard Fields
 Custom fields (see Getting started)
 Field Scroll Menus
 Line Payment Statuses (see Payment schedule (Amortization payment schedule) > Line status ) 
 Custom Column Titles
 Sensitive Data
 Internet Connection
 Email Connection
 FolioMedian (SMS) Connection
 Data and Backups (see Backup (data) > Backup (data)
 Column Fees : Automatic
 Suggested maximum number of days between "Pmt Date" and "Pmt Due Date"
 Attached Files, maximum size (MB)
 Allow to change the "Expected Payment" amount when Line status is "Due Payment"
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 Number of Decimals displayed
 Unmanaged Records
 Blocking Historical Transaction Changes
 Show / Hide Totals in the Main window
 Amount due variables (Activation)

Modules

 Currencies
 Credit Reporting
 Electronic Funds Transfer (see Tools > Tools Menu > Electronic Funds Transfer > Setting up the EFT module)
 Personal Logo Display (see Introduction > Personal Logo Display)
 Master and Affiliate Loans
 Custom Report settings (see Reports > Custom reports created by Margill Team)
 Returned Checks

Special 

 Borrower Merge
 Creditor Merge
 Import Data (Borrower, etc.) (see Getting started > Import Borrower, Creditor and Employer Data)
 Import Loan Data (see Getting started > Bulk import of Loans and Database configuration)
 Automated Imports - JSON or Excel files

o Salesforce Connection (API)

   

Unlock Records / Alerts

Margill Loan Manager (MLM) will only allow a Record or Alert to be changed by one user at a time. When one user opens
the Record or Alert, it  becomes "locked" by this user and can only be opened by another user in  read-only mode. The
locked Records appear in highlighted yellow in the Record Summary Window (main window).
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If  for  some reason  (power  failure,  computer  crash  or  software  error)  a  Record  (or  Alert)  remains  locked,  only  a  MLM
Administrator  or  a  Power  User  may  unlock  the  Record  (or  Alert)  through  Tools  >  Settings  >  System  Settings
(Administrators) and by clicking on the "Unlock Records/Alerts" under "General Settings".

Upon clicking , the following window will appear, confirming that the Record(s) are indeed unlocked.

When clicking "Unlock" in order to unlock Alerts, the following window will appear so the user can confirm his choice.
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Unlocking Records should only be used after a software or computer crash. Unlocking when a user is still actively in that
Record or Alert may lead to unsaved changes.

   

Borrower Maximum Credit

See Borrower (Client) Information in the Record Window chapter.

   

Mandatory Fields

The Administrator can specify that certain fields are mandatory for the Borrower (or  Co-Borrower and Guarantor),  the
Creditor, the Employer and the Record (data). A user will not be able to save until these mandatory fields are filled in.

This is useful to make sure that specific mandatory and important data is not missed by the users.

The "Mandatory Fields" module is accessible through Tools > System Settings and by clicking on "Mandatory Fields"

To activate the module, the Administrator must check the following box:

It  will  always  be  possible,  for  the  Administrator,  to  temporarily  deactivate  the  module  in  order  to  perform  special
operations.

If the "Do not activate for Draft Records" is checked, when a Record is in Draft mode, the option for mandatory fields will
be deactivated. When a Record becomes Active (or any other status besides Draft), the Record will not be saved until the
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mandatory fields are filled out.

Note: A Borrower, a Creditor or an Employer can not be in "Draft" mode, therefore, the special Draft Record option will
not apply even if a new Borrower, Creditor or Employer is created when the associated Record is in Draft mode.

Note: This special option will not apply when importing via an Excel sheet or by other import tools in bulk.

 Steps to select the Mandatory fields

 Data Import and Mandatory fields

 Global changes and Mandatory fields

Steps to select Mandatory fields

To determine the fields for which data must be entered, follow these steps:

For  example,  the  Administrator  wants  all  Borrower  data  files  to  include  the  Borrower's  Last  name,  First  name,  Social
Security Number and ZIP Code.
  
The Administrator selects the required fields by clicking on them.

A green check mark  confirms the selection. To cancel the selection, click on the green check mark, then click "Save"
and then "Exit".
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Thus when an user creates or changes a Borrower's data file, he will be forced to add all the information of the required
fields, set as mandatory by the Administrator.

The mandatory fields for the Borrower (Creditor or Employer) need not be filled when a Record is created or changed. It
is  only  when  a  Borrower  (Creditor  or  Employer)  is  changed  that  the  mandatory  fields  will  be  reported  as  such.
Nevertheless, mandatory Record fields will have to be entered when a Record is created or changed.

Mandatory fields related to the Borrower, will also be mandatory to create or change the Co-Borrowers and Guarantor
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data files.

All Custom fields (1 to 9) and unlimited custom fields, as well as fields containing scroll menus can also be designated as
mandatory fields.  

Loan (Record) data can also be designated as mandatory fields.

Thus, if  the Administrator indicates, for  example, that  the "Maximum Credit" must be a  entered for the loan,  the loan
(Record) cannot be changed or saved if it does not contain this mandatory information.

In  the  example  below,  the  user  updates  an  existing  Payment  schedule,  but  the  Administrator  has  just  added  the
"Maximum Credit" of the loan as a mandatory field.

Since the Record did not originally contain this mandatory data, a warning message appears to remind the user to enter
this information. The user will not be able to update the Record until the mandatory field is filled in.

However, if  the Record status is "Draft" and the Administrator checked the "Do not activate for Draft Records" option,
the user will be able to update the Record without the need to enter a "Maximum Credit" value.



Page 343

© Jurismedia Inc., 2007- 2023

Data Import and Mandatory fields

For manual imports (Loans, Borrowers, etc.) via Excel sheet, mandatory fields are identified in red in the fields available
for import.

If the mandatory fields are not selected by the user, in other words, if they are not part of the fields that the user plans to
import in MLM, a warning message will appear to remind him to add the missing mandatory field or fields.

To import multiple Borrowers, Loans or Others without having to fill in the fields (for example, the data is unknown) the
Administrator  may  temporarily  deactivate  the  Mandatory  Fields  module  by  unchecking  "Activate  module".  The
mandatory fields already selected will remain for the subsequent reactivation.

For more information on the steps to follow in regards to imports, consult the Import Borrower, Creditor, and Employer
Data and Bulk import of Loans and Database configuration sections.
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Automatic data import via API (JSON and Excel files and Salesforce)

Mandatory fields are not managed when an import is done automatically via Automatic imports. This means that even if
fields are mandatory, the automatic import will ignore blank data. Only when a user accesses the Record will the message
appear indicating that data must be entered in that field.

It is up to the programmers of the upstream information system to ensure that if fields are mandatory in MLM, that these
fields are also mandatory in the other system and that the field values are included in the import file or Salesforce.

Global changes and Mandatory fields

Finally, when Global changes are made for a Record or for a Borrower in a mandatory field, a message in red will appear,
stating that the field is a mandatory field.

"Mandatory Field name" is a mandatory field. Please fill in this field.

Nevertheless, the user will  be able save other Records or Borrowers. He will  not be blocked. However, already existing
data cannot be erased (emptied) for a mandatory field, except if the mandatory field is linked to the loan, if the Record is
in "Draft" mode and the "Do not activate for Draft Records" option is checked. If these conditions are met, existing data
can be eliminated for a mandatory field.

   

Automatic / Overnight Tasks

Automatic tasks, also known as “Overnight tasks”, allow the system to perform certain operations which were done once
a  day  upon  launching  (running)  Margill  Loan  Manager  (MLM).  These  tasks,  such  as  the  calculation  of  daily  totals  and
production of alerts, for large databases, could add many minutes when launching MLM.

These  operations  can  be  programmed in  order  to  be  generated  outside  normal  business  hours  thus  eliminating  some
waiting  time.  Moreover,  it  is  possible  to  set  an  automatic  backup  of  the  MLM  data  at  1:00  AM,  for  example,  without
having the program running. The server or computer where MLM is installed must of course be on or in sleep mode and
the backup folder must be accessible.

Automatic  tasks  allow Alerts  and  automatic  emails  to  be  sent  to  the  Borrowers to  be  generated at  another  time than
overnight. They can even be programmed many times per day, as needed. This then:

 avoids the need to send emails in  the  middle  of  the  night  which can  be  lost  in  the  “mass”  of  emails  received
during the night by the borrowers.

 allows the notification of  a  MLM user that  the condition of  one of  the Alerts was met on that  same day.  This
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way, the user can immediately intervene instead of being advised only on the next day.

With  “MLM_Overnight_tasks.exe”  and  the  “Windows  Task  Manager”,  tasks  can  be  set  to  be  performed  in  the
background at the right time and with no need of human intervention.

Steps for setting automatic tasks:

1. Select tasks to be done in MLM via “MLM_Overnight_tasks.exe”

2. Schedule automatic tasks with the Windows “Task Manager”

o Particular task conditions

1.Select tasks to be performed in MLM via “MLM_Overnight_tasks.exe”

Go to Settings > System settings (Administrators) > General Settings. Click on "Automatic / Overnight Tasks".

In this window, the Administrator decides which tasks are to be accomplished.

Apart from the automatic backup, unchecked tasks in this window and/or unplanned in the Windows Task Manager
will be generated automatically, by default, every time MLM is launched.  Automatic backups can only be created with
this tool.

The “MLM_Overnight_tasks.exe” application can be launched automatically for one or more of the following tasks:

 Automatic backup

All MLM data (usually under MLM Data) will be saved. This is a backup that can become quite large eventually.
The complete software installation folder is NOT included in the backup. It will only be backed up if the DB folder
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is in this MLM installation folder.

If  the “Back up the DB folder only  (Database only)”  sub-option is  activated,  only  this  folder  will  be  backed-up
thus taking up less space. Other data not specifically included in the DB folder will be excluded.

In addition, the Administrator can decide on the number of automatic successive backups to be saved. 

Unless  otherwise  specified  in  the  “Data  and  Backup”  window  (Tools  >  Settings  >  System  settings
(Administrator)), the backup copies will be automatically saved in the “MLM_Automatic_backup” folder.

 Check EFT to date (Due Pmt --> Paid Pmt)

This  option  automatically  updates  Records  with  pre-authorized  payments  that  were  submitted  to  the  EFT
provider  via  the  “Pre-authorized  payments”  tool:  the  “Due  Pmt”  Line  status  is  changed  to  “Paid  Pmt”  (or  as
chosen by the Administrator in System settings > Electronic Funds Transfer).

 Verify the Credit Card expiration date

This tool is no longer available. This tool displays a message informing of the expiration of a Borrower's credit
card used in a Record. The message appears in a red exclamation mark in the Record Summary window.

 Recompute "To Date" data (Balances, Interest...)

These  calculations  can  be  generated  starting  at  midnight  in  order  to  be  already  updated  when  users  access
MLM. Many minutes of waiting can be avoided this way.

 Generate daily Alerts / Emails

Alerts and automatic emails (accessible via the Line status Alerts) can be generated during the night and/or one
or more times per day, as needed.

NOTE: In order for daily alerts and automatic emails to be generated whether OR NOT at the same time as the
other tasks, the “Generate Daily Alerts / Emails” box must be checked. When planning tasks in Windows, it will
be possible to set separate tasks at  different times and frequencies, as needed. Automatic emails will  only  be
sent for Active Records.

 Automatically change "Due Pmt - Unpaid" to Unpaid payment on scheduled payment date

A "Due Pmt - Unpaid" is a special Line status that can be used when à Borrower notifies the Creditor that he will not
be able to meet a payment at a later date but will be able to meet the next closer, upcoming payment(s).

For  example,  we  are  on  June  15  and  the  Borrower  informs  the  Creditor  that  the  August  1  payment  cannot  be
respected (end of employment for example) but that the funds will be available for the July 1 payment. 
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Ordinarily, upon learning this, we would like to change this future "Due pmt" to a "Unpaid Pmt" but since this Line
status  is  not  allowed after  a  "Due Pmt"  (only  before,  chronologically),  this  special  Line  status  "Due  Pmt  -  Unpaid"
resolves the issue since allowed after a "Due Pmt".

However, in order to avoid logical chronological problems, since "Due Pmt - Unpaid" is a "Due Pmt" type Line status
and is  not  allowed before a  "managed" payment ("Due pmt" changed to "Paid Pmt",  "Unpaid Pmt",  etc.)  this  tool
allows you to specify to which Line status the "Due Pmt -Unpaid" will be changed to automatically on its scheduled
date. It must become an Unpaid type Line status.

The change can only  take place if  no "Due Pmt" is  present before this  payment.  If  such a  Line  status  is  present,  a
warning will appear in the Main window (!).

The "Due Pmt - Unpaid" amount must = 0.00.

Once the payment is managed, the usual conditions for this Line status will apply such as automatic fees.

The  amount  in  the  "Expec.  Pmt"  column  will  ordinarily  be  the  payment  originally  scheduled  and  thus  should
automatically increase the Outstanding amount.

 Rebuild the indexes and compress data files every X days

Reindexing may be required following the loss or alteration of the index file. This loss or alteration can render the
application unusable, unstable or simply much slower than usual. Possible causes of loss or corruption of the index:
technical  problem (power outage...),  abnormal shutdown,  physical  removal  of  an  index  file.  Indexation sometimes
increase the database's speed.

With  this  option,  you  can automate the  reindexation process  which could  be  performed every week  for  example.
There is no need to reindex on a daily basis.

For the reindexing to run correctly overnight, it is imperative that all instances of MLM are closed. Please ensure
that all users have closed the software at the end of the day.

 Automatic reports

This  module  allows  the  configuration  of  reports  which  will  be  produced  automatically  with  the  Windows  Task
Scheduler at any frequency and at any time, usually outside business hours.

One can choose all  desired fields in the "Records List" report and/or the "Transactional report" (and other custom
reports created by the Margill team) and produce the reports for the relevant dates and in the preferred format. All
Records or specific Records from an Advanced query can be included. The reports (files) produced will  be saved to
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the specified location or emailed (or both).

These  reports  can  also  be  imported  by  third-party  systems  and  the  data  updated  in  these  systems  (accounting
software, ERP, etc.).

Multiple  reports  can  be  produced.  It  is  recommended to  run  these  reports  at  different  times  (thus  creating  more
than one Windows task) in order to reduce system overload and reduce a potential risk of error caused by too many
operations at the same time.

See > Automatic Reports section for steps on how to create reports that will be automatically generated and saved,
sent by email or by FTP (File Transfer Protocol) and update Salesforce data (Salesforce API).

In order for the report(s) to be produced, the REPORTS argument must be activated: REPORTS=1 or 2, 3, 4, etc. (See
Particular task conditions)

2. Schedule automatic tasks with the Windows “Task Manager”

The MLM_Overnight_tasks.exe file (application) included with the software must be launched automatically in order to
perform one or more of the chosen tasks described above in “Select the tasks to perform in MLM…”.

How to set and launch this application in Windows:

In the Windows File Manager, go to Control Panel > Administration Tools > Task Manager.

Click on “Create Basic Task…”:

Enter a name and a description for the task and click on “Next”.
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Select the frequency at which the task is to be accomplished and click “Next”.

Choose the start date, time and day(s) of the week at which the task is to be accomplished and click “Next”.
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Select the “Start a program” Action and click “Next”.

In the “Start a program” window, click on “Browse”.

Select the file named “MLM_Overnight_tasks.exe” located in the MLM installation folder. Click on “Open”.
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Once the file is chosen, click on “Next”.

Click on “Done”.

The task is now configured and will be started at the next planned time and date.

Particular task conditions

It  is  possible  to  set  several  automatic  tasks  with  different  frequencies  to  perform  particular  operations.  For  example,
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make a backup copy once a day after midnight without generating the automatic Alerts / Emails. Or generate only the
automatic Alerts / Emails at certain times of the day without doing the backup and without recomputing the totals.

It is possible to generate the tasks in four (4) modes with these execution settings.

Mode Settings Effect
General (None) All tasks checked in the "Maintenance and Automatic Tasks"

settings window will be generated without exception.
Alerts only AlertsOnly  Only  the  "Generate  daily  Alerts  /  Emails"  task  will  be

performed when this setting is configured.

Warning:  the  "Generate  daily  Alerts  /  Emails"  option  must
be activated in MLM for this setting to work. Simply adding
this argument is not sufficient.

Without alerts NO_Alerts All tasks checked in the overnight / automatic tasks settings
will be performed, except the Alerts / Emails.

Choice of reports REPORTS= When  this  setting  is  configured,  only  the  "Automatic
Reports" task will be done.

Add  a  unique  report  number  followed  by  a  semicolon  if
there are several reports to be generated.
Example: REPORTS=1;3;5;6

If several reports are required, it is recommended to launch
these  at  different  times  (therefore  create  more  than  one
Windows  task)  in  order  to  reduce  overloading  the  system
and  to  reduce  the  risk  of  potential  errors  caused  by  too
many operations being conducted at the same time.

The  argument  is  compulsory  for  the  report(s)  to  be
produced.

VoPay
Pre-validation EFT

VOPAY The  “Check  Submissions  progress”  button  on  the  EFT
Transmission  window  would  ordinarily  be  used  for  EFT
pre-validation.

On the other hand,  if  a  large batch of  EFT transactions are
simultaneously  sent  to  VoPay,  the  processing  time  may
become high for pre-validation. It  is  then possible to check
the  submission  progress  via  an  Overnight  Task.  Issues  will
then be reported in the Overnight Tasks log file.

This  Task  will  query  VoPay  for  the  transactions  status  and
these  will  be  updated  in  Margill  as  accepted  or  declined
EFTs.  Declined  transactions  will  then  be  reported  in  the
Overnight Tasks log file and a user will  need to contact the
Borrower to manage the payment.

See: Selecting and Submitting Payments in the EFT section.

In the following example, at 12:30 PM, each day, the “Generate daily Alerts / Emails” task will be performed. During the
night, at 1:00 AM, every day, the other automatic tasks that were chosen in the MLM settings will be performed:



Page 353

© Jurismedia Inc., 2007- 2023

In  order  to  add  the  “AlertsOnly”  or  “NO_Alerts”  conditions  to  a  task  in  the  Windows  Task  Manager,  simply  add  the
argument in the window for this purpose during the “Start a program” step:

To  add  "REPORTS="  to  a  task  in  the  Windows  Task  Scheduler,  simply  add  the  unique  Report  ID  to  be  generated
automatically in the Configuration window when you are at "Start a program":
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WARNING: the arguments must be written with the precise texts above in order to work.

Suggested scenario:

We would possibly want this:

1. Make a backup copy and calculate the totals once a day. This task can be performed after midnight.

2. Launch the Alerts and send automatic emails at  the start  of  the  work  day  (not  during  the  night).  This,  in  order  to
prevent emails (notifying borrowers of payments that will be collected in their bank accounts) from being lost in the
“mass” of emails received by the borrower overnight.

3. Perhaps, also, for new loans created during the day, that the automatic emails to the borrower be sent the same day
and not the next.

This way, three or four tasks would configured in Windows:

1.  At midnight with the argument No_Alerts

2.  At 7:00 A.M. with the argument AlertsOnly

3.  At 1:00 P.M. with the argument AlertsOnly

3 bis.  At 4:00 P.M. with the argument AlertsOnly

Unfortunately, the Windows Task Manager does not seem to allow, for daily tasks, to exclude running tasks over the
weekend. Consult the Web for more information about the Windows Task Manager.

Log of tasks performed

The "Open LOG" link (top right) allows the user to see the tasks completed and errors (in pink).
It is suggested to review this history occasionally especially to ensure backups have been completed.
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Automatic Reports

This module allows report configuration and automatic report production using the Windows Task Scheduler.

Automatic reports can be generated, usually outside working hours, for the "Record list" and "Transaction Report" (and
other custom reports created by the Margill Team), based on the relevant dates, in the format that suits you, including all
your Records or  certain Records from an Advanced query.  Reports  produced will  be  saved to  the  specified location or
emailed (or both).

Configuration:

In System Settings > Automatic and Overnight Tasks, click on the Automatic Reports button:

The following window will appear:

The  "ID"  column  corresponds  to  the  "argument"  used  when  managing  the  task  in  the  Windows  Task  Scheduler.  The
Report  column  corresponds  to  the  selected  report's  name  from  the  Record  List  or  from  the  Transaction  Report.  The
Description column will be used in the activity Log of the Overnight Tasks in order to identify the reports produced or not.
In  this  window, one can create /  modify or  delete (with the help of  the right-click button of  the mouse) an  Automatic
Report query.

Upon clicking on the "New" button, the Automatic Report Setup will appear:
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1. Identifier: The Report Identifier is automatically generated by MLM once the automatic report is produced. It will be
used as a rule in the Windows Task Scheduler like this: REPORT=1;3;5 (these three reports would be created although
it may be wiser to create separate tasks at different times to reduce possible machine saturation). See Automatic /
Overnight tasks section for more detail.

2. Type: The Type corresponds to the type of report to be selected for configuration. For now, it is possible to produce
the "Record List" or "Transaction Report". Choose between the two options in the drop-down menu.    

3. Name: Simply click on this button   to select a report from the list of all available reports. If the report template
has not yet been created, go to the Reports section and create the personalized report to meet your needs.    
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4. Description: This field will  be displayed as an identifier in addition to the ID number in the activity Log to indicate
whether the report was generated successfully or not.  

5. Dates:  Several choices are available for the period to be covered when the reports are produced.

Complete report: This is a report that covers from the Origination Date of the Record to the last line of the Payment
schedule.

From  the  Origination  Date  to  Current*  Date:  Will  cover  the  period  from  the  Record's  Origination  date  to  the
current* date according to the "Current Date Mode" selected between "Today end of  day" and "Yesterday end of
day".   

Last X days or months to Current* Date:  Entering "1" day, for example, will give the amounts and transactions for
the current date (or yesterday's date depending on the Today's Date Mode choice) and one day before the current
date (total of 2 days of data).   

Entering "6" days, will give the data of the current date plus the 6 previous days (total 7 days). 

Current*  Date  only  (0:00  to  midnight):  This  report  covers  the  period  between 0:00  to  midnight  according  to  the
"Current Date Mode" selected between "Today end of day" and "Yesterday end of day". 

Next X day(s), X day(s) after Current Date*: If you wish to produce a report with future dates, use this option. 

For example, you want to submit a report for each day of the week excluding weekend days so that your accounting
system can collect the daily due payments. The accounting system then sends to the bank for collection of upcoming
payments. Let's assume you need to send at least 48 hours before payment is actually due.        

If sent at the end of the day, you will need to set up two reports that would look like this: 

The Date Mode would be "Today, end of day" (if sent at 1:00 AM (the next day), then you must choose "Yesterday,
end of day"). 
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It must be set as "Next 1 day(s), 3 day(s) after Current Date" for the Monday to Thursday reports and for the Friday
report: "Next 3 day(s), 3 day(s) after the Current Date" since no report is sent on Saturday and for Sunday. 

- Monday's report, "Next 1 day(s), 3 days after Current Date" would send Thursday's payments. 
- Tuesday, the same report would send Friday's payments. 
-  Wednesday:  Saturday's  payments  (which  are  usually  taken  on  Monday  -  sometimes  on  Friday  depending  of  the
banking institution) 
- Thursday: Sunday's payments (usually taken on Monday)
-  Friday:  (separate  report)  "Next  3  day(s),  3  day(s)  after  Current  Date"  would  send  the  payments  for  Monday,
Tuesday and Wednesday. 
- Monday: Thursday's payments...
- And so on...

Another example: "Next 3 day(s),  0 day(s) after Current Date" would take the current day's transaction if  the date
method  was  "Today,  end  of  day".  If  the  Current  date  mode  was  "Yesterday,  end  of  day"  (therefore  a  report  that
would be produced at 1:00 the next morning), the system would retrieve yesterday's transactions as well as those at
1:00 AM (day of the automatic production of the report) and next-day transactions.     

Current  Date Mode:  Choose between "Today end of  day"  and  "Yesterday end of  day",  according to  the  time you
wish to launch the report production via the Automatic Tasks. Today's transactions and interest are always included
except  when  the  current  date  is  the  last  line  of  the  Record  summary,  in  which  case  the  current  date's  interest  is
always excluded.   

6. "Include  all  Records  selected  no  matter  dates"  option:   Usually,  Records  that  start  after  the  report  end  date  or
which  are  finished  before  the  report  start  date  (payment  date  of  the  last  line  of  the  Payment  schedule)  are  not
included in the final  results.  By checking this  option,  all  selected Records will  be included in the results  even if  no
specific data is available for the reporting period.

7. Destination  Folder:   Upon  clicking  on  ,  select  where  the  report  will  be  saved  after  its  production  via  the
Overnight  Tasks.  Warning:  select  a  location accessible to  the  machine that  runs  the  Overnight  Tasks.  In  the  Cloud
version, this option is not available - use the send by Email option. 

8. Name and format: Enter the file name that will be generated and choose a format for that file. If the "Text" or "CSV"

format is chosen, click on this button  in order to specify field separators and other formats. 

9. File saving options: Three options are available: 1) the existing report is replaced each time it is regenerated via the
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Overnight Tasks.  Make sure to close the report before the Overnight Tasks generate the next report  otherwise an
error will occur and the report will not be saved. 2) the existing report is kept and a suffix of up to 6 digits is added to
the new file name, or 3) the existing report is kept and a suffix containing the date in  the desired format selected
from the scroll menu is added to the new file name.  

10. Records : For reports generated via the Overnight Tasks, it is possible to select "All Records" or select an Advanced

Query by clicking on  in order to select only the desired Records.

11. Button :  The "Test" button is an efficient validation tool to verify that the report to be generated
via the Overnight Tasks corresponds to your needs. Upon clicking on "Test" button, the report/file will be generated
exactly  as  it  will  be  when  launched  with  the  Windows  Task  Scheduler  (same  names,  suffixes,  formats,  Record
selection,  fields,  dates,etc.).If  one  or  more  emails  are  included  in  the  “Email”  tab,  the  report  will  be  sent  to  the
recipients.  Upon clicking on the “Test” button,  it  will  be possible to view the report created and validate with  the
recipients that it meets expectations.

12. Export  to  Salesforce:  Upon  checking  this  box,  no  report  will  be  produced  via  the  Overnight  Tasks,  but  rather  an
export of the data contained in the report to Salesforce will be performed. In order for this option to be available, it
is  necessary  to  create  a  Record  List  report  and  include  the  mapping  to  SF.  To  find  out  how,  see  the  Salesforce
Connection API section.

IMPORTANT: ALWAYS TEST THE RESULTS CAREFULLY OVER A FEW REPORTS!

Sending reports via Email:

The  "Send  to"  tab  allows  the  file  to  be  sent  by  Email.  Sending  emails  must  be  configured  in  Tools  >  Settings  >  Email
Connection. The report will be sent by the "Default Email" regardless of who programmed the Automatic report.

Under the "Send to" tab first choose the Email Template from the pull down list. To learn more about this, see Reports >
Merge / Email /SMS Template. 

By clicking on , a window will show a list of all available Email templates:
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Then enter the recipients’ emails. The first on the list will  be the recipient and the following will  receive the email as a

carbon copy (Cc). To remove an address from the list, click on .

Reports sent via FTP (File Transfer Protocol)

The report can also be placed automatically in a folder on a FTP server. For an FTP server, still under the "Send to" tab,
"FTP Server" section, check the '"Move a copy to an FTP Server"



Page 361

© Jurismedia Inc., 2007- 2023

Using the "New" button, configure the FTP server and test the connection using the “Test connection” button:

For each report configured as an Overnight task, it is possible to choose from the drop-down list the "Server name" and
the FTP folder in which to store the copy of the report.

Other important explanations about these Reports:

IMPORTANT: If the payment schedule is ended before the automatic report production date, the data produced for the
Current Date will not change even over time, because no interest is calculated after the last line of the Payment schedule.

If the "Date - report End Date" field is included in the report produced, and the end date is the current date, the date in
the report will  be the current date at  Midnight and not  the next day's  date  at  0:00 in  the  morning,  unlike  the  normal
Record List report.

For example, for a "Current Date only" report, if it's July 28, the "Start Date of Report" will be 07/28 and the "End Date of
Report" will also be 07/28 but in reality, it is at midnight which does not follow Margill's usual standard whereby the date
returns transactions at the start of the day and not at the end of the day. 

Report example:

The accounting technician wishes to make collection calls every Wednesday. In order to save time, he asked the system
Administrator to  schedule an  Overnight  task  specifically  for  him with  the  report  he  was already using  called "Overdue
Amounts".  The  selected  Records  to  produce  the  report  are  those  from  an  Advanced  query  which  only  selects  Active
Records after 2016 (for examples sakes... you can create the query you want).
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Reports are saved every week in Excel format and are named "Overdue YYMMDD", and are added to the "Clients to be
contacted" folder. Data included in the report cover the period from the previous Wednesday to Tuesday end of day.

The system Administrator  will  plan  the  task  under  Windows  with  the  REPORTS=6 argument  which  corresponds  to  the
Report Identifier:
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In order for the report(s) to be produced, the REPORTS argument must be activated: REPORTS=1 or 2, 3, 4, etc. (See
Particular task conditions)

   

Personalized Standard Fields

This module allows Margill Administrators to modify the name of some standard Margill Loan Manager (MLM) fields and/
or grey out fields if they are not to be used. This configuration applies throughout the application.

Go to  Tools  >  Settings  >  System Settings  (Admin...)  tab.  You  simply  need  to  enter  the  personalized  name you  wish  to
have, which will replace the original name in the software for all users. To grey out a field in order to prohibit users from
entering information, simply select "Grey out".

In the example below, the General tab under the Data window is customized:
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As well as the Borrower file:

These changes should be reflected in most windows (imports, etc.) but in some cases, the original name may appear.

   

Custom Fields

See Custom fields in the Getting Started chapter.

   

Scroll menus - Record Status - Record Type

Scroll menus allow you to input only preset standardized data as defined by the MLM Administrator for many fields: 

 Custom Record Statuses
 Record Types
 City, State/Province and Country (Borrower, Creditor and Employer windows) 
 Grace period (in days)(Record window: Advanced)

 All Custom fields: Data, Borrower and Creditor windows

Go to Tools > Settings > System settings (Administrators) > Field Scroll Menus.
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The window below will appear allowing you to choose whether the fields are free text (Drop-down menu unchecked) or a
scroll (also called drop-down) menu. Depending of course on the context, free-text fields are usually not recommended
since they lead to less uniform data. 

For all drop-down menus (except for Record Status), it is highly recommended to leave the default (therefore the value
that will be the default in that field) empty unless an actual value is desired. Thus, the first value of the menu would be
empty and the Default box would be checked:

This is suggested so that a false value is not automatically entered. If at some point the value was always "ABC", then this
choice  could  be  the  default.  With  changing  needs,  when  ABC  is  no  longer  the  only  choice,  the  empty  default  would
replace ABC.
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Custom Record Statuses

Go to Settings > Tools > System settings (Administrators) > Field Scroll Menus.

Upon clicking on the "Custom Record Statuses" link (in blue), this window will appear allowing you to add one or more
custom Record  Statuses  and  also  giving  you  the  possibility  to  modify  the  display  order  for  the  Statuses  in  the  "Data"
window.

You cannot delete the standard MLM Record Statuses but you can hide some and reorganize with the help of the blue
side arrows:

You can hide certain Statuses (except "Draft", "Active", "Bad Debt" and "Archived") if they are not currently used in MLM.
  That is:

 In the Data window, under the Data tab, if no Record is assigned the Record Status in question: 

 In the Data window, under the Data tab, if no User uses it as default or profile in the Data window:
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 In the User Management window, if no user has the constraint of not being able to change the Record Status:

In order to add your custom Record Statuses, click on the first empty line and type in the new Status. 
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Up to seven (7) custom Statuses can be added, for a total of fourteen (14). 

It is possible to assign French names by clicking on the "Display French names" option. When opening MLM in French, the
Statuses will show in French.

You  can  reorganize  the  Statuses  with  the  help  of  the  side  blue  arrows,  hide  or  delete  certain  Statuses  by  selecting
different options:

Do not  forget that  several reports are produced and some data imports or  data  updates  are  allowed only  for  "Active"
Records.

IMPORTANT: The purpose of the module is to allow exceptions to the proposed Statuses. The simple fact of creating a
Record  Status  and  renaming  it  to  "Active  2"  for  example,  does  not  give  Records  that  have  this  Status  the  "Active"
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status. An "Active 2" Record is not an "Active" Record according to MLM, but a new "Active 2" Status.

Record Types

To  set  the  loan  "Type"  (appears  under  the  General  tab  in  the  Data  window),  again  in  the  Scroll  menu  window,  check
"Record Type" (if not checked, the field will be a text field without a menu - not recommended) and then add the Record
Types:

We suggest to place the most common Types first or to order them alphabetically.

Province / State - Country - Grace Date

If  your  company  operates  in  several  states  or  provinces  or  in  one  or  many  countries,  it  may  be  useful  to  create
drop-down menus for these fields. The "State/Province" and "Country" (in the Borrower and Creditor windows) can have
drop-down menus and defaults.

The "Grace Period" (in the Advanced window) can also be in the form of a drop-down menu and include a default value.

Custom fields

Custom Fields are divided into 2 types of fields: "1 to 9" and "Unlimited in table format". This is historical since Fields 1 to
9 had been created before the Unlimited fields and so we are "stuck" with Fields 1 to 9...

For the nine (9) custom fields, standard or scroll, associated to the Borrower, Creditor or Record. Go to Tools > Settings >
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System settings (Administrator) > Custom Fields > select the desired tab ("Borrower", "Creditor" or "Record").

For  the  Unlimited  Custom  fields  (Table  format),  standard  or  scroll,  associated  to  the  Borrower,  the  Creditor  or  the
Record. Go to Tools > Settings > System settings (Administrator) >  Custom Fields  >  select  the  desired tab  ("Borrower",
"Creditor" or "Record") > select the Unlimited fields (Table format) tab.

Types of scroll menus

All the custom fields allow the creation of various types of scroll menus. The most common and the one we suggest, is
the text format that allows for all types of characters (alphabetical, numerical or other). 

However,  the  disadvantage  may  lie  when  exporting  MLM  data  to  third-party  software.  For  example,  a  monetary  or
numerical data element in a text field may not be properly interpreted by the other application. 
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The scroll menus "Type", "Prov/State" and "Country" are all text fields.

In  the  "Advanced" window,  the  scroll  menu for  "Grace  Period"  is  a  numerical  field  to  preset  the  grace  period  for  late
payments (for example, 10, 30, 45, 60 days).

Field content entered manually

Once the scroll menu type is chosen (Menu (Text), Menu (Numerical) or other) the  button will appear to the right.

By pressing the arrow, the following window will allow you to enter the desired data (or elements):

If it is not mandatory to enter data in a given field, it is suggested to leave the first field empty which will be the default
choice (see example below).
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If a choice is mandatory, then it is not necessary to leave a blank field, but it is required to define a default choice. In the
example  below,  the  "Central"  element  is  the  default  choice.   We  also  could  have  created  a  variable  called  "Other"  to
manage exceptions.

Field content imported via Excel sheet

Data can be entered in the drop-down menu from a spreadsheet. This is particularly useful when the scroll menu includes
dozens or even hundreds of values.

This tool allows you to add new data to a drop-down menu of a custom field via an Excel spreadsheet (.xls or .xlsx). The
worksheet should have only one column WITHOUT a header (the import starts at the first row - cell A1) and each value
should be entered in a separate row in column A. An empty cell will always be ignored. Any other data than column A will
be ignored.
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Directly in this window (without using the spreadsheet), it is suggested to first create an empty (no Description) one-line
drop-down menu. This empty choice should be the default (you must check "Default"). Then, use the Excel button to add
the new data.

Data  to  be  entered  must  correspond  to  the  data  format  (percentage,  number,  monetary  value  (no  currency  sign
required) or whole number). Text format fields can accommodate almost any type of content. The Date format cannot be
entered by this tool.

WARNING: the format type IS NOT validated before the import. If a letter is entered in a monetary value, for example,
the data will be 0.00. Be very careful in this regard.

If you wish to redo a menu (add or modify), you could select all the existing data with "CTRL A" and then delete all data -
it is suggested though to leave the Default empty. You can import again via a spreadsheet.

The data order can also be changed with the arrows on the right. An irritant in previous
versions was that  a  new value in  the  menu was always  added at  the  end of  the  menu
and therefore an alphabetical or chronological order could not be kept. The option thus
eliminates this irritant without having to recreate or to reimport the data. 

Adding, editing and deleting items
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Once the  elements are  defined,  it  is  always  possible  for  the  MLM  Administrator  to  add  new data  or  modify  or  delete
existing data.

If you change or delete existing data and a Record is already using this data, the following message will appear offering
you three choices:

1. Delete all data from all Records (not recommended due to loss of information). 
2. The data will be kept but must then be modified Record by Record and corrected later (suggested). 
3. The desired change will not be made, therefore returning you to the original data.

In a Record, it could happen that a field contains data that is not in the new scroll menu. This can happen especially when
you  had  not  yet  used  the  scroll  menus,  but  had  data  in  this  field  -  for  example,  your  scroll  menu  "Region"  contains
"Central"  but  you  had  previously  entered  "Centrall'  with  an  extra  "l"  at  the  end  -  a  correction  would  be  required  to
standardize the data). In the example below, "50000" was entered in the field "Region" but "50000" is not an appropriate
choice.

"Ignore"  will  keep  the  non  compliant  data.  It  is  then  suggested  to  add  this  value  to  the  scroll  menu  (if  it  is  a  valid
choice)(can be done by a MLM Administrator).

"Change" will allow you to return to the data and to choose from the scroll menu. 

Existing Records and default choices

When a new scroll menu is added and a default choice is entered, the default choice will not be changed in the existing
Records. It will be entered only for the new Records created.

If a field is empty and a default choice is defined, MLM will show " ""is not found in the scroll menu...". You must then
change this choice or add an empty value in the scroll menu (see above).
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Adding carriage returns in scroll menus

It  is  possible  in  the  text-only  format  scroll  menus,  to  insert  very  long  texts  (see  Appendix  1  -  Field  Characteristics  and
Lengths) that can also include paragraphs.

Simply copy your long text and paste it into the scroll menu. MLM automatically changes the carriage return special code
(called dual "pipe": ||) which indicates the location of the carriage return. Thus, the long text will appear on a single line
when selected in the scroll menu.

Using Record Custom Fields as Display filters

See Display Filters. Up to three (3) custom fields (Table format) related to the Loan and that include a scroll menu can be
used as display filters in the Record Summary window.

   

Line Payment Statuses

See  Line  status,  section  Line  status  name  change,  choice  and  order  in  the  Payment  schedule  (amortization,  payment
schedule) chapter.

   

Custom Column Titles

This feature allows the customization of the six (6) "Column Fee" names, as well as the nine (9) "Custom Column" names.
Custom columns are useful in order to enter additional notes or complementary transactions, such as Escrow (Insurance
and Tax).

Important:  Rename  Column  Fees  in  a  meaningful  manner  in  order  to  avoid  operational
conflicts. Since Column Fees added automatically can conflict with fees added manually, it is
important to organize these Fees very well. 
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It  is  recommended to reserve the use of  some Column Fees strictly  for  automatic  addition
and others strictly for manual Fees. The word "AUTO" could even be added in the name for
greater safety.

A  Column Fee  should  never  be  automatic  and manual.  Otherwise,  automatic  Column  Fees
could  erase  fees  inserted  manually  without  the  user  knowing  this  was  done.  MLM  gives
priority to the last data entered and overwrites previous operations. 

Refer to Fees, Insurance and Taxes section (Margill Loan Manager Calculations > How to do...), to
learn more about Column Fees.

By default, "Column Fees" are named: "Column Fees 1", "Column Fees 2", "Column Fees 3", etc. 

"Custom Columns"  are  named:  "Custom Column  1-2-3  (Monetary)",  "Custom  Column  1-2-3  (Numerical)"  and  "Custom
Column 1-2-3 (Text)".

To rename these columns, in  the menu Tools > Settings,  under tab "System Settings (Administrator)" click on "Custom
Column Titles".

Enter the desired name in the "Custom Title" column for Column Fees 1 to 6 and click on "Save" . If needed, also enter
the Custom Columns titles and click "Save" and then "Exit".

For those using the system in both English and French, it is possible to display and modify simultaneously the English and
French titles of all custom columns, without having to go through the User settings of the software. Simply check the box
"Show French Titles" and an additional column will appear so that you can make your changes in the other language. 
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Example:

The modified column title names via this setting will not be updated automatically for reports already created. The user
will need to modify the reports and change the names manually.

You  can  activate  and  create  drop-down  menus  with  the  custom  columns.  By  checking  the  "Enable  drop-down  menu"
option, a new column will appear in the table. 

Upon clicking on the arrows, a window will  appear allowing the Administrator to choose the drop-down menu options
according  to  column  format  (Money,  Numerical  or  Text).  It  is  recommended  to  add  an  empty  line  (0,  in  the  case  of
Money and Numerical types), in order to make it blank again if a user was to choose the wrong Payment schedule cell.

To delete a menu, simply delete all  entries from the drop-down menu by selecting each line,  one by one,  and then by
clicking on "Delete".
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The  pale  green  background  below  the  button  indicates  that  a  drop-down  menu  exists  for  that  column.  If  there  is  no
drop-down  menu  for  a  column,  the  user  will  be  able  to  enter  the  desired  value,  without  constraint,  in  the  Payment
schedule.

NOTE:

 If data already exist in the Payment schedule, before a drop-down menu is created, this data will remain saved and
the software will not warn you if the column data is not part of the drop-down menu.
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Value of 999,999,999.99 was present before the creation of the drop-down menu

 If a value in the drop-down menu is modified by another, this will have no effect in the Payment schedules. The old
value  will  remain.  For  example  the  3.75  value  above  was  changed  by  the  Administrator  to  3.33  in  the  menu  (in
System Settings). If 3.75 had been chosen in a cell for a Record, the change of menu to 3.33 will have no effect on the
value originally entered for that Record (so 3.75 does not become 3.33. Ideally this would be changed manually to
3.33 since 3.75 would no longer be a valid amount, theoretically). 

 The ALT+K shortcut that copies the Payment amount to the custom column when the Line status is "Due Pmt" will
take priority over the drop-down menu even though this is not suggested. No warning will be given.

   

Sensitive Data Module

The purpose of this module is to allow only the ADMIN User, other Administrators and/or Power Users to view sensitive
data such as the Social  Security  Number  (SIN in  Canada,  NI  in  the  UK)  as  well  as  bank  account  information (when the
banking  data  is  entered  in  the  EFT  module).  The  module  does  not  block  Users  from  changing  the  sensitive  data,  only
viewing and reporting it. It restricts display of sensitive information based on User type, not User name. For example, if
only Administrators are allowed to view data, none of the normal “Users” can see the data. 

Note:  The  “Social  Sec.”  field  (and  others)  can  be  renamed  in  Tools  >  Settings  >  System  Settings  (Administrator)  >
Personalized Standard Fields.

Only the ADMIN User can change the preferences in this module.  

All  Users  with  “Write”  permissions  can  enter  and  delete  sensitive  data,  but  once  saved,  they  can  only  see  the  data
partially, most characters being replaced by asterisks (***). 

 The “Characters displayed” option will display as such:

- 1234*******
- *******6789
- 12*******89
- 1234*****6789
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- 1*********9

The Sensitive Data module also applies to the The “List of applications” module. If the User approving or refusing loans
needs to view sensitive data, he will need a User level that allows such.

Only the ADMIN is authorized to make changes in this section. Changes will be effective upon the next MLM launch.

To  activate  the  module  and  to  modify  the  sensitive  data  for  desired  users,  during  the  production  of  reports,  select
"Activate for..." either the SSn or the bank account. Even if one of the Borrower Unique ID fields was renamed to "SSN" or
other, these fields are not included as sensitive data.

In the "Characters displayed" section, select one of the five options:

 Display only first 4
 Display only last 4 
 Display first 2 and last 2
 Display first 4 and last 4
 Display first and last

The "Asterisk (***) displayed" section offers the possibility to show the real hidden characters by replacing them with an
asterisk. Or you can select "Always display fixed number" which allows to standardize the number of asterisks displayed
to hide the sensitive data. The scroll menu offers the possibilité to choose from 1 to 10 asterisks.  For example:
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This option combined with "Display first 2 and last 2" option would display the SSN "123 456 789" like this: "12*89".

Sensitive  data  reporting  is  also  included  in  the  module.  The  ADMIN  User  can  decide  which  User
levels can view sensitive data in the reports that contain sensitive fields.

The "Users that can view full sensitive data (outside reports)" option allows to select which users can display the sensitive
data on screen. You can check one of more options or select none.

 ADMIN user
 All MLM Administrators
 All Power Users

The "Users that can produce reports displaying sensitive data" section allows selecting, or  not,  users that  can produce
reports with fully displayed sensitive data, without asterisks. Check all required options or none, from:

 ADMIN user
 All MLM Administrators
 All Power users
 All users

Credit  reporting  (Metro  2)  is  also  considered  a  report.  If  the  option  is  checked  for  the  User  level
producing the Credit report, the SSN will include asterisks which will be refused by the agencies. The
report  should  thus  be  produced  by  a  User  level  with  the  rights  to  produce  reports  displaying
sensitive data.

If a User does not have the right to display sensitive data in the report, the data will still be reported
but  with  asterisks.  Normal  Users  can  nevertheless  create  report  templates  that  include  sensitive
data but when the report is produced, it will include some asterisks.

In  order  for  “Overnight”  (automatic)  reports  to  display  the  sensitive  data,  the  special  permission
must be given in the module, via the "Display full  sensitive data in Overnight (Automatic) reports"
option.

Warning: A user testing automatic reports in the "Automatic reports settings" window, who cannot see the sensitive data
will  not  be  able  to  see  these  during  testing.  But  when  automatically  producing  the  report  via  the  Windows  Task
Scheduler, the sensitive data will be fully displayed.
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Internet Connection

Accessible through Tools,  Settings,  various options are  available  for  a  seamless access  by  Margill  Loan Manager  to  the
Internet.

Ordinarily, port 80 allows access to the Internet. If the connection is not possible with this choice, either chose another
port or use the Proxy server option.

The connection may be tested with "Test connection".

This option is generally used only by the network administrator.
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Email Connection

Many connection options are available to secure a link between Margill Loan Manager and one or more email addresses.
They are accessible through Tools > Connection Settings. 

SMTP Settings:

The following window will  open. Enter the SMTP Server Name, Username, Password and the Port number. This data is
usually known by the IT manager or can be provided by you Internet Service Provider (ISP). Each user can configure his
MLM for sending emails.

Port 25 is the Port number by default. If the connection does not work, you will have to choose another Port number or
use a "Proxy" server.

The connection can be tested by clicking on "Test my connection".

"SMTP Server Name" examples:

 smtp.gmail.com (use Gmail API instead - see below)
 smtp-mail.outlook.com
 your corporate smtp

"SMTP Username" examples. It is usually not required to add the domain name (@domain.com):

 yourname
 support

Ports examples :
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 25 (by default)
 465

This configuration is generally set up by a network technician since there are many technical options that may apply in
order to connect to your email service provider's server (secure connection via TLS, Operating  mode for IMAP, POP or
multi-platform). 

Gmail API Setting (OAuth 2.0): 

This  is  a  connection with  a  Gmail  account  made by  the  security  protocol  OAuth 2.0.  This  API  is  also  functional  if  your
Gmail is used with your own domain name (for example "@margill.com") with Google Workspace.

The requested permissions are used to retrieve an encrypted cookie from Google in order to read email addresses and to
connect to the Gmail accounts for sending emails on your behalf.

By choosing the "Gmai APIl", the image with "Sign in with Google" will appear. The settings will be done for the selected
user from the drop-down menu at the top of the window. See example below for Admin:

The Internet  browser  will  open and you  will  be  directed to  Google in  order  to  select  an  account  to  access  the  Margill
application.
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Click on the desired account and in the next window Select "Allow" the permission to "Send email on your behalf".

Once the configuration is completed and successful, this message will appear in your browser. Repeat steps for all MLM
users.
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Your Internet Service Provider might impose a limit on the number of emails sent in a short period of time, especially
when sending mass emails with the Document Merge tool. Check with your ISP.

If a limit is indeed imposed, enter a delay in seconds or in fractions of seconds in the "Delay in sec." field at the bottom of
the "Connection Settings" window (Tools > Settings > System Settings (Administrators) > Connection Settings). The emails
will then be sent at intervals. You may need to try many delay times to find the shortest one (to reduce the overall time it
takes to send the emails).

The sender's Email must be entered but the copied email is optional (usually the sender's Email). Be careful, if you send
hundreds or thousands of emails, receiving a copy of all of these is not required or desirable. A copy could be sent only at
the first mailing in order to make sure that all is well set up.

A connection test should be performed by clicking "Test my connection" and by entering an  email  address  (preferably
one outside of your organization in order to be sure that emails are delivered to your clients). An email will  be sent to
that address.

If the connection cannot be established, an error message will appear that will usually allow the technician to identify the
configuration issue. If the test is successful, a window will confirm so and the email address used for the test will receive a
short message in its Inbox.

The "Default Email" is available in order to establish the default email address (for example: info@yourcompany.com or
noreply@yourcompany.com) used to send the automatic emails generated by the Line status Alerts to Borrowers. If no
default email is set, the Alerts sent by email module will not work.

To find out more about the "Test in bulk" and its functions, consult the Email connection (Batch emails) section.

   

FolioMedian (SMS) Connection

It is possible to automatically send Alerts via SMS to Borrowers and to send them SMS texts manually via the Main Margill
Loan Manager (MLM) window. To do so, you must sign-up to the service offered by the Margill partner, SMS FolioMedian
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, a Canadian company offering SMS services in dozens of countries in North American, Europe, Africa, Asia and Australia.
Monthly fees and volume-based fees apply. 

Once the connection information has been obtained from FolioMedian, go to System Settings (Administrators) and click
on "FolioMedian Connection (SMS)". The window below will appear. Enable the API, then enter the information provided
by FolioMedian.

The URL provided by FolioMedia will include your company name and must end with "api/send".

In order to validate the connection, enter the input field provided for this purpose, a valid mobile number, starting with
the number 1 followed by the 10 digits  of  the  number  (North  America number),  without  spaces or  parentheses.  After
clicking on "Test the connection", a "Test" message will be sent to the registered mobile number. A confirmation message
will confirm that everything is correctly configured and ready to be used with the Alerts or for sending SMSs directly via
the Main window. Consult your FolioMedian Dashboard in order to consult the SMSs sent via MLM.

Once the module is activated, the SMS options will be available for the Alerts settings.  Consult Tools > Alerts section to
find out more about automatic Alerts sent by SMS.

For  sending  out  SMS  texts  manually,  you  can  send  personalized  SMS  in  bulk  via  the  Main  window  or  directly  from  a
Record. See Emails and SMS - Sending automatically or in batch with Templates.

   

Data and Backups

See Backup (data)

   

Column Fees: Automatic

Column Fees can be added automatically in a Payment schedule when a change occurs in a Line status.

Automatic Column Fees are not present when the Payment schedule is created but are ADDED when a change occurs in a
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Line status. For example, the Administrator could create a rule by which a returned check will generate a 15,00 fee. Based
on this  rule,  this  fee will  only  be added if  the Line status is  changed from Due Pmt (or  other)  to "Returned Check" (or
other).  These  fees  are  exceptional  as  opposed  to  regular  fees  such  as  Column  fees  at  every  payment  (for  example,  a
monthly fee on top of the normal interest which could be added when initially setting up the loan).

Rules can be more precise by  taking  into  account  the  Record Type or  a  Custom field.  For  example,  fees for  an  unpaid
payment for a Personal loan could be 15.00 while for a Commercial loan, these could be 25.00. 

You can also create a fee rule based on the number of days a payment is late (as compared to the scheduled or expected
payment date).

Column fees  are  much  more  sophisticated  than  Line  fees  to  generate  reports  and  are  usually  used  when  regular  fees
(insurance and taxes)  are  taken  into  account  in  the  payment.  When  a  payment  is  made  (Paid),  these  fees  are  paid  in
Payment type Line statuses. For accounting purposes, they are paid before interest and principal.

There are also automatically RECOMPUTED Column Fees. 

To learn more about the various fee types, refer to Fees, Insurance and Taxes (Margill Loan Manager Calculations >
How to do...).

   

Suggested maximum number of days between ''Pmt Date'' and ''Pmt Due Date''

This option allows you to specify (for information purposes) the maximum number of days between the date in the "Pmt
Date" column and the date in the "Pmt Due Date" column.

Enter the suggested maximum number of days between the payment date and the payment due date in the cell. Thirty
(30) days is suggested since the outstanding amounts of less than 30 days are considered current. If this field is blank or
at 0, no validation will take place.

When a payment is late, Margill allows for two methods of posting:

1. Using a "Late" "Payment" type Line status (and the "Paid Pmt (x)" Line statuses which can be named as desired) while
specifying the "Pmt Due Date" in the column.

2. If a payment is significantly late, it  is strongly suggested to change the Line status to "Unpaid Pmt" and to insert a
new line (Add. Pmt or Compensatory Pmt) when the payment is actually made, taking care to properly manage the
outstanding amount using the "Expec. Pmt" column.

This  second  method  is  suggested  since  an  outstanding  amount  will  appear,  allowing  to  calculate  the  age  of  overdue
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accounts.

The present option allows you to specify (for information purposes) the maximum number of days between the date in
the "Pmt Date" column and the date in the "Pmt Due Date" column. If method 1 is used, and a date is entered in "Pmt
Date", the user will be warned if the two dates differ by more than the number of days indicated and method 2 above
will be suggested to the user.

See also Ageing of accounts.

   

Attached Files, maximum size (MB)

The  Margill  Administrator  can  specify  the  maximum  file  size  for  attached  documents.  If  this  field  is  empty,  or  0,  no
attached documents will be allowed. 

   

Allow to change the ''Expected Payment'' amount when Line status is ''Due
Payment''

When the "Allow to change the "Expected Payment" amount when Line status is "Due Payment"" option is  checked in
the  System  Settings  (Administrators)  window,  users  will  be  able  to  change  the  amount  in  "Expected  Pmt"  when  Line
status  is  "Due  Pmt".  This  is  useful  when  the  Creditor  and  the  Borrower  agree  in  advance  on  a  higher  (or  lower)  next
payment. Thus, the outstanding amount will be properly calculated when the true payment is made.

The amount  entered in  the  "Expected  Pmt"  column  is  ordinarily  based  on  the  amount  of  the  payment  when  the  Line
status is "Due Pmt" (or other "Due Payment" type Line statuses).
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Warning! If the Administrator decides to deactivate the option, the software will automatically search all the lines where
the Line status is "Due Pmt" and the amounts in the "Expected Pmt" column will be changed to the amount entered in
the "Pmt" column, even if the amount was changed manually.

In order to be able to perform this change, all the Records must be closed by all users.

Click on "Save" at the bottom right of the "System Settings" window to complete the deactivation of this option.

   

Number of Decimals displayed (Interest rate)

All interest calculations are done with six (6) decimal places in the interest rate. Before version 4.3, all calculations were
performed with a maximum of 4 decimal places.

The Margill Administrator may decide to display more or fewer decimals with this option:

If a greater number of decimals is used and the Administrator then decides to reduce the number of decimals displayed,
the calculation will nevertheless still be performed with 6 decimal places, but the displayed interest rate will be rounded
up or down.

PS: Interest rates entered as Custom fields can only accept four (4) decimal places.

   

Unmanaged Records

Users can consult, with one click, the "Unmanaged Records" directly from the Main window.



Page 391

© Jurismedia Inc., 2007- 2023

An unmanaged Record contains the "Due Pmt" Line status (or one of the other four "Due Pmt" type Line statuses whose
names can be customized) at the current date or on the day before the current date (yesterday). A "Due Pmt" in the past
must always be changed to a Line status such as "Paid Pmt", "Unpaid Pmt", "Late Pmt", etc. It then becomes "managed"
and up to date.

This option, available at the bottom of the Main window as a tab , will display the number of
Active Records which have a "Due Pmt" type Line status at the current date (if the number of days entered = 0) or X days
before the current date when payment management is not done on a daily basis.

When  the   button  appears  in  red/pink,  not  in  grey,  you  should  immediately  panic  (no  need  to
panic, a little humor in this not so captivating document is good not only for the reader, but for the author as well ;-). You
should check which Records have not been updated and see if you can update them. Ideally, no end-of-month reporting
should  be  done until  all  Records  are  managed.  It  is  also  strongly  suggested  not  to  accustom your  users  to  seeing  this
button in red/pink since the color indicates an abnormal situation. It  is then suggested to increase the number of days
allowed for managing late "Due Payments".

If payment management is done once a week, you would enter 7 so that you are not notified of the "Due Pmt" until  7
days after the expected date. If the first "Due Pmt" of the Payment schedule is May 19, the user will not see this Record
in alert mode until May 26.

To update the Records to be "managed", use the Payment update ("Post Payments").

o Only the Records displayed in the Main window will be displayed. The total number of unmanaged Active
Records is still indicated in this window (total number may differ when certain users do not have the rights
to consult all of the Records, but only their own Records).

o When a Record contains several unmanaged payments, only the first payment (oldest) is displayed.
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In the following example, there are ten (10) Records displayed in the Main window and unmanaged. For your
information, MLM still displays, at the bottom of the window, the total number of Unmanaged Active Records
from the entire database. In this case, there are forty-eight (48) Unmanaged Active Records.

To set up this application, go to Tools > Settings > System settings (Administrator) tab.

Simply enter the number of days after which unmanaged Records are to be displayed in the application.  If  you do not
want to use this application, simply check the "Do not display this option" box. If this is the case, all MLM users will not

have access to the   button in the Main window.

   

Blocking Historical Transaction Changes

This  option  allows Margill  Administrators  to  define the  number  of  days  for  which transactions may  be  changed  in  the
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payment schedule (Payment schedule). Payment lines will become grey, thus in read-only mode for all users.

The time period will usually be 35 days or so to allow changes for the past month. To allow for more flexibility, increase
the number of days.

If the number of days is set to zero (0), the module becomes deactivated. A Margill Administrator can thus temporarily
deactivate the module to allow users to make special changes in the past if required.

The Administrator can also provide rights to some users to bypass the blocking of historic transactions. To find out more
about this option, consult the Getting started > Administrator and Users section.

When the module is activated, any calculation setting or field that can affect the past calculations or transactions will be
blocked. These include:  Advanced settings, the original Principal amount and interest rate changes in the read-only time
period. Notes, custom fields, Alerts and other data not linked to the actual Payment schedule are not blocked.

In the following example, lines 1 to 4 are gray, which makes it impossible to modify or select them. If the Administrator
grants  the  modification  of  transactions  up  to  35  days  from  the  current  date,  line  5,  on  which  the  "Pmt  Date"  is
2019-05-13, will be blocked as of 2019-06-17.

Special  Record  Statuses:  Records with  the  Status  "Draft"  or  "Pending"  will  not  be  blocked.  However,  once the  Record
Status is modified to any other and saved, when you open the Payment schedule again, older transactions will be grayed
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out, therefore blocked. 

NOTE: In order to ensure that no unauthorized user temporarily uses the "Draft" or "Pending" Record Statuses to bypass
the system and modify blocked transactions, Status changes to "Draft" or "Pending" is not allowed when lines are grayed
out in the Payment schedule. The following error message appears if an attempt is made to do so. 

As soon as a transaction is blocked in the payment schedule, other Record components are also blocked:

o The "Data" tab, except for "Record Status" and "Sub-status". 

o Data related to APR:
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o The "Advanced" section:

o The "Modify/New Record link:

Note that blocked periods will also be blocked in the following Tools: 

 Post pmts :
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Line 1 is grayed out because this transaction is included in the blocked period, 
therefore impossible to be modified in any way.

 Bulk Import:

o Import of new payments
o Import of existing payments

An error message advises the user as to the what is the earliest date that can be entered
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The line becomes red with indications in the "Message" column as to what is the earliest date that can be entered

 Rate change:

o Via the Main window with the shortcut CTRL+ALT+SHIFT+I
o Via the payment schedule by right-clicking on the mouse

An error message advises the user as to the what is the earliest date that can be entered

 Insertion and additional lines in the Payment schedule

o When  transactions  blocking  is  activated  and  that  data  must  be  added  or  inserted  between  the  blocked
period and today,  the  date  entered in  the  "Pmt  Date"  will  automatically  be  adjusted  to  the  earliest  date
allowed. If the user tries to enter an older date, it will be blocked and an error message will appear.

Example:

A user needed to add a transaction on an old loan.  The "Pmt Date" column (not the "Start  Date" column
which  is  usually  hidden)  displays  the  earliest  date  that  the  user  can  use,  since  the  transaction  blocking
module is activated. If it has not been activated, the date entered by default would have been one month
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later, like on line 13, which would have been 2002-02-27 and the user would not  have had any problems
modifying it.

Of course, if a user wishes to modify the date in the "Pmt Date" for a more recent or future one, he will
be free to do so.

 Global changes:

o Global  changes  are  prohibited  for  data  and  fields  that  are  grayed  out  in  Records  that  contain  blocked
transactions. 

An error message notifies the user that the lines are blocked and changes will not be made in the Record.

   

Show / Hide Totals in the Main window

The  Main  Margill  window  (Record  Summary  window)  displays  portfolio  totals  that  some  employers  would  prefer  be
hidden from users since this information can be relatively confidential yet easily accessible: 

 Portfolio totals at the bottom of each column
 Summary total for the selected Records
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Three options are thus available for hiding or displaying these totals:

 Hide totals - hides for all users
 Visible for all users
 Visible for Administrators only

WARNING:  A  user  will  have  access  to  portfolio  data  through  reports  therefore  hiding  in  the  Main  window  is  a  very
relative confidentiality measure. 

   

Activation of "Amount due" variables

This  option  allows  the  activation  and  calculation  of  the  four  (4)  "Amount  due"  variables  which  are  used  to  obtain,  at
current date or at date X, the amount that is really past due (including fees, interest, principal and others) and required
for the Borrower to be up to date in his payments. 

 Amount due at Current Date (For final balance = 0.00)
 Amount due at Current Date (For final balance = original balance)
 Amount due report End Date (For final balance = 0.00)
 Amount due report End Date (For final balance = original balance)

This will calculate the Payment amount in order for the final balance to be 0.00 or the original balance as entered in the
Data window.

This  calculation  is  done  by  iteration  to  find  the  appropriate  amount  and  thus,  for  large  databases,  requires  a  longer
processing  time.  For  up  to  current  date  calculations,  it  is  strongly  advised  to  use  the  Overnight  tasks  which  compute
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totals during the night as opposed to when launching Margill in the morning.

   

Activation of "Expected Principal"

This  option  will  activate  two  new  columns  in  the  Payment  schedule:  “Expected  Principal”  and  “Excepted  Principal
Balance”. 

This allows you to estimate the amount of Principal that would ordinarily be paid when a regular (expected) payment is
made.  This  amount  is  theoretical  and  to  provide  an  indication,  like  the  “Expected  Payment”  column  whether  the
Borrower is paying well or not as well as the theoretical  outstanding Principal  amount.  The Expected Principal  amount
may be changed manually.

If the Principal actually paid is less than the Expected Principal, then the Expected Principal Balance will increase. On the
contrary, if more Principal is paid than expected, there would be a negative Expected Principal Balance unless the option
by which the minimum Expected Principal Balance must be 0.00 or greater is checked.

Expected Principal of 375,000 for a 500,000 loan with a balance (residual value) of 125,000

The 20,000 additional payment (added after the initial payment schedule calculation) gives 
an Expected Principal of 0.00 since this amount was not initially expected. 

This payment thus brings the Expected Principal Balance to a negative amount. 
Thus, so far, more Principal is paid than was initially expected.

In certain situations, as is the case with "Expected Payment", users may want to limit the Expected Principal Balance to
0.00  or  more,  thus  never  become  negative  as  in  the  example  above  when  there  is  an  over  payment.  To  activate  this
feature,  go  to  the  Record's  Advanced  tab  and  check  "Expected  Principal  Balance  column  must  always  be  equal  to  or
greater than 0.00". You can also activate this advanced option via Global changes so it can be applied to all  Records or
only to some.
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Resulting Payment schedule when option is checked:

Existing Records

By  default,  the  Expected  Principal  column  is  not  calculated.  To  compute  the  Expected  Principal  for  multiple  (or  all)
Records, in the Main window (Record Summary window), select the desired Records (or all with Ctrl A) and press on Ctrl
Alt Shift x. This will take a few minutes or more depending on the size of your database.

When the Expected Principal column is calculated, for Paid type Line statuses (as opposed to upcoming Due payments),
the  Expected  Principal  will  be  the  amount  that  was  actually  paid  in  principal.  This  may  not  be  desired  but,  given  this
column  is  a  theoretical  amount  that  really  should  have  been  calculated  when  the  loan  was  originally  created  (total
Expected  Principal  should  be  equal  to  the  loan  amount  if  the  final  loan  balance  is  0.00),  this  is  the  only  amount  the
software can compute. If the Expected Principal is not as desired, a user would have to revise the Expected Principal line
by  line,  estimate  the  principal  amount  that  should  have  been  paid  and  enter  this  amount  in  the  Expected  Principal
column. This can be an arduous task for past payments. You could recreate the same original loan payment schedule to
obtain the originally computed Expected Principal amounts and then manually enter these in the live loan, line by line for
past payments. If a payment was not expected (so an extra payment) the Expected Principal should be 0.00.

Once the Expected Principal has been entered for past (Paid) payments manually, you should then use the Ctrl Alt Shift x
shortcut in the Payment schedule to recompute the Expected Principal for all future Due payments. Select only the Due
payment  lines  (not  the  Paid  historical  lines)  and  run  the  shortcut.  Here again,  in  the  end,  the  total  Expected  Principal
should be equal to the loan amount.

New Records



Page 402

© Jurismedia Inc., 2007- 2023

If the option is activated, then the Expected Principal will automatically be calculated for all new Records.
Changing/updating a Payment schedule

The Expected Principal amount is a  special  and slightly unusual  amount to be used only  in  special  situations and users
must really understand how it is used. 

First,  it  is  critical  to  understand  that  once  calculated,  it  will  never  be  updated  or  recalculated  without  human
intervention. 

When  a  payment  is  changed  or  even  a  line  changed  to  another  Line  status  (for  example  from  Due  Pmt  to  Additional
Principal) if there was an amount in the Expected Principal column, it will remain unless deleted or changed with human
intervention.

When  new  lines  are  inserted  in  of  added  at  the  end  of  a  Payment  schedule,  since  the  Expected  Principal  is  already
calculated  in  previous  lines  in  order  to  pay  back  the  full  principal  amount,  the  Expected  Principal  column  will  remain
empty for these new lines. 

If for example, additional principal was added in a loan, the Expected Principal may have to be recomputed by selecting
all  Due Pmts  (existing and  new lines  added  case  being)  and  the  Ctrl  Alt  Shift  x  shortcut  used.  In  theory,  the  Expected
Principal should match the true Principal lent out.

Special Refund Order

The  Expected  Principal  is  also  used  for  the  exceptional  payment  refund  order  by  which  Interest  is  paid  first,  then
Expected Principal,  then Column Fees and  if  the  payment  is  sufficient,  more  Principal  will  be  paid.  This  method  is  not
available by default in the system but on special request only.

See Refund order for Interest, Fees and Principal, subsection Refund Order 2.

   

Multi Currency

Margill Loan Manager (MLM) allows for the use of multiple currencies within the same portfolio. A portfolio could thus
contain as many currencies as desired and reports could be produced to reflect its value at the base currency or in any
other currency.

Only  the  MLM  Administrator(s)  can  set  or  change  the  currencies  or  activate  or  deactivate  the  module.  Go  to  Tools  >
Settings  >  System  settings  (Administrators)  >  "Modules"  section  and  click  on  “Currencies”.  The  following  window  will
appear with a few widely used currencies. The Power user may change the exchange rates per se.
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In  order  to  activate  the  module,  check  "Activate  Multi-Currency  module".  When  the  module  is  activated,  currency
choices will be given in the Record Data window and the option to produce the Record List in various currencies will be
displayed.

 

The first section of the window titled "Windows Currency" lets you specify an abbreviation, usually three letters, for the
default Windows currency (Control Panel > Regional  Settings).  This can be entered because Windows does not  include
such an abbreviation (only the symbol is available for Windows). This abbreviation is often used by third-party systems to
identify the currency. This section also identifies the exchange rate set at 1.0000000. This rate can not be changed.

Other currencies besides the ones included may be added in the next section by placing the cursor on the last line and
adding the currency symbol. The three (3) letter international abbreviation should also be entered. These may be found
on the Web if not known. Once the currency has been set, press on "Exit". The new currencies will automatically be saved
in the database. Currencies may also be deleted if not used.

If  you  are  using,  for  example,  the  US  and  Canadian  dollar  ($)  in  the  portfolio,  each  with  a  different  value,  then  it  is
suggested, in order to differentiate the currencies, to add an extra symbol on the less used unit. If your main currency is
the US dollar (Windows default currency) and the Canadian dollar the secondary unit, the USD symbol being $, then the
CAD symbol could be C$.

Once a currency has been set and used in a Record, MLM will not allow the deletion of this currency. A dialog box will
provide a warning. To permanently delete a currency, this currency must not be used in the database.

Exchange Rate

The third column of the "Currency administration" window contains a conversion factor (Exchange Rate). These should be
updated once in  a  while depending on  when reports  are  produced and on  your  accounting  policy.  These rates  can  be
updated one by one by entering the data directly into the column, or they can be updated via an Excel file.
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Spreadsheet Characteristics:

 File in .xls or .xlsx format.
 Only the first tab of the workbook will be included.
 Column titles must be entered in the first line. The name doesn't matter.
 The  first  column  must  contain  the  currency  abbreviation  (example:  USD,  GBP,  EUR,  CAD  ...).  The  second  column

should contain the exchange rate.
 Data must start on the second line.
 All data will be included, regardless of the number of empty lines.
 It is not possible to add new currencies via the Excel sheet. You must first add them manually by entering the data

directly in the table in the "Multicurrency" section.

File example:

Click on .Find the location of the file with the Windows navigation tool. Select the file containing the currency data
to update.

Click the button. An import confirmation message will appear.

If a currency code is not in your currencies list, a message will appear and indicate the various errors:

For the base Windows currency, the rate is 1.00. The other currencies should contain the exchange rate at a chosen point
in time. The factor should be the value of the other currency when compared to the base currency. For example, if the
base unit is the US dollar and other currencies include the Canadian dollar, the Euro, the UK Pound and the Japanese Yen,
then the table should read as follows (1 CAD = 0.91 USD, 1 Euro = 1.37 USD, 1 £ = 1.668 USD, 1 Yen = 0.0098 USD). 

USD as base
USD 1.0000000
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CAD 0.9100000
EUR 1.3700000
GBP 1.6680000
JPY 0.0098000

Other examples:

Euro as base CAD as base GBP as base Yen as base
USD 0.7280000
CAD 0.6572000
EUR 1.0000000
GBP 1.2143000
JPY 0.0071000

USD 1.1100000
CAD 1.0000000
EUR 1.5217000
GBP 1.8479000
JPY 0.0108000

USD 0.5995000
CAD 0.5412000
EUR 0.8235000
GBP 1.0000000
JPY 0.0059000

USD 102.340000
CAD 92.3780000
EUR 140.570000
GBP 170.780000
JPY 1.0000000

When obtaining base currency results, MLM will multiply the other unit by the factor indicated to obtain the value in the
base currency.

Only the MLM Administrator and the Power user may change the exchange rates. 

See also Record List for reporting the multi currency portfolio in a selected currency. 

   

Amount Due variables (Activation)

A most appreciated feature in Margill Loan Manager (MLM) is its quick access to four variables, accessible in the reports
or in the Main window, that allow the user to instantly see the amount that must be paid by the Borrower to "get back
on track" if one or several payments are missed, partial or late.

Variables:

 Amount due at Current Date (For final balance = 0.00)
 Amount due at Current Date (For final balance = original balance)
 Amount due report End Date (For final balance = 0.00)
 Amount due report End Date (For final balance = original balance)

Example:

 Loan amount: 25,000
 Principal and interest payments for 18 months
 Regular payment should be 1487.08 with a last payment of a few cents less. 

Below is the payment schedule based on contract that would yield a balance of 0.00 if full payments were made on time:
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Let's suppose payment 4 is missed and payment 5 is partial, leading a hypothetical final balance of 2731.16 (in principal,
interest and maybe fees had these been added):

Borrower calls you up today January 10, 2022 to know how much he must pay to be back on track. The amount can be
seen in the Main window with the appropriate variable.  In  this  case "Amount due at  Current Date (For final  balance =
0.00)".  So  the  Borrower  would  have  to  pay  2490.25  (today)  so  that  the  final  balance  of  2731.16  (in  the  year  2023)
becomes 0.00.  The  difference  is  due  to  interest  accrued  on  a  higher  amount  if  the  outstanding  amount  is  paid  in  the
future as opposed to today.



Page 407

© Jurismedia Inc., 2007- 2023

If there had been a residual value, the proper variable would have been "Amount due at Current Date (For final balance =
original balance)" 

If Borrower wished to know the amount due at another date than today, then a report (Record List) would have been
produced to get the data with one of the two variables "Amount due report End Date". 

Or you could have gone in the loan itself, inserted a line on the date, right click > Payments > Payments Adjusted for
Balance = 0.00 (or Balance = X). 

This  option  in  Tools  >  Settings  >  System  Setting  (Admin...)  is  to  activate  and  calculate  these  the  four  "Amount  due"
variables since the calculation is done by iteration and thus, for large databases, requires a longer processing time. 

For "up to current date" calculations, it is strongly advised to use the Automatic / Overnight tasks which compute totals
during the night as opposed to when launching Margill in the morning.

See also Payments (equal) recomputed to yield a balance = 0.00 or other amount.

   

Credit Reporting

To activate the "Credit Reporting" module click on the "Credit Reporting" link under the "Modules" section in the System
Settings (Administrators).

This window will appear:
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1. Check the "Activate Module" box.

2. Choose from the drop down menu, the country for which you wish to produce the Credit Reports since each country
require different credit reporting data.

Warning: You should not change countries after the initial activation of this module because all the data regarding
the credit report will be deleted. 

If you decide to change countries, all the Records must be closed by the users.

3. Enter  your  Creditor  ID  (also  known  as  "Record  ID"  in  the  credit  rating  industry).  This  ID  is  generally  provided  by
Metro 2 software.

It is possible that you have several Creditor IDs. With Margill Loan Manager (MLM) you have the opportunity to add
as  many  as  six  (6)  identification  numbers  (Metro  2  Creditor  ID)  by  checking  "Multiple  creditors  will  report  to  the
credit agencies". 
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In  case  several  Metro  2  Creditor  ID's  were  entered  in  the  fields  provided  for  this  purpose  and  you  uncheck  "Multiple
creditors  will  report  to  the  credit  agencies",  a  window  will  appear.  This  window  will  inform  you  that  if  this  option  is
unchecked,  all  the  identification data  will  be  erased and substituted by  the  first  (and only)  Creditor  ID.  This  operation
cannot be canceled.   

You must then select the Account Types to be displayed in MLM. Before choosing the Account Types to display,  if  you
plan to use the "Credit Manager" software (highly recommended for Metro 2 reporting), it  is suggested to first see the
Account Types available according to your country and industry (in Credit  Manager:  File  >  New >  name a  file  >  save >
choose the country > to the right of "Company Type" press "Help" - The Account Types available will be displayed).

Check or uncheck the options available to select the Account Types displayed.

   

Sub-Creditors

The Sub-Creditor module is an advanced feature which allows for the creation of sub-entities for Creditors and to assign a
participation in a loan to this Sub-Creditor.

Fields cannot be extracted in normal reports nor used in Mathematical Equations. A custom report built  by the Margill
team must be created to extract data using this module.

Only an Administrator can activate the Sub-Creditor module in Tools > Settings: 

Consult Record Window > Creditor (Lender/Investor) to find out more about managing Sub-Creditors. 
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Variable Interest Rates

As of  version 5.5,  the variable interest rate module allows an  automatic  interest  rate  update  in  the  Payment  schedule
when the Interest table linked to it is updated. In previous versions of Margill Loan Manager (MLM), the Interest tables
allowed creating the Payment schedule taking into account variable rates but updating the Interest table did not update
the Payment schedule interest rates.

For users with versions before 5.5,  the new method must be activated specifically by checking "Activate the Advanced
Variable Interest Rate Module".

 

Note that only the ADMIN user can activate this module. 

This module is explained in a separate chapter. See Advanced Variable Interest Rates Module.

   

Electronic Funds Transfer

See Setting up the EFT module in the Electronic Funds Transfer chapter.

   

Personal Logo Display

See Personal Logo Display in the Introduction chapter.

   

Master and Affiliate Loans

See the Electronic Funds Transfer chapter > Master and Affiliate Loans - EFT

   

Custom Report Settings

See Custom reports created by the Margill team in the Reports chapter.

   

Returned Checks

If activated, this module allows you to enter complementary information when payments made by check are returned for
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lack of sufficient funds.

To do so, select the Menu Tools > Settings > System Settings tab > Returned Checks. The following window will appear:

When you click on "Activate module", certain compulsory information, such as the date at which the check is returned
and the payment date that is compensated, will have to be entered by the user that makes the changes. Thus, each time
the "Check returned" Line status is selected, this window will appear:

If the returned check module is activated, a returned check report can be created (Transaction Report) in order to extract
this data.

For more information on extraction reports, see Reports > Commonly required reports > Returned checks.

   

Merge Borrowers and Creditors

This tool performs a "clean up" in the list of Borrowers and Creditors and eliminates duplicates.

What has changed between versions 2.x and 3.x?

The database versions that preceded Margill Loan Manager (MLM) version 3.0  were "flat file" type. As of 3.0, the new
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structure is relational, a more powerful form that offers potentially many more options.

In the old structure, based on the Records (or Loans) when the Record was created, a Borrower (or a Creditor) could be
included in  this  Record.  If  the  same Borrower had  a  second loan in  the  system, the  Borrower's  information had  to  be
entered again. If, for example, the Borrower changed phone numbers, each Record had to be opened and the telephone
number changed for each file, one by one.

With the new database structure, Borrowers and Creditors are created independently of the loan. The Borrower and the
Creditor may be associated (paired) for a loan.  A loan may even include multiple Creditors,  reflecting a  percentage (or
amount) of participation. In addition, a loan may also have a Co-Borrower and multiple Borrowers selected from the list
of  Borrowers.  When  Borrower  information  changes,  the  phone  number,  for  example,  the  change  in  the  Borrower
Information Card will be reflected in all Records (or loans) for that Borrower. 

When  updating  MLM  from  version  2.x  to  3.x  the  database  update  tool  identifies  Borrowers  (or  Creditors)  who  have
EXACTLY  the  same  data,  and  in  this  situation  merges  the  two  (or  more)  information  cards  in  one,  then  assigns  this
information to the appropriate Records.

The merge tool allows the system to merge manually if the updates cannot be merged automatically.

How to merge manually

To  merge  a  Borrower's  or  a  Creditor's  information  card:  Tools  >  Settings  >  System  Settings  (Administrators)  >  section
"Special" > Borrower or Creditor Merge.

In the example above, "DT inc." appears twice. The highlighted (and checked) left Record does not contain the data for
the address, phone number or the email. The right data is more complete than the left. Other situations may occur as
one of the forms includes updated data, while the second contains old data.

To  perform  a  merge,  check  the  Information  Card  or  Cards  in  the  left  panel  (old  data)  or  the  unnecessary  Cards  that
should actually contain exactly the same data as highlighted in the right table. In the example below, we want to replace
the information card of the Borrower "Jeean Rablat" (with the wrong name) with the "Jean Rablat" information card that
contains the correct data. Any difference, however minor it may be (including an invisible space) would have prevented
the automatic merge.

Select the card in the right table that must be preserved. This card will replace each selected cards in the left table.
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Left portion of window

Right portion of window

Press the arrow in the center. 

By  clicking on  "Yes",  "Jeean Rablat",  checked  in  the  left  table,  will  disappear  and  the  good  information  card  for  "Jean
Rablat" will be assigned to "Jeean Rablat"'s loans.

WARNING!  If  you  select  several  Borrowers  (or  Creditors)  by  mistake  in  the  left  table,  these  will  disappear  from  the
system. In  the  example below,  Francis  Reynolds  and  Eric  Durand  are  checked  in  the  left  table  and  Francis  Reynolds  is
selected  on  the  right.  Eric  Durand  will  disappear  from  the  system  and  his  loans  will  now  be  associated  with  Francis
Reynolds.
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Left portion of window

Right portion of window

Before performing a merge, always make sure you have chosen the right Borrowers or Creditors.

It is strongly recommended to perform a backup before doing multiple merges.

   

Electronic Signature

This  module  allows,  if  activated  and  combined  with  a  subscription  to  the  eSignature  partner  Xodo  Sign  (formerly
Eversign),  to  send  personalized  documents  by  email  in  order  to  have  them  signed  electronically  to  Borrowers,  Co-
Borrowers, Guarantors and Creditors.

See Reports > Document Merge (Letters, Contracts, Invoices and Statements) > Electronic Signature (eSignature).

   

Bulk Import of Borrowers, Employers, Creditors and Payment Schedules

The  Margill  team provides  a  data  import  service  from  an  Excel  file  in  addition  to  helping  you  configure  the  Database
(custom fields, drop down menus, etc). Contact us for more information on this service. Additional fees apply. 

With the help of our team's templates, you can easily, rapidly and regularly import Borrowers, Creditors, Employers and
Payment schedule data to Margill Loan Manager.

For  more  information,  see  Import  Borrower,  Creditor,  and  Employer  Data  and  Bulk  import  of  Loans  and  Database
configuration sections.
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See also Automated Imports - JSON or Excel files and Salesforce Connection (API).

   

Automated Imports - JSON or Excel files

This Application Programming Interface (API) enables the automatic import (creation and update) of Borrower, Loan and
new Transaction data  into  Margill  Loan Manager  (MLM) from third-party  software and web application forms in  JSON
and Excel formats.

Importing or updating data through a Margill Windows Service can be done in near real-time as long as the third-party
software has the capability to create the required files, ideally, automatically.

Three automatic imports are available: 

 Borrower creation and Borrower data updates
 Borrower and Loan creation and updates (via a single file)
 New transaction imports

A detailed PDF document is available on the Margill web site that explains the module in detail. Please visit: https://www.
margill.com/margill-loan-manager/win_service-api.pdf.

Important Note:

Especially  when importing  new payments,  it  is  strongly  suggested  to  make  a  backup  copy  of  the  database  (DB  folder)
before any automatic import. The import file should only be copied to the import folder after the backup copy has been
done.

   

Salesforce Connection (API)

This Application Programming Interface (API) allows automatic import (creation and update) of the Borrower data (but
not the loan itself - you could use a JSON or Excel file produced by SF for this) into Margill Loan Manager (MLM) from the
Salesforce software (CRM).

A detailed PDF document is available on the Margill web site that explains the module in detail. Please visit: https://www.
margill.com/margill-loan-manager/Margill_API_Salesforce.pdf

Important notes:

It is suggested to work in Salesforce Sandbox Mode in order to do some preliminary testing. A Sandbox version should
also be used for Margill (contact the Margill Support to do this). 

If you are working on a live version of Margill, it is suggested to save the MLM database before importing anything.

A Salesforce expert should do this integration. 

   

Security

The "Security" tab in Tools > Settings, allows for increased internal security in Margill Loan Manager.

The "Security" tab is visible only for the Administrator ADMIN who is the "Super" Administrator. Only this Administrator
has access for security reasons.

HTTPS://www.margill.com/margill-loan-manager/win_service-api.pdf.
HTTPS://www.margill.com/margill-loan-manager/win_service-api.pdf.
https://www.margill.com/margill-loan-manager/Margill_API_Salesforce.pdf
https://www.margill.com/margill-loan-manager/Margill_API_Salesforce.pdf
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Check out these sections for more information:

 Log File
 Sensitive Information
 Internet Access
 Multi-factor authentification (MFA)
 PGP Encryption Setup

   

Log File

This option activates an external  log in  order to generate a  text  file (.TXT) structured in JSON on a  daily  basis.  The file
includes the activities you wish to log.

The selected activities under the Security tab accumulate over time in the file. 

The  following  information  is  added  to  the  JSON  file:  User  name  who  carried  out  the  event,  time  stamp,  name  of  the
workstation used, user name used in Windows, source (user session, Overnight tasks, etc.),  level, reference (depending
on the context, is the Record number), start and end time, error message (if applicable), success message (if applicable).

Moreover, for each activity, supplementary precisions on the actions made in MLM, are included:

Loan Events

Activity log in the Records (Loans)

Includes for example:

 Changes in the Payment schedule (payments)
 Creating and Deleting Records
 Change of Borrowers in Records

Report Events
Report Events log

 Includes the type of report and its name  

User Management Events
User Management Events log

Includes for example:
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 Deleting a User
 Adding a User as well as the list of granted rights
 Changes in the rights granted

User Session Events

User Session Events log

 Includes time of connection to MLM, time of disconnection and session
duration

Overnight Task Events
Log of Events configured via Background tasks

 Includes the type of tasks done and error / success messages 

Automated Report Events

Automated Report Events log

Includes for example:

 Type of data imported (Borrower, Employer, etc.)
 Name of the data file containing the import information
 Unique ID of the Borrower created or modified during the import

Simply check the required events, choose a destination folder for the JSON files generated daily and click on the "Save"
button.

The files created by these logs can be imported by another analysis software such as Splunk.

WARNING: Logging attempts to include all of the events described above, but although this event capture was done with
great care, some events may not have been captured by the logging tool.  If you find an event described above that is not
included in the log file, please let us know. 

   

Sensitive Information

By checking this option, the enhanced protection of confidential information is activated. This blocks the copy using CTRL
+ C on tables that contain data that could be confidential and hides the window's data when attempting to take screen
shots.

This mechanism is in no way full-proof in stopping unauthorized data copy by internal staff. 

See also: Sensitive Data Module
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Internet Access

When this option is checked, any access to external links and the opening of files by launching Windows programs, via
MLM, will be prohibited. 

This includes:

 Internet, Web addresses
 EFT submissions
 Updates to interest tables / Margill license
 Connections to Salesforce
 Sending emails
 Direct  opening  of  PDF,  CSV,  TXT  etc.  (you  will  have  to  open  the  files  by  launching  your  other  programs  (Word,

Excel...) independently.

   

Multi-factor authentification (MFA)

To increase the security of your system, this option enables Multi-factor authentication (MFA) login. This option enables
MFA for all system users.

In order to receive the verification code, you will need to install an authenticator app on your smart phone. Apps such as
"Authenticator"  from Microsoft  or  Google  are  usually  available  for  free.  Several  others  are  available  for  various  smart
phone types.

Your users will simply follow the instructions when launching MLM (scan the QR code or manually enter the unique key
generated).

If  a  user's  phone  is  replaced,  the  ADMIN  will  need  to  regenerate  the  QR  code  for  this  user.  See  Getting  stated  >
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Administrators and Users > Reset the Multi-factor authentification code

The  TOTP (Time  based  One  Time  Password)  algorithm is  used.  Sometimes,  the  code  is  rejected  4  to  5  seconds  before
expiring. Simply wait for the next code if the first does not work.

   

PGP Encryption Setup

This tool allows setting up the encryption of reports produced via the Background (Overnight) Tasks (Automatic reports).

Encryption would be used in highly secured environments. This requires installing Kleopatra, a certificate manager and a
GUI for GnuPG. The software backs up your OpenPGP certificates and keys.

Configuration:

1. Specify the location of the PGP software. 

2. In order to decrypt a file, enter the private key password used to decrypt files whose public key has been shared.

3. To encrypt a file, indicate the public key fingerprint used for file encryption. The public key must first be imported
into your PGP software.

4. When  checking  the  "Encrypt  all  Overnight  reports"  option,  all  automatic  reports  produced  overnight  (or  when
desired via Windows Task Scheduler) will be encrypted. There is also an option in the Automatic reports settings that
allows you to enable encryption per report.

The  "FOR  TESTING  ONLY"  button  allows  necessary  testing  to  validate  that  the  configuration  with  the  PGP  software  is
working correctly.

Encryption should only be used by a technical team with implementation knowledge. Additional information is available
upon request.

   

Users

See Getting started > Administrator and Users 



Page 420

© Jurismedia Inc., 2007- 2023

   

Various

The tools located under "Various Tools" are less important one but can be very useful. 

 Display the history of changes for selected Records
 History of changes by line in a Payment schedule
 Find specific Line statuses in Records
 Extract Records' Attached Documents
 Extract Notes from Records
 Bulk data import / update in the Payment schedule

   

Log of Changes for Records

Margill Loan Manager (MLM) includes a log of changes made in a client Record. The log includes who made the change
(User), the date and time it was made and what changes were made.

The history can be viewed for changes made in a specific Record, for any dates, or for changes made to multiple Records
(consolidated history) for a chosen date or between two dates.

Constraints for the history of Records:

 CAUTION:  The Record Log should be used for information purposes only. Depending on the change made and how it
was entered, it may not be included in the log.

 Only changes related to Record itself will be included in the history. If a change is made to a Borrower Information
Card for example, those changes or additions will not be included in the history as the change is not directly related
to  the  Record.  Nevertheless,  if  a  Co-Borrower  (or  Borrower  or  Creditor)  is  added  or  removed  from  a  Record,  the
change will be included in the history. Included in the history are:

o Changes to the Payment schedule
o Changes to the "Data" tab
o Changes to the custom fields for the Record
o Adding, changing or deleting a Borrower, a Co-Borrower, a Creditor or a loan officer
o Under "Borrower": "Other Info" and "Loan Security"
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o Under "Creditor": "Other Info" and "Participation"
o Changes to the Credit Report tab - related to the Record but not to the Borrower
o Changes in the APR tab
o Changes to the Advanced tab

 The consolidated history will identify only changes made to Records. If  the change is not included in the history of
the Record itself, it will not be included in the consolidated history.

 If a Record is deleted, this will not be reported in the list of changes since the Record's history will be removed with
the Record. It is extremely important to make backups regularly, several times a day for larger databases.

Changes to a Record

For a Record, you can view the history from the "Data", "APR" and "Advanced" window of the Record.

The log can be copied or exported to Excel, Word or XML (Web) with the right mouse click and can be printed.

Viewing the changes for the chosen Records (Consolidated History)

If you would like a list of changes that have been made in several Records, at a specific date or for a given interval (for
example, changes made yesterday or in the last week), go to Tools > Various > Display the history of changes for selected
Records.

This consolidated history will display the changes made to the SELECTED Records only. Thus, we must choose the desired
Records in the Record Summary. You can choose only certain Records or all Records in the portfolio.

To choose all the Records, press on "Ctrl A" in the Record Summary window. Make sure that all Display Filters are at "All",
otherwise some Records might be excluded. To ensure that no Records are missing, the number of Records selected will
be displayed at the bottom of the image in the "Various Tools" window:
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In the "MLM Log File" window if you wish to obtain the history for a date other than the current date, enter the date or
dates  and  press  on  "Refresh (F5)".  By  default,  the  changes for  the  current  date  will  be  displayed  without  the  need  to
press "Refresh (F5)".

The log can be copied or exported to Excel, Word or XML (Web) with the right mouse click and can then be printed.

See also Security > Log File. Log files may be created in text format on a daily basis and analyzed with log analysis tools
such as Splunk. 

   

Find specific Line statuses in Records

It may be useful to find Records that have particular Line statuses. For example:

 to  identify  and  make  corrections  to  all  Records  that  have  the  "Not  Set"  Line  status,  a  Line  status  which  is  not
supposed to be used;

 to eliminate a Line status from the database that is no longer useful and then be able to delete it from theLine status
 scroll menu choices in the Payment schedule.
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This tool is accessible through Tools > Various > Find specific Line statuses in Records and with the Ctrl Alt Shift L shortcut
from the Main MLM window.

Choose  the  Line  status  to  find  and  press  on  "Find".  The  search  will  be  done  among  all  Records  whether  these  are
displayed or not in the Main MLM window.

To search only among the selected Records, check "Search only the selected Records in the Main window".

Take note of the MLM Record Identifiers and make the corrections. If multiple Records are displayed, click on  in order
for the menu to appear which allows you to copy, export or print the list of Records that contain the Line status.
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Extract Attached Documents from Records

This module allows the user to copy the Records' attached documents to the desired folder outside of Margill Loan
Manager (MLM).

The Records' attached documents in MLM will be copied in a folder chosen by the user. They will stay clearly identified as
to the Record they belong to.

To do so, click  in the Record Summary window then click on . In that window,
click on "Record's Attached Documents Extraction". This window will appear:

It is possible to extract attached documents either for all Records in the database or only for Records selected in the Main
window (Record Summary). Simply check the desired option under "Extract from Records". To be safe,  MLM will  show
the number of Records associated with the selected option. 
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Extracting will generate different folders (under Windows) for each Record. These folders will each have a name. Folder
names can be chosen among the following options in the "Folder Names" drop down menu:

By default, the folder name will be MLM's Record Number.

Next, you will  need to determine the each file's name once extracted. By default, the system will  keep the original  file
names. If another option is selected, all file names will end by "_RecordID". Here are the choices offered by MLM in the
"Extracted File Names" drop down menu:

Click on  and select the destination folder to which the attached documents must be copied. Select an
empty folder in order for the operation to succeed (you will have the opportunity to "Make a New Folder" at this stage).

After selecting the folder, click on .
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MLM  will  confirm  your  choice  with  the  following  message  based  on  the  extraction  choice  made  for  the  files  from
"Records selected in the Main window",

or "ALL Records in the database".

A confirmation is provided when the extraction is finished. A pop-up window will show the number of Records processed:
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The extracted files will be located in the chosen Windows destination folder.

Please note  that  files  will  remain attached to  the  Margill  Records.  Files  are  copied during  the  extraction,  they  are  not
deleted.

   

Extract Notes from Records

This module extracts the Record Notes to the desired folder. The destination folder must be empty.

The  Notes  will  be  extracted  in  PDF  format  and  will  include  the  images  if  there  are  some  present.  The  Notes  will  be
extracted but will remain in the MLM database.

Go to Tools > Various > Extract Records' Notes:

You have the  option  of  extracting Notes  from all  Records or  only  those selected in  the  Record Summary window.  The
file's name will  be one of the IDs listed in  the scroll  menu above or  a  combination with the Borrower name and other
Records IDs. The MLM Record ID is always included since this is the only field that is always present.

   

Bulk Data import or data update in the Results table

This module allows you  to  modify  or  add  data  in  multiple  columns for  existing lines  in  the  payment  schedule from an
Excel file and as of a specific start date for the change / addition until an end date or for the duration of the schedule. The
data for the desired columns will be modified as of the first date of any of the 5 “Due Pmt” type Line statuses.

For  example,  you  had  Column Fees  (taxes,  insurance,  administrative  fee,  etc.)  on  each  payment  line  but  these  are  to
change  at  a  specific  date  going  forward.  Changing  line-by-line  would  be  a  very  long  process.  This  tool  allows  you  to
change these amounts (or other data types in the payment schedule) in bulk.

Lines in the past, so those with "Paid" payments or any other type of Line status (Add. Principal, Other X, Fees, Fees Paid)
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will NOT be updated. Even lines in the future with Line statuses other than "Due" payments will also be ignored. Even if
proper use of the Loan Manager recommends that the past should not contain "Due Pmt" type lines (they should all be
Paid, Unpaid, etc), this does not prevent you from changing historical data as long as the Line statuses are of "Due Pmt"
type.

Go to Tools > Various > Bulk data import / update in the Payment schedule:

This window will appear:

The tool allows to add or update (replace) the following data contained in these payment schedule columns:

 Payment amount
 Line Comment
 Custom Column 1 (Text)
 Custom Column 2 (Text)
 Custom Column 3 (Text)
 Custom Column 1 (Money)
 Custom Column 2 (Money)
 Custom Column 3 (Money)
 Custom Column 1 (Numerical)
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 Custom Column 2 (Numerical)
 Custom Column 3 (Numerical)
 Column Fees 1
 Column Fees 2
 Column Fees 3
 Column Fees 4
 Column Fees 5
 Column Fees 6

Note that multiple columns may be updated at once. For example, an increase in a fee column of  10.00 would usually
involve an increase in the Payment amount.

Warning! It is strongly recommended to backup the database before making major changes in the
database. See Backup (Data) for the steps to follow.

NOTE: Only a Margill with Administrator privileges or a Power user can do such an update since the changes can be
substantial.

Only "Active" Records can be updated with this tool.

To import data from an Excel spreadsheet:

1) Prepare the Excel spreadsheet with the first compulsory column A (the Record identifier) as well as the data that is to
be added or updated:

 The first column (Excel A) is compulsory and serves to identify the Record. Three Record identification methods are
possible. Choose the desired identification from the list. You can choose the MLM Record ID or from Unique ID 1 or 2
(as renamed), the latter two assigned by the user.

 Some columns in Excel must remain empty since the Excel file format follows that of the Bulk Payment Import tool.
Data can be entered in any of the the other columns as "mapped" below:

o Column C: Payment Amount (positive only)
o Column E: Line Comment
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o Column G: Custom Column 1 (Text)
o Column H: Custom Column 2 (Text)
o Column I: Custom Column 3 (Text)
o Column M: Custom Column 1 (Money)
o Column N: Custom Column 2 (Money)
o Column O: Custom Column 3 (Money)
o Column P: Custom Column 1 (Numerical)
o Column Q: Custom Column 2 (Numerical)
o Column R: Custom Column 3 (Numerical)
o Column S: Column Fees 1
o Column T: Column Fees 2
o Column U: Column Fees 3
o Column V: Column Fees 4
o Column W: Column Fees 5
o Column X: Column Fees 6

IMPORTANT NOTE:  The column  positions  (from 1  to  24  (A  to  X  in  Excel))  are  mandatory.  If  only  certain  data  is  to  be
imported,  you  must  leave  the  optional  columns  blank,  in  the  prescribed  order,  so  that  the  data  to  be  imported  is
transferred to the correct place during the import. A header is not required for blank columns.

The first line in the spreadsheet is used to identify your columns, it will not be imported. The names given to the columns
do not matter but their order does.

Only the first sheet of the Excel Book will be imported.

Excel spreadsheet example
Notice data can be present in some cells only

2) Choose the identifier to be used to identify the Record:

3) Specify the date at which the change/addition is to begin and end, or up to the very last line of each of the payment
schedules (end of Record). 

Remember, even if you were to enter a date in the past or in the future but with a Line status other than a "Due Pmt"
type, the change/addition will  be ignored since this will  be considered an historical transaction or a special transaction
which should not be changed.



Page 431

© Jurismedia Inc., 2007- 2023

4) Click on the orange folder icon in order to select the Excel file to import to MLM. 

A preliminary analysis of the spreadsheet is performed and if errors are detected a message will appear:

Errors will appear in red or orange depending on whether the errors are critical for the entire Record or only for some
lines of the payment schedule. 

Error examples:

Record  ID  not  found  in  the
database

Indicates that the Record does not exist. Critical  error  so  Record  excluded from
import

Active Records only Indicates  that  Record  Status  is  not
"Active".

Critical  error  so  Record  excluded from
import

Invalid data format For  example  a  letter  entered  in  a
monetary  field  or  a  negative  number
entered in Payment or Column Fees

Critical  error  so  Record  excluded from
import

Payment  amount  to  be  changed
and  includes  a  Line  Behavior
(Tags)

Line  Behavior  such  that  Payment
amount is automatically recalculated for
Interest-only or Fixed principal payment.

Critical  error  so  Record  excluded from
import

Column fees already present that
have formulas 

For  example,  the  Column  fees  are
recalculated based on the previous line's
balance  or  are  based  on  the  line's
accrued interest.

Critical  error  so  Record  excluded from
import

Line status not accepted Any  Line  status  other  than  one  of  the
five "Due Pmt" types

Relative  error  (orange)  thus  this
specific  line  will  be  ignored  but  data
will be entered for all the Due Pmt type
Line statuses.

All  problem lines  will  be  shown  in  the
"Line Errors" tab.

No  Due  Pmt  type  Line  status  in
the  Record  (for  the  desired  time
period)

Relative  error  (orange)  which  in  fact
becomes  a  critical  error  since  this
Record cannot be updated.

If a critical error is found, it is recommended to cancel the entire import, to correct the Excel sheet and to proceed with a
full new import.
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If a relative error is found, such as a Paid Line status in the time period entered, then there is no need to correct the Excel
sheet.

6)  Once the data is validated, and if necessary, corrected, in the preliminary analysis of the "Line Errors" and "Summary"
tabs, click on "Apply". 

All transactions in the "Summary" tab where the "Record can be processed" column indicates "Yes" will be updated.

Once the processing is complete, a message will indicate that the changes were made except for the lines shown in the
"Records not processed" tab, case being.

Additional notes: 

End of import: The import system will process each line of the Excel spreadsheet until it detects an empty line. When it
detects an empty line, MLM will assume that the line before is the last transaction. However, as a safety measure, MLM
will  verify  that  the  next  nine  (9)  lines  are  also  empty.  If  they  are  indeed  empty,  MLM  will  assume  that  the  sheet  is
complete and that the import is finished. When MLM detects empty lines in a spreadsheet, this message will appear:
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Import Examples

Example #1

Suppose  you  want  to  modify  the  Column  Fees  amount  (Administrative  and  Insurance)  following  an  increase  for  the
period  from  2020-07-01  to  2020-12-31  in  the  Payment  schedule  containing  monthly  payments  on  every  15th  of  the
month. An additional loan amount (Add. Princ. (Loan)) is also scheduled for 2020-09-01:

Once the Excel file is ready, go to the import tool, enter the data change dates (inclusively for both start and end dates)
and select the file to be imported. This window will appear:

Note the "Line Errors (x)" tab ("x" being the number of errors) which means an error was detected. Under this  tab,  an
orange line advises of a relative error simply for you to know that it's there.  The error reports that  a  Line status other
than a  "Due Pmt"  type is  present  and  so  data  will  not  be  inserted or  changed  for  this  line.  This  does  not  prevent  the
submission of modifications for all other Due Pmt lines.
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After  submission  and  confirmation  that  the  data  has  been  modified,  when  reopening  the  Payment  schedule,  you  will
notice that the Fees and Comments have been modified only for the "Due Pmt" lines and only for the desired period. No
Fees have been added to  the  Add.  Princ.  line  and  due  payments  BEFORE  2020-07-01 and  AFTER  2020-12-31 have  not
been modified.

In this example, the payment was not changed, but ordinarily,  it  would have been increased by the additional accrued
amount.  The  payment  could  have  been  changed  by  adding  the  new payment  amount  in  Column C  of  the  Excel  sheet
(payment would have been 1171.54 + 2.50 + 0.75).

Example #2

This tool can not only be used to replace existing data, but also to add/remove data from existing Payment schedules.

Let's suppose Data must be added on the "Due Pmt" Line statuses of "Due Pmt" from 2021-01-01 and for the duration of
the loan. The Fee column was renamed according to Creditor's needs, but does not yet contain an amounts.
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The changes will take effect from date x, to, "Until the end of the Record". This ensures that all Records to be modified
will be changed up to the last "Due Pmt" type line for each of the payment schedules, regardless of the end date of the
loan.

Data that were not yet entered in the Payment schedule when it was first created were added as of the desired date until
the end of the loan. Note that the payment has also been increased by 10.00.

   

Backup

See Backup (data)

   

Tables

For more information on creating new interest tables or for managing sales tax tables, see sections:

 Interest rate tables (variable interest rates) > Creating new interest tables
 Updates > Interest tables (& Sales tax table) updates 
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 Margill Loan Manager Calculations > Other calculations > Sales Tax Calculations

   

List of Applications

See the Useful Features chapter > Lead/Prospect approval and Record (Loan) import via Excel or JSON for more
information.

   

Database Reindexation

The  "Reindexation  button"  ,  accessible  only  for  the  Margill  Loan  Manager  (MLM)
Administrators,  reorganizes  the  database  indexes  and  can  increase  system  speed.  After  reindexing,  index  access  is
optimized. 

Reindexing  may  be  required  following  the  loss  or  alteration  of  the  index  file.  This  loss  or  alteration  car  render  the
application unusable, unstable or simply much slower than usual.

Possible  causes  of  loss  or  corruption  of  the  index:  Technical  problem  (power  outage...),  abnormal  shutdown,  physical
removal of an index file.

It is crucial that no other user use the software during the reindexing phase.

Reindexation  may  be  done  via  the  Automatic  /  Overnight  tasks.  This  needs  not  be  run  every  day.  Every  few  weeks  is
sufficient.

MLM-Repair.exe

The  MLM  installation  folder  (generally  the  "MLM"  folder)  contains  an  application  (MLM-Repair.exe)  to  reindex  MLM
without launching the Loan Manager itself. This may be necessary if the index becomes corrupted and MLM can not be
started.

Warning: Since all users with access to the MLM installation folder can run this tool, and since it is crucial that no other
user  run  the  software  during  the  reindexing  phase,  it  is  strongly  recommended  to  provide  access  only  to  MLM
Administrators, thus avoiding potential database corruption.

   

F1- Help (User's manual)

If you press F1 on your keyboard or on  in the "Tools" menu, you will be redirected to the MLM User
Guide in PDF format. 

The "big" User Guide must first be downloaded from the Margill website.
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Useful Features List

Right mouse click

Bulk Import of Loans

Lead/Prospect approval and Record (Loan) import via Excel or JSON

Emails - Sending automatically or in batch with templates

Shortcuts

Search Tools

Global changes to the database (batch changes)

Notes - Record and Borrower

Attached Documents

Undo function

Check for Data Irregularities

System Warnings

Custom Unique Identifiers (Record, Borrower, Creditor)

Record Color

Calendar

Pocket Calculator

Dashboard

   

Right mouse click

The right button of the mouse  provides access to many powerful Margill Loan Manager (MLM) options notably in
the Payment schedule (payment schedule) and in many other windows.

Right mouse click in the "Record Summary" window

Right mouse click in the "Data" window

Right mouse click in the "Borrower" window (under "File")

Right mouse click in the "Payment schedule"
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Right mouse click in the "Post payments" tool

Right mouse click in the "Record Summary" window

In the "Record Summary" window (Main MLM window), right clicking with the mouse on one or more Records will offer a
series of options.

One Record selected Many Records selected

The "Copy Record" (and "Copy Records") option allows the quick duplication of a Record or Records exactly as they are
saved and without changes (they may be changed by double clicking on them afterwards).

 The  "Copy  Record"  (or  Records)  will  copy  the  complete  Record  including  Record  data,  any  changes  made  to  the
Payment schedule and the links to the Borrower, Co-Borrower(s) and Creditor(s). You will have the choice to include
or not the unlimited Custom fields and the Record Alerts. However, data pertaining to Electronic Funds Transfer will
not be included, nor the Unique Identifiers.
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"Copy" and "Copy All" will only copy the displayed (and/or selected) data (the lines and columns in the Main window), no
other data.

Archive - If this feature is enabled, allows Records to be archived in text mode, completely outside the normal framework
of the software. Option available only for very large databases.

The "Export  to..."  options  will  only  copy  or  export  the  Record  summaries  (the  data  columns  in  the  Main  window),  no
other data.

A user with all the required rights (Tools > Users) can place emphasis on certain special loans and assign these different
colors. Select the Record(s) in the Main window, right-mouse click and choose the "Record Color" option. 

The  "Global  Changes"  option  is  a  very  important  development.  This  tool  allows  users  with  the  proper  permissions  to
make changes to the database in batches, thus to many Records at a time for various fields, without the need to open
each Record one be one. For example, you could add new data in a Custom Field or change many Records from Active to
Closed in a few seconds. Consult the Global changes to the database (batch changes) section. 

The "Send Email / SMS" option allows you to send emails and SMS for the selected Records with a predefined template.
Consult the Mail Merge / Templates section to learn more on this.

Search Database: allows to find any text or number anywhere in MLM.

 
Right mouse click in the "Borrower" window (under "File")

The "Global Changes" option, allows users with the proper permissions to make changes to the database in batches, thus
for  many  Borrowers  (and  Co-Borrowers  and  Guarantors)  at  a  time  for  various  fields,  without  the  need  to  open  each
Borrower's data file one be one. Consult the Global changes to the database (batch changes) section.

Right mouse click in the "Data" window

In the "Data" window, if the amortization or the term in number of payments is not specifically known, the right mouse
click offers two additional choices:

With the "Specific Date" choice, the window below will  open prompting you to enter the end date of the amortization
period. Once a date is entered, the number of payments will  be calculated in the Data window. A date must have first
been entered in the "Origination Date" and the "First Payment Date".
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The amortization or term can also be determined based on the number of full years entered:

Right mouse click in the "Payment schedule"

In a "Payment schedule", highlight one or many lines with the Shift key (or Ctrl key) and the keyboard arrows (  ) or
the “Shift” key (or "Ctrl" key) and the mouse left click. Then right-click and the menu below will appear. Adjacent or non
adjacent lines may be chosen (see TIP box below).

Add

This allows you to add one or many lines at the end of a Payment schedule.
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When "Add Many Lines" is selected, the following window opens providing choices for these additional payments:

Notice  the  payment  Indexation  options  (that  will  appear  below  the  "Add  Fees"  option)  so  that  future  payments  are
indexed based on an amount or a percentage.

Column Fees can also be added by pressing on the "Add Fees" link.
 

Insert 

When one (1) line or many lines are highlighted, the following menu will appear with the "Insert" choice:

When one or more than one line is highlighted, the "Insert line(s)" choice will appear. Line(s) will be inserted above
and in between each of the selected lines.

MLM will also ask how many lines are to be inserted between each of the lines selected:
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For example, when these three (3) lines are selected (selected lines are highlighted in blue) and you indicate that two
(2) lines are to be added between each line:

Three set of two lines (total six) new lines with 0.00 payments will be inserted in the table above each of the selected
lines: 

The dates, payments and interest rates may then be modified for each of these lines by first changing the last date
(line) in each of the the series added in order to respect the compulsory chronological order.

With the "Rate Change" choice, the interest rate may be changed to any date. The rate may be applied to the rest of
the Table and the new equal payments recomputed to give a balance = 0.00 or other amount.  
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For more detail, see Adding or changing interest rates in a Payment schedule.

With the "Payment(s)" choice, additional lines may be added in a table as of the date indicated in the Date line of the
window  below.  Lines  will  be  inserted  automatically  at  the  right  location  in  the  schedule.  If  a  positive  payment  is
indicated,  this  will  be  a  refund.  If  a  negative  payment  is  indicated,  this  will  increase  the  principal  (additional  loan
amount) or an added fee, insurance, tax, etc. The "Annual Nominal Rate (%)" is grayed out since the rate that will
apply will be the rate on that payment date.

The payments that are added may also be indexed (step payments) annually, semiannually, quarterly or monthly. For
more information on indexed payments or step payments, consult the Step payments section.

 Delete - Selected Line(s)

Eliminate one or many lines at the same time in a Payment schedule.

See also: Deleting a line or lines

Delete PAP status for this payment (these payments)

This option only appears when one or more lines are submitted as Electronic Funds Transfer payments.

In the example below, only the lines in red are Electronic Funds Transfer payments.
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This option will delete the EFT special status. Deleting this status could be done for example, if a due payment (in the
example above, the Due Pmt for the amount of 9022.00 due on 03-08-2013) had to be canceled. 

Warning: If the status is deleted in MLM, this does not delete the payment at a banking level. The payment must
also be canceled with the ETF Processor directly. MLM does not send any directive to delete the payment.

Interest Rates

If only one line is selected, four (4) choices are offered with the "Interest Rates" option:

The first  two choices  calculate  the  interest  rate  for  that  line  only  to  yield  a  balance  =  0.00  on  the  last  line  of  the
Payment schedule or other balance chosen (also on the last line of the Payment schedule). 

To change the balance from 0.00 to another amount, at the bottom of the Payment schedule, change the balance
from 0.00 to another amount. 

If the balance at the bottom of the window is not the balance desired, choose instead, "Rate Adjusted for Balance =
X". The following window will appear in which to specify the desired balance.

See also: Interest rate (equal) recomputed to yield a balance = 0.00 or other amount.

The  third  choice  calculates  the  required  interest  rate  to  yield  a  desired  interest  amount  for  that  line  specifically.
Particularly useful to match the MLM Payment schedule to an old payment schedule. 
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See also Interest Rate recomputed to adjust Line (period) Interest amount.

With the "Insert Rate Change" choice, the interest rate may be changed at any date. The rate may be applied to the
rest of the Table and the new equal payments recomputed to give a balance = 0.00 or other amount.  

 

If many lines are selected, the following choices are available:
 

"Rate Adjusted for Balance = 0" calculates the interest rate for the selected lines to yield a balance = 0.00 or other
balance indicated at the bottom of the window. 

"Rate Adjusted for Balance = X" calculates the interest rate for the selected lines to yield a balance = to the specified
balance in the window that will appear. 

With the "Insert Rate Change" choice, the interest rate may be changed at any date. The rate may be applied to the
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rest of the Table and the new equal payments recomputed to give a balance = 0.00 or other amount.  

"Modify Rate - Selected Lines", will change the interest rate for the highlighted lines.

See also: Adding or changing interest rates in a Payment schedule

Payments

By highlighting a single line, six choices are offered:

With "Payment(s) Adjusted for Balance = 0" the payment for that line will  be adjusted to yield a balance = 0.00 or
other amount indicated at the bottom of the window.

Furthermore, a window will open (if this advanced feature is activated), providing the selected line or lines a special
behavior by which the payments for the selected lines are always recalculated to return a final balance of 0.00 or X.
See: Payments (equal) recomputed to yield a balance = 0.00 or other amount.
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With "Payment(s) Adjusted for Balance = X" the payment for that  line will  be adjusted to yield  a  balance =  to  the
specified balance in the window that will appear. 

"Interest-only Payment" will calculate the payment to refund the interest only. 

If  this advanced feature is activated, a window will  open,  providing the selected line or  lines a  special  behavior by
which the payment always refunds only the interest when various payment changes are made above these "special"
lines. See the Interest-only payments section.

"Fixed  Principal  Payment"  will  open  the  window  below  allowing  you  to  specify  the  fixed  principal  amount  to  be
refunded.  The  payment  will  then  be  computed.  The  fixed  principal  amount  may  also  be  recomputed  to  yield  a
balance = 0.00 or other amount. 

If this advanced feature is activated, the window will give the selected line or lines a special behavior by which the
payment always refunds the fixed principal amount entered when various payment changes are made above these
"special" lines. See the Fixed principal payments section.
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The three (3) line "Behavior" advanced options above (automatic payment recalculation) can be activated in Tools >
Settings > User settings > Options: Interest-only and Fixed Principal > Display "Behavior" option...

"No  Interest  Add.  Princ.,  Fees,  Tax,  Insurance,  etc."  allows,  for  the  selected  line(s),  not  to  charge  interest  on  the
principal, fees or other added in the Payment schedule. See Additional principal, fees, penalties, insurance and taxes.

"Untag -  Interest-only  /  Fixed Principal  /  No Interest"  will  eliminate  the  tag  added  on  the  selected  payment  lines.
Thus:

o Payments will no longer be recomputed to refund only interest;
o Payment  will  no  longer  be  recomputed  to  regularly  refund  a  fixed  principal  amount  when  changes

(payments missed, changed, etc.) are made above these lines;
o The Fees (or other) will now bear interest;

See Interest-only payments,  Fixed principal payments and Additional principal,  fees, penalties, insurance and taxes
sections. 

 

When multiple lines are selected, an additional choice is offered, that by which the payment for multiple lines may



Page 449

© Jurismedia Inc., 2007- 2023

be changed. 

A new payment may be included or an additional amount added or subtracted from the existing payments. In  the
example below, 500 was subtracted from the original payment amounts for the lines selected. 

See also the Payments section for more detail.

Column Fee Payment Order or Principal Payment

If  you right click with the mouse when the Line status is  a  "Paid Payment" type,  the following option  will  become
available: "Column Fee Payment Order"

By  default,  MLM refunds  the  Column fees  by  chronological  order  (from 1  to  6).  With  this  option,  it  is  possible  to
modify the refund order by selecting the fee to be refunded first for the selected line or lines.

For more detail on this, see the Special Refund Order for Column Fees subsection in the Fees,  Insurance and Taxes
by Column (and Automatics) chapter.

If you right click with the mouse when the Line status is "Paid Principal", the following option will become available:
"Principal Payment"
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This option determines the desired refund sequence. The default option, Pure Principal + APR Fees Financed and APR
Fees Financed are refunded on a pro-rated basis.

For more detail, see the "Principal" Type Line statuses subsection in the "Payment" Type Line statuses chapter. 

Column Fees

Column  fees,   are  much  more  sophisticated  than  Line  fees  for  reporting  and  are  usually  used  when  regular  fees
(insurance or taxes) are factored in the payment. When a payment is actually made (Paid) these fees are included in
Payment type Line statuses. For accounting, they are paid before interest and principal.

You will have access to this window:

You will then be able to activate up to six fields. By default, the field names are: "Column Fees 1", "Column Fees 2",
"Column Fees 3", etc. These field names can be customized from through Tools > Settings > Custom Column Titles.

You will have to chose among the following options:
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For  more  information  on  the  "Column  Fees"  consult:  Margill  Loan  Manager  Calculations  >  How  to  do...  >  Fees,
Insurance and Taxes > Fees, Insurance and Taxes by Column.

Calculation method

For "short periods" you may chose a special calculation method as opposed to the normal Effective rate method:
 

The method will be applied to the specific lines selected.

For more information on "short periods", "long periods" and the default short setting, consult the Short & Long
periods section of the Calculation methods chapter.

Payments, Principal, Interest - Accumulated / (9a) Payments, Principal, Interest -  Selected Lines 

Obtain the total of the principal and accrued interest (or totals for specific lines) in a payment schedule. Adjacent or
non adjacent lines may be chosen.
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Line Color

This option allows you to add or remove a color on selected lines of the Result table.

Record Color

This option allows you to add or remove a highlight color for a Record (the color will be visible in the Main window).

Update the "Expected Principal - Selected Line(s)"

Update  the  Expected  Principal  when  the  option  activated  in  the  System  Settings  (Administrators)  >  Activation  of
"Expected Principal" (see the important explanations related to this concept in this section).

Global Changes  - Selected Line(s)

Allows you to change the data of several columns including Comment, True Pmt date (Grace/EFT), the Expected Pmt,
the nine custom columns, etc. See Global Changes - Payment schedule 

Display Log - Selected Line(s)

This  option  allows  you  to  consult  the  transaction  history  on  the  selected  Lines  for  the  changes  made  after  the
installation of MLM version 5.6 (summer 2023) on your machine.

Copy and Copy all

Copy the selected line or lines to another program such as a spreadsheet or text editor.

Export Table to...

Export the schedule to Excel, Word or XML (Web). This does not copy the totals, only the Schedule itself. To copy the
entire  Schedule  including  header,  client  data  and  totals,  use  the  "Print"  function  that  allows  the  export  to  other
formats such as PDF. 
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TIP! – Eliminate or modify non adjacent lines

It is possible to eliminate or modify only some non contiguous lines selected in a Table. Use the “Ctrl” key and
the left click of the mouse to choose the desired lines. Make the changes. The interest and the principal will
be recomputed automatically.  

In the example below, only the lines selected (in blue) will  be changed or affected by the right mouse click
operations. 

Right mouse click in the "Post payment" tool

Change / Change Line status of the selected line(s) to - changes the Line status or  Line statuses of  the payments that
have been highlighted (now in blue) by one of the Line statuses appearing in the list to the right.

Change /  Change Line status of  the entire table to  -  by  selecting any  line  in  the  table,  changes the  Line  status  of  the
entire table by one of the Line statuses appearing in the list to the right.
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Change / Change the "Due Pmt" of the entire table to - by selecting any line in the table, changes the Line status of a
"Due Pmt" type by one of the Line statuses appearing in the list to the right.

Change Payment Date - when multiple lines are selected, this allows the user to change the Payment date in bulk. There
are constraints such as the date to be changed cannot be before the previous line's date, nor greater than the next date
in the Payment schedule. 

Change True Pmt Date (Grace/EFT) - when multiple lines are selected, this allows the user to change the True Payment
Date Grace/EFT in bulk. This date cannot be before the Record's Origination date.

Display  Record  change  shows  changes  made  to  this  Record  (one  line  highlighted  only)  during  the  session  in  the  Post
payment tool.

Revert selected lines to original data  - After changes are made in a line (date change, Line status change, Column fees
added,  etc.),  this  option  allows  you  to  undo  these  operations  without  the  need  to  cancel  all  changes  in  non-selected
lines.

Open Record - will open the selected Record's Payment schedule. The table can then be updated manually. The option is
available  only  when ONE (1)  line  is  selected.  This  is  useful  in  irregular  situations  that  are  not  handled  in  the  payment
update tool.

Record Color (if  the Administrator provides the proper permissions) allows a User to place emphasis on certain special
loans and assign these colors. The color will only be posted in the first column in this window (not the whole line). 

Refresh Table - will update the table if for example, the "Payment Date" was changed or if "Select all late payments" was
changed (checked or unchecked).

Export to Excel - Exports the selected line or lines to Excel.

   

Bulk Import of Loans (Manually)

Margill  Loan  Manager  (MLM)  allows  multiple  methods  for  mass  data  import  and  data  updates.  Some  methods  are
manual but as of versions 5.3 and 5.4, processes have been automated via APIs (Application Program Interface).

For the automated import/update of Loans/Borrower/Co-Borrower/Guarantor via API (JSON and Excel files) consult this
web PDF document: https://www.margill.com/margill-loan-manager/win_service-api.pdf.

For the Salesforce API (Borrower import and update) consult this web PDF document: https://www.margill.com/margill-
loan-manager/Margill_API_Salesforce.pdf

The automated aspects offer greater performance than the manual processes but require upstream information systems
to produce the required files as required. This is often less accessible for smaller players.

This section deals with the manual bulk import of Loans via Excel sheets.

This tool is useful  when you regularly import many loans from a database or  when your clients apply  online.  The data

HTTPS://www.margill.com/margill-loan-manager/win_service-api.pdf.
https://www.margill.com/margill-loan-manager/Margill_API_Salesforce.pdf
https://www.margill.com/margill-loan-manager/Margill_API_Salesforce.pdf
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must be previously entered in an Excel sheet.

This not only reduces data entry errors (when loans are entered into MLM manually) but also saves significant time. It is
worth using this tool when ten or more loans are to be entered in MLM each day.

Since importing loans involves many subtleties and special codes to take into consideration, we recommend users consult
the Margill team for guidance. For example, for monthly interest compounding, the number "4" must be included in the
Excel sheet instead of the word "Monthly". This feature should only be used by experienced MLM users.

IMPORTANT:  This  tool  can  only  import  data  related  to  loans  (calculation  data,  loan  identification  data,  custom  fields,
etc.).  Borrowers, Creditors and Employers cannot be imported in  MLM with  this  tool.  A  Borrower (or  any  other  actor)
must  already be  entered in  MLM or  must  be  imported  beforehand  with  the  "Import  Data  (Borrowers,  etc.)"  tool.  See
Getting Started > Import Borrower, Creditor, and Employer Data. 

o When  importing  loan  data  with  this  tool,  a  link  can  be  created  with  the  Borrower,  the  Co-Borrower,  the
Guarantor and the Creditor for each loan. If not, the link will have to be done manually after the import. 

o In order to create this link, one of the unique identifiers must be included in the Excel spreadsheet:

o If some Records are to be imported with credit reporting (Metro 2), we suggest that you communicate with
the Margill team for support.

Once the importing template is created, it can be saved and reused regularly.

See Getting started > Bulk import of Loans and Database configuration.

See also Lead/Prospect approval and Record (Loan) import via Excel or JSON 

Spreadsheet Features for Importing Loan Data

 .xlsx File format (Excel format).

o If your file is CSV or Text (.txt), you will have to convert it to an Excel format.
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o It is possible to import files created in various formats in MLM with the help of the Margill team. 

 Only the first sheet will be included.

 Column titles must be entered on the first line.

 Data starts on the second line.

 Data will be included up to the first empty line.

 Data will be included up to the first unnamed column.

If  your  old  system includes  fields  not  available  in  MLM  (other  than  normal  fields  such  as  Name,  First  Name,  Address,
Email, etc.), create custom fields beforehand in MLM. Go to Tools > Settings > System Settings (Administrators) > Custom
Fields > Borrowers (or Creditors) tab and use fields 1 to 9 or the Unlimited fields (Table format).

These fields  can  also  include drop down menus you  create.  Be  careful,  field  types  (text,  monetary,  integer,  etc.)  must
match fields from your Excel sheet. Text fields are the most versatile. See Custom Fields and Scroll menus.

Steps to Follow

To import data to MLM, go to Tools > System Settings (Administrators) > "Special" section > Import Loan Data.
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The following window will appear:
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First step, select the file to import.

Once selected, fields included on the first line of the spreadsheet will appear in the "Column Header Name" column.

Click  on  the  field  in  the  spreadsheet  that  you  wish  to  associate  with  the  MLM  field  (this  is  called  "mapping").  In  the
example above, "Origination Date" has been selected.

Select the MLM field in the left table that matches the field in the right table and click on the arrow to insert the field in
the "MLM Field Name" column. In the example above, "Origination Date" has been selected for "Origination".
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The fields on the left  highlighted in green are  required fields  and  must  be  included in  you  Excel  spreadsheet.  Without
these fields, the Payment schedule cannot be done.

Mandatory fields specified by the Administrator will  also appear in red. If  these are not entered in the Excel sheet and
mapped, the import cannot be completed.

Once the fields' association is completed, click on "Import" . It is not necessary to import each field.

If  an  error  is  detected  in  the  original  file,  corrections  will  have  to  be  made  before  importing.  Verify  that  the  "Excel
spreadsheet Features..." above are respected.

Saving Import Format

A window asking if you wish to save the Import Format will appear. By clicking yes, the format created will be used for all
subsequent  imports.  However,  the  spreadsheet  must  be  in  the  exact  same  format  (names,  header  names,  number  of
columns, data format).

Data Validation:

 The following Data must be entered: Origination Date, First Payment Date and Principal (Original). These are the
required fields.
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 Field Format (date, monetary, integer, etc.) must be respected:

o Date format must be a "Date" type cell in the spreadsheet.
o Percentage format must be have a maximum of four decimals.
o Monetary format cannot include currency and must have a maximum of two decimals.
o Note: If some data (monetary, percentage or other) has more decimals than allowed by MLM, they will

be rounded during the import.
o Note: A Text format can include all types of characters (alphanumeric). Text is a very versatile format.

When you scroll your mouse over a field's name in the "MLM Available Fields" column, you will see all the variables
allowed for Data import.

You  also  get  the  list  of  variables  allowed  in  the  link   located  at  the  bottom  left  of  the
import window

For  example,  enter  the  following  variables  in  your  spreadsheet:  1=Annually,  2=semiannually,  3=quarterly,  etc.  for
"Payment Frequency".
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 A value under "Unique Identifier" must not be repeated.

 When a scroll menu is defined in MLM, imported data must EXACTLY match the data in the scroll menu including
capitalization (upper and lower case), accents, special characters, spaces, etc.

Errors will be identified during the import first attempt in the "Import Report Preview" window. In the following example,
the  date  in  red,  "2999-12-31"  does  not  exist.  MLM  reports  errors  and  won't  allow  importing  as  long  as  they  are  not
corrected.

The "Table to Excel"  button  allows the  user  to  export  the  table  to  Excel.  However,  erroneous
data will not be highlighted. It is therefore recommended to note the data in the red cells and to leave MLM's window
open  before  making  corrections  in  the  spreadsheet.  Make  the  corrections  and  then  import  again  using  the  method
described above.  

Once all the corrections have been made, click on "Update"  to import the data. A message will then
confirm the import with the number of Loans imported in MLM.

You can close the System Settings window with the Cancel button.
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Automatic email after import

After importing Records, some Creditors send a welcome email to their Borrower. In order to avoid performing a second
operation, the email can be sent automatically after creating the loan in MLM.

Once  the  data  has  been  validated,  but  not  yet  imported,  the  data  validation  window  offers  the  "Send  Email  with
template" box.

By selecting this  option,  and after  you  have clicked on  "Update",  the  following window will  appear  so  you  can specify
from whom the email will be sent, to whom it will be sent as well as a copy if needed, and finally, which Email Template
should be used.

   

Lead/Prospect approval and Record (loan) import via Excel or JSON 

If your web site allows potential customers to apply for loans online, you can bulk import all customer information and
their financing needs, while managing the applications (approved, rejected, pending, etc.). You can this with the "List of
Applications" tool.

This module was designed to create a link between applications from prospective customer made via the Web (or data
captured in some other manner) and Margill Loan Manager (MLM) in order to save time and avoid having to manually
re-enter all the potential future customer / Borrower data.

When  individuals  fill  out  the  application  form  on  your  web  site,  these  applications  can  be  quickly  and  efficiently
processed by importing data in Excel or JSON format into MLM. You will also have access to a database of all approved
and rejected applications without them being in the main MLM system.

Steps for importing applications
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Processing requests imported into MLM

Characteristics of spreadsheets (Excel) and JSON formats for import

Steps for importing applications

To access this module, click on the "List of Applications" button from the "Tools" menu in the Main MLM window.

The following window will open. Click on "Import" in order to import the applications from your web site to MLM.

Choose the file format, either Excel or JSON. Consult the sections below in order to properly configure the import files.

Click on  in order to select the desired file via your browser. Click on "Import".
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Processing applications imported to MLM

Once imported into MLM, applications are automatically classified under the "Pending" status. In this window, you can
decide which applications you wish to show by selecting the desired status ("All", "Pending", "In Process", "Approved",
"Declined"). 

Also,  you  can  delete  a  application  by  checking  the  box  located  on  the  left  and  by  clicking  on  the  
button. For more efficiency and speed, right-click on the mouse to check / uncheck several lines at once.
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To manage applications and their status, simply select one application at a time and click on .  Details of
the application will be displayed in a window, as shown below. All data can be modified by the user before importing, so
if  the  applicant  did  not  follow  the  application  guidelines,  the  user  can  check  and  correct  if  necessary.  The  "Approval
process (Comment)" and "Reason if rejected" are useful for tracking these types of applications.
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In the following example, two alerts can be seen by the user. The first one, the flashing red exclamation mark  beside
of the "Employer" title, means that this Employer (applicant's employer if it is a pertinent information for you) is already
in the MLM database. To correct the situation, you need to click on the exclamation mark.  Duplicates are reported the
same way for potential Applicants / Borrowers.
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Upon clicking on the red exclamation mark , the following window will open: 

The User has tree options:

1. Use selected: The Applicant/Borrower (or Employer) selected in the list will replace the one registered in the list of
applications. When creating a loan, if approved, there will  be no duplication in the MLM database. In the example
above, the loan created will automatically be linked to the Employer with the ID 20068.
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2. Create  a  new  Employer:  Information  entered  in  the  application  form  will  be  used  to  create  a  new
Applicant/Borrower (or Employer) in the database. 

3. Cancel:  With  this  button,  the  user  will  be  returned  to  the  application  form  without  taking  immediate  action
concerning the potential duplicate.

Warning! If  the exclamation mark is ignored or  not  processed, there won't  be other messages to notify  you and if  the
application is approved, a new Borrower (or Employer) will be created automatically even if this creates a duplicate in the
database. 

Here are the criteria for identifying duplicates for Applicants/Borrowers: 

Name, First Name Business Show the !

Scenario 1 Exists Exists Yes

Scenario 2 Exists Does not exist Yes

Scenario 3 Does not exist Exists Yes

Scenario 4 Does not exist Does not exist No

For Employers, only the Business name is verified. If the Business already exists in the system, the exclamation mark will
be displayed.

For  the  Applicant/Borrower  and  the  Employer,  complete  names  must  match,  otherwise  the  user  will  not  receive  a
warning.  For  example,  if  an  applicant  writes  the  Employer  Business:  "Inter-Com",  and  the  database,  this  Employer  is
already created under the name of "Inter-Com Inc.", you will not get a warning from the lead approval module.

However, there is  another tool  to manage duplicates in  MLM for Borrowers and  Creditors  only.  To  find  out  more,  see
Settings > System settings (Administrators) > Special > Merge Borrowers and Creditors.

The button can also by used at any time to select an existing Borrower or Employer in MLM. If,
for example, an Applicant omits to include his Employer and you later learn, after speaking with him, that he works at the
same company as twenty of your Borrowers, it will be quick and easy to click on this button and to select from the list of
Employers.

The second warning is the red circle  that can appear in certain circumstances beside the "Decline" button.  System
messages  inform  you,  for  example,  that  the  Applicant  entered  non  valid  data  that  is  not  recognized  by  MLM  during
import, or that the imported file has irregularities that must be corrected. Here is an example:
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A third warning can also appear like this, for custom fields:

For example, above, we discover a problem: In addition to the "Yes" and "No" choices in the web site's drop-down menu,
we also included "Maybe". This third choice had not been configured in MLM, therefore is not recognized during import.
The user can therefore make another choice from the drop-down menu in the applicant's form in order to regularize the
current form and/or create the missing option in the drop-down menu, via System Settings > Custom fields.

When clicking on , the Borrower and the Employer (if applicable) will be created in the system, unless
you have selected existing ones from your database. The user will receive a confirmation of the data entered in MLM. 

       

The  Record  window,  used  for  entering  a  loan,  will  open  and  the  information  from  the  application  will  be  entered
automatically. You will then have the opportunity to enter the other information necessary for the creation of a  Record
(loan  or  other)  (dates,  interest  rates,  number  of  payments,  etc.).  If  necessary,  you  can  also  modify  any  information
already entered. 

Also, the application status will change from "Pending" to "Approved" in the "List of Applications" management table as
long as you complete of creation and saving process of a new Record, otherwise, only the Borrower and the Employer
will be created in the MLM database and the application status will remain unchanged.

When the status is "Approved", no information can be modified in the Applicant's form. This is a final status: you cannot
go  back  and  modify  it.  Of  course,  the  user  can  make  changes  in  the  normal  MLM  database  for  the  Borrower,  the
Employer and the Record itself.
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With  the  Approved  applications,  the  user  can  easily  find  the  Record  which  resulted  from  this  approval  by  using  the
"Record ID (MLM)" field.

When clicking on , the application status will change to "Declined", and then, this application can no
longer be used. No information can be modified either. Warning! This is a final status: you cannot go back and change it.

Another option is available for the application status: "In process" means to the other users that the application is being
analyzed.  This  Status  can  be  selected in  the  "Status"  drop-down menu on  the  top  right  side of  the  "Loan Application"
window. This field also allows you to switch from one Status to another. Warning! "Approved" and "Declined" statuses
are final and cannot be changed.

For  more  information  on  how  to  use  this  module,  please  contact  Margill  customer  service  by  email  at
support@margill.com.

Characteristics of spreadsheet (Excel) and JSON import formats

The document specifying the formats and examples is available through Margill customer service.

   

mailto:support@margill.com
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Emails and SMS - Sending automatically or in batch with Templates

Margill  Loan  Manager  (MLM)  allows  you  to  easily  communicate  by  email  (and  by  Email  to  SMS  -  if  your  Borrower's
cellular  provider  allows  it)  or  by  SMS  directly  (subscription  required  with  FolioMedian)  with  your  Borrowers.   Many
options are available:

Sending automatic emails / SMS based on Line status - for example, email notice that a direct debit will  be made in 72
hours; notice that a payment has been declined by the bank, etc.

Sending emails in batch with Templates

1. at the time of batch import of loans via spreadsheet
2. in the Main window (right click of the mouse) 
3. in the "Today's Alerts" window
4. individually in the Record itself

Sending emails settings

Sending documents attached by email

The emails or SMS can be sent to the Borrower, to the Co-borrowers in carbon copy (CC) and to the Guarantors but in
blind carbon copy (BCC).

Sending automatic emails / SMS

With  no  human  intervention,  it  is  possible  to  notify  your  Borrowers  of  a  particular  situation  that  will  occur  or  has
occurred in the Payment schedule.  For example, a reminder that a payment is due soon (in the case of pre-authorized
payments  (EFT))  or  notify  that  a  payment  has  been  rejected  (no  sufficient  funds  -  NSF).  Your  Borrower  can  then  be
encouraged to communicate with the person in charge in order to quickly remedy the situation.

To configure the desired conditions, you need to create Alerts based on the Line statuses. Via the Main window, under
Tools > Alerts > Set Alert > Line status, you can configure Alerts that will automatically send emails based on a template,
which is automatically personalized to each Borrower and situation using merge codes, if or when one of the Line status
conditions occurs. See Alerts for details and instructions.
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To create or modify an email or SMS Template, via the Main window, choose Reports and the "Merge / Email Template"

 button. Refer to this section in the User Guide to learn more. 

Sending emails or SMS in batch with Templates

1. At the time of the loan batch import via spreadsheet  

When importing new loans, the system can send emails/SMS created with a Template. This allows you to send an email
for  each  imported  loan  (Record).  Simply  check  the  option  "Send  Email  with  Template"  at  the  bottom  of  the  import
window. When you will click on "Update", the data will import as usual.

Once the import is done, a window for managing emails will appear so that the user can choose the desired options and
the email  connection (default  connection or  other)  as  well  as  the  Template to  use.  The user  can  also  add  other  email
addresses in order to receive, for example, a copy of the sent emails. When clicking on "Send Emails", a confirmation of
the number  of  Records for  which an  email  will  be  sent  will  appear.  This  number  should  correspond to  the  number  of
imported loans.

Warning!  When  choosing  this  option,  an  email  will  be  sent  to  each  imported  Record.  To  exclude  certain  Records,  a
separate import must be done with the "Send Email / SMS with template" option unchecked.



Page 473

© Jurismedia Inc., 2007- 2023

To  create  of  modify  an  email  or  SMS  Template,  choose  Reports  and  than  the  "Merge  /  Email  Template"

 button. Refer to this section in the User Guide to learn more. 

2. In the Main window (right click of the mouse)

Via the Main Window (Record Summary window),  it  is  possible to send an email  based on a template for the selected
Records.  For  example,  user  could  send  to  all  or  only  to  some selected  Borrowers  and  the  Co-Borrowers,  a  change  un
company policy or some special offer.

Simply select or  highlight the Records for which you wish to send an email,  right mouse click and select "Send Email  /
SMS".

3. In the "Today's Alerts" window

When checking "Today's Alerts", which are accessible when MLM is launched, or by choosing Tools > Alerts > View Alerts
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> Current and History, it  is possible, for "Record" type Alerts, to send multiple emails at once using an email template.
After selecting all of the Alert Lines requiring the same template, simply click on "Send Email" and in the window select to
whom to send (Borrower / Co-Borrower / Guarantor), if a carbon copy is to be sent and the email template to be used.

When  only  one  alert  is  chosen,  the  "Open  Email"  button  will  become  active.  By  clicking  on  the  button,  your  email
software  (Outlook,  Thunderbird,  etc.)  will  open,  allowing  you  to  write  an  email.  No  template  can  be  used  with  this
sending method. 

If  you  use  Gmail,  Hotmail  or  other  browser-based email  software,  this  will  not  open  the  Gmail/Hotmail  pages  since  a
browser cannot be defined as default email software. 

4. Individually in the Record itself

Access to this tool is directly into the Payment schedule of a loan, by clicking on the yellow envelop (with the SMS logo)
on the right, under the calculator. Of course, the email or SMS will only be sent for the Record in which you are logged
into:

Sending settings

Upon  clicking  on  "Send  Email  /  SMS"  from the  Main  Window  scroll  menu,  in  Today's  Alerts  or  on  the  yellow  envelop
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directly in the Record, this window, with Email and SMS tabs will open:

 You can use the Default Email or the one associated to your account. Connection and settings available can be found
in Settings >  Email connection. For SMS configuration see: Settings > FolioMedian (SMS) Connection.

 Email/SMS for Borrower, Co-Borrower(s)(CC) and Guarantor(s)(BCC): check if you wish to include or not. 

 Add other Email (cc) / SMS: You can add your email/mobile if you wish to receive a copy of the sent emails/SMS.

 Email / SMS Template: Choose the template you wish to use to send emails or SMS. All merge fields will be replaced
by their respective values before sending. See Reports >  Merge / Email Template.

 Sender's Email: This email is defined in Settings > Email connection.

The number of selected Records for sending emails/SMS is indicated in the window header.

Here is an example of an email received:
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To create or modify an email Template, choose Reports and than the "Merge / Email Template" 
button. Refer to this section in the User Guide to learn more.

Sending attached documents by email

1) You can send the Payment schedule in PDF format by email. To do so, open the Record and click on "Attach". Choose
the "Attach PDF Payment schedule to Email" option.

A document preview will  open.  Via the "Export" tab,  choose the "Email  with attached PDF" option.  Your default  email
software will  open and you will  be able to write your  email  and  subject.  The PDF file  will  already be  attached to  your
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email.

If  you  use  Gmail,  Hotmail  or  other  browser-based email  software,  this  will  not  open  the  Gmail/Hotmail  pages  since  a
browser cannot be defined as default email software.

2) A single or multiple Payment schedules can also be sent via the Main window (right click) and with the  icon from the
Payment schedule. See sections above and check the "Attach Payment schedule". You can also see the Payment schedule
(only the first if you are sending multiple schedules at once) by clicking on "Display Report".

3)  The  Document  Merge  tool  also  allows  to  send  emails  with  templates  along  with  attached  Docx  or  PDF  files.  See
Reports > Merge / Email Template.

   

Shortcuts

The use of shortcuts greatly facilitates the use of Margill Loan Manager (MLM). All MLM shortcuts are accessible by
pressing the F2 key:

General shortcuts

The F1 key accessible from anywhere in MLM, displays the User Guide in electronic format as defined in Settings.
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Calculations can be aborted by pressing “Alt C” simultaneously. The calculation will stop a few seconds after.

The "Ctrl Alt Space" keys adjust the width of columns in the Main MLM window (Record Summary window) and in the
Payment schedule.

The  "Ctrl  Alt  Shift  F12"   keys  allow  to  modify  all  of  the  selected  "Due  Pmt"  type  Line  status  to  "Paid  Pmt"  type  Line
statuses. 

The "Ctrl Alt Shift F11"  keys allow to modify all of selected lines to one of the five (5) "Due Pmt" type Line statuses.  

The "Atl X" keys allow the selection of the "Due Pmt" Line statuses of your choice. 

In the Main window and in the Payment schedule, to obtain a larger font, use "Ctrl ". To reduce the size, use "Ctrl ".
You may reset the original size in Tools > Settings > User setting > Reset text size.

Record / Line selection in a Payment schedule

To select all Records or lines in a Payment schedule, use "Ctrl A". One line should be highlighted.

In a Payment schedule, to select only lines with a payment, thus a payment that is positive or negative, thus excluding
payments with a value of 0.00 (such as all lines except a change in interest rate for example) use "Alt A". One line should
first be highlighted.

To select one line out of every X lines, use "Alt L". The following window will appear:

By entering 12 for example, one line out of every 12 will  be selected starting from the line selected and every 12 lines

afterwards. You can then add a line above each of these lines with or change the payment of these lines or do any
other Right mouse click function that will apply only to these lines.

In a Payment schedule, to select only positive lines, select one line and use "Alt P". To select negative lines, use "Alt N".

 "Alt Z" is used to select all rows for which payments are 0.00.

In a Payment schedule, to select every other line, select one line and use "Alt 2".  This will  select the line selected and
every other line after that.

"Ctrl Alt R" should rarely be used. This shortcut is used in the Payment schedule to modify, for the selected lines only, the
amount in column "Expec. Pmt" to the amount entered in the Payment column. Thus, the amount in the "Outstanding
(Balance)"  column  is  recomputed  to  reflect  this  change.  See  further  explanations  pertaining  to  this  column  in  the  "
Payment schedule columns" section.
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Search Tools

There are three options to find data (a customer (borrower), company, loan, loan date, loan amount, etc.) in Margill Loan
Manager (MLM).

1) Search in Filter mode in Main window

Filter option

2) Search mode in Main window

3) Full database Search engine

All searches are carried out from the Main window (Record summary) according to the "Filter" mode, or "Search" mode
which is selected by each user via the "User settings" tab:

Main Window in Filter Mode

The full database search engine is accessible with the right mouse click (Search Database) in the Main window:
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Full database Search engine

1) Search in Filter mode in Main Window

In order to search for a specific client, company, loan, loan date, loan amount, etc. in the Main (Record Summary) Margill
Loan Manager (MLM) window, use the column headings to sort the information as desired. MLM will sort by ascending or
descending alphabetical, date or numerical order. 

A specific search may also be done by pressing on a column's magnifying glass .  Then enter one or more letters to
search for the desired information.

In the example below, "C" was entered for the company and the C Records appeared. More characters may be entered to
find an exact match. 

Searches may be done on any column in the Record Summary window. To insert an additional field in this window, see
Displayed column selection, name and order. 

Filter option

In order to find more "hidden" data, use the "Filter" option with the right mouse click button. This option allows you to
perform more detailed searches in each of the columns depending on whether the columns are in numeric, text or date
format:
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Numerical data options

Text data options

Date format options

For example, we are searching for all Records that contains the letters "land" in Last Name. Right click on the mouse >
Filter  >  Contains  >  write  "land"  in  the  header.  Only  Records  containing  these  four  letters  in  the  Last  Name  will  be
displayed, since not only is this a search tool, but primarily a filter.
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For data in Date format, an interesting option is to search for data between two dates (Included between 2 bounds): 

You can then add the dates. Dates entered are included in the results.

In  order  to  display  all  Records  again,  simply  delete  the  filter  letters  or  with  the  right-click  mouse  button,  "Delete  the
filter".

To learn more about Filter Mode, see Main Window (Record Summary) > Display Filters.



Page 483

© Jurismedia Inc., 2007- 2023

To go to search Mode, click on .

2) Search Mode in Main window

Search Mode is useful for large databases (over 1000 loans) because it  allows to quickly find data without the need to
show all Records.

By default, no search field is selected. Click on the "Search Fields" link. The following window will appear
allowing to choose up to six (6) search fields:

You can specify the order in which fields are displayed in the Main Window. The order in which the fields are displayed in
the  Main  Window  can  be  specified  by  entering  the  numbers  (1  to  6)  in  the  "Order"  column.  Choices  above  allow  to
display the choices below.
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To  quickly  switch  from  "Filter"  mode  to  "Search"  mode,  use  the  keyboard  shortcut  CTRL+ALT+M  when  in  the  Main
window (Record summary).

To learn more about Search Mode, see Main Window (Record Summary) > Search Mode.

3) Full database Search engine

This  tool  allows  to  search  the  entire  MLM  software  for  text,  dates,  rates  or  amounts.  Data  will  be  searched  in  the
Records, the Borrowers' files (including Co-Borrowers and Guarantors), Creditors' files and/or Notes.

In the Main window, right-click with the mouse and choose "Search Database". In version 5.4, the tool is in Beta mode
since some improvements may be necessary.
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To search for text, enter a minimum of three (3) characters and a maximum of ten (10). A user can select (on the left of
the window) a single or several search fields if unsure where to search. After clicking on the "Search" button, the user will
be able to view the search results under the tab(s) corresponding to the search field(s).

The advantage of searching with a few characters, for example, "mac" instead of "MacDonald" in the following example,
allows  results  that  include  potential  typing  errors,  truncations  and  abbreviations  on  the  word  searched.  On  the  other
hand, the disadvantage is that data may have no relation to what you are looking for. It  is  therefore recommended to
refine the search by adding more characters in the input field.

In the following example, there is a note about Mr. MacDougal. This note has no connection to what the user was looking
for.  On  the  other  hand,  if  there  had  been  errors  in  spelling  the  name  MacDonald,  such  as  "Maconald"  (with  the  D
missing), the results would still have been displayed. 
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For  a  search  by  Date,  real  dates  in  date  format  will  be  found  as  well  as  text  (in  the  Notes  for  example)  but  on  the
condition  that  the  date  is  entered  as  the  Windows  short  date  format  of  the  computer.  If,  for  example,  the  user  was
looking for the 03-03-2021 in the Notes and this  date  was entered there as  March 3,  2021 or  2021-03-03 or  2021-3-3
(without the zeros) or even 03/03/2021 (slashes instead of dashes), this date would not be found because the text does
not respect the precise format which is 03-03-2021.

With the exception of search results in the Notes, results that match the search criteria will be highlighted in yellow.

   

Global changes to the database (Batch changes)

Global changes to the database (batch changes) is a very efficient tool that allows authorized users to perform multiple
data changes for Records (loans) or for Borrowers.

This is a most useful tool since users are not required to open each Record or Borrower individually to make changes or
add new data.

The Administrator must have given users the right to access this utility beforehand - see Getting Started > Administrators
and users.

See next sections for more information:

Global Changes - Records

Global Changes - Borrowers
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Mass import via spreadsheet

Global Changes - Payment schedule

Mass changes via the Post payment tool

Mass adding/changing Creditors

   

Global Changes - Records

With the Global changes, it not necessary to open each Record individually to make the following changes.

o Record Status
o Sub-status
o Record Type
o Record Owner (Margill User)
o Use Automatic Column Fees
o Currency
o File Number
o File Number (Numeric)
o Record Date
o Accounting ID
o Record Unique Identifier 1
o Record Unique Identifier 2
o Maximum Credit
o Alerts: Email/SMS sending Enabled
o EFT active
o Doubtful Accounts (%)

o Compounding
o Grace Period (days)
o Day count
o Balance Expected Principal >= 0.00

o APR Names (5 fields)

o Record Custom Fields (1 to 9)
o Record Custom Fields (Unlimited fields - Table format)

o Record submitted to Metro 2
o Account Status
o Account Type
o ECOA/Code
o Portfolio Type

o Data for the Interest tables (advanced module)

To  do  this,  select  Records  that  need  to  be  changed  in  the  Main  Window  (Record  Summary).  Then,  right  click  with  the  mouse  and
choose "Global changes".

In the "Global Changes" module, fields that can be changed are classifier in four categories:

 Record various Fields / Options
 Record Custom fields (1 to 9)
 Record Custom Fields (Unlimited)
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 Metro 2 Reporting

Global changes for many fields cannot be done simultaneously, but only consecutively. 

In  this  example,  the Records'  currency is  to  be changed. Select  "Currency"  in  the  drop  down menu named "Record  various  Fields  /
Options", click on "Refresh" (F5). Chosen Records will no longer be grey.

Under  "Currency",  select  the  new  value  for  the  Record.  The  "Current  Values"  column  will  indicate  the  Record's  actual  value.  The
"Submit" column indicates that a change has been made. Click on "Save" and the changes will apply.

The user will then confirm his choice:
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The number of Records changed will be displayed:

In order to change multiple Records at once, choose the desired Records (by highlighting them) and right mouse click. In the example
below, the user wishes to change the Loan Status. The user can choose the desired Loan Status for the selected Records from the list.

In a case where the user wants a global change of Record Number (Numeric), he will have to enter the desired value in the window
because thee is no drop down menu for this field:

When changing data for multiple Records at the same time, all the selected Records will have the same new value. If the values differ,
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the change will have to be done cell by cell.

Once the changes are done, the "Updated" column will be checked to indicate which Records have been changed.

NOTE:  For  custom  fields  including  drop-down  menus,  it  is  strongly  suggested  to  have  an  empty  (blank)  field  among  the  choices,
(generally the default choice) so that an empty field does not appear in error. Moreover, it is always preferable to have an empty field
as opposed to false data in a field that is  supposed to be empty if  the default data choice entered does not correspond to the true
value:

Not recommended Menu resulting in "Errors" below

Result: "Error" appears because "empty" field is not available in the
created menu

This type of error has no effect, besides possible confusion

Recommended Menu

Empty fields remain empty without the word "Error"
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It is also possible to import data or change/update data via spreadsheet (Excel) for Records.

   

Global Changes - Borrowers

This tool allows authorized users to make multiple changes in Borrower data without the need to open each Borrower
one by one.

Data can also be imported or updated via an Excel sheet. See Mass Import/Changes via spreadsheet.

To make Global Changes at the Borrower's level, select  "Borrower" under "File":

Select in the scroll menu the Borrower or Borrowers for which a global change is required.
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Next, right click and select " Global Changes".

The following window appears:

General Tab

In the Global Changes module, under the General Tab,  the fields for  which is  possible to  make changes have been arranged in  four
categories:

 Borrower various Fields / Options
 Borrower Custom Fields (1 to 9)
 Borrower Custom Fields (Unlimited)
 Metro 2 Borrower compulsory fields

The following fields are available for adding new data and changes/updates:

o Social security number
o Birth Date
o Marital Status
o Business (Company) Name
o First Name
o Last Name
o Initial
o Title

o Mobile / Cell phone
o Fax
o Email
o Web Site
o Occupation
o Unique Identifier 1
o Unique Identifier 2
o Borrower's Owner/Creator (MLM user)
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o Address 1
o Address 2
o City
o State/Prov.
o Country
o Zip/Postal code
o Phone

o Borrower Custom Fields (1 to 9)
o Borrower Custom Fields (Unlimited)

o Metro 2 - State/Prov.
o Metro 2 - Country

Global changes for multiple fields cannot be made simultaneously but one at a time. 

Banking Data Tab

The second tab, "Banking Data", allows you to add or change the Borrower banking data for Electronic Funds Transfers (pre-authorized
payments) for the US or Canada.

For more information on this subject, see the Electronic Funds Transfer chapter > Adding Bank Account and Activating EFT in Bulk.

In order to understand how to  use the module,  as  well  as  examples,  refer  to  the "Global  Changes -  Records"  section since the two
utilities function exactly the same way for global changes.

   

Mass Import/Changes via spreadsheet

This tool allows you to mass import new/updated data via an Excel spreadsheet (.xls or .xlsx) to various fields including
Custom fields. The spreadsheet should only have two columns and a header for each column.

Powerful  automated  import  tools  for  data  from  third-party  systems  offer  a  considerable  advantage  compared  to  the
Global Changes described here, as long you have information systems such as a CRM (Customer Management), an ERP
system, etc. These systems must have the capability to automatically create JSON or Excel files. A Salesforce API is also
available for Borrower data.

Fields available

Steps to access import via Global changes related to the Records (Loans)

Steps to access import via Global changes related to Borrowers

Steps to import via Global changes

Preparing the spreadsheet before import

Fields available

The fields available for importing via Global changes with a spreadsheet (Excel) are exactly the same as those offered in
Global changes- Records or Global changes - Borrowers (the more manual approach).

Steps to access import via Global changes related to the Records (Loans)  

To access this module, select any Record on the Main window (Record summary) 
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Right click on the mouse and choose "Global changes".

Then, click on the following icon  in order to access the import module of the Global changes.

This window will appear:
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Select the Record identifier that will be used in Column A of the Excel file - this serves to identify to which Record the new
or updated data belongs (MLM Record Identification, Unique Identifier  1  or  Unique Identifier  2),  and  choose from the
drop-down menu the targeted field.

Steps to access import via Global changes related to Borrowers

To access this import module, select any Borrower file via File > Borrower, from the Borrower Update table.

Right click on the mouse and choose "Global changes".
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Then, click on the following icon  in order to access the import module of the Global changes.

This window will appear:

Select the Borrower identifier that will be used in Column A of the Excel file - this serves to identify to which Borrower the
new  or  updated  data  belongs  (MLM  Borrower  ID,  Unique  Identifier  1  or  Unique  Identifier  2  -  the  latter  two  can  be
renamed), and choose the appropriate field from the drop-down menu.

Steps to import Global changes in MLM

The  following  steps  are  essentially  the  same  whether  we  import  data  related  to  Records  (Loans)  or  Borrowers.  The
principles are the same. The term Record has been used in the following steps in order to simplify the text, but it can be
replaced by Borrower in case the data was imported / updated for Borrowers. 

Confirm that the format entered in Column B of the spreadsheet corresponds to the values expected by MLM by pressing

the :
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If necessary, adjust the spreadsheet (Column A in the example below is a Unique ID entered by the user).

Click on to browse in the Explorer and select the .xls or .xlsx file to import.

The tool will allow the import only once ALL data is correctly entered. Partial imports are not possible so all errors must
be corrected before the actual import. For example, in the case below, at line 11 of the spreadsheet, the value to import
was "2" while the allowed and expected values for this field were "0" or "1". On line 13 of the spreadsheet, the Unique
Identifier 1 was entered a second time, it was already found on line 3. It is not possible to modify the data for the same
Record more than once per import. The lines highlighted in red show there is a problem and details are entered in the
"Pre-processing errors" column on the right.
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Once  the  spreadsheet  corrected,  click  on    and  then  click  on  in  order  to  reselect  the
corrected .xls or .xlsx file to import.

In order to import the changes, click on . This window will appear:

Upon  clicking  on  "Change",  a  window  will  appear  to  confirm  the  number  of  Records  modified  and  the  lines  with  the
modified Records will  be highlighted in green. In the following example, certain lines remained intact  because changes
were not required since the values entered in the spreadsheet were equal to those already entered in MLM.
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Preparing the spreadsheet before import

Line 1 should be a header; the name is not important.

Column A of the spreadsheet must be one of the three Record Unique IDs.

or one of the three Unique Borrowers IDs:
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Column B should be the data to be entered.

Specifics:

 The data  to  be  entered must  match the  data  format  (date,  percentage,  number,  monetary  (no  need  for  currency
sign) or whole number).

 If scroll menus are used, the data to be entered must also match the scroll menu data exactly (the simple fact of
having an extra space or even a capital letter as opposed to a small letter will result in an error message).

 Some scroll menus such as the Record Status (Active, Closed, etc.) require a number to be entered as opposed to the
actual text. These "Mappings" are detailed in the ? to the right of the field selected.

For example, if the field in which the user wants to make Global changes is named "Record Status", he will discover

by  clicking  on  the ,that  the  allowed  variables  are  of  "Integer"  type  and  that  the  corresponding  values  to  be
entered for the different statuses. Therefore, in  the spreadsheet, will  be  entered 7  in  order  to  change the  Record
Status to "On Hold". 
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 The interest rate must be entered as in this example:  9.25% should be entered as 9.25, NOT as 0.0925 and without
the percentage sign (%).

 A date format must match that of the computer on which the import will be done. 

Excel sheet example:

See also: Automated Imports - JSON or Excel files and Salesforce Connection (API) sections.

   

Global Changes - Payment schedule

Multiple changes can be done in bulk in the Payment schedule with, most of the time, the right mouse click:
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 Lines added at the end of the Payment schedule or inserted between payment
 Changed Payment amounts 
 Changed Interest rates
 Column Fees added or changed 
 The refund order for Column Fees, Interest and Principal
 Refund method (Special method available upon request)
 Added Line Color
 Updated Expected Principal (recalculation) 

Also, the data for 14 other columns can be changed with the "Global Changes - Selected Line(s) option:

o Comment
o Expected Payment
o Expected Principal (if option is activated in Settings)
o True Pmt Date  - Grace/EFT
o Minimum Payment
o 3 custom columns - Money
o 3 custom columns - Numerical
o 3 custom columns - Text

Global changes for several fields cannot be made simultaneously, but consecutively.

For global changes in the Payment schedule, select the lines that are to be modified. Then, right-click on the mouse and choose "Global
changes - Selected Line(s)":
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The list of fields that appear will depend on the columns that are visible in the Payment schedule. Columns must not be
hidden in the Payment schedule for the Global changes to be available with this module.

For  example,  by  selecting  "Comment",  a  new  window  will  appear  to  enter  the  data  to  add  or  modify  on  the  selected  lines  of  the
Payment schedule.

After clicking on the "OK" button, changes will be effective on all selected lines:
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To restore the old data use this button:  .

If drop-down menus have been configured on the nine (9) custom columns, these choices will be offered during the global change:

 
Some shortcuts allow changes in the Payment schedule:  

 Ctrl Alt Shift F12 - Changes "Due Pmt" type Line statuses to any of the "Paid Pmt" or "Unpaid Pmt" types.    
 Ctrl Alt Shift F11 - Changes the selected lines (excluding "Paid" type Line statuses) to one of the “Due Payment” type

Line statuses

See the Shortcuts section or press on F2 in Margill in order to consult a list of the shortcuts available.

   

Mass changes via the Post payment tool

Other than allowing to post payments from "Due" to "Paid" and to add/insert new payments in bulk, the Post payment
tool also allows to change the dates in the "Payment Date" and "True Pmt Date (Grace/EFT)" columns in bulk for many
Records and lines with the right mouse click. 

See Payment Update ("Post Payments")

   

Mass adding/changing Creditors

The "Ctrl  Alt  Shift  C"  shortcut  in  the  Main  window allows  to  bulk  add or  change Creditors  for  the  Records
selected but only for Creditor in first position.
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This comes with several constraints:

Conditions and repercussions:

1. If there is more than one Creditor, the change will not be done.
2. If there is an EFT for the Record, the EFT will be deactivated (it can be reactivated in bulk afterwards).
3. If there are Sub-creditors, these and their participation data will all be removed from the Record.
4. If there is no Creditor ion the Record, it will be added.

You  will  need  to  enter  the  Margill  Creditor  Unique  identifier  that  usually  begins  with  3  and  contains  five
number in all.

   

Notes - Record and Borrower

Notes may entered by the user for a Record  or for a Borrower .  Notes are saved by date and time (time
stamped) and by user. For compliance reasons, they cannot be changed after 24 hours.

For example, can be added, notes of conversations with the client and any other information for which no field exists.

 It  is  nevertheless  suggested  to  create  Custom  fields  to  easily  find  and  retrieve  data  that  is  used  regularly.  For
example, the fiscal year end date should not be recorded in the Notes, but in the appropriate field of the Borrower.
Custom fields including custom Scroll menus can be used as non-standard fields.

 It is not suggested to include an action that must be accomplished in the notes. Alerts should be used for this.

Notes for a Record are accessible with the  icon located at the top right of the Record window:
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For a Borrower:

To create a new Note, click on the  button.  This window will open so the user can enter the Note:

Note characteristics and functionalities
 
 Text can be copied (Ctrl c) from other software and pasted (Ctrl v) to the Notes window.
 Can include carriage returns in order to include paragraphs.
 Can be formatted and include underline, bold, italics and even highlights in various colors. 
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 Images can be included but it is recommended not to include very large sized pictures.

By clicking the "Save" button, the Note will be saved and time stamped. It will be possible to modify your own notes but
ONLY on the same day for audit reasons. 

Only an Administrator can modify  or delete  (on the same day only) notes created by another user. By clicking

on , a "PDF" file will automatically be generated in a "Notes" folder (that could be well hidden in a Windows user
data folder) and the name will include the MLM Record ID or the Borrower ID.

It is recommended to open in PDF and print immediately (or save in another more accessible folder) since finding the file
later on may not be easy (not possible in SAAS mode).

Older  Notes  cannot  be  deleted  but  can  be  hidden  by  clicking  on  the   button,  24  hours  after  the  Note  has  been
created.

A summary of all Notes is available by clicking on the   icon. This icon also allows the display of hidden notes and to

print  a summary of the Notes including the hidden notes if the "Include the hidden Notes" option is checked.
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The hidden but displayed Notes are identified with this symbol: .

It is possible to extract all Notes from the Records in one single operation. For the procedure, consult > Tools > Various >
Extract Notes from Records.

Record Notes

Notes for a Record are entered in the same window as the Record with the  icon located at the top right of the
window. Notes are available no matter which (tab) is selected. Notes can also be displayed and changed under "Alerts" >

View Alerts > "Current and History" > "Notes" .

The first line of these notes may also be displayed in the Record Summary window. It is thus suggested to insert recent
notes at the top of the Notes window since only the first 500 characters will be displayed.

In the example below, we have stretched the "Notes" column to better see the first line of notes from the image above.

When scrolling over the note, a bubble help text appears which displays a large part of the text note.

See also Displayed column selection and order.
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Borrower Notes

Notes for a Borrower are available at three locations:

 Go to File > Borrower (and Co-Borrower and Guarantor), under the "Notes +"  tab.

 In the Record itself in Borrower, under the "Notes +"  tab.

 Under "Alerts" > "View Alerts, "Current and History"" > "Notes" .

Notes can be added, edited and printed from any of these locations.

The first 500 characters of the Borrower's Notes are also displayed in the list of Borrowers (File > Borrower), but not in
the Record Summary window.

Please note:  A  note  entered  in  the  Borrower  will  be  included  in  all  that  Borrower's  Records.  If  the  note  related  more
closely to the loan itself, then use the Record notes.

See also Files (Attach)(Documents).

   

Attached Documents

Documents (files) may be added in MLM for the loan itself (the Record) or for the Borrower (or Co-Borrower
or Guarantor).

It is important to differentiate between files attached to the Record from those attached to the Borrower. For example,
the loan contract would be attached to the Record and a scan of the Borrower's drivers license would be attached to the
Borrower's details.

The files may be attached and retrieved from these locations:

 For the Record:

o "Data" window, under the "General" tab

 For the Borrower (Co-Borrower and Guarantor):

o Main window > File > Borrower > under the Notes+  tab

o In the Record itself, "Borrower" under the Notes+  tab

The  Attached  Documents  button   or  
allows for files to be attached to a Record, to a Borrower (Co-Borrower or Guarantor). 

The files will be copied (duplicated, not moved) to the database. It is thus recommended, if changes are to be made to
these  files,  that  the  changes  be  made  through  MLM  as  opposed  to  the  original  files  which  remain  in  their  original
location. Otherwise, the changes will not be included in the MLM Record. 

A Record must first be saved in order for the link to work. 
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Upon clicking on the "Attached Documents" image, the "Attachment Container" window will appear:

Files and even folders may be added. Nevertheless, it  is not recommended to attach very large files nor to add folders
with a large number of files. By default, the maximum size of a file is 2 Meg but the MLM Administrator may authorize up
to 99 Meg per file. Adding multiple files totalling over 99 Meg is allowed.

The "Extract File(s)" button will extract the file(s) from the database and save to a specified location. 

Once the operations (adding files, changing names, etc.) are done, press on the "Save" button. Pressing on "Cancel" will
cancel all operations done.

When  a  document  is  attached  to  a  Record  or  to  a  Borrower,  a  paper  clip  logo  will  appear  to  the  right  of  "Attached
Documents".

  

A Read-only user may be authorized by the MLM Administrator to add and delete files. See Administrator and Users.

The  Payment  schedule  can  be  attached  quickly  to  the  Record  in  PDF  format  by  pressing   in  the
Record window as such. This is handy to obtain a Payment schedule at a specific time (especially important to include the
original schedule).

Attached documents can be also be extracted (copied to the desired folder) for some or all Records in batch. See Extract
Attached Documents from Records.

   

Undo function

Most  changes  and  deletions  made  in  Margill  Loan  Manager,  under  "Data",  "Advanced"  and  most  importantly,  the
"Payment schedule", may be canceled (undone) with the Undo arrow located at the top right of the Record window.
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For the "Data" window, only mathematical operations influencing the Payment schedule may be undone. For example,
changes of currency, of file number or of a value in a custom field can not be undone with the button.

Changes and deletions made for the Borrower, Creditor, Employer, APR, Credit Report and Alerts cannot be undone.

The  button shows the changes made during the current operations and to cancel these changes with Undo button

.

   

Check for Data Irregularities

Margill  Loan Manager (MLM) offers great flexibility for  working with multiple scenarios for  loans.  However,  with  more
flexibility comes a greater risk of error by users. MLM contains logical constraints that must be met and others that are
suggested.  See  the  Data  Integrity  section  which  explains  the  constraints  between  the  payments  (positive  payments,
negative,  or  0.00)  and  the  Line  status.  For  example,  a  Line  status  "Not  set"  should  never  be  present,  but  in  some
situations, the system generates this Line status and it should be corrected by the user. This section describes the tools
that can be used to find these irregularities.

If the irregularities are not corrected, reports, particularly at the accounting level, could be wrong. 

1) Post payment Tool

The Post payment tool (accessible under (Tools") will find all "Not Set" Line statuses and highlights these in
dark red.

By selecting the "Use date interval" option with "Report from" as an old date,  for  example 1990, and a date far  in  the
future, let's say 2050 for the "to (inclusively)", all transactions for Active Records (only) in the system will be displayed if
the following conditions apply:

 you have the right to view all Records;
 the display filters are at "All";
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In the example below, two lines for Record 229 have non standard Line statuses (Undefined) which must be corrected
before updating these payments.

Take note of all the problem Records (use the MLM Record ID), close the Post payment tool and open each
Record to make the corrections.

2) Find specific Line statuses Tool

Simpler than using the Post payment Tool, go to Tools > Various > "Find specific Line statuses in Records". This window
will appear:

Choose the "Undefined" Line status and press Find. The number of Records with this undesired Line status and the  MLM
Identifiers will be displayed. Correct problem Records.
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3) Export Accounting entries

The  "Accounting  entries"  report  (accessible  by  Reports)  will  display  irregularities  found  for  the  selected  period.  It  is
obviously strongly suggested that these errors be corrected before generating the report.

4) Transaction Report

Here is a tip for detecting the "Paid Pmt" Line statuses which were entered with the amount of 0.00.

You simply need to create a transactional report with the following Data (you can also choose the "Paid Pmt (2) to (20)"
Line statuses):
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It will be then easy to validate if one of the payments were entered by error with the amount of 0.00 and to make the
necessary corrections for the Record:

If the transactional report contains thousands of Data, the user will be able to export it in Excel format in order to sort
the Payment column and thus easily isolate and view the Data to be verified or modified.

5) Main window (Record Summary)

Finally, in the "Record Summary" window, certain errors related to the Electronic Funds Transfer will  be displayed with

the  icon. See the detailed "System Warnings" section.
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See also the Find specific Line statuses in Records tool.

   

System Warnings

In the Main Margill Loan Manager (MLM) window (Record Summary window) appears Warnings icons  (  or 
)  with varying degrees of urgency to advise the Administrator, the Power User and the Record Owner (and sometimes
the Borrower Owner/Creator) of certain incongruities or upcoming issues.

During automatic data import (Loan,  Borrower or  Transactions),  if  a  file  is  not  processed,  and  remains available  in  the
import folder, the orange exclamation mark will appear next time MLM is launched, notifying of a potential problem with
the Windows Service for import.

Problems  with  the  red  icon  that  will  flash  (CRITICAL  problems)   must  be  resolved  quickly  since  these  are  often
related to the pre-authorized payments. 

MLM performs the following tests:

 For  Electronic  Funds  Transfers  (EFT),  that  no  normal  "Due  Payments"  are  present  before  Due  Payments  that  are
submitted for EFT.

The system generates one warning per event, per user who is entitled to receive the warning. This warning, sent to the
Record Owner (or to the Borrower Owner/Creator) is also displayed to all Administrators and all Power Users. However, if
an Administrator (or Power User) deletes a warning before the User ("To" column in the window) has had a chance to see
the warning, it will not be delivered to this User. 

Nevertheless, even if the warning is deleted by error and the issue is not fixed by the User, the warning will appear the
next day and until the issue is solved.

The System Warnings are not to be confused with the Alerts set by the Users.

   

Custom Unique Identifiers (Record, Borrower, Creditor)
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Custom Unique Identifiers can be created for the Record,  the Borrower and the Creditor.  These identifiers (or  IDs)  are
special  fields  in  which once an  alphanumeric  entry  is  entered,  it  can  not  be  repeated for  any  other  Record.  The  same
principle  applies  to  the  Borrower  and  the  Creditor.  They  can  be  useful  to  link  with  third-party  software  that  need  a
unique identifier for the Record, the Borrower or the Creditor.

If the data is already included in the system, the following message appears prohibiting duplicate backup data.

For the Record, to identify the Loan uniquely, go to the tab "General" under "Data".

For  the  Borrower  or  the  Creditor,  the  Unique  Identifier  can  be  entered  from  the  Main  MLM  window  under  File  >
"Borrower" or "Creditor".

In a Record itself, under Borrower, the term "Identifier" was reduced to "Ident.".

You can rename these Identifiers  (Record and Borrower)  in  order  to  reflect  the  real  name used  in  your  business.   For
example, Unique ID 1 could be renamed "Contract Number". Go to Tools > Settings > System Settings (Administrator) >
Personalized Standard Fields. These identifiers, if not required, can also be grayed out, thus preventing them from being
populated: 
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Do  not  confuse  the  customized  Unique  identifiers  with  Setting  the  Records'  Unique  Identifiers  (Loan),  or  the  system
identifier (ID) for the Borrower and the Creditor:

   

Record Color

See the Record Summary Window (Main), Color sub-section.

   

Archived Records

This module is available only for certain customers with a high volume of very short-term loans.

Please note:  the word "Archived" is used in two contexts: the "Archived Records" module and the "Archived" Status in
the main Margill  Loan Manager  (MLM) database.  These two types  of  "Archived" Records should  not  be  confused.  The
"Archived" Records in  the main MLM database are Records that  could,  in  theory,  become Active again.  Records in  the
"Archived Records" module are completely separated from the main database and cannot be reversed back into the main
database.

How it works:

When  this  option  is  enabled,  the  user  can  decide  to  transfer  the  desired  Records  from  the  main  MLM  database  to  a
secondary database that would contain the Archived Records.

The  selected  Records  will  be  archived  and  permanently  removed  from  Margill’s  main  database  without  any  way  of
recovering them.

If the module is enabled, in the Main Window, choose the Records to be archived > right mouse click > Archive:
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Records  that  are  Closed,  Archived  or  Bad  Debt  from  the  main  database  can  be  archived.  Draft,  Pending  and  Active
Records can not be archived - you must change the Status to one of the allowed Statuses.

WARNING, an Archived Record:

 Can only be viewed in Archived mode offering few options
 Will consist exclusively of data that was present at the time of archiving
 Cannot be modified
 Cannot be used for reporting
 Can only be consulted one by one, not in a table as presented in the main database.

An Archived Record:

 Contains the fields relating to the loan and the Borrower including the customized fields
 Saves the name, first name and company name for the Creditors, the Co-borrowers and the Guarantors but no other

data relating to these
 Contains the payment schedule (Payment schedule)(including all rows and columns) which can be exported to a

spreadsheet
 Contains the Metro 2 data
 Contains Records’ Attached documents
 Does not contain the Borrowers’ Attached documents

Searching in the Archived Records module is limited a few fields: various Record identifiers, names of the Borrower and
Creditor, Record Origination Date, etc.

An Archived Record is essentially a static “photo” or “image” of the Record that is almost but not 100% inclusive of all
data at the time of conversion to the Archived status.

Before archiving Records, make sure that the Archive mode suites your needs. Start by archiving a single test Record
(duplicate this Record in main database before archiving).

Consulting the Archived Records:

To consult the Archived Records go to Tools > Other > Archived Records. A table will open in which you will  see all  the
Archived Records. By double clicking on one of them, you can view the multiple components of the Record such as the
Payment schedule (that's the payment schedule), basic Data, Custom Fields, etc., all in different tabs:
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Calendar

For easy referral to time periods, a calendar  is included at the end of each date entry box.

   

Pocket calculator

A calculator will appear by pressing the  icon on the right of certain data entry boxes.

The calculator is also available in the Payment schedule (on the right).

   

Dashboard

The Dashboard provides a quick activity global perspective and graphics to compare various time periods. The data seen
can be personalized according to  the  needs of  each Margill  Loan Manager  (MLM) user.  It  is  accessible  in  the  Margill's
Main window on the Dashboard tab, at the bottom. To see the Dashboard, the option must be accessible to MLM users.
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In  order  to  give  users  the  right  to  view  the  Dashboard  and  to  configure  it,  the  option  "Can  display  Main  window
Dashboard" must be checked in the User management window (Tools > Users). Users with "Read only" security level are
not authorized to view the Dashboard.

Only a user with the Administrator security level will be able to configure the personalized Widgets that other users will
be able to display in their own Dashboard.
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To access the Dashboard management page, from the Main MLM window (Record Summary), click on the "Dashboard"
tab at the bottom. 

Upon  opening  for  the  first  time,  the  Dashboard  may  be  empty  or  contain  some  sample  widgets.  Each  user  will  be
personalize  their  own  Dashboard.  Only  an  Administrator  will  have  access  to  the  "Widgets"  button  located  on  the  top
right.

By clicking on the "Widgets" button, this window will open:
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First, from the Widgets drop-down list, choose the widget to be created or modified. On the left, the fields available as
widgets are displayed. Chose the field and click on the blue arrow in the center to select the field that is to be used as a
widget. These Widgets can be modified later on according to your needs.

You can customize the Widget title, title size, field size as well as the color.
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Click on the "Refresh" button in order to preview the widget according to the title, sizes and colors. When the widget is to
your  liking,  click  on  "Save".  MLM offers  the  option  to  customize  up  to  six  (6)  widgets.  Once  saved,  the  widget  will  be
available for display for all users who have a Dashboard access. 

To  display  one  or  more  widgets,  click  on  the  right  mouse  button  anywhere  in  the  Dashboard.  Select  "Add".  The
personalized widgets from 1 to 6 as well as the predefined widgets (that can be slightly personalized too - see below) are
there for your choosing.
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Add one of more Widgets according to your needs. They can be positioned by drag and drop with the help of the mouse.

Predefined Widgets:

o Record Types
o Record statuses (except Custom statuses)
o List of paid principal
o List of unpaid payments
o Average Principal by Record Type
o Number of new Records
o Number of Records by Record Type
o Original Principal per month

These can be resized in the Dashboard by positioning the mouse cursor over any the widget borders.

Some widgets may or must be adapted in order to follow your MLM configuration. For example, let's take a look at the
Paid Principal widget. First add the widget:
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Click on the gear located on the top right. You will have the option to select the desired Line statuses and even change
their  names  (usually  not  required)  by  changing  the  names  in  the  "Displayed  title"  column.  The  "Description"  is  the
widget's name. Changing from Paid Principal to another name does not change the calculated amounts. This widget will
only display the paid principal, nothing else.

We only want "cash" payments and thus must exclude all Line statuses that are not "cash". "Bad debt" and "Transfers"
are  "Paid  type"  Line  statuses  but  both  are  non-cash  transactions.  The  Paid  interest  would  also  be  excluded  even  if  it
would have given an amount of 0.00, no matter what.

Once the changes are Saved, to display these, click on the "Refresh" button. If there are too many Line statuses, you may
have to scroll down to see all of these since the box hight is limited.
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Once the Dashboard is organized to your needs, use the date ranges to view the data according to the desired period.
Enter the desired period or select the period to display from the drop-down menu:

Take note that certain widgets cannot be displayed with the data of the day. On each of the widgets, the period taken
into account for displaying the data is in pale gray at the bottom right of each widget:
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In  the  following  example,  NSF  fees  were  charged  in  2  Records  for  a  total  of  12,013.41  for  the  "Floating  year"  (I  must
admit the fees are excessive for NSFs!). 

To remove a widget, place the cursor on the widget header (top portion), right mouse clickand choose "Hide":
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"Restore the initial configuration" will restore the five default widgets.

Restoring  back  to  the  initial  configuration  is  required  if  changes  are  made  in  the  basic  MLM  settings  (Line  statuses
particularly). The Restore resets the widgets and their names and refreshes Line status names.
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Margill Loan Manager Calculations

"Margill Loan Manager Calculations" Content

Amortization & payment schedules (Payment schedules)

How to do...

Other calculations

Refund Options

   

Amortization & payment schedules

Margill  Loan  Manager  (MLM)  can  be  used  to  manage  a  number  of  different  financial  instruments.  For  detailed
information on each and how to create the MLM schedule, click on the link. 

 Loan (personal, car, commercial)

 Add-on Interest Loan

 Rate Adjusted Payments

 Mortgage and Escrow

 Adjustable Rate Mortgage (ARM)

 Reverse Mortgage

 Line of credit

 Collection - Bills, Invoices...

 Lease

 Fees, Insurance and Taxes

 Late and/or unpaid salaries, rent, annuities

 Investment portfolio

 Interest-only (or partly interest-only loan) (see Payment schedule section)

 Fixed principal (or partly fixed principal loan) (see Payment schedule section)

 Loan or other with fees (insurance taxes, penalties or invoices) not bearing interest

 Irregular interest compounding

 Participating Loans - See the Participating Loan subsection in the Creditor section
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How to do...

How to do... Contents

 Loan (personal, car, commercial)

 Add-on Interest Loan

 Rate Adjusted Payments

 Mortgage and Eascrow

 Adjustable Rate Mortgage (ARM)

 Reverse Mortgage

 Line of credit

 Collection - Bills, Invoices...

 Lease

 Fees, Insurance and Taxes

 Late and/or unpaid salaries, rent, annuities

 Legal costs and fees collection with interest

 Investment portfolio

 Interest-only (or partly interest-only loan) (see Payment schedule section)

 Fixed principal (or partly fixed principal loan) (see Payment schedule section)

 Loan or other with fees (insurance taxes, penalties or invoices) not bearing interest

 Irregular interest compounding

 Participating Loans - See the Participating Loan subsection in the Creditor section

   

Loan (personal, car, commercial)

These loans are usually quite straightforward. Create a new Record with "File" and "New Record". See also Creating the
first Record and Data entry screen Basics.

Data window

In  the  example below,  the  loan starts  on  October  1  and  the  first  payment  is  a  month  later.  Compounding  is  monthly,
Payment method, Normal (Principal + Interest). The 25,000 loan is paid back in 4 years (48 payments).
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Annual Percentage Rate (APR) window

Compulsory fees can be included in the APR window for loans to individuals in order to compute the APR. These may be
stated as an amount or as points (percentage of the loan amount).

Advanced window

The  various  Advanced  features  (Day  count,  short  periods)  will  depend  on  the  jurisdiction  and  the  industry.  Method
should usually be Normal - Effective rate Equal Periods (compound interest).

Payment schedule

MLM automatically calculates the payment and produces the preliminary Payment schedule that can be adjusted as one
desires to include for example, lump sum payments,  interest-only  payments,  fixed principal  payments,  step payments,
additional principal, fees, taxes and insurance that bear interest or not.

In this example, the Borrower does not respect his/her payment schedule. The five lines in blue are incidents including:

 January 1, 2007 payment is paid only on the 20th of the month;
 February 1 payment is only 300.00;
 March payment is missed;
 Extra fee of 25.00 for the unpaid payment on March 1, 2006. 

o Note:  Interest  will  accrue  on  the  25.00  fee  (unless  otherwise  instructed  -  see  Loan  or  other  with  fees
(insurance taxes, penalties or invoices) not bearing interest);

 1000.00 payment on May 5, 2007.
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Other special repayment options may also be included: lump sum payments, unpaid payments, interest-only payments,
fixed principal payments, step payments, additional principal, etc.

See also: 

The  very  important  "Payment  schedule  (Amortization,  payment  schedule)",  Payments  section  for  a  host  of  payment
options allowing you to create just about any payment scenario.

Add-on Interest Loan
Lease

   

Add-on Interest Loan

Add-on interest is a peculiar calculation by which interest to be paid on a loan is calculated on the total principal amount
borrowed for one year then multiplying this amount by the number of years to repayment. The principal is then added to
the total interest and divided by the number of monthly payments to be made. 

For example, a car dealer advertises a rate of 12.50 per 100 per year on a 20,000 loan to be repaid in monthly payments
over 4 years.

Total interest for one year: 

0.125 x 20,000 = 2500.00

Total interest for 4 years = 10,000

The interest portion per month is thus 10,000 / 48 = 208.33. 

Total principal and interest = 30,000 over 48 months, so payments are 625.00 in principal and interest.

These loans are more expensive than regular amortizing loans since the interest calculation method does not  factor in
the monthly principal payment. As principal is paid, the monthly interest amount is reduced for amortizing loans, but not
for add-on interest loans.
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Here is how to enter this method in Margill Loan Manager (MLM):

1) Calculate the total interest as we did above - a very simple calculation without the need to use Margill.

2) Create a new Record with "File" and "New Record". See also Creating the first Record and Data entry screen Basics.

3) Enter the financial date in the Data tab: 

Notice "Annual Nominal Rate (%)" is 0.00% since we will  not be charging true interest, but rather will  be using Column
Fees to add the 208.33 with the "Add Fees" link.

Payment may be left at 0.00 and will be computed automatically. Press on "Compute" to generate the payment schedule.

Notice below true interest Rate is 0.00% so true Accrued interest is 0.00. Our Column Fees, now called "Add-on interest -
Accrued" is the same every month.
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No matter if the Borrower pays or not, is late or makes partial payments, the Add-on interest will remain the same since
the amount is not computed but entered manually.

Notice below two missed payments of 625.00 each + automatically added NSF fees (25.00 each) for a total of 1300 due.
This is also the final balance since no extra interest is charged even if payments are not made.

The Annual  Percentage Rate  (APR)  can  also  be  computed through the  APR tab.  Even if  no  extra  fees  are  charged,  the
12.50 / 100 interest rate yields an APR of 21.53% (Effective APR of 23.78%):
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See the Fees, Insurance and Taxes by Column (and Automatic) section.

   

Interest Paid in Advance

Some Creditors reduce their risk by having the Borrowers pay the interest at the date of signature (Origination date of
the loan). Generally, the Creditor does not want to reduce the Principal to be refunded and often wants this payment to
have no effect on the total of interest accrued and to be reimbursed.

A Line status called "Interest Paid" is available in Margill  Loan Manager (MLM) whose purpose is to pay pure interest -
nothing else, not even Column fees. 

Whereas  a  Paid  Pmt  type  Line  status  will  first  pay  Column  fees,  then  Interest  and  if  the  payment  is  sufficient,  the
Principal,  the  "Interest  Paid"  Line  status  will  pay  interest  even  if  the  due  interest  balance  is  0.00.  Thus,  "Balance  Due
Interest" can become negative.

The interest paid in advance may not have the desired results by the Creditor since generally, a payment, whatever its
nature, should reduce the amount due and thus reduce the total interest on the loan. The following examples illustrate
various  scenarios  according  to  the  calculation  method:  simple  interest  of  compound  interest.  Because  of  the
compounding (or capitalization) effect of interest, only interest paid in advance in a simple interest calculation will  not
reduce the total accrued interest on the loan.

Interest paid in advance - Simple interest

In  the  following  example,  a  50  000  loan  with  an  interest  rate  of  12%  per  year,  for  one  year  with  no  Principal
reimbursement, would generate 6000 in interest. It is an easy calculation to do in simple interest (50 000 X 0,12 X 1 year
= 6000).
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With simple interest, the interest calculated of 6000 can be paid on the Origination date and the final balance remains 50
000 as desired. Gradually, the "Balance Due Interest" increases to 0,00.

Interest paid in advance - Compound interest, Effective Rate method

With monthly compound interest with no payments, the interest calculated is 6341,25:

Applying the same method of paying the total of interest in advance, like in simple interest, the 6341,25 interest payment
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on the Origination date has the effect of reducing the total accrued interest. This is the result of compounding. Interest
paid reduces the calculation balance because this negative paid interest is capitalized.

We  end  up  exactly  with  the  same  result  with  a  "Paid  Pmt"  (which  covers  the  interest  first  then  the  principal).  The
difference is at the accounting level only.  With the "Paid interest" Line status,  the payment is  applied to "Balance Due
Interest" (Principal balance remains unchanged at 50 000) while a "Paid Pmt" charges the "Balance Due interest" and the
Principal balance. Compounding (interest on interest, as on principal) has the effect of eliminating, at the mathematical
level, the distinction between interest and principal, thus affecting the calculation balance. 

Interest paid in advance - Compound interest, Simple Capitalized 

With  Simple  capitalized  interest,  the  same  general  principle  with  a  few  subtleties  (depending  on  the  frequency  of
capitalization)  applies  as  in  compound  interest  using  the  effective  rate  method.  If  the  capitalization  is  less  frequent,
during the capitalization period, the principles of simple interest will  apply until  a  date of  capitalization where this  will
have as a result of adding the accrued interest to the calculation balance that is used for calculating the interest.

See also "Interest" Type Line statuses and Interest-only payments (and Column Fees) and Interest paid in Advance.
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Rate Adjusted Payments

See the Adjustable Rate Mortgage (ARM) example. Although applied to a mortgage, the method can be applied to any
other type of loan.

   

Mortgage and Escrow

These are usually quite straightforward. Create a new Record with "File" and "New Record".  See also Creating the first
Record and Data entry screen Basics.

Data window

In the example below, 25-year the mortgage starts on October 1 and the first payment is a month later. Compounding is
monthly, Payment method, Normal (Principal + Interest). The 225,000 mortgage has a five year term.

Mortgages

To calculate mortgages in: United States, England, Australia, Hong Kong, South Africa, France,  Luxembourg,  for
monthly payments, the compounding period should be monthly.

In Canada, the compounding period should be semi-annually.

For other countries or other unusual mortgages, consult a mortgage professional.

In  this  example  the  term  is  included  but  the  entire  schedule  (25  years)  is  produced  by  checking  "Create  complete
Payment  schedule".  This  allows  to  compute  the  Annual  Percentage  Rate  (APR)  (if  need  be)  since  APR  can  only  be
computed if the balance = 0.00 (otherwise not all finance fees are accounted for).

If the APR need not be computed, do not check "Create complete Payment schedule" and leave the term at 60 months. A
five year Payment schedule will be produced (as opposed to a fully amortized schedule) calculating the proper payment
amount and balance at the end of the term.

Annual Percentage Rate (APR) window
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Compulsory fees should be included in the APR window. These may be stated as an amount or as points (percentage of
the loan amount).

Advanced window

The  various  Advanced  features  (day  count,  short  periods)  will  depend  on  the  jurisdiction.  Method  should  usually  be
Normal - Effective rate Equal Periods (compound interest).

An interest adjustment payment may also be included through the Advanced window.

Payment schedule

MLM automatically calculates the payment and produces the payment schedule.

Other special repayment options may also be included: lump sum payments, unpaid payments, interest-only payments,
fixed principal payments, step payments, additional principal, etc.

Escrow Account

If the Creditor collects and remits property (municipal) taxes and / or insurance, it is possible to:

1)  Charge  the  taxes  and/or  insurance  (using  Column  Fees  renamed  to  Property  Tax  and  /  or  Insurance)  ("Accrued"
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columns)

2) Collect the taxes and insurance from the payment amount ("Paid" columns) and,

3) As version 4.3, specify in the Payment schedule, the Taxes and Insurance payment dates by the Creditor to the city and
to the insurance company using the "Custom Columns" and; obtain the payments and the balance of this Escrow account
using Mathematical Equations and relevant fields (see Escrow Report).

First, in Tools > Settings > Custom Column Titles, adapt the column names according to your needs. Below, Column 2 and
3 Fees are named, respectively "Municipal Taxes" and "Insurance". The amounts charged to the Borrower are included in
the total payment amount.

For  the  "Custom  Columns"  subsection,  Custom  Columns  1  and  2  (Monetary)  will  be  renamed  respectively  "Municipal
taxes  paid  by  Creditor"  and  "Insurance  paid  by  Creditor"  (these  names  could  be  shortened  to  avoid  having  a  column
header that is too long).

Also, during the implementation, it is suggested to change the Line statuses "Other" and rename them "Municipal Taxes
paid by Creditor" and "Insurance Paid by Creditor" (shortened names).
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In  our  example,  the  Borrower  must  pay  2500  in  municipal  taxes  (208.33  a  month)  and  1200  in  insurance  (100.00  a
month). These amounts will be added with the "Add Fees" link.

The Payment schedule is created and the payments below are made by the Borrower. One will notice an unpaid payment
and a partial payment, the latter paying only municipal taxes. Taxes and insurance are always accrued but not necessarily
paid.

The Creditor, on the other hand, pays Municipal Taxes twice a year (January 15 and June 15) and pays Insurance once a
year (June 15) as indicated in the columns below. We have inserted lines in the example below to show these payments
by the Creditor. On line 14 (June 15), Taxes and Insurance are paid even if the Line status indicates only the payment of
the Insurance. This is not significant since in the Escrow account report, the calculations will be made correctly without
taking account the Line status since the Taxes and Insurance paid by the Creditor have no effect on the Payment schedule
or Interest.

e

Taking into account the payments made by the Borrower (to the Creditor) and payments by the Creditor (to the city and
to the insurer), a report may be created using Mathematical Equations describing the transactions in the Escrow account
and the its balance for multiple Records. See Escrow Report.
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Interest Adjustment Date

The Interest Adjustment Date is the date from which the Creditor starts calculating the "normal" interest and thus the
regular payment to be paid by the Borrower. This option should be used when an interest adjustment date is scheduled
(usually  for  mortgages)  since  the  principal  is  advanced  on  another  date  than  the  first  of  the  month.  Generally,  the
interest adjustment date falls on the first day of the month after the Borrower's advance.

An  Interest  Adjustment  Date  allows,  when  the  precise  date  of  payment  from  the  Creditor  is  uncertain,  to  create  an
amortization table with a final regular payment which can be submitted to the Borrower. If the Origination date changes,
only the payment amount on the adjustment date would have to be changed.

Example:

A loan starts on June 6 and the first REGULAR payment is August 1st. 

Data should be entered as in the "Data" window below, for, as an example, monthly payments and an amortization and
term of 120 months.

In the "Advanced" tab, check the "Add an extra interest-only payment as Adjustment date" option:

If the Date of first payment is entered as August 1, an extra payment will be added on July 1, which becomes the Interest
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Adjustment Date. The following payments (starting on August 1) will be computed normally (interest and principal).

The "Due Pmt" line, which was added automatically, will only pay the accrued interest between the Origination date and
the adjustment date. In the following example, the date of the first payment entered by the user was 2020-08-01 and not
2020-07-01. The accrued interest between the Origination date of 2020-06-06 is 946.06, which is the first due payment
amount.

For a 120 month loan (entered in "Amortization" and "Term"), when this option is checked, there will be 121 payments,
the first one being the smallest.

In  compound  interest,  Effective  rate  method,  when  an  adjustment  date  is  required,  interest  between  the  Origination
date  and  the  adjustment  date  is  generally  computed  with  the  simple  interest  not  with  the  Effective  rate  method.
Calculation is therefore easy to do for stakeholders without the need for software.

The  user  must  specify  in  "Advanced"  that  the  "Short  Period  Method"  will,  generally  be,  "Simple  interest  Capitalized
Actual/365".  We use "capitalized" because if the interest payment is not made, interest will be computed on the overdue
interest.

Calculation of interest for the "short" period between June 6 and July 1 (25 days):

 425 000 x 0,0325 x 25/365 = 946,06

Nowadays, with powerful calculation tools, it is not compulsory to use a special short method, but such is the custom.
 

Note: If "Column Fees" (regular fees, taxes, insurance (Escrow)) are entered in the "Data" window, no fees will be added
to this adjustment payment. If fees were required at this date, they would have to be added manually in the appropriate
column of the Payment schedule.

   

Adjustable Rate Mortgage (ARM)

Margill Loan Manager (MLM) can easily compute adjustable rate mortgages (or other variable rate loans). In these, the
payment is adjusted based on the interest rate in force at a certain date. 

Rates known or estimated at start of loan

Loan or mortgage adjusted over time as rates become known



Page 544

© Jurismedia Inc., 2007- 2023

Rates known or estimated at start of loan

Very often in ARMs the future rates are not known, but MLM may be used to calculate the predicted schedule. To do so,
follow these steps:

A future (predicted) variable interest rate table is created. Go to "Tools", "Tables".

"Clear"  the existing table and enter the date and rate changes.  In  this  example, the rate in  2015 is

5.00%, 2016: 5.5%, 2017: 6.0, etc. Press on  to add the dates and rates.

Save the file in order to use it as seen below. We called it "File123-ARM" as seen in the complete table below:
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Create a new Record with "File" and "New Record". See also Creating the first Record and Data entry screen Basics.

Enter the various elements. For "Payment Method" choose "Rate Adjusted Payments". In order to be able to choose this,
you must have checked "Use Interest Table" and have selected an interest table, in this case "File123-ARM". A percentage
could be added on top of the rates entered earlier. 

Press on "Compute". The window below will appear since the calculation is quite complex. Press on OK. With today's
computers and "dual core" technology, the calculation above took about 15 seconds.
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The  payments  are  then  automatically  adjusted  according  to  the  rates.  The  payments  will  vary  to  first  cover  (refund)
interest and  the  balance of  the  payment  to  refund the  principal.  See the  "Payment"  column below from the Payment
schedule.

Loan or mortgage adjusted over time as rates become known

If  a  loan  starts  at  a  certain  interest  rate,  lets  say  5%,  and  the  next  year  the  rate  jumps  to  6%,  the  Payment  schedule
(Payment schedule) may be updated to reflect this change.

So we created a standard loan at 5% mortgage with a Normal (Principal + Interest) "Payment Method" and an unknown
payment (0.00).
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We "Compute" and produce a schedule which is saved. One year later, the rate changes to 6%. To insert a new interest
rate, select (highlight) any line in the Payment schedule and right click with the mouse. Among the choices in the menu,
choose "Insert" and "Rate Change(s)".

With the "Rate Change(s)" choice, the interest rate may be inserted or changed at any date. The rate may be applied to
the rest of the table by checking the appropriate box. New equal payments may also be recomputed to give a balance =
0.00 or other amount.

The interest rate may also be changed for multiple loans at once. See the Changing the interest for multiple Records in
one operation sub-section in the Adding or changing interest rates in a Payment schedule chapter.

This process, along with other special repayment options (lump sum payments, unpaid payments, interest-only payments
, fixed principal payments, step payments, additional principal, etc.) may be continued over time.

   

Reverse Mortgage

Reverse mortgages have a different purpose than normal forward mortgages do. With a reverse mortgage, you are taking
the equity out in cash. So with a reverse mortgage, your debt increases and your home equity decreases. 

Let's do an example: 
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The Jones' home equity is about 350,000 and now being at retirement age, they wish to "live a little" without selling their
home. They wish to receive 75 000 up front and then 2500 in regular payments for 60 months. The interest rate for the
loan is 9.5% annually.

Create a new Record with "File" and "New Record". See also Creating the first Record and Data entry screen Basics.

The Principal is 75,000 since this is the up front amount that  was loaned to the Jones and the Payment is  minus  2500
since the Jones are not reimbursing their loan, but receiving 2500 per month for 60 months. 

After 60 months, the Jones would owe 310,485.82. 
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You can then save the Schedule and include any irregular "incident": larger monthly cash loan (- amount), reimbursement
(+ amount) at any time, etc. 

   

Line of credit

Margill  Loan  Manager  (MLM)  allows  you  to  follow  a  line  of  credit  in  which  money  is  lent  out  and  repaid  at  irregular
intervals.

Create a new Record with "File" and "New Record". See also Creating the first Record and Data entry screen Basics.

Let's do an example...

On May 16, the line of credit is activated with a withdrawal on the same day of 1500. This could have been our starting
principal  but  instead,  we  will  leave  Principal  at  0.00  in  order  to  see,  in  the  schedule,  each  and  every  withdrawal  and
refund (including the first one). Below is the Data window with "Payment Frequency" set to "Irregular". Minus (-) 1500
could also have been inserted as the first payment amount.
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Press on "Compute" to produce a Payment schedule with only one line. 

Modify the "Information" Line  status  to  "Add.  Princ.  (Loan)".   Enter  for  this  line  in  the  Payment  column,  the  first  loan
amount of 1500. Minus 1500 should be entered.

NOTE: For new loans created as of MLM version 5.0, the date for the original first payment line can be modified and the
first line be deleted if  needed. The Origination date cannot be changed unless the loan or  line of  credit  is  recalculated
from the start.

A second loan or withdrawal of 2500 is made on June 1st (add a line , modify the Line status and enter as a negative
amount).
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A third withdrawal of 1750 is made on June 16.

The Borrower then refunds 2000 on July 3 (a refund is a positive amount reducing the principal) 
and so on... 

The Schedule may then be saved  in the database and updated as time goes on. 

You will  notice in the window above that the Line status column indicates the first three lines as "Additional principal"
(you could also have used one of the other Additional Principal Line statuses whose names may be customized) and the
4th line as "Due Pmt" which should then be changed to a "Paid Pmt". See also Line status.

Interest automatically recomputed

Compound interest is charged in between each of the payments/refunds. The interest is automatically calculated every
day (as provided by the normal Effective rate method) even if the compounding period is not daily. 

MLM also allows you to choose, since the payments are irregular, simple interest that is capitalized upon each payment.
See Short & Long periods.
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Important suggestion for lines of credit

If a loan or line of credit was to contain only one payment (or only a few payments), MLM would consider it terminated
on the last line of the Payment schedule and thus, data after this last date would not be obtained.

For such loans or lines of credit (the Borrower pays when he/she is able to or when events such as sales occur), in order
to obtain the loan balance and other financial data over time, even if  no payments are made, it  is suggested to create
dummy monthly payments of 0.00 for the next x years or one dummy payment (Line status "Information") of 0.00 a few
years later (as in example below). 

This will allow you to obtain the true balance due, the accrued interest, etc., at any point in time until the last line of the
schedule. The number of years is based on your evaluation of the typical duration of the loan in ordinary circumstances.

   

Collection - Bills, Invoices...

MLM is great for collection, providing up to date information on the status of each invoice and payment.

Create a new Record with "File" and "New Record". See also Creating the first Record and Data entry screen Basics.

In these examples we will include late and unpaid accounts receivables with regular or irregular payments made by the
debtor.

Example 1: 

Irregular invoices and irregular payments by debtor

5 bills sent to client at various dates - interest always starts 30 days later 

 4500 - May 10, 2005 (interest starts June 9, 2005) 
 3450 - June 2, 2005 (July 2) 
 5500 - June 2, 2005 (2 bills on same date) (July 2) 
 12,000 - October 1, 2005 (October 31) 
 7500 - January 15, 2006 (February 14) 

Client pays irregularly: 
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 2000 - August 1, 2005 
 2500 - September 15, 2005 
 5000 - October 20, 2005 - turns out to be NSF with 25 fee 
 7500 - January 10, 2006 
 10,000 - June 5, 2006 

How much is  stilled owed on  December  1,  2006?  Monthly  interest  of  2% compounded  monthly  (could  also  be  simple
interest).

First enter basic information in the "Data" entry window. In order to have all invoices and payments in a neat table, our
starting  principal  (first  amount  due of  4500)  will  not  be  included as  Principal  but  will  be  our  first  "payment"  of  minus
4500.

Press on "Compute". The preliminary Payment schedule is produced below. 

Notice that "Line status" has been changed to "Invoice" (or could have been Add. princ.). 

Important note for accounting relating to the Invoice Line status:

 The "Invoice" Line status will add mathematical principal but not accounting principal. For reporting, the distinction
is important at the accounting level. To add accounting principal instead, use one of the "Add. Princ." Line statuses
whose name can be changed to, for example, "Add. Princ. Invoice". This will add accounting principal. See "Principal"
Type Line statuses.

We also added a comment on the far right. In this case we added Invoice 1234 for reference.

We now simply add lines with the  icon on the right that reflect all the events. We first included all the invoices
(we also could have added invoices and payments in a chronological order).
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Let's now add the payments made by the client. Either position the cursor BELOW where the line is to be inserted and

press on . A new line with 0.00 payment will be added. Or, you may right click on the mouse and select "Insert"
and "Payment(s)".

The following window will appear from which to insert the payment at the appropriate date and amount.

We  added  each  of  the  payments  and  Line  statuses.  The  5000  NSF  check  on  October  20  has  the  Line  status  called
"Returned Ch.". When this choice is made, the window below appears in which to include the amount that should have
been paid (a column to the right will show the 5000.00 that should have been paid).
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A 25 fee was also charged on that same day (the minus 25 on October 20). These fees will bear interest. If no interest is to
be charged on insurance and taxes, select the desired lines, use the right mouse click and under "Payments" select "No
interest  Add. Princ., Fees, Tax, Insurance, etc.".

Comments were placed at the end of each line.

The balance due on December 1, 2006 is thus 16,958.91.

Example 2:

Collection by what should have been regular payments

Debtor owes an amount that cannot be paid in one unique payment. There is an agreement with the collection agency by
which the debtor will repay in equal payments BUT the debtor does not respect the payment schedule.

 50,000 owed on January 5
 Debtor agreed to pay 2500 every 2 weeks starting February 1
 Interest rate of 24% annually, compounded monthly

First  enter  the  normal  schedule.  We  know  the  2500  payment  but  not  the  number  of  payments  -  MLM  will  calculate
automatically when left at 0.
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MLM will calculate 23 payments (22 at 2500 and one last payment of a lesser amount).

Irregular events occur in the collection:

 Missed payment on March 1, 2006
 April 12 payment is paid 5 days late 
 NSF check on April 26, 2006 which implies the payment of a 25.00 fee 
 July 6, 2006 payment of only 1000 
 Extra 5000.00 payment on August 13, 2006 

These are simply entered one by one in the Payment schedule (the 5 incidents and the fee have been highlighted in blue).
The  Line  statuses  "Unpaid  Pmt"  and  "Partial  Pmt"  will  open  (for  reporting  purposes)  a  window  in  which  to  enter  the
payment that should have been made and the date at which the true payment was made:

The "Paid Late Pmt" Line status opens up another window in which to enter the date at which the payment should have
been paid and the date at which the true payment was made.
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The  multiple  "Outstanding"  columns  provide  valuable  data  as  to  the  outstanding  payments  and  interest  on  the
outstanding amounts. See "Payment schedule columns".

See also Loan or other with fees (insurance taxes, penalties or invoices) not bearing interest.

   

Lease

Create a new Record with "File" and "New Record". See also Creating the first Record and Data entry screen Basics.

A car is leased for 25,000. The residual value after 4 years is 10,000. What should be the minimum monthly lease amount
if the cost of capital is 10%?

Data entry window. The balance is 10,000 to represent the residual value.



Page 558

© Jurismedia Inc., 2007- 2023

Partial Payment schedule:

The minimum monthly payment should be 458.53.

What would the payment be if  an up-front payment of 3000 was made? MLM can easily recompute each of  the other
payments upon changing the first payment to 3000. First, enter the 3000 payment on the first line. Then select the lines
for which the payment must be recomputed and right click with the mouse (see image below).
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The new minimum payment would be 392.96.

Taxes are generally included in addition but as part of the payment amount. This or these taxes can be charged with the
renamed Column Fees Tax 1 and Tax 2 (name of your choice) and are paid in the payment amount. See Fees, Insurance
and Taxes and the automatic insertion of taxes in that same chapter.
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Other special repayment options may also be included: lump sum payments, unpaid payments, interest-only payments,
fixed principal payments, step payments, additional principal, etc.

   

Fees, Insurance and Taxes

Adding Fees, Insurance and Taxes is extremely flexible in Margill Loan Manager (MLM). Four options are available: 

1. Fees, Insurance and Taxes by Line status (6 types)

2. Fees, Insurance and Taxes by Column (4 types)

3. APR Fees (5 types)

4. Fees included in the interest rate

1. Line status Fees should only be used to add sporadic fees (penalty, insurance or tax). They become cumbersome when
they  are  charged every payment.  When they  are  paid,  a  new line  must  be  inserted in  the  schedule with  a  Line  status
called, for example, “Fees Paid”. This way, they can be isolated for accounting. Having to add this extra line when paid is
also cumbersome. An alternative is to use the more powerful Column fees.

2.  Column  Fees  are  much  more  sophisticated  than  Line  fees  for  reporting  and  are  usually  used  when  regular  fees
(insurance  or  taxes)  are  factored  in  the  payment.  When  a  payment  is  actually  made  (Paid)  these  fees  are  included  in
Payment type Line statuses. For accounting, they are paid before interest and principal.

MLM offers two (2) options that can become very powerful since these can be:

  Automatically RECOMPUTED 

o These fees are manually  added in the Payment schedule by the user.  These fees must be in  the  Payment
schedule  before  being  automatically  recomputed.  For  example,  1%  monthly  Administration  fees  are
charged  on  the  balance.  If  a  payment  is  unpaid,  the  balance  will  increase  and  the  subsequent  fees  will
automatically be recomputed. They are generally regular fees.

 Automatically ADDED

o These fees did not exist when the Payment schedule was created but were ADDED when a Line status was
changed. For example, a returned check generates a 15.00 fee. This fee will only be added if the Line status
is changed from "Due Pmt" (or other) to "Returned Check". These fees are exceptions as opposed to regular
fees such as the "recomputed" fees above.

3. Fees entered under APR are fees that are either:

 charged and paid in  advance or  after the end of  the loan but  only  affect the finance charge,  but  the amortization
schedule;

 financed and therefore become a sort of Principal (that can be isolated for accounting purposes).

4. Fees included in the interest rate  are treated simply like interest but can be isolated for accounting purposes when
producing reports with Mathematical Equations. See Fees included in the interest rate section.

See  also,  Additional  principal,  fees,  penalties,  insurance  and  taxes  in  the  Payment  schedule  (Armortization  payment
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schedule) chapter.

   

Fees, Insurance and Taxes by Line status

Line status fees should only be used to add sporadic fees (penalty, insurance or tax) or when a user wishes to pay these
fees at a specific time to be determined. They become cumbersome when they are charged every payment. When they
are paid, a new line must be inserted in the schedule with a Line status called, for example, “Fees Paid”. This way, they
can be isolated for accounting. Having to add this extra line when paid is also cumbersome. An alternative is to use the
more powerful Column fees.

1) Manually adding fees, insurance and taxes

For example, a 4 year lease includes insurance payable monthly and taxes payable annually. 

Our example: 

 Price of equipment of  25,000 
 Residual value of 5,000 after 4 years
 Insurance per year 175.00 (4 payments) 
 Taxes payable annually 437.50 (4 payments) 
 Monthly payments 
 Interest rate 5.25%

Create a new Record with "File" and "New Record". See also Creating the first Record. 

Preliminary Data, then press "Compute":
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Once the Payment schedule is created, insert the insurance and taxes (assuming that insurance and taxes do not change
every year). For fees, insurance or taxes that are calculated taking into account the balance,  or  if  paid each month for
example, use Column fees instead.

Insert  the  annual  taxes  and  insurance paid,  say,  on  January  1  of  each year.  Manually  choose  the  Ctrl  key  and  the  left
mouse button with the lines 01-02 of each year or choose the line 01-02-2017 and Alt L which allows you to select a line
out of 12 (see all Shortcuts with F2).

Press on  to insert two lines between each of the selected lines (one line for insurance and one for the taxes).
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The lines will be inserted above 01-02. These new lines will be identified with the Line status "Information" and will  be
dated 01-01 of every year.

Select the first line of each year (01-01) or use Alt L to select one line out of 14. Edit the payment of these lines (right-click
> Payments  >  Modify  Payment  button  -  Selected Lines)  (Fig.  (1))  to  enter  the  insurance of  175.00 (Fig.  (2)).  A  warning
message will appear (Fig. (3)) that you can skip by pressing Yes (explanatory warning required in specific situations).
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(1)

(2)

(3)

Change the "Not Set" Line statuses to "Insurance".
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Do the same for annual taxes.

Once all entered, because of insurance, taxes and interest, the new balance increases to 7761.21, but we want a residual
value of 5000.

We must therefore recompute the payments to pay the right amount while taking into account the insurance and taxes.
Use Alt P which allows you to choose only the positive lines, then recompute the payments to give a balance = 5000:
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The payments then become 536.55 and the table is complete.

An alternative would have been not to recompute the payments immediately, but to include actual, true payments over
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time as they are received. Thus, when a payment is made, change the Line status from "Due Pmt" to "Paid Pmt". Then

add new payments separately using  with the  "Insurance paid" and "Tax paid" Line statuses.

If  no  interest  is  to  be  charged  on  insurance  and  taxes,  select  the  desired  lines,  use  the  right  mouse  click  and  under
"Payments" select "No interest Add. Princ., Fees, Tax, Insurance, etc.". When payments are made, interest is always paid
first, followed by the mathematical principal - see the "Principal" Type Line statuses section.

Warning! "Fees (Insurance, Taxes, Penalties)" Line statuses can only be paid and accounted for (isolated for accounting
purposes) if the Line status is manually changed to "Paid Fees", not to "Paid Pmt". If you wish to isolate and automatically
pay these Fees (or other), use Column Fees.

   

Fees, Insurance and Taxes by Column (and Automatic)

Column Fees are much more evolved than Line Fees. They are generally used when recurrent fees (Administration fees,
Insurance  or  Taxes)  are  included  in  the  payment.  When  a  payment  (Paid  type  Line  status)  is  made,  these  fees  are
included in "Payment Type" Line statuses. For accounting purposes, the pre-established refund order is the following: 

1. Column Fees 1
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2. Column Fees 2
3. Column Fees 3
4. Column Fees 4
5. Column Fees 5
6. Column Fees 6
7. Interest
8. Principal

Note that the refund order can be modified according to different mechanisms (see below).

It is possible to manually add Fees (hereafter "Manual Fees") or automatically add Fees (hereafter "Automatic Fees") in
Records according to rules defined by Margill Administrator. The Automatic Column Fees module allows users to add and
change Column Fees that will automatically be generated when a Line status is changed in a Record.

Important: Rename Column Fees in a meaningful manner in order to avoid operational conflicts. Since
Column  Fees  added  automatically  can  conflict  with  fees  added  manually,  it  is  important  to  organize
these Fees very well. 

It is recommended to reserve the use of some Column Fees strictly for automatic addition and others
strictly for manual Fees. The word "AUTO" could even be added in the name for greater safety.

A Column Fee should never be automatic and manual. Otherwise, automatic Column Fees could erase
fees  inserted  manually  without  the  user  knowing  this  was  done.  MLM  gives  priority  to  the  last  data
entered and overwrites previous operations. 

Example of well-managed Column Fees:

Rename Column Fees in a meaningful way (see Custom Column Titles)

Column Fees 1: Returned Check
Column Fees 2: Insurance Fees (%)
Column Fees 3: Administration Fees
etc. (up to 6 types)

The fixed 25.00  fee  for  a  returned  check  applies  to  all  Loans.  It  will  therefore  be  programmed as  an
Automatic Column Fee in MLM. Thus, each time a user changes a Line status for Returned Check, fees
will automatically be added to the Payment schedule.

Insurance Fees (%) are mandatory for all loans and represent a percentage of the Loan balance charged
each period. It will therefore be added by the user when creating a Record (Manual Fee).

Administration Fees are added manually through the "Administration Fees - Accrued" column when the
Borrower asks for a review of his Record (Manual Fee).

Thus, if Column Fees are well managed, they cannot create any conflict. 

Please note that only the following Line statuses can include Column Fees:

 Due Pmt
 Due Pmt (2 to 5)

 Paid Pmt

 Unpaid Pmt
 Unpaid Pmt (2 to 10)
 Returned Check
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 Paid Pmt (2 to 20)
 Paid Pmt Returned Check
 Paid Late Pmt
 Partial Pmt
 Partial Late Pmt
 Add. Pmt
 Compensatory Pmt
 Interest Paid
 Principal Paid

 Add. Princ. (Loan)
 Add. Princ. (2 to 10)

 Other (1 to 10)

 Not Set (this Line status should never be used)

NOTE: If a Column Fee is defined by default (therefore greater than 0.00) and when the payment schedule is created with
the  "Payments set to 0.00" Payment method ("Data" tab),  the Line status will  become "Undefined" because a Column
Fee is not allowed for an Information line. "Information" is the default Line status for Payments of 0.00.

Contents:

Manual Column Fees

 When creating the Record
 In the Payment schedule with a right mouse click
 In the Payment schedule by entering the Fees one by one in the "Column Fees-Accrued" column
 In the Payment schedule, when adding lines

Automatic Column Fees

 Introduction
 Automatic Fees - Unpaid payment
 Automatic Fees based on the Record Type or a Custom Field
 Automatic Fees based on number of days late
 Sales taxes charged and then eliminated

Special Behavior of Column Fees

Special reimbursement sequences for Column Fees

Manual Column Fees

There are four ways to manually add Column Fees in a Record:

 When creating the Record

 In the Payment schedule with a right mouse click

 In the Payment schedule by entering the Fees one by one in the "Column Fees-Accrued" column

 In the Payment schedule, when adding lines

Add Column Fees when Creating the Record
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Column Fees can be added when creating the Record with the "Data" tab and the "Add Fees" link.

The following window will open:

When creating the Record, two Fee options are available:

1) Add Column Fee to original date only, or
2) For all lines in the Payment schedule
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When creating a loan, these Column Fees will influence the payment amount or other variable to be calculated.

 On the Origination Date only

If Column Fees are only added on the Origination Date, choose the "At Origination Date only":

An extra line will be inserted, even if the First Payment Date is the Origination Date. This new line will  have one of the
"Other" Line statuses (as renamed). It is recommended to name this Line status (Tools > Settings > System settings > Line
Payment Statuses > Description (modify) column with the same name as that given to the Column Fee (Tools > Settings >
System settings > Custom Column Titles). For example, "Closing Fees". 

Payment should be forced to 0 (check the "Payment=0" column) in Settings > Line Payment Statuses in order for there
not be be fees added in the "Payment" column by error since the fee amount must be in one of the six (6) Column Fee
columns.

Click on "Activate" and enter the amount or a percentage: 

Results:
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These fees can be entered by default by clicking on "Set as default" at the bottom left of the Column Fees window. This
default  is  by  user,  not  a  system  default.  Each  user  will  thus  have  to  configure  his  defaults.  To  clear,  press  on  "Clear
Default".

 For all Payment schedule (Due Payments) lines

Six Column Fee types can be activated. By default these fields are: "Column Fees 1", "Column Fees 2", "Column Fees 3",
etc. These names can be customized from Tools > Settings > Custom Column Titles.

Click "Activate" for the Record's desired "Column Fees" to automatically add fees in the "Column Fees" column(s) for all
"Due Pmt" lines.

You will have to choose from the following options:

Fees can be a percentage or a fixed amount. Fees can include interest or not.

If fees are set as a percentage, two options are available:
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Of true balance of preceding
line

The Column Fee amount will be calculated on the True Balance of the line preceding
the Column Fees inserted (or the accrued interest for the line), unless the payment of
this preceding line(s) is 0.00, in which case this or these line(s) will be ignored.

Exceptions to the 0.00 payment rule:

 The True Balance will  be  used for  all  "Unpaid  payment"  or  "Payment  due"  Line
statuses even if the payment is 0.00 ;

 The  True  Balance  will  be  used,  even  if  the  payment  is  0.00,  if  Column  Fees  are
included on this line.

The  True  Balance  of  a  line  payment  of  0.00  will  be  ignored  and  the  calculation  will
reflect the True Balance of the preceding line for which payment is not equal to 0.00
unless one of the exceptions above is met.

Of the line's accrued interest If this option is checked, the Column Fee amount will be calculated as the percentage
of the accrued interest calculated and displayed for this line.

For  example,  if  the  interest  displayed  for  the  line  is  1000.00,  and  the  percentage
entered is 10%, the Column Fee amount will be 100.00.

This option should only be used in regular payment plans. In  irregular scenarios,  fee
amounts should subsequently be reviewed, line by line in the Payment schedule.

Also, if the line's interest is only a fraction of the entire normal period's interest, then
the  fee  amount  will  only  take  into  account  the  interest  for  the  line  on  which  it  is
inserted, not for the entire accrued interest from the previous Column Fee entered.

However,  if  the  payment  of  one  or  more  of  the  lines  preceding  the  line  where  the
Column Fees is inserted is 0.00, the accrued interest for each of the 0.00 lines will be
added and this sum will be used to compute the Column Fees for the desired line. This
special  manipulation  will  not  be  done  in  these  two  situations  (the  normal
computation will be done):

 all "Unpaid payment" or "Payment due" Line statuses even if the payment is 0.00
;

 all lines, even if the payment is 0.00, if Column Fees are included on this line.

Of the pure principal balance
and days 

This type of  fee calculates the Column Fees based on the pure Principal  (accounting
principal)  of  the previous line and the number  of  days  from that  line  to  the  current
line.  The  calculation  is  done  exactly  like  Simple  interest.  Pure  principal  can  only  be
added  by  the  original  principal  entered  in  the  Data  window  and  with  "Additional
Principal" type Line statuses. APR Fees Finances are excluded. 

These fees will be displayed on all types of Line statuses (including the "Information"
lines). Fees cannot be deleted from one line but can be reduced to a percentage of 0%
in order to generate fees of 0.00.

These  fees  are  calculated  based  on  a  percentage  of  the  balance  of  the  pure  real
principal.  These  fees  cannot  be  replaced  by  Column  fees  based  on  other  criteria.  A
monetary amount cannot be entered (you will need to calculate the interest rate and
enter this rate to calculate an exact amount.

Fees will take into account Day count entered initially in the Record's "Advanced" tab.
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If the calculation method is modified for one or several lines (right mouse button and
Simple Interest or Simple Interest Capitalized method or a change in Day count), these
fees  will  not  be  affected  when  changing  methods.  Their  method  and  Day  count
remain unchanged.

No  interest  is  calculated  on  these  fees  even  if  they  are  overdue.  This  option  could
eventually be developed if needed.

If principal balance is negative, fees will be 0.00. These fees can never be negative.

If a calculation uses the Compound interest (Effective rate method or Simple interest
capitalized) method, this will not have any effect on the calculation of these fees since
they  always  use the  Simple interest  method:  pure  principal  balance  *  annual  rate  *
days for the period  / days of the year.

Other notes related to these special fees:
 
For the period's Day count, as well as for the number of days annually which will  be
taken into account in the fees calculation (denominator), the rules for Simple interest
will be used.

These calculations are always based on  the  "Year  base"  and  the  "Day count"  that  is
entered  in  the  Advanced  section,  no  matter  what  special  method  is  used  for  the
period (payment  line)  concerned  (for  example,  loan  uses  Actual/Actual,  but  for  one
specific  line,  the  user  chose  "Simple  Capitalized  30/360".  Fees  for  this  line  will
nevertheless  be  calculated  using  Actual/Actual  as  well  as  Simple  interest,  not
capitalized interest).

If  fees  are  included  by  default  (Data  window),  an  import  of  these  fees  via  Excel
(specified amount) will take precedence over this default as is the case for the other
column Fees.

If  fees  are  included  by  default  (Data  window)  and  the  user  chooses  "Irregular"
payments,  unlike  the  other  Column  Fees,  these  special  Column  Fees  will  be  added
automatically as lines are added.

These types of special fees are not included in the Automatic Fees because this would
not be logical. These fees are applied on every line of the Payment schedule, not on
an ad hoc basis as for other fees following a Line Status change. These fees are really
special fees and REALLY regular.

Once the Fees are set-up, click on "Save as default" and "Submit" in order for these Fees to be activated by default on all
new Records.
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If Fees are included by default, an asterisk (*) appears beside the "Add Fees" link in the Dat window:

Exception:  In  the  case  of  "Irregular"  payment  frequency,  if  a  Payment  schedule  is  pre-filled  before  calculating  the
Payment schedule, the Fees set by default will be ignored. Those entered directly in the table will be used as shown in the
example below:

IMPORTANT:  Even  if  fees  are  left  blank,  the  default  fees  will  be  ignored  if  payments  are  added  as  above.  If  the
"Irregular"  frequency  is  used but  irregular  payments  are  not  entered  as  above,  only  one  line  will  be  created  in  the
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payment schedule and the default fees WILL be added. It is therefore necessary to properly manage these exceptional
situations.

Add Column Fees in the Payment schedule with a right mouse click:

When fees only apply to certain lines, the user can add these fees only to the selected lines in the Payment schedule by
right-clicking the mouse and selecting "Column Fees".

The window including the six (6) Column fees will open with essentially the same options that were available when the
Record was created. This includes the possibility of automatic recomputing by taking into account balances and accrued
interest.

However, two new options become available: 1) "Change/Add Fees (All lines "Due Pmt") or 2) "Change/Add Fees (for the
SELECTED LINES ONLY)".

If you choose "Change/Add Fees (for the SELECTED LINES ONLY)", note that only the following Line statuses can include
Column Fees: "Due Pmt", all "Paid Pmts" and "Unpaid", all "Additional Principal", Other 1 to 10 (payment amount of 0.00
is recommended for "Other") and "Not Set". 

Data present / Empty

When the right mouse click is used to add fees, MLM indicates whether data is present or not in the selected lines.

In the following example, 4 lines without fees are selected (highlighted in blue). The word "Empty" will appear indicating
that there are no fees in the selected lines. However, it is possible that there are fees in subsequent lines:
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In the second example, lines with and without fees are selected. MLM will indicate that Data is present even if it is only
for certain lines.

Add Column Fees in the Payment schedule by entering Fees one by one in the "Column Fees - Accrued" Column:

Column Fees can be manually added in the "Column Fees - Accrued" column of the Payment schedule.

To do so, select the line for which fees are to be added and enter the desired amount in the "Column Fees - Accrued"
column.

When  the  Column  Fees  are  manually  added,  it  is  strongly  suggested  to  move  these  columns  closer  in  the  Payment
schedule for easy access.



Page 578

© Jurismedia Inc., 2007- 2023

In the Payment schedule, when adding lines

Column Fees can be added on lines added in a Payment schedule. Right click:

It is not be possible to add Fees in columns that already contain fees of the "Of pure principal balance and accrued days"
type because these types are added to all lines of the loan automatically.

WARNING:

Once a Line status is changed to Paid payment, the fees' behavior label (automatic recomputing on the balance
for example) is deleted. If changes are made afterwards to lines preceding these fees, thus changing the Payment
schedule's history, Fees will no longer be automatically recomputed.

See also Custom Columns which allow the user to enter complementary notes in regards to these fees.

See also Mortgage and Escrow. 

Automatic Fees - Added (automatically ADDED) under various conditions

 Introduction
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 Automatic Fees - Unpaid payment

 Automatic Fees based on Record Type and Custom field

 Automatic Fees based on number of days late

 Different amount Automatic Column Fees based on loan agreement (or loan type)

 Sales taxes charged and then eliminated

Introduction

This module allows the system to add and change Column Fees automatically  when a  Record's  Line  status  is  changed.
These  automatic  fees  must  be  activated  for  each  Record  (under  the  Record's  "Advanced"  tab).  It  is  also  possible  to
activate automatic fees for multiple Records (even all Records in the database) with the Global changes module in MLM's
Main Window (right mouse click).

  

These  fees  do  not  exist  when  the  Record  is  created  but  are  ADDED  when  a  Line  status  is  changed.  For  example,  a
returned check implies a 15.00 fee. This fee will only be added if the Line status is changed from Due Pmt (or other) to
"Returned Check". This 15.00 is not a regular fee as opposed to fees entered manually or when the loan is created.

IMPORTANT:  Be careful when creating Column Fees rules! It  is important to organize these
fees well because manual and automatic Column Fees can create conflicts.

See the IMPORTANT section above.

Automatic Column Fees can only be applied to the following Line statuses:

 Unpaid Payments:
o Unpaid Pmt
o Returned Check
o Unpaid Pmt (2 to 10)

 Particular Paid Payments:
o Late Paid Pmt
o Partial Pmt
o Partial Late Pmt



Page 580

© Jurismedia Inc., 2007- 2023

o Paid Pmt Returned Check
o Paid Pmt (2 to 20)
o Interest Paid
o Principal Paid

 Additional Payments:
o Add. Pmt
o Compensatory Pmt

 Additional Principal:
o Add. Princ. (2 to 10)

They cannot be added to "Due Pmt" type Line statuses, nor to "Paid Pmt", nor to "Add. Princ. (Loan)" since these Line
statuses are system defaults (that are generated when a payment schedule is created).

In Settings > System Settings (Administrators) > General Settings, click on "Column Fees: Automatic".

Click on to set a new condition (rule).
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Conditions (rules) can be set in the lower section of the window:

Fees can be set as a percentage or as a fixed amount. These fees can include interest or not.

If the fees are set as a percentage, four options are available:
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Of true balance of preceding
line

The  Column  Fee  amount  will  be  calculated  on  the  True  Balance  of  the  line
preceding the Column Fees inserted (or the accrued interest for the line), unless
the payment of this preceding line(s) is 0.00, in which case this or these line(s)
will be ignored.

Exceptions to the 0.00 payment rule:

 The True Balance will be used for all "Unpaid payment" or "Payment due"
Line statuses even if the payment is 0.00 ;

 The True Balance will be used, even if the payment is 0.00, if Column Fees
are included on this line.

The True Balance of a line payment of 0.00 will be ignored and the calculation
will  reflect  the  True  Balance  of  the  preceding  line  for  which  payment  is  not
equal to 0.00 unless one of the exceptions above is met.

Of the line's accrued
interest

If  this  option  is  checked,  the  Column  Fee  amount  will  be  calculated  as  the
percentage of the accrued interest calculated and displayed for this line.

For  example,  if  the  interest  displayed  for  the  line  is  1000.00,  and  the
percentage entered is 10%, the Column Fee amount will be 100.00.

This option should only be used in regular payment plans. In irregular scenarios,
fee  amounts  should  subsequently  be  reviewed,  line  by  line  in  the  Payment
schedule.

Also, if the line's interest is only a fraction of the entire normal period's interest,
then  the  fee  amount  will  only  take  into  account  the  interest  for  the  line  on
which  it  is  inserted,  not  for  the  entire  accrued  interest  from  the  previous
Column Fee entered.

However, if the payment of one or more of the lines preceding the line where
the Column Fees is  inserted  is  0.00,  the  accrued  interest  for  each  of  the  0.00
lines will be added and this sum will  be used to compute the Column Fees for
the  desired  line.  This  special  manipulation  will  not  be  done  in  these  two
situations (the normal computation will be done):

 all "Unpaid payment" or "Payment due" Line statuses even if the payment
is 0.00 ;

 all  lines,  even if  the  payment  is  0.00,  if  Column Fees are  included  on  this
line.

Of unpaid portion of the
payment

The Column Fee amount will be calculated taking into account a percentage of
the amount that should have been paid minus the amount paid.

 "Expect.Pmt" column amount minus "Payment" column amount.

For  example,  if  a  100.00 payment  should  have  been  paid  and  the  percentage
entered  is  10%,  the  Column  Fee  will  be  10.00  if  the  payment  is  unpaid.  If  a
partial payment of 75.00 is made, as opposed to the expected 100.00, the Fee
will be 2.50 (100.00-75.00=25.00 x 10%).

Of payment amount The  column  fee  amount  will  be  calculated  based  on  the  amount  in  the
"payment" column.

For example, if a payment of 100,00 is paid late and the percentage entered is
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10%, the column fee will be 10.00.

Names for  "Column Fees  1  to  6"  can  be  changed.  To  do  so,  see  Settings  >  System Settings  (Administrators)  >  Custom
Column Titles.

Automatic Fees - Unpaid payment:

In the example below, the user wishes a 25.00 fee to be automatically added every time a check is  returned. The user
renamed "Column Fees 1" to "Administration Fees". 

The  user  wants  a  fixed  amount  of  25.00  without  interest  to  be  charged  each  time  a  "Returned  Check"  Line  status  is
selected.

By clicking "Save", this condition will be added to the system and ready to be used.

It  is  possible  to  add  many  conditions  or  to  change  pre-established  conditions  by  clicking  or

.

Note that this rule will ONLY apply to the "Returned Check" Line status, no other. If the rule was to apply to the "Unpaid
Pmt" Line status, a special rule would have to be created specifically. 
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*In order for these predefined conditions to apply to Records,  you must complete the following procedure for  each
Record for which Administration fees are applied when a check is returned*

Open  the  Record  for  which  you  wish  to  add  the  "Automatic  Column  Fees",  click  on  .  Check  "Use
Automatic  Column  Fees  for  this  Record".  If  you  want  these  fees  to  be  applied  to  all  subsequent  Records,  click  on  

.

In order to change multiple Records at the same time, use the Global Changes procedure which can be accessed through
MLM's Main Window.

In certain situations, different fees may apply. For example, if the penalty fee is greater when a preauthorized payment
(PAP)(preset EFT payment) bounces, we could create a new Line status called "Unpaid PAP" (previously named Unpaid
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Pmt (2)) and automatically charge 25% of the payment amount that was EXPECTED.

Expected payment is 372,76. 25% = 93.19

Thus,  a  loan  can  contain  fixed  and  variable  fees  of  the  same type  (NSF  Fees  for  example)  and  a  combination  of  both
based on the final Line status of a payment line.

We can also add fees for each disbursement made to the Borrower. A contract could state that a 100.00 fee is charged
for each portion of the total loan that is disbursed. Thus, the Line status "Add. Principal 2" (renamed as desired) would be
used for this disbursement and the fees will  automatically be added. Fees cannot be added to the "Add. Princ.  (Loan)"
Line status because this Line status is the default for all negative payments.

Automatic Fees based on Record Type or Custom field

This option allows the Margill Administrator to create Column Fee rules based on Record Type OR on a Custom field that
includes a scroll menu.

Only one type of filter can be used for the automatic Column Fee rules by combining Line statuses and Fees. Once the
filter choice is made between None, Record Type or Custom field, only this filter will be available.

To do so, choose from the list if the Fee is based on:

 None: This is the conventional method, as described in Automatic Fees for unpaid payment. 

 Record Type: Fees apply automatically if Line status AND Record Type correspond to the specified conditions.  

o The Record Type is defined via the System Settings (Administrators) > Field Scroll Menus. 
o It can be found in the Record, Data > General tab. 



Page 586

© Jurismedia Inc., 2007- 2023

 Custom  field:  Fees  apply  automatically  if  Line  status  AND  the  Custom  field  data  correspond  to  the  specified
conditions. 

o The Record Unlimited Custom fields (Table format) are defined through System Settings (Administrators) >
Custom Fields. In order to use them with Automatic Fees, they must be "Menu" Type.

o The fields and their values are located in the Record > "Data" section > "Other Data" tab. 

Example :

One could define that a Fee of 20.00 automatically applies for "Personal loans", 50.00 for Business loans and 35.00 for
"Auto loans". 
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To modify the filter, all fee rules containing this field must be first deleted. A new default filter type can then be chosen.

Multiple Types could also have been chosen for one fee amount by checking the types. Types already used appear in grey
and cannot be chosen a second time.

Automatic Fees based on number of days late:

A Creditor would like to apply Fees automatically if a payment is made more than a certain number of days. When a user
changes  the  Line  status  from "Due  Pmt"  to  "Paid  Late  Pmt"  (or  "Partial  Late  Pmt"),  MLM  has  the  ability  to  count  the
number of late days and thus apply, or not, rules previously established here. In the example below, if a Borrower makes
a payment five (5) days late, a Late fee of 25.00 will be added automatically to the Payment schedule:
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When processing the late payment in the Borrower's Record, fees will be automatically added only if the "Pmt Date" is
greater than the "Due Pmt" date by the number of days of delay entered. 

The user must specify, when changing the Line status from "Due Pmt" to "Paid Late Pmt", the date at which payment is
made, the date at which the payment was originally expected being already entered.

If no date is entered in the "Pmt Due Date", even if the Line status is a "Late" payment type line, no fees will be added
since the number of  late days is  calculated according to the real  date of  payment compared to the date on which the
payment SHOULD have been made.

Payment date is modified in the Payment schedule for the real date on which the payment was made and the 25.00 Fees
are added automatically to the Payment schedule in the appropriate column.
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Please note that if a user subsequently changed the date in the "Pmt Date" column of the Payment schedule and that the
difference between the date of "Due Pmt" and the real date becomes less than the allowed difference (in this example,
five (5) days), then the Fees will be removed from the Borrower's Payment schedule. A message will appear in order to
inform the user who can decide whether to continue or not:

Also note:  if  the  date  in  the  "Pmt  Due  Date"  column  is  changed,  the  late  Fees  will  NOT  be  affected  since  usually,  the
payment due date should not be changed since it is due based on contract. 

Only one rule can be created by Line status and Column Fees. One cannot, for example, specify that if payment is 9 days
late, fees are 25.00 and if payment is 15 days late, fees are 35.00. However, a second rule can be created for the same
Line status but with a second Column Fee, as shown in the example below:

Column Fees  1,  renamed "Late  Fee  9  to  14  days"  will  apply  automatically  if  the  payment  is  late  by  more  than  9  days
(25.00 Fees):

Column Fees 2, renamed "Late Fee more than 15 days", will  apply automatically if  the late payment is greater than 15
days  (we  want  a  total  of  35.00  for  Fees  including  the  one  charged  for  the  late  9-14  days,  so  a  10.00  supplement  is
entered, not 35.00, which would have given a total of 60.00 - not a desired result):
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A due payment on April 1st that would be paid on the 17th is nine (9) days late (fees 25.00) AND more than fifteen (15)
days (fees + 10.00), so, since the two automatic fees conditions are met, the two fees will apply to the Record for a total
of 35.00 but in two separate Column Fees.

The less automatic method below can also be used.

Fee scale according to the number of late days

The user would like the Fee to be higher or lower on a pre-established scale, based on the number of days late.

To do this, the user must first rename the "Paid Pmt (2) to (20)" Line statuses based on the rules he wishes to apply. For
example, payments 5 to 10 days late and payments more than 10 days late.
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Next, the user will create the Automatic Fee rules he wishes to apply to the Borrowers who pay late:

For late payments of 5 to 10 days the fee is 20.00:

For late payments of more than 10 days, the fee is 50.00:
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For example, when a Borrower pays 13 days late, the Creditor will automatically charge 50.00 ("Column Fees 1" renamed
to "Late Payment Fees") using the "Pmt made 3" Line status (renamed to "Paid Late (>10 days)"). The system does not
automatically calculate the number of days late, the user must specify the appropriate Line status.

While allowing for a lot of flexibility, this method is less sophisticated than the method by which MLM decides whether or
not  to  add  fees  according  to  the  number  of  late  days  with  the  "Paid  Late  Pmt"  or  "Partial  Late  Pmt"  Line  statuses  as
shown in the previous section.

Different amount Automatic Column Fees based on loan agreement (or loan type)

It  may happen that  different loans will  be charged different fees when payments are unpaid or  late.  In  order to easily
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identify the fee amount, Unpaid payment (2 to 10 )or Paid Line status names could be changed to reflect the fee amount
that will be charged.

In the example below, if a payment is partial or late, fees of 10.00 apply. If unpaid, the fees can be either 15.00 or 25.00.
The Line status names were changed consequently and the automatic fees rules would have to be created for each. 

Sales taxes charged and then eliminated (unpaid Lease payment by borrower)

When  sales  taxes  are  included  in  one  of  the  columns,  for  example,  for  leases,  taxes  are  included  in  each  payment
amount. These taxes are entered in the Column Fees initially, taking into account the payment amount. However, when a
payment  is  not  paid,  these  taxes  must  not  be  invoiced  to  the  client.  They  must  be  eliminated.  This  could  be  done
manually, but it is even more efficient to create a rule by which the Column Fees (taxes) are eliminated when a payment
is not paid.

In the example below, two taxes are charged (GST and QST) at every payment. Two rules are also created:

 if unpaid, GST = 0.00 
 if unpaid, QST = 0.00

A third rule is also created by which 25.00 is charged for unpaid payments.
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Payment schedule at line 5:

 NSF fees of 25.00
 GST which was 50.00 becomes 0.00
 QST which was 99.75 becomes 0.00

Special Behavior of Column Fees

When Column Fees are based on the the preceding line's balance or on accrued interest, or when these fees do not bear
interest, these special behaviors will be displayed in the "Column Fees X - Payment Type" column.

For example, Administration Fees are added in a loan. They represent 1% of the preceding line's balance and do not bear
interest. 

The "Administration Fees - Pmt Type" column informs us of many elements:

 AutoFeesCol: that Fees amount is automatically recomputed based on the events above;



Page 595

© Jurismedia Inc., 2007- 2023

 NoINT: that the Fees do not bear interest (NoINT)
 0.01: that the Fees represent 1% of the balance or of the accrued interest.

When a payment is paid, the "AutoFees" label will be deleted because the payment has now been managed and we do
not want this fee amount to be recomputed. The "NoINT" label, now renamed to "No interest" will remain.

Example:

In the following example, the automatic fees rule dictates that if  Line Status = Add.  Princ.  (3),  then add Column fees 6
(which could be renamed as desired). This fee is equal to 1% of the previous line balance.

Lines 2 to 7 have been added or imported automatically. Notice on Line 3, that no special “Behavior” is included in the
“Column Fees 6 – Pmt Type” column, while on Lines 6 and 7, we see “AutoFeesCol//0.01”. This instructs lines 6 and 7 to
recalculate Fee 6 based on the balance, should that previous balance change.

Why recalculate lines 6 and 7 but not line 3? Margill has a certain intelligence. When importing a Paid type Line status
(line 5 in this case), if it is inserted, the software assumes that all of the lines above are historical and therefore, we would
not want to recalculate fees already accrued and probably billed. On the contrary, for lines 6 and 7, no payment follows,
so  Margill  cannot  assume  that  these  lines  are  historical.  It  is  possible  that  a  payment  will  be  added  upstream,  thus
reducing the balance and consequently reducing the fees for lines 6 and 7.
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By adding  a  “Paid  payment”  (as  opposed to  a  “Due  Pmt”  that  is  not  yet  certain)  on  Line  8,  a  message appears  which
explains  that  the  Behavior  will  now  be  deleted  for  the  lines  above  since  we  are  quite  certain  that  Lines  6  and  7  are
historical since a payment was already made on 16-08-2022.

Special Refund Order for Column Fees

By default, Column Fees refund is done chronologically: Column Fees 1, Column Fees 2, Column Fees 3,Column Fees 4,
Column  Fees  5  and  finally  Column  Fees  6  (with  the  name  given  in  the  Settings).  Interest  is  then  paid  and  finally,  the
principal (and APR Fees financed if applicable, on a pro-rated basis of the accounting Principal). 

However, you can specify, as na exception, that a Column Fee be paid in priority and the others will  follow the normal
sequence. Simply choose one (or several) lines for you wish to change the regular refund order, right click of the mouse
and choose "Column Fee Payment Order: Column Fees 1 (Default)". A list will appear with Column Fees 1 to 6. Select the
one you wish to be paid first. The others will follow the chronological order: for example, Column Fees 3 is first, so the
sequence will be: Column Fees 3, 1, 2, 4, 5 and 6, NOT 3, 4, 5, 6, 1, 2.
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The amounts entered in the "Payment" column of  the  Payment  schedule will  change to  green in  order  to  let  the  user
know that the default refund order was modified:

For example, a Borrower has to pay Fees of 25.00 plus interest because his check bounced. The Borrower sends another
check  and  adds  the  fees  to  the  payment  amount  (total  1025  instead  of  1000).  In  order  to  apply  the  amounts  to  the
appropriate  accounting  revenue category,  exceptionally,  the  MLM  user  applies  the  payment  on  the  fees  for  Returned
Check BEFORE applying the residual amount according to the usual refund order (Administration Fee, followed by GST,
then PST as shown in the example below).

See also the Refund order for Interest, Fees and Principal section in the Calculations Methods chapter.

   

Fees included in the interest rate

If the fees are to be computed exactly as interest, these fees, as a percentage, could be included in the total interest rate.
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For example, the interest rate is 6% a year and the Creditor charges 1% annual administrative fees on top of the normal
interest. So the Nominal Interest Rate entered should be 7%.

Even if  the interest rate is made up of multiple fees (all  added to the "Annual  Nominal  Rate (%)") each portion can be
isolated  for  reporting  purposes  using  the  Mathematical  Equations  and  used  in  Record  list.  Mathematical  Equations
cannot be used in all reports (cannot be used in the Accounting report for example).

First create a custom field for the loan called "Administrative Fees (%)" as a percentage field. For our example, 1% will be
entered here.

Then create the Mathematical Equations to report either the Paid Administrative Fees or the Accrued Administrative Fees
as  well  as  the  corresponding  interest  component.  The  first  equation  should  take  the  Admin.  Fee  proportion  (as  a
percentage of the total finance percentage) multiplied by the Interest Paid for the period. The second equation will  be
the true interest amount paid (Interest rate minus Admin Fee divided by the total finance percentage) multiplied by the
Interest Paid for the period.

Administrative Fees portion (Paid) Interest portion (Paid)

If 100.00 in "interest" (total finance charge) was paid for one month, the Equations would provide the following
numbers: 

Administrative:  1/7 x 100 =  14.29
Interest:                   (7-1)/7 x 100 =                   85.71
Total:  100.00

These would be reported in the Record List  report. The Equations are in the third and fourth columns below. The last
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column is the total of the two Equations (to test that our Equations are properly created). This is  actually  the 'Interest
paid for period" renamed to "Total finance charge - Paid...".

If the fee percentage is to change, do not forget to change the custom field value.

CAUTION:  This technique is usually  used only  if  the interest rate does not  change.  The proportion would no longer be
valid once the interest rate changes. A work-around could be to create a custom field for the interest rate (as opposed to
using  the  Annual  Nominal  Rate  field)  and  when  the  rate  changes,  the  value  for  this  custom  field  would  be  changed
accordingly along as the interest rate in the Payment schedule. Changing custom fields for multiple Records at the same
time is much easier with the Global changes tool.

   

APR Fees

See the Annual Percentage Rate (APR) section.

   

Loan with Fees (Insurance, Taxes, etc.) not bearing interest

Create a new Record with "File" and "New Record". See also Creating the first Record and Data entry screen Basics.

Enter the required financial data in the "Data" window. See for example, Loan (car, personal, commercial).

Line Fees

Once the Payment schedule is produced, add the fees (or other) in the schedule. In this example, Fees, Insurance and a
Tax were added (see blue lines). The description for "Fees" (and corresponding "Fees Paid") may be changed based on
the type of fees charged - see the Line status section). By default, interest is charged on these.
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In order for  these not  to bear interest,  right click with the mouse, "Payments" and "No interest Add.  Princ.,  Fees,  Tax,
Insurance, etc."

 
The last column of the Payment schedule will identify these lines as "No interest" and the Line statuses will appear in a
dark blue in order to see the special statuses of these lines.
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As for repaying these Fees, see the "Paid fees, paid Penalties, paid Taxes, paid Insurance and paid Invoices" subsection of
the Additional principal, fees, penalties, insurance and taxes section for detailed explanations.

It is also possible, as the default setting for a specific Record or for all Records, for Fees (and other) not to bear interest.
In a Record, go to the "Advanced" tab and check the  "No interest on..." box. To set this as the default for all  Records,
press on "Save as default". A Profile could also be set for certain types of loans. 

Column Fees

In order not to charge interest on Column Fees, choose the lines in which fees must be entered then right click on the
mouse > Column Fees. In the "Interest behavior" section, choose "No interest on these fees".

Column Fees with no interest are paid with "Payment" type Line statuses before Column Fees that bear interest.
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These  Fees  and  their  specifications  (amount,  percentage,  with  or  without  interest)  can  become  default  settings  when
creating a new Record. Once the proper fees are set, click on "Save as default" under "Data".

Balances

Because these fees do not bear interest, the "Balance" and "Computational Balance" columns in the Payment schedule
will  usually no longer be equal.  The Computational  balance takes into account only  the principal  (and other fee types)
that bear interest.

See also, Loan without interest on part of the principal only.

   

Arrears: Late and/or unpaid salaries, rent, annuities

Margill Loan Manager (MLM) can also manage late or unpaid salaries, rent or other annuities (such as support payments
or alimony).

Arrears  are  similar  to  loans  but  instead  of  the  principal  diminishing  over  time,  it  accrues  over  time.  A  loan  starts  at  a
certain loan amount and usually finishes at 0.00 over the amortization period. Unpaid annuities usually start at 0.00 and
grow over time. 

Create a new Record with "File" and "New Record". See also Creating the first Record and Data entry screen Basics.
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Let's do an example with a late and unpaid rent:

 The tenant did not pay his June rent 
 The August and September rents were also not paid
 The November rent was only paid on November 18 
 Rent is 1500 per month 

How much is owed on January 1 if the late rent interest rate is 10% annually with simple interest (could also be monthly
compounding if allowed by law). The rates can also be variable legal interest rates depending on the jurisdictions.

First change, in the "Advanced" window, the "Method" to "Simple Interest".

Year  base  (to  take  into  account  the  small  effect  of  leap  year)  may  be  left  at  "Anniversary"  or  changed  to  "Civil  year"
depending if a calculation norm exists. See the distinction in the Simple interest section.

The preliminary Data window would look like this:
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The principal was left at 0.00 but could have been 1500 for the June 1 unpaid rent (but be careful not to count this rent
twice). Instead, in order for all rents due to be neatly detailed in the Payment schedule, minus 1500 was entered as the
payment (this will create a Payment schedule as if ALL rent amounts were unpaid for these 9 periods). 

The  Amortization  period  was  9  payments  to  create  a  table  that  includes  the  interest  up  to  and  including  January  1.
Instead  of  manually  counting  the  number  of  payments,  in  the  "Amortization  (Payments)"  box,  (

 ) right click with mouse, chose "Specific Date" and in the window that
opens, enter January 2, 2007.  

Press  on  "Compute".  The  following  window  will  appear.  Click  on  "No"  (our  initial  principal  is  0.00  and  should  not  be
computed).

The preliminary Payment schedule below must now be edited to reflect our true situation. These would have been the
results had each of these monthly payments not been made. Since the computation is performed with simple interest,
the "Computational balance" in the Payment schedule window is the balance used to calculate the interest as opposed to
the true balance reported at  the bottom right of  the window, in  a  column to  the  right,  and  in  the  printed report  (see
Balance column in schedule for further information on this topic).

By default, amounts of -1500 have the "Add. Princ. (Loan)"  Line status.  These Line statuses could be modified (not an
obligation and there is no mathematical effect), for "Add. Princ. 3" which would be renamed "Arrears" or "Rent".  There is
no quick way to change these Line statuses in bulk, therefore, they must be changed one by one.
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In  the  window  below,  the  first  three  lines  in  blue  represent  the  unpaid  rent  (June,  August,  September).  The  July  and
October rents are at 0.00 since these were paid (thus are not due).

The 4th and 5th lines in blue represent, respectively, the unpaid November 1 rent (-1500) which was then paid (+1500)
(Payment type Line status renamed to "Paid rent")  on November 18. The -1500 and +1500 payment cancel, leaving only
the interest portion to be accounted for during the 18 days.

Finally,  no  amounts  were  due  for  December  and  January  thus  the  0.00  payments.  We  then  changed  the  final  date  to
January 2 instead of February 1 ("Pmt Date" column) to get total interest up to January 1 inclusively.

The very same methods can be applied to late or unpaid salaries and alimony (support payments). For unpaid salaries, if
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salaries are paid every two (2) weeks, then the "Payment Frequency" should be "By day(s)" and "Number of day(s) 14:

   

Legal costs and fees management and collection with interest

Many law firms, particularly, personal injury lawyers will finance their client costs and fees until the settlement occurs, at
which time they will deduct these fees, costs and interest, from the settlement.

Margill Loan Manager (MLM) can, using data from with your other systems, create the actual Case (more or less a loan),
import case costs and fees (transactions) in bulk, and calculate the interest throughout the lifecycle of the Case. In some
situations,  a  line  of  credit  is  afforded  to  the  client  where  costs  and  fees  (invoices)  are  added  and  payments  made
occasionally by the client to reduce the balance owed. This latter situation does not factor in success/non-success, so is
simply client finance.

For litigation finance based on success, if a case is successful, interest will be charged to the client and fees reimbursed. If
the case is not successful, no interest or fees will usually need to be paid back by the client, but the law firm will know its
cost of capital, case by case. Most often, the cost of capital to the law firm (so the interest rate its bank charges) will be
the  same  rate  as  the  rate  charged  to  the  client,  but   the  rate  charged  to  the  client  could  also  be  higher  (margin)  to
generate a little extra revenue. The interest rate could also be fixed or tied to the bank rate (variable interest rate loans)
and could include a spread (so Prime + x%). Simple or compound interest can be used as the calculation method.

We recommend using "Additional Principal" type Lines statuses since we will  consider the Fees or Costs to be principal
 (since this is kind of a loan) as opposed to fees as Margill would see them. So change one or many "Add. Princ (X)" Line
statuses to the desired names (Tools > Settings > Line Payment Statuses): 

 
You could create only one "Fee" or multiple fees (up to 9 different names if needed).

If you are dealing with relatively high volume (for transaction (Fees) input certainly), Data can be imported though and
Excel file. See Bulk Payment (Transaction) Import as well as the Bulk Import of Loans options (manually or automatically
via Excel or JSON files).

A host of special situations can be handled by MLM (the numbers correspond to the red numbers in the image below):

(1) One or many, up to nine (9) Fee types (Lawyer Fees and Expert Fees – could be named as you wish – Medical Expense,
Expert Expense, Medical Expense no interest, etc.).

(2) Line 5 shows the 666.36 Lawyer Fees that do not bear interest (blue Line status and "Pmt Type" column).

(3) As of 1/29/2023, interest is no longer charged on all amounts since maximum 3 year Term (optional of course). Line
color was changed to red to highlight the End of Term.
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(4) An Invoice number was added for each invoice.

(5) A Comment may be added on any line.

(6)  Final  settlement 21,250. All  interest got paid first  but  we could have paid the 19,760.83 in  Principal  (the  Fees)  and
there would have been an interest balance of 39.44 instead of Principal balance for this amount – you have the options
with the Line statuses.

Interest can start 30 days after the expense/invoice date so the Pmt Date entered would be the expense/invoice date +
30 days. The actual expense/invoice date could be in another column (not shown below).

The Case can also be lost in which case, instead of a Payment at the very end, there would be a Line status that could be
called "Loss" or "Bad debt" to bring the balance to 0.00 and to isolate the fees and interest as unrecoverable for your
accounting (not shown below).

Many other options are available...

   

Investment portfolio

An investment portfolio for one or multiple clients is simple to create and the reports can provide up to date or annual
totals in a snap.

In this example, we will recreate one investment that includes investments and cash withdrawals over time. 

Create a new Record with "File" and "New Record". See also Creating the first Record and Data entry screen Basics.
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On December 15, a couple invests 50,000. Their goal is to contribute to their retirement plan 1000 twice monthly for the
next  two  years  (starting  Feb.  1)  and  to  reevaluate  in  two  years  their  return  on  investment.  To  make  it  slightly  more
interesting,  they  will  sometimes  invest  a  greater  amount  and  also  take  out  an  amount  to  pay  off  some  debt  (they
shouldn't have done this but nobody's perfect!).

The Data window looks like this for the normal situation. The Annual Nominal Rate is  not  really  pertinent at  this  point
since we don't know what the ROI will be. But just to get an idea, since the couple would like a 12% return, we will enter
12%.  

Press on "Compute" to produce a Payment schedule over 2 years with  a  12% return.  Their  theoretical  balance at  12%
would be 118,617 after 2 years.
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Time goes by and the couple invests an extra 3500 on August 10, 2007 (first highlighted line in the screen shot below). So
we insert a line by highlighting the line whose Pmt Date is BELOW where we want to insert (thus Pmt Date of 08-15-2007)

and  press  on  .  A  payment  may  also  be  added  with  the  right  mouse  click  (Select  any  line,  press  on  "Insert"  and
"Payment(s)".  A  window  will  appear  to  add  at  the  specific  date  and  with  the  various  criteria  desired  -  in  this  case  1
payment of minus 3500). 

Planning for an expensive Christmas, the couple must draw 5000 from the account on December 1st 2008 and will  not
pay the usual 1000 on December 1. Thus change the December 1 payment from -1000 to 0.00 and add a new line with
5000 to represent a withdrawal (second and third highlighted lines below).
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These are the only changes made until the maturation date of February 1, 2009. 

On the maturation date the value of the investment is really 135,100. What is the true return on investment? This can
easily be figured out by selecting all lines (Ctrl-A), right clicking with the mouse and choosing "Interest rates" and "Rates
Adjusted for Balance = X".

A window will appear in which to specify the balance of 135,100. 

Click  on  OK  and  the  rate  will  be  recomputed  for  all  selected  lines.  The  final  ROI  is  thus  23.8077%  (pretty  good
investment!). See also Interest rate (equal) recomputed to yield a balance = 0.00 or other amount.
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The schedule should be saved  in the database and updated as time goes on. 

Interest automatically recomputed

Compound interest is charged in between each of the payments/refunds. The interest is automatically calculated every
day (as provided by the normal Effective rate method) even if the compounding period is not daily.

To  obtain  the  true  annual,  non  compounded  return,  it  may  be  wise  to  use  simple  interest  as  oppose  to  compound
interest for this calculation.

   

Loan without interest on part of the principal only

Margill Loan Manager (MLM) allows you to create a loan in which only part of the principal generates interest.

For example, in a loan of 125,000, the first 100,000 does not bear interest but the rest does.

Create a new Record with "File" and "New Record". See also Creating the first Record and Data entry screen Basics.
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Enter the required financial data in the "Data" window but since our loan is special, leave the Principal at 0.00. We will
add the principal in the Payment schedule afterwards.

Click  on  "Compute"  to  produce  the  payment  schedule.  Click  on  "No"  to  avoid  the  principal  from  being  calculated
automatically.

The Payment  schedule must  then  be  adapted  by  inserting  a  second  line  dated  June  1st,  2011 .  An  "Add.  Princ
(Loan)" of 100,000 is added at line 1 and the second portion of the 25,000 is added on line 2. 
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We must now specify, for the 100,000, that this portion of principal does not bear interest. Highlight the line, right click
with the  mouse and select "No interest Add., Princ, Fees..." under "Payments".

The last column "Pmt Type" indicates "No interest" for the 100,000 but not for the 25,000 that does bear interest. The
Line status is also in dark blue to show that this principal amount is particular.

The payments must then be calculated. Select all lines with payments = 0.00 (the Alt Z shortcut will only choose the 0.00
payments), right click with the mouse select "Payments" and  "Payments adjusted for Balance = 0.00".

The result, a complete table with the monthly repayment amounts.  The table includes a  column titled "Computational
Balance" (we moved it in the example below) that indicates the amount on which interest is calculated. As of line 21, the
interest-free  100,000  principal  is  fully  repaid  since  the  non  interest-bearing  principal  is  always  repaid  before  the
interest-bearing principal.   
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See also Loan or other with fees (insurance taxes, penalties or invoices) not bearing interest.

   

Irregular interest capitalization

In a calculation with simple interest, interest may be capitalized (or compounded) at one or more dates as required. 

Select the capitalization line (line 11 in the example below) or insert  a line at the desired capitalization date (the
"Pmt Date" may be changed but the table's chronological order must be followed). Use the right mouse click, then select
"Calculation Method". Choose one of the "Simple Interest Capitalized...." methods.
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By performing this operation, any accrued interest and non bearing interest Column Fees (interest bearing Column Fees
are already in the computational balance) not reimbursed by the payment will be capitalized on this particular line. 

Column fees not  reimbursed are  included in  the  capitalization because they  are  similar  to  interest,  generally  financing
fees  that  have  similar  behavior  to  interest.  Margill  does  NOT  allow  not  to  capitalize  Column  Fees  when  interest  is
capitalized.

In  the  example  below,  the  principal  of  -333.06  comes  from:  accrued  interest  that  is  not  refunded  (135.45  +  131.08  +
135.45 + 131.08 = 533.06 less then four payments of 50.00 = 333.06). The 50.00 payments are insufficient to refund the
accrued interest.

You will notice that the interest rate is in blue. This indicates that the line is particular. A comment could be inserted here
to indicate the capitalization.

See also Simple interest (capitalized) (Calculation methods chapter) and Simple Interest for specific lines only.

   

Simple Interest for specific lines only

In certain special calculations, we could combine simple interest and compound interest. This happens when an existing
calculation must be replicated or when interest must match (whether the initial calculation is right or wrong). 

Choose the desired line(s), right mouse click > Calculation Method > Simple Interest - Day count.
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The "Rate" column for Simple interest will  be displayed in green since they are "special" in  a  compound interest table.
Capitalized simple interest rates will be in blue and for normal lines, using the normal method of calculation (unchanged),
rates will be black (Advanced Options).

 

If the normal calculation method chosen is simple interest and the calculation method chosen by right mouse click is also
non capitalized interest rate, special lines will still be displayed in green even if they are not special compared to normal
lines.

See also Simple interest (capitalized) (Calculation methods chapter) and Simple Interest for specific lines only.

   

Participation Loan

See the Participation Loan subsection in the Creditor section and Reports > Commonly  required reports > Participation
Loans.
 
Also known as a syndicated loan.

A special module is also available for irregular syndicated loans where investments are done at irregular intervals. Please
contact Margill customer support.
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Other calculations

Other calculations contents

Nominal / Effective Interest Rate Converter

Sales Tax Calculations

Date Calculations

   

Nominal / Effective Interest Rate Converter

Margill Loan Manager (MLM) can determine the effective (real) rate (also known as Annual Percentage Yield (APY)) when
the nominal rate and the compounding frequency are known. MLM also allows you to insert an effective (real) rate and
the compounding frequency to determine the nominal rate.

 In MLM, choose "Nominal / Effective Rate Converter" from the "Other" menu. Select the compounding frequency:
annually,  semiannually,  quarterly,  monthly,  every 4 weeks, twice monthly,  biweekly,  weekly,  daily  or  by day(s).  By
choosing “By Day(s)”, the day count (360, 365, 365.25 or 366-day year) must be specified as well as the compounding
period from one (1) day (daily compounding) up to 999 days in the “Number of Days” field.

 Specify either the nominal rate or the (real) rate (APY) first, and the second one will be calculated automatically.

Equivalent Rates – “Nominal / Effective Rate Converter”

The calculation can also take an interest rate quoted on a particular basis (monthly or other) and convert this rate on a
different  basis  (semi-annually  or  other).  This  utility  is  accessed  through  the  "Rate  Converter"  window  by  clicking  the
arrow ( ) to the right of "Effective Rate". For example, a nominal annual rate of 8.25% compounded monthly equals an
annual nominal rate of 8.393% compounded semi-annually (the effective rate in both cases is identical at 8.569%). Banks
will  often  use  different  nomenclatures  for  which  comparisons  may  be  difficult  unless  these  can  be  converted  to  an
effective interest rate.
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Sales Tax Calculations

This function calculates the sales tax or taxes on an amount or the sales tax or taxes included in a total amount.

Margill Loan Manager (MLM) includes several American, Canadian, European and Australian sales taxes. Other taxes may
be added or existing tax rates modified through "Tools" and "Sales Tax Table" (see Interest tables (& Sales tax table)).

The rate can also be changed for a calculation (as opposed to a permanent change) by modifying the rate in Tax 1 or Tax
2.

The default sales tax table may be changed from the "Tools" menu, in the "Sales Tax Table" window (see Default settings
and  Interest  tables  (&  Sales  tax  table)).  The  first  two  lines  in  the  table,  in  red,  are  the  rates  used  by  default  in  the
calculation.

The scroll-down menus allow you to choose the desired tax or taxes. A rate of 0% can be used if only one tax is to be
calculated.

The section (Tax 1 and Tax 2) allows to temporarily change a rate without affecting the default choices. It can be used for
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the calculation of a rarely-used foreign tax for example.

The section on the bottom allows you to:

1) enter the purchase amount (sales price) to determine the tax(es) and the total, or

2) enter the total of the amount and the taxes to obtain the purchase amount (sales price excluding the taxes).

By placing the mouse cursor on the “Tax 1” text, the total of the Amount and Tax 1 is obtained. By placing the cursor on
the “Tax 2” text, the total of the Amount and Tax 2 is obtained.

See also in the update section: Interest tables (& Sales tax table).

   

Date Calculations

Margill Loan Manager (MLM) can carry out various calculations between dates.

“Predefined Dates”

This tool determines the date taking into account various predetermined periods, based on the reference date specified.
Each of these calculations is well defined in MLM.
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“Date Calculations”

The “Next” button:

This button determines the dates of  the coming Monday,  Tuesday,  Wednesday,  Thursday,  Friday,  Saturday  or  Sunday,
based on the reference date specified.

“Deadline” button:

This button determines the deadline date which follows the reference date specified. These maturity dates are: 30 days,
30 days – month end, 60 days, 60 days – month end, 90 days, and 120 days.

“24-hour periods (days) between two dates”

This function calculates the number of 24-hour periods between two identical hours on these two dates.  For example,
between 5 PM on June 4th, 2013 and 5 PM on June 7th, 2013, three (3) 24-hour periods have passed. It is not necessary
to indicate the hour (exact time).

It is also possible, by specifying the “Starting Date” and the number of “Days”, to obtain the corresponding “Ending Date”
based on one of the three day counts available: Actual days (including leap year), 365 days and 360 days.

   

Refund options

Margill Loan Manager (MLM) offers a number of refund options for a loan:

 Refund order or sequence:
o Normal refund (Principal and Interest)(P&I payment)(and Column Fees)
o Order 2 (available upon special request only)

 Interest-only (and Column Fees)
 Current interest vs. Capitalized interest
 Fixed principal
 Rate adjusted payments
 Payments set to 0.00 (so no payment)

MLM is very powerful allowing you to produce a schedule with one or many payment methods within the same schedule.
Thus,  for  example,  a  loan  may  be  interest-only  for  the  first  year,  then  the  payments  recomputed  with  the  normal
payment method. It could also include a fixed principal refund for a period of time and lump sum payments. 

Refund order or sequence

Normal refund method:

Refunds  Column  Fees  first,  followed  by  Interest  and  the  balance  of  the  payment  will  be  applied  to  reduce  the
Principal (and proportional APR type Principal).

Refund order 2:
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This refund order, available upon special request only, will first refund Interest, the the Expected Principal, then the
Column Fees and finally some more Principal.

See detailed explanations in the Refund order for Interest, Fees and Principal section.

Interest-only:

MLM will calculate the payment required to refund only the interest accumulated and the Column Fees Accrued. Using
this method, the balance will remain unchanged. This can be used for the entire length of the loan or for part of it.

When  interest-only  is  selected  in  the  Data  window  or  in  the  Payment  schedule  (right  mouse  click  >  Payments  >
Interest-only Payment and Column Fees)), the lines may or may not include a special behavior called interest-only. If you
decide to assign this special behavior, no matter what change is made ABOVE these special lines, the payment for these
lines will  automatically be adjusted to continue refunding only  the interest.  For more detail  on this  option  consult  the
Interest-only payments section.

Current interest vs. Capitalized interest

By default,  when interest  is  paid,  MLM first  pays  the  accrued interest  for  payment  this  payment  line,  followed by  the
interest that  is  due (overdue).  In  Compound interest (effective rate method),  the refund order has no real  effect since
interest generates interest. But in Simple interest, when interest is capitalized (but be careful, capitalized interest remains
interest  and  does  not  become  principal)  it  generates  interest  -  therefore  is  added  to  the  Computational  balance.  If
non-capitalized interest is paid first, the Computational balance does not decrease. On the contrary, if capitalized interest
is paid before the younger, non-capitalized interest, then the Computational balance will be reduced more quickly, thus
reducing the total interest accrued on the loan.

A second option, which should only be used in specific situations, allows the user to repay the capitalized interest (older
interest) first and then to repay the more recent, non-capitalized interest. Of course, the calculation method used should
be either Simple interest capitalized or a manual capitalization must be inserted in a Simple interest calculation in order
to see the effect of this method. 

In order to deviate from the default MLM method, in the Payment schedule, highlight one or more lines > right click on
the  mouse  >  Column  Fees  /  Interest  /  Principal  Payment  Order  >  section  completely  at  the  bottom  "Pay  Capitalized
Interest first".
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You can see the exception to the default method as the Payment amount turns green and a balloon help indicates the
special method.

Fixed principal:

The “Fixed Principal” payment method in the Data window allows you to specify the amount of principal that must be
regularly reimbursed. By entering “Principal Payment Amt” and the other variables, MLM will compute the payment that
will include the refund of the fixed principal amount and the accumulated interest. The payment will thus be variable and
will generally decrease over time (depending on the interest rate if variable interest rates are used). This can be used for
the entire length of the loan or part of it.

When fixed principal is selected in the "Data window" or in the Payment schedule (right mouse click), the lines may or
may not  include a special  behavior  called fixed principal.  If  you  decide to  assign this  special  behavior,  no  matter  what
change  is  made  ABOVE  these  special  lines,  the  payment  for  these  lines  will  automatically  be  adjusted  to  continue
refunding only the fixed principal amount entered plus the accrued interest. For more detail  on this option consult the
Fixed principal payments section.

Rate adjusted payments:

For variable interest rate calculations only,  MLM can calculate the exact payments required to first  refund the interest
accumulated and then the principal.  The payment amount will  be based on the interest rates that vary over time. This
method applies for example, in variable rate mortgages.
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In  the  Data  entry  window,  choose  "Rate  Adjusted  Payments"  for  the  Payment  Method.  MLM  will  calculate  the
appropriate adjusted payments for the entire length of the loan. Thus, the amount of the payment need not be specified.

In  the  example  below,  the  rates  change  every  six  (6)  months.  The  payments  are  thus  automatically  adjusted  to  first
refund interest due and then the principal.

PLEASE NOTE: Considering the complex nature of this calculation, the system may require a few minutes (not seconds) if
the loan is amortized over many years. See also Adjustable Rate Mortgage.

Payments set to 0.00:

If  a  payment  schedule  is  to  be  produced  with  payments  of  0.00,  choose  the  last  option  from  the  Payment  method
(Record  Data  tab).  This  will  set  all  payments  in  the  Payment  schedule  to  0.00.  These  can  then  be  changed  to  other
amounts in the Payment schedule.

See the Defining Line (Payment) Statuses chapter > Principal payment and Interest payment.
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Variable interest rate module - Introduction and Methods

Introduction and Methods

This module allows Records (loans or others) to be created using variable interest rates and the Payment schedules to be
updated automatically  as  the  interest  tables  are  updated.  This  is  possible  as  of  version  5.5.  In  previous  versions,  Rate
tables could be used to create the Payment schedules using the variable interest rates but the Payment schedule could
not automatically be updated.

Activating the module

For users of version preceding MLM version 5.5, the new method must specifically be activated by checking "Activate the
Advanced  variable  interest  rate  module"  under  Tools  >  Settings  >  Systems  settings  tab  >  Modules  section  >  Variable
Interest Rates:

Linking Record to a Rate table

First, at least one Rate table must be created in Margill Loan Manager. See the next section Creating new interest tables
and updating these.

When  creating  a  new  Record  (loan),  under  "Data"  check  "Use  Interest  Rate  Table"  and  the  variable  rate  section  will
appear.

1) The "Percentage to Add/Subtract" (Spread) can be entered.

2) Chose the Interest Rate Table using the pull-down menu.

3) Choose which Method is to be used to update the Payment schedule from then on. The Methods are explained in the
Payment schedule Interest rate update Methods section below.
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The Payment schedule is  now linked to its  Interest rate table and will  be updated over time unless the third option in
Method is chosen by which the Payment schedule is linked to its Rate table but where the user wishes for the Record to
be created with the variable rates but is not updated over time. This would be rather unusual.

When importing loans in bulk either manually with an Excel sheet or automatically via the Margill Service (Hot folder with
Excel of JSON files), the Rate table, the Spread and the Method can all be included in the import files. See Bulk import of
Loans and Database configuration under Getting started and Automated Imports - JSON or Excel files under the Settings
section.

Payment schedule Interest rate update Methods

There are two interest rate update methods:

i) When the Interest rate table is updated, the Payment schedule is updated on this precise date.
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ii) Rates are updated based on a Interest Rate Adjustment Date and at a regular monthly (every x months) frequency as
of this date. Rate changes in the Interest rate table between these Adjustment Dates will be ignored except for the last
rate immediately preceding the Adjustment Date that will become the effective rate for the latest Adjustment Date.

iii) A third option creates the Payment schedule based on the Rate table, but rates will not be updated over time.

IMPORTANT: In both Payment schedule rate update scenarios, the updates will only take place if the last line of the
Payment  schedule  is  after  the  rate  change  date  of  the  Interest  rate  table.  It  is  therefore  highly  recommended  to
include  an  “Information”  (Pmt  of  0.00)  line  far  into  the  future  for  irregular,  non-fixed  amortization  loans/lines  of
credit, etc.

Variable interest rate module auto update rules:

There are only 2 ways to “trigger” a Payment schedule update:

1) When the Interest rate table is updated, the Payment schedule will be changed based on the method chosen above.

Even if interest rates are changed manually in a Payment schedule, when the Interest rate table is updated, the Payment
schedule will also be updated. Manual rate changes will be ignored since the rule for the Payment schedule is to update
based  on  one  of  the  two  methods.  For  the  Payment  schedule  not  to  be  updated,  the  “Do  not  update  the  Payment
schedule when updating the Rate table” option should be selected.

2) When lines are added to a Payment schedule (manually, via Excel or automatically). These new lines will be updated to
the new interest rates based on the chosen method. 

For example, the Payment schedule ends July 1 but the Interest rate table includes rates for August and September. Of
course, since the last line of the Payment schedule is in July, the August and September rate changes will not be added. If
a new line is added in the Payment schedule for November 1, then the two rate changes will be added in the Payment
schedule  (or  updated  when  required  if  the  rates  changes  are  based  on  a  regular  frequency  Rate  Adjustment  Date
(method ii) above).

Interest rate table change / Spread change / Method change

Over time, you may need to change the Interest rate table, the Spread or the Method (i or ii above) for one or multiple
Records.  Consult  the  detailed text  on  Rate  such changes in  Changing Rate  tables,  Spread or  Rate  Update Method in  a
Record  and  the  important  “trigger”  mechanisms by  which  the  Payments  schedules  can  be  updated.  If  Global  changes
(Main window, right mouse click) is used to make Rate table / Spread / Method changes (only to Do not update table, not
Method change from i) to ii) and vice versa at this point) for multiple Records at once, an effective date for the change
cannot be entered. The Payment schedules will be updated when the Rate table is updated, the “trigger”.

You may also decide to apply the new variable interest rate method to loans created before version 5.5. This can be done
Record by Record or through Global changes (Main window, right mouse click). With this method, the Payment schedules
will only be updated when the corresponding Rate table is updated.
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Creating new interest tables and updating these

You can create new variable Interest Rate Tables with Margill Loan Manager (MLM). A Table can contain a unique interest
rate and up to an almost unlimited number of rates.

Only Administrators and Power Users can update Rates Tables in MLM (if the right is given to them).

Under "Tools", go to the "Tables" > Interest Rate Tables

Method as of MLM version 5.5

First make sure the module is activated by checking "Activate the Advanced variable interest rate module" under Tools >
Settings > Systems settings tab > Modules section > Variable Interest Rates.

1) Create the Interest Rate table

In the Interest Rate tables management window that will appear, choose "Add a new Table".

In the "New Rate table" section, enter an abbreviation name for the Rate table. The abbreviation name will be the name
used in MLM to identify the Rate table used, but please note that it cannot be modified later. This field is required. It is
optional to add a Table Name and a Description. Afterwards, click on "Save".

Special characters cannot be used, nor a space. You can use A to Z (upper or  lower case),  the numbers 0 to 9 and the
underscore (_).
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At any time after saving the Name or the Description (but not the Abbreviation) of the Table can be changed by selecting
the table in the Rate tables list and by choosing "Change Table properties":

Under this heading, you can also delete an existing Table using the "Delete Rate table" button as long as this Table is not
linked to a Record.

A TVL table, the old Margill format, can also be created in a new format by clicking on "Add new interest rates". If  the
abbreviation does not exist, a new table will be created with this name. If the abbreviation exists, then the rates will be
updated.

2) Add / Update Interest rate

All new rates will be:

 Added to various Rate tables.
 Applied to linked Records (so the Payment schedule will be updated) to these different Tables.
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WARNING! These changes cannot be undone and therefore you must be doubly careful before entering a new interest
rate. Is it strongly suggested to make a backup copy of the database when rate additions are made. 

Rates can be updated i) Manually, ii) by importing an Excel sheet, or iii) by importing a TVL file (old Margill format):

i) Manually

Enter the rate(s) manually. The date entered must be greater than the last date entered. The rate must be positive.

ii) Import (Excel sheet)

Select the Excel sheet that must follow the specifications below.

Note: Only existing Interest Rate tables can be updated. 

The file may contain several Interest Rate tables to be updated at the same time. Only rates whose date is greater than
the last date entered in the file will be imported.
   
File Specifications (.xls or .xlsx) :

 Only the first tab of the file will be included.

 Line 1: Column headings (column heading names are not important)

 Column A (mandatory): Rate Table Abbreviation (Unique identifier)
 Column B (mandatory): Date (Windows format from your computer)
 Column C (mandatory): Rate which must always be positive or 0.00. Maximum of 6 decimals without the percentage

sign (%). Example: for 5.2534987%, enter 5.253299 (round to 6 decimals).
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iii) Import (TVL file - Margill)

This is the old Margill format (version 5.4 and earlier).

Allows you to create the new format Interest Rate table if it does not exist. If the Interest Rate table already exists, the
file name should match the Interest Rate table abbreviation. The Interest tables in  .tvl  format are usually  found in the
MLM_Data > Tables folder, next to the DB folder that contains the database.

It  is  strongly  suggested,  if  the  Table  did  not  exist,  before the  import,  to  rename the  old  TVL  table  to  include  only  the
allowed characters since the abbreviation of the Interest Table will be the old name.

To find out the details of the Rate table, simply select "View all tables" in the menu to the left and choose the Rate table
in order to display the dates and rates as well as the Records linked to this Table and their update conditions.
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Updating Rates in the Payment schedule:

When  updating  an  Interest  table,  regardless  of  which  of  the  three  methods  is  used  to  update  the  Table,  the  Records
linked to it will ordinarily be updated.

In the following example, a 3.75% rate was added manually to the "AdjustmentRate" table on the 01-02-2024.  By clicking
on "Yes":

We obtain the number of Records processed. Records whose last date in the Payment schedule precedes the date of the
rate change are not included in the processing, they are ignored, hence the importance of including, depending on the
scenario,  an  "Information" Line  status  in  the  remote future.  Note  however,  that  when a  line  is  added to  the  Payment
schedule, the new rates will be entered automatically.
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Record ID 1524 should not be updated because the "Do not update Payment schedule" method was selected:

Exceptions and special cases:

If, for example, a Schedule starts in May and the associated Interest Rate table starts only in November, the loan will be
created with the first available rate despite the fact that the rate, in theory, takes effect only in November according to
the Rate table.
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WARNING: Even if the history change blocking option is enabled (Tools > Settings > System settings > "Users cannot edit
transactions older than X days (from the current date)"), a user with the rights to change Interest Rate tables will  have
the right to add an interest rate even if the rate precedes the current date by more than the X days allowed.

IMPORTANT:  To  reduce  the  risk  of  error  when  updating  Interest  Rates,  it  is  STRONGLY  suggested  to  prohibit  rate
changes to all but one trusted user. In Tools > Users, you should therefore uncheck the "Can change interest rates in
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bulk and update Interest rate tables" option.

Method before MLM version 5.5 (should no longer be used since the launch of version 5.5)

To create a new table:

 “Clear” the existing default table.

 To add a rate, select the  icon. Enter the date at which the rate came into effect in the first column, in the
format  indicated  at  the  bottom  of  the  window,  and  the  desired  interest  rate  in  the  second  column  (up  to  six  (6)
decimal points, depending of your System settings >  Number of decimals displayed (Interest Rate)).

 To save, click on the “Save” icon . You must specify the name of the file to be saved. 

 The saved table can be modified afterwards, if necessary. Use the icons to the right of the table to insert a line at the
end of the table or between two periods, or to eliminate a line. See Updating / changing interest tables.

 After you have made the desired changes, the table can be saved under the same name or under a new name. To
save the file under the same name, click to confirm the replacement of the initial table.

TIP!

Custom tables can easily be created directly in MLM, from a word processor (Word,
Wordperfect) or from a spreadsheet (Excel).

To  do  this,  obtain  the  data  and  place  in  two  columns  (date  and  rate).  The  date
(increasing  down  the  table)  must  follow  the  YYYYMMDD  format  and  the  rate  the
XX.XXXX (without the %) format. The two columns must be separated by a Tab. Do
not include the headings in red below. Save the table in text format (.txt).

                   Date         tab        Rate 
                 20020101      10.5250
                 20020106       9.2500
                 20030101       8.2750
                 etc.                

Save to the "Tables" subfolder (in the MLM Data folder) and change the file
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extension to .tvl by replacing .txt. 

If  the  data  is  originally  in  Excel  (or  other  spreadsheet  software),  using  the
spreadsheet software directly,  convert  the  date  format  to  YYYYMMDD (select  date
cells, Format > Number > Customized and create the "YYYYMMDD" format). Select all
lines, choose the "Data" and "Sort" option to sort the latest dates at the END of the
spreadsheet. Copy the date and rate columns to Word, Wordperfect, Notepad, etc.
The table should have the "Date" "Tab" "Rate" format. Then follow the instructions
above for saving and retrieval in MLM.

Go to Tools > Tables > Interest Rate Tables. The following window will appear:

To add a new interest rate at the END of the table, click on . Then insert the date and rate that can include up to
6 decimal points. Press on "Save". You will be prompted to select the table name. If the existing file is updated, keep the
same name and replace the existing file. A new file may also be created by changing the name of the file.

The  icon serves to insert a line in between two existing lines or at the top of an interest table. Highlight the line
below where you wish to insert the new line.

The  icon deletes one line at a time.

A comment may be written at the top of the table to properly describe each table.

   

Variable rates + or - x% (Spread)
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A calculation may be done using variable interest rates plus or minus a certain percentage (called the Spread).

For example:

Fed Funds plus 2.5%
Bank XYZ Prime plus 1.75%
Preferential rate minus 0.50%

In  the  Record's  "Data"  window,  check  "Use  Interest  Table".  The  rate  table  selection  will  appear.  The  appropriate  rate
table may be chosen (or default table) and the percentage to add indicated on an annual basis (all percentages in Margill
Loan Manager (MLM) should be indicated on an annual basis). 

A  negative  rate  (variable  rate  minus  x%)  may  also  be  included  by  placing  a  minus  sign  (  -  )  before  the  rate  in  the
"Percentage to Add (Annual)" field. For example -2.5%. The user should nevertheless be careful not to include a rate that
subtracted  from the  variable  rates  would  yield  a  negative  interest  rate.  If  the  variable  rate  minus  the  rate  subtracted
gives less than 0.00%, MLM will compute at a rate of 0.00% as opposed to a negative rate.

Step-up / Step-down Spread

A Step-up or Step-down Spread is a Spread that varies over time. For example, at the loan's Origination Date the Spread
could  be  2.0% and in  three years  change to  2.5% and again  increase three years  later  to  3.0% and so  forth.  A  Spread
could also decrease over time.

To enable this advanced feature, a Margill Administrator must enable the module in Tools > Settings > Variable Interest
Rates module. Check "Add Step-up (Step-down) option".

Once the option is activated, you sill see the option in the Data window:
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Check the "Use Spread Step-up/Step-down Option" in the Data window and click on the "Spread Step-up / Step-down"
link.

This window will  allow you to add the rate by clicking on the "Add Spread" button.  For a  Step-down, enter a  negative
percentage. If the resulting rate is negative, MLM will use 0.00%, not a negative rate.

In the example below, that base rate in 2023 was 5.75%. We see two of the three rate increases on January 1. 
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In  this  example,  later  in  2023,  when new rate  becomes known and is  entered in  the  Interest  Rate  table,  the  Payment
schedule will automatically be updated and will factor in the Step-up rates. For example, if  the rate was to increase by
0.25% on 12/15/2023, the rate on 01/01/2024 would automatically become 8% and on 01/01/2027, 8.5% and so forth.

   

Adding or Changing Rate tables, Spread or Rate Update Method in a Record

It may happen that a Record is not linked to an already existing Interest table and that the link must now be made (for
example  for  Payment  schedules  created  with  an  old  version  of  Margill).  Once  a  Record  (loan)  is  set  up  with  variable
interest rates, you can also change, over time, the Interest rate table, the Spread (plus or minus x% of the Interest rate
table (Rate table or Base rate)) and the Method by which the Payment schedule (Payment schedule) will be changed (at
every Rate table change or on regular date intervals, no matter the rate changes in between these dates).

The change can be done either manually, Record by Record, or with Global changes in order to change several Records at
once. If the changes are made with Global changes, only Trigger 1) may be used (Interest rate table update) in order to
update the rates in bulk.

Change Record by Record

Change in bulk via Global changes

Change Record by Record

If a change is made for any of the above, there are two “Triggers” to operate the rate change in the Payment schedule.
The Payment schedule will include the new rates when 1) the Interest Rate table is updated (default method) or 2) at a
date specified by the user.
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Trigger 1): When Interest rate table is updated

No matter  which type of  change is  required  (Rate  table,  Spread  or  Method),  this  change  will  only  affect  the  Payment
schedule interest rates when the active Rate table is itself updated (an update can include adding the same interest rate
on a new date to “trigger” the Payment schedule rate update). 

For example:

We are September 23, 202x and the Payment schedule contains payments for the next five years.

The current Rate table (last changed July 1 of this year) has a rate of 5%. This rate is applied to the rest of the payments
of the Payment schedule since this is the last known rate.

The newly selected Rate table is currently at 7%. This rate will NOT be applied today, nor for the next payments until the
next interest rate change in this Rate table. If the rate change of the new Rate table is only a year from now, then the
current rate will remain at 5% until that rate change a year from now (evidently, even if the old Rate table changes, the
payment schedule will not be updated since there is no longer a link to this Rate table).

A change in the Spread (+ or – x% of the Rate table) will also not take effect when the change was made. This change will
only affect the Payment schedule rates when the Rate table is itself updated. It may thus be wiser to use the second rate
change “trigger” below for a Spread change.

A change in Methods will also take effect based on the trigger, that is, a change in the Rate table. 

If  you are changing from the Method that  is  based on all  interest rate changes to the Method based on changes on  a
regular  basis  every  x  months,  the  next  rate  change  in  the  Payment  schedule  will  only  take  effect  if  the  Rate  table  is
updated, not on the next regularly scheduled rate change date since no trigger has occurred.  

If you change from the Method by which rates in the Payment schedule are updated on regular basis every x months, to
the  Method  based  on  all  Rate  table  changes,  the  Payment  schedule  will  remain  the  same  until  the  next  Rate  table
update.

If you decide to no longer update the Payment schedule rates (third Method in the pull-down menu), this will take effect
immediately, no trigger required.

Trigger 2): At a date specified by the user

Margill  offers  a  second  option  that  may  be  more  suitable  depending  on  your  needs.  The  trigger  for  any  of  the  three
possible rate change options  (Rate table,  Spread,  Method)  takes  place  at  the  date  specified by  the  user  (today  or  any
other date in the future or in the past but cannot precede the last rate change of the Rate table selected).

When saving the Record or upon pressing on the “Update Rates” button, a window will appear in which you can enter
the date at which the change will apply. 
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You  will  also  have  the  option  to  recompute  the  payments  after  this  date  to  give  a  final  balance  of  0.00  or  another
amount.  Be  very  careful  with  this  last  option  since,  if  there  are  Paid  payments  after  the  trigger  date  entered,  these
payments  will  also  be  recomputed  and  their  Line  status  changed  to  “Not  set”  since  Paid  payments  should  NOT  be
changed as they have already been paid (as opposed to simply be expected). You will have to fix this manually. 

If  a  rate  change  occurs  on  the  same  day  as  a  payment,  make  sure  that  the  mechanics  are  as  desired  (if  there  is  one
payment on the rate change date, it will not be recalculated but if there are two, this second one will be – these are odd
exceptions that would have to be managed manually depending on need).

If the date specified by the user is after the last line of the Payment schedule, two Rate change lines will be added at this
date with the rate change included.

Exceptional situation: if the rate change is made for a date in the past and the Payment schedule included rate changes
after  this  date,  the  "Rate  change"  lines  will  not  be  deleted.  They  will  remain  in  the  Payment  schedule  but  the  "Rate"
column may/will  remain unchanged.  These lines,  that  no longer have value,  could be  eliminated by  the  user,  but  with
care.

Change in bulk via Global changes

Multiple Records can be updated to reflect an Interest table and/or Margin change as  well  as  the  special  Rate  change
frequency option. For example, Records using the old method (pre version 5.5), using a fixed rate or even using a base
rate which is no longer used (change from LIBOR to SOFR for example) could all be updated in bulk. This avoids the need
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to make Tables/Margin/Method changes Record by Record.

Changes  must  be  done  in  steps,  not  in  one  operation,  with  Global  changes.  Below  is  the  order  of  operations  to
appropriately modify the Records: 

1 - Abbreviation Name of the Interest table 
2 - Interest rate Margin (%)
3 - Frequency of changes starting on this date
4 - Frequency of changes every X months

So, first, include the Abbreviation of each of the Interest rate tables and then "Save". Then, if a Margin is to be included,
enter the percentages (or use an Excel sheet) then "Save". If necessary, do step 3 above followed by step 4.

The  Rate  table  Abbreviation  name  must  absolutely  be  specified  in  order  to  be  able  to  modify  the  Margin  and  the
Frequency of the changes. Records that are not associated with an Interest table will be grayed out. The "Pre-processing
errors" column will indicate that No Rat table is used in the Record, thus cannot be updated. This does not mean that the
Abbreviation must be re-entered every time with Global changes. If  an Interest table is already present you can simply
change the Margin without needing to go through step 1 above.
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The Margin can only be added to two of the Records above (in black) since no Rate table is specified for the others

If  an  Interest  Table  was  included  by  default  for  creating  new Records  (this  default  is  by  user,  not  system  wide)  but  a
different Table was specified in Global changes, the default Interest table would be ignored and the new Table would be
used.

Please note,  if  you  wish to  add  or  modify  a  "Frequency of  changes every X  months"  via  Global  Changes,  only  Records
containing a first Rate Adjustment Date may be modified. IF not date is included, the Record will be grayed out and the
"Pre-Processing Errors" column will specify that "The Record does not have the first Rate Adjustment Date". You will then
have to go through step 3 (adding the first Rate Adjustment Date) before going to step 4.

IMPORTANT:  Once  Global  changes  are  made,  no  updates  to  the  Payment  schedule  rates  will  occur,  nor  any
recalculations  performed  until  a  Trigger  has  been  activated.  The  Records  will  simply  include  the  information  that  an
Interest table is associated (and other settings related to the Interest table - Margin, Update Method).

The  Trigger  could  be  manual  (Trigger  1  above)  or,  in  order  for  all  Schedules  be  updated  with  the  new  rates  (and
recalculations),  the  Interest  table(s)  will  need  to  be  updated  by  entering  an  interest  rate  (Trigger  2  above).  The  rate
entered  in  the  Interest  table  could  be  unchanged  and  entered  on  the  current  date  simply  to  trigger  the  Payment
schedule update.

   

Changing the interest for multiple records in one operation

If you wish to change the interest rate for multiple loans at once without using the automatic rate change options, tools
were created to quickly update all the desired Records with the desired interest rate.

See  Changing  the  interest  for  multiple  Records  in  one  operation  in  the  "Payment  schedule  (Amortization,  payment)"
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chapter,  Adding or changing interest rates in a Payment schedule section.
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Record Summary Window (Main)

The Main Margill Loan Manager (MLM) window, known as the "Record Summary" window provides the user with a global
view of all Records in the system. It is by this window that:

 New Records are created;
 Multiple Records can be opened simultaneously;
 Existing Records may be updated, changed, deleted;

o Change the interest rate of multiple Records at once
o Make multiple changes with the Global changes (most important module)

 New Borrowers, Creditors and Employers are created and edited;
 Various Tools accessed (Post payments, Electronic Funds Transfers, Alerts, MLM Settings, User Administration, MLM

Backup, Interest rate table creation and update, Sales tax table update or new rate, User Guide);
 Records are chosen to Report on;
 Other calculations available (nominal/effective rate converter, date calculation, sales tax calculation);
 Totals for monetary or numeric fields for the Records displayed can be seen;

 Search tool for Records using various criteria with the magnifying glass  and full database Search engine;
 Filter Records
 Assign a color code for special loans and sort by this color;
 Dashboard;
 Sending Emails and SMS to Borrowers;
 Unmanaged Active Records can be consulted quickly;
 Websites, documents and even third party application can be launched.
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The font size of the Record Summary window may be increased with the Alt  shortcut or decreased with Alt  or with

the  icons to the lower right of the window.

Column widths may be changed, column order changed, columns hidden and data sorted, displayed or searched:

 To change the width of a column, click on the vertical line that separates the columns and widen or reduce with the
mouse.

 To change column order, click on the column header and drag the column with the mouse.
 To hide or display a column, right click with the mouse on any header, then uncheck the column title(s). To add new

columns from among more than 900 fields, see Displayed column selection and order.
 To sort  the  data,  click  on  the  desired header.  Sorting  can  be  done on  2  to  3  columns by  pressing on  Ctrl  and  the

column headers. See Shortcuts or F2. 
 See also Displayed column selection and order and Search tool.
 The Administrator can allow Users to highlight special loans and assign different colors to these. Select the Record(s)

in the Main Window, right mouse click, then choose the "Records' Color".

It  is  also possible to sort  by Record color with  the  "Record's  Color"  field.  To  do  this,  go  to  Tools  >  Settings  >  User
Settings  >  Record  Summary  Window  >  General  tab  >  Record's  Color.  An  empty  column  will  appear  in  the  Main
Window and sorting will be from red to pale violet and vice versa. To find ou more about how to apply filters for the
color, consult the Display Filters section.

 Mass sending of Emails and SMS can be done via the Main Window. To do this, select the Record(s) to whom to send
an Email/SMS and right click on the mouse. Choose "Send Email / SMS":

This  window  will  appear  allowing  you  to  choose  among  the  following  options  in  order  to  send  Emails/SMS  to
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Borrowers  and/or  Co-Borrowers  (carbon  copy  -  cc)  and/or  Guarantors  (blind  carbon  copy  -  bcc)  for  the  selected
Records. The Payment schedule can be added in a PDF format as an attachment (emails only). See Reports > Emails -
Sending automatically or in batch with Template.

 See also Displayed column selection, name and order and Database Search engine under Useful  features >  Search
Tools.

Most  fields  (over  900,  custom  fields  and  Mathematical  Equations)  contained  in  MLM  can  be  displayed  in  the  Record
Summary window. To choose the fields, go to Tools > Settings > User settings tab > Record Summary window section >
click on "Displayed Fields". You will then be able to change the default fields displayed and choose the ones that are to be
displayed  in  this  window.  See  the  next  section  Displayed  column  selection  and  order  and  in  the  Reports  chapter  the
Fields that can be displayed.

See also Display Filters in the current chapter.

The bottom half of the window provides a quick view of the selected Records. To choose all Records, use "Ctrl-A" (select
all). To choose non-contiguous Records use the "Ctrl" key and the left mouse click.

The number of  Records,  total  starting principal,  total  payments,  total  interest and the end balances  are  indicated.  For
much  more  detailed  data,  including  hundreds  of  reporting  fields  with  calculations  done  at  various  dates,  consult  the
Reports section.
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The Dashboard tab provides a portfolio overview and trends with various standard and customized Widgets. See Useful
Features > Dashboard for more details on how to use this tab.

In addition, it is possible to see the totals for the displayed Records in the Main window. They are available for monetary,
numeric and whole number fields, including custom fields.
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Please note that  the  totals  reflect  all  of  the  displayed Records and  not  only  the  selected Records as  is  the  case in  the
lower part of the window:

It is possible to hide the totals shown at the bottom of the columns and the displayed totals at the bottom of the window
(for example, if you do not wish your employees to see an overview of your portfolio too easily). To do so, go to Tools >
Settings > System settings (Administrator) tab > General Settings section:

You have the option to hide or display totals for all users or to display these only for Margill Administrators.

With "Quick Links", you can access a web site, a document or even launch an application that would be pertinent when
using MLM.

To add, modify or delete links, go to Tools > Settings > User settings tab > Quick Links. Add links with this button .
Enter the link or path according to the instructions in the "Note":
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Before saving the link, test the link by clicking on .

The  button allows the Margill Administrator to copy links for all users. If the Administrator uses this button, other
users' existing links will be replaced. A user can also replace or delete the links that were configured by the Administrator.

To delete a link, use this button: .

If certain irregularities are detected, a warning image (  or )  will be displayed in the upper left corner of the
window, depending on the importance level. It is important to read these warnings and resolve any reported problems.

Problems  with  the  red  icon  (CRITICAL  problems)   must  be  resolved  quickly  since  these  are  often  related  to  the
pre-authorized payments. 

The  warnings  cover  irregularities  for  Electronic  funds  transfers,  credit  card  expiration  dates,  Alerts  and  notices  about
Borrowers' exceeded credit limits.
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See System Warnings

It is possible to open multiple Records at the same time. This makes it possible to compare two or more Records side by
side. A maximum of four Records can be opened by a user at a time.

The Payment schedule presentation settings will be those of the last closed window when multiple windows are open at
the same time. To change the order of the columns or to hide certain columns, it is therefore suggested to open a single
Payment  schedule  window,  to  adapt  the  presentation  and  to  close.  This  presentation  will  become  the  default
presentation for this user.

   

Displayed column selection, name and order

The Margill Loan Manager (MLM) Record Summary window (Main window) provides a snapshot of the user's portfolio as
seen below. Various loan information will be displayed in the table. A scroll bar appears to see all the data available to
the right. 
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Choosing the fields that appear in the window

Most  fields  (over  900,  custom fields  and  Mathematical  Equations)  contained  in  MLM  may  be  displayed  in  the  Record
Summary  window.  This  choice  is  made  by  individual  users  according  to  his  needs  and  thus  is  not  exclusive  to  the
Administrator.

To choose the fields,  go  to  Tools  >  Settings  and  under  "User settings" click  on  the  "Record Summary Window" button

"Displayed Fields" . You will then be able to change the default fields displayed and choose
the ones that are to be displayed in the Main MLM window. The fields are classified by theme.

See descriptions for each field in the very important Reporting Fields section (Reports chapter). The descriptions are also
available with a mouse-over the field in MLM. 
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Some fields appear by default . To add fields to the Main MLM window (Record Summary), choose (highlight) the

field or fields (Press "Shift" or "Ctrl" and the mouse) then click on the arrow pointing to the second column  (a field
may also be added by double clicking on the desired field with the mouse). The fields will be copied to the second column
and will be displayed in this same order in the Main window.

To remove a field from the Record Summary, select, in the second column, the field or fields to remove and click .
In the example below, the field "Creditor Name" will no longer appear in the Record Summary window. 

Upon clicking twice on a field, the field will be added  (left column) or deleted (right column).

Once the field has been added in the right column, the user can rename the fields by clicking on the names in the "Fields
Displayed" column. These changes will only affect the Record Summary window for this user. All other menus in MLM
will keep the same original names.
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The default column display order in the Record Summary window can be modified by clicking on the arrows to the right
of the second column.

The   arrow  will  move  the  selected  field  to  the  top  (will  be  the  first  column  to  appear  in  the  Record  Summary

window)  and  the   arrow  will  move  the  field  to  the  bottom  (will  be  the  last  column  to  appear  in  the  Record
Summary window). The fields' order can also be changed directly in the Record Summary window by moving the columns
manually.

It  is  recommended not to check the "Show currencies with the amounts..."  box since if  the currency symbol  is  shown,
amounts will no longer appear as numbers, but as text. Thus, sorting will be done based on a text method as opposed to
the  normal  number-based  method  which  we  are  used  to.  For  example,  when  sorting  from  smallest  to  greatest,
$100,250.00 would appear before $131.00 since the second number that appears is 0 in the larger amount and 3 (1"3"
1.00) in the latter.

For larger databases (more than 1000 loans), it is possible to significantly speed up the refresh speed for the Records in
the Main Window by checking "Fast Display Mode (fewer fields available)" or the "Display mode with direct access", this
mode being almost instantaneous for populating the Main window.
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Fast Display Mode

When "Fast Display Mode" is checked, data display in the Main window is greatly accelerated. However, there are fewer
fields available in order to reduce calculation time. This is the ideal display mode for databases with over 1000 Records or
when  the  network  speed  is  not  optimal.  If  you  had  selected  fields  for  the  "Normal"  display  method  while  in  the  Fast
Display Mode, the fields that are not available will appear in red in your list and will simply be ignored when displayed.
You can go from one mode to the next any time without th need to change your field selection.

Please note that  when using  this  mode,  MLM will  not  take  into  account  Co-Borrowers,  Guarantors  and  Creditors  2,  3,
etc., when applying the display filters, or when searching in the Records of the Main window. Only the Borrower and the
first Creditor will be considered among the search criteria for a Record.

For  example,  the  filter  below  will  only  display  the  Records  in  which  Marina  Thatcher  is  Borrower  but  not  if  he  is
Co-Borrower or Guarantor. However, in regular mode display, all the Records in which Marina Thatcher "participates" are
displayed.

Direct Access Display Mode
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This mode displays data much faster than Fast mode.

Will be documented soon.

Many data are available at the current date that are calculated daily and viewed in the Main MLM window:

 Balance (at Current date)
 Interest Accrued from last payment Paid (at Current Date)(0.00 if no payment)
 Interest Accrued from last payment Paid (at Current Date)
 Interest Accrued from last payment Paid/Unpaid (at Current Date)(0.00 if no payment)
 Interest Accrued from last payment Paid/Unpaid (at Current Date)
 Outstanding - Total (Balance)(at Current Date)
 Active Records - Sub-Status (Current date if AUTO) 
 Various Ageing Balances (0-29 days, 30-59 days and the usual ageing periods)

See descriptions of each field in the very important Reporting Fields section (Reports chapter).

You may include these fields by using the above instructions. This extra data requires more processing time and thus may
result in slower display time.

Of particular interest:

The  "Interest  Accrued  from  the  last  payment  Paid/Unpaid  (at  Current  Date)"  (many  variants)  may  also  be  displayed.
These data are interesting to quickly inform a Borrower how much is owed in Principal ("Balance Due Principal" should be
displayed) and the amount of interest accrued since the last paid or unpaid payment.

Fields at "Current date" reflect reality, as of today, unless the loan is terminated, in which case data from the last line of
the Payment schedule will be displayed. If  there is a balance on the last line of the Payment schedule, in order for the
interest calculation to continue over time, an "Information" line, with a payment of 0.00 should be added at the end of
the Payment schedule and a far away date inserted as the Payment Date (for example 2030-01-01). Adding such a line
simply keeps the accrued interest calculation going and has no "dangerous" effect on the loan.

Making changes in the Record Summary window

Once the fields are selected, the user may decide to change the data displayed for each Record in the Record Summary
window by right clicking on any of the headings. "Select columns" will appear allowing you to uncheck unnecessary data.
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Even once the initial  column order  is  chosen (see above),  MLM allows you  to  change this  order  directly  in  the  Record
Summary  window.  The  important  information  for  you  may  thus  appear  in  the  first  columns  that  can  be  seen  easily
without scrolling.

To do this, simply select the column heading that should be placed elsewhere and drag the column to the left or right.

This  method  is  not  as  efficient  as  using  the   from  the  Record  Summary  window  via  Tools  >
Settings  >  User  settings.  In  large databases,  columns  hidden  by  "Select  columns"  are  still  loaded  in  the  Main  window,
requiring additional display time unnecessarily. 

   

Display Filters

Various data Display filters are available in Margill Loan Manager:

1) Main Display filters

i) Display with only one field
ii) Display with multiple fields
iii) Display filters using Custom fields 
iv) Display filters using Record Colors

2) Column header Display filters (that act as a search tool)

1) Main Display filters

The  Display  filters,  at  the  top  of  the  Record  Summary  window,  display  the  Records  based  on  various  criteria  and  a
combination of these (thus progressively reducing the number of Records displayed):

 Status (Record)
 Sub-statuses (Ageing) for Active Records only
 Record Owner
 Colors
 Borrower
 Creditor
 Record Type (a scroll menu must be defined for this field) 
 Six (6) optional filters based on Record Custom fields 

Filtering also allows to choose multiple data elements and multiple fields to display the desired Records (example: display
Draft, Pending and Active Records):
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To display multiple data to display, click on the arrow in order to show the scroll menu.

i) Display with only one field

If only one display field is required, check the data to display in the Main window and click on . 

ii) Display with multiple fields

If multiple display fields were required, check the data to display and click on . The choices will be saved. The
user will then be able to select other display fields.

In  the  example below,  the  Record "Status"  (Draft,  Pending  and  Active)  were  previously  selected  followed by  the  "OK"
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button. Before the "Status" filter is activated, the user will add some other Record "Sub-statuses". By pressing "Display",
the selected "Statuses" and the "Sub-statuses" will be displayed.

It  is  therefore  possible  to  select  several  filters  before  clicking  on  .  By  clicking  on  "Display",  the  filter
command is activated and only the corresponding Records, based on the selected criteria, will be displayed in the Main
window.

An additional "Display" button is available at the top of the Main window next to the magnifying glass when several fields
have been selected if the user has not yet updated the Records to be displayed (thus has only clicked on the "OK" button
without pressing "Display").

By clicking on the  button, the user deletes the latest selections made and by default, MLM resets the menu
to the previous selections.

When multiple data criteria are selected, MLM attempts to list  them in the field window, separating the selected data
with the "+" sign, but when space is insufficient, "Multiple selection" is displayed.
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Tip: You need to select numerous criteria for one filter? By clicking on the "Select all" button, all the criteria from the list
will be selected. Then you can uncheck the criteria that are not needed by unchecking each.

iii) Display filters using Custom fields 

The Administrator can set up to six  (6)  Custom fields which can then be used as display filters in  the Record Summary
window. Once created, these filters will appear to the right of the window. By default they do not appear.

For  Filters  to  appear,  they  must  be  configured:  Tools  >  Settings  >  System settings  (Administrators)  >  Custom  Fields.  A
Custom field must first be assigned to the Record (as opposed to the Borrower or Creditor) and include a scroll menu. 

Record Custom fields with a scroll menu will be included among the choices of six menus that allow the user to select the
fields to be used as filters. By default, the six menus are set to  "Empty". Select the field and press "Save". The Filter will
be displayed in the Main MLM window.
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A custom Filter may be changed at any time. Note however, that ALL users will have the same filters. The configuration is
not per user, but system wide.

iv) Display filters using Record Colors

Only colors used as Record colors will be available in the Color filter list. In the example below, only two colors among the
30 available are displayed, since they are the only two used in the database so far.

The Administrator can rename the Color for a more descriptive name (color label),  for example "Dark red" renamed as
"Urgent".  To  do  so,  click  on  "Color  Titles  of  Record"  under  Tools  >  Settings  >  System  Settings  (Administrators)  tab  >
Custom Fields (located here since some filters are in this section) > Record tab > Display Filter tab :
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This window will appear:

Simply enter a custom name in the "English Color Titles" column and save the changes. It is possible to designate Color
Titles in English and French, depending of the language used in the settings. Simply click on the "Show French Names"
option to access this:
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If no color Title is entered by the Administrator, default values will be displayed:

Color Names (labels) are available for producing "Record List" type reports under the "General" theme and the field name
"Record Color Tags":
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2) Column header Display filters

These filters, available with the right mouse click, also act as data search tools:

Text field options

See the Search Tools section in the Useful Features chapter.

Data not found

There may be several reasons why a searched item is not found:

 Make sure all Display Filters are at "All". 

o Note: In the image below, the three Filters (up to six are available) on the far right are custom fields defined
by the user.
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 If either option "Can only see own Records" or "Can only see own Borrowers/Employers/Creditors" is checked (Tools
>  Users),  that  user  will  only  see  the  Records  (Loans)  and  Borrowers/Employers/Creditors  for  which  he  is
Responsible/Creator. This substantially limits the results.

 Only Creditors, Borrowers, Employers and Loan Officers (Creditor loan officers) that have loans will  be displayed in
the Record Summary window (provided of course that the user has included this data in the window, see Displayed
column  selection  and  order).  A  Borrower  for  example  may  be  registered  in  the  system  but  not  have  any  loans
associated with him. So, to find a Borrower (Creditor, Employer or Loan Officer) or any data connected to him, go to
the desired list under "File" and then choose among one of the three choices: Borrower, Employer or Creditor.

A  search is  performed exactly  the  same way as  in  the  Record Summary window by  sorting  by  column  or  using  the
magnifying glass. All fields connected to a Borrower or Creditor, including custom fields are included in each list. 

When MLM is used in a multi-user environment, the "Refresh" button,  refreshes the window to include the latest
changes made by other users.

   

Search Mode
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Margill Search mode allows users to display only relevant Records according to multiple criteria. This is usually used only
for larger databases (more than 1000 Records).

To go from "Search" mode to "Filter" or vice-versa, go to "User Settings" and choose the desired mode:

Search Mode Configuration

Perform a Search

Search Mode Configuration

For the initial configuration, click on "Search Fields".

 

In the "Search Fields" window, you can select up to six (6) search criteria by checking the "Select" box.
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Besides the regular fields, custom fields (only Custom fields 1 to 9) may also be included in the search fields selection.

Please note that the following fields are excluded from the selection:

 Custom fields with drop down menus ;
 Unlimited Custom fields (Table format).

Enter the number sequence in the "Order" column and click on "Save" to establish the order in which search fields will be
displayed in Search Mode.

Choose  the  type  of  search  to  be  performed  in  each  field  with  the  drop  down  menu

 (Record identification number fields do not have drop down menus).

Six (6) choices are available:

 "Contains the value"
 "Starts with the value"
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 "Matches the exact value"

For date fields:

 "Date to search is equal to (=)"
 "Date to search is greater than (>)"
 "Date to search is less than (<)"

With the mouse over the  icon , the user can see which type of search fields have been configured:

Perform a Search

A search can be performed on one or many fields at a time. If data is entered in several search fields, the search tool will
find Records that include each of this search data.

The tool will add "AND" in between search fields.

For Borrowers and Creditors: Borrower search fields will find all Records associated with this Borrower even if he is a Co-
Borrower or a Guarantor.

Same goes for Creditors when several Creditors exist in a Record.

Be careful! Search fields are case-sensitive (except first and last names). If you are not sure about some data's spelling,
select "Contains the value" as opposed to "Matches the exact value".

For example, if "Montreal" and "montreal" (capitalized and non capitalized) were entered in the database, you will have
to choose "Contains the value" in order to get all the data related to these two (2) criteria:
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Search Examples:

In order to find all clients named "Abbot":

 Enter "Abbot" in the "Borrower Last Name" field and select the "Matches the exact value" criteria in the drop down
menu;

 Click on :

To find all clients named "Abbot" born after January 1st 1980:

 Enter "Abbot" in the "Borrower Last Name" field and select the "Matches the exact value" criteria in the drop down
menu;

 Enter the date in the "Borrower Birth Date" field and select "Date greater than (>)" "01-01-1980" in the drop down
menu;

 Click on :
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Record Window

Record Window contents

What is a Record?

Record Data

Changing the basic loan data in a Record
Doubtful accounts

Borrower (Client) information

Co-Borrower
Guarantor
Security (Guarantee)

Creditor (Lender)

Loan officer
Participation loans

Credit Report

Annual Percentage Rate (APR)

Alerts (Record specific)

Advanced functions

Notes

Print

Attach

   

What is a Record?

In Margill Loan Manager (MLM), a Record is made up of a number of elements that, depending on your particular needs,
may or not contain data. 



Page 670

© Jurismedia Inc., 2007- 2023

Components

 Record Data - all basic loan information such as the loan identifiers, the original loan amount (principal), the interest
rate or rates, the number of payments and their frequency, the payment amount, the maximum credit allowed and if
there is an allowance in case the loan is doubtful.

o If  a variable interest rate table is used, the interest table is  first  associated with the Record,  but  once the
Payment  schedule  is  created,  the  interest  table  itself  is  no  longer  required.  Even  if  the  interest  table  is
updated,  the  interest  rates  in  the  Record  are  not  automatically  updated.  It  is  nevertheless  possible  to
update  rates  in  the  Payment  schedule  directly  or  to  update  multiple  loans  at  once  through  the  Main
window. See Adding or changing interest rates in a Payment schedule.

To each Record is linked:

 Borrower,  Co-Borrower  and  Guarantor  information  (including  custom  fields  and  credit  data  for  this  Borrower,
Co-Borrower or Guarantor).

o An Employer may be assigned to each.
o Notes, Attached documents, Maximum credit and special Notes (automatic warnings about this actor) can

also be included for each.

 Data linked to the Credit report can also be included.

 Creditor information (one or many) (including custom fields of this(ese) Creditor(s))

o A Loan Officer may be assigned to a Creditor.
o Many Creditors may "own" a loan (participation loan).

 Custom fields (for the Record (the Loan) itself).
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 Annual Percentage Rate (APR) information (fees and points associated with that Record).

 "Advanced"  loan  settings  such  as  interest  calculation  method  (compound,  simple  interest  or  simple  interest
(capitalized), Day count, short period method between the Origination Date and the First Payment Date, number of
weeks in a year.

 Alerts allowing you to be advised that tasks must be done on a specific date.

 At the heart of it all, is the Payment schedule (amortization schedule).

o A variety of reports can be calculated based on the Payment schedule or on other data.

o Electronic Funds Transfer may be entered in a Payment schedule for automatic payments by ACH (electronic
bank account debit) or credit card.

 Documents (files) may be attached to a Record via the Data window.

 Notes  allow  the  user  to  include,  from any  Record  window,  notes  pertaining  to  the  Record.  The  first  line  of  these
notes can also be displayed in the Record Summary window - see Displayed column selection and order. Notes can
also be consulted, edited and new notes inserted with the Alerts module.

 

A  Record  may  be  saved  and  updated  over  time  as  the  true  payment  scenario  evolves  (paid,  unpaid,  late,  partial
payments, etc.).

   

Record Data

The "Data" window is the first step in producing the detailed payments table. Loan details are included in this window to
produce a normal, regular loan.

If  a  more complex loan is  to  be  created,  this  first  window should  first  be  filled in  with  preliminary data  and  the  exact
payment details customized in the "Payment schedule" once the "Compute" button has been pressed.

See also "Fundamental principles of operation".
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The  "Data"  window includes  mathematical  and  other  data  to  describe  the  loan  itself.  The  window contains  four  tabs,
each providing information of different nature:

 "Data" tab

 "General" tab

 "Other Data" tab

 "EFT" tab (Electronic Funds Transfer)

"Data" tab

The "Data" tab contains the most important data for a Record:

Record Status: A Record will be assigned one of the following seven statuses:
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"Active" Records also include multiple Sub-statuses to identify Records with payments that are current, late or that meet
other criteria. This data is often required by credit agencies. The various sub-statuses are identified below as well as the
corresponding collection agency Metro 2 format codes:

Name Metro 2 Code

AUTO
Current 
Deferred payment
Late payment
Late payment 30-59 days
Late payment 60-89 days
Late payment 90-119 days
Late payment 120-149 days
Late payment 150-179 days
Late payment 180 days or more
Collection
Foreclosure completed
Voluntary surrender
Repossession

-
(0)
 -
-

(1)
(2)
(3)
(4)
(5)
(6)
(G)
(H)
(J)
(K)

By default, a loan sub-status for a Record is "AUTO". This means the sub-status is calculated and updated automatically
taking  into  account  the  outstanding  amounts  and  the  dates  of  the  unpaid  payments.  Static  choices,  which  are  not
updated automatically, are available in the scroll menu. For the calculation of ageing payments, see Ageing of Accounts.

These sub-statuses are also displayed in the Main window (Record Summary).

The  "Active"  status  is  required  for  certain  tools  and  reports:  Payment  update  (Post  payments)  and  Export  accounting
transactions  to  the  General  Ledger.  For  these  tools  and  reports,  only  "Active"  Records  are  included  in  the  results
provided.

If "Bad Debt" is selected, to the right will appear "Date of bad debt" in red. This will serve to produce a Bad debt report
with the balance of the loan on that date or on the previous payment. 

 

Origination Date: Date at which the loan (or other financial instrument) starts. In the calculation, the Origination date is
included in the calculation and the final date is excluded.

The date format to use will appear at the bottom of the window:
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This date format may be changed in the Windows Control Panel.

The date may be entered manually or with the calendar  at the right of the field.

First Payment Date: The First Payment Date can either be the date at which the first payment is made by the Borrower or
when any other event  occurs such as a second loan or cash outlay (represented by a negative amount in the Payment
schedule).

 The First Payment Date can be entered automatically as exactly one Payment period after the Origination Date (click

on on the right of Origination Date in the Data window). For monthly payments, for example, the first payment
entered automatically would be entered one month after the Origination Date:

Compounding Period: The Compounding Period only applies to normal (compound) interest loans. 

This will be gray and cannot be changed when Simple Interest or Simple Interest (capitalized) (see Advanced functions) is
chosen.

If a weekly, biweekly or "every 4 weeks" compounding period is chosen, MLM may be adjusted for weekly compounding
52, 52.1428 or 52.2857 (or 51.4286 for a 360-day year) times a year in the Advanced functions window.

Mortgages

To calculate mortgages in:  United States,  England,  Australia,  Hong Kong,  South  Africa,  France,
Luxembourg, for monthly payments, the compounding period should be monthly.

In Canada, the compounding period should be semi-annually.

For other countries or other unusual mortgages, consult a mortgage professional.

Payment Frequency: Specify the frequency at which the payments are made.

If a loan is to be totally or partially irregular (for example, a line of credit or an special loan), chose "Irregular". This will
create a Payment schedule with only one line in which dates and payments (or negative payments) may then be added. A
one-line  schedule  will  be  created  unless  payments  are  entered  in  the  preliminary  irregular  payments  window  (see  "
Irregular Payments' box below). 
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Important:  MLM considers a loan to be finished on the last line of the Payment schedule and thus, data after this  last
date cannot be obtained. In order to obtain the loan balance and other financial data over time, even if no payments are
made, it is suggested to create a dummy payment of 0.00 (Line status "Information") a few years later (in the year 2025 in
example below). 

For a partially irregular loan, to create a table faster than with the "Irregular" choice, chose the closest payment period
and then adapt the table afterwards.

Irregular Payments

When  the  user  selects  the  "Irregular"  payment  frequency,  he  can,  without  having  to  precompute  the  Payment
schedule, enter irregular payments by adding payments in the Irregular Payments window. The data entered in this
table  may  be  changed  in  the  Payment  schedule  afterwards.  A  negative  amount  entered  here  will  add  Additional
principal.
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This window also allows to add irregular Column Fees (up to six types). These Column fees can be added later in the
computed Payment schedule

Irregular payments Payment schedule based on the pre-filled table above:

Entering payments in this table is optional since the data can also be updated directly in the Payment schedule that
will be created ("Compute" button) by checking this:

With  this  selection,  the  Payment  schedule  will  be  produced  taking  into  account  the  Start  Date,  the  First  Payment
Date,  the  original  Interest  Rate  only  (if  variable  rates),  the  Compounding  Period,  the  Principal  and  the  Payment
amount (first payment, optional).

After entering the Principal and the Payment amount (optional), press Compute (F5).
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The Payment schedule will thus be created. It will contain only one line whose Line status will be "Information" (or
"Due Pmt" if a Payment amount was entered).

If the user wishes to manually add Column Fees, on this line of the Payment schedule, he will have to select the  "Due
Pmt" Line status (or other compatible Line status (with an amount of 0.00 in the "Payments" column).

The  customized  Payment  schedule  can  be  created  by  inserting  new  lines  containing  the  corresponding  dates  and
payments. 

The Number of payments (Amortization) and the Balance can not be specified with this option.

If "By day(s)" is chosen, the "Number of days(s) becomes an editable field. The frequency of payments, expressed in days
may then be included. If a payment is to be made weekly, specify 7 (for 7 days in a week), if every two weeks, then 14,
etc. Any number may be chosen.

If a 7, 14 or 28-day payment period is chosen, MLM may be adjusted for weekly payments made 52, 52.1428 or 52.2857
(or 51.4286 for a 360-day year) times a year in the Advanced functions window.

For "Twice monthly" payments, a window will provide you the option to chose the repayment dates during the month. 
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Thus, "Twice monthly" payments can be scheduled on any dates of the month as shown in the last option in the window
above.

If payments are to be made every other period (for example every two months) choose monthly payments, produce the
Payment schedule and in the schedule use the "Alt 2" shortcut. This will choose every other line. Delete the highlighted

lines with  or with the right mouse click: 

Then right click with the mouse to recompute the payments:

The same method applies  for  other  unusual  payment  periods.  Use the  "Alt  L"  shortcut  to  choose every x  lines,  delete
lines and recompute.
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Number of day(s): See "Payment Frequency" above.

Payment Method:  The Payment Method allows you to choose among the  five payment  methods below for  the  entire
duration of the loan. Nevertheless, in the Payment schedule, the payment method may be changed for any number of
lines  so  that,  for  example,  a  loan  may  have  interest-only  for  x  periods  then  a  normal  reimbursement  (interest  and
principal) afterwards.

"Norma (Principal + Interest)l" will calculate the precise payment to refund interest and column fees (the case being) and
the balance going to the principal.

 If  the  "Display  'Behavior'  option  when  creating  a  new  Record  (Automatic  recomputation  if  payment  amount)"  is
activated (Tools > Settings > User settings > Options: Interest-only and Fixed Principal),

the "Add Behavior" check box will appear. If this box is checked, payments with "Due Pmt" type Line statuses will be
automatically  recalculated  taking  into  account  the  upstream  activity  (previous  unpaid,  partial  payments,  added
principal, etc.) in order to arrive at a final balance of 0.00 or other amount.

"Interest-only" will only refund the interest and Column fees, leaving the balance unchanged as long as the Refund order
remains the default order (where interest is paid before principal). 

 If  the  "Display  'Behavior'  option  when  creating  a  new  Record  (Automatic  recomputation  if  payment  amount)"  is
activated (Tools > Settings > User settings > Options: Interest-only and Fixed Principal), the "Add Behavior" check box
will appear. If this box is checked, payments with "Due Pmt" type Line statuses will be automatically recalculated to
refund interest only, taking into account the upstream activity (previous unpaid, partial payments, added principal,
etc.). See Interest-only payments.

 If  the  "Display  'Behavior'  option  when  creating  a  new  Record  (Automatic  recomputation  if  payment  amount)"  is
activated (Tools > Settings > User settings >  Options: Interest-only and Fixed Principal), the "Method Interest-only"
scroll  menu  will  be  displayed  so  the  user  can  select  the  desired  refund  option  for  the  current  Record.  See
Interest-only Payments.
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"Fixed Principal" will refund a fixed principal amount. 

 If  the  "Display  'Behavior'  option  when  creating  a  new  Record  (Automatic  recomputation  if  payment  amount)"  is
activated (Tools > Settings > User settings >  Options: Interest-only and Fixed Principal),   the "Add Behavior" check
box will appear. If this box is checked, payments with "Due Pmt" type Line statuses will be automatically recalculated
to  refund  the  desired  fixed  principal  amount,  taking  into  account  the  upstream  activity  (previous  unpaid,  partial
payments, added principal, etc.). See Fixed principal payments.

 If  the  "Display  'Behavior'  option  when  creating  a  new  Record  (Automatic  recomputation  if  payment  amount)"  is
activated (Tools > Settings > User settings >  Options: Interest-only and Fixed Principal), the "Method Fixed Principal"
scroll  menu  will  be  displayed  so  the  user  can  select  the  desired  refund  option  for  the  current  Record.  See  Fixed
Principal Payments.

 This fixed principal amount to be refunded is indicated in the second column under Principal Payment Amt. MLM will
automatically divide the principal by the number of payments to automatically calculate, unless otherwise wanted,
the fixed principal amount.

"Rate  Adjusted  Payments"  can  only  be  used  with  an  interest  table  in  which  the  rates  change,  for  an  adjustable  rate
mortgage (ARM) for example. This will compute the adjusted payments based on the interest rate and column fees (the
case being) in force throughout the loan period. In a normal scenarios (see Refund order for Interest, Fees and Principal)
the interest is always first repaid and the balance of the payment will refund principal.

"Payments set to 0.00" allows the user to create a Payment schedule that include lines on desired dates with payments of
0.00 ("Information" Line statuses).

Date of bad debt (seen only when File Status is "Bad debt"): See "Record Status" above.
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Principal:  The  original  loan  amount  should  be  indicated  here.  If  the  loan  consists  of  multiple  successive  loans,  the
"Payment" field may contain a negative number sign to include successive loan amounts. If successive loans are irregular,
then a normal schedule may be calculated and the additional principal simply added manually in the Payment schedule
as negative amounts with one of the "Additional principal" Line statuses.

If 0.00 is indicated as the principal amount, when the Payment schedule is calculated, the following window will appear
allowing you to choose whether the principal is to be calculated or if it is in fact 0.00 to start off.

Compute the unknown variable

MLM  will  automatically  calculate  the  unknown  variable  among  Principal,  Annual  Nominal
Rate, Amortization (Payments) and Payment.  Simply leave the unknown amount (very often
the Payment amount) blank and it will be calculated automatically.

Annual Nominal Rate (%)(hidden when "Use Interest Table" is checked"): The nominal interest rate should be included
here ( from 0 to 999.9999%). The nominal rate is the rate quoted and does not factor in compounding. MLM will use this
rate and factor in the compounding period entered to obtain the effective interest rate. See also Definitions and Glossary
.

Add Fees:  Allows to add fees, insurance or taxes (hereafter "fees") by Column. Up to six Column Fees can be added. A
window will open allowing the user to enter the percentage or the fees' fixed amount:

These fees can also be added or changed directly in the Payment schedule afterwards.
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See the detailed Fees, Insurance and Taxes by Column section in the How to do Chapter...

Use Interest Table:  If  a loan or financial  instrument is  to use variable interest rates (for example, ARM, post-judgment
interest, etc.), check the "Use Interest Table" box. A new section will appear allowing you to choose the rate table to use
and to add (or subtract) a percentage rate to this table. See also "Variable rates + or - x%"

Some  tables  in  MLM  may  include  a  single  fixed  interest  rate  (not  variable)  such  as  the  legal  interest  rate  for  certain
countries, states or provinces.

See also, Interest rate tables (variable interest rates).

Amortization  (Payments):  In  this  field,  include  the  amortization  period  of  the  loan  or  leave  blank  if  unknown.  The
amortization period is the full period required for the loan, through its payments, to reach a balance most often equal to
zero or some other residual value.

Mortgages often have a 25 year amortization period whereas some loans may have an amortization period of only a few
years and equal to the term (see below).

Insert the number of periods in the field - for example a 25 year mortgage would have 300 monthly payments.

The right mouse click offers other features if the amortization is not specifically known in number of payments:

With the "Specific Date" choice, the window below will  open prompting you to enter the end date of the amortization
period.  Once a date is  entered, the number of  payments  will  be  calculated in  the  Data  window.  Dates  must  first  have
been specified in the "Origination Date" and the "First Payment Date".

The amortization can also be specified in number of years based on the "Payment Frequency" (payment frequency).
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Term  (Payments):  The  term  of  the  loan  represents  the  period  for  which  a  loan  is  granted.  For  example,  a  25  year
mortgage may have a term of 5 years, after which the mortgage contract may have to be renegotiated.

The right mouse click offers the same options as for the Amortization period.

When a term that is not equal to the amortization period is entered, the payment amount and the balance at the end of
the term will be calculated automatically.

If  you do not  intend to use this  option,  you may hide it.  See Settings > User Settings Record "Data" window: Display /
Hide Loan "Term" and "Due Pmt" Type for more information on this subject.

The "Due Pmt Default" option allows the user to define, when creating the payment schedule, the Line status to be used
for the Borrower's future Due payments. Thus, a Payment schedule could consist of "Due Pmt" or be more precise, for
example with the Line status "Due Pmt - EFT" for payments to be drawn by Electronic Funds Transfer. Five (5) "Due Pmt"
type Line statuses are available and the last four can be renamed.

Take note also that once the Payment schedule is created, it  is possible to modify the Line statuses to another type of
"Due Pmt" one by one or in batch with the "Ctrl-Alt-Shift-F11" shortcut .  You can have Due payments for EFT, cash, by
check, extra payment, etc. See "Due Payment" Type Line statuses.

If  you do not  intend to use this  option,  you may hide it.  See Settings > User Settings Record "Data" window: Display /
Hide Loan "Term" and "Due Pmt" Type for more information on this subject.

Payment: Enter the payment amount or leave blank if the payment is unknown. If the payment is unknown and the other
loan  data  is  entered,  the  loan  payment  amount  will  be  computed  automatically.  In  the  "Data"  window,  only  a  fixed
amount may be entered, but  the loan may be  customized in  the  Payment  schedule.  This  can  include lump sums,  zero
payment, negative payment (increase in principal), fees (negative payments), step payments (according to an amount or
a percentage), etc. The right mouse click is a very powerful tool to customize payment schedules. Each payment line may
also have its own Line status and comment.

Balance: The balance may include any amount including a balance greater that the original principal. In this latter case,
negative payments will be computed which will increase the total loan or investment instead of reducing it.

A balance may also include a residual value such as is the case in a lease.

If no amount is entered, the balance will automatically be 0.00.
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If a negative amount is entered, the payments will continue until the negative balance is reached which inverses the loan
- the lender will now owe the amount to the Borrower.

Currency:  If  the Multi  Currency option is  activated, MLM displays the  "Currency" section,  thus  allowing the  use of  the
default Windows currency (Windows Control Panel), or, by clicking the "Choose from the list" option, a scroll menu will
allow the user to choose the desired currency. The MLM Administrator may determine the currencies included in MLM
(Tools > Settings).

Percentage  to  Add  (Annual),  Rate  Tables,  Use  Fixed  (unique)  interest  rate  at  "Origination  Date":  See  "Use  Interest
Table" above and Interest Rate Tables.

Allowance for Doubtful Accounts: This allows you to tag part of the loan as doubtful. Thus enter the percentage of the
loan's balance on a certain date (date is inclusive) which you estimate will not be recovered.  

It is not required to include a date. If no date is indicated, in the Doubtful accounts report, the doubtful accounts will be
computed based on the percentage indicated here and on the final balance (last payment) or on the balance at the date
entered for the report. 

See Doubtful Accounts, Doubtful accounts report and Record List for more detail.

Report Header: A header can be inserted here. This may be useful to add a header (company name, address, logo, etc.)
in the Detailed schedule (Payment schedule) report. 

Please  note  that  detailed  client  information  or  other  data  pertaining  to  the  Record  itself  should  be  inserted  in  the  "
Borrower" window or in one of  the specifically created "Custom fields".  This approach allows for an easy extraction of
data since any data contained in the "Report Header" box are not  included in any report except the Detailed schedule
report as a  header.  If  the header is  used in the Detailed schedule report and too much data is  entered in  the  "Report
Header" field, the Detailed schedule header can become messy.

The right mouse click  allows basic text formatting. 
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For more complete formatting, you may import a  text  directly from Word (or  other word processor).  Most images are
supported.

See the Special header for Detailed schedules section of the Detailed schedules report.

Multiple functions appear at the bottom of the Data window:

 Modify / New Record: This very important link allows you 1) to modify an existing Record using the existing data or
2) to create a blank new Record. See also Changing the basic loan data in a Record and  Duplicating Records.

Clear  Data:  This  link  clears  the  data  in  the  window.  Brings  up  a  blank  window  taking  into  account  or  not  the  default
settings. This is only available when no Payment schedule has yet been produced. In order to clear the Payment schedule,
press on New Record and choose among the two choices offered (see image above). 

Save profile: In order to reduce data entry to a  minimum, MLM allows you to create multiple "default" settings called
"Profiles". These allow you to enter the settings and save them under a Profile which can then be loaded with the "Load
profile" button. See further explanations in Profiles. 

Load profile :  This link will  retrieve a  Record profile  among the  profiles  that  were previously  saved.  See "Save profile"
above.

Save as default:  If  some data is  used regularly in  your loans,  you may set the financial  settings as default  for  the next
calculations.  For  example,  a  Record could  always  be  Active (instead  of  the  "Draft"  system default)  and  "Compounding
Period" and "Payment Frequency" could be set to Monthly (instead of "Annually"). See also "Save profile" below and the
General defaults and Profiles sections of this user guide.

Display Record log: This displays this Record's log that includes changes made to it and by which user. See Record log.

The Administrator can set Mandatory fields for the Record's "Data" tab. The user will not be able to save as long as these
fields are not filled in.

"General" tab



Page 686

© Jurismedia Inc., 2007- 2023

The General tab leads to a window with additional information about the Record:

File:  This  field  usually  contains  the  loan number  assigned by  the  lender.  This  number  can  be  based on  the  numbering
system used by the Creditor and can include text or numbers. If numbers are used, sorting in the Main window may not
meet the desired sort order because sorting will not be done numerically (e.g. loan 1000 would appear before loan 900,
since as text data, 1 is smaller than 9).

File  Number  is  a  numeric  field  and  can  be  used  when  the  loan  numbering  is  numeric-only  with  no  other  characters.
Letters, dashes, spaces and other characters are not allowed. The field can contain up to 15 digits.

These  fields  should  not  be  confused  with  the  Record  unique  identifier  that  is  automatically  assigned  to  any  Record
created (MLM Record Identification).

The "File" and "File Number" (in addition to the Record unique identifier and the names of the Borrower) appear in the
window header. In the example below, the "File" is "DIA-3456" and the "File Number" is "654987".

Unique Identifier may be entered in order to establish a  link with the unique customer number from your accounting
software. Custom fields can also be used for this purpose when identified as General Ledger numbers. See Custom fields
and Export accounting transactions to the General Ledger

Type  may be the loan type: personal loan, car loan, mortgage, reverse mortgage, investment, collection, lien of  credit,
type  of  fund  from  which  the  loan  comes  from,  etc.  Records  can  then  be  sorted  in  the  Record  Summary  Window
depending on the Record type.

The "Type" field can be defined as a scroll field allowing you to enter only predefined standardized data. Go to Tools >
Settings > System settings (Administrator) > Field Scroll Menus. For more information, see the Scroll Menus (under Tools
> Settings) section to create menus and to define the standardized data (very simple). When a scroll menu is created, it is
possible to display (and not just a sort) only certain Record types in the Main MLM window.

Date: This field can be used to enter, for example, the date the Record was created.

Maximum Credit: If a credit limit is imposed on the loan, enter the amount here. A Conditional Alert can be created to be
alerted when the total loan amount (principal, additional principal and unpaid interest balance when required) exceeds
the Maximum Credit amount entered. This Conditional Alert must be created by the MLM Administrator. 

 Note: A credit limit can be added to a Borrower for all his loans. See Borrower (Client) Information.

Other Info: This field allows you to enter a clarification about the Record that is not standardized or predefined in other
fields. This field can not be extracted in the reports.

The Attached Documents  link allows for files to be attached to a Record. See the Tools
& Settings chapter, Attached Documents section. 

Record Owner:  identifies the Record's Owner or the user "Responsible" for the Record. The Owner can be modified at
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any  time  by  another  registered  MLM  user.  The  Record  Owner  can  also  be  changed  for  multiple  Records  in  a  single
operation by the Administrator. 

Record Window Header

The header of the Record window Header can be adapted to the needs of each user in
order to see only the relevant identifier.

See Record Window Header (Settings > User Settings).

"Other Data" tab

Under  the  "Other  Data"  tab  you  will  find  the  "Record  -  Custom  fields"  and  "Unlimited  fields  (Table  format)"  sub-tabs
which allows you to enter additional data not included in the normal Record fields.  To understand the benefits of  one
type over the other, see Custom fields.

For example, it may be of interest to create a field that indicates the number of jobs created (expected) as a result of this
funding, or a loan risk factor.

It is important to understand that these custom fields are linked to the loan itself and not directly to the Borrower. We
would not put the Borrower's license number in one of these custom fields. Such a field is a custom field that should be
related to the Borrower.

You  can  create  or  edit  these  fields  in  the  MLM  Settings.  You  can  also  assign  a  default  value  and  a  scroll  menu  to
standardize the information associated with the fields. Some scroll menu fields may also be used asDisplay filters in the
Main MLM window. 

For more detail on custom fields, see Custom fields and Scroll menus.

Some fields can be identified as mandatory fields which must be completed before the Record can be saved. See Settings
> System settings (Administrator) > Mandatory Fields. Mandatory fields allow the creation of a more standardized loan
portfolio.

"EFT" tab

The EFT tab (preauthorized payments) allows:

 to activate the EFT for this specific Record;

 to submit ALL upcoming Due payments of the loan for futur debit;

 to specify which Creditor (bank) account will be credited;

 specify which Borrower account (or credit card) will be debited;
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 for  Records  that  are  already  EFT-enabled,  the  number  of  transactions  submitted  as  EFT  (upcoming,  accepted  and
rejected payments).

If  the  tab  appears  in  grey,  you  must  enable  the  EFT  module  by  Tools  >  Settings  >  System  settings  (Administrator)  >
Modules.

When trying  to  activate the  EFT,  several  messages may appear,  depending on  the  preliminary steps  that  have not  yet
been completed:

1)  a  Creditor  must  be  assigned to  the  Record  and  the  information  pertaining  to  their  EFT  file  must  be  entered  (File  >
Creditor > "EFT" tab).

2) a Borrower must be assigned to the Record and the information pertaining to their  EFT file must be entered (File >
Borrower > "Accounts" and "EFT" tabs).

Once the choices are made, press Save .

See the Electronic Funds Transfer section.

See also Changing the basic loan data in a Record, Default settings and Profiles.

   

Changing the basic loan data in a Record

Upon creating a loan and producing a Payment schedule, if you wish to change some of the loan settings afterwards (in
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order to try various hypotheses - date, amount, compounding or rate changes, number of payments, etc.), press on the
"Data" tab, and on the "Modify / New Record" link (bottom left):

This window will appear allowing you to either:

1)  creates a new Record using the new data displayed in the "Data" window (but will not include
the changes made in the Payment schedule - these will be lost),

This  option  will  not  change the  information in  the  "Borrower",  "Creditor"  "Custom fields",  "Credit  Report",  "APR"  and
"Advanced" windows. This should be done separately if need be.

Important Notice for Preauthorized Payments (PAP) already submitted: If some payments have already been submitted
as (PAP), since a new schedule (Payment schedule) is to be created, a message will appear indicating that the lines that
were submitted as PAP will be eliminated. This is not suggested unless you are really creating a new Record as opposed
to a replacement of the existing Record. Eliminating PAP lines in MLM does not eliminate payments already submitted to
the EFT Processor.

See also Change of compounding or calculation methods without affecting the existing Payment schedule.
 
OR

2)  creates a new Record while clearing all data in the "Data" window. If default settings were
set for the Data window, these will appear as opposed to a blank window. The "Borrower", "Creditor", "Credit Report",
"Custom fields", "APR" and "Advanced" data will also be cleared or set to the default settings.

Change only the required data if need be and press on "Compute". 

If  the  default  Data  settings  are  not  wanted,  press  on  the  "Clear  Data"  link  and MLM  will  prompt  you  to
clear the window or to load the default settings. 

See also above, the Important Notice for Preauthorized Payments (PAP) already submitted.
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See also Duplicating Records

   

Doubtful accounts

A Record may contain an allowance for doubtful accounts. This may be useful when a Borrower is in financial difficulty
and does not meet his/her payment deadlines. Some of the loan may be considered doubtful.

A percentage of the loan's balance on a certain date may be considered doubtful. A doubtful accounts report is available
in Margill Loan Manager.

It is not required to include a date. If no date is indicated, in the Doubtful accounts report, the doubtful accounts will be
computed based on the percentage indicated here and on the final balance (last payment) or on the balance at the date
indicated in the report request itself.

If a date is included, the date indicated will include the balance up to and including that date.

The Doubtful accounts report provides detailed information as to the reporting aspects and explains the three doubtful
accounts scenarios:

1) Doubtful account based on the balance at the date indicated in the "Data" window (thus x% of the balance on date y).

2)  Doubtful  account  based on  the  balance at  the  end of  the  Record -  last  payment  of  the  schedule (even  if  balance  =
0.00). This will be the case if no date is indicated in the "Data" window but if a percentage is included. 

3) Doubtful account based only on the date entered in the report.

This data is also included in Record List.

   

Borrower (Client) Information

The "Borrower" window allows you to select or create the Borrower, Co-Borrower(s) and Guarator(s) for the Record.

The data for the Borrower or Co-Borrower are ideally entered in the system via File > Borrower from the Main window.
The data can also be Recorded in the "Borrower" window of the Record of Margill Loan Manager (MLM)) by pressing the

"New"  button.
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See Creating and modifying a Borrower, Creditor, Employer or a Loan Officer.

"Borrower" tab

"Borrower" sub-tab

Special Notes:

The  Borrower  identification  number  ("Borrower  ID")  is  automatically  assigned  by  MLM  for  each  Borrower  entered
(entries  numbered  10000).  This  number  is  different  from the  Record  Unique  Identifiers  ("MLM  Record  Identification")
number.

The  fields  "State/Prov."  and  "Country"  may  be  configured  as  scroll  menus.  Go  to  Tools  >  Settings  >  System  settings
(Administrator) > Field Scroll Menus. See the Scroll Menus section (under Tools and Settings) for further explanations on
how to create the menus and define the standardized data.

Unique  Ident.  1  and  2:  can  be  used  to  bridge  the  gap  with  a  third-party  software.  An  identifier  entered  may  not  be
reused for another Borrower.

Several  emails  may  be  entered  in  the  "Email"  field.  Simply  separate  these  with  a  semicolon  (;)  without  spaces.  This  is
particularly useful when the user wishes to send emails via the Document Merge tool to all these email adresses.
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Special fields "Other info" and "Loan Security"

The  data  ("Other  info"  and  "Loan  Security")  located  below  the  buttons

are  data  related  to  the  loan,  not  to  the  Borrower.  Thus,  Loan
security  is  a  security  agreed to  by  the  Borrower but  related to  the  loan.  If  a  Borrower has  more than  one  loan  in  the
system, he might also have a loan security on the first loan and another on the second loan. "Other info" is also related to
the loan and allows the user to add further data. However, it is suggested to use custom fields to access the data in the
reports.

If data have been entered in these two fields and the Borrower or Co-Borrower is removed from the loan, the data would
be deleted from the database but remain Recorded in the Record's History. See also Security (Guarantee).

"New"  Button:  creates  a  new  Borrower  directly  in  this  window  (instead  of  going  through  the  Main  window  >  File  >
Borrower.

"Select" Button: among the MLM list of Borrowers selects the Borrower for the current loan. If the Borrower is not in the
list, you can use the "New" button to create the Borrower.
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"Edit" Button: adds or removes information in the Borrower's Information Card. 

If  a  Borrower  has  multiple  loans  in  the  portfolio  (or  is  a  Co-Borrower  in  other  loans),  all  modifications  made  to  this
Borrower's data applies to all his other loans. The Borrower should have only one entry in the "Borrower" database and
this entry should be linked to each Record.

"Remove"  button:  without  destroying  the  information  about  the  original  Borrower  for  this  loan,  removes  the  link
between the Record and this Borrower.

If Preauthorized Payments (PAP) were submitted in this Record, the system would not allow the removal of this Borrower
unless  all  PAPs  were  first  deleted  from the  Payment  schedule  (a  cancellation  of  payments  should  follow  with  the  EFT
Provider). If  information pertaining to PAPs was present in the "Data" window > "EFT" tab,  this  data would be deleted
since new data will be required once a new Borrower is chosen.

"Save as default" link: if (almost) all the Records are attached to the same client, you can click "Save as default" (in the
window  lower  left  corner).  Information  pertaining  to  the  Borrower  in  this  window  will  be  applied  to  all  new  Records
created, but it can still be modified in any future Record created.

"Clear default" link: removes data entered by the user for the Borrower by default and becomes blank.

The Administrator can set mandatory fields for the Borrower. The user will not be able to save as long as these fields are
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not filled in.

"Borrower - Other Data" sub-tab

In the "Borrower - Other Data" sub-tab, two types of custom fields are available. The "Borrower - Custom fields" sub-tab
which  contains  (9)  custom  fields  are  displayed  as  boxes,  while  the  second  "Unlimited  fields  (table  format)"  sub-tab
contains  an  unlimited  number  of  custom fields,  but  in  table  format.  To  understand  the  benefits  of  one  type  over  the
other, see the Custom fields section.

These fields are useful for including information not present in regular fields. These can be used, for example, to include
the client's fiscal year end date, the individual risk factor, etc. The data can then be manipulated (exported to third party
software such as Excel or to banking applications) through the powerful Record List.

Specific  names  and  data  types  can  be  customized  in  Tools  >  Settings  >  Borrower  -  Custom  fields.  To  customize  field
names, see the Custom fields section.

These fields can be defined as scroll fields. To create menus and standardized data, see the Scroll menus section (under
Tools and Settings) .

Special Borrower warning/message

The third sub-tab "Other Options", only visible through File > Borrower, allows the user to enter a special message that
will then appear if a Borrower is selected in a Record as a Borrower, as a Co-Borrower or as a Guarantor (when linked to a
loan). For example, a Borrower can be labeled as "Bad payer - do not lend to..." (or any other message). The message can
be customized for each Borrower.

For example: Do not lend to this person.

Accessible via File > Borrower
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When  choosing  this  Borrower,  Co-Borrower  or  Guarantor  in  a  Record,  a  window  will  appear  displaying  the  message
entered under the "Other Options" sub-tab.

This message is only a warning and will not prevent the Borrower, Co-Borrower or Guarantor from being selected for a
Record.

Maximum credit by Borrower 

It is also possible to specify the maximum credit for a Borrower. Previously, a maximum amount could be specified only
for a loan in the "Credit Limit" field (Data > General).

The amount can be specified based to the following amounts:

 True Balance (Principal, Interest, Fees, etc.) at the current date
 Balance of the Principal and the Fees Financed (APR) at the current date
 Total original Principal and Fees Financed (APR) 
 Total original Principal , Fees Financed (APR) and all Additional Principal Line statuses

After entering an amount in the "Maximum Credit Borrower", MLM will compile all Active Records for this Borrower to
confirm that all loans do not exceed the credit limit. Closed, Pending, Draft, On Hold, etc., Records will not be included in
the calculations. 

If the credit limit is exceeded, the Record can still be saved as this is just a warning.

Credit limits will only be computed for Borrowers. It will not be computed if the Borrower acts as a Co-Borrower or as a
Guarantor for a loan. Furthermore, if a Borrower has a participation percentage in a loan, the percentage will be ignored
and the full amount (or balance) of the loan will be considered in the credit limit.
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By clicking on , the current credit amount will be displayed for this Borrower's Active Records, but only as
a Borrower, not as a Co-Borrower or Guarantor. 

In System Settings (Tools > Settings), under "Borrower Maximum Credit", the Administrator has some options that can be
activated as default settings for all users.
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The Administrator can choose the default maximum credit criteria that will be followed when users enter an amount in
the "Borrower Maximum Credit" box. The Administrator can prohibit the user from changing the criteria by checking the
"Do not allow the user to change the criteria by Borrower (except the amount)". Thus, if this option is checked, the user
will have to use the default maximum credit criteria chosen by the Administrator. If the option is not checked, the user
can choose the desired criteria for each Borrower. A unique system-wide criteria is usually and should be used.

If the option "Do not activate the Maximum Credit test performed upon launching the software" is not deactivated (it is
activated  by  default),  a   second  Credit  Limit  test  will  be  performed  for  all  Borrowers  that  have  a  Credit  Limit.  When
launching  MLM,  an  automatic  computation  will  be  performed  to  examine  if  the  Credit  Limit  has  been  exceeded.
Exceeded credit limits will be displayed in the "Alerts" display module.  In this module, no Record is displayed, only the
Borrower name is displayed. The computation will only be performed once a day (upon software launch) and the Alert
will be displayed daily so long as the limit is exceeded.

"Notes+" sub-tab

The  "Notes+"  sub-tab  allows  the  user  to  add  Notes  and  attach  documents  to  the  Borrower's  (Co-Borrower's  and
Guarantor's) Information Card.

See under Tools & Settings, sections Notes - Record and Borrower and Files (Attach)(Documents).

"Employer" sub-tab

The  "Employer"  tab  allows  the  user  to  enter  information  about  the  Borrower's  Employer.  The  "New",  "Edit"  and
"Remove" options offered are the same as in  the  Borrower tab.  The "Select"  button  opens  a  list  of  Employers  already
registered in the system.
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Employer Information Cards are ideally created via the Main MLM window > File > Employers.

Employer data is often used for credit reports.

The Administrator can set mandatory fields for the Employer. The user will not be able to save as long as these fields are
not filled in.

"Co-Borrower" sub-tab

The "Co-Borrower" window allows you to  select  one or  more Co-Borrowers for  a  Record ("Select  /  New").  The "New",
"Edit" and "Remove" options offered are the same as in the Borrower tab.

A  Co-Borrower  can  also  be  created  with  the  "New"  button,  although  it  should  ideally  be  created  via  the  Main  MLM
window > File > Borrower. The system does not include a separate database for Co-Borrowers, the latter being included
in the "Borrower" database. Thus, a Borrower can easily be a Co-Borrower for another loan without having to create a
new Information Card.

See the Co-Borrower sub-section for more detail.

"Guarantor" sub-tab

One or many Guarantors may be chosen for a Record ("Choose/Add" button) in the "Guarantor" window. A Guarantor
can be chosen from the Borrower database and all the Co-Borrower's features apply to the Guarantor.

To see all the loans a Borrower may have, go to File > Borrower > "Borrower File" tab and press the "Records" blue link.

Or use the Display Filters in the Main window, "Record Summary".

   

Co-Borrower

The  "Co-Borrower"  tab  of  the  "Borrower"  window  allows  you  to  select  or  create  one  or  more  Co-Borrowers,  as
thoroughly as those main Borrowers.
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See Borrower (Client) information for more detail on how to enter the data.

You can associate multiple Co-Borrowers to a loan. By clicking on the  button on the bottom of the
"Co-Borrower"  window,  the  list  of  Borrowers  already  in  the  system  appear,  allowing  you  to  choose  one  or  more
Co-Borrowers previously entered.
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If  more  than  two  Co-Borrowers  are  entered,  a  vertical  scroll  bar  will  appear   allowing  you  to  see  the  other
Co-Borrowers.

It is possible to enter a new Co-Borrower in MLM from the Co-Borrower window by clicking the  button and
completing the appropriate fields.

Warning! The system does not include a separate database for Co-Borrowers, the latter being included in the "Borrower"
database. Thus, a Borrower could be a Co-Borrower or a Guarantor for another loan without creating a new entry.

For reporting, most data pertaining to the main Borrower is  available.  However, only  the normal data (name, address,
phone, email, etc.) can be reported for up to nine (9) Co-Borrowers. Custom fields cannot be reported for Co-Borrowers.

For the Credit Report, only the first Co-Borrower will be included in the report, but only as a Co-Borrower and not as a
main Borrower.
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To find all loans that may have a Co-Borrower, from the Main window > File >  Borrower > "Borrower File" tab > press the
"Records" blue link.

   

Guarantor

A Guarantor can be included in a loan.

A Guarantor is not a Borrower and does not have to pay back the loan as long as the Borrower and/or the Co-Borrower
are  fulfilling  their  obligations.  A  Guarantor  will  have  to  pay  back  a  loan  if  the  Borrower  and/or  Co-Borrower  do  not
reimburse their loan. His role is therefore different from a Co-Borrower's. 

One or many Guarantors may be chosen for a Record ("Choose /Add" button) by the "Guarantor" window. A Guarantor
can be chosen from the Borrower database and all the Co-Borrowers' features apply to the Guarantor.

See Co-Borrower and Borrower (Client) Information for more detail.

   

Security (Guarantee)

For  loans  or  mortgages  that  involve  securities  or  guarantees  (asset-based  lending),  these  may  be  included  in  the
"Security" section of the "Borrower" window. Although shown under "Borrower", (Co-Borrower or Guarantor) the "Loan
Security" is related to the loan, not to the Borrower. Thus, a security  is a security agreed by the Borrower but relating to
the  loan.  If  a  Borrower  had  more  than  one  loan  in  the  system,  he  might  also  have  a  guarantee  on  the  first  loan  and
another on the second loan.

A  description  of  the  security  may  be  included,  as  well  as  the  estimated  value  of  this  security.  If  no  value  is  assigned,
simply  leave  the  "Amount"  field  blank.  The  securities  may  be  listed  in  alphabetical  order  or  value  by  clicking  on  the
"Description" or "Amount" columns, use Record List to list all securities in the portfolio. To include this field in the Record
List  or  Document  Merge  (Letters,  Contracts,  Invoices  and  Statements),  you  will  find  the  field  under  the  "Loan  Data"
theme, not under "Borrower".

Some clients choose to create Custom fields for these guarantees, thereby gaining greater flexibility when exporting data
via  the  reports.  If  multiple  guarantees  are  included,  multiple  Custom  fields  can  be  created  and  named  Guarantee  1,
Guarantee 2, Guarantee 3, etc.

See also: Client (Borrower) information.
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Creditor (Lender/Investor)

The "Creditor" window allows you to select or create the Creditor for the Record.

The data for the Creditor is ideally entered in the system via File > Creditor. The data can also be entered in the "Creditor"

window of the Record by pressing the "New"   button.

See Creating and modifying a Borrower, Creditor, Employer or a Loan Officer.

If only one legal entity is a Creditor for the whole portfolio, it is suggested that you enter the Creditor information and
then press the "Set as default" button (bottom left). Thus, all  future loans will  be linked to this Creditor. This does not
preclude the possible addition of a second Creditor in the system. The "Clear Default" link removes data that has been
entered for the Creditor by default by the user.

Mass  or  bulk  adding/changing  Creditors  with  the  "Ctrl  Alt  Shift  C"  shortcut  from  the  Main  window.  See  Mass
adding/changing Creditors.

Some of our users use the Creditor window to identify the Fund as opposed to the Creditor as such.

In  addition,  some  companies  may  lend  money  while  being  Borrowers  to  finance  these  loans  (double  role  in  Margill).
These  companies  can  enter  their  Creditors  and  have  themselves  as  Borrowers  in  the  database.  When  reporting,  be
careful to sort or view Records based on the user role to obtain precise data based on the Borrower or Creditor context.
The "Type" field can also be used to distinguish the Creditor role from that of the Borrower.
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"Creditor" Tab 

Special Notes:

The Creditor identification number ("Creditor ID")  is  automatically assigned by MLM for each Creditor entered (entries
numbered 30000). This number is different from the Records' Unique Identifier ("MLM Record Identification") number.

The  fields  "State/Prov."  and  "Country"  may  be  configured  as  scroll  menus.  Go  to  Tools  >  Settings  >  System  settings
(Administrator) > Field Scroll Menus. See the Scroll Menus section (under Tools and Settings) for further explanations on
how to create the menus and define the standardized data.

Unique  Ident.  1  and  2:  can  be  used  to  bridge  the  gap  with  a  third-party  software.  An  identifier  entered  may  not  be
reused for another Creditor.

Several emails may be entered in the "Email" field. Simply separate these with a semicolon (;) without spaces.

The  Data  ("Other  info")  located  below  the   buttons  are
data linked to the loan, not to the Creditor, allowing the user to add further data. However, it is suggested to use custom
fields to access the data in the reports.

"Edit" Button: to add or remove information in the Creditor Information Card. 

If a Creditor has multiple loans in the portfolio (and this is usually standard), all modifications made to this Creditor's data
apply to all  its other loans. The Creditor should have only one entry (Information Card) in  the "Creditor" database and
this entry should be linked to each Record.

"Remove"  button:  removes  the  virtual  link  between the  Record  and  this  Creditor  without  destroying  the  information
about the original Creditor for this Record.

If Preauthorized Payments (PAP) were submitted to debit this loan, the system would not allow removal of this Creditor
unless all PAPs were first deleted from the Payment schedule (and a cancellation of payments should follow with the EFT
Provider). If information pertaining to PAPs was present in the "Data" window > "EFT" tab, this data would be deleted,
since new data would be required once the choice of a new Creditor is made.

The Administrator can set Mandatory fields for the Creditor. The user will not be able to save as long as these fields are
not filled in.

"Creditor - Other Data" sub-tab

In the "Creditor - Other Data" tab, two types of custom fields are available. The "Creditor - Custom fields" sub-tab, which
contains  (9)  personalized  fields,  are  displayed  as  boxes,  while  the  second  "Unlimited  fields  (table  format)"  sub-tab
contains  an  unlimited  number  of  custom fields,  but  in  table  format.  To  understand  the  benefits  of  one  type  over  the
other, see the Custom fields section.

"Loan Officer" sub-tab

The "Loan Officer" sub-tab allows a Creditor with multiple loan officers (responsible, in charge or account manager), to
choose the officer responsible for the current Record. One can only enter the name of the loan officer or his details (e.g.
other address, if it is not located at the same address as the Creditor).

Selection,  modification,  etc.  of  a  loan  officer  is  exactly  the  same  way  as  the  Creditor  or  the  Borrower  (

buttons).
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Loan Officer entries are ideally created via the Main MLM window > File > Creditors. A load officer must be assigned to a
Creditor.

Participation Loans 

Each  Record  can  be  individually  assigned  to  a  Creditor  (lender)  or  to  a  fund.  It  may  also  be  attributed,  in  varying
proportions, to several Creditors or funds. Such loans are known as "participation loans" or "syndicated loans". 

In  this  case,  to assign each Creditor his  participation in  a  Record,  choose the  "Select  /  Add"  button  to  select  the  main
Creditor and its Participation (by placing the allocated amount or percentage (up to 8 decimal places) of the total loan) at
the bottom of the Creditor window. Determine, if applicable, the return, as a percent (%) for each Creditor. Then choose
the other Creditors or funds with the "Select / Add" button, indicating the participation and the return of each. These all
appear in the Creditor table of the at the top of the window. This window also allows you to quickly view the totals in the
"Amount" and "Percentage" columns for all  Creditors for the loan.  The total  Amount for all  Creditors should equal  the
amount of the loan. If not, a correction should be made. A report can quickly be created to ensure that the total Creditor
participation is equal to the total loan amount including Additional principal (as a Line status). Total percentage should
always be 100%.

These  fields  can  be  used  when  creating  Mathematical  Equations  and  when  combined  with  the  "Creditors  (All)"  fields,
they allow you to get an overview of  the participating loan portfolios (such as accrued or  paid interest,  paid  principal,
total participation, each, by creditor).
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Importance of the display order in multi-Creditor Records

The order is very important since the first Creditor of the list will be the main Creditor for the Record, and so:

1. the  first  Creditor  will  be  the  "Creditor"  returned  when  producing  reports  and  only  for  this  Creditor  can  all  data
(including Custom fields the case being) be extracted.

o For  Creditors  in  the  second  and  third  positions  in  the  Record's  Creditor  table,  the  following  data  can  be
extracted for each loan:

o For all other Creditors (the first three Creditors are also included with these fields), only the following data
can be extracted, based, not on the order in the Record's Creditor window, but on the Creditor MLM ID:

 Creditor MLM ID
 Business (Company) Name
 First and Last Name (If the Creditor is a person)
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 Participation Amount
 Participation Percentage
 Possibility of using Mathematical Equations to extract hundreds of other accounting data.

The "Creditor (All)" fields are used to extract the data:

2. For the Credit Report, the first Creditor of the list will be the entity that reports to the credit reporting agencies for
that Borrower / Record.

To change Creditor order, use the arrows:

Notwithstanding  the  above,  you  can  add  as  many  Creditors  as  you  wish  in  a  Record.  It  is  possible  to  extract  several
accounting and mathematical data for each Creditor according to their respective proportions. These data (participation
in  terms of  principal,  interest,  etc.)  can  be  extracted  with  the  Record  List  report  along  with   Mathematical  Equations.
Consult the Reports section > Commonly  required reports > Participation Loans.

Sub-Creditors

The  Sub-Creditor  module  is  an  very  specialized  feature  which  allows  the  creation  of  sub-entities  for  Creditors  and  to
assign a participation in a loan to this Sub-Creditor.

Fields cannot be extracted in normal reports nor used in Mathematical Equations. A custom report built  by the Margill
team must be created to extract data using this module.

In  order  to  add  participation  by  Sub-Creditor  to  the  Creditors  already  involved  in  the  Loan,  the  module  must  first  be
activated by an Administrator in Tools > System Settings (Administrators) > Sub-Creditors.

Once the Sub-Creditor module is activated, the "Add Sub-Creditors" link will  be added in the Record's Creditor section,
under "Participation":

For each Creditor added to the Loan, it will be possible to add Sub-Creditors. In the following example, two Creditors are
assigned to the Record. For ABC Funds, which owns 40,000 of the portfolio, three Sub-Creditors must be added. To do
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this, select the desired Creditor in the table on top of the window and its information will become available: 

Then click on "Add Sub-Creditors". This window will appear:

Click on "New" to create the Sub-Creditor and its information. Available data are:

 Sub-Creditor
 First Name
 Last Name
 Unique ID
 A Sub-Creditor unique identification number will be generated automatically (in the 50,000) 

It  is  mandatory  to  have  at  least  one  Sub-Creditor  (entity  name)  or  a  First  Name  or  a  Last  Name  in  order  to  save  the
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Sub-Creditor.

If the Creditor participation is entered as an amount, you will need to enter an amount for the Sub-Creditor participation
as well,  as  opposed to a  percentage (and vice-versa).  The Sub-Creditor  participation as  a  percentage will  otherwise be
blocked:

It is not possible to exceed the participation amount of the Creditor.  In the example, Creditor ABC Funds owns 40,000 of
the portfolio, therefore the total Sub-Creditor amount should also be 40,000.  However, if  there is missing information
which would have to be entered later, you can click the "Do not force full participation amount and percentage" which
allows the user to save and leave the window without needing to specify the amounts or percentages.

For the percentage participation, the Sub-Creditor's parts should be equal to 100%, but could be less if the exception box
is checked.

It  is  the  user's  responsibility  to  return  to  the  Record  in  order  to  enter  the  missing  Sub-Creditor  data,  since  no  other
warning will be sent to the user.

Upon clicking on "Modify", the user will be able to modify the Sub-Creditor information. These changes will be effective
in all  other Records in  which the Sub-Creditor is  involved, not  only  the current one (does not  apply  to participation of
course that is unique to each loan).

Upon clicking on "Remove", the user will be able to remove the Sub-Creditor from the current Record, but will still remain
available for the other Records where he is involved. It will be saved as a Sub-Creditor of the selected Creditor and will
remain available for future use with the "Choose" button.

In  the  following  example,  ABC  Funds  has  six  "branches"  or  "departments"  as  Sub-Creditors.  Based  on  the  Records  in
which ABC Funds owns shares, it can select the desired branches.
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When information is entered for the Sub-Creditor of the Record, an asterisk (*) is added to the link to indicate that data is
present:

To see all loans of a Creditor, from the Main window > File > Creditor > "Creditor File" tab and press the "Records" blue
link.

Or use the Display Filters in the Main window.

   

Credit Report
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The  "Credit  report"  window  allows  you  to  enter  numerous  information  required  for  reporting  the  payment  habits  of
consumers to credit agencies such as Equifax. 

Reporting consumer repayment habits to credit agencies is not the responsibility of all lenders. There is often a minimum
number of loans required for reporting, as well as aspects specific to each industry. Understanding the intricacies related
to the reports can take months.

This module is available for the United States and Canada and is used in conjunction with the Credit Manager 4 or  (CM4
or  CM5  -  CM5  was  launched  in  December  2019)  software  developed  by  The  Service  Bureau  (www.tsbsoftware.com).
Margill provides the raw repayment habits data to the CM4/5 software for compliance verification, which is then sent to
the agencies in a "Metro 2" standardized format.

Data for the credit report is required at several levels:

 Loan as such:

o "Record" tab.
o This describes the loan according to several criteria. The data evolves over time according to payments (paid

on time or late, unpaid).
o Required data (marked with *).
o Several fields (marked "AUTO") can be calculated and updated automatically by MLM when producing the

report (which will be sent to the CM4/5 software). These calculations are performed based on the Payment
schedule and the Borrower's payments.

o If a Co-Borrower is present, certain other information must be included at the bottom of the window.

 Borrower (and Co-Borrower if applicable):

o "Borrower" and "Co-Borrower" tabs.
o The data can also be entered by the Main MLM window > File > Borrower > "Credit report" tab. 
o Although  data  has  already  been  registered  for  the  Borrower,  the  Metro  2  format  requires  you  to  select

some  standardized  data  from  menus.  For  example,  although  the  state  is  already  registered  for  the

http://www.tsbsoftware.com
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Borrower, you have to choose among the available choices for the credit report.

 Employer of the Borrowers:

o "Employer" sub-tab of the "Borrower" or "Co-Borrower".
o The  data  can  also  be  entered  by  the  Main  window  >  File  >  Employer  >   "Credit  Report"  tab  and  File  >

Borrower > "Employer" tab > "Credit reporting module: Other compulsory data" section.
o It is not necessary to specify the Employer.

 Creditor:

o "Creditor" tab.
o "Creditor ID" is the only required field and is provided by the Credit Manager 4 or 5 software.
o The id is initially entered by Tools > Settings > "System settings (Administrators)" tab > "Modules" section >

"Credit Reporting" link. 

See the Credit Reporting Module section in the Reports chapter for detailed explanations.

   

Annual Percentage Rate (APR)

See the complete APR section.

   

Alerts (Record specific)

Four types of alerts may be created for a Record:

 Record Alerts: general Alerts relating to a specific Record. Each Record being different (payment and renewal dates,
required  documents,  payment  of  insurance,  etc.),  this  type  of  alert  can  specify  for  this  Record,  only  that  which
should be done or requested.

 Record Alerts, specific lines: In the Payment schedule for each Record, an alert included on any payment line. These
alerts are inserted on a specific line in the Payment schedule and are generated for the Record Owner only. 

 Conditional  Alerts:  alerts  that  take  into  account  mathematical  conditions  and  that  compare  two  fields  and/or
Mathematical Equations (greater than, less than, equal to, etc.).

 Line status Alerts: Send or do not send Automatic Emails / SMS to Borrowers in a Record.

See the Alerts section to obtain an overview and detailed information about the Alerts module.

   

Advanced Functions

The Advanced window available for each Record, allows you to set or change the Record's specifics that include:

 The calculation Method (Compound, Simple interest or Simple interest capitalized);
 The year base for Simple interest;
 Day count;
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 Short period method between the Origination Date and the First Payment date;
 Refund Order/Sequence (Normal order or Special order available by request only):

o Normal: Column Fees > Interest > Principal
o Special: Interest > Expected Principal > Column Fees > Principal

 Advanced mathematical refund method for special Line statuses
o By checking this option, the additions to the balance by negative payments other than Additional Principal

and Interest Charged (therefore the Fees, Penalties, Invoices,  Insurance,  Taxes,  Investments, Withdrawals,
Adjustment and Other Line statuses – the “Special Group”) will only be paid, at the mathematical level, by
positive payments from this Special Group of Line statuses.

o This method, available since version 5.3, will be more precise in advanced scenarios when interest-bearing
and non-interest amounts are added to the balance.

o We suggest to always check this option
 Interest adjustment date
 Number of weeks in a year for the Record (for compounding and number of payments);
 Whether, by default for this Record, there is to be interest charged or not on additional principal, on fees, etc.;
 Payment schedule to be computed taking into account whether payments are to be made on the very last day of the

month or not (when payment date is the 29th or 30th);
 Activation of Automatic Fees;
 Default Grace period for the Record;
 Expected Principal Balance must always be equal to or greater than 0.00:

o If  you  are  using  the  "Expected  Principal"  concept  in  your  portfolio,  if  a  payment  pays  more  than  the
Expected  Principal  for  the  transaction,  the  Expected  Principal  Balance  will  never  be  negative  (so  will  not
factor in extra principal payment amounts).
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Settings of a mathematical nature (Method, Year base, Day count, Short periods, Weekly periods per year) are explained
in detail in the Calculation Methods section.

Add an extra interest-only payment at Interest Adjustment Date 

Particularly  with  mortgages,  when  the  first  payment  date  is  more  than  a  full  period  from  the  Origination  date,  the
Creditor will often add a payment, usually on the first day of the month before the regular payment which will pay the
accrued interest up to that day. This is called the Interest adjustment date. For more information on this option, see the
Margill Loan Manager Calculations chapter > Mortgages and Escrow > Interest adjustment date).

No interest on various types of principal added (including principal, fees, insurance, taxes, invoices, penalties)

Normally, interest is charged on various types of mathematical principal added in a Payment schedule. If by default, no
interest is to be charged on Add. Princ. (and Add. Princ. 2 to 10), Fees (and Fees 2 to 6), Insurance, Taxes, Invoices and
Penalties, check the "No interest on..." box. This avoids having to use the right mouse click in order for the fees not to
bear interest.

This can be the default setting for a specific Record or for all Records. To set this as the default for all Records, check the
box and press on "Save as default". A Profile could also be set for certain types of loans. 

Upon checking "No interest on..." existing additional principal and various fees in the Payment schedule for that Record
will  not  be  changed  to  become  interest  free,  but  any  new  principal  added  subsequently  will  not  bear  interest  unless
otherwise specifically desired by the user.

For more detail, see the Additional principal, fees, penalties, insurance and taxes section.

End-of-month payments

For end-of-month monthly payments (28th and 29th for February and 30th for other months), this option forces MLM to
use  the  exact  date  entered  in  the  "First  Payment  Date"  to  generate  the  next  payment  dates  and  thus  does  not
automatically adjust all subsequent payment dates to the last day of the month. 

For example if  you  entered April  30  (30 day  month)  in  "First  Payment  Date",  and  the  option  is  checked,  the  following
monthly payments will be on the 30th of each month (except February) as opposed to being adjusted to the last day of
the month (would be if the case if not checked).

Automatic Column Fees

Automatic Column Fees, applied when changing Line statuses, will be added only if this box is checked. This way, you can
apply automatic fees only to some Records not all.

If you wish all Records to include automatic fees, check the option and press on "Save as default". This will apply to all
new Records created only, not to already existing Records. To add automatic fees to already existing Records in bulk, as
opposed to individually, one by one, use the powerful Global changes tool.

See: Fees, Insurance and Taxes by column (and Automatic)

Grace period

Indicates the number of days by which a payment may be late without interest being charged.

When using the grace period, do NOT change the date in the "Pmt Date" column because this is the date used for the
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computation of interest. Instead enter the true payment date in the "True Pmt Date (Grace/EFT)" column. This way, no
interest will be charged, but you will obtain the true payment date.

For more detail, see the Grace period section.

This field may also be configured as a scroll menu. Go to Tools > Settings > System settings (Administrator) > Field Scroll
Menus. See the Scroll Menus section (under Tools and Settings) for further explanations on how to create the menu and
define the standardized data.

If  a  specific  loan  setting  is  used  most  of  the  time,  then  press  on  the  "Save  as  default"  link  at  the  bottom  left  of  the
window.  This  data  will  then  be  set  for  each  of  the  new  Records.  This  information  may  nevertheless  be  changed
subsequently Record by Record.

"Save profile" allows you to create a  number of  profiles (loan types in  this  case) to avoid entering the  same advanced
settings data time after time. 

For more information on defaults and profiles, see Default settings and Profiles.

The "Display Record log" link displays the log for the Record (changes made over time).

PLEASE NOTE: Considering the number of different calculation methods, it is best to use an existing calculation you know
to be accurate and adjust the MLM calculation settings based on the MLM results that equal the calculation used as a
reference.

   

Notes

A Record may contain detailed Notes  in  a  window reserved for these. Notes are now time-stamped and by user.  They
cannot be changed after 24 hours.

Text in the Notes may be formatted, images added and the Notes printed.

Click on  located at the top right of any of the Record windows.

Record and Borrower Notes can also be displayed and changed via the Alerts module.
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For  more detail  on  the  Notes  and  how these can  be  viewed in  the  Record  Summary  window,  see  Notes  -  Record  and
Borrower.

Notes can also be entered for the Borrower (see Notes - Record and Borrower).

   

Print

The "Print" button   allows the user to print directly three types of reports:

 Payment schedule

o This is the amortization table or schedule.

 Invoices / Statements / Letters / Contracts

o This directs the user in the Reports module, so that he can generates a Document merge. 

 Custom reports (created by the Margill team)

o Special reports, usually tailored to the Margill clients needs, provide various details on the loan.
This may include contracts, Record summaries, etc.

o The Payment schedule is included as an "Appendix" format to print on 8.5 x 11 or A4 paper.

See also the Reports section.

   

Attach

The  button allows the user to attach a saved Payment schedule to the Record, as a PDF format. This
is recommended in order to keep a Payment schedule history as significant changes are made to it.

The  Payment  schedule  will  then  be  accessible  in  "General"  tab  of  the  "Data"  window,  with  the  

 button. 

"Attach"  also  offers  the  option  to  attach  this  PDF  document  to  an  email.  An  overview  of  the  Payment  schedule  will
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appear and the "Email PDF" button, which, if your computer is configured correctly, will open your email program. This
will not be possible if you use a browser for your emails.
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Annual Percentage Rate (APR)

Introduction

Annual Percentage Rate (APR) (also known as Total Charge of Credit (TCC)) is based on the interest rate charged and the
various administrative fees charged for the loan.

The APR can be  computed up  to  10,000% no matter  what  the  final  balance is  and  the  fees  (or  others)  can  be  paid  in
advance, financed or subsequently paid.

The  APR  calculation  respects  country-specific  legislation  such  as  the  Truth  in  Lending  Act  (USA),  Cost  of  Borrowing
Regulations (Canada) and the British and European Union Directives (European Consumer Credit Directive 98/7/CE and
other country-specific regulations for APR or TCC). 

The user should only include fees that actually influence the APR as opposed to all  fees and extra services that  do not
affect  APR.  For  example,  if  the  Borrower  requires  optional  loan  insurance  (not  compulsory),  then  this  amount  most
probably  should  NOT  be  included  in  the  APR  amounts.  Since  optional,  these  fees  should  not  influence  APR.
Country-specific legislation are very similar but may include exceptions. Consult the pertinent legislation which applies to
your industry.

APR calculation with Margill Loan Manager (MLM)

Fees may be entered for a Record with the  button. The following window will appear:

Check the "Calculate the APR" box and enter the appropriate fee amounts and fee names (tags). Also choose if these fees
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are  1)  Paid  up-front,  2)  Financed  ou  3)  Subsequently  paid.  See  the  Fees  paid  up-front,  Financed  or  Paid  subsequently
section.

Before entering the APR information for a Record, it is suggested to first enter the loan mathematical information in the
"Data" window. This then allows MLM to calculate the fees expressed as a percentage of the loan and eliminates an error
message which may appear if the fees financed are greater than the loan amount. Even if APR information is entered first
and the principal afterwards, MLM will nevertheless calculate the APR correctly.

In  the  APR window,  each of  the  tags  (names for  each type of  fee)  may be  named according to  your  needs.  These  are
usually Administrative fees, Insurance (compulsory), Origination fees and Points on loan. These names may be changed
directly in the APR window.

The tag names, the amounts entered and whether the fees are paid up front, financed or paid subsequently may then be
saved either as default settings - press on "Save as default" or as a "Profile". 
 
With the "Save as default" link at the bottom left of the window, the fees expressed in monetary units ($, €, £, F or any
other  unit)  or  in  percentage  (%)  will  then  be  set  for  each  of  the  new  Records.  This  information  may  nevertheless  be
changed subsequently for any Record.

The  "Save  profile"  allows  you  to  create  a  number  of  profiles  (APR  tag  names,  rates  and  how  they  are  paid)  to  avoid
entering the same data time after time. 

For more information on defaults and profiles, see Default settings and Profiles.

For the US Truth-in-lending Act (TILA), MLM produces the Disclosure boxes. See APR Report.

Disclosed APR versus ongoing APR

As the true payment scenario evolves over time, if payments are missed or late, if late fees are charged, etc., MLM will
constantly  recompute  the  APR  since  the  total  finance  charge  changes  with  these  irregular  events.  A  lender  may  not
necessarily  want  this  for  reporting  purposes  over  time.  Once  the  initial  APR  is  computed,  this  APR  should  remain  the
disclosed  APR  for  the  entire  duration  of  the  loan  even  if  the  actual,  true  payment  scenario  is  different  than  the
theoretical one (see Fundamental principles of operation). It is thus suggested to include a Custom field that will state the
original  APR  rate.  Once  computed,  the  user  should  manually  enter  the  original  APR  in  this  field  that  will  remain
unchanged. This rate can then be used in monthly Statements for example.

See "IMPORTANT FOR APR CALCULATIONS" section of Line status.

See also: Fees paid up-front, Financed or Paid subsequently, Additional fees, Nominal & Effective APR, APR undefined,
APR tags (fee names), APR report.

   

Fees paid up-front, Financed or Paid subsequently

Three options are available when fees are charged to the borrowers. The fees can be 1) Paid up-front, 2) Financed or 3)
Subsequently paid. Depending on the option chosen, the APR and the cost of credit will change. 
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Paid up-front : This implies that fees are charged but will be paid by the borrower without affecting the interest amount.
Even if paid in advance, they will affect the APR and the cost of credit.

Financed:  When  fees  are  financed,  they  will  be  added  to  the  "Mathematical  Principal".  The  following  message  will
appear:

For  example,  a  50,000  loan,  with  Fees  financed  of  2,500  will  keep  a  "Principal  (Original)"  of  50,000  but  the  "Amount
Financed  (Original)"  (mathematical  principal)  will  be  increased  by  2,500  and  the  computation  (payment  computation,
number of payments or rate) will take into account a 52,500 mathematical principal. The unknown variable will therefore
be increased in order to finance these fees.

"Data" Window

"Payment schedule" Window

When a payment is paid, these "Fees financed APR" are paid on a pro rated basis of the original Principal. In the example
above, for a 1000.00 mathematical principal refund, the portion of the accounting principal paid will be 952.38 (95.24%)
and the portion of Paid Fees financed APR will be 47.62 (4.76%) since:

Principal Portion: 50 000 / 52 500 =  95.24%
Fees Portion: 2500 / 52 500 = 4.76%

See the Refund order for Interest, Fees and Principal section in the Calculations Methods chapter for further information
and examples.

Exclusion of payment of he APR Fees financed
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In  some  situations,  one  might  wish  to  apply  the  payment  amount  to  pure  (accounting)  Principal  as  opposed  to  the
payment of the APR Fees financed along with the pure Principal on a pro rated basis, or wish that the payment apply first
to pay the Fees financed, therefore before the pure Principal.

The "Paid Principal" Line status offers three options with the right mouse click:

1) Default (usual method): payment of pure Principal and pro rated Fees financed.  
2) Payment of pure (accounting) Principal only 
3) Payment of APR Fees financed (paid in priority, before pure Principal) 

In the following example: 

 Line 5 - default method which pays pure Principal and pro rated Fees financed
 Line 6 - pure Principal payment where the 400 is only applied to pure Principal (see "Paid Principal column)
 Line 7 - payment of Fees financed where the 400 is applied only for Fees Financed (see "Paid Fees Financed (APR)"

column)
 Line 8 - payment of Fees financed is too high:

o the balance of Fees financed is paid in priority to give Fees financed balance of 0.00 (cannot be negative)
o the rest of the payment is then used to pay pure Principal (3000.00 - 2648.28 = 351.72). This amount, being

a Principal payment, cannot be used to pay interest or other fees (Column fees)
 Line 9 - default method which pays pure Principal and Fees financed on a pro rated basis (balance of 0.00 for Fees

financed in the example, therefore applied 100% to pure Principal).  The pure  Principal  balance becomes negative,
even if there was an interest balance

o In  this  scenario,  the three methods would lead to the same result  -  including the priority  payment of  the
Fees  financed  since  these  are  already  at  0.00  (would  not  be  a  logical  method  to  use  in  this  example).
Method 3)  (Payment of  Fees financed)  is  not  an  exclusive  payment  but  a  priority  payment  of  those  Fees
financed before the pure Principal.
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When  a  special  method  is  used,  the  payment  becomes  green  in  order  to  show  that  it  is  a  special  payment.  With  the
mouse-over, you can see which method is used:

See the Refund order for  Interest,  Fees and Principal  section in  the Calculation Methods chapter for  more information
and examples.

See also "Principal" Type Line statuses and "Payment" Type Line statuses

Subsequently Paid: This payment is excluded from the Payment schedule. These fees should only be used in particular
situations such as multiple phase loans (construction loans). It is very similar to "Paid up-front" fees. APR and credit fees
will  be  identical  but  by  legal  definition,  the  "Financed  Amount"  and  the  "Total  Payment"  computed  by  MLM,  will  be
different.

This  subtlety  exists  in  the  United  States  (when  the  APR  disclosure  statement  is  done  in  accordance  with  the  Truth  in
Lending Act). It does not necessarily exist or is not required in other jurisdictions.

If a subsequently paid fee was paid on the last payment of the Payment schedule instead of truly being paid subsequently
(not even in the calculation), then the APR will factor this in. It will not be considered as paid subsequently because it is
included in the Payment schedule. Not to be twice accounted for, it would have to be excluded from the APR tool and
added via Column Fees, not forgetting to adjust the payment to reach a balance of 0.00. 

In  the following example, fees are  either  paid  in  advance or  subsequently  paid  on  a  50,000 loan.  Notice  that  the  only
differences lie in "Amount Financed" and "Total Payment":
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When fees are paid in advance, they are subtracted from
 "Amount Financed" and "Total Payment" 

When fees are subsequently paid, they are not subtracted from
"Amount Financed" and "Total Payment"

Subsequently paid fees are not subtracted from "Amount Financed" and "Total Payment" because they will generally be
paid in another contract. These fees are mostly used in construction loans. A first loan is granted for construction with
fees to be paid subsequently when another contract is signed for financing with amortization. 

These subtleties are explained in the APR window: 

   

Additional fees
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Margill Loan Manager (MLM) offers the possibility of adding fees (or insurance or other) as columns or by Line status.

Adding a negative payment (for example a 20.00 fee for a late payment) and specifying its Line status as a "Fee" will not
affect  the  APR  as  if  it  were  a  fee.  This  negative  payment  will  affect  the  APR  calculation  because  it  will  be  wrongly
collected as being additional principal  (thus actually  reducing the APR).  When fees are included as Line statuses in  the
Payment schedule, a message in red will indicate that this solution should not be used.

It is thus strongly recommended not to use Fees (Insurance) Line statuses to calculate APR. We suggest the use of Column
Fees for a more precise calculation.

Column Fees usually increase the payment in order to correctly increase the APR, without unduly affecting the amount
financed.

If additional principal (not Fees as such) is added via "Additional Principal" type Line statuses, the APR will be computed
properly.

   

Nominal & Effective APR

Margill  Loan  Manager  includes  various  APR  information  such  as  the  equivalent  APR  rates  (nominal  and  actuarial  APR
rates) as well as the total finance charge.

Nominal APR includes all compulsory administrative and finance fees but does not  take into account the compounding
period.

Effective  APR  includes  all  compulsory  administrative  and  finance  fees  and  does  take  into  account  the  compounding
period.

Once a loan has been computed, by pressing on the APR button, the APR information will be posted below the fee entry
fields. The information will include the nominal and effective APR figures:

   

APR undefined

In certain situations, the APR computation may not be determined:
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1. APR is undetermined or undefined when the rate is less than 0.00% or greater than 10,000% or when the loan fees
(excluding interest fees) are greater than the principal.

2. When the balance is not 0.00, a warning message will appear:

APR Warning indicates that MLM detected a problem:

 In order to obtain a proper APR calculation, it is highly recommended to reach an end balance of 0.00 (or off by only
a few cents).

 If  the  balance  is  negative,  Margill  will  assume  that  the  Borrower  paid  too  much  and  thus  will  increase  the  APR.
Nevertheless, the true Finance change will be shown as well as the balance.

 If  the balance is positive, Margill  will  assume that the Borrower did not pay enough, and thus got a  rebate on the
loan, which is not necessarily true since a balance is owed. 

 Only by entering all payments leading to a 0.00 balance can the true APR be computed. 

 If there is a balance left, APR computation may not be consistent because the total of payments actually paid and
due or overpaid payments are not managed.

   

APR tags (Fee names)

Tags and default amounts and rates (%) may be set in the APR window for each Record. Thus, each Record can have its
own APR information.

If  needed,  it  is  possible  to  set  this  information  as  the  default  for  all  subsequent  loans.  Thus,  it  won't  be  necessary  to
manually add them for each Record. Simply change the table (label names, amounts, percentages and fee type with the
drop down menu) and click on "Save as default" located in the bottom left of the APR window. This operation will  not
affect the labels defined in existing Records. 
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"Administration Fees" are set-up fees for example.

"Insurance" is  usually  compulsory insurance. Optional  insurance bought by the Borrower is  usually  not  included in  the
APR calculation.

"Origination  Fees"  are  the  fees  paid  to  the  entity  originating  the  loan  to  cover  their  costs  associated  with  creating,
processing, and closing the loan or mortgage. Fees are mainly expressed as a percentage of the amount borrowed.

"Points  Paid".  Banks  and  other  financial  institutions  often  charge  points  when  lending  money.  Points  are  a  form  of
prepaid interest and are typically calculated as a percentage of the loan amount. Each point is equivalent to one percent
of the amount borrowed (excluding the APR fees financed).

Finally, "Services-Other" may include any other loan fees or charges.

See APR General.

   

APR report

Margill Loan Manager, through the Document Merge (Letters, Contracts, Invoices and Statements) can produce the US
Federal Truth-in-Lending Act (TILA) box as shown below. The numbered codes are mere fields.
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Through the RTF Report Editor (accessible through the MLM Reports module )
choose the Report Description called "TILA APR Box (USA)":

The merge codes are already inserted in the template which can also be modified to fit your specific needs.

You will notice that the formatting is odd (because of centering and the boxes) but when first saved and then printed, the
formatting will be perfect. If you print directly, the boxes may not show up properly. You should save in RTF format first
and then print from your word processor.

It is also possible to generate reports on APR data. This data extraction can be done in most MLM customized reports.
See section Reports for more information.
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Payment schedule (Amortization, payment schedule)

Content of Payment schedule (Amortization, payment)

Introduction

Line status

o "Due Payment" Type Line statuses
o "Payment" Type Line statuses
o "Principal" Type Line statuses
o "Interest" Type Line statuses
o Accounting data and Line status

Data Integrity
 
Line Comment

Payment schedule columns

Change of compounding or calculation methods

Payments
o Fundamentals
o Unpaid payments
o Late or partial payments
o Grace period
o Additional payments
o Step payments
o Rate adjusted payments 
o Interest-only payments (and Column Fees)
o Fixed principal payments
o Changing one or multiple payments
o Lump sum payments / Prepayments
o Adding lines (payments, principal, fees, etc.)
o Payments (equal) recomputed to yield a balance = 0.00 or other amount

Changing the date of a payment

Deleting a line or lines

Adding or changing interest rates in a Payment schedule

Interest rate (equal) recomputed to yield a balance = 0.00 or other amount

Interest rate recomputed to adjust Line (period) Interest amount

Calculation method for "short" periods

Additional principal, fees, penalties, insurance and taxes

Total payments, interest, principal
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Introduction

To create a Payment schedule (amortization, payment, investment or collection table)(also known as "schedule"), enter
the appropriate data in the "Data" window and press on "Compute". See also Fundamental principles of operation and
Creating the first Record.

Once a regular schedule is created, it can be completely edited to include:

 Irregular payments
 Late payments 
 Missed payments 
 Additional or Compensatory payments 
 Lump sums
 Step payments (indexed by an amount or by a certain percentage) 
 Interest-only payments 
 Fixed or principal-only payments
 Payments specifically identified according to the source (check, cash, credit card, preautorized payments, etc.) 
 Recomputed equal payments to yield a balance = 0.00 or other amount x
 Recomputed uniform interest rate (ROI, IRR) to yield a balance = 0.00 or other amount 
 Additional principal (negative amount) and various types of additional principal
 Additional fees (negative amount) and fees paid 
 Insurance (negative amount) and insurance paid
 Taxes (negative amount) and tax paid
 Penalties (negative amount) and penalty paid
 Invoices (negative amount) and invoice paid
 Investments (negative amount)
 Principal, fees and other bearing interest or not
 Column Fees added automatically according to the Line status selected 
 Etc.

The Payment schedule columns, for which data can be changed, are identified with an asterisk (*).

Changes to a schedule may be done line by line, or many lines many at once (Shift of Ctrl  keys and left mouse click to
select the lines) with the very powerful right mouse click menu.

Any change made in the table will automatically recompute the interest, principal reimbursement and balance. No need
to press on any button.

See also: Line status, Payment schedule columns, Change of compounding or calculation methods, Payments.

   

Line status

In  a  Payment  schedule,  Margill  Loan  Manager  (MLM)  provides  each  line  with  a  Line  status.  Over  95  Line  statuses  are
available in MLM, thus allowing the user to obtain a precise detail of each transaction or line in a Payment schedule.
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General

Changing Line status from "Due Pmt" to "Paid Pmt" (or other type of payment type)

Changing Line status from "Due Pmt" to "Unpaid Pmt" (or other  type of custom unpaid payment type)

Line status name change, choice and order

Accounting data and Line status

Effect of Line status on Annual Percentage Rate (APR)

Normal payment history

General

When a payment history is properly detailed, it is thus possible to obtain, for any date, precise reports of outstanding and
delinquent payments, late or partial  payments, additional payments, fees, non sufficient funds (NSF) checks, additional
principal in a loan, etc. Line status also allows you to determine, usually for accounting purposes, the actual interest paid
versus accrued interest, as well as due interest, paid principal,  due principal and the balance for all  other Line statuses
(fees, tax, insurance, etc.). See also Payment schedule Columns and Accounting data and Line status.

Line  statuses  follow rigorous  data  integrity  constraints.  For  example,  a  payment  cannot  be  negative  and  a  Line  status
cannot be changed from "Due Pmt" to "Paid Pmt" if the previous line has the status "Due Pmt". Many other constraints
are imposed. See these conditions in the Data Integrity section.

The names  of over 60 of the 95 or so Line statuses can be changed in order to precisely describe the transactions and
isolate them for accounting purposes. The following Line status names can be changed:

 5 "Due payment"
 1 "Due payment - Unpaid"
 19 "Paid payment"
 9  "Unpaid  payment":  payment  that  was  NOT  paid  (the  names  should  match  the  corresponding  type  of  payments

"paid": for example "Paid - Visa" and "Unpaid - Visa")
 9 "Additional principal"
 6 fees charged
 6 fees paid (the names should match the corresponding type of fees charged: for example "Fees - Annual" and "Fees

Paid - Annual")
 2 "Interest charged"
 1 "Paid Principal"
 10 "Other" Line status. 

Examples: "Paid by check", "Paid PAP" (electronic funds transfer - EFT), "Paid Amex", "Unpaid - Amex", "Fees - Admin",
"Fees - Late", "Due pmt - CASH"...

When renaming a Line status that may be changed, be vigilant in maintaining their true status (or purpose) and use a
good thoughtful nomenclature. To avoid problems, only MLM Administrators can change Line statuses.

In conjunction with the Export accounting transactions to the General ledger module, this becomes a very powerful tool
to precisely export the type of payment (fee or other) to the proper General Ledger account.

Line statuses:
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Line status name Description Name may be
customized

 Due Pmt Default  status.  Payment  is  not  overdue  yet  but  should  be
coming on the indicated date.

 Due Pmt (2) to (5) These Line statuses can be renamed and customized.

Payment  is  not  yet  overdue  yet  but  should  be  paid  on  the
specified date.

Allows the user to indicate that a special due payment must be
collected.  For  example,  a  client  (not  a  very  good  payer),  who
usually  pays  by  pre-authorized  payments,  must  pay  his  next
payment by cash or by certified check.

See  how  useful  Due  Pmt  (2)  to  (5)  can  be  in  the  Unpaid
Payments section, "Working with the "Expec. Pmt" column
" sub-section.

Yes

 Due payment - Unpaid" "Due  Pmt  -  Unpaid"  is  a  special  Line  status  that  can  be
used when a  borrower notifies  the  creditor  that  he  will
not be able to meet a payment at a later date but will be
able to meet the next closer upcoming payment(s).

For  more  information  on  this  see  "Due  Payment"  Type
Line statuses

 Paid Pmt Full payment is paid on the required date.

 Paid Pmt (2) to (10) You  can  rename  and  customize  these  Line  statuses  (for
example, Paid Pmt Cash, Paid Pmt Visa, etc.). 

It  is  possible  to  isolate  principal,  interest,  APR  Fees  Financed
and Column Fees, for each "Payment" type Line status. See the
Accounting Data and Line status section.

Payment may be in full, partial, late or even partial and late. 

For  a  partial  payment,  it  is  suggested to  manually  change  the
"Expec.  Pmt"  column  to  obtain  the  right  data  for  the
outstanding amounts. 

For a late payment, it is suggested to manually change the "Pmt
Due Date" column to keep the original date of the payment. 

For a  late partial  payment,  it  is  suggested to  manually  change
the "Expec. Pmt" and "Pmt Due Date" columns.

Yes

 Paid Pmt (11) to (20) You  can  rename  and  customize  these  Line  statuses  (for
example, Paid Pmt Cash, Paid Pmt Visa, etc.).

Unlike the "Paid Pmt 1 to 10" Line statuses, it is not possible to
isolate  the  sub-components  for  each  of  these  payment  types:
principal, interest, APR Fees Financed and Column fees.

These  Line  statuses  do  not  have  their  corresponding
"Unpaid" Line status types.

Yes

 Paid Late Pmt Full payment but that is paid late.
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 Partial Pmt Partial payment but paid on time.

 Partial Late Pmt Partial payment that is also paid late.

 Paid Pmt Returned Check Payment that compensates a returned check.

 Add. Pmt Additional  payment  made at  any  time  when  no  payment  was
expected.

 Compensatory Pmt Compensatory  payment  made  at  any  time  when  no  payment
was expected.

Yes

IMPORTANT

The  above"Paid"  Line  statuses  have  an  important  effect  that  no  other  Line  statuses  have.  These
statuses have a direct effect on accounting matters - Interest Paid, Column Fees Paid, Principal Paid,
APR Fees financed Paid.

See "Payment"  type  Line  statuses,  "Principal"  type  Line  statuses  and  Accounting  data  and  Line  status
sections.

 Unpaid Pmt Unpaid payment thus = 0.00.

 Unpaid Pmt (2) to (10) Unpaid Pmt thus = 0.00.

By changing "Paid Pmt (X)" descriptions, it is suggested to have
the  equivalent  for  these  unpaid  payments  (eg,  Unpaid  Cash
Pmt,  Unpaid  Visa  Pmt  corresponding  to  the  examples  given
above).  Thus,  you  will  be  able  to  obtain,  for  accounting
purposes, the unpaid portion for this specific type of payment.

Yes

 Returned check Must be 0.00 since the check was returned. Fees or  a  Penalty
may be added on the same date by adding a line below (on the
same date if desired). 

Three new columns are available to enter: Check number, Date
of Returned Check, Date of Compensatory Payment.

New  module  available  to  manage  NSF  checks:  see  Tools  &
Settings > Tools > Tools Menu > Settings > Returned Checks 

 Fees, Fees 2 to 6 Fees  charged,  thus  a  negative  amount  (may  bear  interest  or
not).

The names of these Line statuses may be customized to make
them more descriptive (e.g. "Late Fees" or "Annual Fees").

See  also  Fees,  Insurance  and  Taxes  and  the  Automatically
adding fees, insurance and taxes and recomputation subsection
which  automatically  adds  fees  (insurance  or  taxes)  and
recomputes these as well as the balances.

Yes

 Fees Paid, Fees 2 Paid to  Fees
Paid 6

Fees  that  are  paid  (as  opposed  to  charged).  You  should  not
refund more fees than the Fees charged.

The  names  of  these  Line  statuses  may  be  customized  but
should correspond to its equivalent "Fees".

It is recommended to use Column Fees, which are much more

Yes
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efficient since they are automatically paid with Paid Payments,
without having to specify that they are actually "paid".

 Add. Princ. (Loan) Additional principal. Thus a negative amount. Particularly useful
for lines of credit or for a loan disbursed in instalments. 

May bear interest or not.

See the "Principal" Type Line statuses.

 Add. Princ. (2) to (10) Additional principal. Thus a negative amount.

The names of these Line statuses may be customized to make
them more descriptive (for example, additional principal other
than a normal loan).

May bear interest or not.

See the "Principal" Type Line statuses.

Yes

 Interest charged, Interest
charged (2)

Interest charged, a negative amount.

The name of these Line statuses can be customized so they are
more descriptive (for example, an interest charged of  another
type than a normal loan).

Useful  when  integrating  existing  loans  in  MLM  to  ensure  the
loan starts with the right interest balance.

The Margill  Team can create customized reports  for  you for  a
more in-depth and specialized use of this option.

Yes

 Interest Paid Payment  (positive  amount)  of  pure  interest  (no  Column  fees)
without the need of an interest balance.

Consult Payment schedule > Line status >  "Interest" Type Line
statuses. Several subtleties exist,  since paying in advance is  an
exception to the normal interest calculation rules.

 Paid Principal Payment of pure Principal and APR Fees Financed only

 Additional  option  for  pure  Principal  payment  or  Fees
Financed

Yes

 Rate Change Interest rate change.

Appears in red if not = 0.00.

 Invoice MLM can also manage invoices. This amount must be negative.
Multiple invoices are possible on one date (thus insert multiple
lines with the same date).

May bear interest or not.

If  an  Invoice  should  be  considered  as  accounting  principal  (as
opposed to mathematical principal),  it is suggested to use one
of  the  Additional  principal  type  Line  statuses  and  to  rename
this Line status as desired.

 Invoice Paid Paid invoice (positive amount).

 Withdrawal This is an increase in mathematical principal and thus must be
negative. 
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If  a  Withdrawal  should  be  considered  as  accounting  principal
(as  opposed to  mathematical  principal),  it  is  suggested  to  use
one  of  the  Additional  principal  type  Line  statuses  and  to
rename this Line status as desired.

 Insurance If insurance is charged, it may be entered with this Line status
as a negative amount. 

May bear interest or not.

See  also  Fees,  Insurance  and  Taxes  and  the  Automatically
adding fees, insurance and taxes and recomputation subsection
which  automatically  adds  fees  (insurance  or  taxes)  and
recomputes these as well as the balances.

 Insurance Paid Paid insurance (positive amount). You should not refund more
than the Insurance amount charged.

 Tax If  tax  is  charged,  it  may  be  entered  with  this  Line  status  as  a
negative amount.

May bear interest or not.

See  also  Fees,  Insurance  and  Taxes  and  the  Automatically
adding fees, insurance and taxes and recomputation subsection
which  automatically  adds  fees  (insurance  or  taxes)  and
recomputes these as well as the balances.

 Tax Paid Tax paid  (positive  amount).  You  should  not  refund more  than
the Tax amount charged.

 Penalty If a penalty is charged, it  may be entered with this Line status
as a negative amount.

May bear interest or not.

 Penalty Paid Paid  penalty  (positive  amount).  You  should  not  refund  more
than the Penalty amount charged.

 Investment These  should  be  used  only  for  investment  situations  as
opposed to  loan scenarios.  An investment increases the initial
investment. This amount must be negative.

 Investment - Withdrawal This is a decrease in the investment. Thus a withdrawal by the
investor.

 Adjustment This  can  be  a  positive  or  negative  amount.  Is  used  to  make
adjustments. Often used to enter a payment amount to reach a
certain balance at a point in time.

If  an Adjustment should be considered as accounting principal
(as opposed to mathematical principal),  it is thus suggested to
use one of the Additional principal type Line statuses (increase
in  principal)  or  a  Payment  type  Line  status  (decrease  in
principal) and to rename this Line status as desired.

 Information An extra line may be added anywhere in the payment schedule
to obtain, for example, the balance or any other information at
that particular date. The payment must be 0.00.

This  Line  status  usually  will  not  have  any  influence  on  the
accrued interest calculated but could have an effect in  certain
special cases since its insertion in the payment schedule could
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influence the reference periods and calculation methods.

 Information without impact This Line status was created in order to have no impact on the
accrued interest even in special calculations.

However,  in  very  specific  calculations,  when  the  Day  count  is
30/360,  the  way  the  periods  of  calculations  are  divided  could
have an influence on the Day count for the two periods created
thus modify the accrued interest calculated.

 Other 1 to 10 Ten  (10)  other  statuses  (Other  1,  2,  3...  10)  to  be  used  as
desired by the user.

The names of these Line statuses may be customized to easily
explain their exact purpose. See Warning below.

IMPORTANT: "Other" statuses should be used carefully and in a
consistent  manner.  These  lines  do  not  refund  accounting
principal and interest.

If  Other  should  be  considered  as  accounting  principal  (as
opposed to mathematical principal),  it is suggested to use one
of  the  Additional  principal  type  Line  statuses  (increase  in
principal) or a Payment type Line status (decrease in principal)
and to rename this Line status as desired.

Yes

 Not set When a new line is added in certain situations, in order not to
lead to illogical situations, MLM will not automatically assign a
"Due  Pmt"  or  "Add.  Principal  (Loan)"  Line  status  but  rather  a
"Not set" status. No lines should however remain with a  "Not
set" status.

"Not set" appears in red.

WARNING: Changing the  description of  a  Line status  has  no  effect  on  the  constraints  of  the  Line status,  nor  on  the
effect these have from an accounting perspective. When changing a name, be very careful to leave a descriptive word
such as "Payment" or "Fees" in order to avoid any confusion with other Line statuses. The "Other" Line statuses have
no effect on the accounting principal or interest. See Accounting Data and Line status.

By  default,  all  lines  (or  payments)  are  considered  Due  (outstanding)  unless  in  the  "Data"  window  the  "Payment"  is
negative  in  which  case  the  status  will  be  "Additional  principal".  It  is  thus  up  to  the  user  to  update  these  statuses  as
payments are received, late or unpaid when due.
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See also the Data Integrity section.

Changing Line status from "Due Pmt" to "Paid Pmt" (or other  type of custom payment type)

As mentioned above, when a Payment schedule is first calculated, most of the time, all lines will bear the "Due Pmt" Line
status (or any one among the five (5) "Due Pmt" type Line statuses). The schedule should be updated as payments are
made or not.

The  change  from "Due  Pmt"  to  a  "Paid  payment",  the  most  common  situation  for  normal  portfolios,  may  be  done  in
several ways:

1. Manually in the schedule, line by line. This is a long process that should usually not be done, unless a "Paid Pmt" is an
exception as opposed to the norm.

2. In a schedule by selecting (highlighting) the desired payment lines and using the shortcut:  "Ctrl  Alt  Shift  F12".  This
shortcut changes "Due Pmt" type Line statuses to any of the "Paid Pmt" type Line statuses. You could change all the
desired lines to a Line status with a custom name (Paid Pmt 2 to 20) like "Paid Pmt EFT" for example.

3. A much more efficient method is to update many Records at once through the Post Payments tool.  Please consult
the Payment update ("Post Payments") section in the Tools & Settings section).

4. If  Electronic Funds Transfers are used, the software will  automatically change the Line statuses from "Due Pmt" to
"Paid Pmt" or another custom name (determined by the Administrator), the day on which payments are payable.

See also the very important Fundamental principles of operation section and the "Payment" type Line statuses section.

Changing Line status from "Due Pmt" type to an "Unpaid Pmt" type

The  change  from  Due  Pmt  to  an  unpaid  payment  can  be  done  directly  in  the  schedule,  line  by  line  or  through  the
Payment update tool. 

Please consult the Payment update ("Post Payments") section in the Tools & Settings section.
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Line status name change, choice and order

It is possible to:

1. Change the names of several Line statuses.

2. Select only the Line statuses relevant to your needs, and thus eliminate, from the scroll menu, the Line statuses that
are not useful for you. Also, the choice is faster and the risk of error is reduced. This also allows the Administrator to
hide certain "obsolete" Line statuses even if they are used in the system ("Hide from menu" option).

3. Change the display order in the Line status scroll menu.

The  custom  changes  are  very  easy  to  make.  Go  to  Tools  >  Settings  >  System  settings  (Administrator)  >  Line  Payment
Statuses. The following window will appear:

This window allows the three operations above and displays some of the constraints of each Line status (columns with
). For more detail on all the constraints, see the Data Integrity section.

Explanations for the Line status settings window: 

 The Line status names in grey can not be changed. Only the names of the lines in black can be changed. 

To change a name, click on a black text and enter the desired name. In the example below, Line status "Paid Pmt (2)"
will be changed to "Paid Pmt Mastercard" (not completed in the image below).

Be careful not to enter an overly long name since the "Line status" column in the Payment schedule will be too wide
and take up too much prime screen space.
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The Line status names may be different in English and French. Upon running MLM in English, renaming a Line status
will only apply to the English version. Thus, the name change from "Paid Pmt (2) to "Paid Pmt Mastercard" will  be
displayed in English, but by running the French version of MLM, the Line status name will remain "Pmt fait (2)".

English version of the Payment schedule

French version of the Payment schedule

WARNING: Changing the  description of  a  Line status  has  no  effect  on  the  constraints  of  the  Line status,  nor  on  the
effect these have from an accounting perspective. When changing a name, be very careful to leave a descriptive word
such as "Payment" or "Fees" in order to avoid any confusion with other Line statuses. The "Other" Line statuses have
no effect on the accounting principal or interest. See Accounting Data and Line status.

 You may decide to display only a few Line statuses, thus providing a scroll menu in the Payment schedule which is
much shorter and with only the Line statuses relevant to your operations. Some Line statuses cannot be eliminated
as they are essential to the system (Due Pmt, Paid Pmt, Add. Princ. (Loan), Rate Change, Information, Information -
No impact and Not Set).

 If the "Hide from Menu" column is checked and the description is crossed out, this means the Line status is not used
anywhere. If column is checked but the description is not crossed out, this means the Line status is used somewhere

but  will  be  hidden  in  the  Payment  schedule  "Line  status"  menu  column.  The  "Check  if  used"
button  displays  the  "Used  in:"  column  that  shows  where  the  Line  status  is  used.  If  the  Line  status  is  used  in  the
Records and if it is necessary to know in which specific Record(s), go to Tools > Find specific Line Statuses in Records
in order to obtain the list of the Records in which the Line status is present.

 If the "Expected Pmt = 0" option is checked, the "Expected Pmt" column of the Payment schedule will be set to 0.00
for these Line statuses. This simplifies the calculation of outstanding amounts.

 If  the "Payment = 0" option,  available for  Line statuses "Other" 1 to 10,  is  checked, the  "Payment"  and  "Expected
Pmt" columns of the Payment schedule will be forced to 0.00 for these Line statuses. This can be useful particularly
in order to allow the entry of data in other columns of the Payment schedule without the risk of a Payment amount
being entered by error.

 To change the Line status display order in the Payment schedule menu, choose the Line status to prioritize (bring up)
or to lower by using the arrows to the right.
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In  the example below, if  I  rarely  use variable  interest  rates,  I  would  position the  "Rate Change" Line  status  at  the

bottom of the very table with the  arrow.

 

 The "Reset Line statuses"  button resets the Line status descriptions and
the  display  order  back  to  the  default  settings.  The  Line  status  names  will  also  be  changed  back  in  the  Payment
schedule.

 The  "Reinitialize  order"  option  simply  sets  the  default  order  back  to  the  original  order  but  keeps  the  Line  status
personalized Descriptions.

Accounting data and Line status

See the special section Accounting data and Line status.

Normal payment history

When a Line status is changed from the default setting (usually "Due Pmt") to one of the following statuses:

 "Unpaid payment", "Partial payment", "Partial late payment", "Returned check" or 
 Custom Line statuses "Paid Pmt (X)" and "Unpaid Pmt (X)",

the  amount  that  should  have  been  paid  (and  date  if  late  payment)  may  be  entered  to  determine  the  outstanding
amounts and the original payment dates. The outstanding amounts are also used to determine theAgeing of accounts.
 
For example, in a loan with payments of 1000.00, if the payment was not made, you should enter 0.00 for that payment.
When the Line status is changed to "Unpaid Pmt" and you click out of the status, the following window will appear with
the amount that should have been paid. This amount may be changed if required. The number and amounts of unpaid
payments, partial payments, and returned checks may then be obtained in the reports.   
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If a payment is late, MLM will ask, for reporting purposes, to enter the date at which the normal payment should  have
been made as well as the date at which the payment was actually paid.

See also Partial or Late payments

When  a  variable  interest  rate  table  is  used  for  a  calculation,  for  lines  with  a  change  of  interest  rate,  Line  status  is
automatically set to "Rate Chg" (Rate change) unless a payment is made on that specific date (Payment greater or less
than 0.00). If a payment other than 0.00 is made on that date, Line status will usually be "Due Pmt" (if positive payment)
or "Add. Princ. (Loan)" (if negative payment).

Effect of Line status on Annual Percentage Rate (APR)

IMPORTANT FOR APR CALCULATIONS: Changing the status of a line to a fee (or adding a new fee line) will not affect the
APR  as  desired,  since  the  MLM  calculation  engine  does  not,  except  for  some  accounting  data,  process  the  fees  any
differently  from  other  lines.  The  engine  processes  the  fees,  represented  by  a  negative  amount,  as  additional
mathematical principal thus actually lowering the APR.

To properly compute the new APR, see the Annual Percentage Rate (APR) section, Additional fees subsection.

See also Alerts, Line status Alerts, Find specific Line statuses in Records

   

"Due Payment" type Line statuses

By default, Payment schedules are created with the "Due Pmt" Line status. It indicates to the system and to the user that
payments  of  a  certain  amount  are  expected on  specific  dates.  These payments  are  theoretical  because  the  real  world
shows that Borrowers often do not pay as they should.
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Margill Loan Manager (MLM) allows six "Due Pmt" type Line statuses:

 Due Pmt (Default Line status for positive payments)
 Due Pmt (2) to (5) (names can be changed)
 Due payment - Unpaid payment (special type)

 

Due Pmt 2 to 5 Line statuses could be used to isolate special payments that are due. For example, a normal payment, Due
Pmt, is not paid by the Borrower. The Borrower and the Creditor agree that a compensatory cash payment will be made
in 25 days. Thus, this new payment will be inserted in the Payment schedule but with the Line status "Due Pmt - Cash" in
order to isolate it from normal payments. The Expected Payment ("Expec. Pmt") column should also be changed to 0.00
by the user since this payment is additional, not expected in the "normal" Payment schedule.

In order to be allowed to change the Expec. Pmt column, this must be authorized by the Administrator in Tools > Settings
> System Settings (Administrator) > General > Allow to change...

 

A "Due Pmt - Unpaid" is a special Line status that can be used when a borrower notifies the creditor that he will not be
able to meet a payment at a later date but will be able to meet the next closer upcoming payment(s).

 For  example,  we  are  on  June  15  and  the  borrower  informs  the  creditor  that  the  August  1  payment  can  not  be
respected (end of employment for example) but that the funds will be available for the July 1 payment.

 Ordinarily, upon learning this, we would like to change this "Due Pmt" to a "Unpaid Pmt" but since this Line status is
not allowed after a "Due Pmt" (only before, chronologically), the special Line status "Due Pmt - Unpaid" resolves the
issue since allowed after a "Due Pmt".
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 However, in order to avoid logical chronological problems, since "Due Pmt - Unpaid" ("Due Pmt" type Line status) is
not  allowed  before  a  "managed"  payment  ("Due  Pmt"  changed  to  "Paid  Pmt",  "Unpaid  Pmt",  etc.),  it  must  be
changed to one of the "Unpaid" Line statuses on the scheduled date of non-payment. In Tools > Settings > Automatic
/  Overnight  tasks,  an  automatic  task  allows  you  to  specify  to  which  Line  status  the  "Due  Pmt  -  Unpaid"  will  be
changed on  the  scheduled date,  automatically.  IMPORTANT: the  software must  have  been  closed  and  opened  for
this to occur.

o In  the  example  below,  the  "Due  Pmt  -  Unpaid"  Line  status  will  automatically  be  changed,  at  the  right
payment date ("Pmt Date" column) to "Unpaid Pmt 

o The  change  can  only  take  place  if  no  "Due  Pmt"  is  present  before  this  payment.  If  such  a  Line  status  is
present, a warning will appear in the Main window (!).

 Other notes:

o The amount entered in the "Payment" column for this Line status must = 0.00.
o Once the payment is managed, the usual conditions for this Line status will apply such as automatic fees.
o The amount in the "Expec. Pmt" column will ordinarily be the payment originally scheduled and thus should

automatically increase the outstanding amount. 

See Allow to change the "Expected Payment" amount when Line status is "Due Payment".

"Due Pmt" type when creating the Payment schedule

When creating the Payment schedule,  an option allows the user to specify the  default  "Due Pmt"  to  be  included.  This
allows,  for  example,  to  differentiate  whether  the  normal  payments  for  this  loan  are  to  be  paid  by  Electronic  Funds
Transfer (EFT), by check or in cash.

When creating the loan, the "Due Pmt" can be selected with the following option in the "Data" window:
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The Payment schedule is then created:

If the Electronic Funds Transfer payments (EFT) module is used, the Margill Administrator can decide to exclude certain
payments from these EFT. For example, by checking the box under "Do not include this Due Pmt when submitting EFT",
the "Due Pmt - Cash" (and Due Pmt 5) will not be displayed nor sent when submitting the EFT.
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Batch change of "Due Pmt" type Line statuses in the Payment schedule 

Sometimes,  a  user  might  want  to  modify  the  "Due  Pmt"  Line  statuses  to  another  "Due  Pmt"  type  once  the  Payment
schedule is created. The "CTRL-ALT-SHIFT-F11" shortcut allows you to do this in bulk instead of line by line.

Choose the lines to be modified followed by CTRL-ALT-SHIFT-F11. In the following example, the "Due Pmt" lines and one
"Non Set" will all be modified to "Due Pmt - Cash".

Please  note  that,  for  security  reasons,  "Payment"  Line  statuses  cannot  be  changed  in  batch  back  to  "Due  Pmt"  type
status.

For more information, see "Payment" Type Line statuses, Unpaid Payments and Additional Payments.

   

"Payment" type Line statuses
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Of  all  the  Line  statuses  available  in  Margill  Loan  Manager  (MLM),  the  "Payment"  type  Line  statuses  distinguish
themselves since they are the only ones that refund, for accounting purposes, interest, principal (pure princiapl and Fees
financed (APR)) and Column fees (as opposed to fees added as lines - see example below). Their presence also influences
many computed fields in the reports.

Note: In order to lighten the text, we use "I+P+FFA+CF" to name the four components that are normally reimbursed by
the "Payment" type Line status:

I = Interest
P = Principal
FFA = Fees financed APR
CF = Column Fees

"Payment" type Line statuses:

 Paid Pmt
 Paid Late Pmt
 Partial Pmt
 Partial Late Pmt
 Paid Pmt Returned Check
 Add. Pmt
 Compensatory Pmt*
 Paid Pmt (2)* to Paid Pmt (10)*
 Paid Pmt (11x)** to Paid Pmt (20x)**
 Interest Paid ***
 Interest Paid (2) to (4) * and ***
 Principal Paid ****
 Principal Paid (2) to (4) * and ****

* Line status names that can be customized.

** Line status names that can be customized and only include, for the reports, the amounts per se. The reporting fields
that subdivide Interest, Principal, Column fees and APR Fees financed portions are not included.

*** Allows to pay the interest in advance without the need for an interest balance.

 "Due interest balance" can become negative.

**** Allows to pay pure Principal only and/or APR Fees financed.

The  "Payment"  type  of  Line  status  (which  reimburse  I+P+FFA+CF)  should  not  be  confused  with  "Paid  Fees"  type  Line
statuses which reimburse only their equivalent in Fees charged by Line status. In the example below, line 3 "Fees Paid"
does  not  refund  interest  ("Paid  Interest"  column)  nor  Principal  ("Paid  Principal"  column).  The  "Balance  Due  Principal"
column thus remains at 100,000.

The "Paid Pmt" on line 5 of 500, refunds 500 in interest ("Paid Interest" column), but since the due interest ("Balance Due
Interest" column) is more than 500, no principal is be paid since interest is normally paid before principal (exceptions can
be configured in MLM - see "Interest" Type Line statuses and the Interest-only payments section, Interest-only Payment
Adjustment - Simple Interest subsection).

Only  the  payment  on  line  6  pays  all  the  due  interest  plus  an  amount  of  principal.  Thus,  the  "Balance  Due  Principal"
column decreases by 142.07 since that principal amount is paid back. 
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Regardless of  the  Line  status,  the  "Mathematical  Principal"  column includes  an  amount  (positive or  negative),  but  this
amount is mathematical principal, not accounting principal. The "Interest" column represents the accrued interest from
the previous line only to this line.

You can rename multiple Line statuses. The simple fact of renaming a Line status that is not a Payment type Line status
(for example renaming "Other 1" to "Paid Payment XYZ") does not change its behavior. 

Other "Payment" type Line statuses, but for which the payment MUST be = 0.00 are the "Unpaid" types:

 Unpaid Pmt
 Returned check
 Unpaid Pmt (2)* to Unpaid Pmt (10)*

* Line status names that can be customized and should correspond to their counterpart "Paid Pmt (X)".

When a  payment  SHOULD have been made but  was not,  select  the  "Unpaid  Pmt"  corresponding  to  the  payment  that
should have been made (eg, "Unpaid Pmt - Visa" corresponds to the "Paid Pmt - Visa" Line status). This is critical for many
reasons:

 so that the data collected for accounting purposes, may be entered in the General ledger
 to establish the Outstanding amounts
 to determine the Ageing of accounts
 to calculate the required Credit Report codes

"Unpaid Pmt" Line statuses will also indicate to the system that a payment should have been made, thus calculating the
"due" interest as opposed to "accrued" interest. Interest is considered "due" when a payment was due but was not paid
or  when  a  partial  payment  pays  only  a  portion  of  accrued  interest  for  the  period.  This  important  accounting  field  is
calculated and is available in Record List report, Document Merge (Letters, Contracts, Invoices and Statements) and for
exporting transactions to the General ledger.

For accounting purposes, it is possible to isolate PAID amounts for Column Fees (1 to 6), interest, principal and the Fees
financed (APR) (pro-rated) in the reports for all "Payment" type Line status (of which those whose name can be changed).
 

See also Accounting data and Line status and the definitions of accounting principal and mathematical principal.

Refund exclusivity and priorities

By  default,  if  Column  Fees  are  present,  they  will  be  "paid"  (or  refunded)  with  "Payment"  type  Line  statuses  before
interest  and  before  principal.  The  normal  reimbursement  order  for  Column  Fees  is  as  follows:  Column  Fees  1  (as
renamed), Column Fees 2, 3, 4, 5 and finally 6.
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Also, if APR Fees Financed are present, these "fees" (which are considered in Margill to be of "Principal" type since they
are part of the amount financed) will be paid on a pro-rated basis of the total paid principal.

Exceptions to these rules are however possible with the "Paid Interest" and "Paid Principal" Line statuses  and even for
the Column Fees priority, with the "normal" "Payment" type Line statuses.

"Paid Interest" Line status 

 The "Paid Interest" Line statuses (4 in all, 3 of which the names can be personalized) will only pay interest, nothing
else. 

 See the important Interest paid in advance section.

"Paid Principal" Line status 

 The "Paid Principal" Line statuses (4 in all,  3 of which the names can be personalized) will  only  pay Principal  (pure
accounting Principal and APR Fees financed) with the possibility of only paying the pure accounting Principal  or  to
pay,  in  priority,  the  APR  Fees  financed.  These  Line  statuses  thus  allow  the  user  to  choose  between  three  refund
options.

In  the  payment  schedule,  for  the  "Paid  Principal"  type  Line  statuses,  right  click  with  the  mouse.  Under  "Paid
Principal", three options are available:

The default option is: "Pure Principal + APR Fees Financed". This means that the amount in the "Payment" column
will be allocated on a pro-rated basis to pure Principal and APR Fees financed. Here are simple examples to illustrate
this:  if  the  amount  financed is  9000,  the  APR  Fees  financed  are  1000  and  an  amount  of  1000  is  paid  in  principal,
900.00 will reimburse pure Principal and 100.00 will reimburse APR Fees financed.

If the "Pure Principal" option is chosen, the amount of 1000 becomes green which means the default option is not
used. The amount is allocated 100% to the reimbursement of pure accounting Principal.
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If  the  amount  in  the  "Payment"  column  excess  the  due  "pure"  Principal,  the  extra  amount  will  not  be  used  to
reimburse  the  balance  of  the  APR  Fees  financed.   The  extra  amount  will  then  be  allocated  to  the  "Balance  Due
Principal" which will become negative.

Finally, if  the "APR Fees Financed" option is  chosen, the amount of  1000 becomes green which means the default
option is not used. The amount is allocated in priority to reimburse the APR Fees financed.

If  the  amount  in  the  "Payment"  column  exceeds  the  Balance  Fees  Financed  (APR),  the  extra  amount  is  used  to
reimburse the pure Principal because APR Fees Financed is not allowed to have a negative balance. This third option
is thus a priority for reimbursement, not an exclusivity as is the case in option 2 above.

See also Fees paid up-front, Financed or Paid subsequently

Column Fees payment order with exceptional priority

 The normal refund order for  Column Fees is  as  follows:   Column Fees 1  (as  renamed),  Column Fees 2,  3,  4,  5  and
finally 6. However, a "Payment" type Line status offers, with the right mouse click, the option to change this order: 

In the following example, Column Fees 1 (renamed "Other Fees") would be paid in priority, followed by Column Fees
2 (renamed Returned Check (Auto)), and so on. This is the default order. However, with the choice in blue, Column
Fees 3 (renamed GST) would be paid in priority, before Column Fees 1 and 2.  If  the payment amount exceeds the
balance in  Column Fees 3,  this  extra amount would then pay Column Fees 1,  followed by  Column Fees 2,  Column
Fees 4, Column Fees 5, Column Fees 6 Interest and finally the Principal.
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The user can change the priority of the first Column fees to be paid, but the normal order is always applied after. This
normal order can only be modified by the methods explained in this section and with option 3 of Principal payments
(Principal payment only).

A larger payment on a particular date could also be subdivided into several payment lines in order to assign specific
amounts to the various Column Fees, Interest and Principal. In the following example, the October 20, 2019 payment
for a total of 1625 (split in 3 payments) pays 500 in Principal (and APR Fees financed), followed by interest 125 and
1000 will  be used to pay the Column Fees 4,  followed by the Column Fees 1,  2,  3,  5  and  6  if  applicable  (and if  all
Column Fees and interest are paid, Principal will be refunded - this can become very complex if you wish!).

See also the following sections: "Principal" Type Line  statuses,  "Interest"  Type Line  statuses,  Accounting Data  and  Line
status and also Refund order for Interest, Fees and Principal of the Calculation Methods chapter.

   

"Principal" type Line statuses

Among  the  Line  statuses  that  allow  negative  payments  (Fees,  Insurance,  Taxes,  Invoice,  Withdrawal,  Investment,
Adjustment,  Interest  charged,  Other,  Undefined  and  the  10  "Additional  principal"),  the  "Additional  Principal"  Line
statuses differ because only these add pure, accounting principal. Their presence also affects several calculated fields in
the reports.

In  the  example  below  (no  interest  to  simplify),  the  250.00  charged  as  Fees  influence  the  "Principal"  column  that  is
mathematical principal and also the balance of the loan. The fees, however, don't add any amount in column "Balance
Due Principal" which remains at 4712.70.

However, the following line "Add. Princ. (loan)" (3000.00) increases the "Balance Due Principal" to 7712.70.
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Margill Loan Manager (MLM) contains ten (10) Additional Principal Line statuses including nine (9) of which names can be
customized:

and 7 to 10...

This way, you can identify the specific types of "investments" within the loan.

You can rename multiple Line statuses. Simply renaming a Line status that is not "Principal" type, for example "Other",
to "Principal second payment" does not change its behavior.

See also Accounting data and Line status and the definitions for accounting principal and mathematical principal.

"Paid Principal" type Line statuses

These Line statuses make it possible to pay Principal (pure accounting Principal and/or APR Fees financed - pro rated).

See instructions in the "Payment" type Line statuses section, under "Paid Principal" Line status.

   

"Interest" type Line statuses

Two "Interest" Type Line statuses are available in Margill Loan Manager (MLM):

1) Interest Charged (2 of these)
2) Interest Paid (5 of these)

1) "Interest Charged" type Line statuses 

Among  the  Line  statuses  that  allow  negative  payments  (Fees,  Insurance,  Taxes,  Invoice,  Withdrawal,  Investment,
Adjustment, Others, Undefined and the 10 "Additional principal"), the two (2) "Interest Charged" Line statuses stand out
because only these will add "accrued" interest.

The  name  of  these  two  Line  statuses  can  be  changed  in  order  to  identify  and  to  report,  in  complex  situations,  the
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"artificially" added interest.

Adding interest manually should be an exception since usually, accrued interest should be computed automatically taking
into  account  the  balance,  the  interest  rate  and  the  time factor.  We  often  see  additional  interest  in  order  to  make  an
adjustment,  especially  at  the  start  of  a  existing  loan  imported  into  MLM  without  the  full  transactional  history.  See
Integrating Existing Loans.

Some advanced users, in more complex calculations, will add interest with these Line statuses when the balance of the
loan becomes negative, therefore generating negative interest.  Manually  adding  positive interest  compensates for  this
negative interest which, for example, should not be accumulated. Often, special custom reports must be created by the
Margill team to account for these exceptional situations. 

An "Interest Charged" Line status must be entered as a negative amount in the "Payment" Line status and this amount
will also be displayed in the "Accrued Interest" column.

Normal accrued interest of 1047.62 between 2021-01-01 and 2021-02-01 without
adding any additional interest

Accrued interest of 1047.62 between 2021-01-01 and 2021-02-01 
plus 500.00 in additional interest for a total of 1547.62 in accrued interest. 

2) "Interest Paid" Line statuses

The "Interest Paid" Line statuses, four (4) of which the name can be adapted, will only pay interest, without paying the
Column Fees.  In  addition,  these  Line  statuses  will  pay  the  desired  amount  of  interest  even  if  the  accumulated  or  due
interest balance is less than the amount entered. The interest balance can thus be negative.

For more detail and important subtleties, see the Interest Paid in Advance section in the How to do... chapter.

   

Accounting Data and Line status

Line  status  also  allows  you  to  determine,  usually  for  accounting  purposes,  the  actual  interest  paid  versus  accrued
interest, as well as due interest, paid principal,  due principal  and the balance due for all  other Line statuses (fees, tax,
insurance, etc.). This information is contained in the Payment schedule columns and is available in the Record List report
and when Exporting to the General ledger.
 
Only  true  payments  will  pay  off  interest  or  principal.  Fees,  insurance  and  all  other  "non  payment"  Line  statuses  will
reduce  the  total  balance  (mathematical)  but  not  the  true  principal  (accounting  principal).  See  "Payment"  Type  Line
statuses and "Principal" Type Line statuses.

In the example below, please note that some columns were hidden in order to properly see only the pertinent columns. 
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For the first payment with Line status "Due Pmt", the "Paid Interest" and "Paid Principal" columns are at 0.00. 

Only when Line status is changed to "Paid Pmt" (or other "Paid" status) do the "Paid interest" and "Paid Principal" change
as seen below:

If only a partial payment is made, on the second line, outstanding interest will first be paid off followed by the principal if
the payment is  sufficient.  In  the example below, the  partial  payment  of  200.00 will  first  pay  off  200.00 in  outstanding
interest  and  the  193.91 in  outstanding interest  will  go  to  the  "Due Interest"  and  "Balance  Due  Interest"  columns.  The
"Paid Principal" and "Balance Due Principal" columns will remain unchanged for accounting purposes although the loan
balance (sixth column in this example) does increase by the unpaid interest amount.

Now if fees are charged (25.00) and 15.00 is paid off 5  days later (date column is  hidden here),  this  will  not  affect the
"Paid Interest" nor the "Paid Principal" columns, but will affect the last column, "Balance all others". This will also affect
the  loan  balance  (sixth  column).  The  fourth  column  ("Principal")(mathematical  principal  as  opposed  to  accounting
principal) is adjusted no matter what Line status is chosen since the "Principal" column takes into account the payment
amount (positive, negative or 0.00) and the accrued interest.

Below is a summary of the rules applied:
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Line status name Rule

 Due Pmt
 Due Pmt (2) to (5)

Since the amount will become due and thus is not yet paid, no effect
on "Paid Interest" and "Paid Principal". 

 Paid Pmt, Paid Late Pmt,
Partial Pmt, Partial Late Pmt,
Paid Pmt Returned Check, Add.
Pmt

 Paid Pmt (2) to (20)

Will  first  reduce  the  interest  due  then  reduce  the  principal  due  if
payment is sufficient to refund all outstanding and current interest.

If Column Fees are present, they are paid before the accrued interest.

 Unpaid Pmt, Returned check
 Unpaid Pmt (2) to (10)

Is always  be 0.00 thus will  increase the "Due Interest" and "Balance
Due Interest" columns.

 Add. Princ. (Loan)
 Add. Princ. (2) to (10)

Will increase "Balance" and "Balance Due Principal" columns.

 All Fees, Insurance, Taxes,
Penalties, Invoice, Withdrawal

Will increase the "Balance" and "Balance all others" columns.

 All Paid Fees, Insurance, Taxes,
Penalties, Invoice, Withdrawal

Will decrease the "Balance" and the "Balance all others" columns.

 Adjustment, Information,
Other (1 to 10), Not Set, Rate
Change

Will increase or decrease the "Balance" and the "Balance all others"
columns (respectively, if payment is negative or  positive).

Have no effect if payment is 0.00.

We  strongly  suggest  that  you  only  use  these  Line  statuses  to  add
other  information  in  the  Payment  schedule  (Column  Fees,  data  in
one of the nine informational type columns, etc.) and therefore that
the  payment  always  be  0.00  (an  option  in  Settings  >  Payment  Line
statuses allows to force the Payment to 0.00).

For accounting purposes, it is possible to isolate PAID amounts for Column Fees (1 to 6), interest, principal and the APR
principal (pro-rated) in the reports for all "Payment" type Line status (of which those whose name can be changed). See
Reports > Personalized Reports > Reporting Fields > APR, Fees, Interest and Principal.

For example, the "Paid Pmt 5" Line status is renamed "Bad Debt". This Payment type Line status, will pay the Column fees
balance, followed by the Interest balance and then the Principal balance, and generally, it will give a balance of 0.00 (the
complete balance on a determined date becomes a bad debt).  You can then use these different fields in the reports in
order to isolate the non cash payment from the real cash payments.

In the following example, the lines 1 to 6 are cash payments while line 10 is a Bad Debt (non cash).
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In  the  reports,  we  can  isolate  for  the  month  of  April  2021,  the  losses  in  Column  Fees,  in  Interest  and  in  Principal  by
choosing the corresponding Line status types:

Report of losses for the month of April 2021 (our example, Record 1447): 

  
75.00+3851.18 + 353 978.30 = Payment of 357 979.48

Please note that we can not isolate these data for the "Paid Pmt 11 to 20" Line statuses.
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See Reports > Personalized Reports > Reporting Fields > Principal, Fees, Interest and APR sub-sections. 

See also "Payment" Type Line statuses and "Principal" Type Line statuses and Accounting Data in the Reports section.

   

Data Integrity

Margill Loan Manager (MLM) has a data integrity component to verify if the Line status is correctly associated with the
corresponding positive or negative payment and if the status follows a logical order. For example, an "Add. Princ." Line
status can only be a negative amount and a Line status cannot be changed from "Due Pmt" to "Paid Pmt" if the status of
the preceding line is "Due Pmt".

All data integrity constraints are explained below: When the word "Must" is used under normal conditions, the system
prohibits the unauthorized condition. When the word "Should" is used, the system will  inform you of what you should
do, however, there is always a way around this condition in order not to add too much burden to the user.

Line status name Rule

 Due Pmt
 Due Pmt (2) to (5)

Must be positive or = 0.00.  

Cannot be before:

 Any "Paid" type payments. A "Paid" payment includes the following six
(6)  Line  statuses:  "Paid  Pmt",  "Paid  Late  Pmt",  "Partial  Pmt",  "Partial
Late  Pmt",  "Returned  Check  Paid  Pmt",  "Add.  Pmt",  "Compensatory
Pmt", the nineteen (19) other Line statuses "Paid Pmt (2) to (20)" whose
names can be changed, as well as "Interest Paid" and "Paid Principal".

 "Unpaid Pmt", "Returned check".
 Payments of fees, penalties, invoices, insurance and taxes.   
 "Investment - Withdrawal".

 Unpaid Pmt Must be 0.00.

Cannot be after a "Due Pmt".

 Returned check Must be 0.00.

Cannot be after a "Due Pmt".

 Unpaid Pmt (2) to (10) Must be 0.00.

Should be the counterpart of the "Paid Pmt" Line statuses whose name can
be modified. For example, if the name of "Paid Pmt (1)" is renamed "Paid Pmt
Visa", the counterpart of unpaid should be "Unpaid Pmt Visa".

Cannot be after a "Due Pmt".

 Paid Pmt Must be positive or = 0.00.

Should be equal to or greater than the amount entered in the "Due Pmt" Line
status. Should also be on the same date or before the date entered when the
Line status was "Due Pmt".
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Cannot be after a "Due Pmt".

 Paid Late Pmt Must be positive or = 0.00.

Should be the same amount as of when Line status was "Due Pmt".

Should  not  be  the  same  date  that  was  originally  entered  (when  the  Line
status was "Due Pmt").

Cannot be after a "Due Pmt".

  Partial Pmt Must be positive or = 0.00.

Should be the same date as of when Line status was "Due Pmt".

Should not be the same amount that was originally  entered (when the Line
status was "Due Pmt").

Cannot be after a "Due Pmt".

 Partial Late Pmt Must be positive or = 0.00.

Should not be the amount originally entered (when the Line status was "Due
Pmt"). 

Should  not  be  the  same  date  that  was  originally  entered  (when  the  Line
status was "Due Pmt").

Cannot be after a "Due Pmt".

 Returned check Paid Pmt Must be positive or = 0.00.

Should ideally be the counterpart of "Returned Check".

Cannot be after a "Due Pmt".

 Add. Pmt
 Compensatory Pmt

Must be positive or = 0.00.

Cannot be after a "Due Pmt".

 Paid Pmt (2) to (10) Must be positive or = 0.00.

Can be a complete, partial and/or late payment.

Cannot be after a "Due Pmt".

 Paid Pmt (11) to (20) Must be positive or = 0.00.

Can be a complete, partial and/or late payment.

Cannot be after a "Due Pmt".

Unlike the Line statuses "Paid Pmt 2  to  10",  it  is  not  possible to  isolate the
Principal, the Interest, the APR Fees financed and Column Fees for each type
of Line status.

These Line statuses  do  not  have  their  counterparts  in  the  "Unpaid"  type  of
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Line statuses.

 Interest Paid (5 in all) Must be positive or = 0.00.

Can be a complete, partial and/or late payment. 

Cannot be after a "Due Pmt".

 Paid Principal (5 in all) Must be positive or = 0.00.

Can be a complete, partial and/or late payment. 

Cannot be after a "Due Pmt".

 Rate Change Should be = 0.00 but if positive or negative, will be indicated in red to display
the problem.

 Fees 1 to 6 Must be negative or = 0.00.

 Fees Paid 1 to 6 Must be positive or = 0.00. 

Should  not  be  greater  than  the  corresponding "Fees"  (charged)  amount.   If
greater,  the  Line  status  will  be  displayed  in  red  to  indicate  a  potential
problem.

Cannot be after a "Due Pmt".

 Add. Princ. (Loan) Must be negative or = 0.00.

 Add. Princ. (2) to (10) Must be negative or = 0.00.

 Invoice Must be negative or = 0.00.

 Invoice Paid Must be positive or = 0.00.

Should not be greater than the corresponding "Invoice" (charged) amount.  If
greater, the Line status will display in red to indicate a potential problem.

Cannot be after a "Due Pmt".

 Interest Charged
 Interest Charged (2)

Must be positive or = 0.00.

 Returned check Must be 0.00.

 Withdrawal Must be negative or = 0.00.

 Insurance Must be negative or = 0.00.

 Insurance Paid Must be positive or = 0.00.
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Should not be greater than the corresponding "Insurance" (charged) amount.
 If greater, the Line status will display in red to indicate a potential problem.

Cannot be after a "Due Pmt".

 Tax Must be negative or = 0.00.

 Tax Paid Must be positive or = 0.00.

Should  not  be  greater  than  the  corresponding  "Tax"  (charged)  amount.   If
greater, the Line status will display in red to indicate a potential problem.

Cannot be after a "Due Pmt".

 Penalty Must be negative or = 0.00.

 Penalty Paid Must be positive or = 0.00.

Should not be greater than the corresponding "Penalty" (charged) amount.  If
greater, the Line status will display in red to indicate a potential problem.

Cannot be after a "Due Pmt".

 Investment Must be negative or = 0.00.

 Investment - Withdrawal Must be positive or = 0.00.

Cannot be after a "Due Pmt".

 Adjustment No constraints.

 Information
 Information - No Impact

Can only be 0.00 since this Line status is for information purposes only.

 Other 1 to 10 No constraints.

 Not Set No constraints.

Should never be used or present.

This is the default Line status when system cannot determine the proper Line
status.

The "Line status Settings" window (Tools > Settings > System Settings (Administrators) > Line Payment Statuses) displays
the different Line status constraints.  

Changing payment amounts (positive, negative) in the payment schedule 

If a 0.00 or positive payment is changed to a negative payment, the Line status will usually change to "Add. Princ. (Loan)".
This can later be changed to other Line statuses such as Fees, Penalties or other appropriate Line statuses.
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If several lines are changed at the same time with positive payments, the Line statuses will be either "Due Pmt" or "Not
Set", depending on their original Line status. The "Not Set" Line status should be changed afterwards.

The following Shortcuts can be useful to quickly change several Line statuses at once: 

 Ctrl Alt Shift  F11 - Changes the selected lines to "Due Pmt" or to any of the "Due Pmt (2) to (5)" Line statuses.  
 Alt X - Selects all the "Due Pmt" lines (and "Due Pmt (2) to (5)"). 
 Ctrl Alt Shift F12 - Changes the selected "Due Pmt" (and "Due Pmt (2) to (5)") to "Paid Pmt" or to any of the "Paid

Pmt 2 to 20" Line statuses.

Here are, in general, the Line status changes when changing payment sign:

Sign of original payment Sign of new payment New Line status

+ or 0.00  - "Add. Princ. (Loan)" or "Not set"

- or 0.00 +  "Not set" or "Due Pmt" 

+ 0.00 "Information" or "Not set"

- 0.00 "Information"

See the Check for Data Irregularities section which explores the tools available to eliminate data integrity issues. 

   

Line Comment

Line comments may be  added for  all  lines  in  a  Payment  schedule.  Because  of  constraints  in  the  printed  report  space,
comments may not exceed 100 characters (and spaces). 

If you do not see the comment at the far right of the Payment schedule window, scroll to the right with the scroll bar.
This may happen if the "Start Date" column is included in the Payment schedule as seen below:

By default however, the "Start Date" column is not included (to include, see "Payment schedule columns") thus in the
default settings, we can see the "Comment" column.
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Line comments may also be added in "batch" through the "Payment Update" tool.

See also Alerts and in particular Record Alerts, specific lines.

Comments can be extracted by the Transaction Report or by the Special Events Report.

   

Line Color

Colors can be added to the lines in the Payment schedule in order to place emphasis on certain lines of the loan. To do
so, select the desired lines, right mouse click and choose "Line Color".
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Colors can be eliminated with the "Remove Color" option.

The line colors will also be visible in the Payment Update "Post payment" tool.

   

Payment schedule columns

By default, a Payment schedule includes over 60 columns described in the table below. These may be viewed with the
horizontal scroll bar.  

Totals of monetary data columns are entered at the bottom of the Payment schedule.
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Columns: hide, show, move, lock widen and narrow

The  columns  can  be  hidden,  widened  or  narrowed,  moved  and  locked  in  order  to  see  only  data  pertinent  to  your
operations. Once you set up an order and column widths, these preferences will be saved for your next calculation and
upon your next use of MLM.

A more efficient method is available instead of manually moving columns and hiding them with the right mouse click.  

Click on the icon on the lower right corner of the Payment schedule. A table will appear in which you can select

the columns to display or hide, using the  and  arrows and place them in the order you wish with the following
arrows:
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You can also freeze the left columns you wish to keep visible when scrolling horizontally by clicking on the lock . In
the  example  above,  the  grayed-out  choices:  "Line"  (always  visible  by  default  and  always  frozen),  "Line  status",  "Pmt
Date", "Payment" and "Rate" will always be visible on the left when navigating to the right in the Payment schedule.  It is

possible to unlock columns by placing the mouse over a grayed-out column header name and clicking on .

It is recommended to click on "Save as default" (bottom left) in order to keep your choices for the long term and then by
clicking on "Save", your changes will become effective for all of your Records. Refresh time can be up to 30 seconds or
more.

If you wish to temporarily change the column display order, make your changes without choosing "Save as default" and
then click on "Save". The "Restore Default" link will allow you to return to your normal default configuration.

Methods described below also remain available but are often slower and less permanent:

To change column order, click on the heading of the column (and keep pressing on the mouse key) to drag the column to
the desired location.

To hide a column, right click on the header and under "Select column" uncheck the column(s) to hide.  In  the example
below, the "Comment" column will be hidden.

To  widen  or  narrow  a  column,  click  on  the  light  grey  line  separating  columns  and  keep  the  left  button  of  the  mouse
pressed.

Columns and Descriptions

Column name Description

 Line Line number.

 Line status Multiple  Line  statuses  are  included.  The  Line  status  should  reflect  the  true  payment
history.  By  default,  lines  will  have  the  "Due  Pmt"  status.  Only  change  this  to  another
status when the payment has been made, is late, is unpaid, or when other amounts are
added over time: additional principal, fees, insurance, taxes, etc.
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Line  status  will  have  an  effect  on  accounting  data  (see  the  "Other  columns"  section
below) and are subject to some Data integrity constraints.

Over 70 Line statuses are available including 40 or so whose names may be adapted.

If  some  Line  statuses  are  not  useful,  these  may  be  hidden  and  their  order  changed  to
reflect your needs. See the Line status name change, choice and order subsection in the
Line status chapter.

 Start Date Does not appear by default.

Based on the previous line's payment date. May be useful when variable rates are used.
This column thus shows at which date the new interest takes effect.

The Start date may not be changed. 

With mouse over, the day of the week corresponding to the date is displayed.

 Pmt Date The date at which the payment is made. This date should be changed when a payment is
not  made  on  time  or  should  remain  unchanged  but  a  payment  of  0.00  entered  if  the
payment is not paid on the expected date.

See  further  explanations  below  for  the  "True  Pmt  Date  (Grace  /  EFT)"  column  when  a
grace period is granted or when pre-authorized payments are made.

With mouse over, the day of the week corresponding to the date is displayed.

 Payment The actual payment amount. The amount should be changed to reflect the true payment
amount. 

This  may  be  a  positive  amount  (refund)  or  a  negative  amount  to  reflect  an  increase  in
balance (principal, fees, or other).

The Line status must match the type of payment (positive, negative or 0.00).

 Rate The interest rate that applies for this period.

The rate may be changed for one or many lines and the rate recomputed automatically
(see Right mouse click options).

The  interest  rate  of  multiple  Records  can  also  be  modified  in  batch.  See:  Adding  or
changing interest rates in a Payment schedule.

 Mathematical
Principal

Mathematical  principal  amount  (as  opposed  to  accounting  principal)  that  is  computed
based on the payment amount entered (positive or negative), the interest generated and
other amounts added (Fees or other) at this date.

This is the column that, based on the amounts above, will either increase the true balance
or reduce it. It is useful in order to see the effect of the payment on the balance. 

 A payment that is too low to pay any accrued interest and fees charged will generate
a negative Mathematical principal and increase the true balance.

 A payment that is greater than the accrued interest and fees charged will generate a
positive Mathematical principal and decrease the true balance.

Amount cannot be changed manually.

 Accrued Interest Accrued interest from the line "Start date" to the payment date.

Will  include  interest  added  with  the  "Interest  Charged"  and  "Interest  Charged  2"  (as
renamed) Line statuses.
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Amount cannot be changed manually unless the interest rate is changed.

 Balance, or
 "Computational

Balance" in Simple
interest

True Record balance on the payment date at 0:00 AM but taking into account that day's
payment. Does not include the interest for the day.

In  Simple  interest,  column  name  changes  to  "Computational  Balance".  Provides  the
balance that is used for the calculation since no interest is calculated on interest.

 Comment Comment for that line. 

Other columns

 Expec. Pmt Payment that SHOULD have been made. This may be entered through the pop-up box or
directly in the column.

The amount is in light grey in order not to be confused with the true payment.

The amount may only be changed for "Due Pmt" and "Payment" type Line statuses and
for "Other 1 to 10" Line statuses. Otherwise, the amount of this column = amount of the
Payment column.

The keys "Ctrl Alt R" allows to modify, for the selected lines only, the amount in column
"Expec. Pmt" to the amount entered in the "Payment column". Thus, the amount in the
"Outstanding (Balance)" column is recomputed to reflect this change. 

Expected Pmt  should  usually  be  equal  to  the  Payment  amount  when  the  Line  status  is
Due Pmt (or Due Pmt (2) to (5)). Therefore, if the Payment amount is changed when the
Line status is Due Pmt, the Expected Pmt will also change except if an option is activated
allowing Payments and Expected Pmts not to be equal. This is  useful when the Creditor
and the Borrower agree in advance on a next payment (higher or lower). The user must
activate the Allow to change the "Expected Payment" amount when Line status is  "Due
Payment" option.

 Pmt Due Date Date at which the payment was due initially.

Will be the date corresponding to the payment date when Line status was "Due pmt".

The date is in light grey in order not to be confused with the true payment date.

The date may be changed for the following Line statuses only:  "Paid Late Pmt",  "Partial
Late Pmt" and for the "Paid Pmt" from (2) to (20).

 Outstanding -
Payment (Balance)

Cumulative balance of  the payment amount that  should be paid (Payment column) but
that  is  overdue.  This  column  subtracts  the  amount  entered  in  the  "Payment"  column
from the amount entered in the "Expec. Payment" column. 

The minimum outstanding amount is  0.00. The outstanding amount cannot be negative
even  if  the  payment  made  is  greater  than  the  outstanding  balance.  In  addition,  the
calculation of  the overdue amount always  starts  from a  positive balance or  0.00,  never
from a negative balance (overpayment).

For  example,  a  payment  of  1000.00  ("Due  Pmt")  should  have  been  made.  Only  300.00
("Payment") was paid. The "outstanding (balance) therefore becomes 700.00.  The next
payment  which should have been 1000.00 is 1200.00.  The amount in "Due Pmt" should
be 1000.00 and the "Payment" should be 1200.00.  The outstanding (balance)  therefore
becomes 300.00 less 200.00 = 100.00.  The next payment is of 1500.00 while 1000.00 was
expected. The "outstanding (balance)" becomes 0.00, not 100.00 less 500.00 = -400.00.

Used to compute the ageing of accounts.

 Outstanding - Interest Interest calculated on the outstanding balance and on the interest on this amount when
the calculation is done using compound interest (effective rate method) or when a line or
lines  use  the  "Simple  Interest  Capitalized"  method.  Interest  is  calculated  using  the
"Outstanding - Total (Balance)" column.
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For a calculation using simple interest, the interest amount excludes interest on interest.
Interest is calculated using the "Outstanding - Payment (Balance)" column.

 Outstanding - Interest
(Balance)

Cumulative amount of the interest on the Outstanding amount (and interest on interest
for compound interest).

 Outstanding - Total
(Balance)

Total  of  the  "Outstanding  -  Payment  (Balance)"  and  "Outstanding  -  Interest  (Balance)"
columns.

 True Pmt Date (Grace
/ EFT)

If a grace period is given to the Borrower, the true payment date should be entered here.
If  the  true  payment  date  were  entered  in  the  "Pmt  Date"  column,  interest  would  be
charged as of this date. Thus the need to leave the “Pmt Date” column with the original
payment date and the true date entered in the "True Pmt Date (Grace) / EFT" column for
transaction date purposes.

For  pre-authorized  payments,  there  may  be  a  two  to  four  day  lapse  between  the
Borrower's account debit date and the deposit date to the Creditor's account.  For bank
reconciliation,  the  deposit  date  can  be  entered  in  the  "True  Pmt  Date  (Grace  /  EFT)"
column.

When a  date is  entered in  the "True Pmt Date (Grace /  EFT)"  column,  this  date  will  be
used only in the Accounting entries report, no other. 

 Alert to accomplish For the Alerts module, description of what must be done or accomplished on or close to
the date entered in the "Pmt Date" column.  The Record Owner will be alerted of this on
the day itself or days  before or after this date, depending on the number of days entered
in the “Alert Days Before - / After +” column.

 Alert Days Before -  /
After +

For the Alerts module, the Record Owner will be alerted on the date entered in the “Pmt
Date” if the column is left blank. The Owner will be alerted x days before if the number
entered is negative (for example, to be alerted 2 days before the “Pmt Date”, enter minus
2 (-2)). To be alerted after the date in the “Pmt Date” column, enter a positive amount (to
be alerted 2 days after, enter 2 with no sign).

 Minimum Pmt Minimum payment that should be paid. 

This amount must be entered manually.

 Balance before Pmt Balance on the payment date at 0:00 AM BEFORE that day's payment.

 Computational
Balance or 

 "Balance" in Simple
interest

Balance that is used for the calculation.

In Simple interest, column name changes to "Balance" to indicate the true balance.

As  of  MLM  version  4.0,  the  "Computational  Balance"  column  on  the  last  line  of  the
Payment  schedule  displays  the  balance  used  in  the  computation  as  opposed  to  the
previous versions where it used the true balance in Simple interest.

Principal amounts, fees or others that do not bear interest were always excluded and still
are in versions 4.0 and up.

 Paid Interest Interest that is actually paid following one of the Payment type Line statuses.

For any other Line status, Paid Interest will be 0.00.

 Paid Principal Principal that is actually paid following one of the Payment type Line statuses.

For any other Line status, "Paid Principal" will be 0.00.

 Due Interest Accrued interest minus Paid interest for the period.

 Balance Due Interest Balance of all Due interest from the start of the loan (taking into account the accrued and
paid interest).



Page 766

© Jurismedia Inc., 2007- 2023

 Balance Due Principal Balance of  the actual (accounting) principal only,  that factors in  the initial  principal  and
any additional principal added over time (Additional principal type Line statuses).

 Balance all others Portion  of  the  total  loan  balance  due  to  increases  in  "Fees",  "Penalties",  "Insurance",
"Tax" and all other Line statuses EXCLUDING Payment type and Additional principal type
Line statuses.

Balance  will  increase  with  negative  payments  for  these  Line  statuses  but  will  decrease
when these are paid (positive payments).  

 Pmt Type Indicates  that  lines  have  a  special  behavior  and  an  automatic  recomputation  of  the
payment amount: Interest-only, Refund Fixed Principal, automatic fees. 

When the tag is added to a line, the payment amount will be recomputed when payment
amounts are changed above these "special" lines.

To remove a tag, highlight the line(s), right click with the mouse, and under "Payments",
choose "Untag - Interest-only / Fixed Principal / No Interest)...".

 EFT Comments Displays the Batch number sent to the ACH Processor for this line's payment. 

APR/TCC Column Fees and Column Fees

 Paid Fees Financed 
(APR)

APR Fees Financed are a  type of  principal  and are added to  the  mathematical  principal
but  isolated  for  accounting  purposes.  Thus,  they  are  paid  at  the  pro  rata  of  the  paid
accounting principal.

See the APR chapter, Fees paid up-front, Financed or Paid subsequently section.

 Paid Fees Financed 
Balance (APR)

Remaining balance of the Fees Financed  (APR).

 Column Fees
(Accrued)

6 Column Fees whose
names can be
changed

Columns indicating Accrued Fees (billed/charged). Fees can also be Insurance or Taxes.

An amount may be entered by the user or a Fee can be automatically  entered in  these
columns with Automatic Column Fees.

Data is these columns can be changed in batches with a right mouse click > Column Fees

Their names can also be changed (Tools > Settings).

 Column Fees - Paid Column Fees - Paid Amount

A  regular  payment  ("Payment"  Type  Line  statuses)  will  pay   Column  Fees  1  first,  then
Column Fees 2, Column Fees 3, Column Fees 4, Column Fees 5, Column Fees 6, interest,
then principal.

 Column Fees -
Balance

Each Column Fee's Balance.

 Column Fees - Pmt
Type

Indicates if  these Column Fees bear no interest or  are computed according to  different
criteria (previous line balance, according to interest, etc.).

Other Columns related to "Returned Check" Line status

Returned checks data can be generated in the Transaction Report.

 Check Number Allows the user to enter the Check Number of the Returned Check.

 Date of Returned
Check

Allows the user to enter the Date of Returned Check.

 Date of Allows the user to enter the date of the Compensatory payment.
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Compensatory Pmt

Custom Columns (see detailed explanations below)

The names of these nine columns can be changed (Tools > Settings)

These can all have a scroll menu to force only certain data in these

 3 Columns  Monetary
format

Information / Transaction taking place at "Pmt Date"

 3 Columns  Numerical
format

Information / Transaction taking place at "Pmt Date"

 3 Columns Text
format

This column may be used to enter comments regarding the corresponding Monetary or
Numerical column.

Comments entered here can only be obtained through the Transaction Report.

Custom Columns

Nine  (9)  columns  allow  additional  information  or  special  transactions  for  information  purposes  in  addition  to  the
Comments column. The columns are located to the right of the Payment schedule and can be moved further to the left
and widened as required.

Column names can be customized according to your needs in  Tools > Settings > Custom Column Titles (where you can
change the names for Column Fees as well).
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The nine (9) columns can each include a scroll menu to force the entry of only specified values in these. Columns with
scroll menus are shown in green:

Result in the Payment schedule:
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The data included in these columns can be obtained individually in the Transaction report and/or amounts added for the
report period in the Record List (Personalized).

See also Margill Loan Manager Calculations > How To > Mortgage / Escrow.

   

Change of compounding or calculation methods

Once a Payment schedule has been created and adapted, Margill Loan Manager (MLM) allows you to keep this table and
change some of its settings. This allows you to create various scenarios such as the impact of the compounding period,
the day count or of simple or compound interest. 

Only  some  of  the  mathematical  settings  may  be  changed:  Compounding  Period,  Principal  and  all  the  settings  in  the
"Advanced" window. Settings such as "Origination date", Payment Frequency, "Amortization period", etc., will affect the
Payment schedule to such an extent that it cannot be recreated without a complete recomputation.

Below is the "Data" window. Settings in gray cannot be changed without pressing on "New Record", which will create a
new Record.

See also Changing the basic loan data in a Record
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Payments - Fundamentals

Fundamentals

A preliminary schedule may be completely edited in order to adapt it to one's peculiar needs and to the actual payment
scenario. 

Changes to a schedule should be made in two different ways:

 First, to establish the theoretical payment schedule (along with fees, insurance, tax and other special events)

 Second, to integrate the true payments over time 

1. First:  If  the  loan  is  to  be  adapted  to  meet  special  repayment  needs  (interest-only  for  a  few  months,  lump  sum
payments,  no  payments  for  a  few months,  fees,  tax,  insurance,  additional  principal,  changing  interest  rates,  etc.),
then  the  schedule  produced  through  the  Data  window  should  be  adapted  to  reflect  the  theoretical  (proposed)
payment  plan  along  with  special  events  (additional  principal,  taxes,  fees,  etc.)  over  time.  All  these  theoretical
changes  should  be  made  with  Line  status  as  "Due  Pmt".  Other  special  events  such  as  fees,  insurance,  additional
principal, etc., (all negative amounts) may also be added. Column Fees can also be added.

2. Second: The payment schedule works on a what you see is what you have format so only change a Line status from
"Due Pmt" to the new Line status when a payment or other event is actually made. Thus, the data that appears in a
payment  schedule  along  with  the  Line  status  should  reflect  what  has,  what  is,  and  in  the  future,  what  should
happen over time. 

See also the Fundamental Principles of Operation in the Introduction.

Payments contents

Unpaid payments

Late or partial payments

Grace period

Additional payments

Step payments

Rate adjusted payments

Interest-only payments

Fixed principal payments

Changing one payment or multiple payments

Lump sum payments / Prepayments

Adding lines (payments, principal, etc.)

Payments (equal) recomputed to yield a balance = 0.00 or other amount
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Unpaid payments

Lines with payments of 0.00 may be found in two circumstances:

1) They serve for information purposes only (thus no payment is to be made on these).

2) Payments should have been made but the Borrower did not pay.

In the first situation, the Line status should be "Information". By default, when multiple lines are changed at once to 0.00,
then the Line status is automatically changed to "Information".

In the second situation, the payments were not made and Line status should then be "Unpaid Pmt", "Returned Check" or
one of the nine (9) "Unpaid Pmt" custom Line statuses.

In the Payment schedule, an unpaid payment can be represented by a 0.00 amount. In the table below, 3 payments are
unpaid:

For unpaid payments, a window will appear in which to enter the payment that should have been paid.

If many payments are unpaid, it  is suggested to use the Payment update ("Post Payments") tool which will  change the
payment to 0.00 and the Line status to the desired "Unpaid" (or  partial  or  late)  status in  one step.  The payments that
SHOULD have been paid will automatically be set ("Expec. Pmt" column) to obtain the Outstanding payment amounts. 

Comments may also be added for each individual line.

Even Column Fees can be added manually or automatically when the Line status is changed from "Due Pmt" to "Unpaid
Pmt",  "Partial  Pmt",  "Late  Pmt",  etc.  You  create  your  own  rules  (for  example,  25.00  fee  or  a  penalty  according  to  a
percentage of the payment that should have been paid). See Fees, Insurance and Taxes by Column.

Working with the "Expec. Pmt" column

The Expected Payment column ("Expec. Pmt") contains VERY IMPORTANT data and must be properly dealt with in order
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to generate the true Outstanding amounts along with the Ageing report.

By default, the amount entered in the "Expec. Pmt" is the same as the one in the "Payment" column when the Line status
is "Due Pmt" (or Due Pmt (2) to (5)).

If the payment amount is changed, when the Line status is "Due Pmt", the amount entered in the "Expec. Pmt" column
will follow. This allows you to change the Payment schedule as you like. 

In the example below we were expecting a 5000 payment on 12-01 (format is Day-Month in the example below) but the
payment was not made. We should thus have 0.00 as the payment yet expecting 5000 ("Expec. Pmt" column).

On 19-02 and 26-01, normal payments were made. Payments of 5000 with Expected payments of 5000.

On  02-02,  an  extra  payment  (unexpected)  was  made  to  compensate  the  12-01  unpaid  payment.  Since  we  were  not
expecting the 02-02 payment, 0.00 should appear in the Expec. Pmt column even if  this payment merely compensated
for the unpaid payment of 12-01.

Finally,  on  09-02  we were  expecting  5000  but  6500  was  paid.  So  5000  should  appear  in  the  Expec.  Pmt  column.  This
amount is sufficient to pay off all outstanding amounts.

The "Ctrl Alt R" shortcut changes, for the selected lines only, the amount in column "Expec. Pmt" to the amount entered
in the Payment column. Thus, the amount in the "Outstanding (Balance)" column is recomputed to reflect this change.
See further explanations of this column in the "Payment schedule columns" section.

As of Margill Loan Manager (MLM) 4.0, it is possible to change the payments' amounts of the "Expec. Pmt" column while
the Line status is still "Due Pmt" (or Due Pmt (2) to (5)). This is not possible by default, therefore the MLM Administrator
must activate this right via Tools > System Settings (Administrators) > Allow to change the "Expected Payment" amount
when Line status is "Due Payment".

When the "Expected Payment" is changed, this message will appear indicating that once the "Due Pmt" is changed, it will
no longer automatically be updated, regardless if the amount in the "Payment" column is changed when the Line status is
"Due Pmt". This special condition will only apply to the affected line but not to the entire Payment schedule.
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This  option  can  be  useful  when  an  unpaid  payment  must  be  compensated  by  a  compensatory  payment  that  is  not
expected in the Payment schedule. For example, a client calls you on May 2 because he missed his payment on May 1. He
tells  you that  he will  send you a 500.00 check on May 5.  You will  can insert a  line for May 5 (Due Pmt) with  a  500.00
Payment. Since it was an unexpected payment, the "Expec. Pmt" column should be 0.00 (not 500.00) in order to reduce
the outstanding amount. Therefore, you will have to manually change "Expec. Pmt" to 0.00.

Also,  four new Line statuses are available: Due Pmt 2 to 5,  whose names can  be  changed.  Thus,  back  to  our  example,
regular  payments  are  usually  made  by  pre-authorized  payments  (Electronic  Funds  Transfer)  but  this  particular  May  5
payment will be paid by check. Instead of naming this new line "Due Pmt", the user should use "Due Pmt (2)" and rename
it "Due Pmt - Check" (or "Due Pmt - Extra Pmt"). Thus, this special payment could be easily found with the very important
payment update tool,  Payment update ("Post Payments")).  The payment can therefore be treated separately from the
preauthorized payments.

By updating the payment when it's actually paid, the Line status could be "Paid Pmt - Check" (customized name) or "Add.
Pmt". This allows you to identify special payments if needed. The default "Paid Pmt" could also be used. 

Unpaid payments carried forward

Your Borrower should have made his usual monthly payment but does not pay (bad check for example). To compensate,
he agrees to carry this payment forward on one or more subsequent payments.

In the example below, the first three payments are made. The balance thus remains at 0.00.

However, the fourth payment is missed and so the Line status is changed to "Unpaid Pmt" and payment becomes 0.00.
By default, the amount of the missed payment and the additional interest generated will be added to the final balance of
the schedule (637.28).

If  the  Borrower  wishes  to  pay  over  one  or  more  subsequent  payments  (three  (3)  in  this  example),  select  the  lines  on
which the amount due will  be refunded and then right click on mouse. Select "Payments" and "Payments Adjusted for
Balance = 0.00" or "Payments Adjusted for Balance = X" if the final balance is to be other than 0.00.
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The three payments will be recomputed and the balance will return to 0.00 (plus or minus a few cents).

Only one line could have been selected to carry the payment forward on to the next payment. Instead of selecting three
lines, select only one and do the same procedure as above. Notice that  the payment is  968.11, that  is  2.39 more than
twice the regular payment (482.86 x 2 = 965.72) because of accrued interest for the month.

The amount in the "Due Pmt" column could also be changed manually in order to eliminate the outstanding amount.

One or  more missed payment(s)  can  also  be  paid  at  a  later  date  with  additional  payments  of  the  same amount  or  an
amount of your choice. Simply add one or more lines at the end of the Payment schedule with a right mouse click or click
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on the button on the right of the window.

See also Late or partial payments, Additional payments and the very important Line status section.

   

Late or partial payments

A Borrower  may  make  partial  payments,  late  payments  or  even  partial  late  payments.  There  are  multiple  methods  of
dealing with these in Margill Loan Manager (MLM) with the various Line statuses available.

Late payment versus unpaid payment

Fundamentally, a late payment is an unpaid payment until it becomes paid. The Creditor must take a decision as to when
an unpaid payment is considered unpaid in MLM as opposed to simply late. This decision is important since the user must
clearly take a decision as to which Line status applies to this late/unpaid/repaid payment and at what date.

For  example,  the  Line  status  for  a  late  payment  could  be  "Late  Pmt"  at  which  point  the  payment  date  must  also  be
changed to reflect the true payment date (and extra interest calculated automatically by the system). The user could also
decide to change the Line status to Unpaid (with a  payment of  0.00) for  this  line and then insert a  new line when the
payment actually becomes paid. The Line status could be "Additional pmt" or "Compensatory Pmt" on the new payment
date since no payment was due (expected) on this new date. 

This  is  particularly  important  as  this  affects  the  Ageing  report  since  the  "Paid  Late  Pmt"  and  "Partial  Late  Pmt"  Line
statuses will  not generate an Outstanding amount. An Outstanding amount must be present in order for there to be a
computation of late days. Thus the "Paid Late Pmt" and "Partial Late Pmt" Line statuses should be used only for payments
late by only a few days as opposed to true unpaid payments. 

The decision as to when a payment becomes unpaid as opposed to only late, is based on each Creditor's methodology.
Below are a few recommended solutions:

 General principle:  A payment should be considered unpaid when it  is  not  paid  by  the  time the  next  due payment
comes along.

o For example, if  payments are weekly, a payment should be considered unpaid six or seven days after it  is
due.

o If a payment is monthly, if it is paid within the month, then it could be changed to "Paid late pmt" (and the
payment date changed) anytime before the next payment.

 Exception:  Payments  that  are  to  be  paid  every  two  months,  quarterly  or  other  lengthy  intervals.  Credit  agencies
consider payments as Current if they are paid within 30 days. The same principle could apply to these payments. It is
thus recommended, if a payment is over 30 days late, to consider it  unpaid (change it  to one of the "Unpaid" Line
statuses). When the payment is actually made, insert a new line with one of the "Paid" Line statuses, making sure
that the "Expected Pmt" column contains a 0.00 since no payment was due on this new date even if  this payment
merely compensates for the unpaid payments.
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These Line statuses are suggested for partial payments, late payments or even partial late payments:

If only slightly late:

 Paid Late Pmt
 Partial Pmt
 Partial Late Pmt
 Paid Pmt (2) to (20) (customized names such as "Paid late < 10 days" and an automatic column fee could created for

this special late payment - see Automatic Column Fees)

If considered Unpaid then Paid:

 First change Line status to:

o Unpaid, Returned Check or Unpaid Pmt (2) to (20)(customize names)

 Then insert line with the following Line status:

o Add. Pmt, Compensatory Pmt, Paid Pmt, Paid Pmt Returned Check or Paid Pmt (2) to (20) (customized
names)

If  a  payment  using  one of  the  nineteen custom "Paid"  Line  statuses  (e.g.  "Paid  Pmt  -  Visa")  is  late  and/or  only  partial
(should be 500 but was only 300), enter the actual payment manually in the "Payment" column (300.00) and manually
change the amount in the "Expec. Pmt" column (500). The Outstanding amounts will be calculated as well. 

For proper Ageing of accounts reporting, always make sure that the amount in the "Expected Pmt" column is either 0.00
or the amount that should have been paid on that specific line (see Working with  the "Expec. Pmt" column sub-section
in the Unpaid payments section).

Working with "Paid Late Pmt", "Partial Pmt" and "Partial Late Pmt" Line statuses

When a scheduled payment ("Due Pmt") is paid only partially or is slightly late, after changing the Line status, a window
opens asking you the enter the payment amount that should  have been made and/or the expected date as well as the
true payment amount and its true payment date.

The Payment schedule will be adjusted accordingly (principal, interest, balance, outstanding, etc.). 

The  amounts  and  dates  in  the  four  columns  can  also  all  be  changed  manually  if  a  data  entry  error  was  made  in  the
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pop-up window.

It  is  not  mandatory  to  use  the  "Partial  Pmt"  Line  status  in  order  to  obtain  the  partial  payment  data  (amount  that  is
outstanding) for reporting. For accounting purposes, to obtain the debits and credits of particular payments (for example,
payments  made  by  Visa  as  opposed  to  payments  by  pre-authorized  debit),  enter  the  true  payment  amount  and  the
amount that should have been paid using one of the nine custom "Paid Pmt" Line statuses.

See also Unpaid Payments, Additional payments and the very important Line status section.

IMPORTANT: It is possible to update partial payments, late payments and late payments in batches with the Payment
Update tool. This avoids the need to open each Record to manage these loans. Thus, all "Due Pmt" (and Due Pmt (2)
to (5)) can be displayed and the payments can be "managed" to become Paid Pmt, Partial Pmt, Late Pmt, etc. This tool
is certainly the most important in MLM!

Even Column Fees can be added manually or automatically when the Line status is changed from "Due Pmt" to "Unpaid
Pmt",  "Partial  Pmt",  "Late  Pmt",  etc.  You  create  your  own  rules  (for  example,  25.00  fee  or  a  penalty  according  to  a
percentage of the payment that should have been paid). See Fees, Insurance and Taxes by Column.

Distinction between Late payments and Unpaid payments that are paid later

Since the credit agencies consider a payment to be late when unpaid within 30 days, a payment which is not paid within
30 days should be considered unpaid and the proper "Unpaid"  Line  status  entered along with  a  payment  of  0.00.  The
amount  that  SHOULD  have  been  paid  must  be  entered  in  the  "Expec.  Pmt"  column  thus  calculating  an  Outstanding
amount. Thus, the "Late" Line status should not be used in these circumstances.

If  a  "Late"  Line  status   is  used  and  the  "Expected  Pmt  Date"  column  indicates  more  than  30  days  late,  the  following
warning will appear, suggesting the status line be changed to "Unpaid" and an "Add. Pmt" or a "Compensatory Pmt" line
be inserted when the payment is made. This payment will compensate for the missed payment and eliminate or reduce
the  outstanding  amount  (the  amount  shown  in  the  "Expec.  Pmt"  column  should  be  0.00  since  we  did  not  expect  this
particular payment, even if it is meant to offset the unpaid payment).
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This message is for information purposes only and can be ignored. However, we suggest establishing an internal policy
to standardize the definition of a late payment versus unpaid payment.

It  is  possible  in  Tools  >  Settings  >  System  settings  (Administrators)  to  specify  that  time  period.  For  example,  if  your
portfolio is composed of weekly payments (every 7 days), then the number of days should be changed to 6 or 7 days. For
quarterly payments, 30 days or more may be the norm. If the portfolio has loans with various frequencies of payments,
30  days  could  be  used  taking  into  account  that  no  warning  will  be  given  in  this  case,  for  example,  of  unpaid  weekly
payments.

If the field is empty (or 0), no validation will be done. See the ? for further explanation.

   

Grace period

The "Grace period" feature in Margill Loan Manager (MLM) is developed rather basically.

A grace period may be granted if a payment is late. So even if a payment is a few days late, no interest will be charged
because of the grace period granted.

The grace period may be entered, in days, in a Record's "Advanced" tab. This grace period may be set by default for all
Records by pressing "Set as default" or a profile can be created for this grace period.

This field may also be configured as a scroll menu. Go to Tools > Settings > System settings (Administrator) > Field Scroll
Menus. See the Scroll Menus section (under Tools and Settings) for further explanations on how to create the menu and
define the standardized data.
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When using the grace period, do NOT change the date in the "Pmt Date" column since this is the date used for computing
interest. Instead, enter the true payment date in the "True Pmt Date (Grace / EFT)" column. This way, no interest will be
charged, and the true payment date will be noted for reference purposes. 

In  the  example  below,  the  payment  date  should  be  12-01-2013  but  the  payment  was  only  done  on  12-10-2013.  By
entering a date in the "True Pmt Date (Grace / EFT)", column MLM indicates the suggested number of grace days, and if
you are within this period ("Difference"). The number of days entered in "Grace" should be equal to or greater than the
number of days calculated for "Difference".

If  the  payment  is  not  made  within  the  grace  period,  the  following  message  will  warn  you.  You  will  nevertheless  be
allowed to enter the desired date.

This message will only appear when the Line status is "Paid Pmt" (and "Paid Pmt 2 to 20"), "Paid Late Pmt", "Partial Pmt",
"Partial  Late  Pmt"  or  "Paid  Pmt  Returned  Check".  It  appears  for  no  other  Line  status,  but  the  "Difference"  appears
nevertheless to the right of the date entered in "True Pmt Date (Grace / EFT)".

Depending on your use of  the Line status,  a  late payment,  within the grace period,  can either be considered a regular
payment, "Paid pmt" or a "Paid Late Pmt" - the latter offering more information about the reliability of your Borrower.

If you decide to consider the payment late (Line status, "Paid Late Pmt") the following window will appear requesting the
true  payment  date.  If  you  change  this  date,  interest  will  be  calculated.  You  should  not  change  the  "Date  of  TRUE
payment" and thus must check "Allow same dates (Not suggested)". You should then enter the true payment date in the
"True Pmt Date (Grace / EFT)" column. These more or less elegant acrobatics allow you to not charge interest for a late
payment, yet have reliable data.

Important note: If the grace period is changed in the "Advanced" tab, this change will not affect the transactions already
completed (late paid payments) and no warning will  be given if  the date in  the "True Pmt Date (Grace /  EFT)"  column
exceeds the grace period indicated in the "Advanced" tab.
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This column is also used to enter the true date at which a payment is received when Electronic Funds Transfers are used,
thus the "EFT" after "Grace". See the "Debit date (money from Borrower account) versus Credit date (money to Creditor
account)" box in the Selecting and Submitting Payments EFT chapter.

   

Additional payments / Compensatory payments

When payments have not been made, it is possible to add additional payments to compensate. Additional payments can
also be done simply to repay the loan faster.

When  additional  payments  are  made,  it  is  suggested  (but  not  required)  to  select  the  Line  status  as  "Add.
Pmt","Compensatory Pmt" (name may be changed) or "Paid Pmt Returned Check" in the case of a returned check (see
Returned Checks (under Tools > Settings) and Reports.

If an additional payment is not paid yet but is EXPECTED, thus agreed upon between the creditor and the borrower, use
one of the Line statuses Due Pmt 2 to 5 (renamed) to identify this  special  payment.  See the "Due Payment" Type Line
statuses section.

When one of these Line statuses is used, the amount in the "Expect.  Pmt" column will  automatically be 0.00 since the
payment was not expected. It thus reduces the outstanding amount due. The amount in the "Expect. Pmt" column can
still be changed if necessary.

"Paid  Pmt  (X)"  Line  statuses  which  can  be  renamed,  may  also  be  chosen  as  additional  payments.  Make  sure  that  the
amount in the "Expect. Pmt" is 0.00 or the desired amount. It is possible in Settings > Line Payment Statuses, to force the
Expected payment to 0.00.

Electronic Funds Transfers (EFT)

For those using pre-authorized payments (US and Canada), when a Borrower agrees that a past unpaid payment will be
offset in  the future,  it  is  recommended to insert this  payment  with  the  "Due Pmt X"  Line  status  (renamed "Due Pmt -
Extra" (or "Due Pmt - Compensatory Pmt") for example). Thus in Tools > Settings > Electronic Funds Transfer, the user can
specify that  this  "Due Pmt"  be  modified,  at  the  scheduled date  of  payment,  automatically  to  "Compensatory Pmt"  (or
"Pmt add.").

The amount in the "Expected Pmt" column of the Payment schedule will automatically be 0.00 and so the compensatory
payment would reduce the outstanding amount.
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See also Unpaid payments, Late or partial payments and the very important Line status section.

   

Step payments

Margill  Loan  Manager  (MLM)  can  create  a  payment  schedule  that  will  automatically  index  payments  according  to  a
monetary increase or an increase expressed as a percentage.

A  step  payments  (indexed  payments)  schedule  can  be  created  in  2  simple  steps.  First  enter  the  pertinent  data  in  the
"Data" entry window.

 

If the entire schedule is to be made up of step payments, include only one (1) payment for the number of payments in
"Amortization (Payments)". The other step payments will be added subsequently in the Payment schedule.

Also enter the amount of the first payment. A payment schedule containing only one line will be created:

Either click on  and select "Add Many Lines" or highlight the only line in the table and right click with the mouse.
Select "Insert" and "Payments":
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The window below will appear. Enter the date of the next payment or the Start date (08/08/2006 in this example) if the
indexation is to occur on the anniversary date.

In this  example, the loan will  be for 5 years,  thus the  first  payment  and  59 others.  The 1000 payment  will  be  indexed
semiannually by 250 on the loan anniversary date (08-08-20xx) and every 6 months after that.

After pressing on OK, the table will be created:
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The indexation may also be included as a percentage of the payment:

In this example, the 1000 payment will be increased by 10% semiannually, thus starting 03/08/2020.

The "Calculate Indexation Rate  for  Balance =  ___" is  a  pretty  advanced feature.  By  taking  into  account  the  number  of
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payments, an initial  amount for these payments and a payment indexation frequency, the indexation rate required for
the payment amount to reach a  final  determined balance (often 0.00)  will  be  computed along with  the  next  payment
amounts.

In the following example, we added 24 monthly payments, the first one being 1000 with a Quarterly indexation period.

By checking "Calculate Indexation Rate for Balance = 0,00", MLM will compute and display the indexation rate:

It will also compute the next payment amounts. We see that the 1000 becomes 1063.79 a quarter later, then 1131.65,
and  so  forth  until  the  balance  reaches  as  close  as  possible  to  0.00  (the  last  payment  amount  could  be  adjusted  to
eliminate the -0.26):
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Rate adjusted payments

See the "Rate adjusted payments" sub-section in the Refund options chapter.

   

Interest-only payments (and Column Fees) and Interest paid in Advance

Very often, especially in corporate loans, a lender may give a Borrower a principal refund exemption for a certain period
of time. The Borrower thus  pays  only  interest.  "Interest-only" also  usually  refunds Column Fees (up  to  six  types)  since
they are closely tied to interest. In another scenario, a payment could refund only pure interest even if this interest was
not yet accrued (interest paid in advance).

There are two options for interest refunds in Margill Loan Manager (MLM):

1) Calculation of the interest amount and Column Fees

2) Payment of pure interest with the "Interest Paid" Line status

1) Calculation of the interest amount and Column Fees

Payments for  a  special  loan can be done in two steps: interest-only payments (and Column Fees since these are  often
regular  credit  fees  or  sales  taxes  in  the  case  of  leases)  for  a  given  period,  followed  by  normal  principal  and  interest
payments and can include lump sums, missed payments, extra principal, fixed principal refund, etc.
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If the entire loan is interest-only, choose "Interest-only" (and Column Fees) for the "Payment Method" in the "Data" tab.

In order for only one or many payments to refund only the interest (and Column Fees) in a Payment schedule, select one
or many lines that will be interest-only and right click with the mouse.

With  this  choice,  MLM  will  compute  the  appropriate  payment  amount  to  refund  only  the  interest  and  Column  Fees.
Please  note  that  by  default,  Column  Fees  and  outstanding  interest  will  always  be  refunded  first,  followed  by  accrued
interest (of the same line). However, an option is available allowing you to either refund:

1) all outstanding interest (and outstanding Fees); or
2) only the interest (and Fees) for the period.

See the Advanced options for interest and Column Fees reimbursement section. 

Automatic recomputation of interest-only (and Column Fees) payment

An  advanced  line  "Behavior"  feature  is  also  available  that  will  automatically  recompute  the  interest-only  payment
amount for the selected lines when changes are made above these lines that consequently affect the amount of accrued
interest payable afterwards. 

Since  this  is  an  advanced  option,  it  is  not  activated  by  default.  To  activate  this  option,  go  to  Tools  >  Settings  >  User
settings > and check: "Display "Behavior" option (Interest-only and Fixed Principal in the Payment schedule)".
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When this  feature is  activated and "Refund Interest-only"  is  selected for  a  number  of  lines,  the  following  window will
appear:

With this  interest-only  "behavior"  or  "tag",  no  matter  what  change is  made ABOVE (missed,  late  payments,  additional
principal,  fees,  etc.),  the  payment  for  the  tagged  interest-only  lines  will  be  adjusted  to  continue  refunding  only  the
interest.  If  "Line  behavior"  is  not  checked  there  will  be  an  initial  recomputation  of  an  interest-only  payment  but  no
automatic recomputation afterwards. 

The  "Int  Only"  tag  may  be  seen  on  one  of  the  columns  to  the  right  (column  called  "Pmt  Type").  The  tag  may  not  be
deleted manually from this column but is  automatically deleted when the actual  payment is  changed or  with the right
mouse click (see explanation below). 

The following example shows the effect of the "Int Only" tag:

The first 12 months of the loan are interest-only and the Borrower pays the two first payments (Line status - "Paid Pmt"):
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However, on the third payment, the Borrower does not pay at all. We then change the Line status to "Unpaid payment"
and enter an amount of  0.00.  Since the following lines have been tagged as interest-only,  the  payment  is  recomputed
automatically  to  again  refund  only  the  interest  (we  are  supposing  the  loan  contract  states  that  the  payments  are  to
remain interest-only for  the first  12  months  even if  some payments  are  missed).  The interest  amount  was 437.50 and
now  increases  to  439.41  (payment  option  only  for  the  current  accrued  interest,  not  the  past  due  interest).  The  other
payments (1000.00) are not affected since they do not have the special behavior.

If a payment amount is changed, the line loses its interest-only tag. In order to delete some or all the interest-only tags,
so  the  payments  are  NOT  automatically  recomputed,  choose  the  desired  lines,  right  click  with  the  mouse  and  under
"Payments"  choose  "Untag  -  Interest-only  /  Fixed  Principal  /  No  Interest  /  ...".  Thus,  the  payments  will  no  longer  be
recomputed even if changes (payments missed, changed, etc.) are made above. 

In order to reduce the possibility of error, when the true payments are made (thus no longer hold the "Due Pmt" Line
status) and the schedule is updated to reflect these, the lines cannot be tagged as interest-only. Only the "Due Pmt" type
Line statuses can be given the interest-only tag.

We  suggest  to  tag  lines  only  when  working  on  the  theoretical  payment  schedule  (see  Fundamental  principles  of
operation)  and  then,  once  the  theoretical  schedule  produced,  to  untag  the  lines  (see  explanation  above)  so  that  the
payments are not recomputed automatically. Thus, even if the Borrower does not pay the scheduled amounts, in order
to respect the initial  contract  payment  amount,  the  payments  will  not  be  changed (the final  balance will  however).  In
another  scenario,  the  contract  could  specify  that,  no  matter  what,  the  interest  must  be  paid  on  a  regular  basis.
Therefore,  these  payment  lines  should  continue  to  behave  so  the  payments  are  recomputed  and  equal  the  accrued
interest (or past due interest) which would then be paid.

When a Due Pmt is changed to a Paid payment (or unpaid or other Line status based on the true payment scenario), a
message will appear stating that the special Tag will  be removed. This logical constraint is imposed since once the true
payment is set, il should not be adjusted automatically afterwards if for some reason changes were made above it. The
message is not displayed when the Post payments tool is used to update payments.
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The same principles apply to Fixed principal payments.

See also when interest-only applies for part of the loan and the subsequent payments are to be recomputed:  Payments
(equal) recomputed to yield a balance = 0.00 or other amount.

Behavior before creating the Payment schedule 

It  is  also  possible  to  add  the  "Interest  only"  (and  column  Fees)  Behavior  for  all  of  the  lines  of  the  Payment  schedule
before creating it  in the "Data" window. This saves a step for the rest of  the process.  The "Payment Method" must be
"Interest Only". Check the "Add Behavior" box.

The  option  must  be  activated  by  the  User  in  Tools  >  Settings  >  "User  settings"  tab  >  Options:  Interest-only  and  Fixed
Principal:

   

Advanced Options for Interest and Column Fees Reimbursement

By default, an interest (and Column Fees) reimbursement will  refund the outstanding interest and the accrued interest
(and  Column  Fees)  for  the  period.  However,  if  the  "Options  to  refund  Interest-only  and  Fixed  Principal"  option  is
activated (Tools > Settings > User Settings tab), MLM will give you two choices: 

1. Refund all outstanding interest (and Column Fees)

2. Refund only interest for the period (and Column Fees)
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The first choice (Refund all outstanding interest), is the default choice and the most common option.

The impact of each choice is explained in the example below, in Simple interest. In the payment schedule we moved the
"True Balance" column to the right of the "Computational Balance" to more easily see the impact of each choice.

For  lines  5  and  6  partial  payments  are  made  and  no  payment  is  made  on  line  7  (thus  interest  accumulates).  The
"Computational Balance" increases only by the Column Fee amounts since there is no interest on interest, yet the "True
Balance" column increases since payments  are  insufficient  to  refund the  accrued  interest  and  Fees.  The  contract  then
states that for the following 3 months the payments are to be interest-only (and Fees).

The first choice (Refund all outstanding interest) refunds all outstanding interest on line 8. Thus on this line is refunded:

Outstanding interest 313.63

Outstanding Fees 125.00

Interest for the period 107.61

Fees for the period 10.00

Payments (lines 5 and 6) (20.00)

Total payment line 8 536.24

The  second  choice  (Refund  only  interest  for  the  period)  will  only  refund  the  interest  and  Fees  for  the  current  period
(107.61 + 10.00 = 117.61). Thus, the true Balance will  remain at 13,018.15 as opposed to reducing to the 12,599.52 as
with  the  first  option.  The  "Computational  Balance"  will  not  change  until  the  payments  are  sufficient  to  refund  all



Page 791

© Jurismedia Inc., 2007- 2023

outstanding interest and current interest and Column Fees.

In Compound interest, the impact is not as significant since the unpaid interest is capitalized (is added to the balance and
to the mathematical principal, but stays isolated for accounting purposes). Thus, no matter what you choose (choice 1 or
2), the computed payment will clear the accrued interest of that period only and not the interest in arrears. The impact is
more  noticeable  when  Column  Fees  are  added.  The  first  choice  (refund  all)  will  refund,  not  only  current  fees,  but  all
unpaid fees too.

Example with choice 1, Refund all outstanding interest:

Line Outstanding Interest Column Fees Payment To be included in line 8
payment

5 104.98 capitalized 25.00 10.00 15.00

6 105.98 capitalized 25.00 10.00 15.00

7 106.99 capitalized 75,00 0.00 75.00

8 108.51 to be included 10.00 Computed 108.51 + 10.00

8 223.51 Total: 223.51

Example with choice 2, Refund only interest for the period:
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Line Outstanding Interest Column Fees Payment To be included in line 8 payment

5 104.98 capitalized 25.00 10,00 0.00

6 105.98 capitalized 25.00 10,00 0.00

7 106.99 capitalized 75.00 0,00 0.00

8 108.51 to be included 10.00 Computed 108.51 + 10.00

8 118.51 Total: 118.51

Changing methods (between methods 1 and 2 above)

If  you  wish  to  change  from one  method  to  another  (1.  Refund  all  outstanding  interest  (and  Column  Fees)  and  2.

Refund only interest (and Column Fees) for the period), click on Data  and change the "Method
Interest Only" from one to another and go back to the Payment schedule.  If the lines are tagged as "Interest-only"
you  will  immediately  see  the  effect  of  your  choice.  If  the  lines  are  not  tagged,  then  you  must  right  click  and
recompute the interest-only amount.

A  change  in  the  method  will  impact  ALL  payments  that  have  this  special  behavior.  Different  payment  methods
cannot be specified for individual payment lines.

Note  for  negative  accrued  interest:  In  exceptional  cases,  if  the  interest  becomes  negative  for  a  period  of  time  (for
example, the loan balance becomes negative therefore the accrued interest becomes negative too), recomputing will not
be precise. This function should be avoided in these exceptional cases. Always verify the line-by-line payments in these
situations by looking at the important "Due Interest Balance" column.
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2) Payment of pure interest with the "Interest Paid" Line status

The  previous  section,  "1)  Calculation  of  the  interest  amount  and  Column  Fees"  presents  the  tool  that  allows  for
computing the required amount in order to refund the interest and the Column Fees. As soon as the payment is greater
than the accrued and past due interest and Column Fees, the additional payment amount will pay the Principal.

On  the  contrary,  the  "Interest  Paid"  Line  statuses,  will  only  refund  pure  interest  without  paying  any  Column  Fees,
regardless of  the accrued and past  due interest.  So,  if  the  payment  is  greater  than  the  accrued and past  due interest,
interest balance will become negative.

See Interest Paid in Advance section.

See also:

"Interest" Type Line statuses

"Payment" type Line statuses and its Column Fees payment order with exceptional priority sub-section that explains how
to change, exceptionally, which Column Fees are paid first.

Payments (equal) recomputed to yield a balance = 0.00 or other amount

Right mouse click

   

Fixed principal payments

Some loans may include fixed principal payments throughout the loan or for some of the payments only.

There are two options to refund Principal in Margill Loan Manager (MLM):

1) Refunding the interest first (and Column Fees) followed by a fixed principal amount for all payments

2) Refunding principal only (regardless of interest and Column Fees balances) with the "Paid Principal" Line status

1) Refunding the interest first (and Column Fees) followed by a fixed principal amount for all payments

In standard loans, the regular payment is a fixed amount that refunds principal and interest. The principal and interest
amounts change at every payment since the principal balance decreases, reducing the interest portion and increasing the
principal portion. Less common loans, seen most often in commercial loans, allow to refund a fixed principal amount, but
as a result, the payment amounts vary and generally decrease over time. 

In order for the entire loan to be Fixed principal, choose "Fixed principal" in "Payment Method" in the "Data" window or,
once the Payment schedule is created, select all lines in the Payment schedule and use the right mouse click as explained
below.

In  the  "Data"  window,  if  the  Principal  amount  and  the  number  of  payments  (Amortization)  are  entered,  MLM  will
automatically divide the principal by the number of payments to refund the proper amount of principal. This suggested
amount may be changed. If another fixed principal amount was entered, 500.00 for example, then to obtain a Balance =
0.00  it  is  thus  suggested  to  leave  the  number  of  payments  blank.  MLM  will  compute  the  number  of  payments
automatically.
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"Data" window

If only some of the payments are to refund a fixed principal amount, once the Payment schedule is computed, select one
or many lines for which a fixed principal will be refunded and right click with the mouse.

"Refund Fixed Principal" will open the window below allowing you to specify the fixed principal amount to be refunded

or, by pressing on , MLM will compute the fixed principal amount to refund the loan so that
the balance will = 0.00 (or another balance amount entered).
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This choice allows MLM to calculate, by default, the amount required to refund the interest and Column Fees first and
then the desired principal amount. However, an option is available to refund:

1) principal and ALL outstanding interest (and Column Fees) first; 
2) principal and interest (and Column Fees) FOR THE PERIOD only; or 
3) Refund principal WITHOUT refunding outstanding interest (and Column Fees) (see also: 2) Refunding principal only...).

See the Fixed Principal Payment Adjustment section below.

Automatic recomputation of the fixed principal payment

An extra line "Behavior" feature is also available that will automatically recompute the fixed principal payment amount
for the selected lines when changes are made above these lines that thus affect the amount of accrued interest payable
afterwards. 

Since  this  is  an  advanced  option,  it  is  not  activated  by  default.  To  activate  this  option,  go  to  Tools  >  Settings  >  User
settings > and check: "Display "Behavior" option (Interest-only and Fixed Principal in the Payment schedule)".

When  this  feature  is  activated  and  "Refund  Fixed  Principal"  is  selected  for  a  number  of  lines,  the  same  window  will
appear but with the option, at the bottom of the window, to add this special behavior:
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With the "Line behavior" option, no matter what change (missed, late payments, additional principal, fees, etc.) is made
ABOVE the selected special behavior lines, the payment for the tagged fixed principal lines will be adjusted to continue
refunding  only  the  fixed  principal  amount  specified.  If  "Line  behavior"  is  not  checked,  there  will  be  an  initial
recomputation to refund the fixed principal amount but no automatic recomputation afterwards. 

The  tag,  "Fixed  Princ.||500"  (500  being  the  amount  of  fixed  principal)  may  be  seen  in  a  column  to  the  right  (column
called "Pmt Type"). The tag may not be deleted manually from this column but is automatically deleted when the actual
payment is changed, or with the right mouse click (see explanation below).

The following example shows the effect of the "Fixed-Princ.||xxx.xx" tag: 

The entire loan is fixed principal of 500.00 and the Borrower pays the two first payments (Line status - "Paid Pmt"):
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However, on the third payment, the Borrower does not pay at all. We then change the Line status to "Unpaid payment"
and enter an amount of 0.00. Since the following lines have been tagged as fixed principal, the payment is recomputed
automatically to again refund 500.00 in  principal  (we are  supposing the  loan contract  states  that  the  payments  are  to
refund a fixed principal of 500.00 even if some payments are missed). The next payment amount (line 4 - in blue below)
was originally 559.06 (see image above) and now increases to 561.52 since more interest is accrued.

If a payment amount is changed,  the line loses its  fixed principal  tag.  In  order to delete some or all  the fixed principal
tags, so the payments are NOT automatically recomputed, choose the desired lines, right click with the mouse and under
"Payments"  choose  "Untag  -  Interest-only  /  Fixed  Principal  /  No  Interest  /  ...".  Thus,  the  payments  will  no  longer  be
recomputed even if changes (payments missed, changed, etc.) are made above.
 

In order to reduce the possibility of error, when the true payments are made (thus no longer hold the "Due Pmt" Line
status) and the schedule is updated to reflect these, the lines cannot be tagged as interest-only. Only the "Due Pmt" Line
status should be given the fixed principal tag.

We  suggest  to  tag  lines  only  when  working  on  the  theoretical  payment  schedule  (see  Fundamental  principles  of
operation)  and  then,  once  the  theoretical  schedule  produced,  to  untag  the  lines  (see  explanation  above)  so  that  the
payments are not recomputed automatically. Thus, even if the Borrower does not pay the scheduled amounts, in order
to respect the initial contract payment amount, the payments will not be changed (the final balance will however).

When a Due Pmt is changed to a Paid payment (or unpaid or other Line status based on the true payment scenario), a
message will appear stating that the special Tag will  be removed. This logical constraint is imposed since once the true
payment is set, il should not be adjusted automatically afterwards if for some reason changes were made above it. The
message is not displayed when the Post payments tool is used to update payments.

The same principles apply to Interest-only payments.

See  also,  when  fixed  principal  applies  for  part  of  the  loan  and  the  subsequent  payments  are  to  be  recomputed:  
Payments (equal) recomputed to yield a balance = 0.00 or other amount.

Behavior before creating the Payment schedule
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It is also possible to add the "Fixed Principal" Behavior for all of the lines of the Payment schedule before creating it in the
"Data" window. This saves a step for the rest of the process. The "Payment Method" must be "Fixed Principal". Check the
"Add Behavior" box.

The  option  must  be  activated  by  the  User  in  Tools  >  Settings  >  "User  settings"  tab  >  Options:  Interest-only  and  Fixed
Principal:

 

Fixed Principal Payment Adjustment 

By  default,  a  fixed  principal  refund  will  always  reimburse  the  outstanding  and  accrued  interest  for  the  period  and  all
outstanding and accrued Column Fees for the period. However, if the "Interest-only and Fixed Principal Options" option is
activated (Tools > Settings > User Settings tab), MLM will offer three choices.

1. Refund principal and ALL outstanding interest first

2. Refund principal and interest FOR THE PERIOD only

3. Refund principal WITHOUT refunding outstanding interest 
4.
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The impact of each choice is  explained in the example below. In  the payment schedule,  we moved the "True Balance"
column  to  the  right  of  the  "Computational  Balance"  to  more  easily  see  the  impact  of  each  choice.  Remember  that
Column Fees are also treated like interest.

For the first 6 months, no payment was to be made (thus interest accumulates). The "Computational Balance" remains at
25,000 since there is no interest on interest, yet the "True Balance" increases since no payments are made (or in other
scenarios, payments may be insufficient to refund the accrued interest). The contract then states that for the following 6
months the payments are to be 500.00 fixed principal.

The first choice (Refund principal and ALL outstanding Interest first) refunds all outstanding interest in the first selected
payment (08-01-2010). Thus on this line is refunded:

Outstanding interest 898.80

Interest for the period 153.94

Principal for the period 500.00

Total payment 1552.74
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The second choice (Refund principal and interest FOR THE PERIOD only)(default method) will only refund the interest for
the current period (153.94) and 500.00 in principal that will reduce the "True Balance" by 500.00 (True balance goes from
25,898.80  to  25,389.80).  Thus,  the  "True  Balance"  reduces  by  500.00  as  opposed  to  reducing  to  the  original  25,000
principal as with first option. The amount indicated in the "Principal" column is  0.00 since in  fact  the 500.00 served to
reduce the interest portion of the balance as opposed to true principal.

Only in the second blue line does true principal get refunded (101.20) since the payment becomes sufficient to refund all
outstanding interest.

The third option (Refund principal  WITHOUT refunding outstanding interest)  is  not suggested  since it  does not  respect
generally recognized interest calculation methods by which outstanding interest is always refunded before principal. As
seen below, the 500.00 in fixed principal will immediately reduce the "Computational Balance". 
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It will also reduce the "True Balance" by 500.00 less the interest for the period. For the first blue line above:

True balance 07-01-2010 25,898.80

Principal for the period (refunded thus subtracted) 500.00

Interest for the period  (not refunded thus added) 153.94

True balance 08-01-2010 25,552.74

This method may lead to odd scenarios in which the "Computational Balance" reaches 0.00 (or even a negative amount)
before the "True Balance" does. If a negative amount is reached in the "Computational Balance", negative interest will be
computed, thus actually refunding principal.

Principal can also be refunded without paying interest first with the "Paid Principal" Line status. See section 2) below. 

Changing Fixed principal methods

If  you  wish  to  change  from  one  method  to  another  (not  usual),  click  on  Data   and  change  the
"Method Fixed Principal"  from one to  another  and  go  back  to  the  Payment  schedule.  If  the  lines  are  tagged as  "Fixed
Principal" you will  immediately see the effect of  your choice.  If  the lines are not  tagged, then you must right click and
recompute the fixed principal amount.
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A change in the method will impact ALL payments that have this special behavior. Different payment methods cannot be
specified for individual payment lines.

2) Refunding principal only (regardless of interest and Column Fees balances) with the "Paid Principal" Line status

Generally,  outstanding  and  accrued  interest  are  paid  before  principal.  In  exceptional  cases,  one  might  want  to  pay
principal even when there is an interest (and Column Fees) balance.

Two methods can be used to refund the principal without paying the interest and Column Fees.

1. "Fixed Principal Payment Adjustment" method with option 3, as described previously.

2. With the "Paid Principal" Line status.  See details  in  the "Payment" Type Line statuses chapter,  under the "Paid Principal"
Line status section.

See also:

Payments (equal) recomputed to yield a balance = 0.00 or other amount

Right mouse click

"Payment" Type Line statuses

"Principal" Type Line statuses

   

Changing one or multiple payments

In a Payment schedule, to change a payment, simply click on the payment which will  become blue (sometimes gray on
certain laptops) and change the payment.

To change multiple payments at once, as in to add lump sums every year for example, in the Payment schedule, select
the appropriate lines (Shift and scroll for contiguous lines and Ctrl and click on each desired line for non contiguous lines)
and right click with the mouse to obtain the menu below. Choose "Payments" and "Modify Payment - Selected Lines".
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The "Payment Selection" window will open and allow you to enter the new payment amount. By checking "To add to the
actual  amounts"  the  payment  entered  will  be  added  to  the  actual  payment  whether  these  are  uniform  of  not.  This
feature may be interesting if a Borrower wishes to increase or decrease his/her monthly payment for example.

If these are the payments actually made (as opposed to an initial setup of a loan), then the Line status should be changed
to the proper status. 

The change from Due Pmt to Paid Pmt, the most common situation for normal portfolios, may be done in various ways:

1. Manually in the schedule, line by line. This is a long process that should not be done usually unless a "Paid Pmt" is an
exception, as opposed to the norm.

2. In a schedule by selecting (highlighting) the desired payment lines and using the shortcut:  "Ctrl  Alt  Shift  F12".  This
shortcut will change the "Due Pmt" (and Due Pmt (2) to (5)) to "Paid Pmt" or any other Payment-type Line statuses
whose name can be  customized (Paid  Pmt 2  to  20).  The "Partial  Pmt"  type Line  statuses or  "Late  Pmt"  cannot  be
chosen because the payment amounts or the dates must be entered in the Payment schedule.



Page 804

© Jurismedia Inc., 2007- 2023

3. A much more efficient method is to update many Records at once through the Payment update tool. Please consult
the Tools > Payment update ("Post Payments") section.

 
See also the very important Fundamental principles of operation section.

If  by  contract  or  otherwise,  a  payment  was supposed to  be  made but  was  not  made  or  made  only  partially,  then  the
payment  that  SHOULD have  been  made  may  be  entered  in  the  column  called  "Expec.  Pmt".  This  information  may  be
useful in order to determine the overdue amounts.

See the example in Lump sum payments / Prepayments 

See also Line status and Shortcuts (F2) that offer various options for line selection and payment line attributes.

   

Lump sum payments / Prepayments

Lump  sum  payments  or  prepayments  may  be  included  in  an  Payment  schedule  at  any  point  in  time.  Once  these  are
included, it is also possible to recompute the other regular payments to yield a particular balance (usually 0.00).

In the example below, every three months the Borrower wishes to pay 500.00 instead of the normal 333.67. Select the
appropriate lines (in this case Ctrl and click on the lines or Alt L).
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Right click, Payments > Modify Payment - Selected Lines and enter a payment of 500.00.

Resulting window where each of the selected payments is now 500.00:
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Given these lump sum payments, the 333.67 payment may also be recomputed. See the Payments (equal) recomputed to
yield  a balance = 0.00 or other amount section where the example is continued.

Special lump sum payment / Prepayment

When a payment is of a special nature, for example an early full repayment of the loan or in the case of a default on the
loan, the user may wish to write-off the balance (thus obtaining a balance of 0.00 or other amount),  it  is  suggested to
name this special payment one of the "Payment" Type Line statuses (Paid Pmt (2) to (20)) with a name like "Final Pmt" or
"Write-off  amount".  Thus,  these amounts  (transactions)  can  be  easily  identified and  posted in  the  GL.  See  also  Export
accounting transactions to the General Ledger. It is not recommended to use the "Paid Pmt 11 to 20" Line statuses since
the fields which separate the sub-amounts paid (Column Fees, interest and principal) are not available in the reports.  

When a loan is paid off before its original due date, you can delete all  the lines that follow this special payment which
should  bring  the  balance  to  0.00.  Before  doing  so,  it  is  suggested  to  attach  the  Payment  schedule  (before  the  special
payment  and  before deleting the  lines)  to  the  Record  by  clicking  on  "Attach",  in  order  to  keep  the  loan's  history.  We
could therefore evaluate the "loss" in potential interest caused by the early pay-off. 

   

Adding lines (payments, principal, fees, etc.)

Any  Payment  schedule  may  be  customized,  updated  and  changed  by  adding  new  lines  at  the  END  of  the  table  or
anywhere IN the table.

Adding lines at the end of a Payment schedule

To add lines at the end of a table, press on or right click with the mouse. The following menu will appear:

If "Add One Line" is selected, a single line will be added at the end of the table one period after the last line. If that date is
not the desired date, simply change the date by clicking on it.

If  "Add Many Lines" is  selected, the window below will  appear allowing you to add payments as of  a  certain date and
with many options including rate change, indexation (step payments), etc.
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You can add Column fees on lines added. By clicking on the "Add Fees" link, the window allowing the addition of the six
(6) Column fees will appear:

Insert lines in a payment table (between existing lines)

To insert lines between existing lines click on  or right click with the mouse. The following window will appear.
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If only one line is to be added, leave at "1". 

The line will be added above the selected line or lines so always select the line below where you wish to insert.

If many lines are selected, one or many lines will be inserted above the first line, above the second line and so forth. 

For example, when these three (3) lines are selected (selected lines are highlighted in blue) and the user indicates that 2
lines are to be added between each line:

Three  sets  of  two  lines,  total  six  new  lines  with  0.00  payments  lines  will  be  inserted  in  the  table  above  each  of  the
selected lines. Notice that Line status becomes "Information". This will have to change as the payment amount is entered
(positive or negative amount): 

The dates, payments and interest rates may then be modified for each of these lines.

See also the very powerful features for adding lines with the Right mouse click. The "Insert" (one line selected) or "Insert
lines"  choices,  followed  by  "Payment(s)"  will  add  new  lines  in  a  table  as  of  the  date  indicated.  Lines  will  be  inserted
automatically at the proper places in the schedule. If a positive payment is indicated, this will be a refund. If a negative
payment is indicated, this will increase the balance.

See also Shortcuts (F2 key in MLM) offering multiple line selection options including Alt 2 which selects every second line
and Alt L that selects one line every X lines.

   

Payments (equal) recomputed to yield a balance = 0.00 or other amount

Equal  payments  may  need  to  be  recomputed  to  yield  a  balance  =  0.00  or  another  amount  if,  for  example,  lump  sum
payments  are  made,  if  additional  principal  is  added  during  the  loan,  or  if  a  loan  consists  partially  of  interest-only
payments.

Two options are available in the software: 
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Manual payment amount recalculation

Automatic payment amount recalculation (Behavior)

Manual payment amount recalculation

Let's continue the example of lump sum payments started in the Lump sum payments / Prepayments section. "Normal"
payments  (333.67) must be recomputed since 500.00 lump sum payments are made every three months. The table was
changed as seen below and the new balance (now minus 4483.34 instead of 0.00 with regular payments) is recomputed
automatically.

Choose all the lines with payments of 333.67. A trick to select these lines is to select all lines (Ctrl-A) and then with the
Ctrl key and the mouse, click on the 500.00 lines to deselect them. This will be faster than doing the opposite. 
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Once the lines are selected, right click with the mouse and choose Payments > Payments Adjusted for Balance = 0.00 or
Payments Adjusted for Balance = X.

  

For  "Payments  Adjusted  for  Balance  =  0",  the  0.00  may  be  another  amount  if  the  amount  at  the  bottom  left  of  the
window is another amount. In the examples below, when the balance at the bottom is changed, and the box checked,
the right mouse click menu will adjust consequently:

For "Payments Adjusted for Balance = X" this window will appear allowing you to enter the desired balance.
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To continue our example, we can choose "Payments Adjusted for Balance = 0" since our balance is 0.00 at the end. The
payments will then be recomputed. In this example, the payments will become 251.74.

Automatic payment amount recalculation (Behavior)

As of version 5.4, it is possible to automatically recompute payments in order to have a final balance = 0.00 or another
amount (X), regardless of the transactions above (missed or partial  payment, additional principal,  interest rate change,
etc.). This can be done with a "Line behavior".

The option is available upon creating the loan or once the Payment schedule is created. This advanced option must be
activated for a user in Tools > Settings > User settings > Options:  Interest-only and Fixed Principal.  The first  box below
must  be  checked  for  this  choice  to  be  offered  when  first  creating  the  Payment  schedule  and  the  second  to  add  the
"Behavior" after the loan (Payment schedule) is created.

1) Behavior added when creating the loan

In the tab Data, choose "Normal (Principal + Interest) as the Payment Method and check "Add Behavior".  All  the "Due
Pmt"  lines  will  include  the  label  "BalanceRecalc."  in  the  "Pmt  Type"  column  of  the  Payment  schedule  and  will
automatically be adjusted throughout the life of the loan to give a final balance of 0.00 or X.
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It is possible to eliminate this Behavior for one or more lines. In the Payment schedule, select the lines > right mouse clic
> Payments > "Untag - Interest-only / Fixed Principal / Recompute / No interest":

The "BalanceRecalc." label will be eliminated from the "Pmt Type" column (3 blue lines in the following example):

The Behavior will be automatically eliminated when a "Due Pmt" is "managed" and becomes a "Paid Pmt", "Unpaid Pmt",
etc.,  because  once  the  real  payment  is  entered,  we  do  not  want  this  payment  to  be  recomputed,  regardless  of  the
changes in the Payment schedule prior to this payment.

2) Behavior added in the Payment schedule

In the Payment schedule, select all of the payment lines that must be recomputed for a balance of 0.00 or X. Right mouse
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clic > Payments > Payment(s) adjusted for balance = ....

This window will appear if the option is activated for the user (can be with final balance = 0.00 or X). X = 100.00 in this
example):

Check "Remember this  "Line behavior"  and  always  recompute..."  box.  Payments  will  always  be  adjusted  automatically
unless the Behavior is eliminated (see explanation above).

Only  the  "Due  Pmt"  and  "Undefined"  Line  statuses  (by  exception  in  order  to  deal  with  non-compliant  situations)  can
include this Behavior. Be careful not to change the lines that do not allow this Behavior because some data could be lost.
A warning will be displayed - please read the warning carefully!

See also: Amount Due variables (Activation).

   

Changing the date of a payment

The date of any payment may be changed easily, simply by clicking on it in a Payment schedule. The date becomes blue
(or gray on certain laptops) and can be changed to any date as long as it is a date in between the payment date above
and below (the chronological order must be followed).  

The date may also be changed to the same payment date as that above or below, thus allowing multiple lines with the
same payment date (for example multiple payments on one day or a payment, a fee, additional principal, etc.).

Payment date and Line status

If  a  payment was due on  a  certain  date  but  was late,  Line  status  could  be  changed to  "Unpaid  Pmt"  and  another  line
added  when  the  payment  is  actually  received.  This  new  line  could  have  a  "Late  Pmt"  or  "Partial  Late  Pmt"  status.
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Alternatively, the actual late payment date line can also be changed to the true payment date and the status changed to
"Late Pmt" or "Partial Late Pmt". A pop up window will ask for the date at which the payment SHOULD have been paid.
This tracks late payments and provides a history of a client's trustworthiness.

A column called "Pmt Due Date" is contained to the right of the "Expect. Pmt" column. A date  may be entered in this
column ONLY IF Line status is "Late Pmt" or "Partial Late Pmt". 

When a payment's Line status is "Paid Late Pmt" the following window will ask for a date at which the payment SHOULD
have been paid and the TRUE payment date:

When  a  payment's  Line  status  is  "Partial  Late  Pmt"  the  following  window  will  ask  for  the  date  at  which  the  payment
SHOULD have been made,  the  payment  amount  that  SHOULD have  been  paid  as  well  as  the  TRUE payment  date  and
amount:



Page 815

© Jurismedia Inc., 2007- 2023

Note: The true payment amount and the true payment date may also be changed directly in the payment line per se.

Payment dates can also be changed for several Records with the Payment update ("Post Payments")tool.

See the important Late or partial payments section.

To change payment dates for many Records (loans) at once, so in bulk, see Tools > Payment update (Post Payments") >
Change payment dates in bulk for many Records at once subsection.

   

Deleting a line or lines

Any line or lines may be deleted in a Payment schedule except the very first original line since it  serves as a reference.
Records created  with version 5.0 or later of Margill  Loan Manager are no longer subject to the latter rule. The original
first line may be deleted or its date modified. A Record created before version 5.0 even if it is now in version 5.0 or later
does not allow the first line to be modified since the calculation uses the old method. 

Select the line or lines to be deleted and use either the  at the right of the Payment schedule or the right mouse
click. A confirmation window will appear:

NOTE:  In order to maintain maximum record information, it  is suggested, once a theoretical  schedule is  produced (see
Fundamental Principles of Operation), never to actually delete a line but rather assign the proper Line status based on
the  type  of  transaction.  For  example,  an  unpaid  payment  should  be  given  the  "Unpaid  Pmt"  status  and  the  expected
payment  amount  entered  in  the  "Expect.  Pmt"  column.  One  can  then  better  evaluate  if  a  Borrower  respects  his
commitments and also obtain data that becomes valuable for credit rating agencies.

Another type of line that cannot be deleted is a Capitalization line (green line) when this line is not the last line in  the
Payment schedule. If this were allowed, the mandatory computing method would no longer be taken into account. Only
the last line of Capitalization can be deleted in order to reduce the duration of the loan.
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Adding or changing Interest rates in a Payment schedule

A Payment schedule may include one or many interest rates and these may be changed or added at  any point  in  time
either:

Manually - one rate at a time

Manually - multiple rates

Adding a new rate in the Payment schedule

Changing the interest rate for multiple Records in one operation

Advanced variable Interest rate tables

Manually changing one rate at a time

Click on a interest rate in the Payment schedule. The rate will become blue. Simply replace the existing rate.

Manually changing multiple rates

To change multiple rates at once in a Payment schedule, select the lines to change (Shift or Ctrl key and mouse click) and
right click with the mouse. In the menu that appears, choose "Interest Rate(s)" and "Modify Rate - Selected Lines".
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Then enter the rate that is to be applied for the selected lines. 

A rate may also be added or subtracted (-x%) to the existing rates (practical when dealing with variable interest rates).
Check "To add to actual rates".

Adding a new rate in the Payment schedule

Select (highlight) any line in the Payment schedule and right click with the mouse. Among the choices in the menu,
choose "Insert" (or "Interest Rates") and "Rate Change":

With the "Rate Change" choice, the interest rate may be inserted or changed at any date. The rate may be applied to the
rest of the table by checking the appropriate box. New equal payments may also be recomputed to give a final balance =
0.00 or other amount.  

With this function, when a new rate is inserted in the Payment schedule, the "Rate Chg." (Rate change) Line status will be
included.  If  a  rate  change  line  has  any  other  amount  than  0.00  as  its  payment,  the  Line  status  should  be  changed  to
reflect what type of payment is actually made (see also Data Integrity).

Changing the interest rate for multiple Records in one operation
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If, for example, a fixed interest rate is applicable to some loans and the interest rate changes every year for another set
of loans, it is possible to change the rates only for this last set of loans in one simple operation. 

 First,  the  loans  to  change  must  be  selected  in  the  Main  MLM  window.  The  loans  must  thus  be  isolated  from  the
others. This can be done by sorting or with a display filter along with a custom field to indicate the interest rate type.

o A  custom field  can  be  created  by  the  Administrator  through  Settings  >  System  settings  (Administrator)  >
Custom fields. This custom field must be linked to the Record. It is recommended to create a scroll menu for
the interest rate type (see Scroll menus section). 

 

 The  "Interest  rate  type"  custom field  should  be  displayed  in  the  Main  MLM  window in  order  to  sort  the  Records
using this criteria.

o To add this field to the Main window, go to Tools > Settings > User Settings > "Record Summary Window"
button (see the Record Summary Window, Displayed column selection and order section).

o One of  three custom field  Display  Filters  can  also  be  used to  display  only  the  Records having  the  desired
characteristic.

 In the Main MLM window, click on the "Interest rate type" (custom field name) header to sort the Records by type.
Select (highlight) only the desired Records.

o Warning: set the various display filters to "All", otherwise some Records may not be displayed and thus be
ignored when updating the rates.

 In the following example, we wish to increase the interest rate by 0.5% as of June 6, 2020. The "Ctrl / Alt / Shift / I"
shortcut will display the window in which to specify the percentage to be added to the current rate, and the date at
which the rate change will occur. If -0.5% (negative 0.5%) had been entered, then the interest rate would have been
reduced by 0.5%.
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We can also enter a new rate without selecting the "Add to actual rate" option. This will change all selected Records to
the same interest rate which may not always be desired. 

The "Apply" button automatically changes the rate for all  the Records selected. A confirmation will  be required as this
operation CANNOT be canceled.

You  will  also  be  prompted  to  make  a  backup  before  updating.  This  is  strongly  suggested.  The  user  must  have  the
appropriate read/write permissions in the MLM data backup folder.

It is also possible to change the interest rate only for a specific time period, as opposed to as of a date and for the rest of
the schedule. Check "Add End date of rate change...". In this example, the rate was changed from April 1, 2020 to July 31
(inclusively) to 0.00%. The rate could also have been temporarily reduced or increased.
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Notice that two "Rate Change" lines were added in the payment schedule. One could think the "Rate Change" indication
on  line  12  is  wrong  since  the  rate  is  still  10%  but  this  indicates  simply  that  the  10%  is  closing  up  (on  03-31-2020  at
midnight minus one second the rate is still 10% but changes to 0% on 04-01-2020 at 0:00+). By displaying the "Start Date"
column, this is easier to conceptualize...

Advanced variable Interest Rate table module

This module allows Records (loans or others) to be created using variable interest rates and the Payment schedules to be
updated automatically as the interest tables are updated. See detailed information on this in the  Variable interest rate
module - Introduction and Methods and following sections. 

   

Interest rate (equal) recomputed to yield a balance = 0.00 or other amount

Margill Loan Manager (MLM) may be used to compute the interest rate of a loan or investment that includes regular and
irregular money inputs and outputs. If the interest rate (or the return on investment (ROI) or internal rate of return (IRR))
is not known, it may easily be figured out no matter how complex the loan or investment.
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In this example, an initial 100,000 investment is made on June 1, 2006. Various pay-ins (positive payments) and pay outs
(negative  payments)  are  made  over  time  with  a  balance  of  135,100  24  months  later.  What  is  the  ROI  (IRR)  for  this
investment? 

Below is the preliminary schedule created. A 0.00% interest rate is included but is of no pertinence since on 05-01-2008,
the balance is known to be 135,100.  

To calculate the interest rate,  select all  lines (Ctrl-A), right click with the mouse and choose "Interest rates" and "Rates
adjusted for Balance = X".

A window will appear in which to specify the balance of 135,100. 
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Click  on  OK  and  MLM  will  automatically  compute  the  appropriate  interest  rate  (ROI  or  IRR)  for  this  investment.  The
nominal rate is 15.4314%. To obtain the true annual, non compounded return, it may be wise to use simple interest as
oppose to compound interest for this calculation.

The  last  payment  of  0.03  may  be  eliminated  with  the   button  at  the  bottom  right  of  the  window  which  adjusts
rounding either on the payment or on the interest portion.

With "Adjust on Interest", the last payment becomes 0.00 and the interest is  increased by 0.03.  A note appears in  the
window (and in the printed report) to explain this.



Page 823

© Jurismedia Inc., 2007- 2023

Distinction between "Rates Adjusted for Balance = 0" and "Rates Adjusted for Balance = X"

For "Rates Adjusted for Balance = 0", the 0.00 may be another amount if the amount at the bottom left of the window
other  than  0.00.  In  the  examples  below,  when  the  balance  at  the  bottom  is  changed,  and  the  box  checked,  the  right
mouse click menu will adjust consequently:

 

If "Rates Adjusted for Balance = X" is chosen, then this window will appear allowing you to enter the balance desired.

See also:

Payments (equal) recomputed to yield a balance = 0.00 or other amount

Interest Rate recomputed to adjust Line Interest amount

   

Interest rate recomputed to adjust Line Interest amount

When a previously existing loan (calculated by hand, with other software or in a spreadsheet) is replicated in the Margill
Loan Manager (MLM), it is possible that the interest amount for certain lines and balances are not exactly the same in
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both schedules, particularly in irregular scenarios. A Creditor may wish to change interest rates of one or more lines to
reach the same amounts.

If  multiple  lines  are  to  be  recomputed  to  obtain  a  final  balance  of  X,  use  the  tool  described  in  the  previous  section,
Interest rate (equal) recomputed to yield a balance = 0.00 or other amount.

However, if the amount of interest in a particular line should be a specific amount, the tool "Adjust Rate for Line Interest
= X" will recompute, in a fraction of a second, the appropriate interest rate to obtain the amount of interest required.

Example:

In  our  scenario,  all  calculations  performed  with  the  previous  calculator  correspond  to  MLM’s  calculations  up  to  the
interest amount calculated on line 4 on which the payment is made on 09-22 instead of the 1st of the month. With the
old calculator, the amount of interest was, hypothetically, 500.00 whereas with MLM, the amount is at 511.21. We need
to  adjust  the  interest  rate  to  correspond  to  the  old  schedule  already  provided  to  the  Borrower  (and  in  order  not  to
change the accounting data even if erroneous initially).

We could manually adjust by trial and error, changing the interest rate gradually. To expedite the process, use the "Rates
Adjusted for Balance = X" tool to calculate the interest rate.

Line 4 is highlighted (thus in blue), right mouse click, select "Interest Rate" and "Adjust Rate for Line Interest = X".

Enter the desired interest amount for the period, 500.00 in our case, and press OK.

The rate will be recomputed in a fraction of a second and the interest, principal and balances adjusted for the rest of the
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table to take into account this change. The rate thus becomes 7.3554% for the period from 08-01 to 09-22.

Notes:

 The tool is available if only one line is selected.
 The amount of interest must be 0.00 or more (cannot be negative).
 If  a  line  contains  a  special  behavior  by  which  the  payment  must  be  recomputed  under  certain  circumstances  (

Interest-only or Fixed principal), a rate change will also involve a change in the payment amount. MLM will prompt
you whether to remove the line behavior or not.

 In some situations, rounding to 6 decimal places may not sufficient to obtain exactly the desired amount. A message
will appear if  the precise amount entered cannot be reached. You will  have the choice to apply the corresponding
rounded interest rate or not.

 The maximum rate is 999.9999% and the minimum rate is 0.00%. If the rate is not within range, the calculation will
be aborted. A warning will be given.

Desired balance is known (but unknown interest amount)

If the amount of interest is unknown, but the balance on that date (09-22 in our example) is known, a simple subtraction
will first determine the interest amount to then make use of the tool.

In the same example, the balance on line 4 should be 47,300.00. To achieve this balance, the interest of 500.00 must be
decreased  by  79.70  (47,379.70  to  47,300.00  =  79.70).  Thus  the  interest  for  the  period  will  be  500.00  minus  79.70  =
420.30.

The new rate for that period then becomes 6.1850%.

   

Calculation method for Short periods

For  "Short  Periods"  or  regular  periods,  your  are  not  limited  to  use  the  effective  rate  compound  interest  calculation
methods.  You  can  choose  a  special  calculation  method  at  any  given  time.  You  can  even  have  a  "mix"  of  compound
interest (effective rate method) and simple interest with interest that is capitalized or not. 

This choice is offered to comply with certain laws and practices which state that if a payment period is less than a normal
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reimbursement period, (for example, an additional monthly payment made on another date, creating two short periods
(18  and  13  days))  the  interest  for  that  "short"  period  will  be  computed  using  simple  interest  then  compounded  or
capitalized on the next payment date as opposed to normal compound interest. This is used particularly for the interest
calculated on the first payment that is made after the origination date but before a full period. For example, origination
date is 01/26 and first payment is 02/01, six days apart.  Some will  calculate interest as such:  Principal  x  interest rate x
6/365 for these 6 days even for a compound interest loan.

Ten alternative methods are allowed:

 Simple Interest Capitalized - Actual/366
 Simple Interest Capitalized - Actual/365
 Simple Interest Capitalized - Actual/360
 Simple Interest Capitalized - 30/360
 Simple Interest Capitalized - 30/360 U
 Simple Interest Actual/366
 Simple Interest Actual/365
 Simple Interest Actual/360
 Simple Interest 30/360
 Simple Interest 30/360 U

These calculation methods can apply to one or several lines chosen by the user in the Payment schedule. It can also be
set in  the "Advanced" tab for the short  period between the Origination date  and  the  First  Payment  Date.  See Interest
Adjustment Date in the Margill Loan Manager Calculations section > How to do > Mortgages.

The method will be applied to the specific lines selected with a right mouse click.

"Actual/366" should only be used during leap years.

For more information on "short periods" and the default short setting, consult the Short & Long periods section of the
Calculation methods chapter.
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Additional Principal, Fees, Penalties, Insurance and Taxes

It is possible to add additional principal and fees (insurance and taxes) to a payment table at any time. This principal and
these fees can bear interest or not.

Additional Principal

Fees financed (charged)

1) Line status Fees
2) Column Fees

Fees paid

1) Line status Fees - paid
2) Column Fees - paid

Refund order for Interest, Fees and Principal

Principal and Fees with no interest

Additional Principal

A loan or investment may comprise multiple loans / investments over time. In Margill  Loan Manager (MLM), these are
always indicated as negative payments. 

In  the  "Data"  window (partial  screen  shot)  below,  there  is  an  initial  100,000  loan  on  November  11,  2006  followed  by
monthly loans (minus 12,000) starting on March 1, 2007.

By pressing on "Compute", the Payment schedule appears:
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The "Due Pmt"  Line status  will  automatically  change to  "Add.  Princ.  (Loan)"  (for  Additional  principal)  when  a  negative
amount is entered in the payment.

The  amounts  and  dates  may  be  changed  for  any  line.  Payments  may  be  added  between  lines  or  regular  payments
computed for a normal amortization schedule.

"Add. Princ.  (Loan)" Line status will  have an effect on the Accounting data.  This will  add principal  to the  "Balance Due
Principal" column. This, and the nine (9) other "Add. Princ." Line statuses (whose name may be customized by the User)
are the only Line statuses that add to this column. 

In the example below, the balance after 6 months is to be refunded in 12 equal payments. 12 lines are thus added with

the  icon to the right.

The payment amount entered, if  unknown, could be 0.00 or  ideally  1.00 in  order to generate a  "Due Pmt"  Line  status
instead of "Information". Once the lines have bee added, the 12 lines will be recomputed with the right mouse click and
the Payments (equal) recomputed to yield a balance = 0.00 or other amount function.
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The  schedule  is  thus  made  up  of  negative  payments  (additional  principal)  and  positive  amounts  (refunds  by  the
Borrower).

Principal that bears no interest may also be added in a loan (see section below).

It is possible to create a Line status that specifies the type of additional principal to be added. This is done with the Add.
Princ. (2) to (10) Line statuses. These Line statuses can be renamed (e.g. "Loan 2") in Settings > Line Payment Statuses to
distinguish them from each other, depending on the principal type (or the type of loan). Thus, for accounting purposes,
these amounts can be isolated to create individual reports. 

Using custom Additional principal names: Refinanced loan

A typical example would be a loan (that includes a balance) that is renegotiated and transferred to a new loan. We
must thus close one loan and open a new one. 

In Tools > Settings, the Line status "Paid Pmt (2)" could be renamed "Paid Pmt transfer" and accompanied by Line
status "Add. Princ. (2)" renamed "Add. Princ. Balance transfer". 

The last  line  of  the  payment  schedule  would  be  "Paid  Pmt  transfer"  that  would  repay  the  balance  of  a  loan  (e.g.
15,850). 

A new loan with an Original Principal of 0.00 would include for its first line, a negative amount of  15,850 with the
"Add.  Princ.  Balance transfer"  Line  status.  The origination  principal  would  have  been  0.00  unless  another  amount
had been loaned (cash loan). 

A customized report produced by the user would identify all amounts throughout the year including the balance that
was transferred to another loan. This amount is non-monetary and therefore would not be accompanied by a bank
transaction.
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See the Line status and Export accounting transactions (Debits and Credits) to the General Ledger sections.

Fees (penalties, invoices, taxes and insurance)

Fees can be added (charged or financed) in the Payment schedule by two methods: 1) Fees by Line status and 2) Column
Fees.

1) Fees, penalties, taxes and insurance entered as Line statuses are, like Additional principal,  represented as a negative
payment which will increase the loan balance. These may be entered on the same date as another transaction such as
the non payment of an amount due.

Six (6) fee descriptions by Line statuses are available (Fees, Fees 2 to Fees 6) as well as one called Penalty. The description
of fees may be customized to a more descriptive name to precisely reflect the type of fee charged. See the Line status
section for more detail. The other Line statuses, "Taxes", "Insurance" and "Invoices" may be added at any time.

2)  Column Fees are  much more sophisticated that  the  Line  status  Fees since they  can  be  entered  in  batches,  even  be
automatically  added  according  to  rules  established  by  the  Margill  Administrator  and  paid  with  a  normal  payment
("Payment" type Line status). Six (6) Column Fees are available. See the important section Fees, Insurance and Taxes in
How to do ....

Paid Fees, paid Penalties, paid Taxes, paid Insurance and paid Invoices

Fees,  penalties,  taxes  and  insurance  are  first  charged  and  then  can  be  paid.  This  allows  MLM  to  distinguish,  for
accounting purposes, when interest and true principal (accounting) are paid by the Borrower versus these other fee-type
charges.

1) Paid Line status Fees

To pay the Fees charged, a "Fees paid" Line status must absolutely be added to the Payment schedule otherwise these
fees will be charged but never paid from an accounting perspective even if they are paid mathematically.

For  data  integrity  reasons,  a  "Paid"  Line  status  (or  Paid  penalty,  insurance  or  tax)  should  never  be  larger  than  its
equivalent  negative  counterpart.  For  example,  two  fees  are  charged  (Line  status  "Fees"),  the  first  for  100.00  and  the
second a month later for  150.00 for a  total  of  250.00. Further down the payment schedule you try  to enter 300.00 as
"Fees Paid". The following message will appear indicating that the maximum amount of fees should be 250.00. 

By  pressing  on  "Enter  250.00",  this  amount  will  be  entered  for  you  in  the  schedule.  By  pressing  on  "No  thanks"  your
payment amount will remain in the schedule but the "Fees Paid" Line status will appear in red to highlight the potential
problem.
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Once the "Fees Paid" is  entered at  250.00 and you attempt to lower the fees charged above (thus total  fees less  than
250.00), the "Fees Paid" Line status will appear in red until they are changed and correspond to a maximum of the total
fees charged above. MLM will not change any amount. The flag is raised with the Line status in red.

PLEASE NOTE: A positive payment made with the "Fees paid" type Line status will reduce the loan balance (mathematical
principal) but not the accounting principal. Only the "Payment" type Line status (Paid Pmt, Partial Pmt, Paid Pmt 6, etc.)
can refund the interest and the principal. Likewise, a Line Fee is never paid by a "Payment" type Line status.

IMPORTANT NOTE: Even if the Line status is "Fees" (or other fee type or "Paid" fee status), for Annual Percentage Rate
(APR) calculation purposes, this will not be computed as a fee but rather as additional principal for which interest will be
charged. See "IMPORTANT FOR APR CALCULATIONS" in the Line status chapter.

The "Fees" and "Fees Paid" Line statuses may be renamed in order to properly describe these. It is critical that the name
given to  "Fees Paid"  correspond to  the  matching "Fees".  For  example,  when renaming "Fees 2"  to  "Fees -  Admin"  the
"Fees 2 Paid" Line status should be "Fees Paid - Admin", maintaining the link between these statuses.

Line  status  Fees  offer  an  advantage  compared  to  the  Column  Fees,  when  their  payment  MUST  be  made  on  a  date
determined  by  the  user  as  opposed  to  the  system's  normal  refund  order.  Line  status  Fees  work  for  more  unique
situations,  when  fees  are  charged  occasionally  for  example.  Column  Fees  are  used  when  fees  are  regular  or  must  be
charged according to different situations such as unpaid payments and are therefore added automatically by the system
according to various user-defined rules.

2) Paid Column Fees
 
Column Fees substantially reduce management challenges and accounting problems because a Payment ("Payment" type
Line status) will pay Column Fees automatically without having to specify so, all the while paying interest and principal in
the same transaction. 

The refund order by a "Payment" type Line status is established as such in MLM:   

1. Column Fees 1
2. Column Fees 2
3. Column Fees 3
4. Column Fees 4
5. Column Fees 5
6. Column Fees 6
7. Interest
8. Principal

This order can partially be modified. See Column Fees payment order with exceptional priority in the "Payment" type Line
statuses section.

You can see the Column Fees paid in the Payment schedule for each of the four types of Column Fees. Other than the
partial modification allowed in the previous paragraph, the Fees paid amount cannot be changed in this column since it is
automatically computed. 

See important section Fees, Insurance and Taxes in How to do... and section Refund order for Interest, Fees and Principal
in Calculation methods.
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Refund order for Interest, Fees and Principal

See the Calculations Methods chapter, Refund order for Interest, Fees and Principal section for further information and
examples as to what is refunded when payments are made.

Principal and Fees not bearing interest

By  default,  interest  is  charged  on  additional  principal  and  these  various  fees  (Line  status  Fees  and  Column  Fees).
However, MLM allows additional principal (Add, Princ. (Loan),  Add. Princ. (2) to (10)), fees (Fees, Fees 2 to 6), Invoices,
Penalties, Insurance, Taxes and Column Fees (1 to 6) not to bear interest.

To do this, change the Line status to the desired type (negative amount). Select (highlight) the desired lines that should
not  bear  interest  (Ctrl  or  Shift  key  and  click  on  the  mouse).  With  the  right  mouse  button  select  "Payments"  and  "No
interest Add. Princ., Fees, Taxes, Insurance, etc.". 

With this choice, no interest will be charged on the negative amounts entered for the selected lines. The Line statuses will
be dark blue to indicate that these are "special" lines and in the last  column of  the Payment schedule (Pmt Type),  the
lines will have the "No Interest" tag. 

To delete this special "behavior" (no interest), choose the lines (highlight) and with the right click of the mouse choose
"Payments" then "Untag -  Interest-only  /  Fixed Principal  /  No Interest  /  ...".  The  "No  Interest"  tag  will  be  deleted  and
interest will be calculated on the amounts. Interest is always recomputed automatically.
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It is possible, as the default setting for a specific Record or for all Records, for additional principal (and Fees and other, by
Line status) not to bear interest. In a Record, go to the "Advanced" tab and check the "No interest on..." box. To set this
as the default for all Records, press on "Save as default". A Profile could also be set to be used for certain types of loans.

Upon checking "No interest on...", existing additional principal or fees in the Payment schedule for that Record will not
be changed to become interest-free but any new principal or fees added consequently will not bear interest. 

Please note  that  even if  this  box  is  checked,  if  a  Principal  amount  is  entered  in  the  "Data"  window (thus,  the  original
principal), interest will be charged on the amount entered. In order for there not to be interest on a principal amount, in
the  "Data"  window,  insert  identical  dates  for  the  "Origination  Date"  and  "First  Payment  Date"  and  enter  0.00  as  the
"Principal". In the Payment schedule, insert a line on the desired date with the principal amount (negative amount) and
"Add. Princ." Line status. Make sure that "No Interest" is indicated in the "Pmt Type" column.

In order for the Column Fees not to bear interest, you must specify so in the "Insert Column Fees" window:
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You can access this window either by the "Data" window: 

Or, in the Payment schedule, with the right mouse click:
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We see that these Column Fees do not bear interest when the "Fees X - Pmt Type" column has the "No Interest" mention:

In order for these Column Fees to start bearing interest again, open the "Insert Column Fees" window and enter the Fees
amount without checking the "NO interest on these fees" box.

In order for these Column Fees never to bear interest, in the "Data" window, click on "Add Fees" > "Insert Column Fees"
window  >  Select  "Activate"  >  check  "NO  interest  on  these  fees"  >  close  the  "Insert  Column  Fees"  window  with  the
"Submit" button > then click on "Save as default" at the bottom of the Data window. 

The "Amount" in the Column Fees should ordinarily be 0.00 unless you want a Fee to be added to each payment.
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Total payments, interest, principal

Obtain the total of the principal and accrued interest (or totals for specific lines) in a payment schedule. Adjacent or non
adjacent lines may be chosen.

If only one line is selected, the totals will be for the
lines above and including the selected line.

If multiple lines are selected, the totals will be for
those selected lines only
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Upon clicking on the choice, totals will show up in the window:

The totals may also be seen at the bottom of the Payment schedule window:

See also the powerful Right mouse click functions.
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Unknown interest rate

Unknown interest rate contents

Regular loan

Irregular loan (determination of rate in completed schedule)

   

Regular loan

For calculations at a unique fixed interest rate, in the "Data" window, it is possible to leave the interest rate at 0.00% so
that the rate is calculated automatically. 

By indicating a rate of 0.00%, Margill Loan Manager will ask you if a rate of 0.00% should be used (thus no interest) or if
the  interest  rate  should  be  calculated  if  all  other  variables  are  specified  (principal,  number  of  payments,  payment
amount).

   

Irregular loan (determination of rate in payment schedule)

When  a  loan  or  investment  is  reimbursed  with  various  regular  and  irregular  payments  and  investments,  Margill  Loan
Manager can determine the precise interest rate (or internal rate of return (IRR) or return on investment (ROI)).

To  obtain  the  true  annual,  non  compounded  return,  it  may  be  wise  to  use  simple  interest  as  oppose  to  compound
interest for this calculation.

 
See the detailed section Interest rate (equal) recomputed to yield a balance = 0.00 or other amount.

See also Interest rate (equal) recomputed to yield a balance = 0.00 or other amount.
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Balance options & information

Balance options & information contents

Balance other than 0.00 in Data entry window

Compute final payment for balance = 0.00 or other amount

Ignore small loan balance (add to interest fee)

Balance columns in Payment schedule

   

Balance other than 0.00 in Data entry window

In the "Data" entry window if the balance of the loan is other than 0.00, indicate the desired balance in  the "Balance"
field.

This is often used for a residual value in a lease or the terminal value of an investment (for example insurance policy) at
its term.

See also Interest rate (equal) recomputed to yield a balance = 0.00 or other amount.

   

Automatic payment amount recalculation (Behavior) for balance = 0.00 or other
amount

See the Manual payment amount recalculation subsection of the Payments (equal) recomputed to yield a balance = 0.00
or other amount section.

   

Compute final payment for balance = 0.00 or other amount

In  certain  situations,  a  balance  will  appear  on  the  last  line.  By  checking  at  the  bottom  left  of  the  Payment  schedule
window, "Balance = x", Margill Loan Manager (MLM) will simply adjust the last payment to yield a balance = 0.00 or any
other amount.

It  is strongly suggested to check the box to compute the last payment but then to uncheck it  in order for  MLM not  to
recompute the last payment any time a change is made in the Payment schedule. This 0.00 balance (or other amount)
may otherwise become misleading since the adjustment will constantly be done on the last payment amount.

An automatic adjustment is not possible when the last Line status in the Payment schedule is other than "Due Pmt" or
"Undefined"  or  is  an  EFT  Payment.  Labeled  lines  too  (Interest  Only,  Fixed  Principal...),  cannot  include  this  automatic
adjustment.  An  adjustment  can  not  be  done  on  a  "Paid  Pmt",  for  example.  In  this  case,  a  message  will  indicate  the
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inability to adjust the balance.

See also Ignore small loan balance (add to interest fee).

The "Ctrl Alt Shift Z" shortcut in the Main window will bulk check the "Balance = 0 (or other amount)" box for the selected
Payment schedules in order to adjust the last "Due Pmt" amount. Only for Records whose last line is of  "Due Pmt" type.

   

Ignore small loan balance (add to interest fee)

In most regular loans comprising equal payments, the very last payment may vary by a few cents or a few dollars because
of money rounding to two (2)  decimal places.  Some lenders require equal  payments throughout the loan all  the while
yielding a balance = 0, thus the adjustment option below.
 
Margill Loan Manager offers two options to compensate for this rounding:

1. Last payment is increased or decreased to give a balance = x (default setting)

2. Last  interest  amount  is  increased or  decreased to  give  a  balance  =  x  with  the  last  payment  equal  to  all  others  or
another desired amount.

This  option  is  available  by  pressing  on  the   button  at  the  bottom  right  of  the  Payment  schedule  window.  This  will
expand the end of window and include these choices. By default, by checking "Balance = x," the adjustment will be made
on the payment:

If the choice "Adjust on Interest" is made, the desired uniform last payment amount should be entered on the bottom
right ("Last payment amount") as well as the "Maximum variation allowed" for this interest adjustment. For example, it
would be inappropriate to adjust on interest if this resulted in a 10.00 interest adjustment.

In the example below, all payments should be 373.50. The adjustment on interest will also be included as a note in the
Payment schedule and in the printed detailed report.
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The "Last Payment amount" is available only for the "Adjust on Interest" option. 

The "Adjust on Interest" option does not work if the amount exceeds the "Maximum variation allowed". In the example
above,  the  maximum variation  is  1.00  and  the  adjustment  was  0.18  for  the  last  payment  to  be  exactly  373.50.  If  the
variation was too large, the following message would appear:

   

Reduce / Increase the last payment to adjust final balance (Advanced)

When this  option  is  selected in  the  Record's  "Advanced"  window and  the  Payment  (Amount)  is  entered  in  the  "Data"
window (so not automatically computed), the last payment amount will be adjusted to yield a balance of 0.00 or X (if a
Balance other than 0.00 is entered in the Data window).

If the "Number of payments (Amort.)" is not entered in the Data window, the number of payments will be calculated to
amortize the principal amount, taking into account the payment amount entered and reducing the last payment for the
desired balance.

If the number of payments (Amort.) and the Payment (Amount) are entered in the Data window, only the last payment
will be adjusted for the desired balance.

For example, here is a 50,000 loan with 12 payments of 4000:
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Scenario when option is checked

Regular scenario

If the loan is "over-amortized" (would be a negative final balance), the last payment would become negative and the Line
status  would  be  "Undefined" (in  red).  No warning will  be  given once the  Compute  button  has  been  clicked.  However,
with bulk imports (via Excel), a warning will be given as this result is usually not desired.

For example, here is a 50 000 loan with 12 payments of 6000:
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Upon checking the option "If payment (Amount) entered, reduce or increase last payment to yield balance = 0.00...", the
last line of the Payment schedule would be negative and the Line status "Undefined". Corrections would have to be made
as this is usually not a desired situation.

If the Term is less than the Number of payments (Amort.), this option will be ignored.

   

Balance columns in Payment schedule

The Margill Loan Manager (MLM) Payment schedule contains 13 Balance columns:
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 Balance (or True Balance for Simple interest calculations): the true balance of the loan. This is the balance at 0:00:01
AM thus right after the payment has been made but excluding the day's interest.

 Balance before Pmt (or True Balance before Pmt for Simple interest calculations): the true balance of the loan but
BEFORE that day's payment has been made (also excludes the day's interest).

 Computational Balance: the balance used for computational purposes in Simple interest and/or when fees and other
are added later but do not bear interest.

 Balance Due Interest: the interest portion of the total balance.

 Balance Due Principal: the principal portion of the total balance.

 Balance all others: the portion of the total balance that is any other type of fee, penalty, taxes, insurance and any
other Line status other that a true payment or additional principal (thus including Invoice, Investment, Adjustment,
Other 1 to 5, etc.). This is a type of melting pot balance column for all other increases or decreases in balance due to
Line statuses other than payments and additional principal.

Balance Due Interest
+ Balance Due Principal

+ Balance all others
 = Balance

 Outstanding  -  Payment  (Balance):  Cumulative  balance  of  the  Payment  amount  that  should  be  paid  (Payment
column) but that is overdue. This column subtracts the amount entered in the Column "Payment" from the amount
entered in the column "Expec. Payment". 

The minimum outstanding amount is 0.00. The outstanding amount cannot be negative even if the payment made is
greater  than  the  outstanding  balance.  In  addition,  the  calculation  of  the  overdue  amount  always  starts  from  a
positive balance or 0.00, never from a negative balance (overpayment).

For  example,  a  payment  of  1000  ("Due  Pmt")  should  have  been  made.  Only  300  ("Payment")  was  paid.  The
"outstanding (balance) therefore becomes 700. The next payment which should have been 1000 is 1200. The amount
in "Due Pmt" should be 1000 and the "Payment" should be 1200. The outstanding (balance) therefore becomes 300
less 200 = 100. The next payment is of 1500 while 1000 was expected. The "outstanding (balance)" becomes 0.00,
not 100 less 500 = -400.

 Outstanding - Interest (Balance): Cumulative balance of the interest calculated on the outstanding balance and on
the interest on this amount when the calculation is done using compound interest (effective rate method) or when a
line  or  lines  use  the  "Simple  Interest  Capitalized"  method.  Interest  is  calculated  using  the  "Outstanding  -  Total
(Balance)" column.

For a calculation using simple interest, the interest amount excludes interest on interest. Interest is calculated using
the "Outstanding - Payment (Balance)" column.

 Outstanding - Total (Balance): Total of the "Outstanding - Payment (Balance)" and "Outstanding - Interest (Balance)"
columns.

 Column Fees 1 to 6 - Balance (as renamed): Four columns are included in the Payment schedule. A payment (Paid
Pmt and others - therefore "Payment" type Line statuses) decreases this balance. 

 Balance Fees  Financed  (APR):  When  APR  Fees  are  Financed,  these  fee  amounts  appear  in  this  column.  Payments
("Payment" type Line statuses) decrease the balance when the payment is sufficient to refund principal (accounting).
The  Fee  amount  is  therefore  reduced  on  a  pro-rated  basis  of  the  accounting  principal's  reduction.  See  Fees  Paid
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up-front, Financed or Paid subsequently in he Annual Percentage Rate (APR) chapter.

Negative balance

If for some reason, it is necessary for the user to manage loans whose balance becomes negative, two Line statuses will
be useful:

The  "Interest  Charged"  and/or  "Interest  Charged  (2)"  Line  statuses  can  "refund"  the  negative  interest.  These  Line
statuses isolate the interest from the principal. 

In the following example, the amount of (860.27) will be used to refund the negative accrued interest:

Please note, only the true balance of the loan prints out in a Detailed report. To obtain all columns, use the Right mouse
click to export the payments table to another format and print. 

Simple interest calculation

In  a  Simple  interest  Payment  schedule  only  (not  applicable  for  compound  interest),  if  the  payment  is  less  than  the
accrued  interest,  the  amount  of  accrued  interest  will  be  increased  but  will  not  bear  interest.  In  MLM,  the  balance
displayed in the “Computational  Balance” column indicates the amount used to compute interest  in  the  following line
(known as the "computational balance") The true balance is displayed in the "True Balance" column.

In  the  following  example,  the  payments  of  500.00  are  not  sufficient  to  cover  the  interest  displayed  in  the  "Interest”
column,  however,  the  balance  used  for  the  calculation  of  the  next  interest  amounts  remains  100,000.00.  The  true
balance is displayed in the "True Balance" column and in the Detailed printed report.
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See the "Refund scenarios when principal, fees (or other) bearing interest, or not, are included" sub-section in Additional
principal, fees, penalties, insurance and taxes and its effect on the Computational Balance column (Calculation methods
chapter).
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Reports

Multiple standard reports and reports personalized by the user are available in  Margill  Loan Manager (MLM). Creating
personalized reports takes seconds and offers great flexibility to the user. This flexibility is greatly increased with the help
of Mathematical  equations that  allow the user to add,  subtract,  multiply and  divide any  number  fields.  More complex
custom reports may also be created by the Margill team based on the user's needs.

In order to reduce of risk of forgetting non-displayed Records when producing reports, the number of Records selected in
the "Record Summary" window is displayed before report production.

In the example above, 85 out of the 87 Records in the database are selected. Two Records are excluded from the report.
If this is not what is intended, return to the "Record Summary" window, change the Display Filters as needed, then select
all the Records (Ctrl A).

The number of Active Records is also displayed. If a report using only Active Records is wanted, in the "Record Summary"
window, you can use the Display Filters to display only the Active Records and then select all Records (Ctrl A) or use very
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powerful Advanced Queries which will report only the desired Records based on the inclusion or exclusion criteria. 

Limit access to Records and reports

In  certain  situations,  some  users  might  not  have  access  rights  to  all  Records  (see  "Can  only  see  own  Records"  in
Administrator and Users). 

The "Records accessible to  the  User"  line  identifies  the  maximum number  of  Records  that  can  be  selected  by  the
specific user.

However, for some reports, all Active Records are accessible, making some possibly confidential data accessible to a
user who does not have the necessary rights. To assure the correct segregation of Records, the choices outlined in
red should not be checked in the User Manager window.

 For information about Irregular Data Verification, see the Useful Features chapter.
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Reports chapter contents:

Reporting Fields

Advanced Queries

Personalized Reports

 Executive Dashboard

 Record List

 Record List with Period Breaks

 Transaction Report

 Document Merge (Letters, Contracts, Invoices and Statements)

 Creditor Report

 Export of transactions to accounting package General Ledger

 Special Events Reports

Standard Reports

 Detailed Schedules (Payment schedule)

 Global Summary

 Record List- Summary

 Doubtful Accounts Report

 Credit Reporting Module

Commonly required reports

 List of Borrowers, Creditors or Employers

 Due, Outstanding and Unpaid Payments Reports

 Ageing of Accounts

 Portfolio Analysis

 APR disclosure box (USA only)

 Returned checks
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 Participation Loans

Custom Reports created by the Margill team

Additional information about Reports

 Mathematical Equations

 Accounting Data

 Time required to produce reports

   

Reporting Fields

Margill  Loan  Manager  (MLM)  contains  close  to  1000  fields  in  addition  to  custom  fields  that  can  be  used  to  produce
various  reports  and  displayed  in  the  Main  MLM  window  (Record  Summary  Window).  The  names,  descriptions  and
themes below are standard in most sections of the software to easily find the desired fields.

Descriptions of each of the fields are available directly in MLM, in each report configuration window by clicking on . 
This icon is generally located under the arrows in the middle of the window.

Fields  descriptions  used  to  create  Merge  and  Email  templates  are  usually  available.  Simply  highlight  the  merge  code,
right-click on the mouse and choose "Merge field Description" (or use Ctrl D).
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If a field is not available, you can use the Mathematical Equations to create your own fields. You can add fields together
or  perform sums,  subtractions,  multiplications,  etc.  You  can  also  contact  the  Margill  team  for  custom  reports  created
specifically for you.

These descriptions thus apply to:

 Record Summary Window (descriptions are often shortened)
 Executive Dashboard
 Transaction Report
 Record List
 Document Merge (Letters, Contracts, Invoices and Statements)". The corresponding "Rich Text Format" (RTF) merge

codes and their short versions are given in the third and fourth columns respectively in the tables below.
 Export accounting transactions to the General Ledger

Nomenclature (usually at the end of the name with parentheses):

 "Entire Loan" - will report full loan data even if the start and end dates are entered for the report.

 "For period" and "in period" - except in certain limited exceptions in the tables below, will only return data between
the start and end dates for the report. For a full report (without adding dates), the period is for the entire duration of
the loan and for reports until a certain date, the period shall be from the loan's "Origination Date" until the end date
entered.

 "Report End Date" - usually for balances, will report the balance at the report end date.

 Others: 
o "Pmt" is used for the term "payment" when there is insufficient space to write it completely.
o "Paid"  type  Line  statuses:  includes  Paid  Pmt,  all  Paid  Pmt  (2  to  20),  Partial,  Partial  late,  Add.  Pmt,

Compensatory Pmt and Paid pmt Returned check
o As of version 4.0, "Principal (Original)" usually includes the "APR Fees Financed". The Principal (Original) plus

APR Fees Financed, in the software is now referred to as "Amount Financed (Original)". Before version 4.0,
the  APR  fees  could  not  be  financed  and  so  Principal  (Original)  was  pure  Principal.  As  of  4.0,  in  most
descriptions below, the Principal (Original) includes APR Fees Financed since these are very close to Principal
since  part  of  the  total  amount  financed.  In  the  descriptions  we  have  not  updated  the  term  to  "Amount
Financed (Original)".

o Fields with data returned at current date  reflect the reality, as of  today,  unless the loan is  terminated. In
this case, the data of the last line on the Payment schedule will be displayed. For the interest calculation to
continue, you must add an "Information" line at the end of the Payment schedule and enter a distant date
(for example 2030).
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Note: This nomenclature does not apply to the Accounting report (Export accounting transactions to the General Ledger)
since transactions or balances, as opposed to totals are reported.

IMPORTANT: In some situations, no data will be reported for certain Records. Even data that is not associated to a date
(for example, the file number or the full name of the Borrower) will be excluded from the list when:

 A Record is in the system but the original date falls after the report's end date. So on the requested date, the loan
does not exist yet.

 The last  line  of  the  Result  table  comes before the  report's  start  date,  therefore  the  loan  is  finished.  To  avoid  this
situation, desired or not, add a line with a payment of 0.00 (with a Line status "Information") with a date 10 or 15
years after the current date. For example, for an active loan with little or no recent transactions, adding a last line on
January 1, 2030 would report loan data, while continuing to calculate the theoretical interest.

The tables below are listed in alphabetical order according to the themes in MLM and respecting the order of
the fields as they appear in the software. The alphabetical order is not followed within the themes since the
presentation order is based on the similarity between the fields themselves.

Themes:

 Advanced
 Analysis
 APR
 Balances
 Borrower
 Creditor
 Custom Fields
 Dates
 Doubtful/Bad Debt
 Fees/Columns

 General
 Interest
 Line status
 Loan Data
 Outstanding
 Payments
 Principal
 Tally
 Fields at Current Date
 Special  fields - Payment schedule in RTF Reports (Document

Merge)

List updated: June 1, 2022

Advanced
Field name Description Merge Code Short Merge

Code

Calculation Method Allows  to  differentiate,  notably,  between  simple  and
compound interest. Entered in the "Advanced" window.

&&CalculationMet
hode&&

|901||

Day Count Allows to  show the day  count  indicated in  the  "Advanced"
window.

&&Day-Count&& |902|

Short Period Method Allows to show if  short periods are calculated according to
the normal method or using simple interest capitalized and
the  corresponding  Day  count.  Entered  in  the  "Advanced"
window.

&&ShortPeriodMet
hod&&

|904|

Year Base Allows to show, for simple interest computations, which of
the Anniversary or Civil year methods is used. Entered in the
"Advanced" window. 

&&Year-Base&& |905|

Grace period (Days) Grace period, in days, entered in the "Advanced" window. &&GRACEPERIOD&
&

|903|
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Analysis
Field name Description Merge Code Short Merge

Code

Repayment Ratio Total of Paid payments divided by Total Expected Payments
for the period selected.

Particular scenarios:

 If Total Expected Payments = 0.00 and Paid Payment >
0.00 then Repayment Ratio = 100%

 If Total Expected Payments = 0.00 and Paid Payment =
0.00 then Repayment Ratio = 0.00%

 Only  "Payment"  type  (and  the  corresponding  Unpaid)
Line statuses are included.

&&RepayRatio&& |998|

Internal Rate of Return (IRR) Calculates  the  Internal  Rate  of  Return  (IRR)  for  a  set  of
payments.

Caution: If a negative payment a Line status as Fee or other,
it  will  be  considered  Principal,  reducing  as  opposed  to
increasing the IRR. Only fees added in the APR window and
as Column Fees are considered true fees for this calculation.
The  calculated  IRR  will  therefore  usually  be  false  if  a  Line
status  with  a  negative  payment  (other  than  Additional
Principal) is included in the Payment schedule.

Uses  the  same  formula  as  the  Effective  APR.  See  the
detailed  APR  explanations  in  the  APR  window  and  in  the
User Guide.

The IRR that cannot be determined will have an empty value
(not 0.00) in the report.

&&RATEofRETURN
&&

   |998-1|   

APR
Field name Description Merge Code Short

Merge
Code

APR - Fees 1 (Administrative)(in $, £, €
...)

Fee amount entered in the first of five types of fees in
the "APR" window. 

&&APR-1-AMOUNT&& |203|

APR - Fees 2 (Insurance)(in $, £, €...) Fee  amount  entered  in  the  second  of  five  types  of
fees in the "APR" window.

&&APR-2-AMOUNT&& |204|

APR - Fees 3 (Service)(in $, £, €...) Fee amount entered in the third of five types of fees
in the "APR" window.

&&APR-3-AMOUNT&& |205|

APR - Fees 4 (Origination)(in $, £, €...) Fee amount entered in the fourth of five types of fees
in the "APR" window.

&&APR-4-AMOUNT-
Money&&

|206|

APR - Fees 4 (Origination)(in %) Fee in percentage entered in the fourth of five types
of fees in the "APR" window.

&&APR-4-AMOUNT&& |207|

APR - Fees 5 (Points)(in $, £, €...) Fee  amount  entered  in  the  last  type  of  fees  in  the
"APR" window.

&&APR-5-AMOUNT-
Money&&

|208|

APR - Fees 5 (Points)(in %) Fee in  percentage entered in  the last  type of  fees  in &&APR-5-AMOUNT&& |209|
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the "APR" window.

APR - Name of Fees 1 (Administrative) Name  of  the  first  of  five  types  of  fees  in  the  "APR"
window. By default the name is "Administrative". This
name may be changed. 

&&APR-1-LABEL&& |210|

APR - Name of Fees 2 (Insurance) Name of the second of five types of fees in the "APR"
window.  By  default  the  name  is  "Insurance".  This
name may be changed. 

&&APR-2-LABEL&& |211|

APR - Name of Fees 3 (Service) Name of  the  third  of  five  types  of  fees  in  the  "APR"
window. By default the name is "Service". This name
may be changed. 

&&APR-3-LABEL&& |212|

APR - Name of Fees 4 (Origination) Name of the fourth of five types of fees in the "APR"
window.  By  default  the  name  is  "Origination".  This
name may be changed.

&&APR-4-LABEL&& |213|

APR - Name of Fees 5 (Points) Name of the last type of fees in the "APR" window. By
default  the  name  is  "Points".  This  name  may  be
changed. 

&&APR-5-LABEL&& |214|

APR Proportion Fees 1 Financed
(Administrative)

Available for the 5 Financed Fees

Proportion  expressed  as  a  percentage,  of  the  Fees
Financed entered in the second of five types of fees in
the "APR" window on the total  of  the Fees Financed
exclusively.

Generally used in Mathematical Equations in order to
obtain  various  other  data  (total  of  these  fees  paid,
balance of these fees, etc. 

&&APR-1-Financed-Rate&
&

&&APR-2-Financed-Rate&
&

&&APR-3-Financed-Rate&
&

&&APR-4-Financed-Rate&
&

&&APR-5-Financed-Rate&
&

|228|
|229|
|230|
|231|
|232|

APR - Nominal Rate The  Nominal  APR  rate  that  does  not  factor  in  the
compounding effect. This is often the rate used in the
United States but not in Europe.

&&APR-RATE&& |215|

APR - Effective Rate The APR rate that factors in the compounding effect.

This  gives  a  true  APR  rate  since  a  greater
compounding period (thus compounding more often)
will increase the true interest rate. This is often called
the Annual Percentage Yield (APY). 

&&APR-EFFRATE&& |202|

APR - Total Fees APR The total amount of fees (Fees 1 to 5) entered in the
APR window.

This excludes the interest fees and Column Fees.

Fees  included  in  the  Payment  schedule,  thus  Line
status "Fees 1, 2, 3..." are not included.

&&APR-TOTALFEES&& |219|

APR - Total Cost of Credit (Interest +
Fees)

The  total  of  all  fees  (Fees  1  to  5)  plus  the  total
interest plus all six Column Fees.

Does not include any fees added (with Line statuses)
in  the  Payment  schedule.  Even  if  these  fees  were
compulsory,  they  cannot  be  used  to  compute  the
APR.

Also  known  as  "Finance  charge"  in  the  US  Truth  in
Lending Act - TILA  - disclosure boxes.

&&APR-TOTALCOST&& |217|

APR - Total Fees Paid up front The total amount of fees (Fees 1 to 5) entered in the
APR window that are paid up front.

For  APR  disclosure  purposes  in  the  United  States,

&&APR_Total_UpFront&& |221|
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these  fees  are  subtracted  from  the  "Amount
Financed"  (as  dictated  in  the  Truth  in  Lending  Act  -
TILA).

APR - Total Fees Financed The total amount of fees (Fees 1 to 5) entered in the
APR  window  that  are  financed,  thus  added  to  the
Principal (Original) and used for calculation purposes.

&&APR_Total_Financed&& |222|

APR - Paid Fees Financed (for period) Amount  of  the  Fees  Financed  entered  in  the  APR
window  actually  paid  when  a  Line  status  is  of  a
Payment type.

The  Line  status  must  be  one  of  the  following,
otherwise the Fees Financed will  NOT be  considered
PAID:  "Paid  Pmt",  "Paid  Pmt  (2)  to  (20)",  "Paid  Late
Pmt",  "Partial  Pmt",  "Partial  Late  Pmt",  "Paid  Pmt
Returned  Check"  or  "Add.  Pmt",  "Compensatory
Pmt".  All  other  Line  statuses  will  have  no  effect  on
the Fees Financed paid.

&&ACC_PAID_PRINC_F&& |429|

APR - Paid Fees Financed 1
(Administrative) (for period)

Available for the 5 financed Fees

Amount  of  the  Fees  Financed  entered  in  the  APR
window  actually  paid  when  a  Line  status  is  of  a
Payment type.

The  Line  status  must  be  one  of  the  following,
otherwise the Fees Financed will  NOT be  considered
PAID:  "Paid  Pmt",  "Paid  Pmt  (2)  to  (20)",  "Paid  Late
Pmt",  "Partial  Pmt",  "Partial  Late  Pmt",  "Paid  Pmt
Returned  Check"  or  "Add.  Pmt.",  "Compensatory
Pmt".  All  other  Line  statuses  will  have  no  effect  on
the Fees Financed paid.

&&ACC_Fees_Paid_Admin
&&

&&ACC_Fees_Paid_Assur&
&

&&ACC_Fees_Paid_Service
&&

&&ACC_Fees_Paid_Comm
&&

&&ACC_Fees_Paid_Points
&&

|431|
|432|
|433|
|434|
|435|

Fees Financed Paid (APR)(for period),
Paid Pmt X
 

(Paid Pmt, Paid pmt 2 to 10)

In  the  Payment  schedule,  the  APR  -  Fees  financed
Paid of all lines with the "Paid Pmt" - or "Paid Pmt (2)
to  (10)-  Line status exclusively for  the chosen report
period.

&&ACC_APR_FeesPaid_Pm
t1&&

&&ACC_APR_FeesPaid_Pm
t2&&

&&ACC_APR_FeesPaid_Pm
t3&&

&&ACC_APR_FeesPaid_Pm
t4&&

&&ACC_APR_FeesPaid_Pm
t5&&

&&ACC_APR_FeesPaid_Pm
t6&&

&&ACC_APR_FeesPaid_Pm
t7&&

&&ACC_APR_FeesPaid_Pm
t8&&

&&ACC_APR_FeesPaid_Pm
t9&&

&&ACC_APR_FeesPaid_Pm
t10&&

|601|

|602|
|603|
|604|
|605|
|606|
|607|
|608|
|609|
|610|

Fees Financed Paid (APR)(for period),
Paid Pmt Returned check

In  the  Payment  schedule,  the  APR  -  Fees  financed
Paid of  all  lines  with  the  "Paid  Pmt  Returned check"
Line status exclusively for the chosen report period.

&&ACC_APR_FeesPaid_Pm
tCheck&&

|611|

Fees Financed Paid (APR) (for period),
Add. Pmt

In  the  Payment  schedule,  the  APR  -  Fees  financed
Paid  of  all  lines  with  the  "Add.  Pmt"  Line  status
exclusively for the chosen report period.

&&ACC_APR_FeesPaid_Pm
tAdd&&

|612|

Fees Financed Paid (APR) (for period),
Compensatory Pmt

In  the  Payment  schedule,  the  APR  -  Fees  financed
Paid  of  all  lines  with  the  "Compensatory  Pmt"  Line
status exclusively for the chosen report period.

&&ACC_APR_FeesPaid_Co
mpPmt&&

|6120|

Fees Financed Paid (APR) (for period) - In  the  Payment  schedule,  the  APR  -  Fees  financed &&ACC_APR_FsPaid_PmtL
atePart&&

|618|
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Partial and Late Payments only Paid  of  all  lines  with  the  "Partial  Pmt",  "  Late  Pmt"
and  "Partial  Late  Pmt"   Line  statuses  exclusively  for
the chosen report period.

APR - Fees Financed to be paid at the
next Due Pmt (as if Paid) (entire loan)

Amount  of  the   Fees  Financed  entered  in  the  APR
window  that  WILL  actually  be  paid  if  the  next  "Due
Pmt" is paid in full.

To  find  this  amount,  MLM  identifies  the  next  line
whose  Line  status  is  "Due  Pmt"  regardless  of  the
date, simulates paid payment and reports the amount
of Fees Financed that would be paid.

&&NXDUPay_PrincPaidAsP
aid_F&&

|562|

APR - Next Due Payment - Balance Due
Fees Financed (as if Paid)(entire Loan)

Balance on the date of the next payment with a "Due
Pmt" Line status regardless of the report dates.

To  find  this  amount,  MLM  identifies  the  next  line
whose  Line  status  is  "Due  Pmt"  regardless  of  the
date, simulates a paid payment and reports the Fees
Financed balance.

&&NXDUPAY_BalduePrinA
sPaid_F&&

|561|

APR - Balance Due Fees Financed at
0:00 at report Start Date (before
transactions on that day)

For a report between two dates, balance of the Fees
Financed  due,   entered  in  the  APR  window  at  the
report start date before any transaction (i.e.,  0:00 in
the morning).

Particular cases:

 Report between two dates: 
If  the  report  Start  date  =  Origination  date:
returns  Fees  financed  entered  in  the  APR
window. 
If  the  report  Start  date  <  Origination  date:
returns 0.00 

 "Full"  and  "Up  to  date..."  reports:  returns  Fees
financed entered in the APR window.

See  also  the  variable  "APR  -  Balance  Due  Fees
Financed at 0:00 at report Start Date (excl. these fees
and before transactions on that day)".

&&ACC_BAL_DUEPRINC-
ST-DATE_F&&

|428|

APR - Balance Due Fees Financed at
0:00 at report Start Date (excl. these
fees and before transactions on that
day)

For a report between two dates, balance of the Fees
Financed  due,  entered  in  the  APR  window  at  the
report start date before any transaction (i.e., 0:00).

Particular cases:

 Report  between  two  dates:  if  the  report  Start
date < = Origination date: returns 0.00.

 "Full" and "Up to date..." reports: report returns
Fees financed entered in the APR window..

See  also  the  variable  "APR  -  Balance  Due  Fees
Financed  at  0:00  at  report  Start  Date  (before
transactions on that day)".

&&ACC_BAL_DUEPRINC-ST
-DATE_F2&

|4901|

APR - Balance Fees Financed at report
End Date

Balance  of  all  Fees  Financed  entered  in  the  APR
window, as they are paid.

&&ACC_BAL_DUEPRINC_F
&&

|427|

APR - Balance Fees Financed (at
Current Date)

See Fields at Current Date
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APR - Paid Fees Financed - Year-to-date
(from January 1 to report End Date)

Fees Financed that are paid from January 1 at 0:00 up
to that end date entered for the report.

The year for January 1st is  determined based on the
end date of the report entered.

For example, for a report  from June 1,  2014 to  June
30, 2014, paid Fees Financed will  be from January 1,
2014.

If  a  complete  report  is  requested,  the  amount
reported will be 0.00.

&&INV_PRINCPAID_YTD_F
&&

|835|

APR - Total Fees Paid subsequently The total amount of fees (Fees 1 to 5) entered in the
APR  window  that  are  paid  subsequently  during  the
loan.

&&APR_Total_Subseq.&& |223|

APR - Principal (Original) + Fees
Financed

Total  of  Principal  (Original)  plus  all  Fees  Financed
entered in the APR window.

Called  "Amount  Financed  (Original)"  in  the  MLM
interface.

Excludes  any  Additional  principal  added  in  the
Payment schedule.

Not to be confused with the "Amount Financed" used
for APR disclosure purposes.

&&APR-
OrigPrincPlusFinFees&&

|224|

APR - Principal (Original) + Fees
Financed (for period)

Total  of  Principal  (Original)  plus  all  Fees  Financed
entered  in  the  APR  window  only  if  the  Origination
date is within the start and end dates entered for the
report.  If  not  within  these  dates,  0.00  will  be
reported.

Called  "Amount  Financed  (Original)"  in  the  MLM
interface.

Excludes  any  Additional  principal  added  in  the
Payment schedule.

&&APR-OrigPrincPlusFinFe
es&&

|227|

APR - Amount Financed Original  Principal  plus  all  "Add.  Princ."  Line  statuses
minus Fees Paid up front entered in the APR window.

This  provides  the  amount  of  the  loan  in  the
consumer's  pocket,  taking  into  account  that  interest
and/or  other  fees  are  charged  or  accumulated  and
are to be paid later on.

As defined in the US Truth  in Lending Act (TILA).

&&APR-AMTFINANCED&& |201|

APR - Total Cost of Credit (Interest +
Fees) + Total Principal

Total  Principal  (Principal  (Original)  plus  all  "Add.
Princ." Line statuses plus total of all APR fees plus the
total interest plus all six Column Fees.

Thus  provides  the  consumer's  total  financial
commitment.

Does not include any fees added (with Line statuses)
in  the  Payment  schedule.  Even  if  these  fees  were
compulsory,  they  cannot  be  used  to  compute  the
APR.

&&APR-TotCOST
+TotPRINC&&

|218|

APR - Payment Amount Total  of  all  positive  payments  in  the  Payment
schedule no matter their Line status but not including

&&APR-
TOTALPAYMENT&&

|216|
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"Add. Princ." Line statuses. 

This  should  only  be  used  for  regular  payment
schedules, before any changes are made.

In  an  irregular  payment  table  that  includes  fees,
insurance,  penalties,  etc.  and  other  non  payment
related payments (fees paid, insurance paid, etc.) the
APR  cannot  be  computed  since  the  fees  are  not
necessarily compulsory. 

APR - Total of Payments (TILA - USA) Original Principal, plus all  "Add. Princ." Line statuses,
plus total of APR fees Financed and Paid subsequently
entered in  the  APR  window,  plus  total  interest,  plus
all six Column Fees, minus Fees Paid up front entered
in the APR window.

Does not include any fees added (with Line statuses)
in  the  Payment  schedule.  Even  if  these  fees  were
compulsory,  they  cannot  be  used  to  compute  the
APR.

As defined in the US Truth  in Lending Act (TILA).

&&APR-TOT_PMT_TILA&& |226|

APR - Total Fees minus Fees 2
(Insurance)(in $, L, E...)

Total of fees minus Fees 2 that are usually insurance
fees. 

This is useful for contracts and reporting (example IRS
1098 reports) in order to give a total amount of fees
less the insurance. This can be done in the RTF Report
Editor.

&&APR-
TOTALFEESNoFEES2&&

|220|

APR - Fees 1 (Administrative) paid up-
front (for period)

Available for the 5 paid up-front Fees

Fee amount entered in the first of five types of fees in
the  "APR"  window  if  paid  up-front  and  the
Origination  date  is  within  the  given  report  start  and
end  dates.  If  not  within  these  dates  or  other  than
paid up-front, 0.00 will be reported.

&&APR-1-AMOUNT-
PERIOD&&

&&APR-2-AMOUNT-
PERIOD&&

&&APR-3-AMOUNT-
PERIOD&&

&&APR-4-AMOUNT-
PERIOD&&

&&APR-5-AMOUNT-
PERIOD&&

|233|
|234|
|235|
|236|
|237|

Balances
Field Name Description Merge Code Short RTF

Code

Balance (at Current Date) See Fields at Current Date

Final Balance Balance at the very end of the loan. &&LOANBALANCE
&&

|514|

Original Balance from Data window See Loan Data

Last  Paid  payment  (all  Paid  Line
statuses)(entire Loan) - Balance

See Payments
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Last Paid/Unpaid payment (only Paid
and  Unpaid  Line  statuses)(entire
Loan) - Balance

See Payments

Last Paid payment (all Paid Line
statuses)(in period) - Balance

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(in period) -
Balance

See Payments

Last Transaction (in period) -
Computational Balance

Computational Balance of the last Transaction in the period
taking into account  any type of  Line status,  but  only  on or
before the end date entered in the report. If no transaction
is found in the period, returns 0.00.

&&INV_LastTransB
al_IP_True&&

|853|

Last Transaction (in period) -  True
Balance

Balance  of  the  last  Transaction  in  the  period  taking  into
account  any type of  Line status,  but  only  on  or  before  the
end date entered in the report. If no transaction is found in
the period, returns 0.00.

&&INV_LastPaidUn
pdBalIP_comp&&

|851|

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(in period) -
Computational Balance

Computational  Balance  of  the  last  paid  payment  in  the
Payment schedule taking into account any of the "Payment"
type Lines statuses AND any of  the "Unpaid" Line statuses,
but only on or before the end date entered in the report.If
more  than  one  "Paid"  line  type  appears  on  the  same
payment date, only the amount of the LAST "Paid" line type
will be returned. 

&&INV_LastTransB
al_IP_comp&&

|852|

Balance at report End Date For  reports  between  two  dates  and  Up  to  a  certain  date,
this will be the true Balance on that day taking into account
one  of  the  three  options  for  including  or  excluding
payments and interest for the last day.

For the "Complete report" the true balance will  be that on
the  very  last  day  of  the  loan  (final  balance)(including
transactions  for  the  day  but  excluding  the  interest  for  the
day).

&&INV-
BALLASTDAY0h&&

|706|

Balance computational at report End
Date

Computational  Balance  is  the  portion  of  the  true  balance
that does not bear interest.

In  simple  interest,  unpaid  interest  does  not  bear  interest
and so is not added to the computational balance.

Furthermore, if no interest is payable on additional principal
(or  on  fees,  insurance,  taxes,  etc.),  this  mathematical
principal will be excluded from the balance reported.

For  reports  between  two  dates  and  Up  to  a  certain  date,
this  will  be  the  computational  balance  on  that  day  taking
into  account  one  of  the  three  options  for  including  or
excluding payments  (transactions)  and  interest  for  the  last
day.  Certain  transactions  may  nevertheless  not  influence
computational balance.

For the "Complete report" the balance reported will be the
true balance on the very last day of the loan (final balance)
(including transactions for the day but excluding the interest
for the day).

&&INV-BALLASTDA
Y0h_CALC&&

|834|

Balance at 0:00 at report Start Date
(before transactions on that day)

For a report between two dates, true Balance on that day at
0:00 in the morning, before any transaction is made on that
day.

&&INV-
BALFIRSTDAY&&

|705|
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Particular cases: 

 Report between two dates:
If  the  report  Start  date  =  Origination  date:  returns
Original  Principal  +  Additional  Principal  type  Line
statuses  entered  at  the  Origination  Date  only  +  Fees
financed entered in the APR window.
If the report Start date < Origination date: returns 0.00 

 "Full"  and  "Up  to  date..."  reports:  returns  Original
Principal  +  Additional  Principal  type  Line  statuses
entered at  the  Origination Date  only   +  Fees  financed
entered in the APR window.

NOTE:  Ordinarily,  "Additional  Principal"  type  Line  statuses
are  deemed added at  0:00+  (so  would  be  a  transaction  of
the day,  but  excluded) but  a  logical  exception was  created
assuming  the  user  does  not  differentiate  between  an
Original  Principal  and  "Additional  Principal"  type  Line
statuses  when  this  "Add.  Princ."  is  entered  on  the
Origination  date.  Both  are  thus  deemed  inserted  at  0:00,
not at 0:00+.

See also the variable: "Balance at 0:00 at report Start Date
(before  transaction  on  that  day  and  excl.  Principal
(Original))".

Balance computational at 0:00 at
report Start Date (before
transactions on that day)

Computational  Balance  is  the  portion  of  the  true  balance
that bears interest. For more detailed explanations on what
is  the  computational  balance,  see  "Computational  Balance
at report End Date".

For  a  report  between  two  dates,  this  will  be  the
computational balance on that day at 0:00 in the morning,
before any transaction is made on that day.

Particular cases: 

 Report between two dates:
If  the  report  Start  date  =  Origination  date:  returns
Original  Principal  +  Additional  Principal  type  Line
statuses  (bearing  interest)  entered  at  the  Origination
Date only + Fees financed entered in the APR window.
If the report Start date < Origination date: returns 0.00 

 "Full"  and  "Up  to  date..."  reports:  returns  Original
Principal  +  Additional  Principal  type  Line  statuses
(bearing interest) entered at the Origination Date only
+  Fees financed entered in the APR window.

NOTE:  Ordinarily,  "Additional  Principal"  type  Line  statuses
are  deemed added at  0:00+  (so  would  be  a  transaction  of
the day,  but  excluded) but  a  logical  exception was  created
assuming  the  user  does  not  differentiate  between  an
Original  Principal  and  "Additional  Principal"  type  Line
statuses  when  this  "Add.  Princ."  is  entered  on  the
Origination  date.  Both  are  thus  deemed  inserted  at  0:00,
not at 0:00+.

See  also  the  variable:  "Balance  computational  at  0:00  at

&&INV-BALFIRSTD
AY_CALC&&

|833|
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report Start Date (before transactions on that day and excl.
Principal (Original))".

Balance Due Principal at 0:00 at
report Start Date (before
transactions on that day)

See Principal

Balance at 0:00 at report Start Date
(before transaction on that day and
excl. Principal (Original))

For a report between two dates, true Balance on that day at
0:00 in the morning, before any transaction is made on that
day.

Particular cases: 

 Report between two dates: if the report Start date < =
Origination date: returns 0.00.

 "Full"  and  "Up  to  date..."  reports:  returns  Original
Principal  +  Additional  Principal  type  Line  statuses
entered at the Origination Date only   + Fees financed
entered in the APR window.

NOTE:  Ordinarily,  "Additional  Principal"  type  Line  statuses
are  deemed added at  0:00+  (so  would  be  a  transaction  of
the day, thus excluded) but a logical exception was created
assuming  the  user  does  not  differentiate  between  an
Original  Principal  and  "Additional  Principal"  type  Line
statuses  when  this  "Add.  Princ."  is  entered  on  the
Origination  date.  Both  are  thus  deemed  inserted  at  0:00,
not at 0:00+.

See also the variable; "Balance at 0:00 at report Start Date
(before transactions on that day)".

&&INV-BALFIRSTD
AY2&&

|7900|

Balance computational at 0:00 at
report Start Date (before
transactions on that day and excl.
Principal (Original))

Computational  Balance  is  the  portion  of  the  true  balance
that bears interest. For more detailed explanations on what
is  the  computational  balance,  see  "Computational  Balance
at report End Date".

For  a  report  between  two  dates,  this  will  be  the
computational balance on that day at 0:00 in the morning,
before any transaction is made.

Particular cases: 

 Report between two dates: if the report Start date < =
Origination date: returns 0.00.

 "Full"  and  "Up  to  date..."  reports:  returns  Original
Principal  +  Additional  Principal  type  Line  statuses
(bearing interest) entered at the Origination Date only
+ Fees financed entered in the APR window.

NOTE:  Ordinarily,  "Additional  Principal"  type  Line  statuses
are  deemed added at  0:00+  (so  would  be  a  transaction  of
the day, thus excluded) but a logical exception was created
assuming  the  user  does  not  differentiate  between  an
Original  Principal  and  "Additional  Principal"  type  Line
statuses  when  this  "Add.  Princ."  is  entered  on  the
Origination  date.  Both  are  thus  deemed  inserted  at  0:00,
not at 0:00+.

See  also  the  variable:  "Balance  computational  at  0:00  at

&&INV-BALFIRSTD
AY_CALC2&&

|8900|
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report Start Date (before transactions on that day)".

Balance Due Principal at 0:00 at
report Start Date (before
transactions on that day and excl.
Principal (Original))

For a report between two dates, cumulative amount of the
due  principal  at  the  report  start  date  entered  before  any
transaction (i.e., 0:00 in the morning).

Particular cases: 

-  Report  between  two  dates:  if  the  report  Start  date  <  =
Origination date: returns 0.00.

- "Full" and "Up to date..." reports: returns Original Principal
+  Additional  Principal  type  Line  statuses  entered  at  the
Origination Date only.

Excludes, case being, the Fees financed (APR) portion, thus
only pure (accounting) principal is reported.

NOTE:  Ordinarily,  "Additional  Principal"  type  Line  statuses
are  deemed added at  0:00+  (so  would  be  a  transaction  of
the day, thus excluded) but a logical exception was created
assuming  the  user  does  not  differentiate  between  an
Original  Principal  and  "Additional  Principal"  type  Line
statuses  when  this  "Add.  Princ."  is  entered  on  the
Origination  date.  Both  are  thus  deemed  inserted  at  0:00,
not at 0:00+.

See also  the  "Balance  Due Principal  at  0:00  at  report  Start
Date (before any transaction on that day)" reporting field.

&&ACC_BAL_DUEP
RINC-

STARTDATE2&

|4900|

Balance Due Principal at report End
Date

See Principal

Balance Due Principal (at Current
Date)

See Fields at Current Date

Next Due Pmt - Balance (as if Paid)
(entire Loan)

See Payments

Next Due Pmt - Balance Due Principal
(as if Paid)(entire Loan)

See Principal

Balance Due Interest at 0:00 at
report Start Date (excluding any
transaction on that day)

See Interest

Balance Due Interest at report End
Date

See Interest

Balance  Due  Interest  (at  current
date)

Cumulative amount of the due interest at the current date.
The balance indicated when using this field is the balance on
the  current  date  no  matter  what  the  Lines  statuses  are
before the current date.  Thus,  if  several  payments are due
(so unpaid and not changed to 0.00),  the balance reported
will  not  be true  because the  data  was  improperly  updated
or maintained. Provides a theoretical balance based on the
payments  that  should  be  made.  Excludes,  case  being,  the
Fees financed (APR) portion.

&&ACC_BAL_DUEI
NT_ToDate&&

 

|4990|

Balance all Other (all Line statuses
other than Payment and Principal
types)(report End Date)

Balance  for  ALL  Line  statuses  except  true  payments  ("Paid
Pmt",  "Paid  Late  Pmt",  "Partial  Pmt",  "Partial  Late  Pmt",
"Paid  Pmt  Returned  Check",  "Add.  Pmt"  or  Compensatory
Pmt) and additional principal ("Add. Princ. (Loan)").

&&ACC_BAL_AllOt
her&&

|413|
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Will factor in positive and negative payments.

Balance Column Fees at report End
Date

Column Fees 1 to 6 as renamed

See Fees/Columns

Balance Column Fees sat 0:00 at
report Start Date

Column Fees 1 to 6 as renamed

See Fees/Columns

Unpaid Pmt (Line status) Balance
(Unpaid portion)(report End date)

Unpaid Pmt (2) to (10) as renamed

See Line status

Partial payment Balance (Unpaid
portion) (report End Date)

See Line status

Returned Checks Balance (unpaid
portion) (report End Date)

See Line status

Balance total Unpaid portions (All
unpaid Pmts, Partial, Returned
checks)(report End Date)

See Line status

Outstanding - Total (Balance) at
Current Date

See Outstanding

Outstanding - Total (Balance) at
report End Date

See Outstanding

Outstanding - Payment (Balance)
report End Date

See Outstanding

Outstanding - Payment (Balance)
report Start Date (before
transactions on that day)

See Outstanding

Outstanding - Total (Balance) at
report report Start Date  (before
transactions on that day)

See Outstanding

Interest Balance on Outstanding
Balance at report Start Date (before
transactions on that day)

Balance  of  the  interest  that  is  calculated  on  the  total
outstanding  balance  at  the  report  start  date  entered,  at
0:00  in  the  morning,  thus  before  any  transaction  on  that
day.

For  simple  interest,  no  interest  is  charged  on  outstanding
interest. 

Particular cases:

 Report between two dates:  if the report Start date < =
Origination date: returns 0.00.

 "Full report" and "Report up to...": returns 0.00.

&&Outst_IntBAL_St
artDate&&

|415|

Interest Balance on Outstanding
Balance at report End Date

Balance  of  the  interest  that  is  calculated  on  the  total
outstanding balance at the report end date entered.

For  simple  interest,  no  interest  is  charged  on  outstanding
interest. 

&&Outst_IntBAL_E
ndDate&&

|414|

Interest on Outstanding Balance (for Interest  calculated  on  the  outstanding  balance  and  on  the &&Outst_INT_total |418|
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period) interest on this amount when the calculation is  done using
compound  interest  (effective  rate  method)  or  when  a  line
or  lines  use  the  "Simple  Interest  Capitalized"  method.
Interest  is  calculated  using  the  "Outstanding  -  Total
(Balance)" column.

For a calculation using simple interest, the interest amount
excludes interest on interest. Interest is calculated using the
"Outstanding - Payment (Balance)" column.

_period&&

Amount Due: Due Pmt + Outstanding
+ all Fees + Penalties (for period)

See Line status

Doubtful Accounts (Balance from
Record date)

See Doubtful/Bad Debt

Doubtful Accounts (Balance from
report End date)

See Doubtful/Bad Debt

Bad Debt (Balance)(Record Date) See Doubtful/Bad Debt

Ageing Balance 0-29 days (Current) See Outstanding

Ageing Balance 30-59 days See Outstanding

Ageing Balance 60-89 days See Outstanding

Ageing Balance 90-119 days See Outstanding

Ageing Balance 120-149 days See Outstanding

Ageing Balance 150-179 days See Outstanding

Ageing Balance 180 days and more See Outstanding

Ageing Balance Total 30 days and
more

See Outstanding

APR - Balance Due Fees Financed at
report End Date

See Principal

APR - Balance Fees Financed (at
Current Date)

See Fields at Current Date

APR - Balance Fees Financed at 0:00
at report Start Date (excluding any
transaction on that day)

See APR

APR - Balance Due Fees Financed at
0:00 at report Start Date (excluding
these Fees and before transactions
on that day)

See APR

APR - Next Due Pmt - Balance Due
Fees Financed (as if paid) (entire
Loan)

See APR

Expected Principal Balance See Principal

Expected Principal Balance at report
End Date

See Principal

Balance Capitalized Interest due at
Report Start date at 0:00

See Interest

Balance Capitalized Interest due at
Report End Date

See Interest
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Borrower
Field Name Description Merge Code Short

Merge
Code

Borrower ID ID generated by MLM. Numbers in the 10000. &&BorrowerID&& |111|

Borrower Unique Identifier 1 Identifier  allowing  to  create  a  link  for  a  Borrower  to  third
party software. This identifier must be unique, thus can not
be repeated.

&&CLT_UniqueID1
&&

|121|

Borrower Unique Identifier 2 Identifier  allowing  to  create  a  link  for  a  Creditor  to  third
party software. This identifier must be unique, thus can not
be repeated.

&&CLT_UniqueID2
&&

|122|

Borrower Social Security Number Self explanatory (hereafter entered as -). &&CLT-
SOCIALSEC&&

|118|

Borrower Birth Date - &&CLT-BDAY&& |104|

Borrower Business (Company) Name - &&CLT-
BUSINESS&&

|105|

Borrower Business (Company) Name
or if empty, First Last Name

First and Last Name concatenated. &&CLT-SocietyORFi
rstLastNAME&&

|1120.2|

Borrower Title (Mr., Mrs., Ms., Dr.) - &&CLT-TITLE&& |120|

Borrower Marital Status - &&CLT_MARIT_ST&
&

|194|

Borrower First Name - &&CLT-
FIRSTNAME&&

|110|

Borrower Language - &&CLT-
Language&&

|1995|

Borrower Middle Initial - &&CLT-MI&& |114|

Borrower Last Name - &&CLT-
LASTNAME&&

|112|

Borrower Last First Name First and Last Name concatenated. &&CLT-First_LastN
AME&&

|1120.1|

Borrower Address 1 - &&CLT-
ADDRESS1&&

|102|

Borrower Address 2 Second part of address if needed. &&CLT-
ADDRESS2&&

|103|

Borrower City - &&CLT-CITY&& |106|

Borrower State, Province - &&CLT-STATE&& |119|

Borrower Country - &&CLT-
COUNTRY&&

|107|

Borrower Zip / Postal code - &&CLT-ZIP&& |123|

Borrower Phone Number - &&CLT-PHONE&& |117|

Borrower Fax Number - &&CLT-FAX&& |109|

Borrower Mobile Number - &&CLT-MOBILE&& |115|

Borrower Email - &&CLT-EMAIL&& |108|

Borrower Web Site - &&CLT_WEB&& |195|

Borrower Occupation - &&CLT_OCCUP&& |196|
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Borrower Other information "Other information" field under "Borrower". These data are
associated to the loan as such, not directly to the Borrower.

&&CLT-OTHER&& |116|

Bank Account CA - Description Warning:  In  order  to  be  able  to  extract  bank  data,  the
Electronic  Funds  Transfer  (EFT)  module  must  be  activated
for the Records.

It  is  through  the  EFT  mechanism  that  the  correct  account
can be extracted since several accounts can be present for a
Borrower.

&&CLT-BNK-Desc&
&

|176|

Bank Account CA - Institution &&CLT-BNK-Institut
ion&&

|177|

Bank Account CA - Branch Number &&CLT-BNK-Branch
Num&&

|178|

Bank Account CA - Account Number &&CLT-BNK-AccNu
m&&

|179|

Co-Borrower X - MLM Identification

(Co-Borrower 1 to 9)

Data on the Co-Borrowers (1 to 9) and on the Guarantors (1
to 9) for each Record's Co-Borrower and Guarantor list.

&&CLT-CoBorr1-ML
M-ID&&

&&CLT-CoBorr2-ML
M-ID&&

&&CLT-CoBorr3-ML
M-ID&&

&&CLT-CoBorr4-ML
M-ID&&

&&CLT-CoBorr5-ML
M-ID&&

&&CLT-CoBorr6-ML
M-ID&&

&&CLT-CoBorr7-ML
M-ID&&

&&CLT-CoBorr8-ML
M-ID&&

&&CLT-CoBorr9-ML
M-ID&&

|182|

|183|
|184|

|1250|
|1266|
|1282|
|1298|
|1314|
|1330|

Co-Borrower X - Social Security
Number

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-SO
CIALSEC&&

&&CLT-CoBorr2-SO
CIALSEC&&

&&CLT-CoBorr3-SO
CIALSEC&&

&&CLT-CoBorr4-SO
CIALSEC&&

&&CLT-CoBorr5-SO
CIALSEC&&

&&CLT-CoBorr6-SO
CIALSEC&&

&&CLT-CoBorr7-SO
CIALSEC&&

&&CLT-CoBorr8-SO
CIALSEC&&

&&CLT-CoBorr9-SO
CIALSEC&&

|124.1|
|130.1|
|160.1|

|1250.1|
|1266.1|
|1282.1|
|1298.1|
|1314.1|
|1330.1|

Co-Borrower X - Business (Company)
Name

(Co-Borrower 1 to 9)

&&CLT-CoBorr1-BU
SINESS&&

&&CLT-CoBorr2-BU
SINESS&&

&&CLT-CoBorr3-BU
SINESS&&

&&CLT-CoBorr4-BU
SINESS&&

&&CLT-CoBorr5-BU

|124|

|130|
|160|

|1251|
|1267|
|1283|
|1299|
|1315|
|1331|
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SINESS&&
&&CLT-CoBorr6-BU

SINESS&&
&&CLT-CoBorr7-BU

SINESS&&
&&CLT-CoBorr8-BU

SINESS&&
&&CLT-CoBorr9-BU

SINESS&&

Co-Borrower X - Title (Mr., Mrs., Ms.,
Dr.)

(Co-Borrower 1 to 9)

&&CLTCoBorr1-TITL
E&&

&&CLTCoBorr2-TITL
E&&

&&CLTCoBorr3-TITL
E&&

&&CLTCoBorr4-TITL
E&&

&&CLTCoBorr5-TITL
E&&

&&CLTCoBorr6-TITL
E&&

&&CLTCoBorr7-TITL
E&&

&&CLTCoBorr8-TITL
E&&

&&CLTCoBorr9-TITL
E&&

|129|

|135|
|161|

|1252|
|1268|
|1284|
|1300|
|1316|
|1332|

Co-Borrower X - First Name

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-FIR
STNAME&&

&&CLT-CoBorr2-FIR
STNAME&&

&&CLT-CoBorr3-FIR
STNAME&&

&&CLT-CoBorr4-FIR
STNAME&&

&&CLT-CoBorr5-FIR
STNAME&&

&&CLT-CoBorr6-FIR
STNAME&&

&&CLT-CoBorr7-FIR
STNAME&&

&&CLT-CoBorr8-FIR
STNAME&&

&&CLT-CoBorr9-FIR
STNAME&&

|125|

|131|
|162|

|1253|
|1269|
|1285|
|1301|
|1317|
|1333|

Co-Borrower X - Middle Initial

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-MI
&&

&&CLT-CoBorr2-MI
&&

&&CLT-CoBorr3-MI
&&

&&CLT-CoBorr4-MI
&&

&&CLT-CoBorr5-MI
&&

&&CLT-CoBorr6-MI
&&

&&CLT-CoBorr7-MI
&&

&&CLT-CoBorr8-MI
&&

&&CLT-CoBorr9-MI
&&

|128|

|134|
|163|

|1254|
|1270|
|1286|
|1302|
|1318|
|1334|



Page 868

© Jurismedia Inc., 2007- 2023

Co-Borrower X  - Last Name

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-LA
STNAME&&

&&CLT-CoBorr2-LA
STNAME&&

&&CLT-CoBorr3-LA
STNAME&&

&&CLT-CoBorr4-LA
STNAME&&

&&CLT-CoBorr5-LA
STNAME&&

&&CLT-CoBorr6-LA
STNAME&&

&&CLT-CoBorr7-LA
STNAME&&

&&CLT-CoBorr8-LA
STNAME&&

&&CLT-CoBorr9-LA
STNAME&&

|126|

|132|
|164|

|1255|
|1271|
|1287|
|1303|
|1319|
|1335|

Co-Borrower X - Address 1

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-AD
DRESS1&&

&&CLT-CoBorr2-AD
DRESS1&&

&&CLT-CoBorr3-AD
DRESS1&&

&&CLT-CoBorr4-AD
DRESS1&&

&&CLT-CoBorr5-AD
DRESS1&&

&&CLT-CoBorr6-AD
DRESS1&&

&&CLT-CoBorr7-AD
DRESS1&&

&&CLT-CoBorr8-AD
DRESS1&&

&&CLT-CoBorr9-AD
DRESS1&&

|140|

|151|
|166|

|1256|
|1272|
|1288|
|1304|
|1320|
|1336|

Co-Borrower X - Address 2

(Co-Borrower 1 to 9)

Second part of address if needed. &&CLT-CoBorr1-AD
DRESS2&&&&CLT-C
oBorr1-ADDRESS2&

&

&&CLT-CoBorr2-AD
DRESS2&&

&&CLT-CoBorr3-AD
DRESS2&&

&&CLT-CoBorr4-AD
DRESS2&&

&&CLT-CoBorr5-AD
DRESS2&&

&&CLT-CoBorr6-AD
DRESS2&&

&&CLT-CoBorr7-AD
DRESS2&&

&&CLT-CoBorr8-AD
DRESS2&&

&&CLT-CoBorr9-AD
DRESS2&&

|141|

|151|
|167|

|1257|
|1273|
|1289|
|1305|
|1321|
|1337|

Co-Borrower X - City

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-CIT
Y&&

&&CLT-CoBorr2-CIT
Y&&

&&CLT-CoBorr3-CIT
Y&&

&&CLT-CoBorr4-CIT

|142|

|152|
|168|

|1258|
|1274|
|1290|
|1306|
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Y&&
&&CLT-CoBorr5-CIT

Y&&
&&CLT-CoBorr6-CIT

Y&&
&&CLT-CoBorr7-CIT

Y&&
&&CLT-CoBorr8-CIT

Y&&
&&CLT-CoBorr9-CIT

Y&&

|1322|
|1338|

Co-Borrower X  - State, Province

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-ST
ATE&&

&&CLT-CoBorr2-ST
ATE&&

&&CLT-CoBorr3-ST
ATE&&

&&CLT-CoBorr4-ST
ATE&&

&&CLT-CoBorr5-ST
ATE&&

&&CLT-CoBorr6-ST
ATE&&

&&CLT-CoBorr7-ST
ATE&&

&&CLT-CoBorr8-ST
ATE&&

&&CLT-CoBorr9-ST
ATE&&

|143|

|153|
|169|

|1259|
|1275|
|1291|
|1307|
|1323|
|1339|

Co-Borrower X - Country

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-CO
UNTRY&&

&&CLT-CoBorr2-CO
UNTRY&&

&&CLT-CoBorr3-CO
UNTRY&&

&&CLT-CoBorr4-CO
UNTRY&&

&&CLT-CoBorr5-CO
UNTRY&&

&&CLT-CoBorr6-CO
UNTRY&&

&&CLT-CoBorr7-CO
UNTRY&&

&&CLT-CoBorr8-CO
UNTRY&&

&&CLT-CoBorr9-CO
UNTRY&&

|144|

|154|
|170|

|1260|
|1276|
|1292|
|1308|
|1324|
|1340|

Co-Borrower X - Zip / Postal code

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-ZIP
&&

&&CLT-CoBorr2-ZIP
&&

&&CLT-CoBorr3-ZIP
&&

&&CLT-CoBorr4-ZIP
&&

&&CLT-CoBorr5-ZIP
&&

&&CLT-CoBorr6-ZIP
&&

&&CLT-CoBorr7-ZIP
&&

&&CLT-CoBorr8-ZIP
&&

&&CLT-CoBorr9-ZIP

|145|

|155|
|171|

|1261|
|1277|
|1293|
|1309|
|1325|
|1341|
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&&

Co-Borrower X - Phone Number

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-PH
ONE&&

&&CLT-CoBorr2-PH
ONE&&

&&CLT-CoBorr3-PH
ONE&&

&&CLT-CoBorr4-PH
ONE&&

&&CLT-CoBorr5-PH
ONE&&

&&CLT-CoBorr6-PH
ONE&&

&&CLT-CoBorr7-PH
ONE&&

&&CLT-CoBorr8-PH
ONE&&

&&CLT-CoBorr9-PH
ONE&&

|146|

|156|
|172|

|1262|
|1278|
|1294|
|1310|
|1326|
|1342|

Co-Borrower X - Fax Number

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-FA
X&&

&&CLT-CoBorr2-FA
X&&

&&CLT-CoBorr3-FA
X&&

&&CLT-CoBorr4-FA
X&&

&&CLT-CoBorr5-FA
X&&

&&CLT-CoBorr6-FA
X&&

&&CLT-CoBorr7-FA
X&&

&&CLT-CoBorr8-FA
X&&

&&CLT-CoBorr9-FA
X&&

|147|

|157|
|173|

|1263|
|1279|
|1295|
|1311|
|1327|
|1343|

Co-Borrower X - Mobile Number

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-M
OBILE&&

&&CLT-CoBorr2-M
OBILE&&

&&CLT-CoBorr3-M
OBILE&&

&&CLT-CoBorr4-M
OBILE&&

&&CLT-CoBorr5-M
OBILE&&

&&CLT-CoBorr6-M
OBILE&&

&&CLT-CoBorr7-M
OBILE&&

&&CLT-CoBorr8-M
OBILE&&

&&CLT-CoBorr9-M
OBILE&&

|148|

|158|
|174|

|1264|
|1280|
|1296|
|1312|
|1328|
|1344|

Co-Borrower X - Email

(Co-Borrower 1 to 9)

- &&CLT-CoBorr1-EM
AIL&&

&&CLT-CoBorr2-EM
AIL&&

&&CLT-CoBorr3-EM
AIL&&

|149|

|159|
|175|

|1265|
|1281|
|1297|
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&&CLT-CoBorr4-EM
AIL&&

&&CLT-CoBorr5-EM
AIL&&

&&CLT-CoBorr6-EM
AIL&&

&&CLT-CoBorr7-EM
AIL&&

&&CLT-CoBorr8-EM
AIL&&

&&CLT-CoBorr9-EM
AIL&&

|1313|
|1329|
|1345|

Guarantor X - MLM Identification

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
MLM-ID&&

&&CLT-Guarantor2-
MLM-ID&&

&&CLT-Guarantor3-
MLM-ID&&

&&CLT-Guarantor4-
MLM-ID&&

&&CLT-Guarantor5-
MLM-ID&&

&&CLT-Guarantor6-
MLM-ID&&

&&CLT-Guarantor7-
MLM-ID&&

&&CLT-Guarantor8-
MLM-ID&&

&&CLT-Guarantor9-
MLM-ID&&

|185|
|186|
|187|

|1146|
|1162|
|1178|
|1194|
|1210|
|1226|

Guarantor X - Social Security Number

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
SOCIALSEC&&

&&CLT-Guarantor2-
SOCIALSEC&&

&&CLT-Guarantor3-
SOCIALSEC&&

&&CLT-Guarantor4-
SOCIALSEC&&

&&CLT-Guarantor5-
SOCIALSEC&&

&&CLT-Guarantor6-
SOCIALSEC&&

&&CLT-Guarantor7-
SOCIALSEC&&

&&CLT-Guarantor8-
SOCIALSEC&&

&&CLT-Guarantor9-
SOCIALSEC&&

|1115.1|
|1130.1|
|1145.1|
|1161.1|
|1177.1|
|1193.1|
|1209.1|
|1225.1|
|1241.1|

Guarantor X  - Business (Company)
Name

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
BUSINESS&&

&&CLT-Guarantor2-
BUSINESS&&

&&CLT-Guarantor3-
BUSINESS&&

&&CLT-Guarantor4-
BUSINESS&&

&&CLT-Guarantor5-
BUSINESS&&

&&CLT-Guarantor6-
BUSINESS&&

&&CLT-Guarantor7-
BUSINESS&&

&&CLT-Guarantor8-
BUSINESS&&

&&CLT-Guarantor9-
BUSINESS&&

|1101|
|1116|
|1131|
|1147|
|1163|
|1179|
|1195|
|1211|
|1227|
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Guarantor X - Title (Mr., Mrs., Ms.,
Dr.)

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
TITLE&&

&&CLT-Guarantor2-
TITLE&&

&&CLT-Guarantor3-
TITLE&&

&&CLT-Guarantor4-
TITLE&&

&&CLT-Guarantor5-
TITLE&&

&&CLT-Guarantor6-
TITLE&&

&&CLT-Guarantor7-
TITLE&&

&&CLT-Guarantor8-
TITLE&&

&&CLT-Guarantor9-
TITLE&&

|1102|

|1117|
|1132|
|1148|
|1164|
|1180|
|1196|
|1212|
|1228|

Guarantor X - First Name

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
FIRSTNAME&&

&&CLT-Guarantor2-
FIRSTNAME&&

&&CLT-Guarantor3-
FIRSTNAME&&

&&CLT-Guarantor4-
FIRSTNAME&&

&&CLT-Guarantor5-
FIRSTNAME&&

&&CLT-Guarantor6-
FIRSTNAME&&

&&CLT-Guarantor7-
FIRSTNAME&&

&&CLT-Guarantor8-
FIRSTNAME&&

&&CLT-Guarantor9-
FIRSTNAME&&

|1103|
|1118|
|1133|
|1149|
|1165|
|1181|
|1197|
|1213|
|1229|

Guarantor X - Middle Initial

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
MI&&

&&CLT-Guarantor2-
MI&&

&&CLT-Guarantor3-
MI&&

&&CLT-Guarantor4-
MI&&

&&CLT-Guarantor5-
MI&&

&&CLT-Guarantor6-
MI&&

&&CLT-Guarantor7-
MI&&

&&CLT-Guarantor8-
MI&&

&&CLT-Guarantor9-
MI&&

|1104|
|1119|
|1134|
|1150|
|1166|
|1182|
|1198|
|1214|
|1230|

Guarantor X - Last Name

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
LASTNAME&&

&&CLT-Guarantor2-
LASTNAME&&

&&CLT-Guarantor3-
LASTNAME&&

&&CLT-Guarantor4-
LASTNAME&&

&&CLT-Guarantor5-
LASTNAME&&

&&CLT-Guarantor6-
LASTNAME&&

|1105|
|1120|
|1135|
|1151|
|1167|
|1183|
|1199|
|1215|
|1231|
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&&CLT-Guarantor7-
LASTNAME&&

&&CLT-Guarantor8-
LASTNAME&&

&&CLT-Guarantor9-
LASTNAME&&

Guarantor X - Address 1

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
ADDRESS1&&

&&CLT-Guarantor2-
ADDRESS1&&

&&CLT-Guarantor3-
ADDRESS1&&

&&CLT-Guarantor4-
ADDRESS1&&

&&CLT-Guarantor5-
ADDRESS1&&

&&CLT-Guarantor6-
ADDRESS1&&

&&CLT-Guarantor7-
ADDRESS1&&

&&CLT-Guarantor8-
ADDRESS1&&

&&CLT-Guarantor9-
ADDRESS1&&

|1106|
|1121|
|1136|
|1152|
|1168|
|1184|
|1200|
|1216|
|1232|

Guarantor X - Address 2

(Guarantor 1 to 9)

Second part of address if needed. &&CLT-Guarantor1-
ADDRESS2&&

&&CLT-Guarantor2-
ADDRESS2&&

&&CLT-Guarantor3-
ADDRESS2&&

&&CLT-Guarantor4-
ADDRESS2&&

&&CLT-Guarantor5-
ADDRESS2&&

&&CLT-Guarantor6-
ADDRESS2&&

&&CLT-Guarantor7-
ADDRESS2&&

&&CLT-Guarantor8-
ADDRESS2&&

&&CLT-Guarantor9-
ADDRESS2&&

|1107|
|1122|
|1137|
|1153|
|1169|
|1185|
|1201|
|1217|
|1233|

Guarantor X - City

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
CITY&&

&&CLT-Guarantor2-
CITY&&

&&CLT-Guarantor3-
CITY&&

&&CLT-Guarantor4-
CITY&&

&&CLT-Guarantor5-
CITY&&

&&CLT-Guarantor6-
CITY&&

&&CLT-Guarantor7-
CITY&&

&&CLT-Guarantor8-
CITY&&

&&CLT-Guarantor9-
CITY&&

|1108|
|1123|
|1138|
|1154|
|1170|
|1186|
|1202|
|1218|
|1234|

Guarantor X - State, Province

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
STATE&&

&&CLT-Guarantor2-
STATE&&

&&CLT-Guarantor3-
STATE&&

|1109|
|1124|
|1139|
|1155|
|1171|
|1187|
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&&CLT-Guarantor4-
STATE&&

&&CLT-Guarantor5-
STATE&&

&&CLT-Guarantor6-
STATE&&

&&CLT-Guarantor7-
STATE&&

&&CLT-Guarantor8-
STATE&&

&&CLT-Guarantor9-
STATE&&

|1203|
|1219|
|1235|

Guarantor X - Country

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
COUNTRY&&

&&CLT-Guarantor2-
COUNTRY&&

&&CLT-Guarantor3-
COUNTRY&&

&&CLT-Guarantor4-
COUNTRY&&

&&CLT-Guarantor5-
COUNTRY&&

&&CLT-Guarantor6-
COUNTRY&&

&&CLT-Guarantor7-
COUNTRY&&

&&CLT-Guarantor8-
COUNTRY&&

&&CLT-Guarantor9-
COUNTRY&&

|1110|
|1125|
|1140|
|1156|
|1172|
|1188|
|1204|
|1220|
|1236|

Guarantor X - Zip / Postal Code

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
ZIP&&

&&CLT-Guarantor2-
ZIP&&

&&CLT-Guarantor3-
ZIP&&

&&CLT-Guarantor4-
ZIP&&

&&CLT-Guarantor5-
ZIP&&

&&CLT-Guarantor6-
ZIP&&

&&CLT-Guarantor7-
ZIP&&

&&CLT-Guarantor8-
ZIP&&

&&CLT-Guarantor9-
ZIP&&

|1111|
|1126|
|1141|
|1157|
|1173|
|1189|
|1205|
|1221|
|1237|

Guarantor X - Phone Number

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
PHONE&&

&&CLT-Guarantor2-
PHONE&&

&&CLT-Guarantor3-
PHONE&&

&&CLT-Guarantor4-
PHONE&&

&&CLT-Guarantor5-
PHONE&&

&&CLT-Guarantor6-
PHONE&&

&&CLT-Guarantor7-
PHONE&&

&&CLT-Guarantor8-
PHONE&&

&&CLT-Guarantor9-
PHONE&&

|1112|
|1127|
|1142|
|1158|
|1174|
|1190|
|1206|
|1222|
|1238|
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Guarantor X - Fax Number

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
FAX&&

&&CLT-Guarantor2-
FAX&&

&&CLT-Guarantor3-
FAX&&

&&CLT-Guarantor4-
FAX&&

&&CLT-Guarantor5-
FAX&&

&&CLT-Guarantor6-
FAX&&

&&CLT-Guarantor7-
FAX&&

&&CLT-Guarantor8-
FAX&&

&&CLT-Guarantor9-
FAX&&

|1113|
|1128|
|1143|
|1159|
|1175|
|1191|
|1207|
|1223|
|1239|

Guarantor X - Mobile Number

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
MOBILE&&

&&CLT-Guarantor2-
MOBILE&&

&&CLT-Guarantor3-
MOBILE&&

&&CLT-Guarantor4-
MOBILE&&

&&CLT-Guarantor5-
MOBILE&&

&&CLT-Guarantor6-
MOBILE&&

&&CLT-Guarantor7-
MOBILE&&

&&CLT-Guarantor8-
MOBILE&&

&&CLT-Guarantor9-
MOBILE&&

|1114|
|1129|
|1144|
|1160|
|1176|
|1192|
|1208|
|1224|
|1240|

Guarantor X - Email

(Guarantor 1 to 9)

- &&CLT-Guarantor1-
EMAIL&&

&&CLT-Guarantor2-
EMAIL&&

&&CLT-Guarantor3-
EMAIL&&

&&CLT-Guarantor4-
EMAIL&&

&&CLT-Guarantor5-
EMAIL&&

&&CLT-Guarantor6-
EMAIL&&

&&CLT-Guarantor7-
EMAIL&&

&&CLT-Guarantor8-
EMAIL&&

&&CLT-Guarantor9-
EMAIL&&

|1115|
|1130|
|1145|
|1161|
|1177|
|1193|
|1209|
|1225|
|1241|

Borrower Loan Security (Description
and Amount)

This  usually  contains  the  amount  and  description  of
the  loan  security.  The  two  elements  will  appear  in  a
single cell.

These data are associated with the loan as such,  and
not directly to the borrower.

&&CLT-SECURITIES
&&

|113|

Co-Borrower X - Loan Security
(Description and Amount)

(Co-Borrower 1 to 9)

"Security" field for the Co-Borrower.

These data are associated with the loan as such,  and
not directly to the Co-borrower.

&&CLT-SECURITIES
_CoBor1&&

&&CLT-SECURITIES
_CoBor2&&

|127|

|133|
|165|
|188|
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&&CLT-SECURITIES
_CoBor3&&

&&CLT-SECURITIES
_CoBor4&&

&&CLT-SECURITIES
_CoBor5&&

&&CLT-SECURITIES
_CoBor6&&

&&CLT-SECURITIES
_CoBor7&&

&&CLT-SECURITIES
_CoBor8&&

&&CLT-SECURITIES
_CoBor9&&

|189|
|190|
|191|
|192|
|193|

Total number of files attached to the
Borrower

Borrower tab > Notes+ > Borrower's Attached Documents
button.

&&AttachedFilesBO
RR_Num&&

|180|

Size in (Kb) of all files attached to the
Borrower

Borrower tab > Notes+ > Borrower's Attached Documents
button.

&&AttachedFilesBO
RR_size&&

|181|

Employer Business (Company) Name
Co-Borrower 1

Data on the Employer &&EMP-BUSINESS
&&

&&CoBORR-EMP-B
USINESS&&

|1500|
|1500.1|

Employer First Name
Co-Borrower 1

- &&EMP-FIRSTNAM
E&&

&&CoBORR-EMP-FI
RSTNAME&&

|1501|
|1501.1|

Employer Last Name
Co-Borrower 1

- &&EMP-LASTNAME
&&

&&CoBORR-EMP-L
ASTNAME&&

|1502|
|1502.1|

Employer Middle Initial
Co-Borrower 1

- &&EMP-MI&&
&&CoBORR-EMP-M

I&&

|1503|
|1503.1|

Employer Title (Mr., Mrs., Ms., Dr.)
Co-Borrower 1

- &&EMP-TITLE&&
&&CoBORR-EMP-TI

TLE&&

|1504|
|1504.1|

Employer Address 1
Co-Borrower 1

- &&EMP-ADDRESS1
&&

&&CoBORR-EMP-A
DDRESS1&&

|1505|
|1505.1|

Employer Address 2
Co-Borrower 1

- &&EMP-ADDRESS2
&&

&&CoBORR-EMP-A
DDRESS2&&

|1506|
|1506.1|

Employer City
Co-Borrower 1

- &&EMP-CITY&&
&&CoBORR-EMP-CI

TY&&

|1507|
|1507.1|

Employer State, Province
Co-Borrower 1

- &&EMP-STATE&&
&&CoBORR-EMP-ST

ATE&&

|1511|
|1511.1|

Employer Country
Co-Borrower 1

- &&EMP-COUNTRY
&&

&&CoBORR-EMP-C
OUNTRY&&

|1508|
|1508.1|

Employer Zip / Postal Code
Co-Borrower 1

- &&EMP-ZIP&&
&&CoBORR-EMP-ZI

P&&

|1514|
|1514.1|

Employer Phone Number
Co-Borrower 1

- &&EMP-PHONE&&
&&CoBORR-EMP-P

|1510|
|1510.1|
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HONE&&

Employer Fax Number
Co-Borrower 1

- &&EMP-FAX&&
&&CoBORR-EMP-F

AX&&

|1509|
|1509.1|

Employer Unique Identifier 1 - &&EMP_UniqueID1
&&

|1512|

Employer Unique Identifier 2 - &&EMP_UniqueID2
&&

|1513|

Creditor
Field name Description Merge Code Short

Merge
Code 

Creditor ID ID generated by MLM. Numbers in the 30000. &&CreditorID&& |326|

Creditor Unique Identifier 1 Identifier  allowing  to  create  a  link  for  a  Creditor  to  third
party software. This identifier must be unique, thus can not
be repeated.

&&CRD_UniqueID1
&&

|336|

Creditor Unique Identifier 2 Identifier  allowing  to  create  a  link  for  a  Creditor  to  third
party software. This identifier must be unique, thus can not
be repeated.

&&CRD_UniqueID2
&&

|337|

Creditor Business (Company) Name This could also be a fund as opposed to a Creditor.

If  you  lend  and  borrow,  and  use  MLM  to  manage  your
assets and liabilities, in the first scenario you would be the
Creditor  and  in  the  second  scenario  you  would  be  the
Borrower.   Your  Creditor  would  be  entered  here  in  the
second scenario.

&&CRD-
CREDITOR&&

|321|

Creditor Permit Number - &&CRD-PERMIT&& |333|

Creditor Title (Mr., Mrs., Ms., Dr.) Self explanatory (hereafter entered as -). &&CRD-TITLE&& |304|

Creditor First Name - &&CRD-
FIRSTNAME&&

|301|

Creditor Middle Initial - &&CRD-MI&& |303|

Creditor Last Name - &&CRD-
LASTNAME&&

|302|

Creditor Address 1 - &&CRD-
ADDRESS1&&

|319|

Creditor Address 2 Second part of address if needed. &&CRD-
ADDRESS2&&

|320|

Creditor City - &&CRD-CITY&& |322|

Creditor State, Province - &&CRD-STATE&& |335|

Creditor Country - &&CRD-
COUNTRY&&

|323|

Creditor Zip / Postal code - &&CRD-ZIP&& |338|

Creditor Phone Number - &&CRD-PHONE&& |334|

Creditor Fax Number - &&CRD-FAX&& |325|

Creditor Mobile Number - &&CRD-MOBILE&& |329|
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Creditor E-mail - &&CRD-EMAIL&& |324|

Creditor Web Site -

Creditor Other information "Other  information"  field  under  "Creditor".  These  data  are
associated to the loan, not directly to the Creditor.

&&CRD-OTHER&& |330|

Creditor Participation Amount When  a  loan  has  more  than  one  Creditor,  a  participation
amount  can  be  assigned  to  each  Creditor.  The  amount  in
this field is the amount entered for the first Creditor in the
Creditor list for the loan. 

These  data  are  associated  with  the  loan,  while  also  being
related to the Creditor.

&&CRD-
AMOUNT&&

|331|

Creditor Participation Percentage When a loan has more than one Creditor, the percentage of
participation  can  be  assigned  to  each  Creditor.  The
percentage  in  this  field  is  the  percentage  entered  for  the
first Creditor in the Creditor list for the loan. 

These  data  are  associated  with  the  loan,  while  also  being
related to the Creditor.

&&CRD-
PERCENT&&

|332|

Creditor Return (%) Return percentage this Creditor receives for his investment
in a loan.

For  example,  a  loan  is  provided  to  the  borrower  at  12%
yearly interest. The investor receives 8% yearly interest.

These  data  are  associated  with  the  loan,  while  also  being
related to the Creditor.

&&CRD-RETURN&& |361|

Creditor Loan Officer First Name - &&OFF-
FIRSTNAME&&

|327|

Creditor Loan Officer Last Name - &&OFF-
LASTNAM&&

|328|

Creditor 2 Business (Company) Name - &&CRD-
CREDITOR_2&&

|305|

Creditor 2 First Name - &&CRD-
FIRSTNAME_2&&

|306|

Creditor 2 Last Name - &&CRD-
LASTNAME_2&&

|307|

Creditor 2 Participation Amount The  amount  in  this  field  is  the  amount  entered  for  the
second Creditor in the Creditor list for the loan. 

&&CRD-
AMOUNT_2&&

|310|

Creditor 2 Participation Percentage The  percentage  in  this  field  is  the  percentage  entered  for
the second Creditor in the Creditor list for the loan. 

&&CRD-
PERCENT_2&&

|311|

Creditor 2 Return (%) Return percentage this Creditor receives for his investment
in a loan.

For  example,  a  loan  is  provided  to  the  borrower  at  12%
yearly interest. The investor receives 8% yearly interest.

These  data  are  associated  with  the  loan,  while  also  being
related to the Creditor.

&&CRD-RETURN_2
&&

|362|

Creditor 2 Loan Officer First Name - &&OFF-
FIRSTNAME_2&&

|308|

Creditor 2 Loan Officer Last Name - &&OFF-
LASTNAME_2&&

|309|

Creditor 3 Business (Company) Name - &&CRD-
CREDITOR_3&&

|312|
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Creditor 3 First Name - &&CRD-
FIRSTNAME_3&&

|313|

Creditor 3 Last Name - &&CRD-
LASTNAME_3&&

|314|

Creditor 3 Participation Amount The amount in this field is the amount entered for the third
Creditor in the Creditor list for the loan. 

&&CRD-
AMOUNT_3&&

|317|

Creditor 3 Participation Percentage The  percentage  in  this  field  is  the  percentage  entered  for
the third Creditor in the Creditor list for the loan. 

&&CRD-
PERCENT_3&&

|318|

Creditor 3 Return (%) Return percentage this Creditor receives for his investment
in a loan.

For  example,  a  loan  is  provided  to  the  borrower  at  12%
yearly interest. The investor receives 8% yearly interest.

These  data  are  associated  with  the  loan,  while  also  being
related to the Creditor.

&&CRD-RETURN_3
&&

|363|

Creditor 3 Loan Officer First Name - &&OFF-
FIRSTNAME_3&&

|315|

Creditor 3 Loan Officer Last Name - &&OFF-
LASTNAME_3&&

|316|

Creditor (All) - ID   For  participating  loans  (multiple  creditors  each  owning  a
fraction  of  a  loan),  reports  the  ID  generated  by  MLM
(Numbers in the 30000) of each of the Creditors individually.

&&--__--&& |360|

Creditors (All) – Business (Company)
Name  

For  participating  loans  (multiple  Creditors  each  owning  a
fraction  of  a  loan),  reports  the  Company  name  of  each  of
the Creditors individually.

&&-----R&& |343|

Creditors (All) – First Name For  participating  loans  (multiple  Creditors  each  owning  a
fraction  of  a  loan),  reports  the  First  Name  of  each  of  the
Creditors.

&&----&& |342|

Creditors (All) – Last Name For  participating  loans  (multiple  Creditors  each  owning  a
fraction  of  a  loan),  reports  the  Last  Name  of  each  of  the
Creditors individually.

&&-&& |341|

Creditors (All) – Participation
(Amount)

For  participating  loans  (multiple  Creditors  each  owning  a
fraction  of  a  loan),  reports  the  amount  entered  in  the
"Amount" field ("Participation" section > Creditor window >
Record) for each of the Creditors individually.

&&--&& |339|

Creditors (All) – Participation
(Percentage)

For  participating  loans  (multiple  Creditors  each  owning  a
fraction of  a loan),  allows to report the amount entered in
the  "Percentage"  field  ("Participation"  section  >  Creditor
window > Record) for each of the Creditors individually.

Most useful when used with the Mathematical Equations in
order to multiply this participation percentage by any of the
numerous fields available  to  obtain each Creditor's  portion
(for  example,  principal  portion,  interest  portion,  balance
portion, etc.). 

&&---&& |340|

Creditor (All) – Return (%) Return percentage this Creditor receives for his investment
in a loan.

For  example,  a  loan  is  provided  to  the  borrower  at  12%
yearly interest. The investor receives 8% yearly interest.

Most  useful  when  used  with  Mathematical  Equations  to

&&_123132_&& |364|
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determine the interest to be paid to the investor. Equation
example: 8% / 12%* Interest Paid.

If  multiple  investors  participate  in  the  loan,  a  different
return can be indicated for each investor. The Participation
(%) is then added to the Mathematical Equation.

Creditor - Total Participation Amount
all Creditors

For  participating  loans  (multiple  creditors  each  owning  a
fraction of a loan), reports the total amount entered in the
"Amount" field ("Participation" section > Creditor window >
Record) for all Creditors.

&&CRD_AMOUNT_
TOTAL&&

|339.1|

Custom Fields
Field name Description Merge Code Short

Merge
Code

Custom Fields (Data)

1-9 Custom Fields related to the Loan. &&CUS-Field1&& |1| to |9|

Unlimited (Table Format) Custom Fields related to the Loan. &&CUSFI-1&& |C28|

Custom Fields (Borrower)

1-9 Custom Fields related to the Borrower. &&CUSBr-Field11&
&

|10| to
|18|

Unlimited (Table Format) Custom Fields related to the Borrower. &&CUSFI-1&& |C29|

Custom Fields (Creditor)

1-9 Custom Fields related to the Creditor. &&CUSCr-Field21&
&

|18| to
|27|

Unlimited (Table Format) Custom Fields related to the Creditor. &&CUSFI-1&& |C30|

Dates
Field name Description Merge Code Short

Merge
Code

Date - Today (Windows Short Date
Format)

Current date in short format, such as 23/10/2014. Based on
your Window's format.

&&INV-TODAYS-
DATE&&

|712|

Date - Today (Windows Long Date
Format)

Current  date  in  long  format,  such  as  October  23,  2014.
Based on your Window's format and it's install language.

&&INV-TODAYS-
DATE_LongFormat&

&

|711|

Date - Today (Format: January 20,
2020)

Current date in long format. &&INV-TODAYS-
DATE_LongEN&&

|710|

Date - Today (Format: 20 January,
2020)

Current date in long format (French style). &&INV-TODAYS-
DATE_LongFR&&

|709|

Date - Record Creation Date Date at  which the  Record  was  originally  created,  saved for
the first time

&&LoanCreationDat
e&&

|591|

Loan Origination Date Date entered by the user as the origination date in "Data". &&ORIGINDATE&& |529|

|529| Date  entered  by  the  user  as  the  First  Payment  date  in
"Data".

&&FIRSTPMTDATE
&&

|529.1|
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Loan Origination + 12 months Reports  the  date  that  is  exactly  12  months  after  the
Origination date of the loan (with the exception of February
29).

&&ORIGINDATE+1y
ear&&

|530|

Loan End Date Very  last  date  of  the  loan  no  matter  if  the  payment  is
positive, negative or 0.00.

See also "Last Payment Date (Pmt > 0.00)".

&&LOANENDDATE
&&

|528|

Record Date See Loan Data

Borrower Birth Date See Borrower

First positive transaction - Date See Payments

First negative transaction - Date See Payments

Last positive transaction - Date See Payments

Last Paid payment (all Paid Line
statuses)(entire Loan) - Date

See Payments

Last Paid payment (all Paid Line
statuses)(in period) - Date

See Payments

Last Paid Payment (all Paid Line
statuses)(in period) - True Pmt Date
(Grace)

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(entire
Loan) - Date

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(in period) -
Date

See Payments

Last Paid/Unpaid Payment (only Paid
and Unpaid Line statuses)(in period) -
True Pmt (Grace)

See Payments

Last Unpaid payment (all Unpaid Line
statuses)(entire Loan) - Date

See Payments

Next Due Pmt - Date (entire Loan) See Payments

Days (number) in Loan (up to last line
of Payment schedule)

See Loan Data

Days (number) in Loan (up to last line
of Payment schedule)(Payment >0)

See Loan Data

Doubtful Accounts (Date from
Record)

See Doubtful/Bad Debt

Bad Debt (Date)(from Record) See Doubtful/Bad Debt

Date - report Start Date For  a  report  between two dates,  the start  date  entered by
the user when generating the report. 

May  be  useful  particularly  in  RTF  merged  documents  (
Invoices  and  Statements)  to  indicate  the  period  of  the
report (from... to...) or the date of a specific balance.

&&INV-START-
DATE&&

|714|

Date - report End Date For  a  report  between  two  dates,  the  end  date  entered  by
the user when generating the report. 

May  be  useful  particularly  in  RTF  merged  documents  (

&&INV-END-
DATE&&

|713|
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Invoices  and  Statements)  to  indicate  the  period  of  the
report (from... to...) or the date of the balance at the end of
the month for example.

Record Last Updated Date and time at which the Record was last updated. &&LOANLASTMOD
&&

|547|

Date of change to the "Closed"
Record Status

This  date  is  only  reported  when  a  Record  is  changed  to
Closed, no other Record Status. If a Record is changed from
Closed to Archived for example, the date will be deleted. If a
Record is changed from Active to Closed, then Active again,
the original Closed date will  be lost even if  the change was
only temporary. This field does not  keep the history of  the
Closed  dates.  The  Record  Log  would  have  to  be  consulted
for this. 

If  a personalized Record Status was created, even if  named
"Closed  too",  the  date  will  not  be  reported  since  "Closed
too" is not, for Margill, a Closed Record.

&&DateRecordClos
ed&&

|5993|

Use Interest table See Interest

Rate Table - Percentage to Add
(annual)

See Interest

Abbreviation Name of the Interest
Table

See Interest

Variable Interest rate Method See Interest

Rate Table -  Frequency of changes
starting on this date

See Interest

Rate Table -  Frequency of changes
every X months

See Interest

Doubtful/Bad Debt
Field name Description Merge Code Short

Merge
Code

Doubtful Accounts (%) Percentage  of  doubtful  accounts  as  entered  in  the  "Data"
window ("Data" tab).

&&DOUTACC-
RATE&&

|923|

Doubtful Accounts (Date from
Record)

Date  entered  in  the  "Data"  window  ("Data"  tab).  Will  be
blank if no date is entered in the "Data" window.

&&DOUTACC-
DATE&&

|926|

Doubtful Accounts (Balance from
Record date)

Will  give  the  doubtful  accounts  balance  (based  on  the
percentage  entered  in  the  "Data"  window)  at  the  date
entered in  the "Data"  window including the  transactions  of
the day but excluding the interest of that day.

Takes the percentage entered and multiplies by the balance
on this date.

Will give 0.00 if no date is entered in the "Data" window.

&&DOUTACC-
BALRecordDate&&

|924|

Doubtful Accounts (Balance from
report End date)

Will  give  the  doubtful  accounts  balance  (based  on  the
percentage entered in the "Data" window) at the end date of
the report (thus a percentage of the balance on that day), no
matter what date is entered in the "Data" window.

For  the  "Complete  report",  will  give  the  doubtful  accounts
balance based on the Record's final date balance (often 0.00

&&DOUTACC-
BALReportDate&&

|925|
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for completely amortized loans).

Will / will not give the same results as the Doubtful accounts
report.

Bad Debt (Date)(from Record) Date  entered  in  the  "Data"  window  when  the  Record  is
considered (changed to) "Bad Debt".

&&BADDebt-
DATE&&

|922|

Bad Debt (Balance)(Record Date) Record Balance on the Bad Debt date entered in the "Data"
window.

&&BADDebt-BAL&& |921|

Fees and Columns
Field name Description Merge Code Short

Merge
Code

Six(6) Column Fees, six (6) Line Fees and nine (9) Custom Columns are available for which the names can be modified
by the user.

Column Fees Amount (Original) Original amount of the Column Fees entered in the "Add
fees" window in the "Data" tab.

Even if these fees are changed later on in the Payment
schedule, only the original amount will be reported.

&&Fees1Col_Amou
nt&&

&&Fees2Col_Amou
nt&&

&&Fees3Col_Amou
nt&&

&&Fees4Col_Amou
nt&&

&&Fees5Col_Amou
nt&&

&&Fees6Col_Amou
nt&&

|565|
|566|
|567|

|5670|
|5671|
|5672|

Column Fees Percentage (Original) Original percentage (of the balance or interest accrued for
the line) of the Column Fees entered in the "Add fees"
window in the "Data" tab.

Even if this percentage is changed later on in the Payment
schedule, only the original percentage will be reported.

&&Fees1Col_Perce
nt&&

&&Fees2Col_Perce
nt&&

&&Fees3Col_Perce
nt&&

&&Fees4Col_Perce
nt&&

&&Fees5Col_Perce
nt&&

&&Fees6Col_Perce
nt&&

|568|
|569|
|570|

|5700|
|5701|
|5702|

Column Fees Accrued (for period) Accrued Column Fees (as opposed to Paid or Due) for the
given report dates.

&&Fees1Col&&
&&Fees2Col&&
&&Fees3Col&&
&&Fees4Col&&
&&Fees5Col&&
&&Fees6Col&&

|836|
|837|
|838|

|8380|
|8381|
|8382|

Column Fees Accrued  (entire Loan) Accrued Column Fees (as opposed to Paid or Due) for the full
loan.

&&Loan_Fees1Col
&&

&&Loan_Fees2Col
&&

&&Loan_Fees3Col
&&

&&Loan_Fees4Col
&&

&&Loan_Fees5Col
&&

&&Loan_Fees6Col
&&

|571|
|572|
|573|

|5730|
|5731|
|5732|

Column Fees Paid (for period) Paid Column Fees (as opposed to Accrued) for the given &&Fees1ColPaid&
&

|839|
|840|
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report dates. &&Fees2ColPaid&
&

&&Fees3ColPaid&
&

&&Fees4ColPaid&
&

&&Fees5ColPaid&
&

&&Fees6ColPaid&
&

|841|
|8410|
|8411|
|8412|

Column Fees 1 Paid (for period), Paid
Pmt X

(Paid Pmt, Paid Pmt 2 to 10)

In the Payment schedule, the total Column Fees 1 Paid of all
lines  "Paid  Pmt"  -  "Paid  Pmt  (2)  to  (10)"-  Line  status
exclusively for the chosen report period.

&&ACC_Fees1ColP
aid_PaidPmt1&&

&&ACC_Fees1ColP
aid_PaidPmt2&&

&&ACC_Fees1ColP
aid_PaidPmt3&&

&&ACC_Fees1ColP
aid_PaidPmt4&&

&&ACC_Fees1ColP
aid_PaidPmt5&&

&&ACC_Fees1ColP
aid_PaidPmt6&&

&&ACC_Fees1ColP
aid_PaidPmt7&&

&&ACC_Fees1ColP
aid_PaidPmt8&&

&&ACC_Fees1ColP
aid_PaidPmt9&&

&&ACC_Fees1ColP
aid_PaidPmt10&&

|462|

|463|

|464|

|465|

|466|

|467|

|468|

|469|

|470|

|471|

Column Fees 2 Paid (for period), Paid
Pmt X

(Paid Pmt, Paid Pmt 2 to 10)

In the Payment schedule, the total Column Fees 2 Paid of all
lines  "Paid  Pmt"  -  "Paid  Pmt  (2)  to  (10)"-  Line  status
exclusively for the chosen report period.

&&ACC_Fees2ColP
aid_PaidPmt1&&

&&ACC_Fees2ColP
aid_PaidPmt2&&

&&ACC_Fees2ColP
aid_PaidPmt3&&

&&ACC_Fees2ColP
aid_PaidPmt4&&

&&ACC_Fees2ColP
aid_PaidPmt5&&

&&ACC_Fees2ColP
aid_PaidPmt6&&

&&ACC_Fees2ColP
aid_PaidPmt7&&

&&ACC_Fees2ColP
aid_PaidPmt8&&

&&ACC_Fees2ColP
aid_PaidPmt9&&

&&ACC_Fees2ColP
aid_PaidPmt10&&

|474|

|475|

|476|

|477|

|478|

|479|

|480|

|481|

|482|

|483|

Column Fees 3 Paid (for period), Paid
Pmt X

(Paid Pmt, Paid Pmt 2 to 10)

In the Payment schedule, the total Column Fees 3 Paid of all
lines  "Paid  Pmt"  -  "Paid  Pmt  (2)  to  (10)"-  Line  status
exclusively for the chosen report period.

&&ACC_Fees3ColP
aid_PaidPmt1&&

&&ACC_Fees3ColP
aid_PaidPmt2&&

&&ACC_Fees3ColP
aid_PaidPmt3&&

&&ACC_Fees3ColP
aid_PaidPmt4&&

&&ACC_Fees3ColP
aid_PaidPmt5&&

&&ACC_Fees3ColP
aid_PaidPmt6&&

&&ACC_Fees3ColP
aid_PaidPmt7&&

&&ACC_Fees3ColP
aid_PaidPmt8&&

|486|

|487|

|488|

|489|

|490|

|491|

|492|

|493|
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&&ACC_Fees3ColP
aid_PaidPmt9&&

&&ACC_Fees3ColP
aid_PaidPmt10&&

|494|

|495|

Column Fees 4 Paid (for period), Paid
Pmt X

(Paid Pmt, Paid Pmt 2 to 10)

In the Payment schedule, the total Column Fees 4 Paid of all
lines  "Paid  Pmt"  -  "Paid  Pmt  (2)  to  (10)"-  Line  status
exclusively for the chosen report period.

&&ACC_Fees4ColP
aid_PaidPmt1&&

&&ACC_Fees4ColP
aid_PaidPmt2&&

&&ACC_Fees4ColP
aid_PaidPmt3&&

&&ACC_Fees4ColP
aid_PaidPmt4&&

&&ACC_Fees4ColP
aid_PaidPmt5&&

&&ACC_Fees4ColP
aid_PaidPmt6&&

&&ACC_Fees4ColP
aid_PaidPmt7&&

&&ACC_Fees4ColP
aid_PaidPmt8&&

&&ACC_Fees4ColP
aid_PaidPmt9&&

&&ACC_Fees4ColP
aid_PaidPmt10&&

|4902|
|4903|
|4904|
|4905|
|4906|
|4907|
|4908|
|4909|
|4911|
|4912|

Column Fees 5 Paid (for period), Paid
Pmt X

(Paid Pmt, Paid Pmt 2 to 10)

In the Payment schedule, the total Column Fees 5 Paid of all
lines  "Paid  Pmt"  -  "Paid  Pmt  (2)  to  (10)"-  Line  status
exclusively for the chosen report period.

&&ACC_Fees5ColP
aid_PaidPmt1&&

&&ACC_Fees5ColP
aid_PaidPmt2&&

&&ACC_Fees5ColP
aid_PaidPmt3&&

&&ACC_Fees5ColP
aid_PaidPmt4&&

&&ACC_Fees5ColP
aid_PaidPmt5&&

&&ACC_Fees5ColP
aid_PaidPmt6&&

&&ACC_Fees5ColP
aid_PaidPmt7&&

&&ACC_Fees5ColP
aid_PaidPmt8&&

&&ACC_Fees5ColP
aid_PaidPmt9&&

&&ACC_Fees5ColP
aid_PaidPmt10&&

|4916|
|4917|
|4918|
|4919|
|4921|
|4922|
|4923|
|4924|
|4925|
|4926|

Column Fees 6 Paid (for period), Paid
Pmt X

(Paid Pmt, Paid Pmt 2 to 10)

In the Payment schedule, the total Column Fees 6 Paid of all
lines  "Paid  Pmt"  -  "Paid  Pmt  (2)  to  (10)"-  Line  status
exclusively for the chosen report period.

&&ACC_Fees6ColP
aid_PaidPmt1&&

&&ACC_Fees6ColP
aid_PaidPmt2&&

&&ACC_Fees6ColP
aid_PaidPmt3&&

&&ACC_Fees6ColP
aid_PaidPmt4&&

&&ACC_Fees6ColP
aid_PaidPmt5&&

&&ACC_Fees6ColP
aid_PaidPmt6&&

&&ACC_Fees6ColP
aid_PaidPmt7&&

&&ACC_Fees6ColP
aid_PaidPmt8&&

&&ACC_Fees6ColP
aid_PaidPmt9&&

&&ACC_Fees6ColP
aid_PaidPmt10&&

|4931|
|4932|
|4933|
|4934|
|4935|
|4936|
|4937|
|4938|
|4939|
|4941|

Column Fees X Paid (for period), Paid
Pmt Returned check

In the Payment schedule, the total Column Fees X Paid of all
lines  "Paid  Pmt  Returned  check"  Line  status  exclusively  for

&&ACC_Fees1ColP
aid_PmtCheck&&

|472|
|484|
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(Column Fees 1 to 6)
the chosen report period. &&ACC_Fees2ColP

aid_PmtCheck&&
&&ACC_Fees3ColP
aid_PmtCheck&&

&&ACC_Fees4ColP
aid_PmtCheck&&

&&ACC_Fees5ColP
aid_PmtCheck&&

&&ACC_Fees6ColP
aid_PmtCheck&&

|496|
|4913|
|4927|
|4942|

Column Fees X Paid (for period), Add.
Pmt

(Column Fees 1 to 6)

In the Payment schedule, the total Column Fees X Paid of all
lines "Add. Pmt" Line status exclusively for the chosen report
period.

&&ACC_Fees1ColP
aid_PmtAdd&&

&&ACC_Fees2ColP
aid_PmtAdd&&

&&ACC_Fees3ColP
aid_PmtAdd&&

&&ACC_Fees4ColP
aid_PmtAdd&&

&&ACC_Fees5ColP
aid_PmtAdd&&

&&ACC_Fees6ColP
aid_PmtAdd&&

|473|
|485|
|497|

|4914|
|4928|
|4943|

Column Fees X Paid (for period),
Compensatory Pmt

(Column Fees 1 to 6)

In the Payment schedule, the total Column Fees X Paid of all
lines  "Compensatory  Pmt"  Line  status  exclusively  for  the
chosen report period.

&&ACC_Fees1ColP
aid_CompPmt&&

&&ACC_Fees2ColP
aid_CompPmt&&

&&ACC_Fees3ColP
aid_CompPmt&&

&&ACC_Fees4ColP
aid_CompPmt&&

&&ACC_Fees5ColP
aid_CompPmt&&

&&ACC_Fees6ColP
aid_CompPmt&&

|4730|
|4850|
|4970|
|4915|
|4929|
|4944|

Column Fees X Paid (for period) -
Partial and Late Payments only

(Column Fees 1 to 6)

In  the  Payment  schedule,  the  total  Column  Fees  X  Paid  for
the  "Partial  Pmt",  "Late  Pmt"  and  "Partial  Late  Pmt"  Line
statuses exclusively, for the chosen report period.

&&ACC_F1ColPaid
_PmtLatePart&&

&&ACC_F2ColPaid
_PmtLatePart&&

&&ACC_F3ColPaid
_PmtLatePart&&

&&ACC_F4ColPaid
_PmtLatePart&&

&&ACC_F5ColPaid
_PmtLatePart&&

&&ACC_F6ColPaid
_PmtLatePart&&

|615|
|616|
|617|

|6170|
|6171|
|6172|

Fees Financed Paid (APR) (for period)
Paid Pmt X

(Paid Pmt, Paid Pmt 2 to 10)

See APR

Fees Financed Paid (APR) (for period)
Paid Pmt Returned Check

See APR

Fees Financed Paid (APR) (for period)
Add. Pmt

See APR

Fees Financed Paid (APR) (for period)
Compensatory Pmt

See APR

Fees Financed Paid (APR) (for period)
- Partial and Late Payments only

See APR

Column Fees X Accrued (Total from
Record Origination Date to report
End Date)

Total  of  Column  Fees  Accrued  from  the  Record  Origination
Date to report End Date.

&&Fees1Col_UpTo
Date&&

&&Fees2Col_UpTo
Date&&

|872|
|873|
|874|

|8740|
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(Column Fees 1 to 6)
&&Fees3Col_UpTo

Date&&
&&Fees4Col_UpTo

Date&&
&&Fees5Col_UpTo

Date&&
&&Fees6Col_UpTo

Date&&

|8741|
|8742|

Column Fees X Paid (Total from
Record Origination Date to report
End Date)

(Column Fees 1 to 6)

Total of Column Fees Paid from the Record Origination Date
to report End Date.

&&Fees1ColPaid_U
pToDate&&

&&Fees2ColPaid_U
pToDate&&

&&Fees3ColPaid_U
pToDate&&

&&Fees4ColPaid_U
pToDate&&

&&Fees5ColPaid_U
pToDate&&

&&Fees6ColPaid_U
pToDate&&

|875|
|876|
|877|

|8770|
|8771|
|8772|

Balance Column Fees X at 0:00 at
report End Date

(Column Fees 1 to 6)

For reports between two dates and Up to a certain date, this
will be the Column Fees balance on that day, taking into
account one of the three options for including or excluding
payments (transactions) and interest for the last day.

For the "Complete report" the balance reported will be the
Column Fees balance on the very last day of the loan (final
balance)(including transactions for the day).

&&Fees1Col_BALE
ndDate&&

&&Fees2Col_BALE
ndDate&&

&&Fees3Col_BALE
ndDate&&

&&Fees4Col_BALE
ndDate&&

&&Fees5Col_BALE
ndDate&&

&&Fees6Col_BALE
ndDate&&

|842|
|843|
|844|

|8440|
|8441|
|8442|

Balance Column Fees X at 0:00 at
report Start Date

(Column Fees 1 to 6)

For a report between two dates, the Column Fees Balance on
that day at 0:00 in the morning, before any transaction is
made. Column Fees entered at the report Start date would
thus be excluded in the balance since these are entered at
0:00+.

Particular cases:

 Report between two dates:  if the report Start date < =
Origination date: returns 0.00.

 "Full report" and "Report up to...": returns 0.00.

&&Fees1Col_BALSt
artDate&&

&&Fees2Col_BALSt
artDate&&

&&Fees3Col_BALSt
artDate&&

&&Fees4Col_BALSt
artDate&&

&&Fees5Col_BALSt
artDate&&

&&Fees6Col_BALSt
artDate&&

|845|
|846|
|847|

|8470|
|8471|
|8472|

Fees X (Line status) (for period)

(Fees 1 to 6)

See Line status

Fees Paid X (Line status) (for period)

(Fees 1 to 6)

See Line status

Total Fees (All Fees) (for period) See Line status

Total Fees Paid (All Fees Paid) (for
period)

See Line status

Penalty (Line status) (for period) See Line status

Penalty Paid (Line status) (for period) See Line status

Insurance (Line status) (for period) See Line status

Insurance Paid (Line status) (for
period)

See Line status



Page 888

© Jurismedia Inc., 2007- 2023

Tax (Line status) (for period) See Line status

Tax Paid (Line status) (for period) See Line status

Amount Due: Due Pmt + Outstanding
+ all Fees + Penalties (for period)

See Line status

Custom Column (Money) (for period)

Three columns

Total  of  amounts  entered  in  the  Costum  Column  (Money)
column of the Payment schedule for the given report dates.

&&CustCol_Money
1&&

&&CustCol_Money
2&&

&&CustCol_Money
3&&

|860|
|864|
|868|

Custom Column (Numerical) (for
period)

Three columns

Total of amounts entered in the Costum Column (Numerical)
column of the Payment schedule for the given report dates.

&&CustCol_Num1
&&

&&CustCol_Num2
&&

&&CustCol_Num3
&&

|862|
|866|
|870|

Custom Column (Money) (Total from
Record Origination Date to report
End Date)

Three fields

Total  of  the  amounts  entered  in  the  Custom  Column
(Money)  column of  the  Payment  schedule  from  the  Record
Origination Date to the report End Date.

&&CustCol_Money
1_UpToDate&&

&&CustCol_Money
2_UpToDate&&

&&CustCol_Money
3_UpToDate&&

|861|
|865|
|869|

Custom Column (Numerical) (Total
from Record Origination Date to
report End Date)

Three fields

Total  of  the  amounts  entered  in  the  Custom  Column
(Numerical)  column  of  the  Payment  schedule  from  the
Record Origination Date to the report End Date.

&&CustCol_Num1_
UpToDate&&

&&CustCol_Num2_
UpToDate&&

&&CustCol_Num3_
UpToDate&&

|863|
|867|
|871|

General
Field name Description Merge Code Short

Merge
Code

MLM Record Identification See Loan Data

Record Unique Identifier 1 See Loan Data

Record Unique Identifier 2 See Loan Data

Record Status See Loan Data

Active Records - Sub-Status (Current
date if AUTO)

See Loan Data

Record Owner User  name  indicated  in  MLM  who  is  the  Owner  of  the
Record.  The  Owner  is  under  the  General  tab  in  the  Data
window.

&&fi_User&& |549|

Record Creation Date See Dates

Record Last Updated See Dates

Record Color Tags Record Color Name &&RecordColor&& |577.1|

Number of Records Number of  Records in the "Record List" report.  Displays  "1"
for  each  of  the  lines,  but  useful  for  the  total  number  of
Records when "Show totals" is selected. 

NA NA

Total number of files attached to the
Record

Data tab > General > Attached Documents button. &&Loan_AttachedFil
es_Num&&

|575|
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Size in (Kb) of all files attached to the
Record

Data tab > General > Attached Documents button. &&Loan_AttachedFil
es_size&&

|576|

Total number of files attached to the
Borrower

Borrower tab > Notes+ > Borrower's Attached Documents
button.

&&AttachedFilesBO
RR_Num&&

|180|

Size in (Kb) of all files attached to the
Borrower

Borrower tab > Notes+ > Borrower's Attached Documents
button.

&&AttachedFilesBO
RR_size&&

|181|

Metro 2 - Active Records Metro 2 code based on the Active Record's sub-status.

In MLM's Main window (Record Summary window) and in all
reports, if the sub-status is calculated (set to "AUTO" in the
"Data" tab of the "Data" window) the sub-status calculation
and the corresponding Metro 2 code will be on the current
date, regardless of the report date. 

&&LoanActiveMetro
2&&

|501|

Metro 2 - Record submitted to
Metro 2

See Loan Data

Metro 2 - ID Borrower selected for
Metro 2

Returns the Borrower's ID selected for Metro 2. NA NA

EFT Account Number (Perceptech) Active EFT Account Number for the Record. This is the
unique account identifier used to link between the bank
account in Margill with the EFT provider (Perceptech
"Reference").

&&M2_BorrID&& |595|

EFT Active Indicate if the EFT is activated in the Record. &&EFT_Active&& |599|

Record's  Color All ows  to sort Records  by color (Main window onl y) NA NA

Line Uni que ID NA NA

Date of cha nge to the "Cl osed"
Record Sta tus

See Dates

Interest

See also the very important "Accounting Data" section

Field name Description Merge Code Short
Merge
Code

Nominal Interest Rate (Original) Interest rate that was entered (no compounding factor). Given
on an annual basis.

&&NOMINALRA
TE&&

|537|

Effective Interest Rate Interest  rate  computed  based  on  the  nominal  rate  and  the
compounding frequency. Given on an annual basis.

&&EFFECTIVERA
TE&&

|512|

Nominal Interest Rate (Monthly Rate) Nominal Interest Rate entered in MLM divided by 12. &&MonthlyNOM
INALRATE&&

|539|

Nominal Interest Rate (Daily Rate) Nominal Interest Rate entered in MLM divided by 365 even for
leap years.

&&DailyNominal
RATE&&

|538|

Effective Interest Rate (Monthly Rate) Effective Interest Rate entered in MLM divided by 12. &&MonthlyEFFE
CTIVERATE&&

|513|

Variable Rate plus or minus (%) When an interest table is chosen, the rate added or subtracted
in the "Data" window, "Data" tab.

&&RATEADDED
&&

|557|

Nominal Interest Rate at report End
Date

Nominal interest rate at the report end date. &&INV_Interest
Rate_EndDate&

&

|849|
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Nominal Interest Rate (at Current
Date)

Nominal interest rate at the current date (today's date). &&INV_Interest
Rate_ToDate&&

|850|

Interest Accrued (entire Loan) Total  accrued  interest  for  the  entire  length  of  the  loan
regardless of the report dates.

&&LOANTOTALI
NT&&

|517|

Interest Accrued (for period) Accrued interest (as opposed to paid or due interest). &&INV-
INTEREST&&

|715|

Interest Accrued from last payment
Paid (entire Loan/report End Date)
(0.00 if no payment)

Accrued  interest  from  the  last  payment  that  is  "Paid"  (Line
status  =   "Paid  Pmt",   "Paid  Pmt  2  to  20",  "Paid  Late  Pmt",
"Partial  Pmt",  "Partial  Late  Pmt",  "Paid Pmt Returned Check"
or  "Add.  Pmt"),  at  0:00  (so  interest  for  that  first  day  is
included) until the end date of the report.

Amount "Paid" must  not  necessarily be greater than 0.00,  so
be careful.

If  a  report  between  two  dates  is  requested  and  no  "Paid"
payment is included in the report time period, then MLM will
"search"  for  the  last  "Paid"  payment  before  the  report  start
date and include the accrued interest as of this payment until
the report end date.

If  the  entire  loan  contains  no  "Paid"  Line  status  or  if  the
payment  is  paid  after  the  report  end  date,  0.00  will  be
returned.

Lines with any other status ("Due Pmt", "Unpaid Pmt", "Fees",
"Fees paid", "Information", "Add. principal", "Other", etc.) are
not factored in.

See  the  diagrams  that  explain  the  various  scenarios  for
Accrued interest in the "Accounting Data" section.

&&INV_ACCRUE
D-INT&&

|719|

Interest Accrued from last payment
Paid (entire Loan/report End Date)

Same  explanations  as  above  (Interest  Accrued  since  last
payment  Paid  (entire  loan/report  End  Date)(0.00  if  no
payment)) taking into account the fact that if the loan contains
no  "Paid"  type  Line  statuses,  the  TOTAL  accrued  interest  for
the report period will be returned.

&&INV_ACCRUE
D-2-INT&&

|718|

Interest Accrued from last payment
Paid (at Current Date (0.00 if no
payment)

Accrued interest from the last payment tagged as "Paid"
(Line status = "Paid Pmt", "Paid Pmt 2 to 20", "Paid Late
Pmt",  "Partial  Pmt",  "Partial  Late  Pmt",  "Paid  Pmt
Returned Check",  "Add.  Pmt" or  "Compensatory Pmt"),
at  0:00(so  interest  for  that  first  day  is  included)  up  to
the current date.

Amount  "Paid"  must  not  necessarily  be  greater  than
0.00 so be careful.

Lines with  any  other  status  ("Due Pmt",  "Unpaid  Pmt",
"Fees",  "Fees  paid",  "Information",  "Add.  principal",
"Other", etc.) are not factored in.

If  the  entire  loan  contains  no  "Paid"  type  Line  status
0.00 will be returned.

&&INV_ACCRUE
D-INT_TODATE&

&

|717|

Interest Accrued from last payment
Paid (at Current Date)

Same explanation as above with the exception that if 
the entire loan contains no "Paid" Line status type, the
amount of interest accrued up to the current date will
be returned.

&&INV_ACCRUE
D-2-INT_TODAT

E&&

|716|
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Interest Accrued from last payment
Paid (for period/report End Date)(0.00
if no payment)

Same  explanations  as  above  (Interest  Accrued  since  last
payment  Paid  (entire  loan/report  End  Date)(0.00  if  no
payment)) but reporting interest amounts as described below:

1)  if  the  last  "Paid"  payment  is  within  the  report  period,  the
accrued interest portion as of such "Paid" payment, up to the
report end date;

2)  if  the  last  "Paid"  payment  is  before  the  report  start  date,
the accrued interest for the entire period;

3) if the last "Paid" payment is after the report end date, the
accrued interest for the entire period;

4) if the entire loan does not contain a "Paid" type Line status,
0.00 will be returned.

See explanatory diagram the "Accounting Data" section.

&&INV_ACCRUE
D-INT-2&&

|721|

Interest Accrued from last payment
Paid (for period/report End Date)

Same  explanations  as  above  (Interest  Accrued  since  last
payment  Paid  (for  period/report  End  Date)(0.00  if  no
payment)) with the exception of item 4) that would return the
accrued interest for the entire period.

&&INV_ACCRUE
D-2-INT-2&&

|720|

Interest Accrued from last payment
Paid/Unpaid (0.00 if no payment)
(entire Loan/report End Date)

Same  explanations  as  above  (Interest  Accrued  since  last
payment  Paid  (entire  loan/report  End  Date)(0.00  if  no
payment)) but including all the "Unpaid" Line statuses.

&&INV_ACCRUE
D-

INT_GRPMT_OU
T&&

|722|

Interest Accrued from last payment
Paid/Unpaid (entire Loan/report End
Date)

Same  explanations  as  above  (Interest  Accrued  since  last
payment Paid (entire loan/report End  Date))  but  including all
the "Unpaid" Line statuses.

&&INV_ACCRUE
D-2-

INT_GP_OUT&&

|725|

Interest Accrued from last payment
Paid/Unpaid (at Current Date)(0.00 if
no payment)

Same explanation as above while including all "Unpaid"
Line statuses.

If  the  entire  loan  contains  no  "Paid"  type  Line  status,
0.00 will be returned.

&&INV_ACCRUE
D-INT_GPTODAT

E&&

|724|

Interest Accrued from last payment
Paid/Unpaid (at Current Date)

Same explanation as above while including all "Unpaid"
Line statuses and if the entire loan contains no "Paid" or
"Unpaid"  type  Line  statuses  the  amount  of  interest
accrued up to the current date will be returned.

&&INV_ACCRUE
D-2-INT_GPTOD

ATE&&

|723|

Interest Accrued from last payment
Paid/Unpaid (for period/report End
Date)(0.00 if no payment)

Same  explanations  as  above  (Interest  Accrued  since  last
payment  Paid  (for  period/report  End  Date)(0.00  if  no
payment)) but including all the "Unpaid" Line statuses.

&&INV_ACCRUE
D-

INT_GRPMT_IN
&&

|727|

Interest Accrued from last payment
Paid/Unpaid (for period/report End
Date)

Same  explanations  as  above  (Interest  Accrued  since  last
payment  Paid  (for  period/report  End  Date))  but  including  all
the "Unpaid" Line statuses.

&&INV_ACCRUE
D-2-

INT_GRPMT_IN
&&

|726|

Interest Accrued - Year-to-date (from
January 1 to report End Date)

Interest Accrued  from January 1 at 0:00 until  the report End
Date entered.

The year for January 1 is determined based on the report End
Date entered for the report.

For  example,  for  a  report  from  June  1,  2014  until  June  30,
2014, interest accrued will be effective as of 1 January 1, 2014.

If a full  report is  requested, then the amount of  interest  will
be 0.00.

&&INV_INT_ACC
RUED_YTD&&

|701|
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Interest Due between Expected
Payments (for period)

Interest which is due when a payment that should have been
paid  was  not  paid  or  was  partial  and  insufficient  to  pay  the
accrued interest since the last paid payment or payment that
should have been paid.

"Due  Pmt"  Line  statuses  are  NOT  taken  into  account  when
determining the "Expected" payments.

See  a  more  detailed  explanation  and  an  example  in  the  "
Accounting Data" section.

&&ACC_DUE_IN
T&&

|416|

Interest Charged (Line status)(for
period)

Interest Charged 2 (Line status)(for
period)

(Names can be changed)

See Line status

Interest Paid (Line status)(for period) See Line status

Interest Paid (for period) Interest actually paid as opposed to accrued interest. 

The  Line  status  must  be  one  of  the  following,  otherwise  the
interest will NOT be considered PAID: "Paid Pmt", "Paid Pmt (2
to  20)",  "Paid  Late  Pmt",  "Partial  Pmt",  "Partial  Late  Pmt",
"Paid  Pmt  Returned  Check",  "Add.  Pmt"  or  "Compensatory
Pmt". All other Line statuses will have no effect on the interest
paid.

&&ACC_PAID_IN
T&&

|417|

Interest Paid (for period), Paid Pmt X

(Paid Pmt, Paid Pmt 2 to 10)

In  the  Payment  schedule,  the  total  Interest  Paid  of  all  lines
with  the  "Pmt  Paid"  -or  Pmt  paid  (2)  to  (10)-  Line  status
exclusively, for the chosen report period.

&&ACC_PaidInt_
PaidPmt1&&

&&ACC_PaidInt_
PaidPmt2&&

&&ACC_PaidInt_
PaidPmt3&&

&&ACC_PaidInt_
PaidPmt4&&

&&ACC_PaidInt_
PaidPmt5&&

&&ACC_PaidInt_
PaidPmt6&&

&&ACC_PaidInt_
PaidPmt7&&

&&ACC_PaidInt_
PaidPmt8&&

&&ACC_PaidInt_
PaidPmt9&&

&&ACC_PaidInt_
PaidPmt10&&

|450|

|451|
|452|
|453|
|454|
|455|
|456|
|457|
|458|
|459|

Interest Paid (for period), Paid Pmt
Returned check

In  the  Payment  schedule,  the  total  Interest  Paid  of  all  lines
with the "Pmt Paid Returned check" Line status exclusively, for
the chosen report period.

&&ACC_PaidInt_
PmtCheck&&

|460|

Interest Paid (for period), Add. Pmt In  the  Payment  schedule,  the  total  Interest  Paid  of  all  lines
with  the  "Add.  Pmt"  Line  status  exclusively,  for  the  chosen
report period.

&&ACC_PaidInt_
PmtAdd&&

|461|

Interest Paid (for period),
Compensatory Pmt

In  the  Payment  schedule,  the  total  Interest  Paid  of  all  lines
with the "Compensatory Pmt"  Line status exclusively,  for  the
chosen report period.

&&ACC_PaidInt_
CompPmt&&

|4610|

Interest Paid (for period) - Partial and
Late Payments only

In  the  Payment  schedule,  the  total  Interest  Paid  of  all  lines
with the "Partial  Pmt",  Late Pmt" and "Partial  Late Pmt"  Line
statuses exclusively, for the chosen report period.

&&ACC_PaidInt_
PmtLatePartial&

&

|614|
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Interest Paid (for period) - Interest
paid Line status

In  the  Payment  schedule,  the  total  Interest  paid  of  all  lines
with the Interest Rapid Line status exclusively, for the chosen
report period.

&&ACC_PaidInt_
StatutINT_Paid&

&

|459.1|

Interest Paid (for period)(using Grace/
EFT Date)

Interest  paid  at  the  date  entered  in  the  “True  Pmt  Date
(Grace/EFT)”  column.  The  reports  use  this  date  as  the
transaction date as opposed to the date entered in  the “Pmt
Date”  column.  The  “True  Pmt  Date  (Grace/EFT)”  may  be
before or after the “Pmt Date”. 

The  Line  status  must  be  one  of  the  following,  otherwise  the
interest will NOT be considered PAID: "Paid Pmt", "Paid Pmt (2
to  20)",  "Paid  Late  Pmt",  "Partial  Pmt",  "Partial  Late  Pmt",
"Paid  Pmt  Returned  Check",  "Add.  Pmt"  or  "Compensatory
Pmt". All other Line statuses will have no effect on the interest
paid.

This field and the “True Pmt Date (Grace/EFT)” should only be
used  to  reflect  payments  made  slightly  before  or  after  the
desired “Pmt Date” if these irregularities are to have no effect
on the interest computed.

&&ACC_PAID_IN
T_GraceDate&&

 |436|

Interest to be paid at the next Due
Pmt (as if Paid)(entire loan)

Amount of  the interest that  WILL  actually  be paid if  the next
"Due Pmt" is paid in full.

To find this amount, MLM identifies the next line whose Line
status is "Due Pmt" regardless of the date, simulates an actual
paid payment and reports the amount of  interest that  would
be paid.

&&NextDuePay_
INTPaidAsPaid&

&

|558|

Balance Due Interest (at current date) See Balances

Interest Paid - Year-to-date (From
January 1 to report End Date)

Interest paid (as opposed to accrued)  from January 1  at  0:00
up to the report end date entered.

The  year  for  January  1st  is  determined  based  on  the  report
end date entered.

Thus, for a report from June 1, 2014 to June 30, 2014, interest
paid will be from January 1, 2014.

If  a  complete  report  is  requested,  the  interest  amount
reported will be 0.00.

&&INV_INT_PAI
D_YTD&&

|728|

Interest Paid - Year-to-date (From
January 1 to report End Date)(using
Grace/EFT Date)

Interest paid (as opposed to accrued)  from January 1  at  0:00
up to the report end date entered but taking into account the
date entered in the “True Pmt Date (Grace/EFT)” column. The
reports use this date as the transaction date as opposed to the
date entered in  the “Pmt Date” column.  The “True Pmt Date
(Grace/EFT)” may be before or after the “Pmt Date”. 

The  year  for  January  1st  is  determined  based  on  the  report
end date entered.

Thus, for a report from June 1, 2014 to June 30, 2014, interest
paid will be from January 1, 2014.

If  a  complete  report  is  requested,  the  interest  amount
reported will be 0.00.

This field and the “True Pmt Date (Grace/EFT)” should only be
used  to  reflect  payments  made  slightly  before  or  after  the
desired “Pmt Date” if these irregularities are to have no effect

&&INV_INT_PAI
D_YTD_GraceDa

te&&

|854|
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on the interest computed.

Balance Due Interest at 0:00 at report
Start Date (before transactions on
that day)

Amount  of  cumulative  interest  receivable  at  the  report  start
date entered at 0:00, thus before any transaction on that day.

If interest is added by the Line status "Interest charged" at the
report  start  date,  this  amount  will  be  exluded  as  it  is
considered a transaction for that day.

If  the  report  Start  date  <  the  Origination  date,  we  then
consider  that  the  loan  did  not  exist  at  this  date,  thus  the
amount reported of 0.00. 

&&ACC_BAL_DU
EINT-

STARTDATE&&

|410|

Balance Due Interest at report End
Date

Amount  of  cumulative  interest  receivable  at  the  report  end
date.

&&ACC_BAL_DU
EINT&&

|409|

Interest on Outstanding Balance (for
period)

Interest  calculated  on  the  outstanding  balance  amount  and
the interest on this outstanding amount when the calculation
is done with compounding interest (effective interest method)
or  when  a  lines  or  lines  use(s)  capitalized  simple  interest.
Interest is calculated using the "Outstanding - Total (Balance)"
column.

For  a  simple  interest  calculation,  the  amount  of  interest
excludes  interest  on  interest.  Interest  is  calculated  using  the
"Outstanding - Payment (Balance)" column.

&&Outst_INT_to
tal_period&&

|418|

Interest Balance on Outstanding
Balance at report End Date

See Balances

Interest Balance on Outstanding
Balance at report Start Date (before
transactions on that day)

See Balances

Outstanding - Interest and Column
Fees portion at Report End Date

See Outstanding

APR - Nominal Rate See APR

APR - Effective Rate See APR

APR - Total Cost of Credit (Interest +
Fees)

See APR

APR - Total Cost of Credit (Interest +
Fees)+Total Principal

See APR

Use Interest table Indicates whether the record uses an Interest rate table &&TableRateUse
d&&

|5994|

Rate Table - Percentage to Add
(annual)

Specifies  whether  an  annual  percentage  (up  to  6  decimal
places)  should be added (or  subtracted) to  the  rate  when an
Interest  rate  table  is  used  for  the  Record.  Often  called  the
Spread or Margin (above or below an index or base rate).

&&TableRatePer
centageToAdd&

&

|5995|

Abbreviation Name of the Interest
Table

Indicates the abbreviation name of the Interest rate table used
for the Record.

&&TableRatena
me&&

|5996|

Variable Interest rate Method "Indicates  the  choice  among  the  four  options  available  Data
tab when an Interest rate table is used:
Interest rate table - Fixed rate at Origination Date
Interest rate table - Rates not updated
Interest rate table - Rates updated
Interest rate table - Rates updated periodically"

&&TableRatesM
ethod&&

|5997|

Rate Table -  Frequency of changes
starting on this date

Interest rate table -  Frequency of rate changes starting on this
date.

&&TableRatesDa
teFirstChange&

|5998|
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&

Rate Table -  Frequency of changes
every X months

Interest  rate  table  -   Frequency  of  rate  changes  every  X
months (reported in number of months).

&&TableRatesEv
eryXMonths&&

|5999|

Capitalized Interest (for period) Interest  that  has  been  capitalized  for  the  period  using  the
Simple capitalized interest method only, and not as compound
interest using the Effective rate method.

&&INVTotalIntC
apitalizedPaid&

&

|7000|

Capitalized Interest (entire Loan) Interest that has been capitalized for the entire loan using the
Simple interest capitalized method only, not compound
interest using the Effective Rate method.

&&LoanTotInter
estCapitalized&

&

|7001|

Capitalized Interest Paid (for period) Interest that was capitalized but Paid for the period using the
Simple  Interest  Capitalized  method  only,  not  compound
interest using the Effective Rate Method

&&INV_TotalInt
Capitalized&&

|7002|

Balance Capitalized Interest due at
Report Start date at 0:00

Balance  of  interest  that  has  been  capitalized  but  not  paid,
therefore which is due, at the report’s Start date (at 0:00 a.m.
before  any  transaction  of  the  day).  Balance  based  on  the
Simple  Interest  Capitalized  method  only,  not  compound
interest using the Effective Rate method.

&&INV_BalIntDu
eCap_StartDate

&&

|7003|

Balance Capitalized Interest due at
Report End Date

Balance  of  interest  that  has  been  capitalized  but  not  paid,
therefore  which  is  due,  at  the  report’s  End  date.  Balance
based  on  the  Simple  Interest  Capitalized  method  only,  not
compound interest using the Effective Rate method.

&&INV_BalIntDu
eCap_EndDate&

&

|7004|

Line status
Field name Description Merge Code Short

Merge
Code

Interest to be paid at the next Due
Pmt (as if paid) (entire loan)

See Interest

Principal to be paid at the next Due
Pmt (as if paid) (entire loan)

See Principal

APR - Fees Financed to be paid at the
next Due Pmt (as if paid) (entire
loan)

See APR

Due Pmt (Line status)(for period) In the Payment schedule, the total for each "Due Pmt" Line
status for the chosen report period.

&&INV-DUEPAY&& |790|

Due Pmt (2)(Line status)(for period)
Due Pmt (3)(Line status)(for period)
Due Pmt (4)(Line status)(for period)
Due Pmt (5)(Line status)(for period)

In  the  Payment  schedule,  the  total  amount  for  each
individual  "Due Pmt"  (2)  or  (3)  Line  status,  for  the  report's
time period.

These  "Due  Pmt"  type  Line  statuses  may  be  renamed  as
desired. To avoid any confusion, it is highly recommended to
keep the words "Due Pmt" in the name. For example, "Due
Pmt - Cash".

&&INV-DUEPAY2&&
&&INV-DUEPAY3&&
&&INV-DUEPAY4&&
&&INV-DUEPAY5&&

|857|
|858|

|8580|
|8581|

Due Pmts (All and only Due Pmt type
Line statuses (for period)

In the Payment schedule, the total of all lines with the
"Due Pmt" Line status. This includes "Due Pmt", "Due
Pmt (2)" , "Due Pmt (3)", "Due Pmt (4)" and "Due Pmt
(5)", the latter  four as renamed.

For the chosen report period.

&&INV-DUEPAY_Tot
al&&

|859|
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Due Pmts (All and only Due Pmt
type Line statuses)(entire Loan)

In the Payment schedule, the total of all lines with the "Due
Pmt" Line status. This includes "Due Pmt", "Due Pmt (2)" ,
"Due Pmt (3)", "Due Pmt (4)" and "Due Pmt (5)", the latter
four as renamed, no matter what dates are selected for the
report.

&&LoanINV-DUEPAY
_Total&&

|8590|

Paid Pmt (Line status)(for period) In the Payment schedule, the total of all lines with the "Paid
Pmt" Line status for the chosen report period.

&&INV-
PAIDPAYONLY&&

|778|

Paid Pmt X (Line status)(for period)

(Paid Pmt 2 to 20)

In  the  Payment  schedule,  the  total  amount  for  each
individual  "Paid Pmt"  Line status (as  opposed to  a  total  for
all), for the report's time period.

These  "Payment"  type  Line  statuses  may  be  renamed  as
desired. To avoid any confusion, it is highly recommended to
keep the words "Paid Pmt" in the name.

&&INV-
PAID_PMT2&&

&&INV-
PAID_PMT3&&

&&INV-
PAID_PMT4&&

&&INV-
PAID_PMT5&&

&&INV-
PAID_PMT6&&

&&INV-
PAID_PMT7&&

&&INV-
PAID_PMT8&&

&&INV-
PAID_PMT9&&

&&INV-
PAID_PMT10&&

&&INV-
PAID_PMT11&&

&&INV-
PAID_PMT12&&

&&INV-
PAID_PMT13&&

&&INV-
PAID_PMT14&&

&&INV-
PAID_PMT15&&

&&INV-
PAID_PMT16&&

&&INV-
PAID_PMT17&&

&&INV-
PAID_PMT18&&

&&INV-
PAID_PMT19&&

&&INV-
PAID_PMT20&&

|780|
|781|
|782|
|783|
|784|
|785|
|786|
|787|
|779|

|7901|
|7902|
|7903|
|7904|
|7905|
|7906|
|7907|
|7908|
|7909|
|7910|

Paid Late Pmt (Line status)(for
period)

In the Payment schedule, the total of all lines with the "Paid
Late Pmt" Line status for the chosen report period.

&&INV-
PAIDLATEONLY&&

|777|

Partial Pmt (Line status)(for period) In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Partial Pmt" Line status for the chosen report period.

&&INV-
PARTIALPAYONLY&&

|789|

Partial Late Pmt (Line status)(for
period)

In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Partial Late Pmt" Line status for the chosen report period.

&&INV-
PARTIALLATEONLY&

&

|788|

Paid Pmt Returned Check (Line
status) (for period)

In the Payment schedule, the total of all lines with the "Pmt
Returned Check" Line status for the chosen report period.

&&INV-NSF CHECK-
PAID&&

|803|

Interest paid (Line status = Interest
Paid)(for period)

Interest paid (2) to (4) as renamed
(Line status = Interest Paid)(for
period)

In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Interest paid" Line status for the chosen report period.

Only  interest will  be  paid  with  this  Line  status  no  matter  if
there is  interest outstanding or not.  This  payment type can
result in the "Balance Due Interest" becoming negative.

Can be used for loans with "interest that is paid in advance".

&&INV-
PAID_Statut_INT_Pai

d&&
&&INV-

PAID_Statut_INT_Pai
d2&&

&&INV-
PAID_Statut_INT_Pai

d3&&

|779.1|
|779.3|
|779.4|
|779.5|
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&&INV-
PAID_Statut_INT_Pai

d4&&

Paid Principal  (Line status = Principal
Paid (for Period)

Paid Principal (2) to (4) as renamed
(Line status = Principal Paid (for
Period)

In the Payment schedule, the total of all lines with the "Paid
Principal" Line status for the chosen report period.

Only Principal will be paid with this Line status no matter if
there is interest outstanding or not.

&&INV_Statut_Princ
_Paid&&

&&INV_Statut_Princ
_Paid2&&

&&INV_Statut_Princ
_Paid3&&

&&INV_Statut_Princ
_Paid4&&

|779.2|
|779.6|
|779.7|
|779.8|

Payments Paid (All and only Paid Pmt
type Line statuses)(for period)

In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Payment Paid" status. This includes the these Line statuses
whether  payments  are  complete,  partial,  late  or  on  time.
Other positive Line statuses ("Fees paid" or other) will not be
included.

For the chosen report period.

&&INV-PAIDPAY&& |819|

Total "Expec. Pmt" column (all Paid
and Unpaid Payments) (for period)

Total amount in the "Expec. Pmt" column for the given
report dates. Only "Paid" Line statuses (Paid Pmt 1 to
20, Partial Pmt, etc.) and all "Unpaid" Line status are
included.

&&INV-TOTAL_EXPC
TEDPAY&&

|848|

Add. Pmt (Line status)(for period) In the Payment schedule, the total of all lines with the "Add.
Pmt" Line status for the chosen report period.

&&INV-
ADDPAYONLY&&

|729|

Compensatory Pmt (Line status)(for
period)

In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Compensatory  Pmt"  Line  status  for  the  chosen  report
period.

&&INV-
COMPPAY&&

|7290|

Add. Princ. (Loan) (Line status)(for
period)

In the Payment schedule, the total of all lines with the "Add.
Princ. (Loan)" Line status for the chosen report period. 

Are  excluded  the  "Add.  Princ."  Line  statuses  that  can  be
renamed (see below).

The  amount  in  the  Payment  schedule  is  negative  but  the
value returned here will be positive (absolute value).

The  "Add.  Princ.  (Loan)"  Line  status  and  the  Additional
Principal  Line  statuses  that  can  be  renamed  are  the  only
negative  amounts  that  are  considered  true  (accounting)
principal  and  that  will  affect  the  actual  "Paid  Principal"  or
"Balance Due Principal" columns. All other negative amounts
will only affect the "Balance all others" column in a Payment
schedule. 

&&INV-
ADDPRINC&&

|730|

Add. Princ. X (Line status)(for period)

(Add. Princ. 2 to 10)

In the Payment schedule, the individual  total  of  each "Add.
Princ" type Line status that can be renamed, for the chosen
report period.

The  amount  in  the  Payment  schedule  is  negative  but  the
value returned here will be positive (absolute value).

This Line status adds accounting principal

These  Line  statuses  may  be  renamed  as  desired.  To  avoid
any  confusion,  it  is  highly  recommended to  keep  the  word
"Principal" in the name.

&&INV-
ADDPRINC2&&

&&INV-
ADDPRINC3&&

&&INV-
ADDPRINC4&&

&&INV-
ADDPRINC5&&

&&INV-
ADDPRINC6&&
AddPrinc7&&

&&INV-
AddPrinc8&&

&&INV-
AddPrinc9&&

&&INV-
AddPrinc10&&

|733|
|736|
|739|
|742|
|745|

|7470|
|7473|
|7476|
|7479|
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Add. Princ. (Loan)(interest bearing
portion)(Line status)(for period)

In the Payment schedule, the total of all "Add. Princ. (Loan)"
Line  statuses  but  that  bear  interest,  for  the  chosen  report
period.

Are excluded the "Add. Princ." Line statuses which can be
renamed.

The  amount  in  the  Payment  schedule  is  negative  but  the
value returned here will be positive (absolute value).

&&INV-
ADDPRINC_INT&&

|731|

Add. Princ. X (interest bearing
portion)(Line status)(for period)

(Add. Princ. 2 to 10)

In the Payment schedule, the individual  total  of  each "Add.
Princ."  type  Line  status  that  can  be  renamed  and  only  the
portion that bears interest for the chosen report period.

The  amount  in  the  Payment  schedule  is  negative  but  the
value returned here will be positive (absolute value).

These  Line  statuses  may  be  renamed  as  desired.  To  avoid
any  confusion,  it  is  highly  recommended to  keep  the  word
"Principal" in the name.

&&INV-
ADDPRINC2_INT&&

&&INV-
ADDPRINC3_INT&&

&&INV-
ADDPRINC4_INT&&

&&INV-
ADDPRINC5_INT&&

&&INV-
ADDPRINC6_INT&&
AddPrinc7_INT&&

&&INV-
AddPrinc8_INT&&

&&INV-
AddPrinc9_INT&&

&&INV-
AddPrinc10_INT&&

|734|
|737|
|740|
|743|
|746|

|7471|
|7474|
|7477|
|7480|

Add. Princ. (Loan)(no interest
portion)(Line status)(for period)

In the Payment schedule, the total of all lines with the "Add.
Princ. (Loan)" Line status only,  but that bear no interest, for
the chosen report period. 

Are excluded "Add. Princ." Line statuses that can be
renamed.

The  amount  in  the  Payment  schedule  is  negative  but  the
value returned here will be positive (absolute value).

&&INV-
ADDPRINC_NoINT&

&

|732|

Add. Princ. X (no interest portion)
(Line status)(for period)

(Add. Princ. 2 to 10)

In the Payment schedule, the individual  total  of  each "Add.
Princ."  type  Line  status  that  can  be  renamed  and  only  the
portion that bears no interest for the chosen report period.

The  amount  in  the  Payment  schedule  is  negative  but  the
value returned here will be positive (absolute value).

These may be renamed as desired. To avoid any confusion, it
is  highly recommended to  keep the word "Principal"  in  the
name.

&&INV-
ADDPRINC2_NoINT&

&
&&INV-

ADDPRINC3_NoINT&
&

&&INV-
ADDPRINC4_NoINT&

&
&&INV-

ADDPRINC5_NoINT&
&

&&INV-
ADDPRINC6_NoINT&

&
AddPrinc7_NoINT&&

&&INV-
AddPrinc8_NoINT&&

&&INV-
AddPrinc9_NoINT&&

&&INV-
AddPrinc10_NoINT&

&

|735|
|738|
|741|
|744|
|747|

|7472|
|7475|
|7478|
|7481|

Interest Charged (Line status)(for
period)

Interest Charged 2 (Line status)(for
period) 

In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Interest  Charged"  (or  "Interest  Charged  2")  (as  renamed)
Line statuses. 

The  amount  in  the  Payment  schedule  is  negative  but  the
amount returned here will be positive (absolute value).

&&INV-ADDINT1ONL
Y&&

&&INV-ADDINT2ONL
Y&&

|728.1|
|728.2|
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(Names can be changed)
May  be  useful  to  add  accrued  interest  "artificially"  at  a
particular  date  (often  at  the  start  of  a  loan  in  order  to
recreate the loan history).

Also  used  (rare)  when  the  interest  balance  is  negative  to
increase (repay) negative interest.   A  special  custom report
may be required for this special situation.

Fees X (Line status)(for period)

(Fees 1 to 6) 

In the Result Table,  the individual  total  of  each "Fees" type
Line status.

The  amount  in  the  Payment  schedule  is  negative  but  the
value returned here will be positive (absolute value).

These may be renamed as desired. To avoid any confusion, it
is  highly  recommended  to  keep  the  word  "Fees"  in  the
name.

&&INV-FEES&&
&&INV-2Fees&&
&&INV-3Fees&&
&&INV-4Fees&&
&&INV-5Fees&&
&&INV-6Fees&&

|749|
|750|
|752|
|754|
|756|
|758|

Fees Paid X (Line status)(for period)

(Fees 1 to 6) 

In the Result Table,  the individual  total  of  each "Fees Paid"
type Line status. 

The  Fees  Paid  will  refund  their  counterpart  Fees  charged
(Fees 1 to 6).

These may be renamed as desired. To avoid any confusion, it
is highly recommended to keep the word "Fees Paid" in the
name.

&&INV_FEESPAID&&
&&INV_FEES2PAID&

&
&&INV_FEES3PAID&

&
&&INV_FEES4PAID&

&
&&INV_FEES5PAID&

&
&&INV_FEES6PAID&

&

|760|
|751|
|753|
|755|
|757|
|759|

Total Fees (All Fees)(for period) Total  of  Fees, Fees 2,  Fees 3,  Fees 4,  Fees 5  and Fees 6  for
the chosen report period.

This  will  include  the  total  of  all  fees  even  if  you  rename  a
"Fees (X)" Line status.

&&INV_FeesTotal&& |829|

Total Fees Paid (All Fees Paid)(for
period)

Total of Fees Paid, Fees 2 Paid, Fees 3 Paid, Fees 4 Paid, Fees
5 Paid, Fees 6 Paid for the chosen  report period.

This will include the total of fees paid even if you rename a
"Fees Paid (X)" Line status.

&&INV_FeesPaidTot
al&&

|830|

Penalty (Line status)(for period) In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Penalty" Line status. The amount in the Payment schedule
is  negative  but  the  amount  returned  here  will  be  positive
(absolute value).

For the chosen report period.

&&INV_PENALTY&& |801|

Penalty Paid (Line status)(for period) In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Penalty Paid" Line status for the chosen report period.

&&INV_PENALTYPAI
D&&

|802|

Insurance (Line status)(for period) In  the  Payment  schedule,  the  total  of  all  lines  with  the
 "Insurance"  Line  status.  The  amount  in  the  Payment
schedule  is  negative  but  the  amount  returned  here  will  be
positive (absolute value).

For the chosen report period.

&&INV_INSURANCE
&&

|761|

Insurance Paid (Line status)(for
period)

In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Insurance Paid" Line status for the chosen report period.

&&INV_INSURANCEP
AID&&

|762|

Tax (Line status)(for period) In the Payment schedule, the total of all lines with the "Tax"
Line status. The amount in the Payment schedule is negative
but  the  amount  returned  here  will  be  positive  (absolute

&&INV_TAX&& |804|
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value).

For the chosen report period.

Tax Paid (Line status) In the Payment schedule, the total of all lines with the "Tax
Paid" Line status for the chosen report period.

&&INV_TAXPAID&& |805|

Withdrawals (Line status)(for period) In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Withdrawal"  Line  status.  The  amount  in  the  Payment
schedule  is  negative  but  the  amount  returned  here  will  be
positive (absolute value).

For the chosen report period.

&&INV-WITHDR&& |806|

Invoice (Line status)(for period) In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Invoice" Line status.  The amount in  the Payment schedule
is  negative  but  the  amount  returned  here  will  be  positive
(absolute value).

For the chosen report period.

&&INV-INVOICE&& |765|

Invoice Paid (Line status)(for period) In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Invoice Paid" Line status for the chosen report period.

&&INV_INVOICEPAI
D&&

|766|

Investment (Line status)(for period) In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Investment"  Line  status.  The  amount  in  the  Payment
schedule  is  negative  but  the  amount  returned  here  will  be
positive (absolute value).

For the chosen report period.

&&INV_INVESTMEN
T&&

|763|

Investment Withdrawal (Line status)
(for period)

In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Investment  Withdrawal"  Line  status  for  the  chosen  report
period.

&&INV_INVEST_WIT
HDR&&

|764|

Other X (Line status)(for period)

(Other 1 to 10)

In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Other X" Line status. 

For the chosen report period.

"Other" statuses should be used carefully and in a consistent
manner.  For  example,  "Other  1"  could  be  one  type  of
transaction not  included in  the multiple Line  status  choices
available.  Once  its  vocation  determined,  it  should  always
retain this special status (this should be written down in the
your  internal  user  guide)  so  that  all  users  follow  this
nomenclature. 

For accounting purposes, the "Other" statuses will affect the
"Balance all others" column in the Payment schedule.

These may be renamed as desired. To avoid any confusion, it
is highly recommended NOT to use these as payments or as
addition  principal  since  they  will  not,  from  an  accounting
perspective,  refund  Principal  and  Interest.  Instead  use  the
"Payment"  or  "Add.  Princ."  type  Line  statuses  while
renaming according to the type of transaction.

&&INV_OTHER1&&
&&INV_OTHER2&&
&&INV_OTHER3&&
&&INV_OTHER4&&
&&INV_OTHER5&&
&&INV_OTHER6&&
&&INV_OTHER7&&
&&INV_OTHER8&&
&&INV_OTHER9&&

&&INV_OTHER10&&

|767|
|769|
|770|
|771|
|772|
|773|
|774|
|775|
|776|
|768|

Other 3 (Principal)(Line status)(for
period)

See Principal

Other 3 (Principal)(Line status)(for
period)+ 1 day

Adjustment (Line status)(for period) In  the  Payment  schedule,  the  total  of  all  lines  with  the
"Adjustment" status. 

&&INV_ADJUST&& |748|
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An  adjustment  could  be  any  type  of  adjustment  required
(interest, principal or  other) to reach the right  balance at  a
point in time.

For the chosen report period.

From  an  accounting  perspective,  an  Adjustment  will  not
refund Principal  nor  Interest.  Instead use the "Payment" or
"Add. Princ." type Line statuses while renaming according to
the type of transaction.

Next Due Pmt - Amount (entire Loan) See Payments

Next Due Pmt - Amount (entire Loan)
(all same day)

See Payments

Next Due Pmt - Date (entire Loan) See Payments

Next Due Pmt - Balance (as if Paid)
(entire Loan)

See Payments

Next Due Pmt - Balance Due
Principal (as if Paid)

See Principal

APR- Next Due Pmt - Balance  Due
Fees Financed (as if paid) (entire
Loan)

See APR

Amount Due: Due Pmt + Outstanding
+ all Fees + Penalties (for period)

Depending on your working method, will give the total that
is due for the period entered but by taking into account only
some very specific Line statuses.

Includes  the  total  for  the  "Due  Pmt"  Line  statuses  and  all
"Fees"  (all  6)  and  "Penalties"  in  addition  to  the  balance
shown in the "Outstanding - Total (Balance)" column, at the
report  end  date  (including  interest  on  the  outstanding
amount).

Be careful, if  for example, a Fees 2 is charged but a  Fees 2
Paid line pays all of these fees, this calculation will not take
into account this payment, but only the Fees 2 amount.

You  are  encouraged  to  create  Mathematical  Equations  to
meet your specific needs.

&&INV_Tot_Due_A
mount&&

|702|

Next Due Minimum Payment -
Amount (entire Loan)

See Payments

Last Paid payment (all Paid Line
statuses)(entire Loan) - Amount

See Payments

Last Paid payment (all Paid Line
statuses)(entire Loan) - Balance

See Payments

Last Paid payment (all Paid Line
statuses)(entire Loan) - Date

See Payments

Last Paid payment (all Paid Line
statuses)(entire Loan) - Line status

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(entire
Loan) - Amount

See Payments
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Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(entire
Loan) - Balance

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(entire
Loan) - Date

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(entire
Loan) - Line status

See Payments

Last Paid payment (all Paid Line
statuses)(in period) - Amount

See Payments

Last Paid payment (all Paid Line
statuses)(in period) - Expected Pmt
Amount

See Payments

Last Paid payment (all Paid Line
statuses)(in period) - Balance

See Payments

Last Paid payment (all Paid Line
statuses)(in period) - Date

See Payments

Last Paid Payment (all Paid Line
statuses)(in period) - True Pmt Date
(Grace)

See Payments

Last Paid payment (all Paid Line
statuses)(in period) - Line status

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(in period)
- Amount

See Payments

Last Paid/Unpaid Payment (only Paid
and Unpaid Line statuses)(in period)
- Expected Pmt Amount

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(in period)
- Balance

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(in period)
- Date

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(in period)
- Computational Balance

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(in period)
- Line status

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(in period)
- Computational Balance

See Payments

Last Transaction (in period) -
Computational Balance

See Payments

Last Transaction (in period) - True
Balance

See Payments
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Interest Accrued from last payment
Paid (entire Loan/report End Date)
(0.00 if no payment)

See Interest

Interest Accrued from last payment
Paid (entire Loan/report End Date)

See Interest

Interest Accrued from last payment
Paid (for period/report End Date)
(0.00 if no payment)

See Interest

Interest Accrued from last payment
Paid (for period/report End Date)

See Interest

Interest Accrued from last payment
Paid/Unpaid (entire Loan/report End
Date)(0.00 if no payment)  (entire
Loan/report End Date)

See Interest

Interest Accrued from last payment
Paid/Unpaid (entire Loan/report End
Date)

See Interest

Interest Accrued from last payment
Paid/Unpaid (for period/report End
Date)(0.00 if no payment)

See Interest

Interest Accrued from last payment
Paid/Unpaid (for period/report End
Date)

See Interest

Interest Accrued from last payment
Paid/Unpaid (at Current Date) (0.00
if no payment)

See Interest

Interest Accrued from last payment
Paid/Unpaid (at Current Date) 

See Interest

Interest Accrued from last payment
Paid (at Current Date) (0.00 if no
payment)

See Interest

Interest Accrued from last payment
Paid(at Current Date)(0.00 if no
payment)

See Interest

Partial Payment (and partial late) -
Total unpaid portions (report end
Date)

In  the  Payment  schedule,  the  "Expected  Pmt"  column
amount minus the actual amount paid. Line status to obtain
data is "Partial Pmt" or "Partial Late Pmt".

For the end date entered in the report

&&INV-
PARTIALPAYBAL&&

|818|

Returned Checks - Total Unpaid
portion (for period)(report end Date)

In  the  Payment  schedule,  the  "Expected  Pmt"  column
amount minus the actual amount paid (amount paid should
be  0.00  since  the  check  is  returned).  Line  status  to  obtain
data is "Returned check".

For the end date entered in the report

&&INV-NSF
CHECK&&

|828|

Unpaid Pmt (Line status) - Total
unpaid portions(report end Date)

In  the  Payment  schedule,  the  "Expected  Pmt"  column
amount minus the actual amount paid (amount paid should
be 0.00). Line status to obtain data is "Unpaid Pmt".

For the end date entered in the report

&&INV-
UNPAIDPAY&&

|800|
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Unpaid Pmt (2) to (10) (Line status) -
Total Unpaid portions (report end
Date)

In  the  Payment  schedule,  the  "Expected  Pmt"  column
amount minus the actual amount paid (amount paid should
be  0.00).  Line  status  to  obtain  data  is  "Unpaid  Pmt  (X)"
(according to the new Line status name given). 

For the end date entered in the report

&&INV-
UNPAID2PAY&&

&&INV-
UNPAID3PAY&&

&&INV-
UNPAID4PAY&&

&&INV-
UNPAID5PAY&&

&&INV-
UNPAID6PAY&&

&&INV-
UNPAID7PAY&&

&&INV-
UNPAID8PAY&&

&&INV-
UNPAID9PAY&&

&&INV-
UNPAID10PAY&&

|792|
|793|
|794|
|795|
|796|
|797|
|798|
|799|
|791|

Total Unpaid portions (All Unpaid
Pmts, Partial, Returned checks)
(report end Date)

Field was created before the arrival of Outstanding amounts.
For  more  complete  data,  it  is  suggested  to  use  the
"Overdue" field.

In  the  Payment  schedule,  the  "Expected  Pmt"  column
amount minus the actual amount paid taking into account of
all  the  unpaid,  partial,  partial  late  and  returned  check
payments (including the unpaid custom fields) Line statuses.

Please  note that in  this  total,  MLM takes into account  only
the  Line  statuses  named  in  the  paragraph  above.  For
example,  a  payment  of  300  (Line  status  "Paid  Pmt  2")  is
associated to an "Expected Pmt" of 1000. The 700 difference
will not be included since the Line status is a "Paid Pmt" and
not one of the unpaid or partial payment Line statuses.

For the end date entered in the report

&&INV_UNPAIDPOR
TION-TOTAL&&

|704|

Number of occurrences of the select
Line status (for period)

See Tally

Number of occurrences of Due Pmt
(for period)

See Tally

Number of occurrences of Unpaid
Pmt (for period)

See Tally

Number of occurrences of Add.
Princ. (Loan) (for period)

See Tally

Number of occurrences of all Due
Pmt (for period) 

See Tally

Loan Data
Field name Description Merge Code Short

Merge
Code

MLM Record identification Unique  system  identification  number.  Once  a  Record  is
assigned a number, this number is never again assigned.

The MLM Record Identification starts at 100 by default,  but

&&RECORDID&& |531|
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can  be  modified  to  start  at  1000  or  10000  for  example  by
pressing the "Ctrl Alt Shift I" keys in Tools > Settings .

Record Unique Identifier 1 Identifier  allowing  to  create  a  link  between  the  loan  itself
and third-party software. This identifier must be unique, thus
can not be repeated.

&&RECORDUniqueID
1&&

|551|

Record Unique Identifier 2 Identifier  allowing  to  create  a  link  between  the  loan  itself
and third-party software. This identifier must be unique, thus
can not be repeated.

&&RECORDUniqueID
2&&

|552|

File Number File number assigned by the user. 

Can  include  any  type  of  characters  (numeral,  text,  special
characters, space, etc.).

&&CLT-FILE&& |136|

File Number (Numeric) File number assigned by the user.

Can only be a whole number (no punctuation or spaces).

&&CLT-
FILE_NUM&&

|137|

Accounting ID Unique  client  (Borrower)  identification  that  could  be
generated by your accounting system for this loan. 

Must be entered manually in MLM.

Useful  for  producing  reports  that  are  then  imported  into
your accounting package.  

See Export accounting transactions to the General Ledger.

&&CLT-
ACC_NUM&&

|101|

Record Type Often  the  type  of  loan  -  car,  mortgage,  personal,
commercial, etc. 

Also useful in identifying loans as an asset or liability for the
organization that uses MLM.

A scroll menu may be created for this field and may be used
as a Display filter in the Record Summary window.

&&CLT-TYPE&& |139|

Record Date Often the date the Record was opened. The user must insert
the date. The system does not add a date automatically.

&&CLT-DATE&& |138|

Record Status Includes  Draft,  Pending,  Active,  On  Hold,  Closed,  Archived
and Bad Debt. This is set by the user. 

&&RECSTATUS&& |550|

Active Records - Sub-Status (Current
date if AUTO

For Active Records only, sub-statuses for these Records only.
 Sub-statuses are used to view the age of the accounts or for
other reasons related to payment habits.

The  sub-statuses  are  automatically  calculated  when  left  at
"AUTO" in the "Data" window, "Data" tab or can be adjusted
manually.

In MLM's Main window (Record Summary window) and in all
reports,  the calculation is  solely  based on the current date,
regardless of the report date.

See the Ageing of Accounts chapter.

&&LoanActiveSubCa
t&&

|502|

Metro 2 - Active Records  Metro 2 code based on the Active Record's sub-status.

In MLM's Main window (Record Summary window) and in all
reports, if  the sub-status is calculated (set to "AUTO" in the
"Data" tab of the "Data" window) the sub-status calculation
and  the  corresponding  Metro  2  code  will  be  based  on  the
current date, regardless of the report date.

&&LoanActiveMetro
2&&

|501|
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Record submitted to Metro 2 Record selected to be in the Metro 2 report NA NA

Record Owner User responsible for the Record. "General" tab of the "Data"
window.

&&fi_User&& |549|

Maximum Credit Reports the maximum credit amount allowed for the loan.
This is entered by the user under Data > General. This is not
a calculated amount but an optional amount entered.

&&MaximumCredit
&&

|560|

Loan Origination Date See Dates

Loan First Payment Date (Original) See Dates

Loan Origination Date + 12 months See Dates

Loan End Date See Dates

Compounding Compounding  (capitalization)  period  -  annual,  monthly,
daily, etc. 

&&COMPPERIOD&& |506|

Period of payments (Original) Frequency  at  which  payments  are  made  based  on  the
frequency  entered  in  the  "Data"  window.  Caution,  this  will
not factor in the changes made in the Payment schedule.

&&PAYPERIOD&& |542|

Period of payments (Original)
(Including Days)

Frequency  at  which  payments  are  made  based  on  the
frequency  entered  in  the  "Data"  window.  Caution,  this  will
not factor in the changes made in the Payment schedule.

If  the  "Payment  Frequency"  is  by  "Days",  this  will  indicate
the number of days with the format "Every x days".

 For example:  Every 10 days

For these common payment frequencies, the following texts
will be generated:

 1 day: Daily
 7 days: Weekly
 14 days: Every two (2) weeks
 21: Every three (3) weeks
 28: Every four (4) weeks

&&PAYPERIOD2&& |563|

Payment Method Entered in the Record's "Data" &&MethPmt&& |593|

Days per payment period If  the  "Payment  Frequency"  is  by  "Days",  this  will  indicate
the number of  days.  For  example every 7,  14,  10 days,  etc.
This  will  not  factor  in  the  changes  made  in  the  Payment
schedule.

&&PAYDAYS&& |511|

Days (number) in Loan (up to last
line of Payment schedule)

Number of  days between the beginning and the end of  the
loan.

Regardless of  the  dates  entered for  the  report,  the  data  of
the entire loan will be returned as long as the loan is within
the entered period (start date or end date of the loan).

Regardless  of  the  choice  to  include  or  exclude  the
transactions and interest for the last day when producing the
report,  the  number  of  days  reported  will  include  the  start
date of the loan, but exclude the last day.

&&LoanNumberDays
&&

|510|

Days (number) in Loan (up to last
line of Payment schedule)(Payment
>0)

Number of  days between the beginning and the end of  the
loan  but  taking  into  account  only  the  last  line  whose
payment  is  greater  than  0.00.  If  the  last  line  includes  a
negative  payment,  this  line  will  be  ignored  and  the  line

&&Days_LoanStartT
oEnd&&

|509|
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above  with  a  positive  payment  will  be  considered  the  loan
end date.

Regardless of  the  dates  entered for  the  report,  the  data  of
the entire loan will be returned as long as the loan is within
the entered period (start date or end date of the loan).

Regardless  of  the  choice  to  include  or  exclude  the
transactions and interest for the last day when producing the
report,  the  number  of  days  reported  will  include  the  start
date of the loan, but exclude the last day.

Principal (Original) See Principal

Principal (Original) (for period) See Principal

Original Balance from Data window &&OriginalBalance&
&

|5500|

APR - Principal (Original)
+ Fees Financed

See APR

APR - Principal (Original)
+ Fees Financed (for period)

See APR

Amortization period (Original) Number of  payments entered in  the "Amortization"  field  in
the "Data" window (and not the number of payments in the
Payment schedule).

Period over which the loan is repaid.

If  the  number  of  payments  is  reduced  or  increased  in  the
Payment  schedule,  the  original  amortization  period  will
nevertheless be reported.

&&LOANTERM&& |503|

Amortization period (Original) less 1
payment

Number of  payments entered in  the "Amortization"  field  in
the "Data" window subtracting one (1) payment.

Useful  in  a  contract  or  letter  that  states  the  number  of
payments of  a  certain amount and a  last  (or  first)  payment
of another amount.

If  the  number  of  payments  is  reduced  or  increased  in  the
Payment  schedule,  the  original  amortization  period  will
nevertheless be reported.

&&TOTPmtMinus1&
&

|504|

Amortization period (Original) less 2
payments

Number of  payments entered in  the "Amortization"  field  in
the "Data" window subtracting two (2) payments.

Useful  in  a  contract  or  letter  that  states  the  number  of
payments  of  a  certain  amount  and  last  AND first  payments
of other amounts.

If  the  number  of  payments  is  reduced  or  increased  in  the
Payment  schedule,  the  original  amortization  period  will
nevertheless be reported.

&&TOTPmtMinus2&
&

|505|

Term (Original) Number  of  payments  entered  in  the  "Term"  field  in  the
"Data"  window  (and  not  the  number  of  payments  in  the
Payment schedule).

The "Term" is often equal to the Amortization period. 

For  a  25  year  mortgage,  the  term  could  be  5  years  for
example. 

&&PAYTERMS&& |553|
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If  the  number  of  payments  is  reduced  or  increased  in  the
Payment  schedule,  the  original  Term  will  nevertheless  be
reported.

Nominal Interest Rate See Interest

Effective Interest Rate See Interest

Nominal Interest Rate (Monthly
Rate)

See Interest

Nominal Interest Rate (Daily rate) See Interest

Effective Interest Rate (Monthly
rate)

See Interest

Nominal Interest Rate at report End
Date

See Interest

Nominal Interest Rate (at Current
Date)

See Interest

Payment Amount (Original)  See Payments

First positive transaction - Amount See Payments

First positive transaction - Date See Payments

First negative transaction - Date Very  first  date  of  the  Payment  schedule  with  a
negative transaction amount.

&&FirstNegativeTran
sDate&&

|5001|

First negative transaction - Amount Amount  of  the  first  negative  transaction  of  the
Payment schedule.

&&FirstNegativeTran
sAmount&& 

|5002|

First negative transaction - Balance Balance of the first  negative transaction amount
of the Payment schedule.

&&FirstNegativeTran
sBalance&& 

|5003|

First negative transaction - Line
status

Line  status  of  the  first  negative  transaction
amount of the Payment schedule.

&&FirstNegativeStat
usID&&

|5004|

Last positive transaction - Amount See Payments

Last positive transaction - Date See Payments

Last Paid payment (all Paid Line
statuses)(entire Loan) - Amount

See Line status

Last Paid payment (all Paid Line
statuses)(entire Loan) - Balance

See Payments

Last Paid payment (all Paid Line
statuses)(entire Loan) - Date

See Dates

Last Paid payment (all Paid Line
statuses)(entire Loan) - Line status

See Line status

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(entire
Loan) - Amount

See Line status

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(entire
Loan) - Balance

See Payments

Last Paid/Unpaid payment (only Paid
and Unpaid Line statuses)(entire
Loan) - Date

See Dates
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Line status of line of last Paid or
Unpaid (only Paid and  Unpaid Line
statuses)(entire loan) - Line status

See Line status

Currency - Symbol Will be the currency symbol ($, €, £, F, etc.) assigned for the
Record.  If  multiple  currencies  are  not  used,  then  the
Windows currency symbol will be displayed.

&&CURRENCY-
Symbol&&

|508|

Currency - Abbreviation Will  be the currency abbreviation (USD,  CAD,  EUR,  etc.)  for
the Record. If multiple currencies are not used, then the field
will be left blank.

An abbreviation for the Windows default currency should be
defined in Tools.

&&CURRENCY-
Abrev&&

|507|

Record Other Information Data contained in the "General" tab of the "Data" window. &&LoanOtherInfo&
&

|548|

Notes Data contained in the "General" tab of the "Data" window. &&RecordNotesTXT_
Partial&&

|540|

Borrower Loan Security (Description
and Amount) 

This usually contains the amount and description of  the loan
security. The two elements will appear in a single cell.

These  data  are  associated  with  the  loan  as  such,  and  not
directly to the Borrower.

&&CLT-SECURITIES&
&

|113|

Co-Borrower X - Loan Security
(Description and Amount)

(Co-Borrower 1 to 9)

"Security" field for the Co-Borrower.

These  data  are  associated  with  the  loan  as  such,  and  not
directly to the Co-Borrower.

&&CLT-SECURITIES_
CoBor1&&

&&CLT-SECURITIES_
CoBor2&&

&&CLT-SECURITIES_
CoBor3&& 

&&CLT-SECURITIES_
CoBor4&& 

&&CLT-SECURITIES_
CoBor5&& 

&&CLT-SECURITIES_
CoBor6&& 

&&CLT-SECURITIES_
CoBor7&&

&&CLT-SECURITIES_
CoBor8&&

&&CLT-SECURITIES_
CoBor9&& 

|127|
|133|
|165|
|188|
|189|
|190|
|191|
|192|
|193|

Calculation Method See Advanced

Day Count See Advanced

Year Base See Advanced

Short Period Method See Advanced

Grace period (Days) See Advanced

Number of Records See General NA NA

Total number of files attached to the
Record

Data tab > General > Attached Documents button. &&Loan_AttachedFil
es_Num&&

|575|

Size in (Kb) of all files attached to the
Record

Data tab > General > Attached Documents button. &&Loan_AttachedFil
es_size&&

|576|

Method Interest-only Returns the method used for calculating the Interest-only
payment for "Due Pmt" type lines that have the special
recalculation Behavior.

1 - Refund all outstanding interest
2 - Refund only interest for the period

&&IntOnlyMethod&
&

|5991|



Page 910

© Jurismedia Inc., 2007- 2023

Mostly used simply to make sure all loans follow
the same method.

Method Fixed Principal Returns the method used for calculating the
Fixed Principal payment for "Due Pmt" type lines
that have the special recalculation Behavior.

1- Refund principal and ALL outstanding interest
first
2- Refund principal and interest FOR THE PERIOD
only
3- Refund principal WITHOUT refunding
outstanding interest

Mostly used simply to make sure all loans follow
the same method.

&&FixedCapMethod
&&

|5992|

Use Interest table See Interest

Rate Table - Percentage to
Add (annual)

See Interest

Abbreviation Name of the
Interest Table

See Interest

Variable Interest rate Method See Interest

Rate Table -  Frequency of
changes starting on this date

See Interest

Rate Table -  Frequency of
changes every X months

See Interest

Outstanding

CAUTION: Good management of the "Expected payment" column is required. Otherwise, data generated could be
wrong.

Field name Description Merge Code Short
Merge
Code

Active Records - Sub-Status (Current
date if AUTO)

See Loan Data &&LoanActiveSubCa
t&&

|502|

Metro 2 - Active Records See Loan Data &&LoanActiveMetro
2&&

|501|

Outstanding - Payment (Balance)
report End Date

Cumulative  balance  of  the  amount  that  should  have  been
paid ("Payment" column) but that is outstanding. 

This column subtracts the amount entered in the "Payment"
column from the amount entered in the "Expec. Pmt" column
at the end date entered of the report.

The outstanding amount does not include amounts that may

&&OUTSTANDINGLA
STDAY&&

|419|
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be  due  with  the  addition  of  fees,  insurance,   penalties,  or
others.

Outstanding - Payment (Balance)
report Start Date (before
transactions on that day)

Cumulative balance amount required to be paid ("Payment"
column) but that is outstanding at 0:00 in the morning, thus
before any transaction on that day.

This column subtracts the amount in the "Payment" column
from the amount in the "Expec. Pmt" column.

Particular cases:

 Report  between two dates:  if  the report  Start  date <  =
Origination date: returns 0.00.

 "Full report" and "Report up to...": returns 0.00.

&&OUTSTANDINGFI
RSTDAY&&

|420|

Outstanding - Payment (Variation
for period)

Difference  between  the  outstanding  balance  (Payment)  at
the start  of  the  period  from  the  outstanding balance  at  the
end of the period.

However,  the  amount  is  inversed  in  order  for  a  balance
increase  to  be  represented  by  a  positive  amount  and  a
decrease to be represented by a negative amount.

&&OUTSTANDING-
PAID&&

|421|

Interest on Outstanding Balance (for
period)

See Interest

Interest Balance on Outstanding
Balance at report End Date

See Balances

Interest Balance on Outstanding
Balance at report Start Date (before
transactions on that day)

See Balances

Outstanding - Total (Balance) at
report End Date

Amount of the "Outstanding - Total (Balance)" column at the
report end date.

&&Outst_Total_End
Date&&

|422|

Outstanding  Total (Balance) (at
Current Date

Amount of the "Outstanding - Total (Balance)" column at the
current date.

&&Outst_Total_ToD
ate&&

|423|

Outstanding - Total (Balance) at
report Start Date (before
transactions on that day)

Amount of the "Outstanding - Total (Balance)" column at the
report  start  date,  at  0:00  in  the  morning,  thus  before  any
transaction on that day.

Particular cases:

 Report between two dates:  if  the report Start date < =
Origination date: returns 0.00.

 "Full report" and "Report up to...": returns 0.00.

&&Outst_Total_Start
Date&&

|424|

Outstanding - Total (Variation for
the period)

Difference between the total outstanding balance at the start
of  the period from the total  outstanding balance at  the end
of the period.

However,  the  amount  is  inversed  in  order  for  a  balance
increase  to  be  represented  by  a  positive  amount  and  a
decrease to be represented by a negative amount.

&&Outst_Total_Vari
ation&&

|425|

Outstanding – Interest and Column
Fees portion at Report End Date

Portion  of  the  outstanding  amount  (payment  only,  not  the
interest  on  the  outstanding  amount)  representing  the
Interest and the Column Fees.

Reports  the Due interest and the  Due Column Fees  (sum of

&&OUTSTANDINGLA
STDAY&&

|831|
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the  6  Column  Fees)  at  the  report  end  date  yet  without
exceeding the amount that is outstanding.

Outstanding – Principal portion at
Report End Date

Portion  of  the  outstanding  amount  (payment  only,  not  the
interest  on  the  outstanding  amount)  representing  the
Principal.

The calculation is performed as such: "Outstanding-Payment
(Balance)  at  report  End  Date"  minus  Balance  Due  Interest
minus Due Column Fees (sum of the 6 Column Fees), thereby
determining the Principal portion.

If multiple payments are missed and the interest and Column
Fees  not refunded, the result can often be 0.00.

&&Outst_PRINC_End
Date&&

|832|

Amount Due: Due Pmt +
Outstanding + all Fees + Penalties
(for period)

See Line status

Ageing Balance 0-29 days (Current) Outstanding payment balance at 0 to 29 days. One or many
payments have not been paid but are less than 30 days late.

The oldest  outstanding amounts are always  paid  before  the
more recent amounts.

See also the important Ageing of Accounts section and make
sure  to  understand  the  reference  date  for  the  ageing  of
accounts which is either the report end date or more often,
the  current  date.  In  the  Main  MLM  window,  the   ageing  is
always calculated based on the current date.

&&LateAmount_curr
ent&&

|401|

Ageing Balance 30-59 days Outstanding payment balance at 30 to 59 days.

See  the  explanation  for  the  Ageing  Balance  0-29  days
(Current) feld.

&&LateAmount_30-
59&&

|405|

Ageing Balance 60-89 days Outstanding payment balance at 60 to 89 days.

See  the  explanation  for  the  Ageing  Balance  0-29  days
(Current) feld.

&&LateAmount_60-
89&&

|406|

Ageing Balance 90-119 days Outstanding payment balance at 90 to 119 days  

See  the  explanation  for  the  Ageing  Balance  0-29  days
(Current) feld.

&&LateAmount_90-
119&&

|407|

Ageing Balance 120-149 days Outstanding payment balance at 120 to 149 days.

See  the  explanation  for  the  Ageing  Balance  0-29  days
(Current) feld.

&&LateAmount_120
-149&&

|402|

Ageing Balance 150-179 days Outstanding payment balance at 150 to 179 days.

See  the  explanation  for  the  Ageing  Balance  0-29  days
(Current) feld.

&&LateAmount_150
-179&&

|403|

Ageing Balance 180 days and more Outstanding payment balance at 180 and more.

See  the  explanation  for  the  Ageing  Balance  0-29  days
(Current) feld.

&&LateAmount_180
Plus&&

|404|

Ageing Balance Total 30 days and
more

Total balance of Outstanding payments at 30 days and more.

See  the  explanation  for  the  Ageing  Balance  0-29  days
(Current) feld.

&&LateAmount_Tot
_30Plus&&

|408|
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Number of days of delinquency Number  of  days  from  the  last  payment  that  pays  off
outstanding amounts either at the report end date or, in the
Main window (Record Summary), at the current date. 

The oldest  outstanding amounts are always  paid  before  the
more  recent  amounts  thus  moving  the  number  of  days
delinquency forward as payments are made.

&&ACC_NumDaysDe
linquency&&

|430| 

Amount due at Current Date (final
balance = 0.00)

Is  used  to  obtain  at  report  End  Date  (0:00  AM,  therefore
excluding the interest for the day), the amount that is  really
past  due  (including  fees,  interest,  principal  and  others)  and
required for the Borrower to be up to date in his payments. 

When the final balance of the Record is greater than 0.00, it
will calculate at the report End Date, the amount that would
be required for the final balance of the Record to be 0.00. 

If the report End Date already includes a payment, there will
be  no  impact  on  the  amount  due  calculated  so  the  normal
payment  that  was  to  be  paid  at  report  End  Date  should  be
added to the amount due that was calculated by this variable
in  order  to  provide  a  total  amount  due  at  the  report  End
Date.

Equals 0.00 if the final balance is already 0.00 or less (will not
give  a  negative  amount  if  the  Borrower  paid  more  than
expected).  It  is  therefore  important  to  ensure  that  the  last
payment  is  not  automatically  recomputed  in  the  payment
schedule to give a balance of 0.00 (lump sum payment on the
last line). 

Equals the amount of the last line of the payment schedule if
the  report  End  Date  is  after  the  last  line  of  the  payment
schedule. 

Should not be 0.00 if  there is  an outstanding amount in  the
Record.  If  this  is  the  case,  check  the  amounts  in  the
“Expected Pmt” column of the payment schedule.

PLEASE NOTE:  if a transaction, such as additional principal is
entered in the future, thus after the report End Date, and if
this transaction results in a final balance is greater than 0.00,
the  payment  required  on  the  report  End  Date  will  still  be
calculated,  even  if  at  the  report  End  Date,  no  amount  was
outstanding.

Subtlety  when  report  End  Date  =  last  date  of  the  payment
schedule  and  when  there  is  a  payment  on  this  date.  The
amount  due  calculated  will  factor  in  the  final  balance,
therefore  with  that  payment  included  (0:00  +  AM).  
Otherwise,  if  not  on  the  final  payment  line,  the  calculation
simulates the insertion of a line BEFORE transactions on this
date, therefore at 0:00 AM.

&&ACC_AmountDu_
Bal0_ToDate&&

|4301|

Amount due at Current Date (final
balance = original balance or new
balance entered)

Is  used  to  obtain  at  current  date  (0:00  AM,  therefore
excluding the interest for the day), the amount that is  really
past  due  (including  fees,  interest,  principal  and  others)  and
required for the Borrower to be up to date in his payments in
order to reach the final balance initially  entered or  the new
desired balance when the Balance = X box is checked (below
to the left in the payment schedule). 

ACC_AmountDu_Bal
X_ToDate

|4302|
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When  the  final  balance  of  the  Record  is  greater  than  the
original balance or the new balance entered, it will calculate
at  the current date,  the amount that  would be  required for
the final balance of the Record to be the original balance or
the new balance entered. 

If the current date already includes a payment, there will be
no  impact  on  the  amount  due  calculated  so  the  normal
payment that was to be paid at current date should be added
to  the  amount  due  that  was  calculated  by  this  variable  in
order to provide a total amount due at the current date.

Equals 0.00 if the final balance is already the original balance
or the new balance entered or  less  (will  not  give a  negative
amount  if  the  Borrower  paid  more  than  expected).  It  is
therefore  important  to  ensure  that  the  last  payment  is  not
automatically recomputed in the payment schedule to give a
balance = X (lump sum payment on the last line). 

Equals the amount of the last line of the payment schedule if
the  current  date  is  after  the  last  line  of  the  payment
schedule. 

Should not be 0.00 if  there is  an outstanding amount in  the
Record.  If  this  is  the  case,  check  the  amounts  in  the
“Expected Pmt” column of the payment schedule.

If the original balance or the new balance entered is negative
(ex.: -200.00) is smaller that the finale balance (ex.: 0.00) will
calculate  a  positive  payment  (200.00  in  this  example)  since
the  Borrower  will  need to  pay  this  amount  in  order  for  the
Creditor to “owe” 200.00 to the Borrower.

PLEASE NOTE:  if a transaction, such as additional principal is
entered in the future, thus after the current date, and if this
transaction  results  in  a  final  balance  is  greater  than  the
original  balance  or  the  new  balance  entered,  the  payment
required on the current date will still be calculated, even if at
the current date, no amount was outstanding.

Subtlety  when  current  date  =  last  date  of  the  payment
schedule  and  when  there  is  a  payment  on  this  date.  The
amount  due  calculated  will  factor  in  the  final  balance,
therefore  with  that  payment  included  (0:00  +  AM).  
Otherwise,  if  not  on  the  final  payment  line,  the  calculation
simulates the insertion of a line BEFORE transactions on this
date, therefore at 0:00 AM.

Amount due at report End Date
(final balance = 0.00)

Is  used  to  obtain  at  report  End  Date  (0:00  AM,  therefore
excluding the interest for the day), the amount that is  really
past  due  (including  fees,  interest,  principal  and  others)  and
required for the Borrower to be up to date in his payments. 

When the final balance of the Record is greater than 0.00, it
will calculate at the report End Date, the amount that would
be required for the final balance of the Record to be 0.00. 

If the report End Date already includes a payment, there will
be  no  impact  on  the  amount  due  calculated  so  the  normal
payment  that  was  to  be  paid  at  report  End  Date  should  be

INV_AmountDu_Bal0
_EndDate

|4303|
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added to the amount due that was calculated by this variable
in  order  to  provide  a  total  amount  due  at  the  report  End
Date.

Equals 0.00 if the final balance is already 0.00 or less (will not
give  a  negative  amount  if  the  Borrower  paid  more  than
expected).  It  is  therefore  important  to  ensure  that  the  last
payment  is  not  automatically  recomputed  in  the  payment
schedule to give a balance of 0.00 (lump sum payment on the
last line). 

Equals the amount of the last line of the payment schedule if
the  report  End  Date  is  after  the  last  line  of  the  payment
schedule. 

Should not be 0.00 if  there is  an outstanding amount in  the
Record.  If  this  is  the  case,  check  the  amounts  in  the
“Expected Pmt” column of the payment schedule.

PLEASE NOTE:  if a transaction, such as additional principal is
entered in the future, thus after the report End Date, and if
this transaction results in a final balance is greater than 0.00,
the  payment  required  on  the  report  End  Date  will  still  be
calculated,  even  if  at  the  report  End  Date,  no  amount  was
outstanding.

Subtlety  when  report  End  Date  =  last  date  of  the  payment
schedule  and  when  there  is  a  payment  on  this  date.  The
amount  due  calculated  will  factor  in  the  final  balance,
therefore  with  that  payment  included  (0:00  +  AM).  
Otherwise,  if  not  on  the  final  payment  line,  the  calculation
simulates the insertion of a line BEFORE transactions on this
date, therefore at 0:00 AM.

Amount due at report End Date
(final balance = original balance or
new balance entered)

Is  used  to  obtain  at  report  End  Date  (0:00  AM,  therefore
excluding the interest for the day), the amount that is  really
past  due  (including  fees,  interest,  principal  and  others)  and
required for the Borrower to be up to date in his payments in
order to reach the final balance initially  entered or  the new
desired balance when the Balance = X box is checked (below
to the left in the payment schedule). 

When  the  final  balance  of  the  Record  is  greater  than  the
original balance or the new balance entered, it will calculate
at  the report  End Date,  the amount that  would be required
for the final balance of the Record to be the original balance
or the new balance entered. 

If the report End Date already includes a payment, there will
be  no  impact  on  the  amount  due  calculated  so  the  normal
payment  that  was  to  be  paid  at  report  End  Date  should  be
added to the amount due that was calculated by this variable
in  order  to  provide  a  total  amount  due  at  the  report  End
Date.

Equals 0.00 if the final balance is already the original balance
or the new balance entered or  less  (will  not  give a  negative
amount  if  the  Borrower  paid  more  than  expected).  It  is
therefore  important  to  ensure  that  the  last  payment  is  not
automatically recomputed in the payment schedule to give a

INV_AmountDu_BalX
_EndDate

|4304|
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balance = X (lump sum payment on the last line). 

Equals the amount of the last line of the payment schedule if
the  report  End  Date  is  after  the  last  line  of  the  payment
schedule. 

Should not be 0.00 if  there is  an outstanding amount in  the
Record.  If  this  is  the  case,  check  the  amounts  in  the
“Expected Pmt” column of the payment schedule.

If the original balance or the new balance entered is negative
(ex.: -200.00) is smaller that the finale balance (ex.: 0.00) will
calculate  a  positive  payment  (200.00  in  this  example)  since
the  Borrower  will  need to  pay  this  amount  in  order  for  the
Creditor to “owe” 200.00 to the Borrower.

PLEASE NOTE:  if a transaction, such as additional principal is
entered in the future, thus after the report End Date, and if
this transaction results  in  a  final  balance is  greater than the
original  balance  or  the  new  balance  entered,  the  payment
required on the report End Date will still be calculated, even
if at the report End Date, no amount was outstanding.

Subtlety  when  report  End  Date  =  last  date  of  the  payment
schedule  and  when  there  is  a  payment  on  this  date.  The
amount  due  calculated  will  factor  in  the  final  balance,
therefore  with  that  payment  included  (0:00  +  AM).  
Otherwise,  if  not  on  the  final  payment  line,  the  calculation
simulates the insertion of a line BEFORE transactions on this
date, therefore at 0:00 AM.

Payments
Field name Description Merge Code Short

Merge
Code

Payment Amount (Original) Original payment amount either entered or computed in the
Data  window.  If  the  payment  amounts  are  changed  in  the
Payment schedule, these will not be reflected here.

Should be used only for regular loans.

&&PAYAMOUNT&& |541|

Amortization period (Original) See Loan Data

Amortization period less 1 payment See Loan Data

Amortization period less 2 payments See Loan Data

Term (Original) See Loan Data

Period of payment (Original) See Loan Data

Period of payment (Original)
(Including Days)

See Loan Data

Days per payment period See Loan Data

First positive transaction - Amount First payment amount of the Payment schedule greater than
0.00.

&&FIRSTPAYMENT&
&

|515|

First positive transaction - Date Very  first  date  of  the  Payment  schedule  with  a  payment &&FIRSTPAYDATE&
&

|516|
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amount greater than 0.00.

Last positive transaction - Amount Last payment amount of  the Payment schedule greater than
0.00.

&&LASTPAYMENT&
&

|526|

Last positive transaction - Date Very  last  date  of  the  Payment  schedule  with  a  payment
amount greater than 0.00.

&&LASTPAYMENTD
ATE&&

|527|

Total "Payment" column (entire
Loan)

Total payment amount for the entire length of the loan. This
column  adds  the  positive  and  negative  amounts  in  the
column, no matter what Line status is given.

&&LOANTOTALPAY
&&

|554|

Total "Expec. Pmt" column (all Paid
and Unpaid Payments (entire Loan)

Total amount in the "Expec. Pmt" column for the entire
lenght of the loan. Only "Paid" Line statuses (Paid Pmt 1 to
20, Partial mt, etc.) and all "Unpaid" Line status are included.

&&LOANTOTAL_EXP
CTEDPAY&&

|574|

Total Positive Payments (entire
Loan)

Total  of  all  positive payments,  no matter  what  Line status is
selected, for the entire length of the loan.

&&LOANTOTPAYPos
itive&&

|556|

Total Negative Payments (entire
Loan)

Total of all negative payments, no matter what Line status is
selected, for the entire length of the loan.

&&LOANTOTPAYNe
gative&&

|555|

Positive payments (for period) Total  of  all  positive  payments  in  the  Payment  schedule,  no
matter  what  Line  status  is  selected,  for  the  given  report
dates.

&&INV-PMTS-
POSITIVE&&

|820|

Negative Payments (for period) Total  of  all  negative  payments  in  the  Payment  schedule,  no
matter  what  Line  status  is  selected,  for  the  given  report
dates.

&&INV-PMTS-
NEGATIVE&&

|816|

Negative payments excluding Add.
Princ. (all such Line statuses)(for
period)

All  negative  payments  in  the  Payment  schedule  no  matter
what  Line  status  is  selected  EXCLUDING  all  Additional
Principal type lines. 

This may be used to include all fees, insurance, penalties, etc.,
while excluding any Additional Principal.

You  are  encouraged  to  create  Mathematical  Equations  to
meet your specific needs.

&&INV-PMTS-NEG-
NoAddPrinc&&

|817|

Minimum Payments (Total for the
period)

Total  of  all  amounts entered in  the  "Minimum Pmt"  column
of the Payment schedule for the report period.

May  be  useful  to  see  if  fees  should  be  charged  and  if  the
minimum  payment  amounts  have  not  been  paid  by  the
debtor.

&&INV-MINIMUM-
PAYTS&&

|815|

Due Pmt (Line status)(for period) See Line status

Due Pmt (2) (Line status) (for
period)
Due Pmt (3) (Line status) (for
period)
Due Pmt (4) (Line status) (for
period)
Due Pmt (5) (Line status) (for
period)

See Line status

Due Pmt (all and only Due Pmt type
Line statuses) (for period)

See Line status

Due Pmt (all and only Due Pmt type
Line statuses) (entire Loan)

See Line status

Payments Paid (All and only Paid
Pmt type Line statuses)(for period)

See Line status

Total "Expec. Pmt" column (all Total amount in the "Expec. Pmt" column for the given &&INV-TOTAL_EXPC |848|
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Paid and Unpaid Payments) (for
period)

report  dates.  Only  "Paid"  Line  statuses  (Paid  Pmt  1  to
20,  Partial  Pmt,  etc.)  and  all  "Unpaid"  Line  status  are
included.

TEDPAY&&

Paid Pmt (Line status)(for period) See Line status

Paid Late Pmt (Line status)(for
period)

See Line status

Partial Pmt (Line status)(for period) See Line status

Partial Late Pmt (Line status)(for
period)

See Line status

Add. Pmt (Line status)(for period) See Line status

Compensatory Pmt (Line status)(for
period)

See Line status

Paid Pmt Returned Check (Line
status)(for period)

See Line status

Paid Pmt X (Line status)(for period)

 (Paid Pmt (for period) 1 to 20)

See Line status

Interest Paid (Line status =  Interest
Paid)(for period)

Interest Paid (2) to (4) (Line status =
Interest Paid (2))(for period)

See Line status

Principal Paid (Line status =  Interest
Paid)(for period)

Principal Paid (2) to (4) (Line status =
 Interest Paid (X))(for period)

See Line status

Next Due Pmt - Amount (entire
Loan)

Amount  of  the  next  payment  with  the  "Due  Pmt"  type  Line
status no matter what dates are selected for the report.

&&NEXTDUEPAY&& |533|

Next Due Pmt - Amount (entire
loan) (all same day)

Amount  of  the  next  payment  with  the  "Due  Pmt"  type  Line
status no matter what dates are selected for the report.

If more than one "Due Pmt" type Line status is included at the
same payment date, the total  of  all  these due payments will
be included in the amount reported.

&&NEXTDUEPAY2&
&

|5330|

Next Due Pmt - Date (entire Loan) Date of the next payment with the "Due Pmt" type Line status
no matter what dates are selected for the report.

&&NEXTDUEPAY-
DATE&&

|536|

Next Due Pmt - Balance (as if Paid)
(entire Loan)

Real  balance  of  the  next  payment  with  the  "Due  Pmt"  type
Line status no matter what dates are selected for the report.

To find this amount, MLM identifies the next "Due Pmt" Line
status  regardless  of  the  date,  simulates  a  paid  payment  and
returns the balance after payment.

&&NEXTDUEPAY_BA
L&&

|534|

Next Due Pmt - Balance Due
Principal (as if Paid)(entire Loan)

See Principal

Next Due Minimum Payment -
Amount (entire Loan)

Amount  of  the  next  minimum  payment  indicated  in  the
"Minimum  Pmt"  column  of  the  Payment  schedule
corresponding  to  the  next  payment  with  "Due  Pmt"  Line
status no matter the report dates.

May  be  useful  for  Invoices  and  Statements  to  inform  the
client as to the next minimum payment amount.

&&NEXT-
MINIMPAY&&

|532|
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Use "Next Due Pmt Date" as the corresponding date for  this
data.

Last Paid payment (all Paid Line
statuses)(entire Loan) - Amount

Amount  of  the  last  paid  payment  in  the  Payment  schedule
taking into account any of the "Payment" type Lines statuses,
regardless of the dates chosen for the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date, only the amount of  the LAST "Paid" line type
will be returned.

&&LoanLAST-PmtA
mount&&

|518|

Last Paid payment (all Paid Line
statuses)(entire Loan) - Balance

Balance  of  the  last  paid  payment  in  the  Payment  schedule
taking into account any of the "Payment" type Lines statuses,
regardless of the dates chosen for the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date,  only  the balance of  the LAST "Paid" line type
will be returned. 

&&LoanLAST-PmtBal
ance&&

|519|

Last Paid payment (all Paid Line
statuses)(entire Loan) - Date

Date of the last paid payment in the Payment schedule taking
into  account  any  of  the  "Payment"  type  Lines  statuses,
regardless of the dates chosen for the report.

The "Paid" amount does not necessarily have be greater than
0.00, so be careful.

&&LoanLAST-PmtDa
te&&

|520|

Last Paid payment (all Paid Line
statuses)(entire Loan) - Line status

Line status of the last paid payment in the Payment schedule
taking into account any of the "Payment" type Lines statuses,
regardless of the dates chosen for the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment  date,  only  the  Line  status  of  the  LAST  "Paid"  line
type will be returned. 

&&LastPAIDPmt_Sta
tus&&

|521|

Last Paid Payment (all Paid Line
statuses)(entire Loan)(>5 days of
current date) - Amount

Date of the last paid payment in the Results table taking into
account any of the "Payment" type Lines statuses, regardless
of the dates chosen for the report but only if this payment is
more than five (5) days before the Current date.

The "Paid" amount does not necessarily have be greater than
0.00, so be careful.

For  example,  today is  July  8.  The last  Paid payment is  July  5
and the previous Paid payment is  July 1.  The July 5 payment
will  be  ignored  since  too  young  (and  may  “bounce”(non
sufficient  funds)).  The  July  1  payment  amount  will  be
reported  since  it  almost  certainly  it  is  paid  and  will  not  “
bounce” when electronic payments are used.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date, only the amount of  the LAST "Paid" line type
will be returned.

&&Loan5Days-PmtA
mount&&

|518.1|

Last Paid Payment (all Paid Line
statuses)(entire Loan)(>5 days of
current date) - Balance

Balance  of  the  last  paid  payment  in  the  Results  table  taking
into  account  any  of  the  "Payment"  type  Lines  statuses,
regardless of  the dates chosen for the report but only if  this
payment is more than five (5) days before the Current date.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date, only the amount of  the LAST "Paid" line type
will be returned. 

For  example,  today is  July  8.  The last  Paid payment is  July  5
and the previous Paid payment is  July 1.  The July 5 payment

&&Loan5Days-PmtB
alance&&

|519.1|
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will  be  ignored  since  too  young  (and  may  “bounce”(non
sufficient  funds)).  The  July  1  payment  balance  will  be
reported  since  it  almost  certainly  it  is  paid  and  will  not  “
bounce” when electronic payments are used.

Last Paid Payment (all Paid Line
statuses)(entire Loan)(>5 days of
current date) - Date

Date of the last paid payment in the Results table taking into
account any of the "Payment" type Lines statuses, regardless
of the dates chosen for the report but only if this payment is
more than five (5) days before the Current date.

The "Paid" amount does not necessarily have be greater than
0.00, so be careful.

For  example,  today is  July  8.  The last  Paid payment is  July  5
and the previous Paid payment is  July 1.  The July 5 payment
will  be  ignored  since  too  young  (and  may  “bounce”(non
sufficient  funds)).  The  July  1  payment  date  will  be  reported
since it almost certainly it is paid and will not “bounce” when
electronic payments are used.

&&Loan5Days-PmtD
ate&&

|520.1|

Last Paid Payment (all Paid Line
statuses)(entire Loan)(>5 days of
current date) - Line status

Line status of the last paid payment in the Results table taking
into  account  any  of  the  "Payment"  type  Lines  statuses,
regardless of  the dates chosen for the report but only if  this
payment is more than five (5) days before the Current date.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date, only the amount of  the LAST "Paid" line type
will be returned. 

For  example,  today is  July  8.  The last  Paid payment is  July  5
and the previous Paid payment is  July 1.  The July 5 payment
will  be  ignored  since  too  young  (and  may  “bounce”(non
sufficient  funds)).  The  July  1  payment  Line  status  will  be
reported  since  it  almost  certainly  it  is  paid  and  will  not  “
bounce” when electronic payments are used.

&&Loan5Days-PmtSt
atus&&

|521.1|

Last Paid/Unpaid payment (only
Paid and Unpaid Line statuses)
(entire Loan) - Amount

Amount  of  the  last  paid  payment  in  the  Payment  schedule
taking into account any of the "Payment" type Lines statuses
AND any of the "Unpaid" Line statuses regardless of the dates
chosen for the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date, only the amount of  the LAST "Paid" line type
will be returned. 

&&LoanLast_PaidUn
paid_Amount&&

|522|

Last Paid/Unpaid payment (only
Paid and Unpaid Line statuses)
(entire Loan) - Balance

Balance  of  the  last  paid  payment  in  the  Payment  schedule
taking into account any of the "Payment" type Lines statuses
AND any of the "Unpaid" Line statuses regardless of the dates
chosen for the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date,  only  the balance of  the LAST "Paid" line type
will be returned. 

&&LoanLast_PaidUn
paid_Balance&

|523|

Last Paid/Unpaid payment (only
Paid and Unpaid Line statuses)
(entire Loan) - Date

Date of the last paid payment in the Payment schedule taking
into  account  any  of  the  "Payment"  type  Lines  statuses  AND
any  of  the  "Unpaid"  Line  statuses  regardless  of  the  dates
chosen for the report.

The "Paid" amount does not necessarily have be greater than
0.00, so be careful.

&&LoanLast_PaidUn
paid_Date&&

|524|

Last Paid/Unpaid payment (only
Paid and Unpaid Line statuses)
(entire Loan) - Line status

Line status of the last paid payment in the Payment schedule
taking into account any of the "Payment" type Lines statuses
AND any of the "Unpaid" Line statuses regardless of the dates

&&LoanLast_PaidUn
paid_Status&&

|525|
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chosen for the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment  date,  only  the  Line  status  of  the  LAST  "Paid"  line
type will be returned. 

Last Unpaid Payment (all Unpaid
Line statuses) (entire loan) - Amount

Amount of the last unpaid payment in the Results table taking
into account any of the "Unpaid" type Lines statuses,
regardless of the dates chosen for the report.

If more than one "Unpaid" line type appears on the same
payment date, only the amount of the LAST "Unpaid" line
type will be returned.

Last Unpaid Payment (all Unpaid
Line statuses) (entire loan) - Date

Date of the last unpaid payment in the Results table taking
into account any of the "Unpaid" type Lines statuses,
regardless of the dates chosen for the report.

Last Paid payment (all Paid Line
statuses)(in period) - Amount

Amount  of  the  last  paid  payment  in  the  Payment  schedule
taking into account any of the "Payment" type Lines statuses,
but only on or before the end date entered in the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date, only the amount of  the LAST "Paid" line type
will be returned. 

&&INV_LAST-PmtA
mount_IP&&

|810|

Last Paid payment (all Paid Line
statuses)(in period) - Expected
Payment Amount

Expected  payment  Amount  of  the  last  paid  payment  in  the
Payment schedule taking into account  any of  the "Payment"
type  Lines  statuses,  but  only  on  or  before  the  end  date
entered in the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date, only the expected amount of  the LAST "Paid"
line type will be returned. 

&&INV_LAST-ExpPm
tAmount_IP&&

|810.1|

Last Paid payment (all Paid Line
statuses)(in period) - Balance

Balance of the last paid payment in the Payment schedule
taking into account any of the "Payment" type Lines statuses,
but only on or before the end date entered in the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date,  only  the balance of  the LAST "Paid" line type
will be returned. 

&&INV_LAST-PmtBal
ance_IP&&

|807|

Last Paid payment (all Paid Line
statuses)(in period) - Date

Date of the last paid payment in the Payment schedule taking
into  account  any  of  the  "Payment"  type  Lines  statuses,  but
only on or before the end date entered in the report.

The "Paid" amount does not necessarily have be greater than
0.00, so be careful.

&&INV_LastPmtStat
usDate_IP&&

|808|

Last Paid payment (all Paid Line
statuses)(in period) - True Pmt Date
(Grace)

True Payment Date of the last paid payment in the Payment
schedule taking into account any of the "Payment" type Lines
statuses,  but  only  on  or  before  the  end  date  entered  in  the
report.

The "Paid" amount does not necessarily have be greater than
0.00, so be careful.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment  date,  only  the  grace  date  of  the  LAST  "Paid"  line
type will be returned. 

&&INV_LastPmtTrue
PmtDate_IP&&

|808.1|

Last Paid payment (all Paid Line
statuses)(in period) - Line status

Line status of the last paid payment in the Payment schedule
taking into account any of the "Payment" type Lines statuses,
but only on or before the end date entered in the report.

&&INV_LastPmtStat
us_IP&&

|809|
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If  more  than  one  "Paid"  line  type  appears  on  the  same
payment  date,  only  the  Line  status  of  the  LAST  "Paid"  line
type will be returned. 

Last Paid/Unpaid payment (only
Paid and Unpaid Line statuses)(in
period) - Amount

Amount  of  the  last  paid  payment  in  the  Payment  schedule
taking into account any of the "Payment" type Lines statuses
AND any of the "Unpaid" Line statuses, but only on or before
the end date entered in the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date, only the amount of  the LAST "Paid" line type
will be returned. 

&&INV_LAST_PaidU
npaidAmt_IP&&

|814|

Last Paid/Unpaid payment (only
Paid and Unpaid Line statuses)(in
period) - Expected Pmt Amount

Expected  Payment  Amount  of  the  last  paid  payment  in  the
Payment schedule taking into account  any of  the "Payment"
type  Lines  statuses  AND  any  of  the  "Unpaid"  Line  statuses,
but only on or before the end date entered in the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date, only the expected amount of  the LAST "Paid"
line type will be returned. 

&&INV_LAST_PaidU
npaidExpPmt_IP

|814.1|

Last Paid/Unpaid payment (only
Paid and Unpaid Line statuses)(in
period) - Balance

Balance  of  the  last  paid  payment  in  the  Payment  schedule
taking into account any of the "Payment" type Lines statuses
AND any of the "Unpaid" Line statuses, but only on or before
the end date entered in the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date,  only  the balance of  the LAST "Paid" line type
will be returned. 

&&INV_LAST_PaidU
npaid_Bal_IP&&

|811|

Last Paid/Unpaid payment (only
Paid and Unpaid Line statuses)(in
period) - Computational Balance

Computational  Balance  of  the  last  paid  payment  in  the
Payment schedule taking into account  any of  the "Payment"
type  Lines  statuses  AND  any  of  the  "Unpaid"  Line  statuses,
but only on or before the end date entered in the report. 

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment date,  only  the balance of  the LAST "Paid" line type
will be returned.

&&INV_LastPaidUnp
dBalIP_comp&&

|851|

Last Transaction (in period) -
Computational Balance

Computational  Balance  of  the  last  Transaction  in  the  period
taking  into  account  any  type  of  Lines  Status,  but  only  on  or
before the end date entered in the report. If no transaction is
found in the Period, return 0.00.

&&INV_LastTransBal
_IP_comp&&

|852|

Last Transaction (in period) - True
Balance

True Balance of the last Transaction in the period taking into
account  any  type  of  Lines  Status,  but  only  on  or  before  the
end date entered in  the report.  If  no  transaction is  found in
the Period, return 0.00.

&&INV_LastTransBal
_IP_True&&

|853|

Last Paid/Unpaid payment (only
Paid and Unpaid Line statuses)(in
period) - Date

Date of the last paid payment in the Payment schedule taking
into  account  any  of  the  "Payment"  type  Lines  statuses  AND
any of  the "Unpaid" Line statuses, but only on or before the
end date entered in the report.

The "Paid" amount does not necessarily have be greater than
0.00, so be careful.

&&LoanLast_PaidUn
paid_Date&&

|812|

Last Paid/Unpaid payment (only
Paid and Unpaid Line statuses)(in
period) - True Pmt Date (Grace)

True Payment Date of the last paid payment in the Payment
schedule taking into account any of the "Payment" type Lines
statuses AND any of  the "Unpaid" Line statuses,  but  only  on
or before the end date entered in the report.

The "Paid" amount does not necessarily have be greater than

&&INV_LastPaidUnp
aidTrueDate_I

|812.1|
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0.00, so be careful.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment  date,  only  the  True  Pmt  date  grace  of  the  LAST
"Paid" line type will be returned.

Last Paid/Unpaid payment (only
Paid and Unpaid Line statuses)(in
period) - Line status

Line status of the last paid payment in the Payment schedule
taking into account any of the "Payment" type Lines statuses
AND any of the "Unpaid" Line statuses, but only on or before
the end date entered in the report.

If  more  than  one  "Paid"  line  type  appears  on  the  same
payment  date,  only  the  Line  status  of  the  LAST  "Paid"  line
type will be returned. 

&&INV_LastPaidUnp
dStatus_IP&&

|813|

Partial Pmt Balance (Unpaid
portion) (report End date)

See Line status

Returned Checks Balance (Unpaid
portion) (report End date)

See Line status

Unpaid Pmt (Line status)Total
Unpaid portion (report End Date)

Unpaid Pmt (2 to 10)(Line status)
Total Unpaid portion (report End
Date)

See Line status

Balance Total Unpaid portions (All
Unpaid Pmts, Partial, Returned
checks)(report End Date)

See Line status

Interest Accrued from last payment
Paid (entire Loan/report End Date)
(0.00 if no payment)

See Interest

Interest Accrued from last payment
Paid (entire Loan/report End Date)

See Interest

Interest Accrued from last payment
Paid (for period/report End Date)
(0.00 if no payment)

See Interest

Interest Accrued from last payment
Paid (for period/report End Date)

See Interest

Interest Accrued from last payment
Paid/Unpaid (0.00 if no payment)
(entire Loan/report End Date)

See Interest

Interest Accrued from last payment
Paid/Unpaid (entire Loan/report
End Date)

See Interest

Interest Accrued from last payment
Paid/Unpaid (for period/report End
Date)(0.00 if no payment)

See Interest

Interest Accrued from last payment
Paid/Unpaid (for period/report End
Date)

See Interest

Interest Accrued from last payment
Paid/Unpaid (at Current Date) (0.00
if no payment)

See Interest

Interest Accrued from last payment
Paid/Unpaid (at Current Date) 

See Interest
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Interest Accrued from last payment
Paid (at Current Date) (0.00 if no
payment)

See Interest

Interest Accrued from last payment
Paid (at Current Date) 

See Interest

Outstanding - Payment (Balance)
report Start Date

See Outstanding

Outstanding - Payment (Balance)
report End Date

See Outstanding

Outstanding - Payment (Variation
for period)

See Outstanding

APR Payment Amount See APR

APR - Next Due Pmt - Balance Due
Fees Financed (as if Paid)(entire
Loan)

See APR

Principal

See also the very important "Accounting Data" section

Field name Description Merge Code  Short
Merge
Code

Principal (Original) Principal amount entered in the "Data" window.

Any additional principal is excluded.

&&PRINCIPAL&& |543|

Principal (Original) (for period) Principal amount entered in the "Data" window only if
the  Origination  date  is  within  the  start  and  end  dates
entered  for  the  report.  If  not  within  these  dates,
nothing will be reported.

Any additional principal is excluded.

&&PRINCIPALPERIOD&& |564|

Principal (Original) - TEXT Principal  amount  entered  in  the  "Data"  window.  Any
additional  principal  is  excluded.  The  amount  will  be
displayed in letters (words)

&&PRINCIPAL_TXT&& |598|

Principal (original) + Add. Princ. (all
such Line statuses)(complete report)

This adds up the original Principal amount and all "Add.
Princ."  lines  for  the  entire  loan  no  matter  what  dates
are  chosen  in  the  report.  Includes  "Add.  Princ.  (2)  to
(10) " Line statuses.

The  "Add.  Princ."  amount  in  the  Payment  schedule  is
negative  but  the  amount  returned  will  be  positive
(absolute  value)  when  added  to  the  original  principal
entered in the "Data" window.

&&CAPinit&AddPrinc&& |544|

Principal (Original) + Add. Princ. (all
such Line statuses) up to report End
Date

Total of the principal amount(s) that bear(s) interest for
the period chosen.

This adds, within the report period, all the "Add. Princ."
lines, that bear interest as well as the Original Principal
ONLY IF the Origination date is included within the

&&INV-PRINC
+ADDPRINC&&

|821|
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chosen report period. Includes "Add. Princ. (2) to (10)"
Line statuses. 

Add. Princ. (Loan)(Line status)(for
period)

See Line status

Add. Princ. (Line status)(for period)

 Add. Princ. (Line status)(for
period) 2 to 10

See Line status

Add. Princ. (Loan)(Line status)(Interest
bearing portion)(for period)

See Line status

Add. Princ. (interest bearing portion)
(Line status)(for period)

 Add. Princ. (interest bearing
portion)(Line status)(for period), 2
to 10

See Line status

Additional Principal (Line status) (no
interest portion)(for period)

See Line status

Add. Princ. (no interest portion)(Line
status)

 Add. Princ. (no interest portion)
(for period) 2 to 10

See Line status

Principal Total (for period) Total  of  the  principal  amount(s)  that  bear  interest  or
not for the period chosen.

This adds up all "Add. Princ." lines, within the specified
report dates as well as the original Principal ONLY if the
Origination  date  is  within  the  report  period.   Includes
"Add. Princ. (2) to (10) " Line statuses.

&&INV_TotalPrinc&& |826|

Principal Total (Interest bearing
portion)(entire Loan)

Total of the principal amount(s) that bear(s) interest.

Amount  including  the  Original  Principal  (which  always
bears interest)  and  all  the  "Add.  Princ."  lines  that  also
bear  interest.  Includes  "Add.  Princ.  (2)  to  (10)  "  Line
statuses.

The total amount for the entire loan will be computed,
no matter what dates are chosen in the report.

&&LoanAddPrinc_Int&& |545|

Principal Total (no Interest portion)
(entire Loan)

Total  of  the  principal  amount(s)  that  do(es)  not  bear
interest. 

Total of all "Add. Princ." lines specifically identified not
to bear interest. Includes "Add. Princ. (2) to (10) " Line
statuses.

The  original  principal  is  automatically  excluded  as  it
always bears interest.

The total amount for the entire loan will be computed,
no matter what dates are chosen in the report.

&&LoanAddPrinc_NoInt&
&

|546|

Additional Principal (Line status)
(interest bearing portion)(entire Loan)

See Line status
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Add. Princ.  (Line status) (interest
bearing portion)(entire Loan)

 Add. Princ. (interest bearing
portion)(entire Loan) 2 to 10

See Line status

Additional Principal (Line status) (no
interest portion)(entire Loan)

See Line status

Add. Princ.  (Line status) (no interest
portion)(entire Loan)

 Add. Princ. (no interest portion)
(entire Loan) 2 to 10

See Line status

Principal Total (Interest bearing
portion)(for period)

Total of the principal amount(s) that bear(s) interest for
the period chosen.

This adds, within the report period, all the "Add. Princ."
lines, that bear interest as well as the  Original Principal
ONLY  if  the  Origination  date  is  included  in  the  report
period. Includes "Add. Princ. (2) to (10) " Line statuses.

&&INV_TotalPrinc_Int&& |825|

Principal Total (no Interest portion)(for
period)

Total  of  the  principal  amount(s)  that  do(es)  not  bear
interest for the period chosen.

This  adds,  within  the  chosen  period,  all  the  "Add.
Princ."  lines,  that  do  not  bear  interest.  Includes  "Add.
Princ. (2) to (10) " Line statuses.

&&INV_TotalPrinc_NoInt
&&

|827|

Principal Accrued (after transactions on
the report Start Date)(for period)

The Accrued principal  (or  to  be accrued in  the future)
or "Mathematical" principal, is calculated by taking into
account the balanceafter a transaction (if there be)(ie,
0:00+) at the start date of report and subtracting from
this  balance,  the  balance  on  the  date  entered  for  the
end of  the report (according to  one the three options
for  including  or  excluding  payments  and  interest  for
the last day).

If  the  report  start  date  entered  precedes  the  loan's
origination  date,  the  balance  at  the  report  start  date
will  not  be  considered  0.00  but  by  exception,  the
original  principal  plus"Additional  Principal"  Line
statuses atthis date. Otherwise, the results will  not be
consistent with what is expected.

Note:  The  original  principal  is  considered  entered  at
0:00,  not  at  0:00+  as  would  be  any  other  line  in  the
Payment  schedule  (payment,  etc.)  except  "Additional
Principal"  Line  statuses  that  are  also  considered
entered at 0:00 only if entered at the Origination date.

The principal is the mathematical principal as opposed
to accounting principal.

See also the variable: "Principal Accrued (before report
Start Date transactions)(for period)."

&&INV-PRINC-AFTER-
PMT&&

|822|

Principal Accrued (before transactions
on the report Start Date)(for period)

The Accrued principal  (or  to  be accrued in  the future)
or "Mathematical" principal, is calculated by taking into
account the balance before any transaction (ie, 0:00) at
the  start  date  of  report,  and  subtracting  from  this
balance, the balance on the date entered for the end of
the  report  (according  to  one  the  three  options  for

&&INV-PRINCIPAL&& |823|
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including  or  excluding  payments  and  interest  for  the
last day). 

If the report start date entered precedes or equals the
loan's origination date, the balance at the report start
date will not be considered 0.00 but by exception, the
original  principal  plus"Additional  Principal"  Line
statuses atthis date. Otherwise, the results will  not be
consistent with what is expected.

Note:  The  original  principal  is  considered  entered  at
0:00,  not  at  0:00+  as  would  be  any  other  line  in  the
Payment  schedule  (payment,  etc.)  except  "Additional
Principal"  Line  statuses  that  are  also  considered
entered at 0:00 only if entered at the Origination date.

The principal is the mathematical principal as opposed
to accounting principal.

This  is  the  recommended  field  to  take  if  you  wish  to
include data for  a  full  reporting period (thus from the
very start of the reporting period at 0:00 until the very
end at 24:00).

See  also  the  variable:  "Principal  Accrued  (after  report
Start Date transactions)(for period)".

Paid Principal (Line status) (for period) See Line status

Principal Paid (for period) Principal  actually  paid  as  opposed  to  accrued  or
Mathematical principal.

The Line status must be one of the following, otherwise
the principal will NOT be considered PAID: "Paid Pmt",
"Paid Pmt (2)  to  (20)",  "Paid  Late  Pmt",  "Partial  Pmt",
"Partial  Late  Pmt",  "Paid  Pmt  Returned  Check",  "Add.
Pmt"  or  "Compensatory  Pmt".   All  other  Line  statuses
will have no effect on the principal paid.

Excludes, case being, the Fees financed (APR) portion.

&&ACC_PAID_PRINC&& |426|

Principal Paid (for period), Paid Pmt X

(Paid Pmt, Paid Pmt 2 to 10) 

In  the Payment schedule,  the total  Principal  Paid
of  all  lines  with  the  "Paid  Pmt"  -or  "Paid  Pmt (2)
to  (10)"-  Line  status  exclusively,  for  the  chosen
report period.

&&ACC_PaidPrinc_PaidP
mt1&&

&&ACC_PaidPrinc_PaidP
mt2&&

&&ACC_PaidPrinc_PaidP
mt3&&

&&ACC_PaidPrinc_PaidP
mt4&&

&&ACC_PaidPrinc_PaidP
mt5&&

&&ACC_PaidPrinc_PaidP
mt6&&

&&ACC_PaidPrinc_PaidP
mt7&&

&&ACC_PaidPrinc_PaidP
mt8&&

&&ACC_PaidPrinc_PaidP
mt9&&

&&ACC_PaidPrinc_PaidP
mt10&&

|438|

|439|
|440|
|441|
|442|
|443|
|444|
|445|
|446|
|447|
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Principal Paid (for period), Paid Pmt
Returned check

In the Payment schedule,  the total  Principal  Paid
of  all  lines  with  the  "Paid  Pmt  Returned  check"
Line  status  exclusively,  for  the  chosen  report
period.

&&ACC_PaidPrinc_PmtCh
eck&&

|448|

Principal Paid (for period), Add. Pmt In the Payment schedule,  the total  Principal  Paid
of  all  lines  with  the  "Add.  Pmt"  Line  status
exclusively, for the chosen report period.

&&ACC_PaidPrinc_PmtAd
d&&

|449|

Principal Paid (for period),
Compensatory Pmt

In the Payment schedule,  the total  Principal  Paid
of  all  lines  with  the  "Compensatory  Pmt"  Line
status exclusively, for the chosen report period.

&&ACC_PaidPrinc_Comp
Pmt&&

|4490|

Principal Paid (for period) - Partial and
late Payments only

In the Payment schedule,  the total  Principal  Paid
of all lines with the "Partial Pmt", "Late Pmt" and
"Partial  Late  Pmt"  Line  statuses  exclusively,  for
the chosen report period.

&&ACC_PaidPrinc_PmtLa
tePartial

|613|

Principal Paid (for period)(using Grace/
EFT Date)

Principal  actually  paid  as  opposed  to  accrued  or
Mathematical principal at the date entered in the “True
Pmt  Date  (Grace/EFT)”  column.  The  reports  use  this
date  as  the  transaction  date  as  opposed  to  the  date
entered in the “Pmt Date” column. The “True Pmt Date
(Grace/EFT)” may be before or after the “Pmt Date”. 

The Line status must be one of the following, otherwise
the principal will NOT be considered PAID: "Paid Pmt",
"Paid Pmt (2)  to  (20)",  "Paid  Late  Pmt",  "Partial  Pmt",
"Partial  Late  Pmt",  "Paid  Pmt  Returned  Check",  "Add.
Pmt"  or  "Compensatory  Pmt".   All  other  Line  statuses
will have no effect on the principal paid.

Excludes, case being, the Fees financed (APR) portion.

This field and the “True Pmt Date (Grace/EFT)” should
only  be used to  reflect  payments made slightly  before
or  after  the  desired  “Pmt  Date”  if  these  irregularities
are to have no effect on the interest computed.

&&ACC_PAID_PRINC_Gra
ceDate&&

|437|

APR - Fees Financed Paid (for period)

APR- Paid Fees Financed 1
(Administrative) (for period)
Paid Fees Financed 2 (Insurance) (for
period)
Paid Fees Financed 3 ( Service) (for
period)
Paid Fees Financed 4 (Origination) (for
period)
Paid Fees Financed 5 (points) (for
period)

See APR

Next Due Pmt - Balance Due Principal
(as if Paid)(entire Loan)

Balance on the date of  the  next  payment  with  a  "Due
Pmt" Line status regardless of the report dates.

To find this amount, MLM identifies the next line whose
Line  status  is  "Due  Pmt"  regardless  of  the  date,
simulates a paid payment and reports the due principal
balance.

&&NEXDUPAY_BalduePri
nAsPaid&&

|535|
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Excludes, case being, the Fees financed (APR) portion.

APR- Next Due Pmt - Balance Due Fees
Financed (as if Paid) (entire Loan)

See APR

Principal to be paid at the next Due Pmt
(as if Paid) (entire loan)

Amount  of  the  principal  that  WILL  actually  be  paid  if
the next "Due Pmt" is paid in full.

To find this amount, MLM identifies the next line whose
Line  status  is  "Due  Pmt"  regardless  of  the  date,
simulates  paid  payment  and  reports  the  amount  of
principal that would be paid.

Excludes, case being, the Fees financed (APR) portion.

&&NextDuePay_PrincPaid
AsPaid&&

|559|

APR - Fees Financed to be paid at the
next Due Pmt (as if Paid (entire loan)

See APR

Balance Due Principal at 0:00 at report
Start Date (before transactions on that
day)

For a report between two dates, cumulative amount of
the  due  principal  at  the  report  start  date  entered
before any transaction (i.e., 0:00 in the morning).

Particular cases: 

 Report between two dates: If the report Start date
=  Origination  date:  returns  Original  Principal  +
Additional  Principal  type  Line  statuses  entered  at
the Origination Date only. If the report Start date <
Origination date: returns 0.00 

 "Full" and "Up to date..." reports: returns Original
Principal  +  Additional  Principal  type  Line  statuses
entered at the Origination Date only.

Excludes,  case  being,  the  Fees  financed  (APR)  portion,
thus only pure (accounting) principal is reported.

NOTE:  Ordinarily,  "Additional  Principal"  type  Line
statuses  are  deemed  added  at  0:00+  (so  would  be  a
transaction  of  the  day,  thus  excluded)  but  a  logical
exception  was  created  assuming  the  user  does  not
differentiate  between  an  Original  Principal  and
"Additional  Principal"  type  Line  statuses  when  this
"Add.  Princ."  is  entered  on  the  Origination  date.  Both
are thus deemed inserted at 0:00, not at 0:00+.

See  also  the  "Balance  Due  Principal  at  0:00  at  report
Start Date (before any transaction on that day and excl.
Principal (Original))" reporting field.

&&ACC_BAL_DUEPRINC-
STARTDATE&&

|412|

APR - Balance Due Fees Financed at
0:00 at report Start Date (excluding any
transaction on that day)

See APR

Balance Due Principal at 0:00 at report
Start Date (before transactions on that
day and excl. Principal (Original))

For a report between two dates, cumulative amount of
the  due  principal  at  the  report  start  date  entered
before any transaction (i.e., 0:00 in the morning).

Particular cases: 

 Report between two dates: if the report Start date
< = Origination date: returns 0.00.

&&ACC_BAL_DUEPRINC-S
TARTDATE2&

|4900|
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 "Full" and "Up to date..." reports: returns Original
Principal  +  Additional  Principal  type  Line  statuses
entered at the Origination Date only.

Excludes,  case  being,  the  Fees  financed  (APR)  portion,
thus only pure (accounting) principal is reported.

NOTE:  Ordinarily,  "Additional  Principal"  type  Line
statuses  are  deemed  added  at  0:00+  (so  would  be  a
transaction  of  the  day,  thus  excluded)  but  a  logical
exception  was  created  assuming  the  user  does  not
differentiate  between  an  Original  Principal  and
"Additional  Principal"  type  Line  statuses  when  this
"Add.  Princ."  is  entered  on  the  Origination  date.  Both
are thus deemed inserted at 0:00, not at 0:00+.

See  also  the  "Balance  Due  Principal  at  0:00  at  report
Start  Date  (before  any  transaction  on  that  day)"
reporting field.

APR - Balance Due Fees Financed at
0:00 at report Start Date (excluding
these fees and any transaction on that
day)

See APR

Balance Due Principal at report End
Date

Cumulative amount of the due principal at the report
end date.

Excludes, case being, the Fees Financed (APR) portion.

&&ACC_BAL_DUEPRINC&
&

|411|

Balance Due Principal (at Current Date) See Fields at Current Date

APR - Balance Due Fees Financed at
report End Date

Cumulative amount of the due Fees Financed (APR) at
the report end date.

&&ACC_BAL_DUEPRINC_
F&&

|427|

APR - Balance Fees Financed (at Current
Date)

See Fields at Current Date

Principal Paid - Year-to-date (from
January 1 to report End Date)

Principal  paid (as  opposed to  accrued)  from  January  1
at 0:00 up to that end date entered for the report.

The  year  for  January  1st  is  determined  based  on  the
end date of the report entered.

For example, for a report from June 1, 2014 to June 30,
2014, principal paid will be from January 1, 2014.

If a complete report is requested, the principal amount
reported will be 0.00.

Excludes, case being, the Fees financed (APR) portion.

&&INV_PRINCPAID_YTD&
&

|824|

Principal Paid - Year-to-date (from
January 1 to report End Date)(using
Grace/EFT Date)

Interest paid (as opposed to accrued) from January 1 at
0:00 up to the report end date entered but taking into
account the date entered in the “True Pmt Date (Grace/
EFT)”  column.  The  reports  use  this  date  as  the
transaction date as opposed to the date entered in the
“Pmt Date”  column.  The  “True  Pmt  Date  (Grace/EFT)”
may be before or after the “Pmt Date”. 

The  year  for  January  1st  is  determined  based  on  the
report end date entered.

Thus, for a report from June 1, 2014 to June 30, 2014,

&&INV_PRINCPAID_YTD_
GraceDate&

|855|
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interest paid will be from January 1, 2014.

If  a  complete report is  requested, the interest amount
reported will be 0.00.

This field and the “True Pmt Date (Grace/EFT)” should
only  be used to  reflect  payments made slightly  before
or  after  the  desired  “Pmt  Date”  if  these  irregularities
are to have no effect on the interest computed.

APR - Fees Financed Paid Year-tu-date
(from January 1 to report End Date)

See APR

Outstanding - Principal portion at
Report End Date

See Outstanding

APR - Total of Payments (TILA-USA) See APR

APR - Principal (Original) + Fees
Financed

See APR

APR - Principal (Original) + Fees
Financed (for period)

See APR

APR - Total Cost of Credit (Interest +
Fees) + Total Principal

See APR

Other 3 (Principal)(Line status)(for
period)

In  the  Payment  schedule,  the  total  of  the
"Mathematical Principal" column for the "Other 3" Line
status for the report period. 

This could be used for example, when Simple interest is
capitalized  with  the  Other  3  Line  status  (Payment  =
0.00)  to  report  the  interest  (and  due  Column  Fees  if
present) that are capitalized at this date. 

If  there  is  more  than  one  transaction  on  the
Capitalization  date,  the  Capitalization  line  should
always be before any other transaction (and payment =
0.00),  otherwise,  the  Mathematical  principal  will  not
reflect the amount of interest (and due Column Fees if
present) to be capitalized.  

&&INV_Other3_Principal
&&

|856|

Other 3 (Principal)(Line status)(for
period) + 1 day

"Other 3" as renamed by the User
(usually "Capitalization")

In  the  Payment  schedule,  the  total  of  the
"Mathematical  Principal"  column  for  the  Other  3  Line
status  for  the  report  period,  plus  the  Mathematical
principal  of  the  next  day  if  the  conditions  below  are
met.

This  reporting  field  is  usually  used  when  the  Simple
interest  capitalization  date  is  the  1st  of  the  next
reporting  month  and  thus  normally  excluded  in  the
report for the current month. This field will include the
reporting  period’s  Mathematical  principal  and  the
Mathematical  principal  of  the  NEXT  day  ONLY,  IF  the
Line status Other 3 is present on this day.

For  example,  using  Line  status  Other  3,  the
capitalization date is set to January 1 in order to include
the  last  day  of  December  (31  at  midnight).  When  the
monthly  report  is  created,  thus  from  December  1  to

&&INV_Other3_Principal_
2&&

|856.2|
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December  31,  the  Mathematical  principal  that  is
calculated  on  January  1  would  normally  be  excluded
since  in  the  NEXT  reporting  period.  This  special
reporting field will derogate from this normal reporting
practice  and  thus  include  the  Mathematical  principal
for  this  extra day as  long as  the  Line  status  Other  3  is
present  on  the  next  day.  This  field  will  work  for  any
dates, not only for the calendar month, quarter or year.
   

If  there  is  more  than  one  transaction  on  the
Capitalization  date,  the  Capitalization  line  should
always be before any other transaction and payment =
0.00,  otherwise,  the  Mathematical  principal  will  not
reflect the amount of interest (and due Column Fees if
present) to be capitalized.  

NOTE:  No  matter  the  report  end  date  option  chosen
(include or exclude last day's transaction / interest) the
Mathematical principal for the day after the report end
date will be reported if the proper Line status (Other 3
as renamed) is present on that day. This is an exception
to the normal reporting rules.

The  "End  date  method"  chosen  for  the  report  will  be
ignored.

Expected Principal Balance (entire loan
end date)

Expected Principal Balance (entire loan end date) &&LoanBalanceExpected
Princ&& |5141|

Expected Principal Balance at report
End Date

Expected Principal Balance at report End Date &&Bal_ExpectedPrinc_En
dDate&& |878|

Expected Principal Total (for period) Expected Principal Total (for period) &&INV_Tot_ExpectedPrin
cipal&& |879|

Tally
Field name Description Merge Code Short

Merge
Code

Number of occurrences of the
select Line status (for period)

Number  of  occurrences  of  the  selected  Line  status  in  the
selected period.

&&OCC_LineStatus_
ID&&

|2000|

Number of occurrences of Due Pmt
(for period)

Number of occurrences of all Due Pmt in the selected period.
This includes "Due Pmt - Unpaid", "Due Pmt", "Due Pmt (2)" ,
"Due  Pmt  (3)",  "Due  Pmt  (4)"  and  "Due  Pmt  (5)",  the  latter
four as renamed.

&&OCC_Due_Pmt&
&

|2001|

Number of occurrences of Unpaid
Pmt (for period)

Number  of  occurrences  of  all  Unpaid  Pmt  in  the  selected
period.  This  includes  "Returned  Check",  "Unpaid  Pmt",   and
the latter as renamed: "Unpaid Pmt (2) to (10)".

&&OCC_Unpaid_Pm
t&&

|2003|

Number of occurrences of Add.
Princ. (Loan) (for period)

Number  of  occurrences  of  all  Add.  Princ.  in  the  selected
period.  This  includes  "Add.  Princ.  (Loan)",  "Insurance",
"Invoice",  "Tax",  "Investment",  "Penalty"  ,   and  the  latter  as
renamed: "Add. Princ. (2) to (10)".

&&OCC_Add_Princ&
&

|2004|



Page 933

© Jurismedia Inc., 2007- 2023

Number of occurrences of all Due
Pmt (for period) 

Number of occurrences of all Paid Pmt in the selected period.
This  includes  "Paid  pmt",  "Paid  Late  Pmt",  "Partial  Pmt",
"Partial  Late  Pmt"  "Paid  Pmt  Returned  Check",  "Add.  Pmt",
"Interest  Paid"   and  the  latter   as  renamed :  "Compensatory
Pmt", "Paid Principal", "Paid Pmt (2) to (20)".

&&OCC_Paid_Pmt&
&

|2002|

Fields at Current Date (used mostly in Record Summary Window)

Field name Description Merge Code Short
Merge
Code

Balance (at Current Date) True balance (as opposed to the Computational balance). 

The balance indicated when using this field is  the balance on
the current date no matter what the Lines statuses are before
the current date. Thus, if several payments are due (so unpaid
and  not  changed  to  0.00),  the  true  balance  will  not  be
displayed  because  the  data  was  improperly  updated  or
maintained.

Provides  a  theoretical  balance  based  on  the  payments  that
should be made.

&&INV_BALANCETO
DATE&&

|703|

Balance Due Principal (at Current
Date)

Cumulative amount of the due principal at the current date.

The balance indicated when using this field is  the balance on
the current date no matter what the Lines statuses are before
the current date. Thus, if several payments are due (so unpaid
and  not  changed  to  0.00),  the  balance  reported  will  not  be
true because the data was improperly updated or maintained.
Provides  a  theoretical  balance  based  on  the  payments  that
should be made.

Excludes, case being, the Fees financed (APR) portion.

&&ACC_BAL_DuePri
nc_ToDate&&

|498|

APR - Balance Fees Financed (at
Current Date)

Balance of all Fees Financed entered in the APR window at the
current date.

The balance indicated when using this field is  the balance on
the current date no matter what the Lines statuses are before
the current date. Thus, if several payments are due (so unpaid
and  not  changed  to  0.00),  the  balance  reported  will  not  be
true because the data was improperly updated or maintained.
Provides  a  theoretical  balance  based  on  the  payments  that
should be made.

&&ACC_BAL_DueFe
esFnd_ToDate&&

|499|

Interest Accrued from last payment
Paid (at Current Date)(0.00 if no
payment)

Accrued interest from the last payment tagged as "Paid" (Line
status  =   "Paid  Pmt",  "Paid  Pmt  2  to  20",  "Paid  Late  Pmt",
"Partial  Pmt",  "Partial  Late Pmt",  "Paid Pmt Returned Check"
or  "Add.  Pmt"),  at  0:00  (so  interest  for  that  first  day  is
included) up to the current date.

Amount  "Paid"  must  not  necessarily  be  greater  than  0.00  so
be careful.

Lines with any other status ("Due Pmt", "Unpaid Pmt", "Fees",
"Fees paid", "Information", "Add. principal", "Other", etc.) are
not factored in.

If the entire loan contains no "Paid" type Line status, 0.00 will
be returned.

NA
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Interest Accrued from last payment
Paid (at Current Date)

Same  explanation  as  above  with  the  exception  that  if  the
entire loan contains no "Paid" Line status type, the amount of
interest accrued up to the current date will be returned.

NA

Interest Accrued from last payment
Paid/Unpaid (at Current Date) (0.00
if no payment)

Same  explanation  as  above  while  including  all  "Unpaid"  Line
statuses.

If the entire loan contains no "Paid" type Line status, 0.00 will
be returned.

NA

Interest Accrued from last payment
Paid/Unpaid (at Current Date)

Same  explanation  as  above  while  including  all  "Unpaid"  Line
statuses and if the entire loan contains no "Paid" or "Unpaid"
type  Line  statuses  the  amount  of  interest  accrued  up  to  the
current date will be returned.

NA

Outstanding - Total (Balance)(at
Current Date)

Amount  in  column  "Outstanding  -  Total  (Balance)"  at  the
current date.

NA

Active Records - Sub-Status (Current
date if AUTO) 

See Loan Data

Various Ageing Balances (0-29 days,
30-59 days and the usual ageing
periods)

See Outstanding

Nominal Interest Rate (at Current
Date)

See Interest

Special  fields - Payment schedule in Document Merge
Field name Description Merge Code Short

Merge
Code 

Detailed lines (for period)(True
Balance)

This produces in "Document Merge (Letters, Contracts,
Invoices and Statements)" module only, a table of all
transactions that were done during the period or for the full
loan if no dates are entered.

Found under  "General"  when inserting the  merge  fields  with
the right mouse click.

The  "True  Balance"  column  in  the  table  of  transactions  will
always  display  the  true  balance  as  opposed  to  the
computational balance.

&&DETAILEDTABLE
&&

|999|

Detailed lines (for period)(Summary
format)

See above.

However,  will  only  display  three  (3)  columns:  line  number,
payment date and payment amount.

Presented in a 2 x 3 column format.

&&DETAILEDTABLE
2&&

|997|

Detailed lines (Loan Origination
Date to report End Date)

This  produces  in  "Document  Merge  (Letters,  Contracts,
Invoices  and  Statements)"  module  only,  a  table  of  all
transactions that were done from the Origination Date of the
loan  to  the  End  Date  of  the  report  or  for  the  full  loan  if  no
dates are entered.

Found under  "General"  when inserting the  merge  fields  with
the right mouse click.

The  "True  Balance"  column  in  the  table  of  transactions  will
always  display  the  true  balance  as  opposed  to  the

&&DETAILEDTABLE
4&& 

|995|
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computational balance.

Detailed lines (for period)(Paid
amounts)

Will produce, for the chosen period, a table of all transactions
as  well  as  the  paid  amounts  (as  opposed  to  the  "accrued"
amounts).

The following are included: 

 Paid interest
 Paid principal
 The column called "Paid Fees (Column + APR Financed)"

includes the total  of  the paid APR Fees Financed as  well
as the paid Column Fees 1 to 6.

&&DETAILEDTABLE
3&&

|996|

Detailed lines (for period) 

Formats 5 to 25

This produces in "Letters, Contracts,  Invoices  and Statements
(Document  merge)"  module  only,  a  table  of  all  transactions
that  were  done  during  the  period  or  for  the  full  loan  if  no
dates are entered.

Found under  "General"  when inserting the  merge  fields  with
the right mouse click.

The  "True  Balance"  column  in  the  table  of  transactions  will
always  display  the  true  balance  as  opposed  to  the
computational balance.

There are no specific descriptions for each template - produce
a test in the software to see the content.

Format  13:  The  "Interest"  column displays  the  same interest
accrued  as  that  in  the  payment  schedule  (no  matter  the
previous line's date) as opposed to the interest accrued as of
the report start date

Format 15: This table consists of two (2) lines with up to five
(5) transactions per set of two lines (limited to five because of
paper  width  constraints).  The  first  line  includes  the  Due  Pmt
(all  such  Line  statuses)  Dates  and  the  second,  the  Due  Pmt
Amounts.

The  template  was  created  for  a  client  who  never  has  more
than five transactions per period. If  there are more than five
transactions to report in the given period, an extra set of two
lines will be created in the same table. The presentation is not
ideal  and  thus,  another  presentation  (template)  should  be
used if more than five transactions are present.

Format  16:  The  "Interest"  and  "Principal"  columns  will
indicate the interest paid and principal paid if the Line status is
a Paid payment type line or, if any of the "Due Pmt" type Line
statuses,  then  the  interest  /  principal  that  will  be  paid  once
the payment is made.

This  is  a  special  table  where,  for  the  "Due  Pmt"  type  Line
statues,  the  paid  amounts  are  simulated  with  a  "Paid  Pmt"
Line  status,  no  other.  "Paid  Pmt"  Line  statuses  cannot
generate  automatic  Column  fees,  so  if  Column  fees  are  not
present when producing the report,  none will  be added with
the simulation.

The  "Principal  Balance"  column  excludes  APR  Fees  Financed,
case being (thus "pure" Principal).

&&DETAILEDTABLE
5&& 

&&DETAILEDTABLE
6&& 

&&DETAILEDTABLE
7&&

&&DETAILEDTABLE
8&&

&&DETAILEDTABLE
9&& 

&&DETAILEDTABLE
10&&

&&DETAILEDTABLE
11& 

&&DETAILEDTABLE
12& 

&&DETAILEDTABLE
13& 

&&DETAILEDTABLE
14& 

&&DETAILEDTABLE
15&&

&&DETAILEDTABLE
16& 

&&DETAILEDTABLE
17& 

&&DETAILEDTABLE
18& 

&&DETAILEDTABLE
19& 

&&DETAILEDTABLE
20& 

&&DETAILEDTABLE
21&&

&&DETAILEDTABLE
22&&

&&DETAILEDTABLE
23&&

&&DETAILEDTABLE
24&&

&&DETAILEDTABLE
25&&

 

|994|
|993|
|992|
|991|
|990|
|989|
|988|
|987|
|986|
|985|
|984|
|983|
|982|
|981|
|980|
|979|
|978|
|977|
|976|
|975|
|974|
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Format  17:  The  “Principal”  column  in  this  table  is  either
Additional  principal  (positive  amount)  or  Paid  principal
(negative amount). The Principal excludes APR Fees Financed,
case being (thus "Pure" principal).

The “Interest” column is Paid interest (negative amount). The
Accrued  interest  is  the  second  to  last  line:  “Int.  Accrual  for
period”

This  is  the  same  table  as  Table  10  but  with  the  date  format
matching the user's preference.

Format 18: The amount of transactions is always  displayed in
positive (even for Additional Principal). 

Excludes "Information" and "Non-impact information".

Format 19: The amount of transactions is always  displayed in
positive (even for Additional Principal). 

Excludes  "Information",  "Non-impact  information",  "Fees
from 1 to 6" and "Fees paid from 1 to 6" Line statuses.

Format  20:  The   "Balance"  column  in  the  table  will  always
display  the  true  balance  as  opposed  to  the  computational
balance.

Format  21:  This  report  includes  only  "Paid"  Line  statuses.  It
must  absolutely  be  produced  as  a  "Full  Report"  in  order  to
provide  accurate  data.  If  the  report  is  produced  between  2
dates, the data will be incorrect.

The "Paid Add-on interest" column (that  can be renamed) of
the payment table will display the “Column Fees 1 - Paid” (as
renamed)  amount.  The  “Paid  fees”  column  will  display  the
Column Fees 2 to 6 - Paid amount, and the "Total loan balance
including  the  future  unpaid  fees  after  the  payment  (all  the
column  fees)"  column  represents  the  total  of  all  future  due
payments up to the end of the loan, even if the final balance is
not 0.00.

Format  22:  The   "Balance"  column  in  the  table  will  always
display  the  true  balance  as  opposed  to  the  computational
balance. This styke is identical to style 20,  excluding the start
and  end  balance  lines  if  the  table  is  created  between  two
dates.

NOTE: Other templates are added based on our users' needs.
Always  test  the  templates  properly  before  using  since  they
can include several subtleties specific to the clients who have
requested their development.

   

Advanced Queries

This is a very important module, particularly for larger or diversified portfolios, since it allows the user to create and save
Queries that select only the pertinent Records to be included in the reports. Most reports available under "Reports" can
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use this  Record selection module.  Multiple  fields  and  even  Custom fields  can  be  used  to  include  and  exclude  Records
from reports. Here are a few query examples:

 Report for Active Records only for creditor ABC inc.
 Statement including Records whose amounts are overdue by more than 60 days and for Borrowers from a particular

city.
 Record List Customized report for loans which were opened in 2021 (Origination date) of  over 50 000 (Origination

principal) sorted according to their seniority.
 Produce a Document Merge for Invoices by selecting only the Records with due payments in the coming week.

These  queries  are  especially  useful  for  portfolios  that  have  hundreds,  or  even  thousands  of  loans.  This  option  is  less
appealing  for  smaller  portfolios  since  the  Records  to  be  included  in  the  report  can  simply  be  selected  from  the  Main
window.

All users, of every security level can, or not, create these Advanced Queries. The Margill Administrator can give users the
rights to use these by selecting "Can create and use Advanced Queries" for each authorized User.

 Steps to create Queries

 Modifying a Query

 Deleting a Query

 Using Advanced Queries to include Records in the reports

 Shortcut keys

Steps to create Queries

To create a query, the user must go to Reports > "Advanced Queries" button . The following window
will open:
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In  the  first  column,  you  will  find  the  name  of  the  query  that  can  be  selected  when  generating  a  report.  The  second
column shows the query detailed description (if needed) and the third column displays the user who created the query.
 
A query can be only be modified by its creator. Other users can use it for reporting or to consult its content in read-only
mode.

The user can display all of the queries of all users or only the ones that he created, by checking the appropriate box:

 

Click on (or to edit a query). This will open the "Advanced Queries" window.
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1) Enter the Query title. 

2) Enter a detailed description, if needed.

3) On the left side of the window, choose the desired field from the usual themes and use the arrow  in the center
to copy the field to the table on the right. A field can be used more than once. 

4) Choose  the  operator  from  the  drop-down  menu.  Choices  are  different  depending  on  the  type  of  field  selected
(monetary, text, date, etc.).  

5) Assign the desired value (depending on query type): 

6) If  necessary,  choose other  fields  from the left.  When adding  an  extra  field,  an  "AND"  or  an  "OR"  will  be  required
between the fields. 



Page 940

© Jurismedia Inc., 2007- 2023

Use "AND" between the chosen criteria for all criteria must be included. For example, include the Records that were
created after January 1st, 2018 AND which balance is smaller than 10 000. Only the loans corresponding to these 2
combined criteria will then be included. Using "AND" is more common than using "OR" described below.

Use "OR" if  one or  the  other  criteria  must  be  respected,  but  not  combined.  For  example,  include all  Records that
were created after January 1st, 2018 OR with a balance of less than 10,000. We would obtain ALL Records created
after 2018-01-01, no matter what the balance is and ALL the Records with a balance smaller than 10 000, no matter
the origination date. The "OR" option is therefore not very limiting and generally less relevant for reports.

7) Copy the  next  field  to  be  added to  the  third  line,  and  so  on.  Multiple  operations  can  be  performed including  the
addition of parentheses in order to structure the queries. Each parenthesis must be inserted by the left and right of
the "Field Name". To do this, place the mouse cursor on the desired location and right-click with the mouse. You can
choose from the drop-down menu.

o Parentheses are for more advanced users and are necessary in more complex queries that include multiple
fields with AND and OR combinations.

Important Notes: The "Business (Borrower)" and "Business (Creditor)" fields allow a search by the criteria "Equal to",
"Starts  with"  or  "Contains".  The  "Borrower"  and  "Creditor"  fields,  however,  allow  a  search  from  the  drop-down
menues in order to check the businesses needed for the Query.

For example, here is a query that filters among all the Creditors contained in each Record, in order to include those
that contain either: M&H Inc. or Trans At.com or Clark Inc.
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A powerful variable is available which includes Records based on the date of the upcoming Due payments. It is quite
useful  for  document  Merge  in  order  to  produce  invoices  only  for  "Due  Pmt"  type  Line  statuses  coming  up  next
month, for example.

This variable is called: "Next Due Payments - Date (all Due Pmt Line statuses), under the "Loan Data" section". Three
choices are available for date inclusion:

o Next Calendar month
o Next Sunday + 6 days
o Next Sunday + 13 days

For weekly or bi-weekly payments, Sunday is used as the starting point since it is usually the first day of the week. If
other options are required, please contact Margill support.
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An example from today's date is displayed at the bottom of the window in order to validate that the date selection
corresponds to your needs:

Dates  will  always  be  recomputed  starting  at  the  report  production  date.  The  Query  used  for  a  weekly  report
production on December 31, 2021 will select all Records which include "Due Pmts" between January 2 and 8, 2022.

8) If it is desired that the Records be sorted in a precise order during the report production, it is possible to do so by
adding sorting items in the central zone of the window.
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To do so, simply select the desired item in the list on the left and click on the blue arrow in the middle.

For example, here is Record sort by "Unique identifier 1" in Ascending order. Thus, the Records are listed according
to this criteria when producing the report:

In  the  "Record List"  under  Personalized Reports,  an  option  allows  data  sorting  and  subtotals  without  the  need  to
select the option in the Advanced Queries.

9) Once the Query is completed, click on "Test Query"   or on "Save" . 
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Upon clicking on "Test Query", all the Records that meet the conditions of the query will be displayed in the window
shown below.  It  is  therefore possible  to  verify  if  the  query  was  properly  configured,  according  to  your  needs  and
requirements. 

Note:  In  the  Test  Query  window,  the  same  Record  may  appear  several  times,  since  the  query  search  filters  also
search for the criteria requested at the Co-Borrower and Creditor levels. This will have no effect when the report is
produced. Please note that the Guarantors are excluded from the query search filters.

Note: The fields highlighted in green are based on report dates. There are three available:  

o Balance at report End Date
o Outstanding - Total (Balance) at report Start date (before transactions on that day)
o Outstanding - Total (Balance) at report End date
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These  fields  cannot  be  validated  by  the  "Test  Query"  option,  because  they  require  entering  specific  dates  when
producing reports in order to calculate the results. 

Also, they can only be used with the "AND" operator and they must be at the end of the query fields since they are
not an integral part of the query.

When saving, the syntax will be verified. This verification is not to check if the query will give the desired results, but
to  make  sure  that  it  is  mathematically  sound.  In  the  following  example,  the  query  contains  only  one  open
parenthesis.  That  is  a  syntax  error  so  therefore,  the  query  will  not  be  valid  and  you  will  need to  correct  it  before
saving.

Special "Ageing" fields

These fields will find/include Records for which the selected ageing balance (60 to 89 days in the example below) is
at,  above or  below a certain amount (great or  equal  to 10.00 in  this  example) at  the date the report  is  run  (so  at
current date). The report dates entered will thus have no effect on the Records included in the report, but the dates
will have an effect on the data amounts that are reported.
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Modifying a Query

An already saved query can be modified from the "Query Selection" window. Choose the  query  to  be  modified (it  will

become blue) and then press on "Edit" . You can also copy the Query with the "Copy Query" button

.  To  delete  a  field,  click  on  the  left  arrow  in  the  center  .  The  "Clear  Query"  button

 will delete at once, all the lines of the Query. 

Deleting a Query 

A query can be deleted from the "Query Selection" window. Select the Query to be deleted, right-click on the mouse and
choose "Delete":
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Using Advanced Queries to include Records in the reports 

Queries are used to isolate certain Records so that only these are included in the reports.

Queries can be used in every report except these two in the "Standard Reports" section: Record List Summary and Credit
Agency Report.

Here is a step-by-step method to use an Advanced Query filter when creating a report:

1. Select the desired report type:

2. Do the usual report setup. For more detail on this, consult the User Guide section dedicated to the type of desired

Report. Under "Records included", select "Records from Advanced Query" and click on  .
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3. The following window will open. Select the desired Query and click on . The user can select any
Query whether he created it or not. 

4. The number of Records included in the report is displayed between parentheses. In the following example, only 17
Records will be used when the report will be generated, because 17 Records from the MLM database correspond to
the selected criteria. The selected query name is also displayed. Select other report settings as usual.

Note for queries involving multiple currencies: When the query includes amounts (for example, only include loans larger
than 500 000), the selected Records will be chosen taking into account the currency of the Record. No conversion will be
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made to take into account the exchange rate. 

Shortcut keys (advanced users)

The following shortcuts allow more advanced users to copy queries in order, for example, to use them in another system.
 

 Ctrl+Alt+Shift+C: Will copy the query in SQL format to the clipboard.
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Personalized Reports

Users  can  create  their  own  personalized  or  custom  reports  using  over  1000  fields  and  custom  fields.  The  following
chapters explain each of these reports. The previous chapter, Reporting fields, describes each of the fields in detail. Fields

are also explained in the software when clicking on .

If  the personalized reports do not  meet your needs,  the Margill  team can also create even more sophisticated reports
based on your specific needs. These include invoices, special calculations, special fields, etc. See Custom reports created
by the Margill team.

In order to quickly  copy data and perform some operations,  a  spreadsheet is  available directly in  many reports.  These
spreadsheets are available in the following reports when selecting the "Spreadsheet" tab :

 Record List
 Record List with Period Breaks
 Transaction Report
 Accounting Entries

Please note that these spreadsheets are not as sophisticated as an Excel sheet and may not meet all of your needs.

Personalized reports available:

Executive Dashboard
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Record List and Record List with Period Breaks

Transactions Report

Accounting entries (Export to the General Ledger)

Document Merge (Letters, Contracts, Invoices and Statements)

Special Events Report

   

Executive Dashboard

The Executive Dashboard is a visual report that allows the user to rapidly extract just about any data from Margill Loan
Manager (MLM). The Executive Dashboard can be created by the user and include hundreds of data elements according
to various criteria. It allows to display data related to amounts, number of Records by category, averages and graphs. 

For example, a report could be created to obtain the loan amounts (Principal) based on the types of loans, the Borrowers'
region, age groups and various other socio-economic data entered in MLM. 

Such reports can also be produced with a host of other data such as interest,  fees,  outstanding amounts,  even certain
Mathematical  Equations  that  allow to  add  or  subtract  certain  fields.  One could,  in  a  second,  see  if  a  loan  provided  to
women are on average higher than those given to men (a custom field would have been created with a drop down menu
(man or woman).

Mathematical Equations related to Participation Loans cannot be included in an Executive Dashboard report. They have
to  be  extracted via  the  Record List  report  (Section Reports  >  Personalized Reports).  It  is  a  very  powerful  tool  that  has
been specially designed to gather Data about Participation Loans.

Amounts with decimals will be rounded in order to be converted to integers.

This report also allows, for  multi-currency portfolios,  converting multi-currency values to one or  many other
currencies.

Creating a report template

Producing a report

 Convert to other currencies
 Time required to produce a report
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Modifying a report template

Copy, rename and delete existing report templates

Statistical Errors to avoid

Report example

Creating a report template

In Main MLM Window, click on Reports > Personalized Reports > Executive Dashboard. The following window will appear:

To create a report template, click on "New". This allows the user to select fields one by one by highlighting them (one

click), then by clicking on the arrow , or by double-clicking on the desired field among all available fields (under the
"All" tab or under each theme tab). The report will include as many report sections as the number of selected fields.

Each of these fields is described in Reporting Fields section and also by a mouse-over on the field. The "Equations" theme
are  Mathematical  Equations  created  by  the  Administrator  and  Power  Users  to  add,  subtract,  multiply  or  divide  fields
together.
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To choose the data to be included in the report:

Choose the data to include from the left of the window and bring to the right table. One can change the report section
order in this window (in the"Reporting Fields" section on the right) by highlighting the field to be moved and by using the
arrows on the right-hand side.

It is also possible to eliminate a field by clicking on the arrow in the middle of the window in order to select it.

Then choose, in the columns, the elements to include in the report. These include the:

 number of Records
 amount or number reported (money or number field)
 average (amount or number divided by the number of Records)
 segmentation fields
 pie charts
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Segmentation Fields allow you to segment or divide the data based on various fields or types. These are thus at the heart
of this report. A Segmentation Field is:

 any  of  the  about  20  fields  that  include  menu-type  choices  (Record  Type,  Record  Status  (Draft,  Active…),  Ageing
status, etc.)

 all Custom fields that include scroll menus
 a few other fields (City, State/Prov., etc.) that could be useful as long as there are a limited number of choices.
 
Pie charts are only available if a Segmentation Field is chosen.

The "Segmentation Fields" drop down menu is used to determine which criteria to use in order to divide data and graphs.

If the Pie chart option is checked, you will  need to specify if  the Pie chart  will  display the "Amount or  Number" or  the
"Number of Records" by checking the desired option at the bottom of the window.

Once all the elements are included in the report, enter the report (template) name and save.

The "Save" button will bring you back to the "Executive Dashboard" window.

A  report  can  include  multiple  "Reporting  Fields"  or  identical  "Reporting  Fields",  but  with  different
"Segmentation  Fields".  For  example,  the  report  below  will  include  the  Principal  loan  amount  based  on  the  Record
Type,  the  Borrower  city  and  simply  the  number  of  loans  and  the  total  amount  in  the  portfolio  (or  in  the  selected
Records).  

This report setup...
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... produces the report below:

Producing a report

To  produce  a  report,  you  must  first  select  the  desired  report  in  the  list  located  on  the  left  (under  "Description")  and
determine its settings in the section located on the right:
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Four options are available to select Records (Records Included): 

1. All Records;

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

2. All Records displayed in the Main Margill window (Record Summary window);

3. Records selected in the Main Margill window (Record Summary window): select (highlight) the desired Records in the
Main  MLM  window  (Record  summary).  To  do  so,  you  can  sort  the  Records  as  you  see  fit,  display  some  with  the
display  filters  or  select  them all  with  the  CTRL-A  key.  The  results  order  will  be  in  the  same as  the  selection  order
made in  the  Main  window.  The  first  Record  chosen  (with  a  mouse  click,  for  example),  will  be  the  first  line  of  the
report, and so on.

4. Records from Advanced Query.

An Executive Dashboard can be produced for: 
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1. Full report;

 This  option  is  to  be  used  to  get  a  global  view  of  the  portfolio,  regardless  of  term.  For  example,  total  interest
generated depending on Record type or depending on region.

2. Report up to a specific date (thus from the beginning of the loan until the desired ending date);

 This option is to be used to get partial  statistics from the starting date of the activities up to the current date. For
example, total interest generated by Record type or by region from the beginning of the loans until today. It can also
be used to generate ageing reports based on the current date.

3. Report between 2 dates.

 This third option allows to extract data monthly, quarterly, annually, etc. Thus, we could find total Accrued interest
for a period and compare to the interest actually Paid for the same period taking into account Record type, region,
city, etc.

Be careful when using dates for certain reports because dates have a great impact on data. See the Statistical Errors to
Avoid section.

Report end-date methods:

 Three methods are available to include or exclude interest and transactions that may occur on the reporting end
date specified. This can be important depending on the end-date entered. For a report up to December 31 for
example, the last day's transactions and interest should generally be included. 

For a report up to January 1 (thus the start of the next period), if that day's transaction is to be included but not the
interest  on  that  day,  then  the  second  option  should  be  chosen  ("Include  last  day's  transactions").  Ideally  though,
with a date at the start of the next reporting period, the first option should be chosen ("Exclude last day's interest")
so as not to include any data from the next reporting period (avoid double accounting).

Please note: a Record is considered to be completely terminated on the last line's "Pmt Date" at 0:00:01 (so at 0:00
in the morning plus a fraction of a second to allow the last payment to be made). Thus, if a report end date is equal
to  or  after  the  Record  termination  date,  all  three  "End  date  method"  choices  will  yield  the  same  data  for  this
particular Record and no interest will be included for the Record's last day. It is suggested for lines of credit or loans
with no true end date set, to enter a distant date (e.g. 01/01/2025), so that the loan is not considered finished on the
last line and continues to generate interest. More accurate projections can thus be made.

Segment: 

 When producing reports, the "Do not include empty segments" option allows for the exclusion of Records when the
"Reporting Field" is empty. 
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For example, a custom field with a drop down menu includes the name of  the person that  referred the borrower.
This type of data include names which eventually become irrelevant. In order to avoid having these names included
in the report with zero (0) associated to it, the option "Do not include empty segments" should be activated. This will
decrease the amount of data for each Segmentation field in the report. 

Example:  The  "Reference"  custom  field  includes  30  names  (drop  down  menu  in  order  to  be  able  to  create  an
Executive Dashboard). Senior management would like to know the amount of principal generated by each Reference.
Among those 30 names, only 19 generated sales (active loans) in 2016. The report will therefore include names and
amounts (principal) of  those 19 references only  and will  exclude the 11 others,  which would have a 0.00 principal
amount anyways.

Convert to other currencies: 

 This  report  also  allows,  for  multi-currency  portfolios,  to  convert  the  multi-currency  values  to  one  or  many  other
currencies.  First,  the  Administrator  must  activate  the  multi-currency  module  through  Tools  >  Settings  >  System
settings (Administrators) > Modules > Currencies and by selecting "Activate "Multi-Currency" module (Administrator
only)".

When converting in  the report,  the following choice will  appear with a  pull  down menu of  the  currencies  in  MLM
(other currencies may be added and some deleted - see the Multi Currency section).
 

No matter which currency was used in the Record, the report will  be produced with the selected currency (USD in
the  above  example)  using  the  conversion  factor.  The  report  may  be  created  in  any  currency,  not  only  the  base
currency (factor = 1).

In order to be able to differentiate different currencies (useful when the report is produced in multiple currencies),
MLM adds a first column for currency symbols (which can be eliminated in the backup settings TXT and CSV).

Please note that, as shown below, it is possible to create a report without adding currency ($, €, £, etc.). When the



Page 959

© Jurismedia Inc., 2007- 2023

currency  data  conversion  is  not  activated,  the  amounts  will  simply  add  up  and  generate  a  total  with  no  specific
currency.

Once the  above choices  have  been  entered,  press  on  "Create  Report"  .  A  preliminary  window will
appear that computes the amounts. Before actually producing/printing/saving the report, it can also be given a different
name than that in the template. Often a year or date can be added.

Once all is computed, press on "Preview / Print" to see the actual report with graphics. The printer
settings window will appear but printing will not occur immediately. A preview will be displayed first.
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Once in preview mode, the report can then be printed or saved in various formats. 

 The PDF format is recommended for saving as opposed to Word. 
 If saved as an Excel file, the numbers will be included in the sheet, but not the graphics. 
 The  report  can  also  be  sent  in  PDF  format  by  email  if  your  email  program  is  properly  configured  (browser-based

emailing is not supported)(see Tools and Settings > Tools Menu > Settings > Default Settings > Email Connection).

For more information on printing and report export, see: Saving & Printing > Printing.

Time required to produce a report

See the special section to this effect: "Time required to produce reports".

Modifying a report template

An  existing  report  (template)  may  be  modified  or  saved  under  a  different  name  with  only  a  few  changes.  An  existing
report may be modified or saved under a different name with only a few changes. Choose the desired report and click on
"Edit". Changes may then be made as explained in the "Creating a report template" section above.

In MLM multi-user environments, users other than Administrators (and Privileged users) cannot modify reports created
by  another  user.  The "owner" of  the  report  appears  in  the  second column of  the  main  report  window (this  column  is
hidden by default).
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A normal user or a read-only user can view the report but cannot change it. It is also possible for the user to select the
report, click the right mouse button and copy it. He then becomes owner of this new report. 

Copy, rename and delete existing report templates

To copy, rename or delete an existing custom report, select the desired report and right click on the mouse. Choose the
required action.

Statistical Errors to avoid

Warning!

MLM is a first and foremost a loan servicing software and not a Borrowers or statistics manager.  The software gathers
statistics by taking into account loans, not Borrowers, based on multiple criteria chosen by the user.

Statistical Data Over evaluation

If  a Borrower has more than one loan in the system and if  a field is  associated to a  Borrower and not  to a  loan,  some
statistical data can be improperly accounted for.

For example, John, a Borrower, has two (2) Records (loans) in MLM and a Borrower custom field indicates he has two (2)
children.

When data is extracted in the Executive Dashboard for both Records, Jean will have four (4) children. Data will have been
doubled.
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If MLM is used for statistics, it is suggested to connect statistical data to the Record (loan) and not to the Borrower. For
example, when two (2)  children are entered in  the  Record (even if  a  loan  cannot  have children),  both  children will  be
compiled once but only if the number of children is entered for one of the loans and this, even if the Borrower has more
than one loan in the system.

A typical example would be in social financing where lenders want a statistical report of the current number of jobs in a
business and the number of jobs that will  be created with this  loan.  Each loan granted to the business (Borrower) can
create jobs and the total number of jobs can be compiled in the Executive Dashboard. Likewise, a field with the current
number of jobs in the business should be connected to the business' first loan and not to the business as a Borrower.

Decrease of the Number of Records Reported

The number of Records that will be reported in the Executive Dashboard may not match the number of Records chosen
or the number of Records included in the portfolio unless two conditions are met:

1. only Records that have a value greater than 0.00 in the chosen field will be included, AND

2. only Records with transactions in the Payment schedule within the selected time period will be included.

For example:

 Our database includes 404 Records.
 When choosing a complete report (without dates), only 395 Records appear in the results since the nine (9) excluded

Records have a 0.00 value for the chosen data (Original Principal in our example).
 When adding dates between 2015 and 2016, the number decreases to 228 Records since many Records were closed

before the end of 2015.
 When trying to get data for 2030 (in approximately fifteen years),  the number of  Records decreases to zero when

loans are short term. If the database included long term loans, some Records would show up in the report.

To continue this example, an interesting data that can be extracted in the Executive Dashboard is the Original Principal of
the portfolio as a whole ("Original Principal'' variable) versus the Original Principal granted between the chosen dates of
the report ("Original Principal (for period)" variable).

If a "Full Report" is chosen, these two data will generate the same results since no date is specified (395 Records out of
400 since 5 Records have a 0.00 value in the Original Principal):
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Full Report

If dates are chosen, the "Original Principal" variable will take into account all Records that exist between the two dates
and for which the principal is greater than 0.00. In the example below, 228 Records were active between January 1, 2015
and December 31, for a total of 173 million. It does not mean that loans have been granted in 2015.

The  "Original  Principal  (for  period)''  variable  will  include  all  the  Records  which  Origination  date  is  in  2015  AND  which
principal is greater than 0.00. Records with original Principal of 0.00 will be excluded from the report.

One-year Report

Executive Dashboard subtleties summary: 

Criteria Records Reason of decrease

Full Portfolio 404 -

Original Principal Criteria
(without date)

395  Original Principal of 0.00 for 9 Records

Original Principal Criteria
(in 2015 only)

228  Only 236 Records are active in 2015
 8 of those have an original principal of 0.00

Original Principal (for period)
(in 2015 only)

147  Only 150 Records have an origination date in 2015
 3 of those have an original principal of 0.00

The Average is  also affected by these various criteria.  For example, for  Records which original  Principal  is  in  2015, 150
Records respect the disbursement date's exclusive criteria. Three (3) of these have a Principal of 0.00. The average uses
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147, not 150.

In order to offset these exclusion criteria, it is suggested to add in a report additional data that are not affected by the
0.00 constraint. In the example below, the "Number of Records" field has been added. Thus, all active Records (236) in
2015 are included in the third section of the table.

Report Example

If, for example, a user wants to know if there is a correlation between the number of cars (Custom fields) Borrowers own
and their credit limit, depending on their country of origin, here is how to set up the "Executive Dashboard" report:

The  user  wishes  to  generate  a  report  considering  only  selected  Records  in  the  Main  Window  and  wants  all  monetary
values converted to Canadian dollars.
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Here is the data he will get when generating the report:

Twenty four (24) Records were selected and taken into account for this report. The report shows that Borrowers come
from four different countries,  they own in average 1.58 cars and their  average credit  limit  is  176 188 Canadian dollars
(after currency conversion).

In this example, it  seems that the Irish own the most cars per Borrower. On the other hand,  the French have a higher
credit limit. If the sampling was done properly (not in this case), we would conclude that there is no correlation between
the number of cars Borrowers own and their maximum credit.

In order to avoid generating false statistics, see the Statistical Errors to Avoid section above.
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Record List

This report lists, line by line, the desired data for each of the Records selected in the Main Margill Loan Manager (MLM)
window. This allows you to produce reports containing one or many of the more than 1000 data fields, custom fields and
Mathematical Equations that users can define.

The reports may produce totals up to the end of each of the Records or include totals up to a specific date or between
two dates.

The  reports  produce  either  Text  files  (.TXT),  Comma-separated  value  files  (.CSV)  or  Excel  (XLS)  spreadsheets  that  may
then be organized or exported to third-party software. A spreadsheet is also included under the "Spreadsheet" tab. 

In fact, you may produce a countless number of reports such as:

 Client list including phone numbers, emails, addresses, social security numbers, birth days, etc.;
o Warning, if a client (Borrower) is entered in MLM but does not have a Record (Loan) assigned to him, the

Borrower  will  not  appear  in  the  Record  list.  To  produce  such  reports,  see  List  of  Borrowers,  Creditors  or
Employers.

 Client list with the total principal amounts;
 Client list with balances on a certain day, total interest paid, total principal refunded for a specific period, etc.;
 Fees list;
 APR data;
 Returned check list;
 Late and unpaid payments list; 
 Bad debt reports;
 Loan guarantees (securities) reports; 
 Use one of the customized "Borrower" fields to create a report of client industries, loan type, fund, etc.;
 Participation loans report;
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 Ageing of accounts;
 Etc.

This report also allows, for multi-currency portfolios, converting multi-currency values to one or many other currencies.

Creating a report template

Producing a report

 Convert to other currencies
 Time required to produce a report

Modifying a report template

Exporting monthly interest, fees, principal and balance data to third party accounting software

Copy, rename and delete existing report templates

Creating a report template

In the Main MLM window, click on Reports > Personalized Reports > Record List. The following window will appear:

Press on "New" and the window below will appear. This allows you to select fields one by one by highlighting (one click)

then clicking on the arrow , or by double-clicking on the desired field (under the "All" tab or in each of the thematic
tabs). The report will include as many columns as there are selected fields.

Each of these fields is described in detail in the Reporting Fields chapter and upon clicking  in MLM. The last theme,
called "Equations" are Mathematical Equations that the Administrator and the Power users can create in order to add,
subtract, multiply and divide fields together.
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You can determine the report column order in this window (in the "Report Fields" section on the right) by highlighting the
field you wish to move and by using the arrows to the right (see also Displayed column selection and order in the Record
Summary Window chapter).

It is also possible to remove a field by selecting it and clicking on the arrow  in the center of the window.

Field titles will appear in the report column headings in the report. If necessary, and for greater clarity, these headers can
be changed by highlighting the default title and by changing it.

In the example below, all the original titles have been modified including the name of the column in the report for the
Borrower's  address.  It  was  changed  from the  original  title  (name  in  the  software)  "Borrower  -  Address  1"  for  a  much
shorter description, the user's choice, "Addr.".

Once the fields have been chosen and ordered as desired, a name must be given to the report (at the bottom left of the
window).
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The "Save" button will return to the "Custom Reports" window. 

Producing a report

For Record selection (Records to be included), four options are available:

1. All Records;

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

2. All Records displayed in the Main Margill window (Record Summary window);

3. Records selected in the Main Margill window (Record Summary window): select (highlight) the desired Records in the
Main  MLM  window  (Record  summary).  To  do  so,  you  can  sort  the  Records  as  you  see  fit,  display  some  with  the
display  filters  or  select  them all  with  the  CTRL-A  key.  The  results  order  will  be  in  the  same as  the  selection  order
made in  the  Main  window.  The  first  Record  chosen  (with  a  mouse  click,  for  example),  will  be  the  first  line  of  the
report, and so on.

4. Records from Advanced Query.

You must now choose among the options in this window.

 Include or not all selected/queried Records no matter the date(s) : Normally Records that begin after the end date of
a Report, or are completed before the start date of a Report (payment date of the last line) are not included in the
final  results.  By  checking  this  option,  all  selected  Records  will  be  included  in  the  final  results  even  if  no  data  is
available for the chosen reporting period.

 1) Full report, 2) up to a specific date or 3) between 2 dates.
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 Report end-date method: three methods are available to include or exclude interest and transactions that may occur
on the reporting end date specified. This can be important depending on the end-date entered. For a report up to
December 31 for example, the last day's transactions and interest should generally be included. 

For a report up to January 1 (thus the start of the next period), if that day's transaction is to be included but not the
interest  on  that  day,  then  the  second  option  should  be  chosen  ("Include  last  day's  transactions").  Ideally  though,
with a date at the start of the next reporting period, the first option should be chosen ("Exclude last day's interest")
so as not to include any data from the next reporting period (avoid double accounting).

Please note: a Record is considered to be completely terminated on the last line's "Pmt Date" at 0:00:01 (so at 0:00
in the morning plus a fraction of a second to allow the last payment to be made). Thus, if a report end date is equal
to  or  after  the  Record  termination  date,  all  three  "End  date  method"  choices  will  yield  the  same  data  for  this
particular Record and no interest will be included for the Record's last day. It is suggested for lines of credit or loans
with no true end date set, to enter a distant date (e.g. 01/01/2025), so that the loan is not considered finished on the
last line and continues to generate interest. More accurate projections can thus be made.

 Convert  to  other  currencies:  This  report  also  allows,  for  multi-currency  portfolios,  to  convert  the  multi-currency
values to one or  many other currencies. First,  the Administrator must activate the multi-currency module through
Tools  >  Settings  >  System  settings  (Administrators)  >  Modules  >  Currencies  and  by  selecting  "Activate
"Multi-Currency" module (Administrator only)".

When converting in  the report,  the following choice will  appear with a  pull  down menu of  the  currencies  in  MLM
(other currencies may be added and some deleted - see the Multi Currency section).

No matter which currency was used in the Record, the report will  be produced with the selected currency (USD in
the  above  example)  using  the  conversion  factor.  The  report  may  be  created  in  any  currency,  not  only  the  base
currency (factor = 1). 

In order to differentiate between various currencies (useful when the report is produced in multiple currencies) MLM
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will  automatically  add  a  first  column  with  the  currency  symbol  (this  column  may  be  deleted  in  the  TXT  and  CSV
saving settings).

Press on "Create Report"  that will preview the report.

You  can  adjust  the  column  width  by  placing  the  mouse  over  the  line  separating  columns  and  dragging  the  icon  that
appears. The width does not matter when the data is exported to Excel or other software.

You can sort the data by any report field excluding the special "All Creditors" fields. This can be useful in order to organize
the data before exporting to another software. For example, sort the Borrowers by alphabetical order:
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Once  a  first  sort  is  done,  it  is  possible  to  do  as  many  as  desired.  You  can  then  generate  multiple  reports  containing
different sorts from the same report.

In addition to sorting, you can add sub-totals based on fields. By checking the "Sub-totals by:" box, sub-total lines will be
added  to  the  report  according  to  the  desired  field  that  must  necessarily  be  included  in  the  report.  Results  will  be
displayed  in  ascending  or  descending  order  (alphabetical  or  numerical).  Currency  fields  are  excluded  from  sorting  by
sub-totals because the display is in text format and cannot properly be managed.

When a numerical (or money) field has been selected, the "Show Totals" option appears at the bottom of the window to
display a  total  on the last  line of  numerical  (and money)  columns in  the  report.  Beware,  however,  of  the  relevance of
these  totals  or  sub-totals  in  the  case  of  a  report  where  loans  are  multi-currency.  See  the  Convert  to  other  currencies
section above.

In the following example, the report results are grouped by ascending "Record Type" and sub-totals will be generated for
all of the columns containing values that can be added up.

The second sort sorts the data by the desired field within the sub-totals category. In the following example, in addition to
regrouping by "Record type",  the results are then sorted by alphabetical  order based on the  Borrower's  name.  Also,  a
grand total can be included by clicking on the "Show Totals" button. The pale gray lines represent the sub-totals and the
last darker line represents that grand total:
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Please note that depending on which sub-total field is used, some scenarios could lead to sub-totals offering very little
value.

Tip: You can generate multiple reports containing different sub-totals from the same results. Export and save the report
according a  first  variable,  then sort  again  according to  another  variable  and  export.  The  "Show sub-totals"  and  "Show
totals" button will respectively become "Hide sub-totals" and "Hide totals" in order to let you go back. 

To save the report generated, select the format to which you wish to save the report by clicking on the "Export" button:
Excel sheet (.XLSX), Text file (.TXT) or CSV format (.CSV): 

Choosing "Save as Text File" or "Save as CSV File" will  open up the Windows dialog box allowing you to first  name the
report and then specify other options for formatting: field (column) separator, whether a currency symbol is to be used
or not  and the date format (some third party systems require a  date format not  divided by any symbols).  Most often,
currency symbols should not be used when exporting to third party software.
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In Excel, it will open the dialogue box below.  In order to obtain a number that is a true number (as opposed to a text
format), it is recommended to export without the currency symbol.

You can then open the report (and adapt if need be) and print or export. Text files (.TXT) are often messy since the widths
of the data columns may not  be the same and the headers may be  of  various  widths  too.  To  print  a  clean report  you
should manually add tabs to align the columns. Printing in a spreadsheet is usually handier. 

A  spreadsheet  is  also  included  under  the  "Spreadsheet"  tab  which  allows  users  to  perform  some  basic  spreadsheet
operations (the tool is not as sophisticated as Excel). This is very useful to copy/paste partial data to Excel or other.
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Time required to produce a report

See the special section to this effect: "Time required to produce reports".

Modifying a report template

An existing report  (template)  may be  modified  or  saved  under  a  different  name with  only  a  few changes.  Choose  the
desired report and click on "Edit". Changes may then be made as explained in the "Creating a report template" section
above.

In MLM multi-user environments, users other than Administrators (and Privileged users) cannot modify reports created
by  another  user.  The "owner" of  the  report  appears  in  the  second column of  the  main  report  window (this  column  is
hidden by default).

A normal user or a read-only user can view the report but cannot change it. It is also possible for the user to select the
report, click the right mouse button and copy it. He then becomes owner of this new report. 

Exporting monthly interest, fees, principal and balance data to third party accounting software

This report can be used to generate totals for transactions for a specified period (usually one month) but does not allow
identification of  the  transactions and  corresponding dates  as  such.   Hence the  use of  the  "Accounting Entries"  report,
specifically  designed  for  accounting.  "Accounting  Entries"  report  allows  Exporting  accounting  transactions  (debits  and
credits) to the General ledger. The Transaction Report is also used to obtain transactional data.
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Copy, rename and delete existing report templates

To copy, rename or delete an existing custom report, select the desired report and right click on the mouse. Choose the
required action.

See also, Record List with Period Breaks, mostly used for financial forecasts.

   

Record List with Period Breaks

The "Record List with Period Breaks" is generally used to prepare financial forecasts. It splits monetary data into annual,
quarterly or monthly periods according to your needs. Over 215 fields can be reported split by period.

Reports  can  produce totals  up  to  the  end  of  each  Record  or  include  totals  up  to  a  specific  date  or  between dates.  In
addition,  they will  be  split  as  needed:  monthly,  semi-annually,  annually  or  without  any  fraction (only  according to  the
specified dates), while specifying the first day of the period and / or month.
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The  reports  produce  either  Text  files  (.TXT),  Comma-separated  value  files  (.CSV)  or  Excel  (XLS)  spreadsheets  that  may
then be organized or exported to third-party software. A spreadsheet is also included under the "Spreadsheet" tab. 

In fact, you may produce a countless number of reports such as:

 Interest income forecast;
 Principal refund forecast;
 Summary of overdue payments;
 Results analysis;
 Etc.

This  report  also  allows,  for  multi-currency portfolios,  the  conversion  of  multi-currency  amounts  to  one  or  many  other
currencies.

Creating a report template

Producing a report

 Report subtleties
 Convert to other currencies
 Time required to produce a report

Modifying a report template

Exporting monthly interest, fees, principal and balance data to third party accounting software

Copy, rename and delete existing report templates
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Creating a report template

In  the  Main  MLM  window,  click  on  Reports  >  Personalized  Reports  >  Record  List  with  period  Breaks.  Reports  created
using the "Record List" and "Record List with Period Breaks" are grouped together in the same list. The following window
will appear:

Press on "New" and the window below will appear. This allows you to select fields one by one by highlighting (one click)

then clicking on the arrow , or by double-clicking on the desired field (under the "All" tab or in each of the tabs in
which  fields  are  displayed  by  theme).  The  report  will  include  as  many  columns  as  there  are  selected  fields.  Fields
highlighted in olive green are fields that can be split monthly, quarterly or annually. If fields not highlighted in olive green
are selected for the report, the data will simply be reported without providing periodic amounts.
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In the example below, the Borrower name is simply reported, while the "Due Pmt (for period)" field is split monthly, since
it is one of the fields highlighted in olive green.

Each of these fields is described in detail in the Reporting Fields chapter and with a mouse-over the field in the software
itself.  The last  theme,  called "Equations"  are  Mathematical  Equations  that  the  Administrator  and  the  Power users  can
create in order to add, subtract, multiply and divide fields together.

You can determine the report column order in this window (in the "Report Fields" section on the right) by highlighting the
field you wish to move and by using the arrows to the right.

It is also possible to remove a field by selecting it and clicking on the arrow  in the center of the window.

Field titles will appear in the report column headings in the report. If necessary, these header names can be changed by
highlighting the default title and by changing it.

In the example below, all the original titles have been modified including the name of the column in the report for the
Borrower's  address.  It  was  changed  from the  original  title  (name  in  the  software)  "Borrower  -  Address  1"  for  a  much
shorter description, the user's choice, "Addr.".

Once the fields have been chosen and ordered as desired, a name must be given to the report (at the bottom left of the
window).

The "Save" button will return to the "Custom Reports" window. 
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Producing a report

For selecting Records (Records to be included in the report), four options are available:

1. All Records;

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

2. All Records displayed in the Main Margill window (Record Summary window);

3. Records selected in the Main Margill window (Record Summary window): select (highlight) the desired Records in the
Main  MLM  window  (Record  summary).  To  do  so,  you  can  sort  the  Records  as  you  see  fit,  display  some  with  the
display  filters  or  select  them all  with  the  CTRL-A  key.  The  results  order  will  be  in  the  same as  the  selection  order
made in  the  Main  window.  The  first  Record  chosen  (with  a  mouse  click,  for  example),  will  be  the  first  line  of  the
report, and so on.

4. Records from Advanced Query.

You must now choose among the options in this window.

 Include or not all selected/queried Records no matter the date(s) : Normally Records that begin after the end date of
a Report, or are completed before the start date of a Report (payment date of the last line) are not included in the
final  results.  By  checking  this  option,  all  selected  Records  will  be  included  in  the  final  results  even  if  no  data  is
available for the chosen reporting period.

 1) Full report, 2) up to a specific date or 3) between 2 dates.
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 Report end-date method: three methods are available to include or exclude interest and transactions that may occur
on the reporting end date specified. This can be important depending on the end-date entered. For a report up to
December 31 for  example,  the  last  day's  transactions and  interest  should  generally  be  included.   However,  a  split
period always includes the end date. For example, if the start of the period is the first day of the month, the end date
will  always  be  included  for  split  periods  regardless  of  the  report  end  date  selection  method.  The  inclusion  or
exclusion method for  interest  and  /  or  transactions applies  only  at  the  end  of  the  full  period  and  not  to  the  split
period.

Please note: a Record is considered to be completely terminated on the last line's "Pmt Date" at 0:00:01 (so at 0:00
in the morning plus a fraction of a second to allow the last payment to be made). Thus, if a report end date is equal
to  or  after  the  Record  termination  date,  all  three  "End  date  method"  choices  will  yield  the  same  data  for  this
particular Record and no interest will be included for the Record's last day. It is suggested for lines of credit or loans
with no true end date set, to enter a date in the future (e.g. 01/01/2030), so that the loan is not considered finished
on the last line and continues to generate interest. More accurate projections can thus be made.

 Split period: Four options are available for report production. 1) None, 2) Monthly, 3) Quarterly or 4) Annually.

It is also possible to specify:

o The first day of the period:

o The actual month in which such period begins:
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You can also calculate totals by period according to the beginning of your fiscal year and even a financial year (rare)
that would start not on the 1st of the month, but on any other date.

 Report subtleties:

1) The term "Summary" below provides the result according to the report dates, not according to the sum of the
periods. There may also be a few cents difference due to rounding by period.

Warning!  When  the  field  name  includes  "Report  End  Date"  or  "Report  Start  Date",  MLM  does  not  add  the
individual  amounts  then  report  the  sum  in  the  Summary,  rather  it  gives  us  the  logical  result  based  on  the
requested  data.  In  the  example  below,  for  the  column  named  "Outstanding  -  Payment  (Balance)  Report  End
Date", the amount reported in the "Summary" line corresponds to the balance at the report end date. It does not
add the balances at the end of each month, but rather displays the final balance at the end of the report. The
same principle applies for the "Outstanding - Payment (Balance) Report Start Date". The balance reported on the
summary line is that of the first balance.

Once a numerical (or monetary) field has been selected, the "Show totals" option appears at the bottom of the
window,  displaying  the  total  on  the  last  line  of  a  numerical  (and monetary)  column of  the  report.  Be  careful,
however, as to the relevance of these totals. These results can be deceiving when Equations are improperly used
or when the loans are multi-currency.

In other cases, when relevant, as in the example below, for the "Paid Payment" field, the Summary is an addition
of all periods, per Record:
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2) This report compiles the results in four different ways. The results can be presented horizontally or vertically
in detail (Record by Record) or as a summary.

In the examples below, the report includes four Records, two production fields, and the selected monthly split
period for three months.

For  "Detail  -  Horizontal",  the  lines
represent  each  of  the  Records  that  were
selected  in  the  Main  window  and  the
columns are displayed per month.
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For  the  "Detail  -  Vertical",  each  of  the
Records  is  separated  monthly  and
contains a summary for each of the fields.
Only  the  data  from  the  "Summary"  lines
are  added  in  the  total  displayed  in  dark
gray at the bottom of the report (Total).

For  the  "Summary -  Horizontal",  the  data
is  simply  broken  down  in  columns  by
month for the fields.

For  the  "Summary  -  Vertical",  the  data  is
simply  broken  down  by  month  for  the
fields, but shown as lines.

 Mathematical Equations

Mathematical Equations are highlighted in green if one of the fields that is included in this Equation is a field that can
be split. Even if an Equation is highlighted in green, the totals calculated by period may not be logical. For example, if
the “Principal (Original)” field is used and added to the “Additional Principal” Line status field, the Original Principal
will appear every month making this monthly (or other) amount false. 

If  on  the  other  hand,  the  “Principal  (Original)(for  period)”  field  is  used  and  added  the  “Additional  Principal”  Line
status field, then the “Principal (Original)(for period)” will only appear in the month at which it was really advanced
(at the Origination Date) and never again.

 Convert  to  other  currencies:  This  report  also  allows,  for  multi-currency  portfolios,  to  convert  the  multi-currency
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values to one or  many other currencies. First,  the Administrator must activate the multi-currency module through
Tools  >  Settings  >  System  settings  (Administrators)  >  Modules  >  Currencies  and  by  selecting  "Activate
"Multi-Currency" module (Administrator only)".

When converting in the report, the following choice will appear with a pull down menu with the currencies in MLM
(other currencies may be added and some deleted - see the Multi Currency section).

No matter which currency was used in the Record, the report will  be produced with the selected currency (USD in
the  above  example)  using  the  conversion  factor.  The  report  may  be  created  in  any  currency,  not  only  the  base
currency (factor = 1). 

In order to differentiate between various currencies (useful when the report is produced in multiple currencies) MLM
will automatically add a first column with the currency symbol (this column may be excluded when saving the file).

Only  previously  highlighted  Records  in  the  "Record  Summary"  window  will  be  included  in  the  report.  Press  on

"Create Report"  that will preview the report.

You can adjust the column width by placing the mouse over the line separating columns and dragging the icon that
appears.

The width does not matter when the data is exported to Excel or other software.

Select  the  format  in  which  to  save  the  report:  Text  files  (.TXT),  Comma-separated  values  (.CSV)  or  Excel  (.XLSX)
spreadsheets.



Page 986

© Jurismedia Inc., 2007- 2023

When a  numerical  (or  monetary)  field  has  been  selected,  the  "Show Totals"  option  appears  at  the  bottom  of  the
window to display a total on the last line of numerical (and monetary) columns in the report. Beware, however, of
the relevance of  these totals  in  the case of  a  report  when multi-currencies are included.  See the Convert to other
currencies section above.

"Save as Text File" or "Save as CSV File" options will open up a dialog box allowing you to first name the report and
then specify other formatting options: field (column) separator, whether a currency symbol is to be used or not and
the date format (some third party systems require a date format not divided by any symbols). Most often, currency
symbols should not be used when exporting to third party software.
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In Excel, the dialogue box below will appear. In order to obtain a number that is a true number (as opposed to a text
format), it is recommended to export without the currency symbol.

You can then open the report (and adapt if need be) and print or export. Text files (.TXT) are often messy since the
widths of  the data columns may not  be the same and the headers may be of  various widths too.  To  print  a  clean
report you should manually add tabs to align the columns. Printing in a spreadsheet is usually handier. 

A spreadsheet is also included under the "Spreadsheet" tab which allows users to perform some basic spreadsheet
operations (the tool is not as sophisticated as Excel). This is very useful to copy/paste partial data to Excel or other.

 

 Time required to produce a report

Note  that  this  complex  calculation  /  report  can  take  several  MINUTES  (not  seconds)  depending  on  the  number
Records, fields and periods in the report, its start and end dates, and the speed of your computer. It is preferable to
group a few fields into several reports, rather than to produce one very large report. A gauge appears at the bottom
of the window to show the report's progression. It is always possible to use the ALT + C keys to cancel the report.

Modifying a report template

An existing report  (template)  may be  modified  or  saved  under  a  different  name with  only  a  few changes.  Choose  the
desired report and click on "Edit". Changes may then be made as explained in the "Creating a report template" section
above.

In MLM multi-user environments, users other than Administrators (and Privileged users) cannot modify reports created
by  another  user.  The "owner" of  the  report  appears  in  the  second column of  the  main  report  window (this  column  is
hidden by default).
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A normal user or a read-only user can view the report but cannot change it. It is also possible for the user to select the
report, click the right mouse button and copy it. He then becomes owner of this new report. 

Exporting monthly interest, fees, principal and balance data to third party accounting software

This report can be used to generate totals for transactions for a specified period (usually one month) but does not allow
identification  of  the  transactions  and  corresponding  dates  as  such.  Hence  the  use  of  the  "Accounting  Entries"  report,
specifically designed for accounting. "Accounting Entries" report allows the export of accounting transactions (debits and
credits) to the General ledger. The Transaction Report is also used to obtain data as transactions (dates and amounts).

Copy, rename and delete existing report templates

To copy, rename or delete an existing custom report, select the desired report and right click on the mouse. Choose the
required action.

   

Transaction Report

The  Transaction  Report  will  list  the  desired  transactions  for  all  of  the  Records  selected  in  the  Margill  Loan  Manager
(MLM) Record Summary window (Main window). A transaction is essentially any payment or amount calculated following
this payment on a specific date in the Payment schedule. 

Transaction examples:

 Payment amount
 Balances
 Accrued interest
 Paid Interest
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 Paid Principal
 Fees charged or paid
 Transactions  that  have  no  effet  on  the  Payment  schedule  (Information  columns)  but  that  may  be  required  for

accounting
 etc.

This  report  can  recreate  Payment  schedule  for  multiple  Records  in  one  report,  exactly  as  a  user  desires  for  a  specific
period of time. You can include:

 only the necessary Payment schedule columns (Payment Date,  Payment amount,  Comment, Paid Interest,  Column
Fee, etc.)

 only some Line statuses (Paid pmt, Paid Pmt Returned Check, Additional Principal, Fees, etc.)
 any other field pertaining to the Record (Record number, Borrower name, custom fields, etc.)

You could produce a report, for example, that would:

 list all and only "Additional Principal" Line statuses for a number of Records and for a specified period of time;

 list all dates and amounts of all Paid Payments, Special Payments ("Visa Paid Pmt" for example);

 list  all  Returned checks  or  Returned checks  that  were subsequently  paid  along with  the  check number  (and other
check related data).

 
These transactions can then be exported to Excel, CSV or TXT and imported into third-party software such as accounting
packages.



Page 990

© Jurismedia Inc., 2007- 2023

Creating a report template

Producing a report

 Convert to other currencies
 Time required to produce a report

Modifying a report template

Copy, rename and delete existing report templates

Creating a report template

Go to Reports > Personalized Reports > Transaction Report:

To create a report template, click on "New". The following window will appear with, boxed in red, the data that is to be
included in the report. On the left one finds data fields classified by theme as well as Transaction-type data fields. On the
top right, in the red box are the various Line statuses to be included in the report. One could only wish to show the Paid
payments and exclude any other type of Line statuses. 
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To add a field from the left side of the table to your report, simply select it and click on the arrow pointing to the right

,  or  double-click on the field itself  to include it.  To delete a  field from the report,  select it  and click on the arrow

pointing to the left .

To include or delete Line statuses that are at the top right side of the table, you can:

1. Select fields one by one by highlighting them and clicking on: "Select / Deselect"
2. Select all Line statuses
3. Deselect all

The Line statuses do not appear in the Report Fields but one can see which are included since they will be checked 
.

The report will include as many columns as there are Fields and Transaction Data in the "Report Fields" section. 

The Report Fields that can be included in the report are of two types:

• Transaction Data

• Information Data (included by theme below the "Transaction Data" button)

"Transaction Data" are all  the columns (73 in  all)  in  the Payment schedule.  These usually  are amounts but  can include
dates  and  comments  entered  in  the  Payment  schedule.  These  usually  change  as  the  date  changes.  For  example,  a
payment amount or a balance may/will change as the date changes.
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"Information Data" will be the same, no matter which date is entered in the report. For example, if the Borrower's name
is included in the report, it never changes, no matter the transaction date. Other example: The same applies for the Final
Balance  –  the  amount  of  the  last  line  of  the  Payment  schedule  will  be  reported  for  all  transaction  dates  (so  not  very
valuable data for this report).

If Information Data is included in a report, it will be repeated for all transaction lines, whereas the Transaction Data will
be reported based on what is contained in the Payment schedule.

The box below illustrates various example of the reports that can be produced. Keep in mind that a report could easily
include hundreds of columns and thousands upon thousands of lines when multiple Line statuses and reporting fields are
used.

Report Setup: Resulting report:

Will  only  show,  for  all  Records  selected,  lines  (transactions)  whose
Line  status  is  "Paid  Pmt"  and  will  show  that  actual  Line  status,  the
Payment  date,  the  payment  amount  and  Borrower  first  and  last
names.

Notice the Report fields names may
be changed to your liking

Will only show lines in which Additional principal was added. 

The line's interest rate, the balance and the Borrower's business name
and the loan Origination date will also be shown.
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Will show returned checks and payments that compensated for these
unpaid checks. Fields are added to obtain the check number, date of
returned check etc.

Consult  the  Returned  Checks  chapter  under  "Commonly  required
reports" for more detail on this module.

Will  only  show  transactions  in  which  Attorney  Fees  were  charged
(custom Line status name) and Paid.

We  also  added  the  MLM  Identification  (the  system's  reference
number) and the Comment column.

Will  show  all  upcoming  payments  for  the  month  of  August  2016
including the total due for that month.
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Producing a report

For selecting Records (Records included in the report), four options are available:

1. All Records;

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

2. All Records displayed in the Main Margill window (Record Summary window);

3. Records selected in the Main Margill window (Record Summary window): select (highlight) the desired Records in the
Main  MLM  window  (Record  summary).  To  do  so,  you  can  sort  the  Records  as  you  see  fit,  display  some  with  the
display  filters  or  select  them all  with  the  CTRL-A  key.  The  results  order  will  be  in  the  same as  the  selection  order
made in  the  Main  window.  The  first  Record  chosen  (with  a  mouse  click,  for  example),  will  be  the  first  line  of  the
report, and so on.

4. Records from Advanced Query.
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You must now choose among the date options:

1. Full report

2. Report up to a specific date, or 

3. Report between 2 dates.

 For  the  report  between  two  dates,  notice  that  if  the  same  date  is  entered  in  the  "from"  and  "to"  dates,  only
transactions on this day will be reported. Entering the same "from" and "to" dates is usually not permitted in other
reports.

The second section, "Reference Date from Payment schedule" allows you to choose which date is to be used to extract
the proper lines from the Payment schedules. 

Up to four Reference Dates are available:
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1. Payment Date – this is the most commonly used date for this report and is based on the date contained in the "Pmt
Date"  column of the Payment schedule.

By default in this report, if a date is entered in the "True Pmt Date (Grace/EFT)" column, this date will be used as the
transaction date as opposed to the date in the "Payment Date" column for all "Paid" type transactions. The "Ignore
True Payment Date (Grace/EFT) option allows to override this rule by ignoring the date entered in "True Pmt Date
(Grace/EFT)" for all Line statuses.

Example:

o Line 108 is Payment type line
o Line 109 is not a Payment type line
o Line 110 is not a Payment type line

The four options and resulting reports are produced below.

i) Report with the Payment date when the "Ignore" option is not checked:

Report  picks  up  the  non  Payment  type  lines  since  by  default  these  are  ignored  even  without  the  "Ignore"  option
checked. The reason behind this,  logically,  the  Grace date  should  only  be  used for  "Payment"  type lines  since the
reason behind Grace is not to charge extra interest when a payment is slightly late. For all  other Line statuses, the
Grace date should ideally be empty.
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Paid Pmt takes 06/20 as transaction date so excluded from 06/15 report

ii) When the "Ignore" option is checked, all three transactions on 6/15 are shown since Grace date is ignore for ALL
Line statuses.

All transactions are on 06/15

iii) When the  report date is the Grace date and the "Ignore" option is not checked, then only the Paid Payment is
included in the report since Grace dates are not logical for the other Line statuses. Payment types Line statuses use
the Grace date by default as the transaction date.
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Only Paid Pmt shows up on Grace Date

iv)  When  the  "Ignore"  option  is  checked,  then  the  system  will  ignore  the  date  in  the  Grace  column  and  so
transactions are on the 15th, not the 20th so nothing shows up in the report.

No transactions on  06/20

2. Payment Due Date – if this date is chosen, only transactions with a date entered in the "Pmt Due Date" column and
that are within the report date range will be included. This is mostly used for late payments.
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3. Date  of  Returned Check  –  will  only  appear  if  the  "Returned Checks"  module  is  activated.  Only  transactions  with  a
date entered in the "Date of Returned Check" column and that are within the report date range will be included. 

The purpose of using this date is usually to report the amounts that should have been paid ("Expect. Pmt" column)
 as well as the check numbers for returned checks.

4. Date of Compensatory Payment for returned check  - will only appear if the "Returned Checks" module is activated.
Only  transactions with  a  date  entered in  the  "Date of  Compensatory Pmt"  column and that  are  within  the  report
date range will be included. 

The purpose of using this date type is usually to report the amounts that compensated the returned checks at these
dates.

5. True Pmt Date (Grace/EFT)

This option will simply use the  date entered in the True Pmt Date (Grace/EFT) column.

What does a light yellow highlighted Data mean when generating a transaction Report?

Data are highlighted in light yellow to indicate that a date is entered in the "True Pmt Date (Grace/EFT)" column.

Important: If a date is entered in the "True Pmt Date (Grace/EFT)" column, this date will be used as opposed to the
date in the "Pmt Date" column for all "Paid" payments.

Transaction Report example (all "Paid" Payments):
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In the report preview, you will have the option to display column totals that include monetary values with this "Show /
Hide totals" button.

A  spreadsheet  is  also  included  under  the  "Spreadsheet"  tab  which  allows  users  to  perform  some  basic  spreadsheet
operations (the tool is not as sophisticated as Excel). This is very useful to copy/paste partial data to Excel or other.

Convert to other currencies: This report also allows, for multi-currency portfolios, to convert the multi-currency values to
one or many other currencies. First, the Administrator must activate the multi-currency module through Tools > Settings
>  System  settings  (Administrators)  >  Modules  >  Currencies  and  by  selecting  "Activate  "Multi  Currency"  module
(Administrator only)".

When converting in the report, the following choice will appear with a pull down menu of the currencies in MLM (other
currencies may be added and some deleted - see the Multi Currency section).
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No matter which currency was used in the Record, the report will  be produced with the selected currency (USD in the
above  example)  using  the  conversion  factor.  The  report  may  be  created  in  any  currency,  not  only  the  base  currency
(factor = 1). 

In order to differentiate between various currencies (useful when the report is produced in multiple currencies) MLM will
automatically  add  a  first  column  with  the  currency  symbol  (this  column  may  be  deleted  in  the  TXT  and  CSV  saving
settings).

Time required to produce a report

See the special section to this effect: "Time required to produce reports".

Modifying a report template

An existing report  (template)  may be  modified  or  saved  under  a  different  name with  only  a  few changes.  Choose  the
desired report and click on "Edit". Changes may then be made as explained in the "Creating a report template" section
above.

In MLM multi-user environments, users other than Administrators (and Privileged users) cannot modify reports created
by  another  user.  The "owner" of  the  report  appears  in  the  second column of  the  main  report  window (this  column  is
hidden by default).

A normal user or a read-only user can view the report but cannot change it. It is also possible for the user to select the
report, click the right mouse button and copy it. He then becomes owner of this new report. 



Page 1002

© Jurismedia Inc., 2007- 2023

Copy, rename and delete existing report templates

To copy, rename or delete an existing custom report, select the desired report and right click on the mouse. Choose the
required action.

   

Document Merge (Letters, Contracts, Invoices and Statements)

The Document Merge module allows you to send personalized documents such as invoices, statements, letters, contracts
and emails to your customers. Merge is done from the templates previously created by the user. The merge to includes
and optional  report  start  date and an end date in  order for  the totals  to be computed for  this  period.  Here are  a  few
invoices and statement examples:

 an invoice for the payment to be made next month, 
 a statement for payment and interest of the previous month, 
 for tax returns, interests paid for the year, 
 balance and other annual totals

You  can  use  your  own  custom  templates  and  include  information  or  data  from  more  than  1000  fields  included  or
computed in Margill Loan Manager (MLM), in addition to the Custom fields and Mathematical Equations.

Easy steps to create invoices and statements:

Create a personalized template. See Mail Merge / Templates

Reporting period for invoices and statements

Producing a report

Direct printing from a Record

Printing on pre-printed forms
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Create a personalized template

The first  step is  to  create your  own invoice,  statement or  email  with  the  MLM  text  editor,   use  and  adapt  one  of  the
examples included, copy/paste or import a document previously created in a third-party word processor, ideally Word.

See Mail Merge / Templates to create a template.

Reporting period for invoices and statements

General concept

The Document Merge tool  to produce contracts,  letters,  statements and  invoices can  report  data  not  only  for  one set
period  of  time (as  in  the  older  MLM  versions)  but  also  for  various  periods.  For  example,  an  invoice/  statement  could
include the interest Paid (or Accrued) from June 1 to June 30 but also the total interest paid from the start of the civil
year (year-to-date) or from the very start of the loan. 

Users can create sophisticated merge templates that can be used over and over. Initially,  creating these templates can
take significant time especially for complicated documents. Various examples are included and can be adapted to each
situation.

It  is  essential  that  the Payment schedule be up to date (managed) at  the time of  invoicing.  The "Due Pmt"  Line  status
should never be in the past, only in the future.

When creating the template

Merge codes are inserted by double clicking on the desired field on the left side of the window or with the right mouse
click  ("Merge/Email  Template"  under  Reports).  Two  types  of  merge  codes  can  be  used:  a  long  code  which  is  more
descriptive or a short code which takes less space, especially in table format templates. Using the short code only makes
template conception easier.

The user can include merge fields in the same template for four periods. To do so, the user will have to choose the right
option, from the drop-down menu located above the list of available fields (or via the mouse right-click button).
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Only the relevant fields are available for the last three periods (the fields that are not available are grayed-out) and only
the short codes (less descriptive) have been included.

1) Current reporting period: whole duration of the loan or Billing period (often one month)(example of short merge code
: |123| or long code &&Description&&))

2) One period preceding Billing period (often the previous month)(merge code: P123P)

3) Year-to-date to the start of the Billing period (merge code: Y123Y)

4) Origination date to the start of the Billing period (merge code: O123O)

Only  pertinent  reporting  fields  have  been  included  for  the  three  latter  time  periods  (2,3,4)  and  only  the  Short  (less
descriptive) codes have been included.

The payment lines (payment schedule)(under the "General" theme) have also been included in order to report activity for
any past period and for the T=0 period (see previous image).

Please note that billing can become complex. It is therefore recommended to try several payment scenarios.

The "Mathematical Equations" module is a powerful tool in order to add (subtract,  multiply,  etc.)  up various amounts.
For example: Total due = Next due payment amount + Outstanding amount + Fees.
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See Merge / Email Template for more detail.

Report production

The user can choose to produce a report that does not take into account dates (full report) or that takes into account the
desired dates in order to get the totals of balances between, or on these dates:

1) Full report :

The user can create a report for which dates are not important since no totals or balances are required for a specific time
period within the loan. The initial contract, a letter containing the loan conditions, general letters, a card index, etc., are
typical examples of a Full report.

Specific time periods :

For invoices, statements and reminder letters, the user can choose specific dates to include transactions for this period,
amounts, totals and balances for any of the following periods:

 Current Billing period (T=0)
 One period preceding Billing period (T=-1)
 Year-to-date to the start of the Billing period
 Origination date to the start of the Billing period

There are two standard scenarios for invoices and statements :

a)  Statements  that  only  reflect  past  transactions  (called  “Current”  Billing  period  above  although  becomes  past  at  this
point). These include income tax statements for the past fiscal year for example. These simply report for a specific period
known as T=0 in the diagram above. Usually, there is no need to add other time periods such as year-to-date since we
only wish to reflect activity for a past fixed period.

b) Invoices or Bills to show what amounts are past due and are TO BE paid. These are also often called Statements since
they  not  only  reflect  what  payments  are  coming  up,  but  also  include  past  activity.  So  they  are  a  mix  between  an
Invoice/Bill  and  a  Statement.  These are  usually  sent  a  few days  before the  next  payment  is  due,  as  a  reminder to  the
borrower to make the payment or to make sure the funds are available for EFT payments sent via Margill.

These are sent a few days before what is called the Report start date of the T=0 period. In this scenario (as opposed to
past transaction statements as in a) above), payments in the T=0 period have not yet been paid so are Expected – most of
the time they are “Due Pmt” Line statuses. In these statements, fields such as “Next Due Pmt” (Date and Amount)  or “
Next Due Pmt Interest as if paid” or “Principal as if Paid…” would be used.

Please take note that when the merge codes like "Origination date to current period report start date" (merge codes with
"O") are used, "0.00" value will always be reported for fields whose name includes "... at 0:00 at report Start Date (before
transaction on that day)", since these refer to non-existent data BEFORE the loan is even active. These fields have been
kept in this category in order to maintain uniformity in MLM in the list of fields available by period.
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Billing cycles:

Billing  cycles  (based  on  payment  schedule  payment  dates)  or  calendar  month  billing  could  be  used  in  Margill.  Billing
cycles would be used only if there were one to three cycles per month (for example, billing on the 5th, 10th and 15th of the
month). If there are multiple billing cycles per month, or if payments are scheduled on any day of the month, then it is
recommended to do calendar month billing in order to reduce the administrative time required to send out statements.
One statement could be sent a few days before the first day of next month. This becomes even more efficient with batch
billing by email with an attached PDF document directly in Margill.

If billing cycles are used, it is recommended to create a Custom field for the Record with a scroll menu. This will allow you
to select the proper Records from the Main window for invoicing or  via  Advanced Queries.  The reporting  period (T=0)
would then be for payments on the 5th of the month, for example, from the 5th to the 4th (inclusively) of the next month.
This would compute interest, fees, principal, balances, etc., for that period as opposed to calendar month data which in
most cases will not align with payment/billing cycles (accrued interest from the 5th to the 4th at midnight is usually not
that from the 1st to the 31st of the month).

It is also possible to create recurring Record Alerts and to send invoices or statements through the Alerts window in MLM
by pressing the "Document Merge" button:
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Alerts display window

Producing a report

To produce a merged document, make sure you have previously created the required template(s). For more information
on how to create templates, see:  Mail Merge / Templates.  

Under Reports, click on Document Merge:

The following window will appear:
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Reports interface before version 5.0

Please take note that the old interface is still available with the shortcut: 
CTRL+ALT+SHIFT+R.

Important, this interface is no longer updated and therefore it is not recommended to use it.

Select the template from the templates list.

Choose one out of two (2) options:

1) Full report : full loan term (from origination date to the last payment)

2) Invoices and statements... (this is the T=0 period)
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If merge codes concerning previous period are included in the template, the user will be able to view (and modify)
the corresponding dates for the previous transactions.  For example:

3) Previous period from (date) (T= -1)
4) Year-to-date to current period start date
5) Origination date to current period report start date

By selecting the "More options for end date" check box, it will be possible to choose a method for the end of the report: 

 Three methods can be used to include or exclude interest and transactions that may occur on the end date entered.
This  could  be  important  depending  on  the  end  date  entered.  For  example,  for  a  report  up  to  December  31st,
transactions and interest of the last day should generally be included.

For a report up to January 1st (therefore including the start date of the following period) and if the transactions of
that day must be included, but not the interest of that day, the second option should be then be chosen ("Include
transactions of last day"). However, ideally, with a start date for the next period, the first option should be chosen
("Exclude transactions and interest of the last day"), in order to not include the data for the following period (avoid
double posting).

Please  note:  a  Record  is  considered  completely  closed  at  the  "Payment"  date  on  the  last  line  at  0:00:01  (so  at
midnight plus a fraction of a second to allow the last payment to be made). Thus if a report end date coincides with
or follows the end date of the Record, the three "Methods for report end date" will produce the same data for that
Record and no interest will be included for the last day of the Record. It is recommended in lines of credit or loans
without a real end date, to enter a distant date (for example 2025-01-01) so that the loan is not considered closed on
the last line and that it continues to generate interest. This way, more precise projections can be made. 

Choose which Records must be included in the Document merge:
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o All Records;

o All Records displayed in the Main Window (Record Summary window);

o Records selected in the Main Window (Record Summary window);

o Records from Advanced Query.

By selecting "Active Records only", MLM will produce a report with the Active Records only, so if Records with another
status are displayed or selected, MLM will ignore these for the Document merge.

When selecting the option "Include only Records WITH transactions within report dates", processing time will be shorter,
since MLM will only process Records with transactions during the requested period. A transaction is a line, regardless of
the Line  status  within  the  period covered.  For  example,  only  Records  with  transactions  between February  1st  and  29,
2020 will be generated if this box is checked.

You  can  obtain  a  preview of  transactions  and  Records  that  will  be  displayed  in  the  report  by  clicking  on  the  "Display
Records and transactions" button:
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Once the data is entered, click on . The following window
will offer various choices that are explained below.

First, choose a document format:   DOCX (Word),  a  word processing format that  can easily be modified or  PDF format,
which is not as easy to modify.
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When choosing the PDF format, you have 2 options: 

 If the "Create the document using Word" option is chosen, the document will  be produced using Word's functions
(versions 2007 and greater).

 If  the  option  is  not  chosen,  the  document  will  be  produced using  a  slightly  less  sophisticated algorithm offering a
layout which could be deficient in some cases.

Trial and experimentation is suggested depending on the complexity of your document's layout.

When hundreds or thousands of documents must be produced, it will take longer via Word since the software must be
opened (in background) and closed for each document. You can count approximately 6 to 10 seconds for each document
(for 100 Records, count 10 minutes).

The  clock  will  appear  during  processing,  prohibiting  any  other  operations  on  this  station.  Other  users  using  the  same
database can continue working with MLM normally.

Merge Options

1) Saving the document. When saving a report in DOCX or PDF format, three options are offered: 

 each letter, invoice or statement can be saved in its own file. It will bear the name you have given it followed by the
MLM  ID  number  in  order  to  easily  identify  it.  These  files  can  then  be  sent  by  email  for  example.  When  saving
individual files, it is suggested to create an easy to identify folder (for example - July 2020 Invoices) in which you will
put all of the files. A suffix can be added to each of the names created. Choose from the drop-down menu. The name
will become, for example, July 2020 Invoice Harrison_Paul_841.
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 all the invoices and statements can be saved in one "large" file. 

 all  invoices and statements can be saved in one "large" file with page breaks  between each Record or  at  every X
Records (up to a maximum of 10 Records per page) (useful for pre-printed forms, for example, three forms on one
page).

The Windows dialog box will ask the name of the file(s) and the location:

Depending on  the  speed of  the  computer,  the  number  of  Records and  the  complexity  of  the  template  (with  image  or
not), merge will take from a few seconds to a few minutes. Since this is a rather intensive process, it is recommended to
limit the number of software running at the same time.

At the end of each merge, Operations Results will be displayed, thereby identifying problems if any:
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2) Attach to Record: This allows to attach each merged document to its Record. In this situation, a file will be created per
Record and not just one. Each of the merged documents will be attached to its Record.

A paper clip indicates that a document is attached (Record > Data > General) and the name of the file will have the MLM
ID number, date and time of production.

3) Send by email. This powerful option allows to send the merged document from the Record to each Borrower via email.
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See  Tools  >  Tools  Menu  >  Settings  >  System  Settings  (Administrators)  >  Email  connection  section  for  configuration  of
sending emails.

Recipient email address

One or more email  addresses much be entered for each Borrower to whom you wish to send an email.  If  you wish to
send to numerous Borrowers, each email addresses must be separated by a semicolon ";", otherwise an error message
will  be  generated  once  the  mass  mailing  is  done.  You  can  only  send,  via  the  system,  to  the  Borrower,   not  to
Co-Borrowers or Guarantors.

Once  the  emails  are  sent,  the  Records  in  which  there  were  no  email  addresses  in  the  Borrower  "Email"  field  will  be
identified in order to rectify the situation before the next mailing. Messages and attached documents will be sent to the
Borrowers with one or more email addresses. In the following example, out of the 12 chosen Records, ID number 866 and
867 (MLM ID number) were not sent. User will need to enter an email for each Borrower and resend.

Subject and message

A subject and a message to the Borrower should also be sent with the attached document. Two methods can be used to
do this:
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i) In one of the merge templates, which will be the default message for this template. Create an email template that will
be linked to a merge template. For the detailed procedure, see Reports > Merge / Email Template >  "Add a template for
Email" section.

The  following  window  will  open  allowing  to  enter  the  subject  and  the  message.  Text  can  include  a  certain  format
including the size, font, highlight, etc., and even a hyperlink. It is highly recommended to make a few tests before doing
an important mailing.

It is possible to personalized the emails with the merge codes for emails only.

ii) Written when sending the attached document (during the merge)

When ready to send from: Reports > Personalized Reports > Document Merge > "Save - Print - Email - Attach to Record"
button > "Send each file produced by email" > "Subject and message".

When a message is included in the
template, a pencil appears.

The "Document Merge - Message" window will appear in which you can enter the subject and the message, or choose a
message from an existing Email template.
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Sending

To send attached documents, from the Main window (or other option including Advanced Queries) choose the Records
then  follow  this  path:  Reports  >  Personalized  Reports  >  Document  Merge  >  "Save  -  Print  -  Email  -  Attach  to  Record"
button > "Send each file produced by email". 

Once the documents are merged and sent, the "Operations Results" window will appear. 

Printing: Finally, printing can be done independently or with some of the options described above.

It is possible to choose the paper size (Letter, Legal or A4), text orientation, adjust the document margins and number the
pages.

Direct printing from a Record

It is possible to print (or to save) a contract, invoice or statement directly from a Record's window. This way, you do not
need to close the Record you are working on but can produce a document as seen in the normal procedure (via Reports).

When the Record is open, click on "Print". When choosing "Invoices / Statements / Letters / Contracts", the Document
merge window will open offering the option to choose the template and to produce a full report or for the desired date
range.

The normal merge reports method will  follow (entering the dates if  necessary, choice of  template,  merge, save, attach
document, send by email and printing). The merged document will be produced only for the current open Record.
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Printing on pre-printed forms

When using pre-printed forms, you will first need to recreate the forms in a Word table format (or other word processing
software)  and  save  it  as  a  DOCX  document.  You  will  need  to  adjust  the  formatting  in  the  MLM  word  processor  and
include the merge codes. Margins will also have to be adapted for each print job. Creating the first form can take a few
hours due to the precision required, but once it's done, it can be used over and over again. 

After a Document merge and before printing, margins must be adapted for every print job.

See also the Custom reports created by the Margill team section.

See also Merge / Email Template.

   

Merge / Email / SMS Template

This  module  allows  you  to  create,  modify,  import  and  export  different  templates  for  letters,  contracts,  invoices,
statements and custom emails from the data of each loan. For example, you can create a template letter or contract that
will be used repeatedly.

A relatively powerful word processor has been integrated into Margill Loan Manager (MLM) allowing the user to create
templates in DOCX format. This allows the user to add tables and footers and create a sophisticated layout.

Before version 4.4, the DOCX format was not an option. The less sophisticated method, via a RTF format template, is still
an option for those who wish to use the old templates.

A document can be created directly in the MLM word processor, or can be imported from an existing document (Word or
other word processor), which is suggested for a better layout.

Any merged document (thus personalized for each Borrower for example) may then, in one operation be:

 saved as a DOCX (Word 2007 and newer), RTF (Rich Text Format)(Word) file or PDF file;
 printed;
 attached to each Record individually;
 sent by email in batch (thus each document is sent to a specific client) along with a standardized email subject and

message.

To  create  a  template,  the  user  must  go  to  Reports  >  "Merge/Email  Template"  button  .  The
"Merge/Email Template Setup" opens, displaying the existing templates. 
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The first column shows the name and description of the template. The second column shows the type of template: it can
be  a  Rich  Text  Format  document  (RTF),  a  Word  document  (DOCX),  a  Word  document  (DOCX  (Creditors))  specially
designed for  the  "Creditor  /  Investor  Statements"  or  for  an  Email.   The  third  column  identifies  if  an  email  template  is
linked to a Document merge. Finally, the forth column shows the user who created each template. 

In "Merge/Email Template Setup", with the mouse right-click button, it is possible to duplicate, rename or delete existing
templates. An Administrator can assign or modify a person in charge/creator of the template.

Designing a new template with the MLM word processor

o Create a new template
o Modify an existing template
o Importing files from a word processor
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o Exporting templates
o Formatting and editing of detailed lines of the payment schedule
o Formatting and editing Borrower data (tables) presented to Creditors

Designing an Email template for Mail merge

Adding an Email template to an existing template

Designing a SMS template

Merge fields

Detailed Payment schedule and other Special fields

Important notice on APR data

Produce, save, print, send by Email and Attach to merged documents

Designing a new template with the MLM word processor

Create a new template

It is easy to create a template with the MLM word processor. In the menu to the left of the Main MLM window (Record

summary), click on Reports and then on  . Choose  to create a template.
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Choose the type of template according to the document to be created. The RTF format template has been preserved for
existing customers, but it is recommended to choose the "DOCX" format, because the layout offers more sophisticated
options. Then, enter a short description of the report:

Write the text  (or  copy/paste from an existing text).  The same method is  used as in  Word or  other text  editor.  As  the
template progresses,  the  user  should  click  on  "Save" once in  a  while  to  ensure  no  data  is  lost  (just  in  case  something
happens). Add the merge codes by double-clicking on the available fields on the left. When merging, these codes will be
replaced with the corresponding data from the selected Record. When the document is  completed, click on "Save and
Exit" to return to the "Merge/Email Template Setup" window.
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Tip:  To  reduce  the  space  taken  by  the  merge  codes,  and  to  make  the  layout  easier  to  read,  press  on  the

 button  so  the  codes  are  automatically  replaced  by  short  codes  in  between vertical
bars (pipe), as shown in the example below:

Important tip: It is strongly recommended to do the maximum of the work in a word processor such as Word and then
copy and paste a few times between the word processor and MLM. If you already have a template in Word, refer to the "
Importing an existing template" section.
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Current deficiencies in the MLM text editor

There are a few deficiencies we have noticed but these will probably disappear over time as our development tool
adds and corrects various text editing components:

 It is not possible to add a footer with the MLM text editor. However, if  a Word document contains one and is
imported, it will be saved by the MLM text editor.

 When importing a Word document that contains tables:

o If text has been entered in a table cell, it will be impossible to remove the border;
o The table behaves as a series of columns, and not as individual cells; 
o If you press "Enter" when positioned at the beginning of a text to create a line spacing, the whole table

will be erased.
o Even  if  a  cell  is  deleted,  the  interior  borders  cannot  be  removed.  Below,  what  is  circled  in  red  is

impossible to remove.

The "Add template for email mailings" button is useful to link, by default, an email template to a document.

Modify an existing template

This  option  allows  you  to  modify  any  existing  template  shown  in  the  left  window.  Simply  select,  with  the  mouse,  the

document  you  wish  to  modify  and  click  on   .  The  editing  window  corresponding  to  the  type  of
document to be modified will appear and the user can then make the desired changes.
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A  RTF  document,  created  before  MLM  4.4  could  be  copied  and  modified  into  DOCX  thus  offering  more  formatting
options.

Importing files from a word processor

If  you  already  have  letters,  contracts,  invoices,  statements,  etc.,  but  in  another  format  (RTF,  DOCX,  HTML,  TXT),  it  is
possible  to  integrate  these  into  MLM.  From  the  Main  window  (Record  Summary),  click  on  Reports  >  Merge/Email

Template  and  then,  from  the  "Merge/Email  Template  Setup"  window,  click  on   .  A  window  will
open in which you will be asked to select the file to be imported. Then click "Open".
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Another  window  will  confirm  that  the  template  has  been  added  to  MLM  and  it  will  be  possible  to  modify  it.  Once
imported, insert the appropriate merge fields by double-clicking on the fields in the left menu.

You  can  also  just  open  a  document  in  Word  and  then  copy/paste  in  MLM  without  having  to  import  it  as
described above. However, formatting might be less sophisticated.

Exporting templates

It is possible to export a template in order to, for example, modify it in a more efficient word processor, then to import
back into MLM.

Select the template from the list in the "Merge/Email Template Setup" window and click on  .
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The user will have to choose the folder where to save and click "OK". The template will be copied to that folder and will
keep  the  same  name  and  document  type  as  the  original  from  MLM.  Moreover,  the  original  document  will  always  be
available in MLM.  In other words, exporting copies a MLM file to the user's drive.

Formatting and editing of detailed lines of the payment schedule

Under the "General" tab, you can find over twenty Payment schedule template styles that contain various data elements
to be inserted into the merge templates. It is possible to modify the layout of each to a certain extent so that when they
are inserted in the templates, they follow a certain pre-established layout.  
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To  use  this  tool,  open  a  new  template  or  modify  an  existing  template,  right  click  with  the  mouse  and  choose  "Edit
detailed lines table" 
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The following window will open, then select the detailed lines table from the drop-down menu.

You  can  change  the  width  of  the  columns  manually,  as  well  as  the  text  of  the  headers.  Please  note  that  any  other
modification will not be taken into account. For example, you cannot delete a column, place text outside the table, add
graphics or colors.



Page 1029

© Jurismedia Inc., 2007- 2023

Font size will not be kept for printing. It is only used here to provide an idea of the results in the table according to a font
size. The font size must be previously set in the report template itself. Highlight the merge code in the detailed table and
select a font size as well as an alignment on the page:

You  can  also  edit  the  templates  based  on  the  master  template's  ultimate  orientation:  landscape  or  portrait.  The
appropriate configuration will be selected according to the orientation defined in the master template. Important! Save
the changes before switching to the other report orientation, otherwise, changes will be lost. In the following example,
for landscape orientation, all of the columns have been widened, in order to use all of the space horizontally.

In order for the changes to be save, make sure you click on Save before modifying the next table, if required. It is always
possible to return to the original  MLM format by selecting the desired detailed lines table from the drop-down menu,
selecting the table orientation to restore and then clicking on the "Restore default format" button.
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 Formatting and editing Borrower data (tables) presented to Creditors

See the Creditor / Investor Statements chapter.

Designing an Email template for mail merge

It is possible to create templates for sending emails. These emails can be attached to other templates, such as invoices,
statements in either RTF or DOCX mode. They can also be linked to Line status Alerts previously configured which allow
emails  to  be  sent  automatically  to  Borrowers  based  to  certain  rules  (upcoming  payment  notice  or  insufficient  funds
returned payment notice). Thus, you can save quite a bit of time managing your customers. In addition, these emails are
automatically personalized when using the Merge fields. 

To access the module for creating email templates:  Menu Reports > button > .

Select "Email", enter a name for the template and click "OK":

The  email  Subject  will  be  the  title  of  the  mail  sent  to  recipients.  Enter  the  desired  text  and  insert  Merge  codes  to
personalize each email. Only the main merge codes relating to more general data are available for the email templates.

Configure your desired layout.  With the text editor, you can:

o Modify the font
o Modify the font size
o Have text in bold, italics and underlined 
o Highlight colors
o Modify the font color 
o Left, center and right alignment 
o Add images
o Insert hyperlinks.

Please note, some service providers do not support sending or receiving more sophisticated emails in terms of layout. In
addition, some inserted images may not work depending of the recipient. It  is strongly recommended to create simple
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templates, the simplest possible. Always test the templates first with external recipients.

When your text is ready and the layout is complete, press on "Save and exit".

Adding an email template to an existing template

In order for an email template to be linked to an existing template, select, from the list, the master template for which

you wish to add the email template.  Click on .
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The  window  for  editing  templates  will  appear.  Click  on at  the  bottom  of  the
window. The following window displays all of the existing email templates:

Choose an email template to use, as the default, when this document is emailed. While producing this report, it will also
be possible to choose from other email templates. Check the desired email from the list and click on "Close".

Designing a SMS template

It  is  possible  to  create  templates  to  send  Short  Message  Service  texts  (SMS).  In  order  to  have  access  to  the  SMS
functionalities, consult the FolioMedian (SMS) Connection section. These SMS can be linked to Alerts configured for Line
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statuses  that  send  these  SMS  to  Borrowers  automatically  based  certain  rules  (upcoming  payment  notice  or  rejected
payment by the bank). SMS can also be sent directly from the Main MLM window.

These SMS are automatically populated with Borrower (and other chosen data) through Document Merge.

To access the module to create templates: Reports section >   button >   button.

Select the "SMS" type, name the template and click on "OK":

There is no Subject like in the email template and no formatting is possible, since only a message in standard text form
can be sent by SMS. Enter the desired text, insert Merge codes in order to personalized each SMS. Only the main merge
codes relating to more general data are available for the creation of the SMS templates.

Once the text is entered and formatting is completed, click on "Save and exit".

IMPORTANT:  Laws  or  regulations  in  some  counties  limit  the  content  that  can  be  sent  by  SMS.  Consult  the  laws  or
regulations of your jurisdiction in order to respect these. A FolioMedian account can be suspended in case of breach of
such laws or regulations.

Merge Fields

A  merge  field  is  a  code  that  replaces  a  particular  element  for  each  Borrower/Employer/Creditor/Record.  Rather  than
creating several documents individually, you simply need to create a master document in which codes are then replaced
by the loan's data or the borrower's data for each Record.

For  example,  a  user  could  include  in  his  template:   Hello  &&CLT-TITLE&&  &&CLT-LASTNAME&&.  Inserting  these  two
merge codes, each Borrower who would receive this letter, would see this instead:  Hello Mr Harris.  Therefore, the letter
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would be addressed personally to each Borrower, automatically.

Since there are close to 1000 merge codes in MLM, the possibilities are endless.

Merge codes are inserted by double-clicking on these from the left side of the window (or via the right mouse click). By
default, the long codes will be added to the template. Two types of merge codes can be used:  a more descriptive long
code or a short one that takes less space, especially with table-type templates. Simply click on  "Convert to Short Merge
Code", located on the top right side of the Editing report window in order for all long codes to be converted into short
codes.

Fields are described in the Reporting Fields; these fields are listed by theme ("Borrower", "Creditor", "Loan Data", etc.).
More than 1000 fields are available for merging on top of the Custom fields.

Mathematical  equations  is  a  powerful  took  to  add  (subtract,  multiply,  divide...)  different  amounts  in  your  reports.  For
example:  Total due = amount of next payment + Outstanding amount + Fees.

Users can include merge fields in the same template for four periods:
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1) Current reporting period: whole duration of the loan or Billing period (often one month)(example of short merge code
: |123| or long code &&Description&&))

2) One period preceding Billing period (often the previous month)(merge code: P123P)

3) Year-to-date to the start of the Billing period (merge code: Y123Y)

4) Origination date to the start of the Billing period (merge code: O123O)

To do so, you will need to choose the right option, in the drop-down menu located on top the list of available fields.

Only  the  relevant  fields  are  available  for  the  last  three  periods  (unavailable  fields  are  grayed-out)  and  only  the  short
codes (less descriptive) have been included.
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Detailed transaction lines, so essentially the Payment schedule (under the "General" theme) are also included in order to
add the pas transactions and those for period T=0.

Invoicing can become complex.  It is therefore recommended to test with several payment scenarios.

For more detail on periods, see the Document Merge (Letters, Contracts...) section.

IMPORTANT  :  For  detailed  explanations  for  the  different  data  fields,  see  the  Reporting  Fields  section.  Each  field  is
detailed and the merge codes are displayed.

Description is also available in MLM by selecting the field, among the list on the left and by clicking  .

The  merge  fields  include  the  &&  symbols  to  indicate  the  start  and  the  end  of  the  codes.  For  example,
&&CLT-FIRSTNAME&&  represents  the  Borrower's  first  name.  These  codes  should  not  be  altered  or  contain  a  partial
special  format  (such  as  underline,  bold,  italics).  If  a  partial  format  difference  is  included,  then  the  code  will  NOT  be
recognized. 
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For example, these first two codes are acceptable and would merge properly:

Dear &&CLT-FIRSTNAME&& &&CLT-LASTNAME&&,  

Dear &&CLT-FIRSTNAME&& &&CLT-LASTNAME&&, (only the last name will be in bold)

However, the example below would exclude the Borrower's last  name since there is  a  partially  bolded and underlined
section:

Dear &&CLT-FIRSTNAME&& &&CLT-LASTNAME&&, 

Shortcuts for the RTF merge codes - "Short RTF code"

In order to simplify the document merging design, codes that include &&, which are usually
long, can be replaced by "Short Merge Code". These Short merge codes comprise numbers
and,  in  some  cases,  a  letter,  and  therefore  are  non-descriptive  and  are  not  easily
understandable. Their advantage however is that they take up little space and make it easier
to visualize the final formatting of a more sophisticated document.

For example, the code && CLT-FIRSTNAME && (First Name) can be replaced by |110|.

The bar that resembles a lowercase L letter is actually a "pipe" (|) generally accessible with

Alt (right) and the key on the keyboard directly below the Esc key ("tilde"  key).

If  you have merged documents that include long codes, it  is  possible to replace them with
short codes by pressing "Convert to Short Merge Code". 

Detailed Payment Schedule and other Special Fields   

A dozen detailed payment schedules (Payment schedule) are available under the "General" theme. These allow the user
to add transaction detail for the specified time period or if no dates are specified, for the whole loan or from the loan's
start date until  the end date chosen. Various format are available including accrued amounts,  paid amounts,  summary
reports, etc. Other formats may be created based on your needs (fees are charged).

For the detailed versions, the first line indicates the start period of the report and the balance on this date. The last line
computes  the  interest  and  principal  between  the  last  payment  date  and  the  final  date  entered.  The  principal  usually
increases (indicated by a negative sign) by the amount of interest accrued.
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All Custom fields (for the Loan, Borrower or Creditor) created by the Administrator, may also be inserted in the merged
document.  Even custom fields that  include scroll  menus (pull  down menus)  can  be  included,  making contracts  easy  to
create for example. These scroll menus can include typical contract clauses that are then merged in the contract.

Mathematical  Equations,  created  by  the  Administrator  or  Power  user,  can  also  be  inserted  allowing  for  invoices  or
statements that include sums or totals.

Date formats

A standard date format can be specified for all "Date" fields in the document merge. Thus, a long or short format or an
English or French format can be chosen by each user.

To choose the format, go to Tools > Settings > User Settings > Date format in the Document merge reports: 

The Windows format is the one defined in the Windows Control Panel whereas the others are more polished formats.

Once the document is completed with the appropriate fields, you can set the page layout for  direct printing only.  This
formatting will not apply to documents that are to be saved. It is possible to choose the paper size (Letter, Legal or A4),
text orientation and adjust the document margins and page numbering.

Once the document is  completed with the appropriate merge fields,  press on OK. This will  save the  template in  MLM.
Your text can be edited later on.

Important notice on APR data

In the calculation of the "APR", "APY", "Total fees", "Total Cost of Credit" and "Amount Financed", only the fees indicated
in  the  APR  section,  as  opposed  to  those  tagged  as  "Fees"  in  the  Payment  schedule,  will  be  considered  in  the  APR
calculation.

Nevertheless,  the  various  "Fees"  Line  statuses  will  be  considered  as  additional  principal  (although  not  computed  in
"Amount Financed") and will have an effect on the total interest and thus affect APR.
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Only the fees entered in the Record's APR  window as well as the Column Fees will be correctly
factored in the APR calculation.

See also Effect of Line status on Annual Percentage Rate (APR).

MLM contains the US Truth in Lending Disclosure box. The Report Description is called "TILA APR Box (USA)":

See APR Report

Produce, save, print, send by email and attach to merged documents

Once the template is completed, consult the Document Merge (Letters, Contracts...) section for the step by step method.

See also Electronic Signature (eSignature).

   

Electronic Signature (eSignature)

Electronic signatures are integrated into Margill Loan Manager (MLM). The process is quite simple:

1)  Create  your  document  template  normally  with  the  MLM  Document  Merge  factoring  in  that  the  two  signatures  or
multiple signatures (Borrower, Creditor, Co-Borrower(s), even the Guarantors if necessary) are inserted electronically on
the last  page of  the  document  (always  on  the  last  page which contains  the  electronic  evidence required  in  electronic
signature standards.

2) When the document is ready to be sent, communication is established with Xodo Sign (formerly Eversign) (Xodo.com),
Margill's partner who automatically sends emails to recipients to collect the required signatures.

3) The final document, electronically signed by everyone, is then found in a PDF format on the Xodo portal to which you
have access. 

The  electronic  signature  can  be  used  in  the  majority  of  countries.  You  must  make  sure  your  jurisdiction  allows  the
eSignature.

Steps to follow:

Subscription to the electronic signature service at Xodo Sign

Account setup

Sending documents for electronic signatures

Signed and completed documents

Subcription to the electronic signature service at Xodo Sign (formerly Eversign)
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In order to be able to user electronic signature, please contact the Margill partner in order to subscribe.

Xodo Sign

Xodo Sign is an electronic signature software that  offers small  and large businesses a  secure platform which they can
approuve, deliver and sign legally binding documents online. By integrating contract templates, third-party integrations
and a powerful REST API, Xodo Sign aims to provide a complete electronic signature solution.

To subscribe and to find out more, visit: eversign.com or contact the Margill Team.

Account setup

Under Tools > Settings, under the System settings (Administrators), in the section Module, click on "Electronic Signature".
  This window will appear:

Upon  clicking  on  the  "Activation"  box,  from  the  drop-down  menu,  you  will  be  able  to  choose  the  Margill  eSignature
partner with whom you have a subscription. The URL will be provided automatically. Then click on "Save".

Under File > Creditor, select the Creditor for which there is a subscription and select the "eSignature" tab:

https://www.eversign.com/
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The business ID and the API Key are provided by Xodo Sign at registration.

The chosen mode is "Test" or "Production". It is your responsibility to test the application before officially going into the
production mode.

The headings "Requester Name" (2*) and "E-mail message" (5*) can be personalized every time you send a document for
eSignature.

On the other hand, the "Requester Email" (3*) is static. The recipients will receive the document to be signed from the
same email address regardless of who the Margill user is. 

The "Name of  Signer"  (4*)  is  the  legal  name of  the  signature found on  the  document  for  the  company  that  holds  the
subscription with Xodo Sign.

*Here is  an example of  a  message received in Test mode and the presentation of  different elements.  Number  1  is  the
name of the Document sent that can be modified.
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Sending documents for electronic signatures

The document for electronic signature must be produced and sent one at a time, not in batches.

1. To send a document to be signed, open the Record. 

2. Make sure that the Creditor who owns the subscription to Xodo Sign is the first on the list of Creditors, if the Record
has "Co-Creditors" (if necessary, reposition the Creditors using the blue arrows):

3. Click on "Print" and choose the "Invoices / Statements / Letters / Contracts:
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4. The usual Document Merge window will appear but will not offer the option to select multiple Records since only
one Record is active: 

5. After choosing the document to be signed, as well as the dates required for the Merge, if necessary, click on "Save -
Print  -  Email  -  Attach  to  File".  The  usual  Document  Merge  window  will  appear  but  the  "Send  via  Xodo  Sign  for
eSignature(s)" option will be available:
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6. If the "Send via Xodo Sign for eSignature(s)" option is checked, click on "Next" and this window will appear to setup
the electronic signature:

7. Check / uncheck the recipients from the list of all actors registered in the Record. Modify the "Document Name", "
Requester Name", "Email Message" and even the names of the signatories or the email addresses as needed. Specify
the order of signatories using the blue side arrows on the right. Once the required information has been entered and
validated, click on "Save". The rest of the Document Merge steps will continue as usual.
 
*The  "Cancel"  button  in  the  "eSignature  Selection"  window  will  cancel  the  command  to  send  documents  for
signature  via  Xodo  Sign,  but  the  rest  of  the  Document  Merge  operations  will  continue  as  usual  according  to  the
user's choices: save, print, etc.

8. At the end of the process,  an eSignature request report  confirms the status of  submissions. If  a  problem occurred
during sending process, it would be reported in this window under the topic "Problem(s) encountered":
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Signed and completed documents  / Xodo Sign Portal

Once subscribed  to  Xodo  Sign,  you  will  have  access  to  your  Xodo  Sign  Portal  page  allowing  you  to  consult  the  signed
documents and see the evolution of the signatories.

In  this  version, signed documents  are  not  automatically  attached to  the  MLM Record.  This  step,  if  necessary,  must  be
carried out manually once all the signatures have been obtained.

   

Creditor /Investor Statements

This module is used to produce and send statements to your Creditors and Investors of their portfolio that you manage.
The  module  can  extract  a  great  number  of  data  relating  to  the  loan  and  to  the  Borrower.  Financial  data  for
participation/syndicated loans can be obtained by  using  Mathematical  equations  that  extract  pro-rated data  based on
the financial  participation of  each investor in  individual  loans.  The financial  and personal  data of  each of  their  loans  is
displayed in table format, one line per loan, as shown in the example below:
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These statements can then be saved, printed or sent in bulk by email along with an attachment to the investors.

Steps for creating statements for Creditor/Investor:

Creating a custom template for the Creditor/Investor Statement

Production of the Creditor/Investor Statement

Converting values for multi-currency portfolios

Creating a custom template for the Creditor/Investor Statement

A statement for Creditors/Investors has two components: 

1) Creditor / Investor data

2) Loan data for each Borrower  
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Before production

After production
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To create a new template, click on  , "New" and check the "Creditor/Investor Statements" box.

1) Creditor/Investor data: 



Page 1049

© Jurismedia Inc., 2007- 2023

Initially, only the merge fields relating to the Creditor/Investor (and certain dates) will be available (component )
to create the basis of your template, since at this level, we only want to identify the Creditor.

2) Loan data for each Borrower 

Fields relating to the loan and borrower data you wish to show to your Creditors/Investors will  be displayed in a  table
format and, once created, they will be available under the tab "Merge tables" (or via the mouse right-click).
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The   button  allows  the  user  to  create  tables  with  column  headers,  the
chosen merge fields, and after merging, data will appear underneath. By clicking this button, the following window will
appear displaying the "Templates: Loan Data presented to the Creditor" and including the merge code to be included in
the complete template. It is possible to create new templates or to modify existing ones.

When  clicking  on  "New",  the  following  window  will  appear  allowing  you  to  select,  on  the  left,  the  fields  you  wish  to
include for each loan.



Page 1051

© Jurismedia Inc., 2007- 2023

Choose the data to include from the left of the window and bring to the right table. One can change the report section
order in this window (in the"Reporting Fields" section on the right) by highlighting the field to be moved and by using the
arrows on the right-hand side.

It is also possible to eliminate a field by clicking on the arrow in the middle of the window in order to select it.

When  the  desired  fields  are  added,  it  is  possible  to  rename  these  in  order  for  the  Creditors/Investors  to  better
understand their exact meaning (they become the column titles). The "Original Description" column informs the user of
the official field name in MLM. Data for each Record of this creditor/investor will appear individually on one line of the
table - one line per Record/loan.
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Click on "Refresh" in the "Preview settings" column in order to view the table. Options available for the layout (font size
and orientation) are used for the preview only and will not be saved when producing the report. They are indicative so
that you can organize the template properly. However, it is possible to rename the field name headers and modify the
width  of  the  cells  in  the  table.  It  is  suggested  not  to  add  too  many  fields,  otherwise  the  table  will  quickly  become
unreadable due to lack of space. 

A color can be added to header cells.  Click on  to choose among the colors:
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Once a color has been selected, click on "OK" and then on "Refresh" to preview the results.

Name the table and click on "Save". The window will  close and  reopen with  the  new template.  Long and short  merge
codes will have been generated automatically, in order for the user to add this new merge table to the master template. 



Page 1054

© Jurismedia Inc., 2007- 2023

Upon closing this window, simply add this table to the master template by selecting and double-clicking on it under the
"Merge  Tables"  theme  to  the  left.  Complete  the  layout:  for  example,  if  your  table  is  wide  and  more  suitable  to  a
landscape format,  you can modify it  here so that  the changes are  effective upon document  merge.  Once the  layout  is
complete, click on "Save and Exit".

You  can  change  the  layout  of  the  merge  tables  at  any  time  using  the  right  mouse  click.  Highlight  the  merge  codes
assigned to the table, right-click with the mouse and choose "Edit loan data presented to Creditor Templates".
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It is possible to add to this, a template for sending emails. See the Mail Merge / Templates section for more information
on this option. 

Mathematical equations and syndicated / participation loans

Each Record / loan can be assigned to a single Creditor (lender / investor / fund) or in various proportions to several
Creditors. Many Creditors in one loan is often known as a "participation loan" or a "syndicated loan".

A  loan  can  be  entered  in  Margill  and  include  the  percentage  (up  to  8  decimal  places  for  maximum  accuracy  in
Equations) or amount participation of each Creditor:
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Mathematical Equations allow these percentages to be multiplied by various financial data of the loan, thus bringing
out the pro rata of the respective participation for each of the Creditors. The equations below, for example, make it
possible to establish the interest paid, the principal paid and the respective balance of each Creditor:

Several other data can be extracted as needed, including individual income (accrued interest), the balances, etc. We
could even extract the income by taking into account a lower rate of return granted to the Creditors compared to the
rate of interest charged to the Borrower.

Equations  can  be  included  in  the  "Data  presented  to  the  Creditors"  in  table  form.  A  merge  code  is  automatically

generated by MLM which represents all of these data (Component ) which are added to the master template
afterwards.
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Simply add this new merge code to the main template (Component  ):
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When merging, the results are obtained based on the participation of each Creditor. In Julie Andrews' loan, FUND ABC
has a participation of 50% while Lab Industries has a 30% participation. The last line of the table represents the total
by column and is especially useful when there are several loans by Creditor.

The total  paid interest for  the loan in March is  125.00 of  which 62.50 to FUND ABC, 37.50 to KLT Inc.  and  the  rest
(25.00) to DT Inc. (statement not produced):
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Statement for FUND ABC

Statement for Lab Industries

To find out more about participating / syndicated loans, see the Reports > Commonly required reports > Participation
/ Syndicated Loans section.
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Production of a Creditor/Investor Statement

In "Reports", click on "Creditor / Investor Statements" and choose the desired template. 

By checking the "ACTIVE Records Only" option, the system will produce a report for the Active Records only. If some of
the Records have another Status and are displayed or selected, MLM will not display these in the List of Records. Add a

Creditor in  the table with  the  help  of  the  arrow  .   To  view the  Records associated to  this  Creditor,  click  on  "+"

beside the yellow Folder  .  Select the Records for which a report needs to be produced by checking the box on the
right.

To select all of the Records linked to a Creditor, check the box located on the right of the Creditor's name.
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It is also possible to eliminate a previously chosen Creditor by selecting it and clicking on the   arrow in the center
of the window. The number of Creditors as well as the number of selected Records are displayed as an indication under
the "Records List" of the window.

Please  note:  The   and   options  located  in  the  lower  left  corner  of  the  window
provide access to the template's creation or modification window for the Creditor/Investor Statements.

You must now choose among the options in this window.

 1) Full report, 2) up to a specific date or 3) between 2 dates.

 Report end-date method: three methods are available to include or exclude interest and transactions that may occur
on the reporting end date specified. This can be important depending on the end-date entered. For a report up to
December 31 for example, the last day's transactions and interest should generally be included. 

For a report up to January 1 (thus the start of the next period), if that day's transaction is to be included but not the
interest  on  that  day,  then  the  second  option  should  be  chosen  ("Include  last  day's  transactions").  Ideally  though,
with a date at the start of the next reporting period, the first option should be chosen ("Exclude last day's interest")
so as not to include any data from the next reporting period (avoid double accounting).

Please note: a Record is considered to be completely terminated on the last line's "Pmt Date" at 0:00:01 (so at 0:00
in the morning plus a fraction of a second to allow the last payment to be made). Thus, if a report end date is equal
to  or  after  the  Record  termination  date,  all  three  "End  date  method"  choices  will  yield  the  same  data  for  this
particular Record and no interest will be included for the Record's last day. It is suggested for lines of credit or loans
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with no true end date set, to enter a distant date (e.g. 01/01/2025), so that the loan is not considered finished on the
last line and continues to generate interest. More accurate projections can thus be made.

 Convert  to  other  currencies:  This  report  also  allows,  for  multi-currency  portfolios,  to  convert  the  multi-currency
values to one or  many other currencies. First,  the Administrator must activate the multi-currency module through
Tools  >  Settings  >  System  settings  (Administrators)  >  Modules  >  Currencies  and  by  selecting  "Activate
"Multi-Currency" module (Administrator only)".

When converting in  the report,  the following choice will  appear with a  pull  down menu of  the  currencies  in  MLM
(other currencies may be added and some deleted - see the Multi Currency section).

No matter which currency was used in the Record, the report will  be produced with the selected currency (USD in
the  above  example)  using  the  conversion  factor.  The  report  may  be  created  in  any  currency,  not  only  the  base
currency (factor = 1). 

In order to differentiate between various currencies (useful when the report is produced in multiple currencies) MLM
will  automatically  add  a  first  column  with  the  currency  symbol  (this  column  may  be  deleted  in  the  TXT  and  CSV
saving settings).

Once the data entered, click on  . The following window will
be displayed offering different choices which are explained below.

First, choose the document format:  DOCX (Word), a format that can be modified in a word processor or in a PDF format,
which is not as easy to modify.

When choosing PDF, two options are offered:
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 If "Create the document using Word..." is chosen, the document will  be produced using the Word's (versions 2007
and greater) functionalities.

 If  the  option  is  not  chosen,  the  document  will  be  produced using  a  slightly  less  sophisticated algorithm offering a
layout that could be deficient. 

Experimenting is recommended depending on the complexity of the layout of your document. 

Merging options

1) Saving a report. When saving a report in DOCX or PDF format, you have three options: 

 each  letter,  invoice  or  statement  can  be  saved  in  its  own  file.  By  default,  it  will  bear  the  name  you  have  given
followed by the MLM Creditor's ID according to the suffix chosen in the drop-down menu, in order to easily identify
it. These files can then be sent by email for example. When saving individual files, it is suggested to create a folder
with a clear identification (for example - Invoices - March 2020) and place your files there.

 all invoices and statements can be saved in one single "large" file.

 all invoices and statements can be saved in one single "large" file with page breaks between each Creditor or at all X
Creditors (up to a maximum of 10 Creditors per page) (useful for pre-printed forms with, for example, three forms on
one page).

The following saving steps are very similar to the ones of Document merge.

2) Sending by Email. This powerful option allows to send a merged document to each Creditor (or multiple Creditors) via
Email.

See in Tools > Menu tools > Settings > System settings (Administrator) > Email connection to configure the system.

Delivery address

One or more email addresses must be entered for each of the Creditors to whom you wish to send an email. If you wish
to  send  to  multiple  Creditors,  each  email  address  must  be  separated  by  a  semicolon  ";",  no  space  between  each,
otherwise you will get an error message once the sending is finished.
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If  a loan is assigned to multiple Creditors, each will  receive a  merged report based on their  own information. This tool
becomes particularly powerful for participation / syndicated loans by combining it with Mathematical Equations. See the
Mathematical equations and syndicated / participation loans box above for an example. 

Steps for sending are the same as in the Document merge.

Subject and message in email

A subject and an email message to the Creditor(s) should also accompany the attached file.

The following window will  appear and you will  be able to enter a  subject as well  as  a  message. Text can include some
formatting including font, size, highlight, etc. and even a hyperlink. It is suggested to test before sending to a large group
of creditors. A tool allows test sending to large groups of emails. See the Email mass sending test tool sub-section in the
Email connection (Batch emails) chapter.
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It  is also possible to personalize the emails to be sent by using the email  templates for  "Creditor/Investor Statements"
which  can  include  merge  codes.  The  "Creditor/Investor  Statements"  box  must  be  checked  for  the  email  templates
otherwise the template will not appear in the choices available.

For  detailed steps,  see Reports  >  Merge  /  Email  Template  >  under  "Add  a  template  for  sending  email".  Note  that  the
merge fields are limited to the information relating to the Creditor, not to Record (loan) or Borrower data since a Creditor
Statement generally includes multiple Records and multiple Borrowers.
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3) Printing: Finally, printing can be done independently or with some of the options described above.

   

Export accounting transactions to the General Ledger

Margill Loan Manager (MLM) allows you to the export transactions and other accounting data to the General Ledger (GL)
of several accounting packages, Excel and other formats:

o Intuit QuickBooks Pro (.IIF)
o Sage 50 Pro, Sage 300, and multiple others (names vary depending on country)
o Acomba
o Excel (.XLS)
o Text format (.TXT)
o CSV format (.CSV)

You can then produce a list of accounting transactions for a given period while combining these debits and credits to your
chart  of  accounts  (GL  numbers  or  names).  MLM  will  then  produce  the  file  in  the  format  required  for  import  into  the
desired system.

Creating the accounting report template

General
Assigning a unique GL number to each client
Adding notes (or comments) to each entry 
Transaction dates entered into the accounting system 
Modifying a report
Copying, renaming and deleting existing reports
Using Creditor Participation Percentage or Amount

Producing the export file

General
Detail tab
Summary tab
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By Account tab
Time required to produce a report

Reversing exported entries

Importing into Accounting packages

Intuit QuickBooks Pro (.IIF)

Sage 50 Pro (and other Sage products)

Acomba

Creating the accounting report template

General

In the MLM Main window (Record Summary), click on Reports  and on "Accounting Entries". The following window will
open:

Next, click on "New" and the window below will open:
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This window allows you, for the numbers identified above to:

1. select the fields (or transactions) to include;
2. include a GL number (or name) for a particular Record; 
3. associate the GL account number with the corresponding field (or transaction);
4. add descriptive notes for each transaction. These notes will be imported into the accounting system;
5. name the report.

Each of the available fields is described in detail in the "Reporting fields" section. Please note that the field names and the
descriptions are not always perfectly adapted to this  report  since transactions or  balances are reported as opposed to
totals in other reports. For example, "for period" could appear in the name but in fact the transaction date or dates is
(are) reported. The mouse-over describes in a bubble what is reported:

In  our  example,  using  cash-basis  accounting,  we  wish  to  include  three  types  of  transactions  for  the  period  from
November 1 to November 30:

 Interest Paid
 Principal Paid
 Fees Paid (Line)

We  could  also  have  included,  for  accrual-basis  accounting  (see  box  for  report  preparation  suggestion),  Interest  paid,
Accrued and Due Interest, Principal Paid, Fees (charged) and Fees Paid and other balances needed. Many other types of
"transactions" can be included :
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 Original Principal
 Original Fees for a Record (APR calculations)
 Additional Principal (during the loan)
 Paid payments (also based on the type of payment made). 

o See Line status in order to customize the payment type made (for example, Paid Visa, Paid Check, Paid Cash,
etc.)

 Insurance
 Taxes
 Other types of transactions
 Balances
 Outstanding amounts
 Doubtful accounts

Let's return to our example:

Choose from the left column, the three transactions (Principal Paid (for period), Interest Paid (for period) and Fees Paid

(Line status)(for period)) by selecting the data and then pressing .

The three fields now appear in the central section, displaying in red, missing data, or debit and credit accounts for the GL.
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Options available for associating the GL Accounts to the transactions

Two  options,  or  a  combination  of  these,  are  available  to  associate  the  GL  accounts  to  the
transactions:

1. Transactions of a particular type will  be exported into a  single GL account for ALL Records (ie.
not associated with a particular client as is the case in 2. below). For example, Interest Paid for
all Records will be charged to the GL credit account 5820.

2. Second  scenario...  Each  client  (Borrower)  or  Creditor  has  his  unique  account  for  one  type  of
transaction.  For  example,  the  Principal  Paid  for  company  ABC  Inc.  will  be  exported  to  credit
number  1701  while  that  of  company  DEF  Inc.  will  go  to  number  1702.  This  involves  the
development  of  a  more  complex  chart  of  accounts  in  the  accounting  package,  but  provides
much more detailed data in your accounting software.

This  option  is  possible  for  both  debits  and  credits.  For  the  debit  accounts,  for  example,  some
Records could be assigned to Bank A, while others assigned to Bank B. The GL account does not
have  to  be  unique  for  each  Record.  In  the  example  above,  many  clients  will  have  the  debit
number for Bank A.

3. Often  a  combination  of  both  is  used.  For  example,  all  interest  income  would  be  included  in
account  5820  and  the  Principal  Paid  in  separate  accounts  for  each  client  (1701,  1702,  1703,
etc.)..

In the example, for the debit accounts, the three transactions are assigned to the Bank whose GL number is 1000. The
number  (or  unique  QuickBooks  description)  must  be  the  unique  identifier  from  your  accounting  package  and  must
respect the number of digits allowed (see the User Guide of your accounting software).

For the credit:

 Interest Paid: all interest paid is recorded in a single income account, 5820
 Fees Paid: all fees paid are recorded in a single income account, 5830
 Principal Paid: each client has his own GL account and therefore we must assign the GL number to each client.

Thus, for the Interest Paid and Fees Paid, enter the appropriate account numbers in each box, respectively:

For Principal Paid, follow the instructions in the box below: 

Assigning a (unique or common) GL number to each client (Borrower) or Creditor
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GL numbers (or names) may be assigned in two (2) sections in Margill Loan Manager:

1)  In  the  "Accounting  ID"  field  in  the  "Data"  window  ("General"  tab).  Only  one  account  can  be
created here.

2) In the "Custom Fields"  section. An unlimited number of fields can be created for  accounts. These
can be related to the Borrower, to the Creditor or to the Loan (Record) itself. The choice of where to
enter the GL account is not highly important. In case of doubt, enter for the Record itself.

 The field would be linked to the Loan (Record) for maximum flexibility -  thus, each loan would
have its own GL number but this would imply entering the number for each one - use the Global
changes for quick data entry.

 The field would be linked to the Borrower if each Borrower had its GL number for principal for
example. This would be useful  if  a  Borrower has many loans in  the portfolio.  By linking to the
Borrower, you would not have to enter the GL numbers for each of his loans.

 The GL number is linked to the Creditor in portfolios with multiple Creditors.

To create a custom field that will be linked to the accounting module, the MLM Administrator must
go to Tools > Settings > System settings (Administrator) > Custom Fields > Borrower (or Creditor or
Record) tab > "Unlimited fields (Table format)" subtab.

Enter the field name with the Type as "Text" (suggested for maximum flexibility) and check "# GL" to
indicate that this field is intended to accommodate a GL account number. A scroll menu could also
be  created  if  there  were  only  a  few  account  choices  for  the  debits  or  credits.  The  field  (and
corresponding data once entered) will appear in the accounting module. In the example above, the
two lines starting with "GL -..." are fields identified as General ledger accounts.

The image below, taken from the accounting reports creation window,  displays  the  fields  that  can
include accounting identifiers ("Accounting ID" and "GL Account - Principal" which is a custom field).
The  account  number  of  each  Record  is  also  displayed.  Notice  that  for  Record  104,  no  account
number is entered. The user should add an account number for this client otherwise an error will be
generated when creating the export file.
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To associate the "GL Account - Principal" custom field with the transaction "Principal Paid": 

 choose (highlight) the "GL Account - Principal" field;
 click in the red box "Credit Account" for the "Principal Paid" transaction; then

 press on the arrow  to lower the field in the appropriate box.

Note  for  line  3,  that  the  column  with  the  asterisk  (*)(right  of  "Credit  Account")  contains  a  black
square. This indicates that a custom field or Accounting ID ("Data" window > General) is associated
to the "Credit Account" of this transaction.

By associating the corresponding Principal Paid to the custom field, the association between account numbers and debit
and credit transactions is now complete. 

All that remains is to save the report by assigning a name:
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It is also possible to add a note or comment to each transaction in order to identify the origin of each in the accounting
package.

Payments in cash, check, credit card or other special "payment"

It is possible, to apply different payment methods to the appropriate debit and credit accounts.

First, the Line statuses corresponding to the payment method should be defined (Tools > Settings >
System settings (Administrator) > Line Payment statuses). See the Line status chapter.

 
In the example below, the payments are deposited in various bank accounts (1000 and 1002) based
on  the  payment  type,  while  in  credit,  all  amounts  are  applied  in  the  balance  due  by  the  client
(Assets).

The explanations above also apply to "Fees" and "Other" Line statuses. Note that "Other" type Line
statuses  do  NOT  pay  principal,  interest  and  Column  fees  so  should  only  be  used  in  special
circumstances by experienced users.

 It is possible to extract different "paid" components for each "Payment" type Line status. 

o Principal
o Interest
o Column Fees 1 to 6
o APR Fees Financed 

The principal and interest paid can be isolated according to the type of payment made. Thus, one
could isolate the amounts paid by a  normal payment (Paid Pmt) from one "paid" as  a  "Write-off"
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(Pmt made 5, for example, renamed to "Write-off"). Amounts paid by Write-off are not actually paid
and therefore can be treated differently (loss of principal and interest).

Thus, 89 new fields have been added for the paid portions of the following  "Payment" type Line statuses:

o Paid Pmt
o Paid Pmt 2 to 20 (as renamed)(64 fields)
o Paid Pmt Returned Check
o Add. Pmt
o Compensatory Pmt
o Partial Pmt, Partial Late Pmt, Late Pmt

Suggestion for Accrual-based accounting report preparation 

Revenue accounts:

Interest:    5820
Fees:        5830

Accounts receivable:

Interest:  2100
Fees:      2120

Bank:      1000

Principal:  1700 (or separate accounts)

Create the report like this:

Thus, interest will go to income (5820) as soon as accrued (and accounts receivable - 2100). When
paid, interest goes to the bank (1000) and accounts receivable (2100) is also adjusted accordingly.

The same principle applies for fees.
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Adding notes (or comments) for each entry

When multiple entries are transcribed in the same GL account in the accounting package, it becomes difficult to identify
the origin of these amounts when reconciling the accounts. For example, most accounting software allow a comment (or
note) for each accounting entry. MLM allows the export of transactions with such "Notes".

You may add one or more notes among the following choices: 

 
Accounting  software  packages  can  generally  support  up  to  thirty  (30)  characters  for  comments.  MLM  will  remove
everything after the limit imposed by the particular software. It is therefore suggested to include only one or two of the
available descriptions.

To include a note: 

Click on one of the fields in the scroll menu. The chosen field will appear in the box on the right.

Press on the eraser icon  to eliminate the undesired choices.

Transaction dates entered in the accounting system

All transactions imported in the accounting system require a transaction date. MLM provides four options for this date,
depending on the type of data exported to the accounting system: 

Date entered Fields included Special explanations

Origination Date  Original
Principal

 Fees charged
for the APR
Calculation

If  the  Origination  Date  precedes  the  report  start  date,  the  principal  amount  and  the
APR  information  will  be  excluded  since  the  transactions  are  not  within  the  chosen
period.

Transaction Date
(from the column
"Pmt Date") 

or

Date in the
column "True Pmt

 All Line status
transactions 

The  date  listed  in  "True  Pmt  Date  (Grace/EFT)"  is  ALWAYS  used  instead  of  the  date
"Pmt Date" IF a date is entered in this column.

Thus, the accounting system will use this date even if MLM, at the mathematical level,
does not take it into account for the calculation of interest.

Important Note:  The "True Pmt Date (Grace/EFT)"  dates are only  used for  the "Pmt"
Line statuses. The date is  ignored for the Fees, Fees Paid,  Add. Princ.,  etc.  If  a  date is



Page 1076

© Jurismedia Inc., 2007- 2023

Date (Grace)" listed in the "True Pmt Date (Grace/EFT)" column for these other Line statuses, an error
will be reported. See the "Payment" Type Line statuses section.

Date entered at
the end of the
report

 All the totals
 All balances,

with the
exception of
the unpaid
portion
balances
(resulting from
a partial
payment for
example)

Date entered for
doubtful accounts
in the "Data" tab

 Doubtful
Accounts
(Record
Balance Date)

Location of the date in the tab "Data"

Modifying a report

An  existing  custom  report  may  be  modified  or  saved  under  a  different  name  and  include  only  a  few  changes.  In  the
Reports window, click on "Accounting entries". Select the existing report and click "Edit". Changes can then be made as
specified in the previous sections.

Please note that an existing report that is modified and renamed, will  not create a new report but  will  replace the old
report. To create a new report, first "Copy" the report, then modify (see next section).

Copying, renaming and deleting existing reports

To copy, rename or delete an existing report, click on the report, then use the right mouse click.

Using Creditor Participation Percentage or Amount

This option divides the transaction amounts based on the each Creditor's participation in the Record. Thus, an "Interest
paid" transaction for example, if two Creditors participate in the loan, will be divided in two based on the proportion of
each and the respective amounts will be returned in the report taking into account the debit and credit accounts of each
of the Creditors.

Check the option: Use Creditor Participation (Percentage or Amount)
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If  this  option  is  checked,  then  the  Creditors'  General  Ledger  (GL)  accounts  must  be  used  (usually)  for  each  item  as
opposed  to  a  static  account  or  a  GL  account  from  a  Record's  Custom  field  or  Accounting  ID.  By  using  the  Creditor's
Custom fields, the number of lines in the report will be multiplied by the number of Creditors present in each Record. 

By  indicating  to  which  General  Ledger  account  each  type  of  transaction  for  each  Creditor  belongs,  we  will  obtain  the
correct amounts distributed according to the participation percentage (%) or amount of each of the Creditors.

General Ledger type Custom fields linked to the Creditor

Usually, the GL number would only be numbers/letters/etc., but for 
educational purposes, a detailed text has been added 

Example in which the transactions will  be separated automatically based on the percentage of  participation of  each of
the Creditors:

 Amount paid: 1500 including 500 in interest and 1000 in principal

o Creditor ABC with a participation of 25%:  125 in interest, 250 in principal
o Creditor XYZ inc. with a participation of 75%:  375 in interest, 750 in principal
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Here  is  the  report  based  on  the  above  example.  All  of  the  amounts  are  separated  according  to  the  participation
percentage (up to 8 decimal points) or amounts for each of the Creditors:

One could also decide to produce a report combining the GL accounts linked to the Creditors (according to a participation
percentage),  linked to  the  Records as  well  as  static  accounts  (therefore always  the  same GL  number  regardless  of  the
Creditor,  Borrower  or  the  Record).  Thus,  the  report  lines  would  be  duplicated  only  for  the  transactions  that  are
distributed  to  multiple  Creditors  according  to  their  participation  while  the  other  lines  of  the  report  would  appear  as
normal with the mention "Creditor not determined". For example:
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To  find  out  more  about  Creditor  participation  percentages/amounts,  consult  >  Commonly  required  reports  >
Participation / Syndicated Loans.

Producing the export file

General

Once a report template is created as described above, in the "Accounting entries" window, choose the desired report (it
will be highlighted in blue), choose the start date and end date of your report and the inclusion or not of the Interest or
Transactions at the end date chosen.

Permission to create this report must be given to each specific user. In Tools > Users, check "Can produce an "Accounting
entries" Report".

For Record selection (Records included), only the ACTIVE Records will be taken into account unless the "Include CLOSED
Records" option is checked.

Four options are available:

1. All ACTIVE (and CLOSED if option is activated) Records;

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

2. All ACTIVE (and CLOSED) Records displayed in the Main Margill window (Record Summary window);

3. ACTIVE Records selected in the Main Margill window (Record Summary window): select (highlight) the desired Active
Records in the Main MLM window (Record summary). To do so, you can sort the Records as you see fit, display some
with the display filters or select them all with the CTRL-A key. The results order will be in the same as the selection
order made in the Main window. The first Record chosen (with a mouse click, for example), will  be the first line of
the report, and so on.
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4. All  Records from an Advanced Query,  no  matter  the  Record Status.  Before version 5.6,  only  ACTIVE Records were
included, even with a Query. 

IMPORTANT: 

 If the Record starts after or ends before (date of the last row of the table) the dates chosen in the start and end of
the report, this Record will be excluded from export.  

Then  press  on  "Create  Report"  .  If  no  irregularities  are  encountered,  the  results  window  will
appear:
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If  irregularities  had  been  encountered  following  the  calculation  and  analysis  done  by  MLM,  these  irregularities  would
have been displayed and can be copied (to Word for example) so you can do the corrections before producing the export
file.

The main irregularities are:

 GL Account number (or name) missing
 If a date is recorded for a Line status other than a "Payment" type Line status in the "True Pmt Date (Grace)" column,

that date will be ignored.
 If a Line status should be at 0.00 but is not.
 If the transaction "Due Pmt" is outside the period selected, it will be ignored.
 For the Line status "Not Set" and "Rate Change" for which a payment is other than 0.00, an entry error will occur.
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Obviously, it is suggested to correct any errors in Payment schedules or directly in the data prior to exporting
transactions from MLM to your accounting system.

The results window contains three tabs: "Summary", "Detail" and "By Account".

By default, the "Summary" tab is presented by showing the total of debits and credits and have the option to print and
export to the appropriate software.

"Detail" Tab

With the "Detail" tab you will see all transactions and be able to eliminate some from being exported. Thus, transactions
that  are  deselected  will  no  longer  appear  in  the  "Summary"  and  "By  Account"  tabs.  Furthermore,  irregularities  are
automatically unchecked because they could cause problems when importing into the accounting software.

The most important columns are those to the right indicating the account numbers and the values that will be included in
the debit and credit accounts.

"Summary" Tab
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The "Summary" tab provides a more accounting perspective of the data that will be exported to the accounting system.
The typical scenario will present the individual credit accounts (principal, interest and fees paid, for example) and a total
for the debit (bank).

It is from this tab that you can export the transactions to various formats and accounting systems.

See the Importing into Accounting packages (QuickBooks, Simply Accounting (Sage 50), Acomba) section, specific to each
of  the  accounting  packages  for  explanations  for  saving  the  files.  For  some software,  the  files  must  be  saved  in  a  very
specific folder since at launch, the software will automatically import the transactions. For others, a manual operation is
required. Once the file save folder is specified with the first export (or save), this folder will be remembered for the next
export.

A  file  can  also  be  exported  to  Excel,  as  text  (.TXT)  or  CSV  (Comma  Separated  Value)  files  or  simply  printed

without necessarily exporting to third-party software. 

When printing, all columns will be included, even if they are not displayed in the summary. To hide a column, click the
header of a column and right click with the mouse. You can then select and deselect the data you wish to display.

The  "Summary"  tab  also  calculates  the  total  debits  and  credits  to  provide  a  quick  overview  useful  for  the  bank
reconciliation. The totals are those provided for all  transactions displayed in the "Summary". If  transactions have been
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excluded in the "Details" tab, they will not be included in the "Summary" or in the totals.

"By Account" tab

If  a  detailed  export,  by  client,  is  not  required,  the  "By  Account"  tab  shows  totals  according  to  GL  account  number.
Amounts can thus be manually recopied to the accounting system or exported in CSV, Text, or Excel file.

A  spreadsheet  is  also  included  under  the  "Spreadsheet"  tab  which  allows  users  to  perform  some  basic  spreadsheet
operations (the tool is not as sophisticated as Excel). This is very useful to copy/paste partial data to Excel or other.

Time required to produce a report

See the special section to this effect: "Time required to produce reports".

Reversing exported entries

When a batch of entries (see Definitions and Glossary) is imported in the accounting software using MLM data and these
happen to be wrong for some reason, it is possible to re-export these, but reversed, thus essentially canceling  the first
batch import. The original entries will not be removed from the accounting system, but they will all be reduced to 0.00 as
the initial debits imported into the accounting system will be followed by new equivalent entries but in the credits and
vice versa for credits initially imported.

To reverse entries or some of these, under "Reports" select "Accounting Entries". At the bottom of the window on the
left, press "Recover exported entries":

The following window will  appear showing all  the exported files to date.  Choose the  file  to  recover and  press  "Open".
Make sure not to select a file that had already been reversed. These are identified with the letter "R".
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The  next  window  will  show  all  transactions  (Summary  window).  To  select  only  certain  transactions  to  reverse  and  to
export, go to the "Detail" tab and uncheck those transactions that should not be exported.
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Once the transactions are selected in the "Detail" tab, press the "Reverse"  button then come back to
"Summary" to see the transactions that will be exported. Once this operation done, you will notice the "Reversed Entries"
text at the top right of the window. 

Only transactions that  appear in  the "Summary" will  be exported by pressing the  Export  button .
Save the file in the appropriate folder for either an automatic import by the accounting software or for a manual import.
The "R" means that the file is a reversed file.

Thus, an amount that was first posted as a Debit will now be displayed in the Credit column, and vice versa.

The  saved  files  remain  in  the  MLM  database  for  18  months.  They  are  automatically  deleted  thereafter.  To  avoid
accumulating too much data, it is also possible, with the right mouse button, to remove the files one by one.
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Importing into Accounting packages (QuickBooks, Sage,  Acomba)

This section includes, for each of the accounting packages, explanations for importing the file generated by Margill Loan
Manager (MLM)

IMPORTANT NOTICE: In order to avoid any corruption of data in case of an import problem, it is highly recommended,
and should even be mandatory, to backup your accounting software data before importing third party data to your
accounting package.

QuickBooks Pro 

Sage (50, 300, etc.)

Acomba

QuickBooks Pro

Only versions of QuickBooks Pro and higher-end versions allow import to the General Ledger.

IMPORTANT WARNINGS ABOUT QUICKBOOKS IMPORTS:

1) The import of third party files to QuickBooks is a well documented source of problems, regardless of the software
that generates the file. The cause: the date format required in the import file to QuickBooks (IIF file type) is poorly
defined.  Thus,  a  date  with  this  format  for  example 11-03-2012 could  be  interpreted as  November  3  or  March  11.
Always  check  with  a  few  transactions  with  dates  that  can  be  reversed  (as  in  the  example  above)  if  QuickBooks
correctly interprets all dates. Particular vigilance is required during the first import.

Furthermore,  the  MLM  export  file  is  created  using  the  Windows  date  format  on  the  computer  where  MLM  is
installed.  If  your  QuickBooks  is  installed  on  another  computer  with  a  different  Windows  date  format,  the
transactions will  not  be  imported properly  and  QuickBooks will  not  warn you.  In  addition,  a  date  that  can  not  be
confused (e.g. 11/17 for Nov. 17) will be correctly interpreted whereas others may not!

For example, if on the MLM computer the date format is MM/DD/YYYY and on the QuickBooks computer, the format
is DD/MM/YYYY, your 11/03 date will be November 3, whereas QuickBooks will import the transaction as March 11!
But November 17 would be correctly entered. 

All computers involved should have the same Windows date format (Windows Control Panel > Regional Settings). 

2)  If  errors  were made by  creating the  IIF  import  file  in  MLM, QuickBooks may  not  pick  these  up.  For  example,  a
nonexistent account was included in the MLM export to QuickBooks file.  When importing this file, QuickBooks will
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not check whether or not this account exists and will simply create this account without further warning.

In the example below, the descriptive account of "Bank of America" was incorrectly entered, the false entry with an
extra "a" on "Americaa". QuickBooks nevertheless allowed the import while creating this "new" account with all the
transactions associated with it. The transactions that should have been recorded in the "Bank of America" account
will not be. Please be extra careful.

Special Notes when creating a report in Margill Loan Manager

QuickBooks offers a certain advantage over other packages since the GL may be identified by either a number or a unique
alphabetical description. For example, "Bank of America" is a description sufficient to identify the account without having
to enter an account number. 

Thus  in  MLM,  the  accounts  can  be  registered  with  text  instead  of  numbers.  In  the  example  below,  all  accounts  are
registered  with  text.  The  debit  account  "Principal  paid"  has  an  error  (double  "a").  A  correction  is  required  otherwise
QuickBooks will import the error while creating an account with this error. 

Importing a file

Importing a file generated by MLM is done manually by selecting "File" then "Utilities", followed by "Import." Among the
import choices, select "IIF File". The following window will appear allowing you to choose the IIF file created in MLM.
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Choose the appropriate file (you can sort by date to select the latest file). Press "Open". Unless there are compatibility
issues, QuickBooks will inform you that the data has been imported.

The transactions will be recorded in QuickBooks including the descriptive comments added in MLM.

Sage 50, 300, etc.

Only the Pro and higher-end versions (Superior and Quantum) allow the import of files to the General Ledger.

Importing a file generated by Margill Loan Manager (MLM) is done manually by selecting "File" then "Import / Export",
followed by "Import Transactions". The following window will appear allowing you to choose the file created in MLM.
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Press "Next". You can then backup your data (strongly recommended).

Then select the file created by MLM. When saving the file in MLM, it is suggested to save the file in the "DATA" sub-folder
under "Simply Accounting" (or other new name). Simply Accounting (Sage) will usually search in this folder by default.

One or  more text  files (TXT) will  appear.  Choose the  appropriate  file  (you can sort  by  date  to  select  the  most  recent).
Press "Open" then click "Next".

Sage will analyze the data to ensure a balance between the debits and credits, dates and so on. An import summary will
be created showing the successful entries and problems the case being.

Once the transactions are imported you will obtain a confirmation message.

Transactions will be entered in Sage including the descriptive comments added in MLM.
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Acomba

Two import modes are possible with Acomba: automatic and / or manual.

Automatic Import

In  Acomba,  the  automatic  import  into  the  General  Ledger  is  activated  when  you  run  Acomba,  provided  that  the  file
created  in  Margill  Loan  Manager  (MLM)  is  saved  in  the  company's  "Import"  sub-folder.  In  the  example  below,  the
company name is "COMPAGNIE DEMO". The "D:\Remote Users ..." is the installation path. Every time you run Acomba,
the software checks if a new file has the extension .00X (X representing the number of exports made from MLM). MLM
will automatically generate an extension with an increment of 1.

Thus,  the  first  export  file  will  be  named GLImport.001,  the  second,  GLImport.002,  and  so  on.  If  "reversed entries"  are
done in MLM (to cancel  the transactions previously exported), the file will  be named GLIMPORT_R.00X, where X is  the
next number in sequence.

Select "Import Transactions in the Current Period" and press "Import". You can also check the file before importing with
the "View File" button. The document will look like this:

Then  answer  the  question  "Do  you  want  the  system  to  automatically  convert  to  mixed  case?".  Answer  "Yes"  unless
otherwise desired.
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Processing data:

The transactions will then be imported into Acomba. 

If the import is successful, the file to import the entries, Glimport.00X will be deleted automatically.

If a problem occurs during import, the "GLimport.err" file will be created. The system will include the problem file name
followed  by  a  list  of  errors  encountered  while  attempting  to  import.  If  the  "GLimport.err"  file  already  exists  from  a
previously failed import, the new errors will simply be added to the existing file.

By clicking on "Yes", a list of errors will be displayed:

Transactions will be entered in Acomba including the descriptive comments added in MLM.
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Manual import

An  import  may  also  be  done  manually.  In  the  Acomba  "Input"  tab,  select  "Utilities",  then  "Import  Data".  Select  the
"Transactions  to  the  General  Ledger  (GLIMP)"  option  (under  "Import  File  Format")  and  chose  "Transactions"  under
"General Ledger". Click on "Import". Select the file to import that should be in the company's "Import" sub-folder.

The process then proceeds exactly as described in the "Automatic Import" section.

   

Special Events Report

As of Margill Loan Manager version 5.2.1, the "Special Events" report is no longer automatically included in the software,
but is still available under custom reports (password required). Contact the Margill Team.

The Special Events report provides a Record by Record view of all "special events" in the selected Records. A special event
is created by assigning Line statuses to individual lines in a loan as seen in the example below: 
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The report may serve to determine specific trends in the portfolio. For example, are some Records showing and unusual
number of missed payments or late payments? Which Records show abnormalities as compared to the other Records?
The  report  can  also  produce  a  list  of  all  comments  included  on  each  individual  payment  line.  You  can  then  identify
abnormalities quickly.

First choose the Records to include :

1. All Records;

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

2. All Records displayed in the Main Margill window (Record Summary window);

3. Records selected in the Main Margill window (Record Summary window): select (highlight) the desired Records in the
Main  MLM  window  (Record  summary).  To  do  so,  you  can  sort  the  Records  as  you  see  fit,  display  some  with  the
display  filters  or  select  them all  with  the  CTRL-A  key.  The  results  order  will  be  in  the  same as  the  selection  order
made in  the  Main  window.  The  first  Record  chosen  (with  a  mouse  click,  for  example),  will  be  the  first  line  of  the
report, and so on.

4. Records from Advanced Query.

The following window will appear allowing you to choose the appropriate dates and events to include in the report:
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Choose  whether  to  create  a  full  report  (thus  up  to  the  last  payment  of  each  of  the  selected  Records)  or  up  to  (and
including) a particular date.

Then choose the events to include in the report. If a particular event is not relevant to you, do not choose this event. To
choose  an  event,  click  on  the  event  (or  use  Shift  or  Ctrl  and  click  on  the  multiple  events).  The  line  or  lines  will  be

highlighted in blue. Then click on . This will check , thus include, non checked lines OR uncheck
those that had already been checked.

The "Select All" function selects all Line statuses and the "Deselect All" unchecks all Line statuses.

On  the  right  of  the  window,  you  may  choose  the  headers  to  include.  This  is  the  client  data  that  will  appear  on  each
printed Record header.

If comments are included on certain lines, these may be included in the report.

Finally,  in  order to obtain a  better visual  perspective of  a  Record's events -  for  example the number of  paid  payments
versus missed payments, graphics may be included.
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Page 2 of the report (if line comments are included):

See also Record List. This powerful report can also provide quite a bit of information for all Records, up to a certain date
or for a period or time.
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Detailed Schedules (Results table)

A detailed schedule (Payment schedule or amortization schedule) may be produced (printed or exported) for any Record
or for multiple chosen Records.

These reports can only be partly modified to include or exclude other data (columns) even if columns are hidden or their
position changed. Only the "Start Date" and "Interest Rate" columns may be hidden when printing (or saved as PDF or
other format). Exporting the Payment schedule to a spreadsheet (Excel)  with the right mouse click would allow you to
create a custom Payment schedule that could then be printed.

IMPORTANT:  the  interest  shown  in  this  report  is  the  accrued  interest  that  may  or  may  not  be  equal  to  the  paid
interest.  As  for  the  "Principal"  column,  this  is  mathematical  principal,  not  accounting  principal.  See  the  important
distinction  between  mathematical  and  accounting  concepts  in  the  Accounting  Data  and  Line  status  and  Accounting
Data chapters.

Margill Loan Manager offers two methods for printing the complete or partial detailed schedules. 

1) Report for a single Record  

If the Record is open, the schedule will appear. Click on "Print" . A few report types will be available:

Select  "Payment schedule" and  the  following  window will  appear  allowing  you  to  choose  the  details  to  include  in  the
report:

The "End date method" section offers the possibility to include the last day's interest and transactions.
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You can choose among the print options or export in a specific format.

The report's header includes several elements such as the "Description" taken from the "Data" window. Ordinarily, this
field should be used to include a header such as a logo, the organization’s name or the Creditor company. However, the
field is often mistakenly used to enter notes (see the specific "Notes" option). You can uncheck this option and the "Other
Info" (taken from the "Borrower" window) which if too lengthy affects the report's look.

The nominal interest rate and the effective interest rate applicable will appear in the printed Payment schedule header,
either on the production date of the report or at the current date (if  the report is produced up to this date). In earlier
versions  of  MLM,  the  rate  that  appeared  in  the  header  was  the  rate  initially  entered  in  the  Record.  If  the  Record
Origination date  precedes the  report  production  date  (current  date),  the  interest  rate  of  the  first  line  of  the  Payment
schedule will be displayed.

The schedule can also easily be attached to the Record as a PDF file or can be sent by email with the "Attach" button. The
PDF file created is not exactly the same as with the "Print" button and contains less detail and options.

In the Record window, press the "Attach"   button then choose from the following three options:
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If  the "Attach PDF Payment schedule to Record" option was selected, you will  have the  option  to  view the  document.
Whether  you  open  the  document  or  not,  it  will  be  attached  to  the  Record  (will  be  found  in  the  "Data"  window  >

"General"  tab  >   -  the  paper  clip  indicates  a  document  is  attached).  The  file  will  be
named automatically.

For emailing, the following window will appear. Press "Email PDF". If your workstation is properly configured (the email
software actually used is configured as the default email program in Windows), the software will open and the PDF file
will be attached. You will simply need to enter the recipient's email.

If your workstation is not configured correctly or if you are using a web platform for sending emails (Lotus Notes, Gmail,
Hotmail, etc.) you will have to send the documents manually.

2) Printing multiple Records

You may print one or more detailed schedules in a single operation by going through the "Record Summary" window. 

Choose the desired Records to print (these must be highlighted using the Shift or Ctrl keys and the left mouse click). Then
click on "Reports". The following window will appear:
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Click on "Detailed Schedule(s)". The "Report Printing Settings" window will open, allowing you to choose what to include
in the report.

First, choose the Records to be included:

1. All Records;

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

o In order to be able to produce a report with all Records in the database, make sure that the "Can produce
Reports for all Records" is checked under Tools > Users. 

2. All Records displayed in the Main Margill window (Record Summary window);

3. Records selected in the Main Margill window (Record Summary window): select (highlight) the desired Records in the
Main  MLM  window  (Record  summary).  To  do  so,  you  can  sort  the  Records  as  you  see  fit,  display  some  with  the
display  filters  or  select  them all  with  the  CTRL-A  key.  The  results  order  will  be  in  the  same as  the  selection  order
made in  the  Main  window.  The  first  Record  chosen  (with  a  mouse  click,  for  example),  will  be  the  first  line  of  the
report, and so on.

4. Records from Advanced Query.

Choose the "End date method". 

By default, full schedules will be produced. 

Detailed schedules may also be printed up to  a  specific  date.  This  allows you  to  produce schedules that  include totals
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(total interest, balance, payments) up to that date, including the day's transactions but NOT including the day's interest.

To INCLUDE the last day's interest, check "Annual Totals" (and/or Quarterly Totals") and the "Fiscal year-end" choice will
become available. Any date may be entered here and the report will include the totals up to and including this date. See
also End of year totals.

Please  note:  even  if  the  report  is  requested  up  to  a  specific  date  and  the  Annual  Percentage  Rate  (APR)  is  to  be
computed, the APR rate provided will be that for the entire schedule, thus up to the last payment.

When previewing the report, only the first Record will be shown, but all those selected will be printed thereafter.

To go back to the Main MLM window, click on  or on Exit.

End of year totals

Regardless of the dates at which the payments are made, the Detailed schedules report allows you to specify a sub-total
for quarterly or annual totals.

For  example,  in  the  case  of  recurring  monthly  payments  on  the  11th,  you  may  want  to  know  the  total  interest  on
December 31st 20xx. For a specific Record, press on “Print”. The "Report Printing Settings" window will appear. You will
then be able to specify the date at which the totals are to be included.

If, for example, December 31st is entered, the totals will include interest, principal and balance due on December 31st, at
midnight.

As shown in the example below, two new “virtual” lines (highlighted in this example) will be included in the report. These
two  lines  will  show  payments  of  0.00,  will  not  be  numbered,  but  will  indicate  the  total  accrued  interest  during  this
irregular period as well as the effect of that interest on the balance. 
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Quarterly  and  annual  totals  are  calculated  from  the  previous  total,  not  from  the  previous  payment.  In  the  quarterly
report example above (fiscal year ending on December 31st), Quarter 4 totals cover the period between October 1st and
December  31st.  It  does  not  start  on  October  11th.  Therefore,  the  total  interest  on  December  31st,  2006  is  calculated
using the following amounts:

Included 348.58
Interest line 9: not included since includes Quarter 3
interest

1042.15

Included 1021.76
Included 1001.15
Included 652.42

Total 4066.06
Less Interest line 9 1042.15
Total Quarter 4 3023.91

The Quarter 4 principal is calculated more easily and takes into account payments made on lines 7, 8, and 9. The principal
on line 7 is included in the payment made on October 1st, which reimburses 1827.83 of the principal.

Line 9 1957.85
Line 10 1978.24
Line 11 1998.85

Total 5934.94

If the payment date corresponds to the day following the day specified for the report (for example payments on the 1st
of the month and totals on the last day of the month, 30th or 31st), a single unnumbered line (here boxed in red) will
appear per quarter since the information that would be displayed on the second line already appears in the report.

In  the  example  below,  interest  in  line  3  (from  December  1st  to  December  31st)  are  not  part  of  Quarter  1  since  this
quarter starts on January 1st 2007. However, the payment and principal of that line are accounted since the payment is
made on January 1st. 
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IMPORTANT: the interest shown in this report is accrued interest that can or cannot be equal the interest paid. As for the
"Principal"  column,  it  is  mathematical  principal  and  not  accounting  principal.  See  the  important  difference  between
mathematical and accounting concepts in the Accounting and Line status and Accounting Data chapters.

Print page format

By default, the Payment schedules will be printed in the Landscape format. If you wish to obtain the Payment schedules
in Portrait format, in the Windows print dialog box below, click on Preferences:

Then, depending on your printer, various printing options will become available.

Special header for Payment schedules

A Detailed schedule may contain a prominent header that can include a company name and its address for example. In a

Record's "Data" window , fill in the "Description" field. 
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The text in this field may be formatted as desired. The right mouse click  allows basic formatting to take place:

 
Direct import from a Word (Wordperfect or other word processor) formatted text can also be done. Most (but not all)
images are supported.

See the example below:

"My Company Inc." and the address, using a specific style, was written in a word processor and copied (Ctrl-c, Ctrl-v) to
the Description field of the Record Data.

Resulting printed Detailed schedule:
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If  this section served to take notes (not suggested however - it  is  rather suggested to use the Notes section),  it  is  thus
suggested to exclude this section from the report.  Uncheck "Data window "Report Header"" from the "Report Printing
Settings".

The Detailed schedule may also be produced between two dates and inserted in a letter or contract for example, using
the "Document Merge" tool.

   

Global Summary

The Global Summary report provides a snapshot of the desired Records. The report will list, based on each Record status
(Draft, Pending, Active, Closed, Archived or Bad debt) total principal, additional principal (if tagged as such in Line status),
total interest, total payments, total negative payments (excluding additional principal tagged as such in Line status) and
balance.

This  report  may  produce  totals  up  to  the  final  date  of  each  of  the  Records  or  include  totals  up  to  a  specific  date  or
between two dates.

To fully understand this report, read the notes at the end of the report.
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Record List Summary

The  Record  List  -  Summary  is  meant  to  provide  the  user  with  a  quick  overview  of  all  Records  selected  in  the  Record
Summary window.

The report will  include all  selected Records with  its  number  (MLM reference number),  your  Record number,  Borrower
name,  origination  date,  initial  principal,  total  interest,  principal,  balance,  loan  guarantees,  and  write-off  date  (if
applicable).

This report may produce totals up to the end of each of the Records or include totals up to a specific date or between
two dates.

See the Record List (Customized) report which provides much more information based on you specific needs.
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Doubtful Accounts Report

A Doubtful Accounts report will be produced for each of the Records selected in which a percentage greater that 0.00%
has been assigned to the "Allowance for doubtful accounts" in the "Data" window.

From the Reports window, choose "Doubtful Accounts" report.

The report will list all doubtful accounts identified as such in each individual Record's "Allowance for Doubtful Accounts"
section in  the Record Data.  Please note that  the date indicated will  include the  balance up  to  and including  that  date
(including that day's transaction, the case being, but usually excluding that day's interest).

Margill Loan Manager offers three doubtful accounts scenarios:

1) Doubtful accounts based on the balance at the date indicated in the Record Data window (thus x% of the balance on
date  y).  The  amount  will  be  based  on  the  balance  on  that  day  after  the  payment  has  been  made  (had  there  been  a
payment) but will not include that day's interest:

 

Select  the  Records  to  be  included  in  the  report  and  "Full  report"  (many  options,  including  the  Advanced  Queries  are
explained in other sections dealing with reports):

2) Doubtful accounts based on the balance at the end of the Payment schedule - last payment of the schedule (even if
balance = 0.00).  This will  be applied if  no date is  indicated in the Record Data window but  if  a  percentage is  included.
Choose the "Full report" choice as in 1) above.

3) Doubtful accounts based on the date indicated in the report request or the date indicated in the Data window if this
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date precedes the report date. Choose "Report up to and including (date)" and specify the appropriate balance date to
be used to compute the doubtful portion.

 

This date will  apply  whether a  date is  indicated or  not  in  the  Record "Data"  window.  The date  indicated in  the  report
request will override the date indicated in the Record Data only if the date indicated in the "Data" window is before than
entered for the report. 

If  the "Data" window Doubtful accounts date is later that the date entered for the report,  then the Record will  not  be
considered as doubtful (at the report's date). In this latter case, the report will include the Record stating the percentage
but a note will highlight the fact that it is not yet considered doubtful. Furthermore, in the summary at the bottom of the
report, this Record will not be included in the totals since not yet doubtful. To obtain a report that does not factor in this
logical constraint, use Record List which allows a complete override of the Data date entered. 

The  last  day's  interest  may  also  be  included  by  checking  "Include  last  day's  interest".  This  could  be  checked  if  you
included the end of month (year or other) as the date, for example 12-31-2014 but should not be checked if the first of
the next period is entered (as in the example above, 01-01-2015).

The report will list all included Records (with more than 0.00% in the "Allowance for Doubtful accounts" field) and at the
end will provide a overall summary of the total doubtful accounts. The average percentage will be based on the Doubtful
Accounts balance of each of the selected Records. In the example below, 11.8287% is obtained by dividing 55,151.86 by
466,252.64. 
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Pages 4 and 5 of Doubtful Accounts Report 

See also Doubtful accounts and Record List.

   

Credit Reporting Module

Reporting to credit bureaus can be done easily with MLM alongside Credit Manager 4 (CM4-5) software (version 5 (CM5)
was released in 2019 and MLM is up to date for this version) developed by The Service Bureau (www.tsbsoftware.com).

Credit reporting to agencies is not for all lenders. There are often a minimum number of loans that must be reported as
well as industry-specific reporting aspects. It may take months to fully understand the intricacies related to reporting.

The collaboration between The Service Bureau and Margill Loan Manager hopefully will help you with this reporting.

Reporting is available for the US and Canada.

The diagram below summarizes the interaction between MLM and CM4-5-5:

http://www.tsbsoftware.com
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See: 

Setting up Credit Reporting

Entering specific credit data

Exporting from MLM to CM4-5

Important Notes:

 ALL Records, except “Draft” and “Pending” Records, are included in the report as long as a consumer is included in
the “Borrower” tab under “Credit Report”.

 Close  to  100  fields  can  be  included  in  a  Metro  2  report.  Only  some of  these  are  mandatory  (names,  full  address,
Account Status, Account Type, ECOA Code, Portfolio Type, etc.). Depending on the field type entered for one field,
this may affect another.

 A  basic  compliance  check  is  performed  in  MLM  (for  mandatory  fields)  but  the  true  compliance  check  is  made  in
CM4-5. Thus, especially at first, and for less experienced users who report, choices made in MLM may not comply to
Metro  2  guidelines.  It  is  thus  important  to  consult  the  very  thorough  CM4-5  Help  Manual  and  the  Reporting
Guidelines (available for US and Canada through your credit agency).
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o Credit  Manager  will  test  for  all  interactions  required  by  the  Metro  2  format.  You  may  thus,  in  some
situations, have to make changes in CM4-5, such as adding a First Delinquency Date either in CM4-5 or in
MLM. It is suggested to make the changes in MLM before doing any changes directly in CM4-5. If changes
are made directly in CM4-5, these should be noted and adjusted over time.

 Especially at the very first import, you may need to export the MLM data to CM4-5, run a compliance check, make
the necessary adjustments in MLM, rerun the report and reimport to CM4-5. This may have to be done a few times.
In  some situations,  depending  on  the  compulsory  field  choices  made  (especially  the  less  common  Account  Status
options), the data may have to be changed manually in CM4-5 but this should be the exception. 

 It is most important to export from MLM to CM4-5 every month. Otherwise, the CM4-5 Payment History Profile will
be outdated as compared to the MLM history. 

o For example, when producing the latest credit report, an account may be at 150-179 days late in MLM, but
if the previous month’s report had not been exported from MLM to CM4-5, there will  be a  reporting gap
and CM4-5 may expect a maximum 120-149 days late payment, thus producing a compliance error in  the
late Records. 

o Such errors will have to be fixed (updated) manually in CM4-5 as opposed to fixed in MLM, since the MLM
data is properly updated.

 You cannot send a report to credit agencies if the Activity Date is older than four (4) months.

 When a payment is late or is not paid, it is imperative to properly enter this information. Since the credit agencies
consider a payment to be late when unpaid within 30 days, a payment which is not paid within 30 days should be
considered unpaid and the proper "Unpaid" Line status entered along with a payment of 0.00. The amount that
SHOULD have  been  paid  must  be  entered  in  the  "Expec.  Pmt"  column  thus  calculating  an  Outstanding  amount
used to compute the ageing of accounts, THE key component in credit reporting. The "Late Payment" Line statuses
should only be used for payments that are only a few days late, with a maximum of 29 days late. Using one of the
"Late Payment" Line statuses will NOT generate an Outstanding amount even if a date is contained in the column
"Pmt Due Date", thus not calculated in the ageing. See "Distinction between Late payments and Unpaid payments
that are paid later" sub-section in the "Late or partial payments" section).

 If  for  some  reason,  as  an  experienced  agency  reporter,  there  seems  to  be  a  particular  situation  that  cannot  be
handled properly between MLM and CM4-5, please contact Jurismedia (support@margill.com) so we can look into
the issue.

See next section: Setting up Credit Reporting.

   

Setting up Credit Reporting

Your organization must have an agreement with at least one credit bureau either to report directly, or through a third
party processor.

Credit Reporting Bureaus: Equifax, Experian, TransUnion, Innovis

Third  party  processors:  The  Service  Bureau  (TSB)(www.tsbsoftware.com)  and  Credit  Builders  Alliance  (in  the  US),  the
latter, available for non profit organizations only (www.creditbuildersalliance.org).

The  bureaus’  reporting  policies  vary  as  to  the  volume they  will  accept  through  a  processor  and  the  type  of  accounts
which they are reporting. If a Creditor does not meet the bureaus reporting minimums, the next step is for the Creditor
to see if they allow them to report through a processor. If not, Creditors will not be able to report until they meet the

mailto:support@margill.com
http://www.tsbsoftware.com
http://www.creditbuildersalliance.org
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bureaus’ minimum reporting standards. A bureau must approve the Creditor to report through a processor.  

How to report to credit bureaus: www.tsbsoftware.com/how-to-report-credit.jsp

Third Party Processing/Stacking services is also used by Creditors who wish to simplify the up-load process. 

For more information on TSB services, consult: www.tsbsoftware.com/service-processing-stacking.jsp.

You should obtain a license of Credit Manager 4 (CM4-5) which will:

 Import all Borrower credit data from Margill Loan Manager (MLM);

 Check for Metro 2 compliance errors;

 Produce the Metro 2 format file to be sent to the credit bureau(s). 

 See www.tsbsoftware.com/metro2-credit-reporting-software.jsp

CM4-5 can be ordered through Jurismedia: 1-877-683-1815 (sales@margill.com) 

Credit Manager 4 Setup 

Once CM4-5 is installed, a basic configuration must be done in the software. Please consult the CM4-5 Help Manual for
detailed information. Below is a quick overview:

 Company information is gathered with the Company Information Wizard the first time you run CM4-5. The company
information  is  saved  in  the  CM4-5  database.  The  information  you  enter  will  be  used  for  software
registration/activation.  

 General Setup: Go to Tools > Options > Credit Manager 

 Reporting configuration:

o Subscriber ID / Codes are mandatory for each Credit Bureau you are approved to report to. Go to Tools >
Options. Please note that TransUnion may not assign a subscriber ID until after the first time you report.

o The  Service  Bureau  ID  (Record  id)  is  also  required  before  reporting.  Go  to  Tools  >  Options  >  The  Service
Bureau tab.

 There is no need to enter any of your Borrowers’  data in  CM4-5 since these will  be imported with your first  MLM
export to CM4-5.

Setting up the import connection between MLM and CM4-5

 CM4-5  must  be  configured  in  order  to  import  the  file  created  in  MLM.  This  can  be  done  in  a  few  minutes…
(Jurismedia can also give you a hand – 1-877-683-1815).

 In CM4-5 go to File > Install Vendor Import. You must then select the "Metro2" subfolder located in the MLM install
folder (the location on the server or on the local machine where Margill Loan Manager is installed) or in the location
determined by the MLM Administrator (MLM Data folder). After finding the Metro2 subfolder, click OK.

https://www.tsbsoftware.com/how-to-report-credit.jsp
http://www.tsbsoftware.com/service-processing-stacking.jsp
http://www.tsbsoftware.com/metro2-credit-reporting-software.jsp
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 CM4-5  will  indicate  that  the  two  files  required  have  been  located  (Credit_Manager_MLM  and
Margill_Loan_Manager files). Click on “Install” and the process will be completed.

Margill Loan Manager Setup

 In MLM, the Credit Reporting module must first be activated (Tools > Settings > System settings (Administrators) >
Modules > Credit Reporting).



Page 1114

© Jurismedia Inc., 2007- 2023

 The country must be chosen - this should not be changed afterwards.

 The “Metro 2  Creditor  ID”  should  be  entered (this  is  The  Service  Bureau  ID).  One  company  usually  reports,  but  if
multiple Creditors are reporting, then multiple IDs can be entered (Pro and Elite versions of CM4-5).

 To reduce the number of “Account Types” to choose from as you input data in MLM, you may configure the system
to show only the Account Types that apply to your business. Go to "Account Types Displayed" and deselect all non
relevant  Account  Types.  Before removing these,  please read the  instructions  in  MLM  and  go  to  CM4-5  to  see  the
Account Types that apply to your country and industry.

Once these steps are done, you may start entering the reporting data in MLM.

 All  credit  data  should  be  entered  in  MLM  only  (not  in  CM4-5).  Very  rarely  should  any  data  be  changed  in  CM4-5
directly, since subsequent MLM exports to CM4-5 will update and overwrite the existing CM4-5 data.

 Fields with “AUTO” entered as the default will be computed automatically based on the payments made or missed.
The  corresponding  data  will  only  be  included  in  the  report.  The  fields  in  the  Credit  Report  tab  should  remain  at
“AUTO”. If the field value is other than "AUTO", this new value will be reported and never again updated as the loan
evolves. 
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See next section Entering specific credit data.

   

Entering specific credit data

Credit reporting data may be entered in Margill Loan Manager (MLM) in various locations:

 Under "File" in the Main MLM window:

o Borrower: "Credit report" tab
o Employer: "Credit report" tab
o Creditor: "Credit report" tab

 In the Record per se:

o Credit Report  tab. Data is entered in various tabs with compulsory data indicated with
an red asterisk * for the loan itself (Record tab), the Borrower, possibly the Co-Borrower and the Creditor.

o Even  if  the  State/Province  and  Country  are  entered  in  the  "Borrower"  tab,  these  must
nevertheless be specified for the Borrower (and Co-Borrrower) since they must be reported in standardized
form from a pull-down menu. 

 All credit data should be entered in Margill  only (not in CM4-5). Very rarely should any data be changed in CM4-5
directly, since subsequent MLM exports to CM4-5 will update and overwrite the existing CM4-5 data. Data should be
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added in CM4-5 ONLY if the data is not available in MLM.

o For  some  industry-specific  data,  MLM  may  not  include  some  fields  that  are  mandatory.  For
example, for a Debt Buyer or Collection Agency, the "Original Creditor Name" must be submitted
to the credit agencies. Since this field is not included in MLM, it must be added in the appropriate
CM4-5 tab for each Borrower.

 Except in very peculiar situations, data should be entered in CM4-5 only when a Record is closed and when MLM is
no longer required for credit reporting since no new data would get reported. It  is recommended for these closed
files to change the final (no longer computed) fields from AUTO to the final status that is to be reported. If a field is
left as AUTO and the data for this field is changed in CM4-5, the automatically calculated field in MLM will  replace
the CM4-5 field.

o For  example,  a  loan  is  closed  with  an  outstanding  balance  of  1000  that  is  never  paid  off.  Since  these
accounts must nevertheless be reported, if the Account Status field is 30 days when the account is closed,
"Account 30 days past due" will be reported. Next month, even if the account is closed, AUTO will calculate
the the account is now 60 days past due and so forth. So AUTO should not have remained as the Account
status  but  rather,  changed  to,  depending  on  the  case,  to  "97-  Unpaid  balance  reported  as  a  loss  by
Creditor".

 Fields with "AUTO" entered as the default will be computed automatically based on the payments made or missed.
The corresponding data will  only be included in the report, not  in  the window (which will  remain as "AUTO"). The
fields in the Credit Report tab should remain at AUTO. If the field value is other than AUTO, this new value will  be
reported and never again updated as the loan evolves. In order to report 0.00 or other number, uncheck "AUTO". 

The following fields can be or must be reported to credit agencies. The explanations included are meant to
provide  a  quick  reference,  although  a  user  who  reports  to  credit  agencies  should  already  understand  the
process  very  well.  It  is  strongly  suggested to  consult  the  CM4-5  User  Guide as  well  as  the  US  or  Canadian
Credit  Reporting  Guidelines  (Metro2)  available  through  your  credit  reporting  bureau  or  through  the
Consumer Data Industry Association (CDIA).

Report data element What is reported

Account Number MLM Record Identification

Account Status Defined  automatically  if  set  to  AUTO  for  statuses  11,  71,  78,  80,  82,  83,  84  based  on  the
Outstanding  Total  (Balance)  in  the  Payment  schedule  and  the  date  at  which  this  amount
became outstanding.

These  statuses  will  automatically  be  updated  when  a  report  is  generated.  Only  the  seven
statuses can be updated. No other.

OR

Data in the corresponding field under "Credit Report" for all other statuses besides the seven
mentioned above.
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When a  payment is  late  or  is  not  paid,  it  is  imperative  to  properly  enter  this  information.
Since  the  credit  agencies  consider  a  payment  to  be  late  when  unpaid  within  30  days,  a
payment  which  is  not  paid  within  30  days  should  be  considered  unpaid  and  the  proper
"Unpaid" Line status entered along with a payment of 0.00. The amount that SHOULD have
been  paid  must  be  entered  in  the  "Expec.  Pmt"  column  thus  calculating  an  Outstanding
amount  used  to  compute  the  ageing  of  accounts,  THE  key  component  in  credit  reporting.
The "Late Payment" Line statuses should only be used for payments that are only a few days
late,  with a  maximum of  29 days  late.  Using  one  of  the  "Late  Payment"  Line  statuses  will
NOT  generate  an  Outstanding  amount  even  if  a  date  is  contained  in  the  "Pmt  Due  Date"
column, thus not calculated in the ageing.

Account Type Data in the corresponding field under "Credit Report".

Actual Payment Amount Total payment amount for the month being reported.

ALL positive payments will  be included in the payment amount being reported. This includes
"Payment" Type Line statuses as  well  as,  for  example,  Paid Fees and Penalties paid,  positive
Adjustments, etc.

Amount Past Due MLM  will  report  the  amount  present  in  the  "Outstanding  -  Total  (Balance)"  column  of  the
Payment  schedule.  This  will  include  outstanding  principal  and  interest  but  will  exclude  any
fees, penalties, etc.

An amount will be reported only if the outstanding amount is outstanding for over 30 days and
if there is an amount outstanding at the report end date (end of month).

If for various reasons a Borrower's Payment schedule includes an Outstanding amount but, as
the Creditor  you  feel  that  the  Borrower  should  not  be  penalized (forbearance for  example),
you  can  change  the  "Expec.  Pmt"  amount  for  that  period  so  that  the  Outstanding  becomes
0.00. 

You can also adjust the "Expec. Pmt" based on the Amount Past Due that should be reported.

Company ID For multiple company reporting (using Credit Manager Pro or Elite), the "Company ID" is used
to  identify  the  company  reporting  to  the  credit  agencies.  When  submitting  multiple
companies, each company (Creditor) reporting must do so individually.

Compliance Condition Data in the corresponding field under "Credit Report".

Credit Limit Data in the corresponding field under "Credit Report".

Current Balance The true balance (principal, interest, fees and all other) on the last day of the report including
interest of this day as well as payments paid and additional principal, fees, etc. added on this
day.

Date Closed Data in the corresponding field under "Credit Report".

Date of Account
Information

Last day of the month of the reporting period.

Date of First Delinquency MLM will automatically determine this date. It will report a Date of First Delinquency if the two
following  conditions  are  met:  there  is  an  amount  Outstanding  at  the  report  date  (end  of
month) and if the Outstanding amount is due for over 30 days.

If  an  account  is  delinquent,  becomes  current  and  again  becomes  delinquent,  the  second
delinquency date will be reported, not the first.

A date may be entered in  this  field in  special  circumstances.  If  you do report  a  special  date,
make  sure  that  the  Outstanding  amount  on  this  date  (Pmt  Date)  is  the  right  amount,  since
MLM will report the amount indicated in Outstanding – Total (Balance) column of the Payment
schedule.
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Consult the Credit Manager Help file for specific industries and particular situations.

Date of Last Payment The last positive Due or Paid (all Paid Line statuses) payment of the Payment schedule will be
reported here.

Date Opened "Data" window - "Origination Date".

Highest Credit Will report the highest balance reached (principal, interest, fees and all  other) up to the end
date  entered  (inclusively).  Will  report  the  initial  loan  amount  if  the  balance  never  increases
above this amount.

Interest Type Data in the corresponding field under "Credit Report".

Original Charge-Off Amount Data in the corresponding field under "Credit Report".

Payment Rating Data in the corresponding field under "Credit Report".

For Account Status = 05, 13, 65, 88, 89, 94, Payment Rating must be filled out. MLM will test
this and advise you if the Payment Rating must be selected.

Portfolio Type Data in the corresponding field under "Credit Report".

Scheduled Monthly
Payment Amount

MLM will take the amount from the Data window entered or computed in the "Payment" field.

If the payments are other than Monthly, MLM will automatically compute a monthly amount.

If  the  "Payment  Frequency"  is  by  "Days",  a  monthly  payment  amount  will  be  computed
automatically taking into account a 365.25 day year. Two exceptions are weekly (7 days) and
biweekly  payments  (14  days)  for  which  the  payments  are  multiplied  by  4.33  and  2.16
respectively.

If "Irregular" is used, please see the Help (?) text in MLM.

If  the  scheduled  payment  amount  is  changed  in  the  Payment  schedule  from  the  original
"Payment"  field  (Data  window),  please  enter  the  new  "Spc.  Scheduled  Pmt  Amt"  in  Credit
Report > Record tab.

If an amount is entered in the "Spc. Scheduled Pmt Amt" (Credit Report > Record), this amount
will be reported as opposed to the amount in the "Payment" (Data window).

See the Credit Manager Help file for specific industries and particular situations.

Special Comment Data in the corresponding field under "Credit Report".

Terms Duration By  default,  Margill  will  report  the  number  of  payments  entered  in  the  Data  window  under
"Term"  (which  is  most  often  equal  to  the  Amortization  period).  For  Mortgages  (based  on
“Portfolio  Type”)  this  will  be  reported  in  number  of  YEARS  and  for  Installment  loans  (and
Leases) this will be reported in MONTHS.

If a number is entered in "Spc. Terms Duration" ("Credit Report" - "Record"), this number will
be reported as opposed to the number of payments (converted to months or years) entered in
the "Data" window.

Terms Frequency Since MLM only allows credit reporting on a monthly basis, the "Terms Frequency" will always
be reported as "Monthly" except for "Deferred" or "Single Payment" loans. For these two loan
types, the user must select the appropriate Terms Frequency.

Even if  the scheduled and actual payment amounts are other than monthly,  all  amounts are
reported  on  a  monthly  basis  (unless  otherwise  required  by  Metro  2),  thus  creating  an
equilibrium in reporting.

All  other data is  related to the Borrower,  Co-Borrower or Employer and are taken from the basic information for each or
from the data specifically required for credit reporting.

State/Province and Country are taken from the Credit Reporting data since these are standardized data (pull-down menu).
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Exporting from MLM to CM4/CM5

Before being able to export data from MLM, all mandatory fields (indicated with *) must be entered in the Credit Report
tab for the Borrower, Co-Borrower (if there is one) and for the Employer (case being).

ALL Records are included when producing a report except “Draft” and “Pending” loans, as well as when no Borrower is
specified in the Credit Report tab. You can exclude Active Records if needed when a Borrower is specified. To exclude a
specific Record, the "Record Submitted to Metro 2" option must be unchecked.

In  order  to  exclude  multiple  Records  in  batches  (or  to  include  them),  use  the  Global  Changes  module  accessible  from
MLM  Main  Window  (Record  Summary),  instead  of  opening  each  Record  one  by  one  and  checking  or  unchecking  the
include option: 

To produce a report, click on Reports > Credit Agency Report. All reports are MONTHLY but can be produced on any day
of  the  month.  Once a  report  has  been submitted,  this  day  of  the  month  should  (must)  be  used  for  all  future  reports,
otherwise compliance issues could result.

When  a  report  start  date  is  entered,  MLM  will  add  exactly  one  extra  month  to  obtain  the  end  of  report  date  which
cannot be changed (only the start date may be changed).

MLM will check for basic compliance issues (CM4-5 checks for any other issues before sending in Metro 2 format) and will
provide a list of elements that must be solved before export to CM4-5. MLM will check for:
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 Missing field data
 Some incompatibilities
 Records that do not have any Borrower in the Credit Report tab. These will not be included in the report.

Once  basic  compliance  issues  are  solved  in  MLM,  the  report  may  be  exported  to  various  formats  including  Credit
Manager.  Two  reports  are  produced,  the  first,  that  which  is  imported  by  Credit  Manager  is  called
“Credit_Manager_MLM.txt” (and overwritten upon each production)  and  the  second  is  a  new file  saved  every  month,
bearing the month’s name for later reference.

IMPORTANT: When the system is used by many users, it is suggested that only one user have an open  session in order to
avoid other users changing data between the time the report is produced and the final submission to CM4-5.

Once MLM indicates that the report is saved, go to CM4-5 and click on Import External File.

Click on “Margill Loan Manager Import” (it will be highlighted in blue), followed by “Run”. This should have already been
set up (see "Credit Reporting Module",  Setting up Credit Reporting, if not set).
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Follow the next few steps. Some basic errors may be highlighted at this point.

Then  click  on  “Check  for  Compliance  Errors”.  This  will  show,  Record  by  Record,  all  Metro  2  compliance  errors.  These
should be fixed in MLM, not, in CM4-5 since the next import from MLM would overwrite the changes made directly in
CM4-5. Thus, the errors would not be resolved at the source and need to be corrected over and over in CM4-5 (not a
good solution).

Reports  cannot  be  sent  to  the  Credit  Rating  Agencies  until  all  compulsory  compliance  errors  have  been  solved.  Some
compliance errors reported are recommendations and should be fixed but are not compulsory for reporting.

Please consult the Credit Manager 4 User Guide for further instruction on its use.

Date of First Delinquency (DOFD)

A recurring problem that is often seen when submitting data is the Date of First Delinquency (DOFD) problem. This date is
automatically computed by MLM. When a Record is delinquent, this date should not change unless the Record becomes
current again and then delinquent again, in which case there will be a new DOFD.

To  avoid  problems  with  DOFD  compliance,  especially  for  loans  not  paid  monthly,  set  the  DOFD  when  creating  the
preliminary report in Margill to keep the date (and report it to CM4-5) as long as the Record is delinquent. To do so:

1) Generate the preliminary report in MLM by keeping the dialogue box opened

2) Export to CM4-5
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3) If everything is compliant in CM4-5, especially the DOFD accepted, click on "Set the First Delinquency Date / Close"

Important trick: BEFORE closing the Margill report window, import the Margill file to CM4-5. See if all compliance issues,
particularly DOFD, are solved. Make changes in Margill as needed if there are compliance errors. If there are no errors,
then click on "Set the First Delinquency Date / Close."  

If it is not compliant in CM4-5, review the problem Records.

IMPORTANT: Account Status must be set to AUTO in order for MLM to take the decision whether to keep or eliminate
this  Date of  first  delinquency.  If  the user changes the Account Status to any other Status  than  AUTO,  this  date  will  be
eliminated and a new date will be recomputed by the system. It  is suggested, based on the Account Status, to insert a
Special Date of First Delinquency that will be permanent for this Record (uncheck AUTO for the DOFD).

If a date is entered in the "Special DOFD" field, and "AUTO" is checked (Account Status is no longer AUTO), the DOFD will
nevertheless be computed. It  is  thus  recommended to  uncheck  AUTO in  order  for  the  date  entered to  be  reported to
CM4-5.
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List of Borrowers, Creditors or Employers

The  Borrowers  (and  Co-Borrowers  and  Guarantors),  Creditors  and  Employers  are  in  separate  databases  from  the  loan
data. The license allows you to create three times (3x) the number of Borrowers as the number of loans. So if you hold a
license for 1000 loans, you may have up to 3000 Borrowers.

Thus, a Borrower (or other) may be entered in the system without having a loan. If the highly flexible "Record List" report
was used to try to make a list of Borrowers, only Borrowers who have a loan in the system would appear in this report.
Others  would  be  excluded  since  only  loans  would  be  included  in  the  report  and  their  corresponding  Borrowers.  In
addition, if a Borrower had three loans, the name would appear three times.

For  a  list  of  the  Borrowers,  Creditors  and  Employers  entered  in  MLM,  in  the  Main  window (Record  Summary),  select,
under "File", the desired "actor" (Borrower, Employer or Creditor ) .

The "Borrower Update" opens. Sort the data by pressing the desired header, choose the desired Borrowers (or Ctrl-A to
choose them all) then press the right mouse button. The following menu will appear:

You can choose to copy only some or all the Borrowers by choosing "Export table to Excel". Choosing "Select columns"

 allows you to select which columns will  be  displayed or  not.  Only  the  columns displayed
will then be exported to Excel or other. You will need to copy/paste the data or save a file.

   

Due, Outstanding and Unpaid Payments Reports

Due Payments

It is possible in Margill Loan Manager (MLM), to identify receivables at any time.

The  Post  Payment  (or  Payment  Update  Tool),  available  under  "Tools"  and  "Post  Payments"  
identifies all payments that are "Due Pmt" for all "Active" Records AND that are displayed in the Main window.
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By entering the current date or a future date, MLM will display all payments with the "Due Pmt" type (total of five)  Line
status. These may be printed or exported to Excel with the right click of the mouse.

Thus, MLM may be updated as payments are received. This replaces the need to manually open a Record, change the 
from "Due Pmt" to "Paid Pmt" (or Unpaid or other), and save.

The due payments may also be printed or saved in Excel format.

A  due  payments  report  can  also  be  generated  with  the  Transaction  Report.  You  will  extract  all  the  "Due  Pmt"  Line
statuses. The Record List report can also be used but will generate a total amount as opposed to each transaction.

Outstanding amounts

The Payment schedule also includes four columns that detail the Outstanding amounts:

These data are available by creating a custom report with either the Record List or by Exporting transactions to the GL.

Several fields are available to extract this data including the interest and principal portions. See Reporting Fields under
"Outstanding".

Ageing of accounts is also available. See the Ageing of accounts in the next section.

See also: Record Summary Window and Calculation of interest on the Outstanding amounts.

Unpaid Payments

These data are available by creating a custom report with either the Record List, the Transaction Report or by Exporting
transactions to the GL.

These reports are used to extract the outstanding portions taking into account the payment that should have been paid
(expected payment) and the payment that was actually made. Several fields are available to extract this data for example
"Balance Total  Unpaid portions (Unpaid Pmts,  Partial,  Returned checks)(at report  End Date)" which includes all  unpaid
balances. The unpaid portions individually are also available depending on the outstanding payment. 

For example, on May 1, 2020, six Records were outstanding for a total of 3760.35 plus one Record with 25.00 in fees.
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See Line status and Reporting Fields.

Mathematical Equations can also be useful to obtain other totals.

   

Ageing of Accounts

The age of accounts may be computed automatically for Active accounts only. The Sub-status setting for each loan must
be set to "AUTO" which is the default. If  another sub-status has been manually  selected, to activate this  option so the
calculation is done automatically, in each Record, under Data, the Sub-status must be set to "AUTO".

The ageing report may be produced with the Credit report or through the Record List (Customized) report. For the latter,
integrity checks (error message given to the user) are NOT performed as they are for the Credit report.

Once this is set, the following rules will apply:

An account is always “Current” unless there is an amount in the “Outstanding” column in MLM AND IF the amount due in
this column is due 30 days or more at the report end date.

 An Outstanding amount is calculated by subtracting the “Payment” amount column from the “Expec. Pmt” (Expected
payment) column. 
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 For  proper  reporting,  it  is  thus  critical  to  make sure  that  the  exact  amounts  are  entered  in  the  “Payment”  and
“Expec.  Pmt”  columns   (see  "Working  with   the  "Expec.  Pmt"  column"  sub-section  in  the  "Unpaid  payments"
section).

 IMPORTANT: When a payment is late or is not paid, it is imperative to properly enter this information. Since the
credit agencies consider a payment to be late when unpaid within 30 days, a payment which is not paid within 30
days should be considered unpaid and the proper "Unpaid" Line status entered along with a payment of 0.00. The
amount  that  SHOULD  have  been  paid  must  be  entered  in  the  "Expec.  Pmt"  column  thus  calculating  an
Outstanding amount used to compute the ageing of accounts, THE key component in credit reporting. The "Late
Payment" Line statuses should only be used for payments that are only a few days late,  with a maximum of 29
days late. Using one of the "Late Payment" Line statuses will NOT generate an Outstanding amount even if a date
is  contained  in  the  column  "Pmt  Due  Date",  thus  not  calculated  in  the  ageing.  See  "Distinction  between  Late
payments and Unpaid payments that are paid later" sub-section in the "Late or partial payments" section).

A payment is always first applied to the oldest due amounts. See example below with explanations:

o Line 1 is paid.
o Lines 2 (02/01) and 3 (03/01) are unpaid.
o Line 4 (04/01) will first pay the outstanding amount from line 2 (so the late status is approx. 30 days less –

the  outstanding  date  thus  becomes  03/01).  The  Outstanding  amount  remains  2000  since  1000  was
nevertheless expected on Line 4.

o Line  5  (05/01  with  500  payment)  will  first  pay  only  part  of  the  Line  3  outstanding  amount  (so  the
outstanding date remains 03/01).

o Line 6 (06/01 with 1000 payment) pays 500 of Line 3 (so now nothing is owed on 03/01) and 500 for Line 4.
o Line 7 (extra 1250 payment on 06/15) pays 500 for Line 4 (so now nothing is owed on 04/01) and 750 for

Line 5.
o Line 8 (normal 07/01 payment of 1000) pays 250 for Line 5 (so now nothing is owed on 05/01) and 750 for

Line 6.
o Line 9 (extra payment of 1500 on 07/15) pays all outstanding (Lines 6 and 8). Nothing was owed (Expec. Pmt

= 0.00) on the two extra payments (Lines 7 and 9). An extra amount of 250 was paid but has no effect. The
extra amount paid does NOT reduce future outstanding amounts.

Any positive amount entered in the "Payment" column (no matter the Line status) will have an effect on the age of the
account. A negative payment has no effect on the age of accounts.

Line statuses with “Due Pmt” should NEVER be present before the report end date since these do not define if a payment
is made or not. An error message will appear when producing the Credit report only (but not when the data is extracted
through the Record List report) if a "Due Pmt" appears before the report end date. If the report is produced nonetheless,
these due payment lines will not add to the outstanding amounts but the age of the outstanding amounts will continue
to increase.
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MLM does not take into account the date indicated in the “Pmt Due Date” nor the "Paid Late Pmt" and "Partial Late Pmt"
Line  statuses  since  these  Line  statuses  should  be  used  only  for  payments  late  by  only  a  few  days  as  opposed  to  true
unpaid payments. A decision must be taken at some point by the managers as to when a payment is late as opposed to
unpaid. For late payments, it is strongly suggested to use the “Unpaid Pmt” Line status and then to insert a line when the
payment is actually made (and enter an "Expec. Pmt" of 0.00).

For the credit report, the number of late days is computed taking into account a payment due at 0:00 in the morning and
a report end date at 0:00 in the morning a month after that (so the last day’s transactions and the day’s interest are NOT
included).  So  if  the  report  is  produced  on  the  15th  day  of  each  month,  between  March  1  (payment  due  date)  and  a
March 15 end date, there are 15 days (not 16) since the report is actually produced up to the 14th at midnight (or the 15th

at 0:00).

MLM only takes into account the amount indicated in the "Outstanding - Payment (Balance)" column. If  interest is still
due on the old outstanding amount, this will not be included when the ageing is computed.

Ageing in the Main MLM window (Record Summary window)

When an Active loan’s Sub-status (that  computes the  Age of  accounts  -   AUTO option  is  set)  is  computed in  the  MLM
Main window, the current (computer) date is used. MLM will INCLUDE the day’s transactions.

Ageing Report Preparation

To set up the Ageing report, go to "Reports", "Record List (Customized)", and click on New . On the
left,  click  on  the  "Outstanding"  tab  and  choose  the  balances  you  wish  to  include  in  the  report.  Other  Borrower
identification fields should also be added. Provide the report a name and save.
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The  ageing  data  can  also  be  produced  for  Document  Merge  and  for  the  Credit  Report  (but  this  module  must  be
configured properly).

Ageing Report Production

To  produce  the  report,  choose  the  Records  to  include  (Ctrl  A  to  choose  all  the  Records  displayed)  in  the  Main  MLM
window. It is recommended to set Display filters to "All" in order not to exclude any Records. 

Go to "Reports" and "Record List (Customized)" (or "Document Merge"). Choose the report previously prepared and the
date (current date or other). Generally, the age of accounts is relative to the current date, but if another date is selected
as the report end date or if no date is entered, the reports will use the calculation dates as follows:

 Full report: the current date will be used as the reference date.

 Reports between two dates or up to a specific date for the "Record List ", the report end date entered will be used.

o If the report end date is greater than the date of the last line of the Payment schedule (the end of the loan),
the end date entered for the report will be used while still counting late days. The outstanding amount will
not increase (nor the outstanding interest amount), but the ageing (in days) of the outstanding amount will
continue to increase.

The "Active Records - Sub-Status (Current date if AUTO)" field, as its name implies, always uses the current date as the
reference date, regardless of the end date entered in the report. 

Once  the  report  is  produced  with  "Record  List",  to  obtain  a  quick  total  of  all  selected  Records,  click  on

. A grey line with the totals will appear as the last line of the table.
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Caution: In the image above, the amounts shown reflect the reporting date (06-15-2019) while the data for the sub-statuses include the current date. If
the report is not produced at the current date, it is suggested not to produce reports using these data simultaneously.

IMPORTANT NOTE: Non Active Records will return amounts of 0.00 since the ageing is not computed for these. Zeros will
be returned even if, when the Record was Active, amounts were present in the various ageing categories.

Days of Delinquency

The "Number of days of delinquency" field (under the Outstanding theme) counts the number of days of delinquency for
payments on the current date or on the date entered in the report.

We can also create a Conditional Alert in order to be notified when, for example, an account is more than 14 days late.

   

Escrow Report

When a Creditor holds an Escrow (Trust) account in which he receives payments for municipal taxes and insurance, it is
possible  to  include  the  amounts  charged  and  paid  by  the  Borrower  and  to  manage,  directly  in  Margill  Loan  Manager
(MLM), the amounts that he subsequently returns to the city and/or the insurance company on behalf of his Borrower.

The  Payment  schedule  below  (taken  from  the  Mortgage  /  Escrow  Account  section  example)  shows  in  the  first  circled
columns, the payments made by the Borrower for taxes and insurance and in the right columns,  amounts  paid  by  the
Creditor on behalf of the Borrower.
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With the "Record List" report it is easy to extract the amounts paid by the Borrower and by the Creditor for a period of
time with the following fields (under the "Fees/ Col." theme):

We created a report for the month of January 2017 based on the example above. The Borrower thus paid 208.33 in taxes,
100.00 in insurance. The Creditor paid the accumulated municipal taxes so far but no insurance yet. The Escrow account
balance can also be obtained (see below).

A statement or invoice can be produced with the Merged documents (Invoices and Statements) using these same fields.

It is also possible to see the payments made by the Borrower or by the Creditor line by line, including the check number
(and other data) if desired with the Transaction Report.
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Result for a single Record (several Records can be selected to obtain a portfolio total):

Escrow Account Balance

Each account's balance (Taxes and Insurance) can be obtained thanks to the Mathematical Equations. For the Insurance
account, we would take the following fields and equation:

Insurance paid (total from Record Origination to Report End Date)

Less

Insurance paid by Creditor (total from Record Origination to Report End Date)

=

Balance Escrow / Insurance
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MLM can calculate the Escrow balances of the Insurance portion and the Municipal Tax portion independently, or as total
by creating a longer equation:

In the "Record List", all the balances of the Escrow account are thus available on the desired date (example above used):

To view the progress of the Escrow account over time, use the "Record List with Period Breaks". Notice that the balance
increases progressively until the end of January (Tax payment by the Creditor), that it goes down and falls to 0.00 at the
end of May 2017 when the Creditor makes the second Tax and Insurance payment.
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If the Insurance was paid monthly by the Creditor, which is often the case, the Insurance portion would generally be 0.00
at the end of the month.

The report may include all or some of the Portfolio Records.

See also Custom Columns and Mortgage and Escrow.

   

Portfolio Analysis

Portfolio analysis tools are slowly being developed in Margill Loan Manager. However, users can create their own analysis
tools with Mathematical Equations.

The first ratio is the "Repayment Ratio" that calculates as follows:

 Total of "Paid" payments for the period divided by total "Expected Payments" for the period.

In the example below, from 04-01 to 06-30, the total payment amount was 2568.34 (1159.17 +1159.17 + 250.00) but the
expected payment was 3477.51 (3 x 1159.17). The Repayment ratio for these three months is thus 73.3856%. The -25.00
fee is not factored in even if included within the report dates.

Particular scenarios:

 If Total Expected Payments = 0.00 and Paid Payment > 0.00 then Repayment Ratio = 100.00%
 If Total Expected Payments = 0.00 and Paid Payment = 0.00 then Repayment Ratio = 0.00%
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IMPORTANT: In order to obtain reliable data, it is key to always include the true payment amount and the corresponding
expected payment amount in the "Expec. Pmt" column. 

Additional principal, fees, and any other non payment related transactions have no influence on the ratio since the ratio
will  only factor in true payment type transactions: Paid Pmt (and Paid Pmt 2 to 20),  Paid Late Pmt,  Partial  Pmt,  Partial
Late Pmt, Paid Pmt, Add. Pmt, Compensatory Pmt, Returned Check, Unpaid Pmt Returned Check.

For  example,  if  a  report  is  run  for  the  future,  thus  where  the  payments  are  Due,  the  ratio  will  be  100%  since  Due
Payments have no influence on the ratio.

Create your own analysis tools with Mathematical Equations or contact us so we can create more analysis tools with you.

   

APR disclosure box (USA only)

See APR Report

   

Returned checks

This module,  if  activated, is  used to manage transactions when a check is  returned. It  allows the capture of  additional
data when payments that are paid by check are returned for insufficient funds. It is also possible to extract this data in a
report.

Returned Check Module Activation

Returned Checks Management in the Payment schedule

Example

Transaction Report (Data extraction for returned checks)

Returned Check Module Activation

First of all, activate the module: Tools > Settings > under System Settings (Administrators) > click on Returned Checks:
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This window will appear:

By  clicking  "Activate  module",  you  will  automatically  obtain  two  additional  fields  (two  columns)  in  your  Payment
schedule: "Date of Returned Check" and "Date of Compensatory Pmt". The "Check Number" field is there by default even
if the returned check module is not activated. It will therefore be possible to add more information about the returned
check.



Page 1136

© Jurismedia Inc., 2007- 2023

Returned Checks Management in the Result table

When a check is returned for insufficient funds, data in the Payment schedule will have to be changed. The "Paid Pmt"
Line status will be changed to "Returned Check".

The following window will appear and some information can be entered: You will have to enter "Payment that SHOULD
have been made", in other words the returned check amount.

You will have the option to enter the check number, the date of returned check and eventually the date of compensatory
payment.
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When  the  information  is  entered,  the  columns  related  to  these  fields  will  automatically  be  updated  in  the  Payment
schedule.

If the data is not entered in this window, they can be entered directly in the Payment schedule in the "Check Number",
"Date of returned Check" and "Date of Compensatory Pmt" columns. Field names followed by an asterisk (*) can indeed
be changed at any time by the user.

When a compensatory payment is  received to cover the returned check,  the "Date of  Compensatory Pmt"  field  of  the
"Returned Check" line can be completed. After entering the date, this window will appear:

This window reminds you that when the compensatory payment is received, it  is  important to add the "Paid Returned
Check" line because this line is not automatically inserted in the Payment schedule.

After  adding  the  "Paid  Returned  Check"  line,  this  window  will  appear  and  will  suggest  to  add  the  date  at  which  the
payment SHOULD have been paid.

By adding these additional data, it will be possible to extract them and display them as a report.

Example: 

The user receives a check, as expected, of 500.00 by Donald, cashable on January 1, 2016.

The user therefore changes the Line status from "Due Pmt" to "Paid Pmt".
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Unfortunately, the check is returned on January 6, 2016 for insufficient funds.

The "Paid Pmt" Line status must be changed to "Returned Check" in Donald's Payment schedule.

This window will appear: The user adds the known information such as check number and the date of returned check.

When  Donald  is  notified,  he  sends  another  check  of  500.00  to  replace  the  one  returned  for  insufficient  funds.  The
Creditor receives it on January 9, 2016. He therefore enters the following information in the Payment schedule:

1) The user adds "Date of Compensatory Pmt" in the "Returned Check" Line status.



Page 1139

© Jurismedia Inc., 2007- 2023

When the user adds the data in the "Date of Compensatory Pmt" field, a pop-up window will remind him that each time a
payment is made for a returned check, he will have to insert a payment line to enter the payment that compensates the
returned check/payment. This line is never inserted automatically.

2) The user inserts a line with a right mouse click.

3) He chooses the "Paid Pmt Returned Check" Line status.

4) A window pops up so the user can enter the date at which the payment SHOULD have been paid. When the date is
entered,  MLM  recomputes  the  due  balance,  at  the  end  of  the  loan,  by  adding  interest  (and  fees  if  applicable,  see
Automatic Fees), on additional days for which the payment was missing.

5) The user enters the information about the new payment received to replace the one that was returned. He enters the
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check amount in the "Payment" field.

WARNING! When the loan's last payment is returned, the following window will appear when the user enters the date of
compensatory payment in the intended field: 

In this case, a line will have to be added in the Payment schedule with a right mouse click:

Then, the "Paid Pmt Returned Check" Line status will  have to be selected and the relevant information entered before
completing the "Date of Compensatory Pmt" field of the previous "Returned Check" Line status.

Transaction Report (Returned Checks Data extraction) 

If the Returned check module is activated, a Transaction report with data concerning the returned check will be available.
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Will show returned checks and payments that compensated for these unpaid
checks. Fields are added to obtain the check number, date of returned check
etc.

Data can also be extracted according to various dates, as required:

 Payment Date
 Payment Due Date
 Date of Returned Check
 Date of Compensatory Payment for Returned Check

Consult the Transaction Report chapter under Personalized Reports for more details.

   

Participation / Syndicated Loans

Each Record can be individually assigned to a Creditor (lender), to Sub-Creditors or a to a fund. It can also be assigned, in
various proportions, to many Creditors, Sub-Creditors or funds. These loans are known as "participation loans". For more
information  on  Creditor  management,  see  the  Record  Window  section  >  Creditor  (Lender)  >  Participation  Loans
sub-section.

The Record List section (Reports > Personalized Reports) is a very powerful tool for data extraction for Participation Loans
related to Creditors. 

Here are the Data that can be extracted for all Creditors, regardless of the number of Creditors involved in a Record and
regardless of their participation percentage in a Record.

 Business Name
 First and Last Name (if the lender is a person)
 Participation and percentage (up to 8 decimals)
 Participation as an amount
 Possibility of using Mathematical Equations to extract hundreds of other data.
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In the example below we would like to know the original principal for each creditor, their participation in loans, the total
original  Principal  and the interest paid (for the time period).  Here is  how we would create the Record List  report.  This
report would include two Mathematical Equations:

AND

And the following fields (and others if required):

The  report  would  have  many  columns  including  yellow  and  blue  columns  which  are  the  participation  data  for  each
Creditor. White columns are normal data:

This is a small part of the report since this report generates as many columns as there are Creditors.

When generating a report, participation fields for each Creditor (yellow and blue columns) will follow normal data (white
columns) regardless of the fields' order.

Special Notes: 

Be careful when assigning participation percentages to each Creditor because if the attribution is less than a 100%, you
will not be notified. You will be warned only if the percentage is above 100%.

If you enter an amount for each Creditor's participation, you will not be notified if the total amount is not equal to the
loan amount (regardless if the amount is greater or lower than the total loan amount).

Optional Investor Module
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Note: A very sophisticated optional module allows you to manage participation / syndicated loans in which investors or
funds  invest  different  amounts  on  various  dates  and  can  withdraw  their  monetary  investment  and  be  replaced  by
another  investor.  Payments  (principal  and  interest  or  interest-only  or  principal-only)  by  the  borrowers  are  then  paid
based on the participation proportion and dates of these investments or withdrawals for each.

For more information on this module please contact Margill customer support (support@margill.com).

   

Custom reports created by the Margill team

If  you  have more complex report  requirements,  the  Margill  team can create a  report  or  reports  to  meet  your  specific
needs:

 Multiplication/division/addition/subtraction/proportions  of  the  various  fields  (although  Mathematical  Equations
offer great flexibility)

 Creation of new fields
 Data or multi-dimensional results (e.g. a single report containing annual, monthly data, global, etc.)
 Predetermined sorting
 Analyses
 PDF Formats
 Special page layout
 Graphics
 Etc.

Once the report is created by the Margill team, to activate it go to Tools > Settings > System settings (Administrators) >

"Modules" section > Custom Reports Settings. Click on the "Activate a report"  button
and enter the password provide by the Margill team:

An activation confirmation message will appear.

OR

mailto:support@margill.com
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For some reports, custom fields may be required.  These must be created in MLM.  If they do not already exist, once a
report is imported, a simple method to customize it without leaving the configuration page is to select each field, press
the right mouse and "Create this Custom field in:". The field will be created for the Record (the usual case), the Borrower
or the Creditor. Everything can be done in a few seconds.

The final step is to associate the report fields with the MLM custom fields (this step is performed automatically using the
procedure created above). Choose the "Custom Field" column and the corresponding field from the drop-down menu:
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If fields were included, then press "Save Field Settings modifications".

The procedure is now complete. Close the window by clicking on "Exit".

To produce  the  report  itself  from,  "Reports",  choose  "Custom Reports".  A  list  of  each  activated  custom report  will  be
displayed. Select the desired report.
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To  delete  a  report,  scroll  to  the  far  right  of  the  "Custom  Reports  Configuration"  window  (Tools  >  Settings  >  System
settings (Administrators) > "Modules" section > Custom Reports Settings) and check the appropriate Delete box. Confirm
with the DELETE button.

   

Automated Reports

See Automatic Reports in the Automatic / Overnight Tasks.

   

Mathematical Equations

This  module  allows  you  to  create  custom  reporting  fields  to  be  used  in  some  of  the  reports  and  in  the  Main  Margill
window.  The  module  allows  you  to  add,  subtract,  multiply,  etc.,  a  field  by  another,  or  by  numbers.  For  example,  you
could produce a statement which details  all  the amounts to be paid with a  total  that  sums it  all,  or  create an  analysis
algorithm based on balance, payment ratio and other elements. Another example would be a "loan-to-value" ratio using
the loan amount to a Custom field listing the value of the asset or security.

As of MLM version 5.3, calculations can use 8 decimal points instead of 6 in order to provide additional precision. In some
situations, some results of existing Equations might be slightly affected due to this new additional precision.  

Only MLM Administrators and Power users can create Equations. These rights are limited because we would not want a
user without superior rights to inadvertently change an element in a formula and this change to go unnoticed.

To  create  an  equation,  the  Administrator  (or  Power  user)  must  go  to  the  Reports  >  "Equation  Management"  button

.The  following  window  will  appear,  briefly  explaining  the  procedure  and  displaying  these
Equations.

The first column shows the name or merge code of the variable that can be included in the Document Merge. The second
column  shows  the  same  variable  but  in  short  format  (which  makes  it  easier  to  design  merged  documents).  The  third
column is the name given by the user and the latter gives the details of the equation as such, including the fields in black
and the mathematical operators in red.
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Click  on  the  "New"  button    (or  to  edit,  on  the  "Edit"  button   ).  The
"Equation Formulation" window will follow.

Steps for creating Equations
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1) Give a title to the Equation. Choose a title that is descriptive but not too long.

2) Select the "Results format".

Be careful to choose the right format from the four choices. There is a potential danger if the last option, "Percentage
(%)" is chosen. This should only be used if the resulting equation is a percentage. The syntax verification tool does not
analyze compatibility.

Also, if you use the multi-currency module, it is strongly suggested that you assign a currency format, in order not to
mix up the currencies.

3) Select  the  desired  field  among  the  usual  themes  from  the  left  and  use  the  center  arrow   to  copy  it  in  the
"Description" table on the right. Only numeric, monetary, whole or percentage field types are available,  as well  as
many  current  date  fields.  Text  fields  are  not  available.  Each  line  in  the  "Description"  table  should  contain  only  a
single field, operator or number.

A field can be used more than once. The fact that it is checked  does not affect the right to reuse it.

4) Choose the mathematical operator that will appear on the next line with the middle icon.

A number (positive or negative) can also be added.  For example, to divide a field by two, to add a fixed amount to a
field, etc.

5) Copy the next field to be added to the third line, and so on. Multiple operations can be performed including adding
parentheses in order to structure mathematical operations. Each parenthesis must be inserted on a line.
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For example, in a scenario where several Creditors have a participation in a loan, the equation below computes the
total principal and the interest paid to the first Creditor on the list. In this example, the first Creditor participation (%)
is multiplied by the paid principal, and then this amount is added to the paid interest according to its participation
interest. The parentheses are used to carefully isolate the mathematical operations *. 

=

* Note: In this example, the normal order for the mathematical operations ensures that parentheses are not required.

A maximum of 1000 characters are allowed in the Equations.

7) Once the Equation is completed, either press  "Check syntax" or "Save" 
. When saving, the syntax will be checked. A syntax check does not check if the equation gives the desired result, but
simply that it is mathematically consistent. In the example below, the Equation ends with a + without another field
to add. Therefore this is a syntax error.

If a transaction involves a division by 0 (e.g. loan principal divided by paid principal when no principal has been paid),
instead of generating an error, MLM will report 0.00.

Editing Equations

If by error a field (operator or number) is entered in the wrong place, use the arrows on the right to change the order.
Choose the field (it will turn blue) and then bring it up or down with the arrows.
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To remove a field (operator or number), press the arrow pointing to the left in the center .

An Equation already saved can be changed from the main Equation Management window by choosing the Equation to

change (it will turn blue) and then pressing "Edit" .

Example of a more sophisticated Equation

An Equation could include custom fields and amounts that change in accordance with the loan's accrued interest and
paid amounts. 

For example, your accountant could create a risk formula that takes into account the Borrower's FICO score (i.e. part
of a custom field) and the loan balance (automatically calculated) and the repayment Ratio. 

The formula takes into account the level of risk of these elements (fictitious formula)

1) FICO score Custom field 600
2) Loan balance                 automatically calculated                 25550
3) Maximum risk balance  Custom field 30000
4) Repayment ratio automatically calculated                 85.25%
 
The elements can be divided or multiplied to get a percentage.

Deleting an Equation

An Equation can be removed from the main Equation Management window by choosing the Equation to change (it will
turn blue) and then pressing the right mouse button, followed by Delete.

An Equation cannot be deleted if it is used in a report. A message will appear if this is the case.

Retrieve Equations in reports

Equations  can  be  used  in  Record  List   and  in  Document  Merge.  They  are  NOT  available  for  Exporting  accounting
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transactions to the General Ledger.

In the Record List, the Equations can be added to a report with the "Equations" tab located on the field themes' last line,

to the left. Use the central arrow  to add.

In  Document  Merge  (Letters,  Contracts,  Invoices,  Statements),  Equations  can  be  integrated  in  the  merge  documents
using the right mouse button under the last topic on the list, "Equations". 

View Equations in the Main MLM window

Equations can be viewed in the Main MLM window.  Go to Tools > Settings > User settings >  "Record Summary Window"

button. Click the "Equations" tab located on the field themes' third line, to the right and use the central arrow  to
add.
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See in  the  Alerts  chapter,  Conditional  Alerts  that  can  use  Equations  in  order  to  obtain  warnings  that  can  include  very
sophisticated conditions.

   

Advanced Mathematical Equations

The Advanced Mathematical Equations module is a powerful tool that allows to build complex Equations with conditions.
This  module  would  mostly  be  used  for  sending  invoices  or  statements.  A  typical  example:  on  an  invoice  sent  to  the
Borrower, if the balance of the loan is less than 2.00, then the next due payment for that Borrower would be 0.00. If the
balance is 2.00 or more, then the next payment would be the real balance due.

To access this module, click on Reports > Equation Management > Advanced Equations.

This window will appear:
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You can create a new Advanced Equation with the "New" button or modify an existing Equation by selecting from the list
and by clicking on the "Modify" button, or via the menu accessible with the right mouse click. This menu also allows the
deletion of Advanced Equations.

Steps to create Advanced Equations 

Upon clicking on "New", this window will appear:
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The Equation title is mandatory. Choose the logically results format from the list below:

In order to obtain all of the possible variables, click on the  icon next to the word "Expression". By default, the most
popular variables are displayed: 
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By browsing through the drop-down menu below, multiple themes are displayed. You can access the variables available
by theme:

Advanced Equation construction is based on: If the condition is true then the result will be this, otherwise the result will
be something else.

For example, in order for the balances less than 5.00 not to appear in the reports, select from the "Balances" theme and

double-click on the variable called "Balance at the end of report" or click on  to display it in the "Expression" box: 
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Please  note  that  you  can  add  other  variables  or  mathematical  operators  in  this  first  condition,  therefore  in  all  of  the
expressions of the equation in order to make it more complex and powerful.

Once the first expression completed, click on "Confirm" and choose a comparative operator from the list:

For numerical and operational (+ - * /, etc.) expressions, click on "Add" in order for the "Expression" box to be displayed:
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Once the equation is done, click on "Save". In this example, we could read the equation like this: If the balance at the end
of the report is less than 5.00, enter 0, if not, display the balance at the report's end date.

By clicking on the  located in the IF section, we are able to add an AND or an OR to the expression:

To eliminate an extra condition, click on  to the right.
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By clicking on the  located in the RESULT IS sections, we can add one of more sub-conditions:

Practical tip: 

Conditions must be mathematical and cannot be based on text. For example, we cannot say IF the data is Yes, the result
is X but if it's NO, then the result is Y. You could therefore, instead of text values, enter a 0 for YES and a 1 for NO and use
this  data  in  the  conditions.  The  title  of  the  Custom  Field  could  be  "Friendly  Customer  0  =  Yes,  1  =  No"  and  like  this,
everything is  clear to your users.  This field  should  be  mandatory  if  used in  an  Equation,  otherwise the  result  could  be
false.

IMPORTANT : These Equations can become quite complex.  Always test in multiple scenarios.

Retrieve Equations in reports

Equations  can  be  used  in  Record  List   and  in  Document  Merge.  They  are  NOT  available  for  Exporting  accounting
transactions to the General Ledger.

In the Record List, the Equations can be added to a report with the "Equations" tab located on the field themes' last line,

to the left. The Advanced Equations will be displayed after the "Normal" Equations. Use the central arrow  to add.



Page 1159

© Jurismedia Inc., 2007- 2023

   

Accounting Data

Margill  Loan  Manager  (MLM)  includes  multiple  accounting  data  that  can  be  obtained  in  the  Record  List,  Transaction
Report,  Document  Merge  (Letters,  Contracts,  Invoices  and  Statements)  and  in  the  Export  accounting  transactions  to  the
General Ledger reports. The concepts and fields are explained in detail in the section that follows.

From  an  accounting  perspective,  the  interest  name  may  evolve  over  time  as  payments  are  made  in  the  loan.  The
following interest definitions will allow you to better understand the various computing fields.

The term "interest" is a generic term that includes all interest sub-categories: 1) Accrued interest, 2) Interest receivable
but Not Due, 3) Interest Receivable and Due 4) Paid interest.

The diagram below helps to better understand the effect of time and payments on the definitions that follow.
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 Accrued interest: Generic term for interest whether these are due or not or paid or not. Accrued interest most often
eventually becomes receivable, due or paid interest as payments are due or paid. 

 Interest receivable but Not Due:  Although possibly incorrect from a pure accounting perspective, generally simply
called "Due interest" in MLM. This is interest that is to come in the future for payments that are not yet due.

 Interest Receivable and Due: Called "Due Interest" in MLM. Interest which is due when a payment that should have
been  paid  was  not  paid  or  was  partial  and  insufficient  to  pay  the  interest  that  was  accrued  since  the  last  paid
payment (or payment that should have been paid). 
MLM rarely  differentiates  the  two  subtleties  in  interest  due  except  in  specific  fields  explained  in  this  section.  The
term  "Interest  Receivable"  is  thus  used  to  describe  one  or  the  other  since  the  distinction  is  very  small  as  well  as
relative (depending on whether the report is for the past or the future and depending on whether payments exist or
not). In addition, the distinction is required only in certain specific accounting situations.

 Paid interest:  Interest  that  is  actually  paid  by  the  Borrower  (and  received by  the  Creditor)  with  a  true  payment  (
Payment-type Line statuses: Paid Pmt, Paid Pmt (2) to (20), Paid Late Pmt, Partial Pmt, Partial Late Pmt, Paid Pmt,
Returned Check,  Add.  Pmt,  Compensatory Pmt),  as opposed to fees,  penalties,  insurance,  taxes and all  other non-
payment related transactions.

The amount  of  interest  paid  can  be  isolated  according  to  the  type  of  payment  made.  Thus,  one  could  isolate  the
"paid" interest according to two types: monetary (what we call cash even if not real physical cas) and non monetary
(non-cash).

o A regular cash payment (Paid Pmt, Paid Pmt Cash, Paid Pmt Credit Cart or other) can be isolated from other
"paid" payments (non-cash) such as Write-off ("Paid Pmt 5" renamed to "Write-off" or to "Transfer" (current
loan  closed  and  interest  and  principal  balances  transferred  to  a  new  loan)).  "Paid"  interest  through  a
Write-off  or  by  a  Transfer  is  not  actually  paid  and  therefore  can  be  treated  otherwise  (loss  of  interest
income for a Write-off or simply no monetary effect since the Transfer reduces a loan and increases a new
loan by the same amount). See Payment-type Line statuses.

 Interest to be paid at the next Due Pmt: Amount of the interest that WILL actually be paid if the next "Due Pmt" was
paid in full.

To find this amount, MLM identifies the next line whose Line status is "Due Pmt" regardless of the date, simulates an
actual paid payment and reports the amount of interest that would be paid.

The diagram below presents a graphic view of what accrued interest is reported for the various interest fields:

o Interest Accrued
o Interest Accrued from last Payment "Paid"
o Interest Accrued from last Payment "Paid" (interest within the period only)
o A field also available computes the accrued interest since the last payment that is "paid" or "unpaid". The

Line  statuses  must  be  Payment  type  or  Unpaid  type.  All  other  Line  statuses  will  be  ignored  for  this
calculation.

o It also compares with "Due interest" (further explained in next section).

Many scenarios  are  presented since the  accrued interest  reported is  influenced by  several  factors:  paid  or  unpaid
payments, payment dates, and of course, reporting dates. 
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For each "Interest Accrued" field , two types of fields are available to handle the situation where a loan does not contain
any paid or unpaid payments. The use of one field or another depends on the type of accounting report to be produced.

1) If no paid (or unpaid) payments are present: returns an interest accrued amount of 0.00 (the field description contains
"0.00 if no pmt").

2) If no paid (or unpaid) payments are present: returns the interest accrued amount until the end date entered for the
report or only for the selected period.

The  diagrams  below  illustrate  the  various  "Interest  Accrued"  fields  according  to  the  choice  to  return  0.00  when  no
payment is present and when a payment is paid (or unpaid) within or outside the report period.

Unpaid payment in the report period
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Unpaid payment outside (before) the report period

Unpaid payment outside (after) the report period - so as if no paid or unpaid payments 

 Balance  due  interest:  If  the  payment  is  not  sufficient  to  pay  the  accrued  interest,  then  the  difference  between
accrued  interest  and  the  paid  interest  becomes  due  interest.  The  balance  will  increase  and  decrease  over  time
depending on the interest amount and if the payment is sufficient to refund these.

If  the  "Paid  Interest"  Line  status  is  used  and  the  the  interest  balance  is  lower  than  the  amount  paid  by  this  Line
status, the due interest balance will become negative.

 Principal  (all  types  of  transactions)(mathematical  principal):  The  increase  or  decrease  of  the  total  loan  amount
whether the increase is  in  principal  per se or  in  fees,  penalties,  taxes,  etc.  A decrease in  principal  will  occur  when
actual  payments  are  made  or  when  fees,  penalties,  taxes,  etc.  are  paid.  In  compound  interest,  a  payment  that  is
insufficient  to  pay  off  the  current  interest  will  lead  to  an  increase  in  this  mathematical  principal  but  not  in  the
accounting principal.
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Important definitions

Mathematical principal:

All  negative  payments,  regardless  of  the  Line  status  and  any  unpaid  interest  added  to  the  loan  balance,  are  mathematical
principal.

All positive payments ("Payment" type lines, Fees Paid, Insurance Paid, "Other" type lines, etc.) refund mathematical principal.

All  increases  or  decreases  in  mathematical  principal  increase  or  decrease  the  balance  of  the  loan  but  not  necessarily  the
accounting principal.

The mathematical principal is located at the left of the Payment schedule ("Principal" column) .

The mathematical principal amount increases when a payment is negative or when the payment amount is insufficient to pay the
accrued interest (this is represented by a negative amount in the "Principal" column) .

The mathematical principal amount decreases when a payment is positive, regardless of the Line status (this is represented by a
positive amount in the "Principal" column). 

Accounting principal:

Accounting principal can only be added to a loan by the original principal entered and by adding "Principal" Type Line statuses.

Capitalized interest or adding fees, penalties, taxes, etc., has no influence on the accounting principal. Any payment other than
true payments ("Payment" Type Line statuses) does not refund accounting principal.

The accounting principal  amounts are in  the columns to  the right  of  the  Payment  schedule  ("Balance  Due Principal"  and  "Paid
Principal" columns), not in the first columns to the left ("Principal" column which is the mathematical principal - see explanation
above).

The  "APR  Fees  financed",  while  included in  the  amount  financed,  are  distinct  from  the  accounting  principal  and  are  displayed
when accrued or paid in  separate columns in the Payment schedule.

 Paid principal: Accounting principal that is actually paid by the Borrower (and received by the Creditor) with a true
payment  (Line  status:  Paid  Pmt  (and  Paid  Pmt  2  to  20),  Paid  Late  Pmt,  Partial  Pmt,  Partial  Late  Pmt,  Add.  Pmt.,
Compensatory  Pmt,  Paid  Returned  check)  as  opposed  to  the  payment  of  fees,  penalties,  insurance,  taxes  and  all
other  non-payment  related  transactions.  These  last  Line  statuses  refund  mathematical  principal,  not  accounting
principal.

The principal paid can be isolated according to the type of payment made. Thus, one could isolate the amounts paid
by  a  normal  payment  (Paid  Pmt)  from  one  "paid"  as  a  "Write-off"  (Pmt  made  5,  for  example,  renamed  to
"Write-off").  Amounts  paid  by  Write-off  are  not  actually  paid  and  therefore  can  be  treated  differently  (loss  of
principal). See "Payment" Type Line statuses.

Paid principal can be greater than the principal's balance. Principal balance then becomes negative. 

 Principal to be paid at the next Due Pmt: Amount of the principal that WILL actually be paid if the next "Due Pmt" is
paid in full.

To find this amount, MLM identifies the next line whose Line status is "Due Pmt" regardless of the date, simulates an
actual paid payment and reports the amount of principal that would be paid.

 Due Interest between Expected Payments (Period): Interest which is due when a payment that should  have been
paid was not paid or was partial and insufficient to pay the interest that was accrued since the last paid payment (or
payment that should have been paid). 
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Interest  is  considered  "Due"  in  this  context,  if,  during  the  reference period  (desired  report  dates),  there  is  a  paid
"Payment" whether full or partial or an unpaid payment that was due. An unpaid payment is an expected payment
that should have paid the accrued interest. If the expected payment is not paid, the accrued interest then becomes
due. The "Due Pmt" Line status is NOT taken into account when determining the "Expected" payments.

If no payment is expected during the reference period, then interest will accrue but is not due. 

If  a  payment  is  expected  (paid,  partial  or  unpaid,  no  matter)  during  the  reference period,  and,  for  the  preceding
period no payment (a "payment" type payment as opposed to non payments such as Fees and other Line statuses,
see "Payment" Type Line statuses) is actually included in the Payment schedule, then the calculation will go back in
time, to the preceding periods to find the last payment or payment that was expected. MLM will then compute the
due interest for the reference period.

The example below explains many subtleties including lines that contain payments other than true "Payments" and
thus  that  have no  influence on  the  due interest  calculated.  It  also  shows the  effect  of  more  than  one  transaction
during the reference period or no transaction in the period, as well as additional and partial payments.

In the diagram above, generally, payments are normal and on the 7th day of each month with some exceptions.

o Period 1: October report, payment of 15.00 that refunds 10.00 of the accrued interest. The balance refunds
the principal.

o Period 2: November report, unpaid payment (thus 0.00). Accrued interest becomes due interest.

o Period 3: December report, no transactions during the month and therefore there is an accrued interest of
17.00  between  the  last  payment  and  December  31,  but  no  Interest  paid  nor  due  since  no  payment  was
expected.

o Period 3a:  January report,  payment of  15.00 will  repay a  portion of  the accrued interest from the unpaid
payment of November 7 (we must go back in time before December since no payments were due or made
in December).

 Fees are charged but have no effect on the due interest as this is not a payment or a payment that
was expected. ANY transaction other than "Payment" Type Line statuses has no effect on the due
interest.

o Period 4: February report, unpaid payment (thus 0.00). Accrued interest of 10.00 becomes due interest.

 Period 5: February report (continued) because an additional payment was made during the month.
Payment of 15.00 can pay due interest in period 4 (10,00) plus 4.00 of accrued interest. Total due
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interest = 0.00 and paid interest = 14.00.

o Period 6: March report, partial payment of 5.00 that refunds 5.00 in interest and 1.00 is left as due interest.

 Balance due principal: Initial principal amount less "Paid principal" plus any line with all "Add. Princ." Line statuses.
Any other negative payment (fees, penalties,  insurance,  taxes,  etc.)  will  not  affect the "Balance Due Principal"  but
will affect the "Balance all others" and the "Balance" of the loan. This balance can be negative.

 Balance  all  other  transactions  ("Balance  all  others"):   balance  of  all  non-payment  related  transactions:  fees,
penalties, insurance, taxes, invoices, withdrawals, investment, other and the payment of these.

 Balance of loan: Actual loan balance factoring in, all type of payments whether these are positive or negative.

 Outstanding - Payment (Balance): Cumulative balance of the amount that should be paid (Payment column) but that
is  overdue.  This  column subtracts  the  amount  entered in  the  Column "Payment"  from the amount  entered in  the
column "Expec. Payment". 

The minimum outstanding amount is 0.00. The outstanding amount cannot be negative even if the payment made is
greater  than  the  outstanding  balance.  In  addition,  the  calculation  of  the  overdue  amount  always  starts  from  a
positive balance or 0.00, never from a negative balance (overpayment).

For  example,  a  payment  of  1000  ("Due  Pmt")  should  have  been  made.  Only  300  ("Payment")  was  paid.  The
"outstanding (balance) therefore becomes 700.   The next  payment   which should  have been 1000 is  of  1200.  The
amount  in  "Due  Pmt"  should  be  1000  and  the  "Payment"  should  be  1200.  The  outstanding  (balance)  therefore
becomes 300 less  200 =  100.  The next  payment  is  of  1500  while  1000  was  expected.  The  "outstanding  (balance)"
becomes 0.00, not of 100 less 500 = -400.

Interest on the outstanding amounts due  are also calculated. In  compound interest,  interest is  also computed on
outstanding  interest.  To  see  how  interest  is  computed,  consult  the  Calculation  of  interest  on  the  Outstanding
amounts in the Calculation Methods section.

A total amount (outstanding payments and interest on these outstanding payments) is also calculated.

 Outstanding - interest and principal portions:

Outstanding – Interest portion at Report End Date Portion of the outstanding amount (payment only, not the interest
on the outstanding amount) representing the interest.

Reports  the  Due  interest  at  the  report  end  date  yet  without
exceeding the amount that is outstanding.

Outstanding – Principal portion at Report End Date Portion of the outstanding amount (payment only, not the interest
on the outstanding amount) representing the principal.

The calculation is performed by subtracting "Outstanding - Interest
portion  at  report  End  Date"  from  the  "Outstanding  -  Payment
(Balance)  at  report  End  Date"  thereby  determining  the  principal
portion.

If multiple payments are missed and the interest not refunded, the
result can often be 0.00.

Accounting Data and Fees (Insurance and Taxes)

Accounting data for many types of Fees are available:
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1) Line Fees (fees as Line status)

2) Column Fees

3) APR Fees

1) Line Fees

When lines are inserted for adding Fees (negative amounts that are added to the balance, defined as "Accrued" Fees), we
can  insert  a  matching  "Fees  Paid"  line  when  the  fees  are  in  fact  paid.  This  data  can  also  be  isolated  for  accounting
purposes. A payment ("Payment" type Line status) will not pay these fees on the accounting level.

2) Column Fees (manually or automatically added)

 Column Fees  -  Accrued  (6  types,  names can  be  changed):  we  can  manually  or  automatically  charge  fees  by  using
rules.

 Column  fees  -  Paid  (6  types,  names  can  be  changed):  column  fees  are  paid  with  payments  ("Payment"  type  Line
statuses). Here is the refund sequence made by a payment: 

1. Column Fees 1 without interest
2. Column Fees 1 with interest
3. Column Fees 2 without interest
4. Column Fees 2 with interest
5. Column Fees 3 without interest
6. Column Fees 3 with interest
7. Column Fees 4 without interest
8. Column Fees 4 with interest
9. Column Fees 5 without interest
10. Column Fees 5 with interest
11. Column Fees 6 without interest
12. Column Fees 6 with interest
13. Interest
14. Principal

Thus, a "Paid Pmt" for example, will pay all the Fees first (based on the order above), then the interest and the principal
which can be further divided (see "APR Fees" below).

The paid portion can even be isolated according to payment type. For example, the fees paid portion paid by a "Paid Pmt
-  Cash"  (name chosen by  the  user)  or  by  a  "Paid  Pmt -  Transfer"  (meaning  no  cash  transfer)  can  be  isolated  from the
reports.

 Column Fees - Balance (6 types, name can be changed): exclusive balance for Column fees 1 to 6 after payments.

3) APR Fees
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 Paid  Fees  Financed  (APR):  total  of  all  Paid  Fees  Financed  (APR)(up  to  five  types).  When  a  payment  is  paid,  these
"Fees financed APR" are paid on a pro rated basis of the original Principal. In the example below, given an original
principal of 50,000, for a 1000.00 mathematical principal refund, the portion of the accounting principal paid will be
952.38 (95.24%) and the portion of Paid Fees financed APR will be 47.62 (4.76%) since:

Principal Portion: 50 000 / 52 500 =  95.24%
Fees Portion: 2500 / 52 500 = 4.76%

This  pro  rated  approach  was  chosen  in  MLM  because  these  fees  are  very  close  to  principal.  If  this  method  is  not
desired, use Line Fees or Column Fees.

The paid portion can also be isolated for each one of the five Fees financed APR when generating a report. The paid
portion can even be isolated according to type of payment (according to "Paid" Line status).

 Balance Fees Financed (APR): Balance of all Fees Financed (APR).

See important Fees, Insurance and Taxes chapter.

Many of  these amounts are reflected in  the Payment schedule.  To see all  the  columns,  one must  scroll  to  the  right.  If
more pertinent data is to be shown, columns may be hidden or moved (click on the column header and right click with
the mouse or drag the column). Nevertheless, in a printed Detailed schedule report, only some columns are printed and
this printed report may not be customized. In order to obtain a detailed "custom" print out, one should right click in the
Payment schedule and export to another format such as Excel.

The data is also available in the Record List and for Document Merge. In this last report (Document Merge), the Payment
schedule may be obtained according to "Paid" data, not only according to "Accrued" (see "General" theme).

If a field is not available, you can use Mathematical Equations to create your own fields. Thus, you can add fields together
or perform subtractions, multiplications, etc. You can also contact the Margill team for custom reports.

See also Export accounting transactions to the General ledger.
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Time required to produce reports

The time required to produce the various reports will depend on the following factors:

 number of Records included in the report
 type of report
 number of fields included in the report (for custom reports)
 time period of report (full reports, up to a specific date or between two dates - processing time being longer for the

latter two)
 network speed (refresh times may become quite long to download on wireless networks)
 computer speed

For small databases (under 500 Records), most reports are quick to produce (under 30 seconds). 

Tests were conducted on a normal high speed Ethernet local area network (LAN) with a recent computers (Intel Core i5
and i7)).

Tests were conducted with 500 Records. Here are some processing times:

 "Global Summary" and "Record List - Summary" reports took about 5-10 seconds each.
 For the "Record List" report with 350 fields (total of 175,000 data elements), the report took less than 50 seconds.

Reports with 10-20 fields required less than 10 seconds.

For larger databases, with over 1000 loans, reporting times, of course increase. 

With 5,000 Records here are some processing times:

 Global Summary and Record List - Summary: 10-25 seconds
 Record List  report  with  over  350 fields  (1,750,000 data  elements),  the  report  takes  between 3  and  5  minutes.  An

export to Excel took less than another minute. Reports with 10-20 fields require 90 seconds.

With 10,000 Records here are some processing times:

 Global Summary and Record List - Summary: 20-120 seconds
 Record  List  report  with  over  350  fields  (3,500,000  data  elements),  the  report  took  between  5  and  8  minutes.  An

export to Excel took less than another minute. Reports with 10-20 fields require between 30 seconds and 3 minutes.

Export of debits and credits to third party accounting systems

For  this  report,  Margill  Loan Manager  performs thousands  of  calculations  and  tests,  often  line  by  line  in  the  Payment
schedules when producing these reports, thus a longer processing time.

Tests  were  conducted  with  500  Active  Records  with  50  fields.  For  over  23,000  transactions,  plan  less  than  2  minutes
distributed as such:

 preliminary  processing (list of errors): 30 seconds
 transaction list: 10 seconds
 switch from Summary tab to Detail tab (each switch): less than 10 seconds
 producing the export file: under 30 seconds 

Tests were also conducted with over 5000 Active Records with 50 fields. For over 265,000 transactions, plan less than 10
minutes distributed as such:



Page 1169

© Jurismedia Inc., 2007- 2023

 preliminary  processing (including determining errors): 5 minutes
 transaction list: 50 seconds
 switch from Summary tab to Detail tab (each switch): 45 seconds
 producing the export file: 2.5 minutes

If your processing times are much longer than the times indicated in this section, check your network and workstations.
Upgrades or optimizations may be required.
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Saving & Printing

Saving, Reports, Export & Printing contents

Saving

Printing

Printing problems

   

Saving

Calculations made in the Margill Loan Manager (MLM) are saved in the database. No file name needs to be specified.

Once a new Record has been computed (thus the Payment schedule appears), to save the Record in the database, press
on the "Save" button on the left.

A window will appear assigning a unique number to the Record.

When you try to close the calculation with  or , unless the results had been previously saved, MLM
will query as to whether the Record should be inserted in the database or not.

Options for saving a Record

When a change is made in the Payment schedule (or other changes in a Record) and the user chooses Save, the following
window will appear:

When choosing "Update", changes will be saved in the existing Record.
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When choosing "Create a new Record", all data of the current loan will be copied, including the associated Borrower(s),
Co-Borrower(s), Guarantor(s) and the Creditor(s). Changes made in the original Loan will not be saved, only copied to the
new Record.

Data concerning pre-authorized payments will  not  be copied,  but  the user will  be able to decide to  include all  custom
field data related to the loan and the Record's Alerts.

When  choosing  "Always  Update",  you  will  no  longer  be  asked  if  you  wish  to  update  the  Record  or  create  a  new  one
(copy). One less window will appear when saving.

If you wish for this window to appear again, go to Tools > Settings > User settings and check the "Display the tips and
messages" option.

IMPORTANT

Don't forget to backup all data regularly. See Backup section.
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Printing

See the Reports available section and the various reports that can be produced with Margill Loan Manager (MLM).

Depending on the report type, a preview may be available before actual printing:

Printing options are available through the "Pages to print" button:

Some reports do not offer previews and will print the report directly. 

For  the  Detailed  schedules  (Payment  schedule),  a  preview  is  available  only  for  the  first  of  the  chosen  Records  but  all
Records chosen will be printed (or exported).

Exporting Reports

Several export formats are also available using the following icons:
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Depending on the report, some exports may be disappointing because of deficient formatting (Word and Excel) and will
require adjustments for the fonts, cell size, etc.

See also Printing problems.

   

Printing problems

Possible Printing Problems:

It may happen that some of the lines at the right of the printed table are incomplete, or that a few characters from one
line appear on the line below. This problem may be caused by printer configuration errors. For example:

If the paper size is wrong:

To  correct  this:  in  the  Windows  “Start-up”  menu,  choose  “Settings”,  then  “Printers”.  Place  the  mouse  cursor  on  the
desired  printer  and  right-click  the  mouse.  In  the  window  that  opens,  click  on  “Properties”.  Choose  the  “Paper”  or
“Control” tab (depending on the type of printer) and verify if the paper size is “Letter” (North America) or  A4 (Europe).

If the margins defined by default are too wide:

To  correct  this:  in  the  Windows  “Start-up”  menu,  choose  “Settings”,  then  “Printers”.  Place  the  mouse  cursor  on  the
desired  printer  and  right-click  the  mouse.  In  the  window  that  opens,  click  on  “Properties”.  Choose  the  “Paper”  or
“Control” tab (depending on the type of printer), then choose the “Non-printable Zone” (or another, depending on the
type of  printer)  and  reduce  the  non-printable  zone  to  0.25  inches  (0.5  centimeter)  or  another  measure  of  that  order.
However, not all printers and drivers have this function.
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Calculation methods

Margill  Loan Manager (MLM) was developed to take into account the multiple calculation methods prescribed by  law,
regulations and usage all over the world. MLM can be used on all five continents and its methods set for the particular
local needs.

Specific calculation rules are often imposed by law or regulation on certain Borrowers only, i.e., banks, credit unions, and
other  financial  institutions  that  lend  to  consumers.  You  may  not  be  subject  to  these  rules,  unless  you  are  specifically
regulated by the laws in question (the banking laws of various countries, European Community directives, the US Truth in
Lending Act, etc.).

If you are not subject to these regulations, you can choose any of the MLM methods available, usually stating these in
the contract.

The calculation settings below are included in MLM and explained in separate sections of this guide:

 The  calculations  respect  the  following  well  known  payment  methods:  Normal  (or  Effective  Rate)  Method,  Simple
Interest Rule, Simple interest (Capitalized) and the United States (U.S.) Rule (this latter rule is in fact Simple interest).

 Simple interest (capitalized)
 Effective Rate method based on equal periods or exact days (sometimes called "Actuarial" method)
 Day count: 30/360, Actual/Actual, Actual/360, Actual/365
 Short and long periods
 Effect of leap year
 Weeks in a year

Other elements that are covered include:

 Effect of fraction of cents (pence or other unit)
 Effect of a change in a payment schedule (Payment schedule)
 Irregular payments schedule
 Date inclusion and exclusion
 Balance at date x comparisons

IMPORTANT NOTICE

MLM offers a number of options for the calculations to provide precise results according to the user's situation and the
standards, norms and laws in force. 

Other calculation software use various norms or options that are not always applied constantly or for which the settings
may not be set. 

If  the  user  compares  these  other  software  with  MLM,  in  the  vast  majority  of  situations,  MLM  may  be  configured  to
provide the same results. However, many software contain inconsistencies, flaws or imprecise definitions as to the norms
used.

MLM answers the vast majority of norms and laws for North America, Europe,  Australia,  Africa (excluding the 364 day
year) and Asia.
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In  case of  doubt  as  to  the  norm  that  must  be  applied,  use  MLM's  default  settings  or  consult  the  laws,  by-laws,  rules,
conventions or the contract applicable to the particular situation.

   

Effective Rate (Normal) method

The Effective Rate method is the most commonly used interest calculation method for amortization (loans,  mortgages,
bonds, investments, leases, etc.). 

This method states that when a payment is made, it must first serve to refund the column fees, the interest, and then the
principal. No matter when a payment is made, interest continues to accrue at an effective rate of interest. 

o The US Federal Reserve Board's Regulation Z - Truth in Lending allows the use of this rule.

o The European Community opted for this rule in its Directive 98/7/EEC, which modified the previous directive
(87/102/EEC)  related  to  integrating  the  member  countries'  legislative,  regulatory  and  administrative
provisions regarding consumer credit.

This is the most widely used rule in the world and should be used ordinarily. Mortgages are usually calculated with this
method.

Interest is computed daily no matter what compounding period is chosen. The interest computed every day is based on
the balance and on the effective interest rate, itself computed based on the number of compounding periods in a year
and the stated nominal interest rate. The amount of interest generated every day is not linear (as it is in simple interest)
but follows a very slightly exponential curve, where the first days in a period generate less interest than the last.

In the interest calculation formula used, the frequency of payments is one of the variables and therefore influences the
totals.  Since  MLM  offers  complete  flexibility  (the  Payment  schedule  can  be  completely  modified  by  the  user),  a
calculation initially done with annual payments (1x per year) and another made with monthly payments (12x per year)
for example, while having the exact same other settings (method, compounding, day count, amounts...), will give slightly
different totals once the two schedules are changed to become identical (payment amounts and dates).

A nominal rate compounded (or capitalized) x times per year gives the effective rate that is then used for the calculation.

Interest calculation formula: 

I = C * (1 + t/n) exponent (n * p) - C

I = Interest for the period
C = Capital (Principal)
t = Interest rate
n = Number of compounding periods per year
p = Number of payment periods (or fractions of periods)

Margill Loan Manager (MLM) "Normal (Compound, Effective Rate) Equal periods" method vs. "Normal  (Compound,
Effective Rate) Exact days"

The “Normal – Effective Rate” calculation in MLM offers two options:

 Normal - Effective Rate Equal periods
 Normal - Effective Rate Exact days
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The first: “Normal – Effective Rate Equal periods” calculates interest taking into account equal payment periods in a year:
 

Payments Number of periods in a year

Annually 1

Semiannually 2

Quarterly 4

Monthly 12

Twice monthly 24

According to choice of approximate periods or exact
periods. See “Weeks in a year”

Every 28 days 13 12.x or 13.x

Every 14 days 26 25.x or 26.x

Every 7 days 52 51.x or 52.x

Daily 360, 365, 366

Every x days 360, 365, 366 / x *

Fraction of a period Number of days in the chosen payment period /
Number of days

Example for a monthly payment in January: 31/8 or
30/8 depending the day count method

* Means 360, 365 or 366 divided (/) by x days

In addition, for irregular periods (long or short periods), a situation exists in terms of respecting the equal weight of each
month when calculating interest.  A  day  in  the  month  of  February  (28  days)  must  have  the  same weight  as  a  day  in  a
month of 31 days. MLM uses a weighting method taking account a reference period. Considering the specific intricacies
to Margill's methodology, detailed explanations are available for clients upon request.

See also Change in payment schedule

The second: “Normal – Effective Rate Exact Days” uses a method that takes into account the number of days in a period
in relation to the number of days in the year.

Payments Number of periods in a year

Annually 360/360 *
365 or 366 / 360, 365 or 366

Semiannually 360/180
360, 365 or 366 / 182 

Quarterly 360/90
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360, 365 or 366 / 91 ou 92 

Monthly 360, 365 or 366 / 28, 29, 30 or 31

Twice monthly 360, 365 or 366 / 14, 15 or 16 

Every 28 days 360, 365 or 366 / 28 

Every 14 days 360, 365 or 366 / 14 

Every 7 days 360, 365 or 366 / 7 

Daily 360, 365 or 366

Every x days 360, 365, 366 / x

Fraction of a period 360, 365 or 366 / Number of days 

Example: 365/8 or 366/8 or 360/8 according to day
count method

* Means 360 divided (/) by  360 = 1

See also Change in payment schedule

Calculation adjustments in version 5.0 (September 2018)

The  following  fixes  will  only  apply  for  new  loans.  Existing  loan  calculations  will  NOT  be  updated  with  these  improved
mechanisms:

 Effective Rate Method (Equal periods):

o Improved interest calculation for payments that are added before the First Payment Date initially entered in
the Data window. When payments are added exactly one period (or more exact periods) before the initial
First Payment Date, interest now computed using equal periods based on first payment date basis.

o Fix of odd weighting of payments periods fixed (in exceptional cases)

 For the Effective rate method (Exact days): un-required mathematical weighting taken out.

 For  long  periods  at  start  of  loan,  when  the  First  payment  date  is  not  exactly  x  periods  after  Origination  date
(example: Origination date Sept. 17 and First payment date Dec. 1), the short period is now at the very start of the
loan (Sept. 17 to Oct. 1) as opposed to being before the First date (Nov. 17 to Dec. 1).

   

Simple Interest (Capitalized)

With this method, simple interest is used to compute the interest between the first (previous) payment and the second
(next) payment. The interest accrued for this period is then added to the balance and serves as the new balance upon
which interest is computed for the next period. It is thus simple interest compounded or capitalized at the end  of each
period. 

Margill Loan Manager (MLM) offers two approaches for this method:
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1)  Automatic Capitalization at the Loan Origination date

This calculation method will apply capitalized simple interest to the entire Payment schedule without the user needing to
capitalize the interest manually. Green lines are included to indicate the capitalization. Default capitalization will start on
the loan origination date, but it is possible to start capitalization on any other date, by checking the option in Settings >
User settings  >   Ask  Date  of  first  capitalization.  See  Automatic  Capitalization  on  a  later  date  than  the  loan  origination
date)  under  section  (2)  below.   The  anniversary  can  be  annual,  semi-annual,  monthly,  etc.,  depending  on  the
"Compounding" displayed in  the  Data  window.  The accrued interest,  neither  paid,  nor  capitalized,  calculated  with  the
simple interest is thus capitalized.

In  the  example  below,  the  compounding  (capitalization)  is  monthly  with  an  Actual/365  Day  Count  and  a  biweekly
payment frequency (every 1st and 15th of the month).

The capitalization lines are highlighted in green. These lines cannot be deleted (except the last capitalization line of the
Payment schedule with the possibility of deleting lines as they become the last line of the schedule).
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 The calculation to obtain accrued interest for capitalization lines is as follows:

Computational Balance (as opposed to the true balance) of the previous line x Number of days / 365 (or 366 or 360)
[depending on the selected day count] x interest rate = Accrued interest

Therefore, to obtain the accrued interest on line 9:

6,320.15 (calculation balance: line 8) x 13 days (from 2017/01/15 to 2017/01/28) / 365 x 12.25% = 27.57
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The Line status for a capitalization (in green) will  be "Information", unless a transaction is scheduled for the same day,
such  as  a  payment  or  other.  In  the  example  below,  the  payment  is  scheduled  on  the  1st  of  each  month  and  the
capitalization are done on the same day. We can recognize the capitalization lines by their green color:

If  the  payment  date  is  changed  on  a  green  line,  a  new  line  will  automatically  be  created  to  consistently  meet  the
mandatory capitalization date.
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For  an  irregular  capitalization,  see  the  section  below:  Manual  Capitalization  or  the  Irregular  Interest  Compounding
section, in the How to do... chapter.

2)  Automatic capitalization on a later date than the loan origination date 

This  method  is  identical  to  the  one  explained  above,  except  that  the  capitalization  will  not  take  place  on  the  loan
origination date. In order to activate this extra option, go to Tools > Settings > User settings tab and select the "Ask Date
of first capitalization" options.

When  you  select  this  option,  once  you  have  clicked  on  "Compute"  and  if  the  "Capitalized  simple  interest"  method  is
selected in the "Advanced" tab, the following dialog box will open:

In the example above, payments will be made on the 15th of each month, but capitalization will be made every first of
the  month  starting  on  June  1st,  2020,  as  you  can  see  in  the  Payment  schedule  below  with  the  help  of  the  green
capitalization lines:
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Exception: If the chosen capitalization is bimonthly, capitalization dates must be entered directly in the dialog box made
for  this  purpose,  which  automatically  appears  when  the  capitalization  is  "Bimonthly",  and  which  can  be  modified  by
clicking on the "Calendar" icon:

Therefore, in the above example, payments will be made on the 3rd of each month and capitalization will occur on the
15th of each month and on the last day of the month but at 0:00 in the morning, not at the end of day (the 1st would
have to be chosen to include a full month), starting at the loan origination date of the Record:
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It is not possible to start loan capitalization before the Origination date.

To disable the option, check "Always at Origination Date Anniversary".

3) Manual Capitalization

This method can be applied to the Payment schedule line by line or simultaneously to multiple lines. To apply to all lines,
it is suggested to use the automatic method above.

To obtain the capitalized simple interest method, with the Payment schedule above, select the desired lines (Shift or Ctrl),
right click with the mouse and in "Calculation Method" choose, "Simple Interest - Actual/365" (or other Day count). 

The Rate column will appear in blue to show that there has been a change in methods. 
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The Simple interest capitalized method (green lines) will always have precedence over a line that has another calculation
method entered manually by the user. 

For  example,  the  capitalization  is  performed  on  the  first  day  of  the  month  using  the  Actual/Actual  Day  count.  The
Payment  schedule  ends  (last  line)  on  the  16th  of  the  month  and  the  user  has  decided  to  change  the  Day  count  to
Actual/360.  The  use  decides  to  change  the  payment  on  the  16th  to  the  1st  of  the  next  month  that  is  a  compulsory
capitalization line and thus must follow the rule established initially, the Actual/Actual Day count. The special Day count
entered manually by the user will thus be eliminated.

The user  could  nevertheless "cheat"  and  insert  a  line  on  the  1st  of  the  month above the  green capitalization  line  and
enter the desired Day count. The interest will thus be computed as Actual/360 for the period terminating at this date.

See also Irregular interest compounding in the How to do ... chapter.

   

Simple Interest

The  Simple  Interest  Rule  only  calculates  the  interest  on  the  remaining  principal  and  not  on  interest  accrued  between
payments. No interest is calculated on the interest even if the payment is insufficient to cover this interest.

In business, simple interest (no interest on interest) is often used for short duration loans and even in longer loans but is
not the norm. Simple interest is found in the legal arena,  as when interest is  payable on judgments and particularly in
liability matters, but the courts are increasingly considering compound interest, which more accurately reflects "real life."

In simple interest, Margill Loan Manager computes periods as the number of days for the period over the number of days
in year as opposed to a fraction of a year. For example, January is 31/365 (or 366) as opposed to being 1/12 of a year.

To obtain equal interest for every month, use the 30/360 day count so that uneven months such as January and February
each count for 30/360 or 1/12 of a year. 

Year base

When using the Actual/Actual method of the Simple Interest calculation to determine the interest on a loan or a period
of a loan (formula: principal balance X yearly interest rate X number of days/number of days in a year), leap year has a
subtle effect on the "number of days" (the denominator). Various methods are used to determine whether it will be 365
or 366 days.
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One  method  divides  the  calculation  to  take  into  account,  as  a  reference,  the  civil  year.  The  example  in  Table  One
illustrates  the  calculation  method  by  which  the  interest  accrued  from  Nov.  1,  2019,  to  Dec.  1,  2019,  is  principal  (or
balance)  X  yearly  interest  rate  X  30/365.  In  the  bond market,  this  is  called the  ISDA  method  (International  Swaps  and
Derivatives Association). 

Table One: Civil year method (ISDA)

A second method, slightly more complex,  takes into account the payment anniversary date to calculate the base year.
The example in Table Two shows the calculation method by which, counting backwards, the number of days are taken
from the end of the actual payment period to a year prior. For the interest accrued from Nov. 1, 2019, to Dec. 1, 2019,
this  method  will  take  into  account  the  anniversary  date  (December  2019  back  to  December  2018),  to  calculate  the
number of days in that year. Since there are 365 days in this period, 365 will be used as the base. For the March 1, 2020,
to  April  1,  2020  period,  the  366-day  basis  will  also  be  used,  because  from  April  1,  2020  to  April  1,  2019  (counting
backwards), there are 366 days. 

Table Two: Anniversary method

In the bond market, other methods include ISMA (International Securities Markets Association) and the AFB (Association
Française de Banques), which borrow aspects of the above methods but with certain subtleties that are not included in
MLM.

See also the How to do... > Simple Interest for specific lines only chapter.

   

U.S. Rule
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The United States Rule, in compliance with “Regulation Z - Truth in Lending“, is in fact Simple interest (Merchant's Rule)
but with an important distinction by which a  payment always first  reimburses the accrued interest before reimbursing
the principal (US Rule applies exactly the same calculation method as Simple Interest). 

From  Regulation Z Truth in Lending Act, Appendix J

(3) In contrast (to the actuarial method – our addition), under the United States Rule method, at the end of each payment
period, the unpaid balance of the amount financed is increased by the finance charge earned during that payment period
and is decreased by the payment made at the end of that payment period. If  the payment is less than the finance charge
earned,  the  adjustment  of  the  unpaid  balance  of  the  amount  financed  is  postponed  until  the  end  of  the  next  payment
period. If at that time the sum of the two payments is still less than the total earned finance charge for the two payment
periods, the adjustment of the unpaid balance of the amount financed is  postponed still  another payment period, and so
forth.

See Simple interest.

   

Day count

Day count is defined as the method for counting the days in a month and the days in a year for the purpose of interest
calculation. The notation used is (days in a month)/(days in a year).

Margill Loan Manager (MLM) includes the four most common day count conventions as well a second 30/360 rule:

 Actual/Actual - takes into account the 365-day year and the effect of 366 days for leap year

 30/360 - 12 equal 30-day months, based on a 360-day year
o Date adjustment rules (many can take effect, be applied in order, and if a date is changed in a rule, the

modified value is used in the following rules:
 If Date1 is the last day of February, then change D1 to 30.
 If Date2 is the last day of February, then change D2 to 30.
 If D1 is 31 then change D1 to 30.
 If D2 is 31, then change D2 to 30. 

o Number of days formula: (360*(A2 - A1))+(30*(M2 - M1))+(D2 - D1)
 D1 : start date / D2 : Payment date
 Y = year, M = month

 30U/360 (method added in version 4.4) - 12 equal 30-day months, based on a 360-day year

o Date adjustment rules (more than one may take effect; applied in order, and if a date is changed in one rule
the changed value is used in the following rules):
 If the payment is EOM (end of month) and (Date1 is the last day of February) and (Date2 is the last

day of February), then change D2 to 30.
 If the payment is EOM and (Date1 is the last day of February), then change D1 to 30.
 If D2 is 31 and D1 is 30 or 31, then change D2 to 30.
 If D1 is 31, then change D1 to 30.

o Number of days formula: (360*(A2 - A1))+(30*(M2 - M1))+(D2 - D1)
 D1 : start date / D2 : Payment date
 Y = year, M = month

 Actual/360 - calculates the actual number of days in the numerator but bases the interest rate on a 360-day year
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 Actual/365 (Fixed) - same as Actual/Actual but the interest rate is based on a 365-day year, even in leap year

By default, MLM uses the most precise convention, Actual/Actual (the most precise standard also known as Actual/365
but  without  the  adjective  "Fixed").  This  nomenclature  respects  the  terms  used  by  the  International  Standards
Organization (ISO). 

The day count convention usually has a  direct effect on the results (not always) since the convention may exclude the
effect of leap year or simply interpret a year as having 12 equal months of 30 days each (360-day year) or the particular
result  of  Actual/360  where  a  year  contains  12  unequal  months  (28,  29,  30  or  31  days  –  thus  365  or  366  days  for  12
months) on a 360-day year!

The day count to use in a loan will depend on the contract, your location, industry, Borrower (consumer or business) and
sometimes even simply the popular, but not quite scientific, "we've always done it this way". 

Please note: When drafting a loan, lease or other agreement, it is often a good idea to indicate the day count convention.
This simplifies future reference.

   

Short & Long periods

A “short” period payment is defined as a payment made in between two regular payments or when the loan's Origination
date is not exactly a full period before the first regular period.

Loan Origination date March 10, 2016 / regular payments on the 1st of each month
Short periods: Lines 1 and lines 7 and 8

Depending on the jurisdiction, in a regular compound interest loan using the Effective rate method, these short periods
could  be  calculated  using  Simple  interest  (capitalized  when  the  payment  is  made)  as  opposed  to  compound  interest
according to the Effective rate method. Some laws or regulations require this simplified calculation method particularly
when the loan's Origination date is not exactly a period (generally one  month) before the first payment.

For example, if payments are usually made monthly and on the first of the month, an additional payment on the 11th of
a  30  day  month  would  create  two  (2)  short  periods  (of  10  and  20  days  respectively).  Interest  could  be  computed  as
follows: 10/365 (or 10/360 depending on the Day count) for the first short period and 20/365 (or 20/360 depending on
the Day count) for the second period. Interest is capitalized on the 10th day of the month at midnight.

Margill Loan Manager (MLM) includes eleven methods to calculate the short period:

1. Use same as calculation (thus no change in method for short periods);
2. Use simple interest with capitalization based on a 366-day year (Actual/366);
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3. Use simple interest with capitalization based on a 365-day year (Actual/365);
4. Use simple interest with capitalization based on a 360-day year (Actual/360);
5. Use simple interest with capitalization based on a 360-day year (Actual/360 U);
6. Use simple interest with capitalization based on the 30/360 rule;
7. Use simple interest based on a 366-day year (Actual/366);
8. Use simple interest based on a 365-day year (Actual/365);
9. Use simple interest based on a 360-day year (Actual/360);
10. Use simple interest based on the 30/360 rule;
11. Use simple interest based on the 30/360 U rule.

In  the Payment schedule,  MLM will  indicate the interest in  blue when Capitalized Simple interest  is  used and in  green
when Simple interest is used. In the example below, with a Compound interest (Effective rate method) lines 7 and 8 use
the Capitalized Simple interest method and lines 12 and 13 use the Simple interest method.

 

For “long” periods, thus a period whose length is more than one regular payment period yet not full periods, MLM will
determine  the  last  complete  period  which  will  be  calculated  normally  and  will  add  the  short  period  that  will  use  the
special calculation method. 

If a loan’s Origination date is January 15, and the first payment June 1st with monthly payments, MLM will create a long
period from January  15 to  May 14 (midnight)  using  the  calculation’s  regular  method.  It  will  also  create a  short  period
from May 15 to May 31 (midnight) that would use the special short method payment method (Actual/365 in the example
below). 

If a whole period or periods are removed (lines deleted), MLM will consider this long period with full periods and thus use
the calculation’s normal method.

Changing a calculation method in the Payment schedule manually
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A change in the calculation method can be applied, in the Payment schedule, to one irregular payment or to many.

As of MLM version 5.0, these changes must be made manually by the user as he modifies the Payment schedule, since
the options for the short  method in the data entry widow under the  "Advanced" tab  are  now reserved for  the  period
between the loan Origination date and the date of first payment. To change methods, select the desired lines ("Shift" or
"Ctrl" and left mouse click) and right mouse click to choose "Calculation Method". Then select the desired method. The
method will then be changed for the selected lines and the interest rate will appear in blue or in green.

Short period and long period calculated between the loan Origination date and the Date of first payment

Two options are available, as of MLM 5.0 in order to define the calculation method between the loan Origination Date
and the Date of first payment.

These options are located under the "Advanced" tab of a Record.

Note:  These  settings  will  not  affect  short  periods  that  are  subsequently  added  to  the  Payment  schedule.  If  the  user
wishes  to  apply  a  calculation  method  other  than  his   normal  method  ("Same  as  calculation"),  he  will  need  to  add  it
manually as described in the previous section.

Short Period Method, "Advanced" tab:

This option is often chosen when the “Method” above is “Normal (Compound Effective Rate)”.

When a method other than “Same as calculation” is  chosen, if  the time period between the  Origination Date  and  the
First Payment Date is LESS than a regular payment period (one month, one year, one week, etc.) – thus a “Short” period
– the interest calculated for this period will  use the selected short  period calculation method, not  the normal method
chosen under “Method” above. 

The special method will also apply if the time period between the Origination Date and the First Payment Date is MORE
than a regular payment period – thus a “Long” period. But be careful, basically, Margill tries to minimize the use of the
short period method. Thus, Margill will use the normal calculation method for the regular period(s) included in the long
period and will do the short period calculation for the days between the end of the complete initial periods and the first
regular payment.
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Example  of  a  long  period  with  regular  monthly  payments:  Origination  Date  03/22/2018,  First  Payment  Date
06/01/2018

03/22/2018 to 05/22/2018 (2 full months, normal method, same as calculation)
05/22/2018 to 06/01/2018 (10 days, short period method - interest rate becomes blue or green)
06/01/2018 and subsequent payments (normal method, same as calculation)

 

The  normal  method  will  NOT  be  changed  to  the  short  period  method  as  lines  are  added  at  the  end  of  the  payment
schedule or are inserted between payments, as dates are changed and even if irregular payments are posted. If required,
the normal calculation method can be substituted by the short period method, manually, in the payment schedule with
the right mouse click (under “Calculation Method”).

Short period Interest-only first payment (+ Column fees if applicable) option

Particularly  used in  mortgages,  this  option  adds  an  additional  payment  called  the  "Interest  adjustment  date".  See  the
Interest Adjustment Date section in the How to do... chapter.

This first payment will not count in the amortization. So for a 60 month loan (entered in Amortization/Term (Payments)),
when this option is checked, there will actually be 61 payments, the first being a smaller payment. 
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Short period default setting

A default short period calculation method may also be specified in the "Advanced" window. Once the setting is set, press
on "Save as default". The settings will be the default settings for all subsequent calculations.

A Profile may also be set if certain calculation types require special short period settings. See Profiles.

   

Leap year

Depending on the settings set by the user, leap year will be factored into the calculation.

To see the effect of leap year, see:



Page 1192

© Jurismedia Inc., 2007- 2023

Simple interest

Day count

Weeks in a year (payments & compounding)

   

Reference date

Margill  Loan  Manager  (MLM)  uses  as  its  reference  period  for  calculations,  the  first  payment  date  as  opposed  to  the
Origination Date or calculation Start date. This allows for equal interest for each uniform payment frequency thereafter.

The difference between these reference periods can be seen in certain loans depending on the Origination date and the
first payment date.

For example, a loan with a start date of October 15 and a first payment date of February 1 (thus a long period), and with
its  monthly  payments  on  the  first  of  each  month  thereafter,  Margill  will  compute  the  interest  from  October  15  to
November  1  (short  period)  and  afterwards,  from November  1  to  December  1,  from December  1  to  January  1,  and  so
forth.

o This is contrary to calculating from October 15 to November 15, from November 15 to December 15, from
December  15  to  January  15  and  from  January  15  to  February  1  (short  period  in  the  middle  of  an
amortization table as was done in versions before MLM 5.0)

   

Weeks in a year (payments & compounding)

In calculating the amortization when payments or compounding are weekly, biweekly (every 2 weeks), or every 4 weeks,
various  interest  calculation  software  will  use  a  different  number  of  periods  per  year.  For  example,  in  a  365-day  year,
weekly  compounding  may  either  be  52  times  per  year  or  52.143  times  (365/7)  or  even  52.286  (366/7).  Although  few
norms exist as to the right method, and the difference between both is quite small, Margill Loan Manager (MLM) allows
both options. 

Either check or uncheck the boxes for number of compounding periods in a year and number of  payment periods in  a
year. This can be done directly in the "Advanced" window and the default setting set with "Set as default" at the bottom
left of the window.
 
In case of doubt as the whether or not the boxes should be checked, use the MLM default settings.

   

Fraction of cents (or other units)

For simple and compound interest calculations, Margill Loan Manager (MLM) carries out the calculations by accruing the
amounts  of  interest  by  periods  of  one  month  or  longer.  If  the  amount  of  the  principal  and  the  interest  rate  are  not
sufficient  to  accrue  at  least  a  one-hundredth  (0.01)  of  an  interest  unit  (cent,  penny,  pence,  etc.)  for  the  period  in
question, no interest will be taken into account.
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Thus, MLM should not be used to calculate small amounts (under 1.00 unit, for example), as the calculations for such
interest will not comply with the formulas in the software.

   

Change in payment schedule

When a payment line in a Payment schedule is added or eliminated, the reference period for calculating the interest of a
new period may be  altered.  The total  interest  will  thus  be  slightly  different  from the  total  which  would  have  resulted
from a calculation done when the eliminated line had a 0.00 payment.

In  certain  more  complex  cases  (loan  including  some principal  bearing  interest  and  some without  interest,  30/360  Day
count with an additional line that modifies the Day count, payment of interest in advance), adding or deleting a line, even
with  a  payment  of  0.00  (Line  status  "Information"),  could  have  a  significant  effect  notably  because  of  the  interest
capitalization that could be calculated on that new date. As of version 5.0, a new Line status called  "Information -  No
Impact" eliminates the effect of adding a line which, in theory, should not have an impact (excluding possible rounding
effects) on the total interest accrued. 

   

Irregular payments schedule

Creation of a Table of Irregular Payments

Because the frequency of payments influences the reference period in the calculations in  compound interest (effective
rate method), the total interest calculated can vary slightly based on the chosen payment frequency.

Consequently,  if  a  table  of  completely  irregular  payments  is  created,  it  is  recommended,  to  specify  the  effective (real)
interest rate with annual compounding (with annual compounding, by definition, nominal interest rate = effective (real)
interest rate) and choose “Irregular” in the “Payment Frequency”. In this way, the results will be more precise than if the
payments  frequencies  are  chosen  at  random  since  an  "Irregular"  payment  frequency  uses,  in  the  interest  calculation
formula, annual payments data.

To  compute  the  effective  interest  rate  from  the  nominal  rate  to  which  is  applied  a  compounding  period,  use  the
"Nominal / Effective Rate Converter" from the "Other" button in the Main MLM window.

   

Date inclusion and exclusion

Loan Start date and loan End date

As in all well developed software, and as is the norm in the industry, the start date ("Origination Date" in Margill  Loan
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Manager) is included and the final date is excluded.

This is easily explained through this simple example: a start date of January 1 and an end date of January 1 should yield
zero interest (thus no 24 hours of interest) as opposed to one day of interest.

Payment date

If a payment is made on the first of the month (November 1 in the example below), the payment will be considered made
at the beginning of that day at 0:00 hours in the morning (as opposed to the end of day). Interest on that payment will
also start at 0:00 AM.

The interest reported on November 1 will  be interest up to midnight on October  31.  The interest  is  not  computed for
November 1 (end date excluded).

   

Balance at date x comparisons

Margill Loan Manager (MLM) offers powerful tools to obtain totals and balances at any chosen date.

To obtain  in  the  "Global  Summary"  and  the  "Record  List-  Summary"  reports,  the  same balance  as  in  the  amortization
tables (detailed reports), check "Include the last day's transaction" since the day's interest are EXCLUDED in the detailed
reports but the day's transactions are included. 

MLM also includes a column in the Payment schedule that shows the balance before payment.  To obtain this  balance,
check "Exclude last day's interest and transactions".
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Refund order for Interest, Fees and Principal

Margill Loan Manager (MLM) includes multiple types of "monies" that can be included in the loan. The most obvious ones
being:

 Principal (accounting)
 Interest

We  can  then  add  various  types  of  fees  (taxes  or  insurance).  MLM  includes  three  types  of  fees  that  are  refunded
differently et can therefore be used or not (as required by the user):

 Line Fees
 Column Fees
 APR Fees

Finally,  we  can  add  other  types  of  "mathematical  principal"  with  Line  statuses.  For  example,  Line  status  "Other  1"
including  a  negative  payment,  is  added  to  the  "mathematical"  principal  (loan  balance  increases)  but  not  to  the  pure
accounting principal.

There are two refund orders, one being the mathematical order and the second the accounting order. These orders are
very similar but there are subtleties because of the fact that some monies bear interest and others do not.

Refund orders for versions before 5.0 

The following "mathematical refund order" is determined in MLM and cannot be changed:

 1) Column Fees 1
o 1a) Without interest
o 1b) With Interest

 2) Column Fees 2
o 2a) Without interest
o 2b) With Interest

 3) Column Fees 3
o 3a) Without interest
o 3b) With Interest

 4) Column Fees 4
o 4a) Without interest
o 4b) With Interest

 5) Column Fees 5
o 5a) Without interest
o 5b) With Interest

 6) Column Fees 6
o 6a) Without interest
o 6b) With Interest

 7) Interest
o 7a) Interest without interest
o 7b) Interest with interest (including capitalized interest)

 8) Accounting principal without interest
 9) Mathematical principal of all other Line statuses

o 9a) Without interest
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o 9b) With interest
 10) Accounting principal with interest and APR Fees Financed (on a pro rated basis)

From an "accounting refund order":

 Only a "Payment" type Line status can refund Column Fees, interest and accounting principal.

 A "Fees" type Line status for example can only be refunded by its corresponding Line status "Fees - Paid".

Example of the mathematical refund order before version 5.0: 

Principal Overdue interest
(capitalized)

Accrued
interest of the

line

Line Fees
without
interest

 Column Fees

Added amounts

5000 80 20 225 65

Total payment = 395 Mathematical refund - Amounts paid

Refund order 4 2 3 1

Paid Pmt = 275 0 0 20
Balance = 0

190 65
Balance = 0

Paid line fees = 120 85 0 35
Balance = 0

0

Total payment = 395 Accounting refund - Amounts paid

Paid Pmt = 275 110 80
Balance = 0

20
Balance = 0

0 65
Balance = 0

Paid line fees = 120 0 0 0 120 0

*  Accounting  balance:  Balance  according  to  type  of  monetary  element.  For  example,  interest,  principal,  Column  Fees  1,  Line  Fees,
Insurance, etc., are all components that can be isolated and reported individually.

Post Version 5.0 Refund Order

As of version 5.0 (September 2018) an improved refund order was created for new calculations only (existing calculations
maintain the pre-version 5.0 order). 

Interest that is capitalized (which is therefore past due) is now refunded, at the mathematical level, before principal and
other principal-type amounts added (line-type Fees) that do NOT bear interest. This new approach is more in line with
the principle that interest is refunded before principal, even if capitalized. This change in method will only have an effect
if principal amounts that do not bear interest are added to the loans. These situations are not very common.

The "mathematical refund order" is established as followed in MLM and cannot be modified:

 1) Column Fees 1
o 1a) without interest
o 1b) with interest
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 2) Column Fees 2
o 2a) without interest
o 2b) with interest

 3) Column Fees 3
o 3a) without interest
o 3b) with interest

 4) Column Fees 4
o 4a) without interest
o 4b) with interest

 5) Column Fees 5
o 5a) without interest
o 5b) with interest

 6) Column Fees 6
o 6a) without interest
o 6b) with interest

 7) Interest
o 7a) Interest without interest
o 7b) Interest with interest (including capitalized interest)

 7) Principal without interest
 8) Mathematical Principal of all other Lines Statuses 

o 8a) without interest
o 8b) with interest

 9) Principal with interest and APR Financed Fees (by proportion) 

The "Accounting order" has not been modified as of version 5.0.

Example of mathematical refund order and accounting as of version 5.0 calculations:

Principal Overdue interest
(capitalized)

Accrued
interest of the

line

Line fees
without
interest

Column Fees

Added amounts

5000 80 20 225 65

Total payment = 395 Mathematical refund - Amounts paid

Refund order 4 2 3 1

Paid Pmt = 275 0 100
Balance = 0

110 65
Balance = 0

Paid Line fees = 120 20 0 0 100 0

Total payment = 395 Accounting refund - Amounts paid

Paid Pmt = 275 110 80
Balance  = 0

20
Balance  = 0

0 65
Balance  = 0

Paid Line fees = 120 0 0 0 120 0
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Refund of APR Fees Financed

When a payment is made, the "APR Fees Financed" are paid based on the proportion related to the original principal. In
the  following  example,  for  a  mathematical  principal  refund  of  1000.00,  the  portion  of  paid  principal  will  be  952.38
(95.24%) and the portion of the APR Financed Fees will be of 47.62 (4.76%) since: 

Principal portion: 50 000 / 52 000 =  95.24%
Fees portion: 2500 / 52 500 = 4.76%

This order can be changed with the Paid Principal Line status and right mouse click. See the "Payment" Type Line Statuses
chapter > "Paid Principal" Line status sub-section.

Zero (0.00) payment lines

When the Payment amount is 0.00 and no extra fees are added as Column fees, this is usually simply an information line.
Technically,  this  line  shouldn't  have any  effect  on  the  mathematics.  However,  in  certain  very  special  cases,  a  line  with
payment 0.00 could have an effect on the calculated interest,  since it  could be separating a  normal period in  two and
therefore have an important effect on the interest calculated.
 
We notice this particularly in calculations using the 30/360 Day count where the month of February, which must count 30
days  (even  if  in  reality,  it  has  28  or  29  days),  when  divided  in  short  periods,  can  count  less  than  30  days.  This  is  an
exception that cannot be ignored. This division must change the number of days of interest for that month.

In other more complicated scenarios, also unusual, including, for example a loan with some principal bearing interest and
some not bearing interest and when interest (and Column fees) capitalization interest lines are added, "Information" Line
statuses (or other payment lines of 0.00) could change the accrued interest. To ensure a strict minimum effect of these
lines, it is suggested to use the "Information - No impact" Line status since it was created specially not have any impact
on the mathematics for the majority of situations. On the other hand, the "Information" Line status or a payment of 0.00
could have an effect on the mathematics.

Special refund order

Usually, the refund order is:

1) Column fees 1
2) Column fees 2
3) Column fees 3
4) Column fees 4
5) Column fees 5
6) Column fees 6
7) Interest 
8) Principal and APR Financed Fees (by proportion)

This order can be modified line by line in order to change the refund order for Column Fees and the proportion of the
Principal and the APR Financed Fees.

See: the Fees, Insurance and Taxes by Column (and Automatic) chapter >  Special reimbursement sequences for Column
Fees sub-section.
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See: the Line status chapter > "Payment" type Line statuses > Refund exclusivity and priority > "Principal" Type Line
statuses sub-section.

Refund order 2 (available only upon request)

This special refund sets the accounting refund order as such:

1) Interest
2) Expected Principal (Accounting principal and APR Financed Fees (by proportion))
3) to 8) Column Fees (1 to 6 in that order)
9)  Principal  (Accounting  principal  and  APR  Financed  Fees  (by  proportion)(if  the  payment  is  sufficient  in  order  for  the
balances of 1) and 3) to 8) above to be 0.00)

This method is not available by default in the system but on special request only.

In  this  Refund method, if  payments are missed (or  partial)  and new payments need to be added to compensate these
unpaid/partial  payments,  the Expected Principal  would be 0,00 (since not  initially  planned)  for  these new lines.  In  this
situation,  interest would first  be paid,  then all  outstanding Column Fees and  only  if  the  payment  was sufficient  would
principal be paid.

To counter the above,  so in  order for  the  compensatory payments  to  pay  interest,  then the  Expected Principal  before
Column fees, these compensatory payments should include Expected Principal  amounts in  the column. Thus,  Expected
Principal should be added in the new payment lines to compensate for any unpaid or  partial  payments above and the
sum  total  of  Expected  Principal  will  thus  be  greater  than  the  loan  amount.  Human  intervention  will  be  required  for
adding this Expected Principal (use the Ctrl  Alt Shift x shortcut). This will  result in an Expected Principal amount higher
than the  loan amount  and  an  Expected Principal  Balance greater  than  0.00.  This  equation should  give 0.00 for  proper
accounting: Total Expected Principal minus Expected Principal Balance minus Loan amount.

A complete recomputation of  the Expected Principal  for  all  Due Pmt lines  could  also  be  an  option,  but  this  action  will
eliminate the originally computed Expected Principal amount.

See Activation of "Expected Principal" in order to see how to activate this data when producing the Payment schedule
and how to recompute it subsequently, if required, in the Payment schedule.

Interest Refund order - "current" interest versus "capitalized" interest

For detailed explanations of these methods, the second being an exception method, see the Refund Options section in
the Margill Loan Manager Calculations chapter.

   

Calculation of interest on the Outstanding amounts

In  the  Payment  schedule,  the  "Outstanding  -  Interest"  column  computes  the  interest  on  outstanding  payments  and
interest on this interest for compound interest.

The calculation of the interest amount simply uses the Rule of Three (cross multiplication).

In Compound interest:

Outstanding interest for the current line =

Total Outstanding Balance (including interest on the outstanding payment) of the line above

DIVIDED by
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True* Balance of the line above

MULTIPLIED by

Accrued interest for the current line.

For the computation using Simple interest, the first variable "Total Outstanding Balance" is replaced by the "Outstanding
Payment Balance", which excludes interest on interest.

* Before version 5.0, Computational Balance was used instead of True Balance. This could have given less accurate results
when (rare) important non interest bearing principal (or fees) were mixed in with interest bearing amounts.
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Definitions and Glossary

Financial and various terms

30/360:
ISO Nomenclature

Day count based on a 360 day year with exactly 30 days per month even if the calendar 
months are 28, 29, 30 or 31 days. Made for an easy way to compute normal loans before
the advent of more sophisticated computing method. Odd for irregular loans.

Accounting Balance Balance according to type of monetary element. For example, interest, principal, Column
Fees 1, Line Fees, Insurance, etc., are all components that can be isolated and reported
individually.

Accrued Interest Interest  that  is  computed  over  time  whether  a  payment  is  actually  paid  or  not.  As
opposed to Paid interest where a payment must actually be paid (as opposed to due) to
pay off interest.

WARNING:  Interest  could  also  be  considered  accrued  as  soon  as  calculated.  Thus,
interest  calculated  in  the  future  (that  will  become  receivable),  that  is  not  necessarily
accrued, is still known as "accrued interest".

Accrued Principal (simply called
"Principal" in MLM)

Principal  that  is  computed  over  time  whether  a  payment  is  actually  paid  or  not.  The
balance will be reduced by the principal amount when the payment is greater than the
accrued  interest.  If  the  payment  is  not  sufficient  to  pay  off  accrued  interest  then  the
principal  will  become  negative  (by  the  accrued  interest  amount)  thus  increasing  the
balance. As opposed to Paid principal where a payment must actually be paid.

Accrued principal is the equivalent of mathematical principal in MLM.

Actual/360:
Nomenclature

Day count based on a 360 day year but where months have the true number of calendar
days.  Can  lead  to  odd  computations  in  favor  of  the  lender.  For  example  365  days  of
interest but with interest per day computed to be 1/360.

Actual/365:
ISO Nomenclature
Also known as Actual/365 (fixed)

Day count based on a 365 day year but where months have the true number of calendar
days including leap year.

Actual/Actual:
ISO Nomenclature
Also known as Actual/365

Day  count  based  on  a  true  calendar  year  including  effect  of  leap  year.  Most  precise
calculation method.

Amortization period: The paying off of debt in regular installments over a period of time. Such payments must
be  sufficient  to  cover  both  principal  and  interest.  A  mortgage  may  have  a  25  year
amortization period. Not to be confused with the "Term" of a loan (see below).

Annual Percentage Rate (APR):
The true cost of a loan expressed as a percentage and based on the interest rate and the
various compulsory fees, insurance or other charged for the loan. 

See also the distinction between Nominal APR and Effective APR.

Als o known as Total Charge of Credit (TCC).

Annual Percentage Yield (APY): The effective, or true, annual rate of return. The APY is the rate actually earned or paid in
one  year,  taking  into  account  the  effect  of  compounding  and  any  fees  charged.  Also
known as Effective (Real) Interest Rate if fees are not included. The rate is included in the
 MLM APR data window.

Biweekly: Every two weeks.

Capitalize: In the context of Margill Loan Manager, "capitalize" means to compound simple interest
at the end of a period as opposed to the effective rate method which computes interest
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based on the effective interest rate. 

Compound Interest: Interest computed on the sum of an original principal and accrued interest.

Day count: The method for counting the days in a month and the days in a year.

Effective (Real) Interest Rate: The true interest rate that is paid or received on a borrowed or invested sum of money,
as opposed to the nominal rate. Also known as APY (Annual Percentage Yield).

Effective APR: Includes all compulsory administrative and finance fees and takes into account the effect
of the compounding period.

Effective Rate method: Method of calculating interest based on compound interest theory in which the accrued
interest is always paid before the principal and in which interest is calculated every day
based on the effective interest rate (sometimes called "Actuarial method").

Information Card (Borrower, Creditor
or Employer): Data that is contained in MLM pertaining to these participants in a loan.

Long period: Payment  period  longer  than  one  normal  (regular)  payment  period  but  ending  before
another complete normal period.

Nominal APR: Includes all compulsory administrative and finance fees but does not  take into account
the effect of the compounding period.

Nominal Interest Rate: The interest rate that  is  applied to  borrowed or  invested  principal  without  factoring  in
compounding.  The  true  rate  (effective,  or  real  rate)  can  vary  based  on  the  different
methods of interest calculation.

Paid Interest or Principal Interest or  Principal  that  is  actually  paid  (refunded) as  opposed to  accrued.  In  MLM,  a
payment must be a true payment as opposed to the payment of a fee, tax, insurance or
other non payment type transaction.

"Paid" Payment All Line statuses that pay principal, interest, Column Fees and APR Financed Fees:

 Paid Pmt
 Paid Late Pmt, Partial Pmt, Partial Late Pmt, Paid Pmt Returned Check
 Add. Pmt, Compensatory Pmt
 Paid Pmt 2 to 10 (names that can be customized) as renamed *
 Paid Pmt 11 to 20 (names that can be customized) as renamed ** 

* The simple fact of renaming a Line status that is not of Payment type Line status (for
example  renaming  "Other  1"  to  "Paid  Payment  XYZ")  does  not  change  its  behavior  or
effect.

**These payments do not include their "Unpaid" counterparts and only include,
for the reports, the amounts per se. The reporting fields that subdivide Interest,
Principal, Column fees and APR Fees financed portions are not included.

See also "Payment" Type Line statuses

Principal (Accounting) Accounting principal can only be added to a loan by the original principal entered and by
"Principal" Type Line statuses.

Capitalized  interest  or  adding  fees,  penalties,  taxes,  etc.,  has  no  influence  on  the
accounting  principal.  Any  payment  other  than  true  payments  ("Payment"  Type  Line
statuses) does not refund accounting principal.

The  accounting  principal  amounts  are  in  the  columns  to  the  right  of  the  Result  table
("Balance Due Principal" and "Paid Principal" columns), not in the first columns to the left
("Principal" column which is the mathematical principal - see explanation below).

Principal (Mathematical) All negative payments, regardless of the Line status and any unpaid interest added to the
loan balance, are mathematical principal.
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All  positive  payments  ("Payment"  type  lines,  Fees  Paid,  Insurance  Paid,  "Other"  type
lines, etc.) refund mathematical principal.

All increases or decreases in mathematical principal increase or decrease the balance of
the loan but not necessarily the accounting principal.

The  mathematical  principal  is  located  in  the  left  columns  of  the  Payment  schedule
("Principal" column) .

The mathematical principal amount increases when a payment is  negative or when the
payment  amount  is  insufficient  to  pay  the  accrued  interest  (this  is  represented  by  a
negative amount in the "Principal" column) .

The mathematical principal amount decreases when a payment is positive, regardless of
the Line status (this is represented by a positive amount in the "Principal" column). 

Quarterly: A period of three consecutive months.

Semiannually: A period of six consecutive months, therefore, two halves of a year.

Short period: Payment  made  in  between  two  regular  payments  or  made  less  than  one  complete
regular period after the loan origination date.

Simple Interest: Sum collected on a fixed principal. No interest is payable on interest.

Term: The period for which a loan is granted. Not to be confused with "Amortization period".
For example, a 5 year mortgage (5 year term) may have a 25 year amortization period.

Total Charge of Credit (TCC): See APR definition above.

US Rule: Sum collected on a  fixed principal.  No interest is  payable  on  interest.  Same as  "Simple
interest".

Computer terms

Assigned: The loan itself,  the Borrower (and  Co-Borrower  and  Guarantor),  Employer  and  Creditor
are all in individual databases (tables in technical terms). 

By  assigning  a  Borrower  to  a  loan  for  example,  a  link  is  created  between  these  while
keeping the data separate (relational database).

Batch: A  set  of  data  processed  in  a  single  program  run,  as  opposed  to  individual  transactions
processed in real-time.

Default: The setting that is determined by the software developer (or the user if allowed) 

Desktop: In  Windows,  the  screen  displayed  when  the  system  starts  up;  the  main  screen  of  the
Windows program.

Export: The action of transferring a file to a word processor, spreadsheet or other software, and
converting the file into a format compatible with that software.

Extension: The  optional  or  required  three  character  identification  added  at  the  end  of  all  files.
Example: ClientABC.RTF

Field: The zone (box) of a window in which it is possible to enter data.

Also a data element used for reporting.

Folder (Directory): A group of files, or group of folders, placed together under one title. Example: C:\Program
files\MLM.

MLM is often the "folder" and subfolders are contained in it. 

A subfolder is a folder in the main folder.
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Main MLM window (Record
Summary window):

Window  that  opens  up  upon  launching  Margill.  Also  called  the  "Record  Summary
Window".

Path: The  fully  specified  name  of  a  file,  including  the  position  of  the  file  in  the  file  system's
folder structure.

RTF file: Rich  Text  Format  file  (extension .RTF).  File  with  a  sophisticated page  setup  that  can  be
opened  and  modified  easily  in  most  word  processors,  all  the  while  conserving  the
formatting.
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Appendix 1 - Field Characteristics and Lengths

Field Characteristics and Lengths

Section(s) Tab Field(s) Type Character
length

Notes

Data Data Report header Alphanumeric Unlimited

Data General File Alphanumeric 40

Data General File Number Numeric 15

Data General Type Alphanumeric 40 Can be scroll
menu

Data General Accounting ID Alphanumeric 20

Data General Other Info Alphanumeric Unlimited

Data /
Borrower /

Creditor

General (for
Data)

Unique Identifier Alphanumeric 40

Data Record Notes Alphanumeric and images Unlimited Possible to
format and

paste images

Borrower Notes+ Borrower Notes Alphanumeric and images Unlimited Possible to
format and

paste images

Field characteristics and lengths of field types for the custom fields (Fields 1 to 9)

Field type Data type Maximum length Number of units Number of
decimals

Text Alphanumeric 50 NA NA

Text / Menu (Text) Alphanumeric 50 NA NA

Numerical / Menu 
(Numerical)

Numeric 16 10 6

Monetary / Menu
(Monetary)

Numeric 12 10 2

Rate (%) / Menu (Rate (%)) Numeric 7 3 4

Date / Menu (Date) Date 8 NA NA

Integer / Menu (Integer) Numeric 10 10 0

Field characteristics and lengths of field types for the custom fields (Table format)

Field Type Data type Maximum length Number of units Number of
decimals
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Text / Menu (Text) Alphanumeric 1000 NA NA

Numerical / Menu 
(Numerical)

Numeric 16 10 6

Monetary / Menu
(Monetary)

Numeric 12 10 2

Rate (%) / Menu (Rate (%)) Numeric 7 3 4

Date / Menu (Date) Date 8 NA NA

Integer / Menu (Integer) Numeric 10 10 0
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- F -
Filter option (and search)  479

- I -
Interest (capitalized) refund order  620

- C -
Creditor - add or change in bulk  117
Capitalized interest refund order  620
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Column fees (adding when adding lines)  806

- P -
PDF Reader  334

- A -
Automated Reports  1146

- L -
Log of changes (by line)  437

- B -
Bank account - hide  379

- S -
Social security number - hide  379

- V -
Version 5.x  30

- R -
Redacted (hidden) data  379

- L -
Legal costs and fees management and collection with interest  606

- I -
Injury lawyers (fees and costs finance)  606

- P -
Personal injury lawyers (fees and costs finance)  606

- R -
Results table (now called Payment schedule)  727

- E -
e-Transfers (credit to Borrower)  276

- K -
Kleopaptra (software)  419

- V -
Variable interest rate module - Introduction and Methods  624

- A -
Adding or Changing Rate tables, Spread or Rate Update Method in a Record  638
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- S -
Spread (interest)  638, 635

- I -
Interest rate Spread  635

- P -
Penalty Spread  635

- M -
Main window and Payment schedule Template for users  101

- A -
Activation of "Amount due" variables  399
Activation of "Expected Principal"  400
ADMIN Password Lost  76

- P -
Perceptech / Acceo  231

- G -
Global Changes - Payment schedule  501

- E -
e-Transfer (EFT credit)  231
Emails - sending in bulk  1018
Expected Principal  400

- B -
Balance - Expected Principal  400

- V -
Variable Interest Rates  638, 410

- E -
Electronic Signature  414
Electronic Signature (eSignature)  1039

- I -
Indexation (payment)  437

- P -
Payment indexation  437

- E -
EFT payment deletion  437
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- R -
Report by email (send)  355

- E -
Emailed report (automatically)  355

- F -
FTP - send report to  355

- V -
VoPay  231

- S -
Show / Hide Totals in the Main window  398
Spreadsheet data import and changes  493

- M -
Mass Import/Changes via spreadsheet  493

- E -
EFT Payment Rejection Date and Reason  261
Email - Borrower  117

- T -
Text messaging  117

- E -
Email to text (SMS)  117

- A -
Automatic backup  139

- O -
Overnight tasks  139

- S -
Sandbox version of MLM  145

- U -
Update  145

- C -
Compensatory payment  153

- S -
SMS  117, 471
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- L -
List of Applications  436

- E -
Email to SMS  471

- T -
Tutorial in Main window  331

- Q -
Quick Links  328

- A -
Archived Records  517

- D -
Do Not Refresh Main window  330

- C -
Creditor /Investor Statements  1045

- R -
Record "Data" window: Display / Hide Loan "Term" and "Due Pmt" Type  333

- A -
Ask Date of first Capitalization  332

- I -
Internal Standard Operating Procedures (SOP)  328

- S -
Standard Operating Procedures (SOP)  328

- W -
Web links  328

- U -
Unplanned payment  153

- S -
Setting up the EFT module  231, 206

- M -
Merge / Email / SMS Template  1018

- U -
Unmanaged Records  390
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- I -
Interest Paid in Advance  785, 535

- P -
Payment update via precise payment Amount and Date  200

- A -
Automatic / Overnight Tasks  344

- B -
Blocking Historical Transaction Changes  392

- A -
Advanced Queries  936

- P -
Payment Behavior  437

- I -
Interest Adjustment Date  542

- A -
ACH payments  216

- L -
Line Color  759

- M -
Merge - email data  471

- C -
Canada - Perceptech (Acceo) / VoPay  230

- " -
"Interest" type Line statuses  749

- C -
Changing or Deleting Submitted EFT Payments  227, 263

- O -
OUT - EFT credit card pour utilisations futures  

- I -
Importing Bank Account Data and Activating EFT in Bulk  281

- C -
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Comparative "Sandbox" version before live version update

- O -
OUT - Intrix ACH  

- T -
Tutorial  104

- I -
Investor  702

- E -
Emails and SMS - Sending automatically or in batch with Templates  471

- A -
Automatic emails  471

- S -
Sending emails in bulk  471

- B -
Bulk emails  471

- U -
United States - NACHA file  206

- I -
IF, OR, THEN condiitions in reports  1152

- T -
Type (Record)  364

- D -
Drop-down menus  364

- S -
State (drop-down, défault)  364

- C -
Country (drop-down, default)  364

- P -
Province (drop-down, default)  364

- R -
Record Status (Custom)  364
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- S -
SMS - Alerts  290, 386

- D -
Data import and changes - bulk via Excel  493

- A -
Automatic payment amount recalculation (Behavior) for balance = 0.00 or other amount

- R -
Reduce / Increase the last payment to adjust final balance (Advanced)  841
Record Type  364

- E -
Equations (Advanced - IF, OR, Conditions)  1152

- C -
Custom Record Status  364

- T -
Text messages - Alerts  290

- J -
JSON import  107

- E -
Excel import  107

- S -
Salesforce API  339, 107

- B -
Bulk import  107

- S -
SEPA file (Europe EFT)

- D -
ddd

- S -
SEPA file
SEPA file (EFT Europe)  281

- E -
European SEPA file  281
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- N -
NACHA file  216

- A -
Advanced Mathematical Equations  1152

- I -
Import historical transactions  178

- D -
Data changes in bulk via Excel  493

- N -
New User Guide 5.6  11

- B -
Bulk Data import or data update in the Results table  427

- S -
SMS- Sending manually to Borrowers  386

- T -
Tax and insurance paid by Creditor  178

- S -
Status (Record)  364

- H -
Historical payment import in bulk  178

- P -
Past payment import in bulk  178

- B -
Bulk import and changes  85

- L -
Lead/Prospect approval and Record (loan) import via Excel or JSON   462

- E -
Extract Notes from Records  427

- D -
Dashboard  519

- L -
Log File  416
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- I -
Internet Access  418

- P -
PGP Encryption Setup  419

- F -
FolioMedian (SMS) Connection  386

- S -
Sub-Creditors  409

- U -
Upcoming new things  

- S -
Sensitive Data Module  379

- M -
Master and Affiliate Loans  410

- A -
Automatic Reports  355, 419

- P -
Personalized Standard Fields  363

- A -
Automated Imports - JSON or Excel files  415

- S -
Salesforce Connection (API)  415

- M -
Master and Affiliate Loans - EFT  267

- S -
Sensitive Information  417

- " -
"Due Payment" type Line statuses  739

- * -
* Page numbers refer to sections not the actual page
* Page numbers refer to sections not the actual pages
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- 0 -
0.00 payment  620

- 1 -
1098 IRS
1099 IRS  

- 3 -
30, 60, 90... days late  1125
30/360  1186, 1201

- A -
Acceptance  24
Accounting  1159, 1066, 728
Accounting data  1159
Accounting Principal
Accounting system  966
Accounts receivable  552
Accrual basis (Accounting)  1066
Accrued amounts (interest, etc.)  1066
Accrued interest  750
Accurate calculation  1174
Accurate results  711, 1174
ACH  231, 205, 204
Acomba  1066
Activation  13
Active records  754
Actual/360   1186, 1201
Actual/365  1201
Actual/365 (Fixed)  1186
Actual/366  1186
Actual/Actual   1186, 1201
Actuarial method  1175
Add lines  437
Add-on Interest Loan  532
Adding lines (payments, principal, fees, etc.)  806
Adding or changing Interest rates in a Payment schedule  816
Adding payments  806
Additional expected payment  739
Additional fees  722, 827, 728
Additional payment  739, 153
Additional payments / Compensatory payments  780
Additional principal  806, 827, 728, 728, 748
Additional Principal, Fees, Penalties, Insurance and Taxes  827
Adjust interest rate
Adjust on interest  820
Adjust on payment  820
Adjustable Rate Mortgage (ARM)  543
Adjusted payments  543, 620
Adjustment  1159, 728
Administration Fees  724
Administrator  85, 75
Administrator and Users  85
Advanced  121, 317
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Advanced functionshhhh  711
Advanced settings  129
AFB  1184
Ageing of Accounts  1125
Ageing report  1109
Agent  121
Alerts  85, 290
Alerts (Record specific)  711
Alerts - Days late  1125
Allow to change the ''Expected Payment'' amount when Line status is ''Due Payment''  389
Allowance for Doubtful Accounts  671, 1107
Alt 2  477
Alt A  477
Alt L  477
Alt P  477
Amex  728
Amortization  end date  15
Amortization & payment schedules  529
Amortization (Payments)  671
Amortization end date  437
Amortization period  1201
Amortization period in years  437
Amount Financed  
Amounts charged (no interest)  827
Annual Nominal Rate (%)  671
Annual Percentage Rate (APR)  711, 1201, 718, 717, 728
Annual Percentage Rate (APR)  711, 1201, 718, 717, 728
Annual Percentage Yield (APY)  1201
Annuity
Appendix 1 - Field Characteristics and Lengths  1205
Apply Payment(s)  437
APR  827, 532, 711, 129, 718, 717, 317, 728
APR (Annual Percentage Rate)  121
APR (fees)  
APR box  725
APR disclosure box (USA only)  1134
APR Fees  599, 760
APR report  725
APR tags  317
APR tags (fee names)  724
APR undefined  723, 717
APY  
ARM  543
Arrears: Late and/or unpaid salaries, rent, annuities  602
Association Française de Banques  1184
ATO
Attach  715
Attach documents  671
Attached document  1097
Attached Documents  509
Attached Files, maximum size (MB)  389
Attachment Container  671
Audit trail
Aurtomatic Fees  711
Australia Tax Office  
Automatic Fees  775
Automatic fees (changing manually)  567
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- B -
Backup  435, 139
Bad debt  671
Bad debt report  966
Balance  1159, 840, 1194, 839, 839, 671, 839, 820, 808, 966
Balance (at current date)
Balance - computational  843
Balance - Interest  750
Balance - Principal  750
Balance - true
Balance all others  750, 843, 760
Balance at date x comparisons  1194
Balance before payment  843, 760
Balance columns in Payment schedule  843
Balance Due Interest  843, 760
Balance Due Principal  843, 760
Balance options & information  839
Balance other than 0.00 in Data entry window  839
Balance others  728
Balloon help  317
Bank of Australia
Bank of Canada  
Bank of England  
Batch database changes  486
Batch import
Behavior  317
Bills  552
Biweekly  1201
Borrower  85, 121, , 129, 317
Borrower (Client) Information  690
Borrower (import in batch)
Borrower - Custom fields  130
Borrower and Lender in MLM  702
Borrower changes  486
Borrower Maximum Credit  339
Borrowers  149
Bounced check  771
Broverman, Samuel A  1207
Budget
Bulk database changes  486
Bulk Import of Borrowers, Employers, Creditors and Payment Schedules  414
Bulk Import of Loans (Manually)  454
Bulk import of Loans and Database configuration  111
Bulk Payment (Transaction) Import  178

- C -
Calculation method  711, 437
Calculation method for Short periods  825
Calculation methods  769, 1174
Calculation of interest on the Outstanding amounts  1199
Calendar  519
Can only see own Records  85
Canada Revenue Agency  
Capital - long term  976
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Capital - short term  976
Capital to be received  976
Capitalization  825, 1187
Capitalize  1201
Car loan  530
Carried forward  771
Cash basis (accounting)  1066

- O -
OUT - Central Bank and Bank interest rates  

- C -
Change calculation method in a Results table  1187
Change in payment schedule  1193
Change of compounding or calculation methods  769
Change payment (Line) status  153
Changing one or multiple payments  802
Changing or Deleting Submitted EFT Payments  227, 263
Changing the basic loan data in a Record  688
Changing the date of a payment  813
Changing the interest for multiple records in one operation  642
Charts
Check  760
Check - NSF  771
Check for Data Irregularities  511
Check for software updates  319
Check Number  760, 1134
Checking for Data Irregularities
CHM  73
Citrix server  13, 12
City taxes  760
Clear  317
Clear the Results table  1170
Client Data  24
CM4  1109
Co-Borrower  698, 690
Code de commerce  1207
Collection - Bills, Invoices...  552
Collection of irregular payments  552
Collection of regular payments  552
Collections  290
Color (Record)   644
Column - Hide  644
Column - Show  644
Column Fees  671, 599, 760
Column fees paid  1066
Column Fees, Insurance and Taxes  567, 599
Column Fees: Automatic  387
Column order  650, 644
Column selection  650
Column width  644
Columns  760
Columns - move, lock, hide  760
Columns not displayed  644
Comment  153
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Commercial loan  530
Compensated check  1134
Compound interest  711, 825, 1199, 1201
Compounding  671, 825, 769
Computational Balance  843, 760
Compute final payment for balance = 0.00 or other amount  839
Compute fixed principal  793
Compute interest rate
Computer software crash
Conditional alert - days late  1125
Conditional alerts  290
Confidentiality of Data  24
Consolidated log of changes  420
Construction loan APR  718
Consumer Data Industry Association (CDIA)  1115
Contact information  24
Copy all  437
Copy Attached documents  424
Copy lines  437
Copy Record  437
Cost of Borrowing (Banks) Regulations  1207
Cost of Borrowing Regulations (Canada)  717
CRA  
Create a new Record  1170
Create the complete Results table  671
Creating and modifying a Borrower, Creditor, Employer and Loan Officer  117
Creating new interest tables and updating these  627
Creating the custom template
Creating the first Record  121
Creator (see "Owner")  85
Credit account  1066
Credit agency  671
Credit Builders Alliance  1111
Credit bureau  671
Credit card  204
Credit card payment  728
Credit limit (Borrower)  690
Credit Manager 4  1111, 1109
Credit Manager4  709
Credit Rating Agency  1109
Credit Report  709
Credit Reporting  407
Credit Reporting Module  1109
Creditor  85, 121, , 129, 317
Creditor (Lender/Investor)  702
Creditor and Borrower in MLM  702
Creditors  149
CSV  1066
Ctrl  437
Ctrl A  477
Currency  317, 402
Custom Column Titles  375
Custom fields  364, 130, , 644, 690, 153
Custom letters  
Custom Report Settings  410
Custom reports created by the Margill team  1143
Custom Results table  988
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Custom schedule (Results table)  121
Custom Unique Identifiers (Record, Borrower, Creditor)  515
Customized Record List  966

- D -
Data  671
Data and Backups  387
Data Backup  23
Data fields
Data Integrity  754, 
Data sorted  644
Data window  437
Database  13, 149
Database Reindexation  436
Date Calculations  619
Date Format  84
Date format in the Document Merge reports  334
Date inclusion and exclusion  1193
Day count  711, 1186, 1201, 317
Days late  1125
Days of delinquency  1125
Debit account  1066
Decimal points  390
Default  711
Default (Loan)  804
Defining Line (Payment) Statuses
Deleting a line or lines  815, 437
Deleting a Record, a Borrower, a Creditor, an Employer or an Agent  125
Demo mode  76
Demographic data  130
Denominator  1184
Description  671, 1097
Desktop  1201
Detailed schedules  1097
Direct debit  204
Directive 98/7/CE  717
Directive 98/7/EEC  1175, 1207
Display Filter  130
Display Filters  656
Display Record log  420
Display the tips and messages  330
Displayed column selection, name and order  650
Do not show again  317
Document Merge (Letters, Contracts, Invoices and Statements)  1002
Dollar  402
Doubtful accounts  690, 966
Doubtful Accounts Report  1107
Due Interest  1159, 843, 966, 760
Due payment  750, 739, 728
Due Pmt 2  739
Due Pmt 3  739
Due principal  1159, 843
Due, Outstanding and Unpaid Payments Reports  1123
Duplicating Records  126
Duplication  437
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- E -
Early pay-off  804
Edit Record  688
Effective (Real) Interest Rate  1201
Effective APR  1201
Effective interest rate  617
Effective Rate (Normal) method  1175, 1201
Effective Rate Equal periods  1175
Effective Rate Exact days  1175
Effective rate method  614
EFT  204, 728
EFT Definitions  205
EFT lead time  246
EFT Payment Update (Rejected payments)  257, 225
Electronic Funds Transfer  231, 410, 204, 728, 966
Electronic Funds Transfer  231, 410, 204, 728, 966
Electronic Transaction Processing  966
Email  135, 
Email Connection  383
Email connection (Batch emails)  135
Email Payment schedule  1097
Employer  85
End of loan  804
End of Record  15
End of year balance  1159
End of year totals  1097
English  319
Entering specific credit data  1115
Equal payments  808
Equifax  709, 1109
Equivalent Rates  617
Escrow  178, 538, 760
Escrow Account  1129, 538
Escrow Report  1129
Ethernet  12, 1168
Euro  402
European Central Bank  
European Community  1175
Excel  1066, 107, 493
Excel import of loans  454
Exchange rate  402
Executive Dashboard  951
Expected payment  780, 739, 760, 771
Expected payment / check  739
Expected payment amount  153
Experian  709, 1109
Export  437
Export accounting data  750
Export accounting transactions to the General Ledger  1066
Export to accounting package  1159, 966
Exporting from MLM to CM4/CM5  1119
Extract Attached Documents from Records  424
Extract File(s)  671

- F -



Page 1228

© Jurismedia Inc., 2007- 2023

F1- Help (User's manual)  436
Federal Reserve Board  1175, 
Federal Truth-in-Lending Disclosure box  725
Fee names  724
Fees  1159, 827, 671, 717, 317, 728, 599, 760
Fees (automatic)  567
Fees (no interest)  827
Fees - Automatic  775
Fees - financed
Fees - various amounts  567
Fees and Points  121
Fees by Line status  599
Fees financed (APR)  718
Fees included in the interest rate  597
Fees list  966
Fees paid  750, 827, 1066, 728
Fees paid subesquently (APR)  718
Fees paid up-front, Financed or Paid subsequently  718
Fees, Insurance and Taxes  560
Fees, Insurance and Taxes by Column (and Automatic)  567
Fees, Insurance and Taxes by Line status  561
Fields  1201, , 850
Fields - custom  690
Files attached to a Record  671
Files to backup  139
Final payment  804
Financed Fees APR - Paid  750
Find specific Line statuses in Records  422
First payement (irregular)  825
First Payment Date  671
Fiscal year  976
Fiscal year-end  1097
Fixed principal  671, 317, 728, 620, 437
Fixed Principal Payment Adjustment - Simple Interest  793
Fixed principal payment recomputed automatically  793
Fixed principal payments  793
Fixed principal tag  793, 760

- O -
OUT - Fixed Rate at Origination Date  

- F -
Font size  477
Forecast  976
Forecast - revenue  15
Foreclosure  671
Fraction of cents (or other units)  1192
Franc  402
French  319
Fundamental principles of operation  15

- G -
General Ledger  750, 1066, 728, 966
Getting started  75
GL  750, 1066, 728
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Global Changes - Borrowers  491
Global Changes - Records  487
Global changes to the database (Batch changes)  486
Global Summary  1105
Grace period  711, 317, 778, 153
Guarantee  690, 701
Guarantor  690, 701

- H -
Help & Support  73
Hide column  644
Hide columns  760
Hide the Database Path in the Record Summary window  331
Highlight Record by color  644
History  153, 420
HKMA  
HLP  73
Hong Kong Monetary Authority  
How to do...  530
Hyperfile database  13, 12
Hypotheses  688

- I -
Identifier  124
Ignore small loan balance (add to interest fee)  840
Import Format  107
Import PDF  1143
Import RTF  , 
Importing existing word processor files  
Importing into Accounting packages (QuickBooks, Sage,  Acomba)  1087
Inaccurate calculation  711, 1174
Inaccurate results  711, 1174
Include last day's interest and transactions  
Indentifier (unique, loan)  121
Indexed payments  437, 781
Innovis  1109
Insert documents  671
Insert lines  437
Insert payment  552
Installation, Networking capabilities and Database  13
Installer  73
Insufficient funds  780
Insurance  827, 724, 728, 599, 538, 760
Insurance paid  827
Integrating Existing Loans  113
Interest  836
Interest (no)  599
Interest - accrued  750, 15
Interest - Paid  750
Interest - reduce or increase for equal payments  840
Interest accrued (at current date)  650
Interest automatically recalculated  549
Interest balance  750
Interest on Outstanding  1199
Interest Paid  1159, 1066, 966, 760
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Interest rate  823
Interest rate (equal) recomputed to yield a balance = 0.00 or other amount  820
Interest rate - change multiple records at once  816
Interest rate - unknown  838, 838
Interest rate change  816, 437
Interest rate Fees  597
Interest rate table (default)  317
Interest receivable  976
Interest table updates  144
Interest tables  543, 627
Interest tables (& Sales tax table) updates  151
Interest-only  671, 317, 728, 620, 437
Interest-only payment recomputed automatically
Interest-only payments (and Column Fees) and Interest paid in Advance  785
Interest-only tag  785, 760
Internal rate of return (IRR)  820, 838, 838
Internal Revenue Service (IRS)  
International Securities Markets Association  1184
International Standards Organization (ISO)  1186
International Swaps and Derivatives Association  1184
Internet Connection  382
Intial loan amount  827
Introduction  728, 11
Investment  728
Investment portfolio  607
Invoice  728
Invoices  552, 

- O -
OUT- Invoices and Statements  

- I -
Invoices sent by email  
Irregular interest capitalization  614
Irregular investment  607
Irregular invoices  552
Irregular loan  121
Irregular loan (determination of rate in payment schedule)  838
Irregular payments  671, 552, 728, 1193
Irregular payments schedule  1193
IRS  
IRS 1098  
IRS 1099  
ISDA  1184
ISMA  1184

- K -
Kellison, Stephen G  1207
Key  13
Knowledge Base (Web)  74

- L -
Language  317, 319
Larger font size  477
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Last payment  840, 820
Late days  1125
Late fees  567, 775
Late fees based on number of days late  567
Late or partial payments  775
Late payment fees  567
Late Payment of Commercial Debts (Interest Act)  1207
Late payments  813, 728, 775, 153
Lead time EFT  246
Leap year  1191
Lease  839, 567, 560, 557

- O -
OUT - Legal / Judgment (pre/post judgment) interest rates   

- L -
Lender  702
Lender and Borrower in MLM  702
Letters - custom  

- O -
OUT - Letters, Contracts, Invoices and Statements (Document merge)  

- L -
License  24
License Agreement  24
Limited warranty  24
Line behavior  793, 317, 785
Line Comment  758, 728, 1093
Line Comments - Extracting to report  758
Line of credit  549
Line Payment Statuses  375
Line status  1159, 750, 827, 290, 843, 813, 422, 728, 743, 770, 966, 850, 760, 1093
Line status  1159, 750, 827, 290, 843, 813, 422, 728, 743, 770, 966, 850, 760, 1093
Line status alerts  290
Line status Fees, Insurance and Taxes  561, 599
Line status/payment condition  754
Line-specific alerts  290
List of all "Active" Records  153
List of Borrowers, Creditors or Employers  1123
Live support  73
Loan (personal, car, commercial)  530
Loan - Irregular  121
Loan changes  486
Loan end date  1193, 15
Loan Guarantees (Securities) Report  966
Loan hypotheses  688
Loan import  454
Loan numbering  121
Loan or mortgage adjusted over time as rates become known
  543
Loan start date  1193
Loan with Fees (Insurance, Taxes, etc.) not bearing interest  599
Loan without interest on part of the principal only  611
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Loan-to-value ratio  1146
Local area network  1168
Location (Path) of System Data  81
Lock columns  760
Locked User  85
Log (multiple records)  420
Log of Changes for Records  420
Log out  85
Logo  671
Long period  825, 1201, 1187
Long term capital  976
Long term principal  976
Loss of password  85
Lump sum payments / Prepayments  804
Lump sums  728

- M -
Mac  12
Main MLM window  1201, 644
Mandatory Fields  339
Margill Loan Manager Calculations  529
margill.com  , 151, 144
Margins  1173
Mass change  486
Mastercard  728
Mathematical Equations  290, , , 1146, 966
Mathematical Principal  748
Maximum Credit (Borrower)  690
Merge Borrowers  149
Merge Borrowers and Creditors  411
Merge Creditors  149
Merge Data Fields  
Method Interest-Only  785
Metro 2  671
Metro 2 data  709
Metro2  1111, 1109, 1115, 1119
Minimum payment  760
Missed payments  405, 728
Modify rate  543
Monetary Unit  84
Monitor  12
Monitor resolution  12
Mortgage  760
Mortgages  1175, 671, 538
Multi Currency  317, 402
Multiple loan import  454
Municipal taxes  538, 760

- N -
Negative amount  754
Negative payment  827
New payments  728
New Record  671, 688, 126
No interest  827
No interest on Fees, Insurance and Taxes  599
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Nominal & Effective APR  723
Nominal / Effective Interest Rate Converter  617
Nominal APR  1201, 723
Nominal interest rate  1201, 617
Non contiguous lines  437
Non-printable zone  1173
Normal refund  620
Notes  290, 1097, 714
Notes - Record and Borrower  505
Notes de Marc
NSF check  780, 1134, 771
NSF report  966
Number of computers with access to MLM  80
Number of day(s)  671
Number of Decimals displayed (Interest rate)  390
Number of years  671

- O -
Operational speed  12
Options: Interest-only and Fixed Principal  321
Origination Date  671
Origination Fees  724
Other calculations  617
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Outstanding  1159, 405, 843, 1199, 552, 1109
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Outstanding amount (at current date)  650
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Overwrite Record  688
Owner  85

- P -
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Paid amounts  1066
Paid fees  728
Paid interest  1159, 750, 966, 760
Paid Late payment  728
Paid payment  750, 728, 743
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Paid principal  1159, 750, 966, 760
PAP  728
Paper size  1173
Parallels  12
Partial late payment  813
Partial payment  728
Participation loan  1045, 702, 616
Participation Loan  1045, 702, 616
Participation / Syndicated Loans  1141
Particpating loan  121
Passwords  85, 75
Payment  743
Payment = 0.00  620
Payment date  813, 1193
Payment Due date  813, 760
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Payment frequency  671
Payment method  793, 785
Payment periods  671
Payment that should have been paid  771
Payment type  793, 785, 760
Payment type Line statuses  743
Payment Update Tool  1123
Payment update via Line Unique Identifier  190
Payments (equal) recomputed to yield a balance = 0.00 or other amount  808
Payments - added  806
Payments - Fundamentals  770
Payments - positive or negative
Payments adjusted  543, 620
Payments adjusted for balance = 0.00  437
Payments adjusted for balance = X  437
Payments carried forward  771
Payments every two months  671
Payments set to 0.00  620
PDF  , 1143, 73
Penalty  827, 728
Penalty paid  827
Percentage to Add  671
Perceptech  204
Period of Payments  671
Personal loan  530
Personal Logo Display  28, 410
Personalized Reports  950
Peso  402
Pocket calculator  519
Points Paid  724
Portfolio abnormalities  1093
Portfolio Analysis  1133
Portfolio trends  1093
Positive payments  754
Post payment tool  775
Post payments  1123
Pound  402
Power user  85
Pre-authorized payment  728
Preauthorized payments  966
Precise calculation  711, 1174
Preliminary Payment schedule  15
Prepayments  804
Preview  1097
Principal  671, 769, 743, 748, 836
Principal - Accrued  750
Principal - long term  976
Principal - no interest  827
Principal - short term  976
Principal and Interest payment  620
Principal balance  750
Principal Paid  1159, 750, 1066, 966, 760
Principal to be received  976
Principal Type Line statuses  748
Print  715, 1170
Print page format  1097
Printers  1173
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Printing  1172
Printing custom RTF reports  1172
Printing detailed schedules  1172
Printing multiple Records  1097
Printing Preview  320
Printing problems  1173
Pro rated fees paid  718
Producing and printing the RTF reports  
Profiles  711, 129, 317
Purchase additional licenses / Upgrade loan level  27

- Q -
Quarterly  1201
Quarterly statement  1159
Quarterly Totals  1097
QuickBooks Pro  1066

- R -
Rand  402
Rate Adjusted Payments  543, 671, 538, 785, 620
Rate change  816, 728
Rate Table/Interest Tables  627
Rate Tables  671
Rates adjusted for balance = 0.00  820, 437
Rates adjusted for balance = X  820, 437
Read-only  85, 671, 337
Read-only user  85, 153
Real balance  843
Real interest rate  617
Recalculated equal payments  728
Recalculated uniform interest rate  728
Receivables  552
Recompute equal payments  808
Recompute fixed principal amount  317
Recompute interest rate  820, 823
Recompute interest-only amount  317
Reconciliation  1159
Record  669
Record - Active  671, 754
Record - Archived  671
Record - Bad Debt  671
Record - Closed  671
Record - Draft  671
Record - End date  15
Record - Pending  671
Record Alert  290
Record change log  420
Record changes  486
Record Color  656, 644, 517
Record Data  671
Record history  420
Record List Summary  1106
Record List  966
Record List with Period Breaks  976
Record Status  671, 769, 364
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Record Summary window  15, 644, 319
Record Window  669
Record window Identifiers (Headers)  325
Reference date  1192
Refinanced loan  827
Refresh Table  437
Refresh time  1168
Refund  549
Refund all outstanding interest  785
Refund interest-only  785
Refund only interest for the period  785
Refund options  785, 620
Refund order  827, 711, 567
Refund order for Interest, Fees and Principal  1195
Refund principal and ALL outstanding Interest first  793
Refund principal and interest FOR THE PERIOD only  793
Refund principal WITHOUT refunding outstanding interest  793
Regional settings (Windows)  84
Registration code and Key  78
Registration key  78
Regular loan  838
Regulation Z  1175
Regulation Z Truth in Lending Act  1185
Relational database  149
Remote Desktop (Microsoft)  12
RemoteApp  12
Rent  602
Replacing Bank accounts  229, 266
Reporting Fields  850
Reports  754, 847, 1170
Reports - custom  , 966
Reposession  671
Reset text size (main window and Results table)  330
Residual value  839
Results Table  1097, 760, 437

- P -
Payment schedule (Amortization, payment schedule)  727

- R -
Results table (custom)  988
Results table - preliminary  15
Results table - theoretical  15
Results table - true  15

- P -
Payment schedule columns  760

- R -
Return on investment (ROI)  820, 607, 838
Returned check  728, 760
Returned check date  760
Returned check list  966
Returned check report  1134, 988
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Returned checks  1134, 410
Revenue  1159
Reverse Mortgage  547
Rich Text Format  
Right mouse click  153, 437
ROI  607
RTF  , 
RTF Editor  , 

- S -
Sage 300  1066
Sage 50  1066
Salary  602
Sales Tax Calculations  618
Sales tax rate(s)  317
Sales tax table  151
Sales tax tables updates  144
Sales taxes  567
Sales taxes - unpaid  567
Same as calculation (Calculation method)  1187
Save  688, 126, 1170
Save as default  317
Save Attached documents  424
Saving
Saving & Printing  1170
Schedule - custom  121
Search Mode  664
Search Tools  479
Security  690, 416, 415
Security (Guarantee)  701
Security levels  85
Select all lines  477
Select all Records  477
Select every other line  477
Select only lines with a payment  477
Select only positive lines  477
Selecting and Submitting Payments   246, 216
Semiannually  1201
Services - Other (APR)  724
Services-Other  724
Setting the Records' Unique Identifiers  124
Setting up Credit Reporting  1111
Short & Long periods  1187
Short period  711, 825, 1201, 317, 437, 1187
Short period default setting  1187
Short term capital  976
Short term principal  976
Shortcuts  644, 477
Show Balloon Text  330
Show column  644
Simple Interest  711, 843, 825, 1199, 1201, 607, 1184
Simple Interest (Capitalized)  1177
Simple Interest - 30/360  437, 1187
Simple Interest - Actual/360  437, 1187
Simple Interest - Actual/365  437, 1187
Simple interest - interest-only  785
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Simple interest capitalized  825, 614
Simple interest compounded  614
Simple Interest for specific lines only  615
Simply Accounting  1066
Simultaneous access  337
Software update  145, 149
Software updates  144, 144
Sort  644
Sort by color  644
Sort Records  479
South Africa Reserve Bank  
Special events  728
Special Events Report  1093
Special header  1097
Specific date  671
Speed issues  1168
Standard Securities Calculation Methods  1207
Start and Exit the software  75
Statements  
Statements sent by email  
Step payments  728, 437, 781
Suggested maximum number of days between ''Pmt Date'' and ''Pmt Due Date''  388
Summary report  1105
Support, maintenance and update contract  74
Syndicated loans  1045, 702, 616, 1141
System Requirements  12
System settings (Administrators)
System Warnings  515

- T -
Tables  435
Tables (in reports)  1143
Tag  827
Tag (line)  793, 785, 760
Tax and insurance (Escrow account)  1129
Taxes  827, 560, 728, 599, 760
Taxes (Municipal)  538
Taxes and Insurance  760
Taxes paid  827
TCC  1201, 717
Technical and Application support  23
Term  671, 1201
Terminal Services  12
Terminal value  839
Text size  317, 477
The Service Bureau  1109
Theoretical Payment schedule  15, 770
Thousands Separator  84
TILA  725, 718
TILA box  725
Time required to produce reports  1168
Tools - Payment update  153
Tools Menu  153
Total Charge of Credit  717
Total Cost of Credit  , 1201
Total fees  
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Total payments, interest, principal  836
Transaction  988
Transaction Report  1134, 988
True balance  843
True payment amount  770, 771
True payment date  813
True Payment schedule  15
Trust account  1129
Truth in Lending Act  1175, 1207, 717
Truth in Lending Act (TILA) (USA)  718
Twice monthly payments  671
TXT  1066

- U -
U.S. Rule  1185
Undo function  510
Unexpected payment  739
Unique identifier  121, 124
Unknown interest rate  823, 838
Unknown variable  671
Unlock Records / Alerts  337
Unlock user  85
Unpaid accounts receivables  552
Unpaid payment  780
Unpaid payments  728, 153, 771
Unpaid Penalty fees  771
Unpaid Sales taxes  567
Untag Fixed Principal  793
Untag Interest-only  785
Updates  151
Upgrade loan level  27
US Rule  1201
Use Fixed (unique) interest rate at "Origination Date"  671
Use interest table  543, 671
Use of the Period (.) or the Comma (,) for Decimals  84
Useful Features List  437
User - Power  85
User - Read-only  85
User Guide  73
User license  24
User management  85
User names  85
User settings  318
Users  85, 419

- V -
Variable rate loans  543
Variable rates + or - x% (Spread)  635
Variable rates minus %  635
Variable rates plus %  635
Variables  671
Various
Version 1.x  30
Version 1.x, 2.x  149
Version 2.x  30
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Version 3.x  149, 30
Version 4.x  30
Versions  30
Visa  728
Voluntary surrender  671
VPN (Virtual Private Network)  12

- W -
WARNING  23
Weeks in a year  711
Weeks in a year (payments & compounding)  1192
What is a Record?
What is Margill Loan Manager (MLM)  11
Wireless connection  12
Wireless LAN  1168
Withdrawal  549, 728
Word processor  
Write-off  804

- Y -
Year base  711, 317, 1184
Yen  402

- Z -
Zero payment  620
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